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Introduction
This manual has been written for DotNetNuke Professional Edition 06.00.01, and DNN Community Edition 06.00.01. It provides instruc-
tions on how to set-up, create and maintain one or more web sites using DNN. This manual is written to assist users of all levels with 
using, building and maintaining DNN sites. Note: SuperUser level topics are only included in the SuperUser manual.

About DotNetNuke

DotNetNuke (DNN) is an open source Portal and Content Management Framework, based on Microsoft's .NET technology. DNN offers a 
robust, extensible and fully functional framework for the development of a broad range of commercial portal applications.

DNN is a world leading open source portal and content management framework, adopted by thousands of organizations worldwide.

Typically, portals provide a single web front-end to the many applications within an organization. For example, it may present critical infor-
mation from the HR, Finance, Marketing, and Customer Service all from one web site. Connected back-end systems also provide busi-
nesses with the opportunity to combine information and more easily assist. 

About DotNetNuke Corp

DotNetNuke Corp. is the steward of the DotNetNuke open source project, the most widely adopted Web Content Management Platform 
for building web sites and web applications on Microsoft .NET. Organizations use DotNetNuke to quickly develop and deploy interactive 
and dynamic web sites, intranets, extranets and web applications. The DotNetNuke platform is available in a free Community Edition and 
the subscription-based Professional Edition and Enterprise Edition with an Elite Support option. DotNetNuke Corp. also operates the Dot-
NetNuke Store (Snowcovered.com) where users purchase third party software apps for the platform. Founded in 2006 and funded by 
Sierra Ventures, August Capital and Pelion Venture Partners, DotNetNuke Corp. is headquartered in San Mateo, Calif.

http://www.dotnetnuke.com/Products/Community-Edition.aspx
http://www.dotnetnuke.com/Products/Community-Edition.aspx
http://www.dotnetnuke.com/Products/Community-Edition.aspx
http://www.dotnetnuke.com/Products/Professional-Edition.aspx
http://www.dotnetnuke.com/Products/Professional-Edition.aspx
http://www.dotnetnuke.com/Products/Professional-Edition.aspx
http://www.dotnetnuke.com/Products/Enterprise-Edition.aspx
http://www.dotnetnuke.com/Products/Enterprise-Edition.aspx
http://www.dotnetnuke.com/Products/Enterprise-Edition.aspx
http://www.dotnetnuke.com/Products/Elite-Support.aspx
http://www.dotnetnuke.com/Products/Elite-Support.aspx
http://www.dotnetnuke.com/Products/Elite-Support.aspx
http://www.snowcovered.com/Snowcovered2/Default.aspx


Content Overview
A summary of the chapters of this manual and what you will find in each section.

 1. Introduction: Provides a brief introduction of DotNetNuke.

 2. Managing Your User Account: How to create and manage user accounts and subscribe to members services. This section is rel-
evant to all users who have a user account to a DNN site. This section also details additional tools typically available to users 
such as tagging, syndicating and printing content. Note: Administrators manage visitor registration under Admin > Site Settings.                    
See "Enabling/Disabling User Registration"

 4. Working with the DNN Control Panel: Overview of the DNN Control Panel which enables authorized users to add and manage 
site content and perform common tasks.  The Control Panel includes the Admin Console which enables Administrators to perform 
site administration tasks, and the Host Console which enables SuperUsers to perform host level administration tasks for one or 
more portals.

 5. About the Admin Console: Lists all of the functionality available on the Admin Console page and provides links to tutorials on 
using each function.

 6. Configuring Your Site Settings: This section the basic and advanced site settings required for a portal and details how to quickly 
build a site using the Site Wizard.

 7. Building Your Portal:  This section covers the main settings required to set up your portal (site settings) and shows how to quickly 
build a site using the Site Wizard. It details how to build a site by adding pages and modules as well as common tasks such as 
managing files using the File Manager. Finally, this section details how to configure content staging (Only available in Dot-
NetNuke Enterprise Edition) and upload staged content.

 8. Common Tools:  This section details how to use tools which are commonly used throughout DNN. The controls covered in this 
section are the Link control, the Editor control, the Pager control and the Calendar control. This section also includes the list of 
replacement tokens.

 9. Managing Module Content: This section provides in depth topics on using each of the modules included with DNN.

 10. Advanced Site Management: This section provides information on how to add additional functionality to your portal. It consists of 
these sub-sections:

 l Application Health: Tools to optimize the performance of your portal 

 l Extensions: Provides information for Administrators and Module Editors on using the Extension module to view details of 
the available extensions, as well as how to enable the various authentication (login) methods.

 l Logs: Overview of the Site Log and Log Viewer modules.

 l Multi Language Sites: Enable multiple languages on your site and undertake translations into multiple languages.

 l Recycle Bin: Restore and manage deleted pages and modules

 l Search Optimization: Details four tools (modules) which help you optimize searches both within your site and on search 
engines.

 l Users and Roles: Adding and managing registered users; restricting access to pages and/or modules using security 
roles; and imitating user's experience.

 11. Managing Site Design: The basics of setting site wide, page and module design using skins (page design) and containers (mod-
ule design). It consists of these sub-sections:



 l Skin Designer: The Skin Designer module enables Administrators to set container and skin token values.

 l Skins: The Skins module enables Administrators to manage skins and containers which have been installed
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Managing Your User Account
Logging In and Out
Logging into a Site
How to login to a site using the typical basic login method.

 1. Click the Login link to display the Account Login module (also titled the User Log In module). This link is typically located in the 
top right corner of each page - OR - Navigate to an Account Login module.

 2. In the User Name text box, enter your user name. 

 3. In the Password text box, enter your password.

 4. Click the  Login  button.

Tip:  Mouse over or click the Help   icons displayed beside the User Name and Password fields to view login help.

Related Topics:

 l See "Logging in with LiveID"

 l See "Logging in with a Verification Code"

 l See "Logging in with a Security Code"

 l See "Logging in with a Verification Code and a Security Code"



Logging Out of a Site
How to log out of a site. If you have set the site to remember your login credentials, logging out will forget your login credentials.

 1. Click the Logout link which is typically located in the top right corner of each page. 

Tip: To exit a site without logging out, simply close your Web browser. This does not cancel the Remember Login setting.

Remembering Login Credentials
How to set a site to remember your login credentials. Selecting the Remember Login will automatically log you into that site next time you 
visit it. This feature adds a cookie to your computer so it will not work on another computer. It is also portal specific so it will not log you in 
to other portals within this DNN installation. Note: At the time of writing this setting expired after 24 hours. 

 1. Click the Login link (which typically located in the top right corner) - OR - Navigate to an Account Login module. 

 2. In the User Name text box, enter your user name. 

 3. In the Password text box, enter your password. 

 4. Optional. Enter your verification code or the security code if required. 

 5. Check   the Remember Login check box.

 6. Click the Login  button.

Tip: To exit a site, simply close your Web browser. If you click the Logout link you will need to login next time.

Retrieving your Password
If you forget your password you can have it sent to the email address associated with your user account.



 1. Click the Login link or navigate to an Account Login module.

 2. Click the Retrieve Password link.

 3. In the User Name text box, enter your user name.

 4. Optional. If the Security Code field is displayed, enter the code displayed as a picture into the Security Code text box.

 5. Click the Send Password link. If the password sends successfully, the message "   Password Has Been Sent To Your Email 
Address" is displayed.

 6. Click  Proceed to Login to go to the Login module.

Troubleshooting. Login Failed, Remember That Passwords are Case Sensitive

What Happened: Login was unsuccessful. The "  Login Failed, remember that Passwords are case sensitive" message is displayed.

Action: Attempt to logging in again, ensuring Caps Lock is not selected on your keyboard.  If you are still unsuccessful, check your user 
name and password are correct, as detailed in your Welcome Message.

If you are still unsuccessful,  "Retrieving your Password".

Note: If  your login fails too many times your account will be locked for the time set by the Administrator. If this occurs you will be unable to 
login even with the correct details until either the account automatically unlocks or the Administrator unlocks the account for you



Troubleshooting. Retrieving Password Failed
The following error messages may be displayed when password retrieval fails:

 l  User Name Does Not Exist: Retry with a different user name or email the Administrator for assistance.   The Retrieve Pass-
word page.

 l  Please Enter Your User Name: Enter your User Name into the User Name text box and then click the Retrieve Password 
link.

 l  Password could not be sent at this moment. Please try again later or contact the site administrator: Retry login later or 
contact the Administrator.

Managing Your Profile
Changing your Password
How to update the password associated with your user profile.

Important. If you are updating the default Administrator login details for the first time, begin at Step 5.

 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR -Navigate to a View Profile module (also 
called the My Profile module). This displays the user profile page.

 3. Click the Edit Profile link. This displays the Manage Profile page.

 4. Select the Manage Password tab.

 5. In the Change Password section, update the following fields: 

 a. In the Current Password text box, enter your current password.

 b. In the New Password text box, enter your new password.

 c. In the Confirm Password text box, re-enter your new password.

 6. Click the   Change Password link.



Changing your Password

Managing your Profile Photo
How to manage the photo associated with your user profile.

 1. Go to the Manage Profile page of the View Profile (also titled My Profile) module. See "Managing your User Profile"

 2. Go to the Photo field and select from these options:

Uploading a New Image

 1. Click the  Upload File link.

 2. Click the Browse... button and select the file from your computer.

 3. Click the  Save File link to save the selected file.

 4. This displays the selected image.



 5. Click the  Update link.

Selecting a Previously Uploaded Image

 1. At File, select the required photo from the drop-down list. This displays the image to the right of this field.

Removing Images from Profile

 1. At File, select <None Specified>.

Managing your User Credentials
How to manage your user credentials including your names and email address. Note: Your user name cannot be changed.

Mandatory fields are indicated by the Required  button.

 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR -Navigate to a View Profile (also called 
My Profile) module. This displays the user profile page.

 3. Click the  Edit Profile link. This displays the Manage Profile page.

 4. Update any of these User Credentials:

 a. In the First Name text box, edit your first name.

 b. In the Last Name text box, edit your last name.

 c. In the Display Name text box, edit the name you want to be displayed to other site members.

 d. In the Email Address text box, edit your email address.

 5. Click the  Update link.



Managing your User Credentials

Managing your User Profile
How to manage all your personal user details including your name, contact details, biography, photo, time zone and preferred locale.  
The fields used in this example are typical for a US based site; however sites in other countries will typically use local names for address 
fields, etc. 

Note: You can set the visibility of each field as follows, Public sets a field as visible to anyone who is able to view your user profile;                
Members Only sets a field as visible to authenticated site members; Admin Only sets a field as visible to Administrators only.

Tip: If your country is either Canada or United States of America, select the Country before selecting a Region as this will pre-populate 
the Region field.

Admin Tip: Modify the Manage Profile page to suit your needs. You can add, rename and modify fields and more! See "Managing Global 
User Profile Properties"

 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR -Navigate to a View Profile (also called 
My Profile) module. This displays the user profile page.

 3. Click the  Edit Profile link. 

 4. Optional. If the Manage Profile page is not displayed, click the  Manage Profile link.

 5. On the Manage Profile page, complete or edit any of the following fields and then select the Visibility for each field (see note 
above). Mandatory fields are indicated by the Required  button.

 a. In the Prefix text box, enter a prefix for the name. E.g. Ms

 b. In the First Name text box, enter the first name. E.g. Rose

 c. In the Middle Name text box, enter the first name. E.g. A

 d. In the Last Name text box, enter the first name. E.g. Booth

 e. In the Suffix text box, enter a suffix for the name. E.g. MD



 f. In the Unit text box, enter a unit number. E.g. Flat 35

 g. In the Street text box, enter the street address. E.g. 101 Blackburn Road

 h. In the City text box, enter the city. E.g. New York

 i. In the Region text box, enter/select the region. E.g. New York

 j. At Country, select a country from the drop-down box. United States

 k. In the Postal Code text box, enter/select the postal code. E.g. NY 11368

 l. In the Telephone text box, enter your telephone number.

 m. In the Cell/Mobile text box, enter your mobile number.

 n. In the Fax text box, enter your facsimile number.

 o. In the Website text box, enter your web site URL. E.g. www.ecozany.com

 p. In the IM text box, enter your instant messenger id. E.g. rose.booth@ecozany.com

 q. At Photo, select, upload or remove a photo or image for your profile. See "Managing your Profile Photo"



 r. In the Biography Editor, enter a biography.

 s. At TimeZoneInfo, select your time zone from the drop-down box.

 t. At Preferred Locale:

 i. Select Display English Name to display your locale in English (E.g. Italy) - OR - Select Display Native Name to 
display the native spelling of your locale (E.g. Italia)

 ii. Select the name of your locale from the drop-down box.



 6. Click the  Update link.

Admin Tip: The list of available locales is managed using the Languages module.

Unregistering your User Account
How to unregister from a site. This permanent deletes your user account, removing your access to restricted pages and content. 

 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR -Navigate to a View Profile (also called 
My Profile) module. This displays the user profile page.

 3. Click the Edit Profile link. This displays the Manage Profile page.

 4. Click the UnRegister link. This displays the message  "Are you sure you want to un-register?"



 5. Click the OK button to confirm. You are now unregistered and have been automatically logged out of the site. A message is sent 
to you confirming that your account has been unregistered. A message is also sent to the Administrator advising that you have 
unregistered.

Signing Up for a User Account
Signing up as a Registered User
How to sign up to become a registered user of a site.

Mandatory fields are indicated by the Required  button.

 1. Click the Register link (typically located in the top right corner of the page). This opens the User Registration page. 

 2. In the User Registration section, complete all of these fields:

 a. In the User Name text box, enter a user name. Your user name is private and cannot be changed.

 b. In the First Name text box, enter your first name.

 c. In the Last Name text box, enter your last name.

 d. In the Display Name text box, enter the name you want to be displayed to other site members.

 e. In the Email Address text box, enter a valid email address.

 3. In the Enter a Password section, complete all of these fields:

 a. In the Password text box, enter your password. Note: Passwords are case sensitive.

 b. In the Confirm Password text box, re-enter your password.

 4. Click the  Register link.



Tip: Depending on the set up of the site, you may be automatically logged in and your account details displayed, or you may need to 
open your welcome email to obtain additional information to complete login.

Signing up as a Registered User with a Security Code
How to sign up to become a registered user of a site when a security code is required.

Mandatory fields are indicated by the Required  button.

 1. Click the Register link (typically located in the top right corner of each page). This opens the User Registration page. 

 2. In the User Registration section, complete all of these fields:

 a. In the User Name text box, enter a user name. Your user name is private and cannot be changed.

 b. In the First Name text box, enter your first name.

 c. In the Last Name text box, enter your last name.

 d. In the Display Name text box, enter the name you want to be displayed to other site members.

 e. In the Email Address text box, enter a valid email address.



 3. In the Enter a Password section, complete all of these fields:

 a. In the Password text box, enter your password. Note: Passwords are case sensitive.

 b. In the Confirm Password text box, re-enter your password.

 c. At    Security Code, enter the code displayed as a picture in the text box below.

 4. Click the  Register link.

Tip: Depending on the set up of the site, you may be automatically logged in and your account details displayed, or you may need to 
open your welcome email to obtain additional information to complete login.

Subscribing to Member Services
Subscribing to a Member Service
How to subscribe to a member's service. Once a user subscribes they immediately gain access to any modules or pages restricted to this 
service. The user may need to refresh their Web browser to view additional areas of access. 



 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR - Navigate to a View Profile (also called 
My Profile) module. This displays the user profile page.

 3. Click the Edit Profile link. This displays the Manage Profile page.

 4. Click the Manage Services link. This displays a list of the available services.

 5. Click the Subscribe link beside the service you want to subscribe to. This displays the "You have successfully subscribed to the 
[Service Name] role" message at the top of the module.

Tip: Where a fee is charged for the service you will be redirected to the payment Web site to complete the payment process.

Subscribing to a Service with an RSVP Code
How to subscribe to a member's service using an RSVP code provided by an Administrator. Subscription grants you immediate access to 
any pages or content restricted to service subscribers.  

 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR - Navigate to a View Profile (also called 
My Profile) module. This displays the user profile page.

 3. Click the Edit Profile link. This displays the Manage Profile page.

 4. Select the Manage Services tab. This displays a list of the available services.

 5. In the RSVP Code text box, enter the code supplied to you.

 6. Click the Subscribe link to the right of the RSVP Code text box. 



This displays the following messages:

 You have successfully subscribed to the [Service Name] role.

You have been successfully added to the role(s) associated with the RSVP Code entered. In order to get access to the new serv-
ices you will need to Logout and then Login to the site again.

 7. Logout and then Login to the site to gain access to the new services.

Tip: Where a fee is charged for the service you will be redirected to the payment web site to complete the payment process. 

Subscribing to a Service with an RSVP Link
How to subscribe to a member's service using an RSVP link provided by an Administrator. Subscription grants you immediate access to 
any pages or content restricted to service subscribers.  

 1. Login to the site. "Logging into a Site".

 2. Enter the RSVP link into the Address window or your Web browser - OR - click on the RSVP link in an email message. E.g. 
http//www.domain.com/Default.aspx?rsvp=rsvpcode&portalid=0

 3. Logout and then Login to the site to gain access to the new services.

Unsubscribing from a Member Service
How to unsubscribe from a member's service. Unsubscribing from a service  removes your access to any modules or pages restricted to 
subscribers.

 1. Login to the site. "Logging into a Site".

 2. Click on your [Display Name] link (typically located in the top right corner of the site) - OR - Navigate to a View Profile (also called 
My Profile) module. This displays the user profile page.

 3. Click the Edit Profile link. This displays the Manage Profile page.

 4. Click the  Manage Services link. This displays a list of the available services.



 5. Click the Unsubscribe link beside the service you want to unsubscribe from. This displays the message  "You have suc-
cessfully unsubscribed from the [Service] role."

Unsubscribing from a Member Service

Working with Content
Minimizing and Maximizing Content
How to minimize or maximize module content. 

 l Click the Maximize    button to show content.

 l Click the Minimize  button to hide content. Only the title, header and footer are visible.

Tip: If you are logged in, these settings are remembered the next time you visit the site enabling you to customize the way you view dif-
ferent pages.

Printing Content
How to print module content. This option may not be available for all content.

 1. Click the Print  button (typically located in the bottom right corner of the module) - OR - Select   Print from the module actions 
menu. This opens a new Web browser with the content displayed in a print friendly format.

 2. Use the Print option on your new Web browser to print this content.



Content displayed in a Web browser ready to print

Subscribing to Syndicated Content
How to create an RSS feed of content. You can then subscribe to the feed and view it using Internet Explorer, or other RSS programs. 
This option may not be for all content. 

Tip: Display syndicated content using the News Feeds (RSS) module.

 1. Click the Syndicate  button  (typically located in the bottom right corner of the module) - OR - Select Syndicate from the mod-
ule actions menu. This displays the XML code for the module content.

You can now do one of the following:

 l Copy the URL from the Address bar of your Web browser and use as required.



 l Click the Subscribe to this feed link and complete the Subscribe to this Feed dialog box.

Tagging Page Content
How to add a tag to a page. This functionality is only available on sites where tagging has been enabled.



 1. Click the  Add Tags link (typically located at the base of each page).

 2. Enter the tag name into the text box.

 3. Click the  Save link. The newly added tag will now be listed at this field. 

Tip: Tags can be managed using the Taxonomy Manager module. See "About the Taxonomy Manager Module".

Tagging Page Content



Working with the DNN Control Panel
About the DNN Control Panels
DNN comes with a choice of two Control Panels called the RibbonBar  and the Iconbar which enable Content Editors (optional), Page 
Editors and Administrators  to access a range of page management tools and portal administrative tasks.            The RibbonBar is the default 
Control Panel in DNN6+.

Related Topics:

 l "Overview of the RibbonBar Control Panel".

 l "Overview of the Iconbar Control Panel".

 l "Configuring the Control Panel Options".

Overview of the RibbonBar Control Panel
The RibbonBar is the default Control Panel. It displays the Modules and Pages menus to users who are authorized to manage the cur-
rent page. The  Admin and Tools and menus are displayed to the Administrator and the Host menu is displayed to SuperUsers.

Permissions. In DNN Community Edition, user must have Edit Page permissions granted to access the modules and pages tool. The per-
missions required for Professional Edition are listed in the below tables.

The Admin Console
 See "About the Admin Console",

The Modules Console

Function Description Permissions (Com-
munity/Professional

Add New Mod-
ule Adds a new  module to the current page. See "Adding a New Module (RibbonBar)" Edit Content / Add Content

Add Existing 
Module

Adds a new instance of an existing module to the current page.  See "Adding an Exist-
ing Module (RibbonBar)" Edit Content / Add Content



The Pages Console
Note: In DNN Community Edition, user must have Edit Page permissions granted to access these tools. The permissions required for Pro-
fessional Edition Permissions are listed in the below table.

Function Description Permissions (Com-
munity/Professional)

Actions Section   

 Page Settings Link to edit current page settings. See "Editing Page Settings" Edit Page / Manage Settings

 Add Select to add a new page and configure setting. See "Adding a New Page via 
the Site Settings Page" Edit Page / Add Page

 Copy Select to copy the current (or any other) page including modifying modules. See 
"Copying a Page"See "Copying a Page" Edit Page / Copy Page

 Delete Link to delete current page. See "Deleting a Page"See "Deleting a Page"
Enabled if the current page is not a special page. Edit Page / Delete Page

 Import Link to import a page. See "Importing a New Page" Edit Page / Import Page

 Export Link to export a page.See "Exporting a Page" Edit Page  / Export Page

Copy Actions Section   

 Copy Permissions to Children Copy current page permission to children pages. See "Copying Permissions to 
Descendant Pages"Enabled if page has child pages. 

Administrator Only / Manage 
Settings

 Copy Design to Children Copy current page design (skin and container settings) to children. See "Copy-
ing Design to Children Pages" Edit Page / Manage Settings 

Add New Page Section   

Add New Page Add a new page directly from the Control Panel. See "Adding A New Page Vis-
ible to Administrators only using the RibbonBar" Edit Page  / Add Page

Update Current Page Section

Update Current Page Update the page name, menu options and skin for the current page. Edit Page  / Manage Settings



The Tools Console

The Tools menu of the RibbonBar as displayed to Administrators

Tool Description Role Restric-
tion

Common Actions Section  

 Add 
User Opens the Add User page. See "Adding a User Account"  

 Add 
Role Opens the Add Role page. See "Adding a Security Role (Basic Settings)"  

 Upload 
File Opens the upload file interface of the File Manager. See "Uploading Files"  

Help   

 Help Opens the Help resource for this site. Link (new window) to Help URL defined in Host Settings. See "Set-
ting the Online Help URL"  

Setting the RibbonBar Mode
How to select the mode that you view your site in.

Important. You cannot view the module menu which enables you to manage the modules on the current page if you are in View mode.

 1. Click on the Mode drop-down list and then select one of the following:

 l View: Select to view your site as a typical user without editing rights. This hides the module actions menu on all 



modules and disables the Tools menu.

 l Edit: Select to edit your site. This displays the module actions menu for all modules



 l Layout: Select to view the layout of the current page. This displays the pane layout of the skin applied to this page, 
the titles of all modules within each pane including the module actions menu.

Viewing the RibbonBar Management Menus
How to view the features associated with each section of the RibbonBar.

 1. Hover your mouse over either of the Admin, Modules, Pages or Tools links located on the top leftr-hand corner of the RibbonBar. 
This displays the management console associated with the chosen link. 



Tip: Click on the Admin link to view the Admin Console as a page rather than as a drop-down menu.

Overview of the Iconbar Control Panel
The Iconbar Control Panel provides a single interface from which authorized users can access page and module management tools, 
shortcuts to six common administration tasks and quick links to the Admin and Host Consoles.

Tip: Click the  Admin link (top right) to view the Admin Console page. 

The Iconbar Control Panel as displayed to Administrators

Page Functions Section
The Page Functions section (left) is accessible to Page Editors, Administrators and SuperUsers. It enables users to add new pages (See 
"Adding a New Page via the Site Settings Page"), edit settings for the current page (See "Editing Page Settings"), delete the current page 
(See "Deleting a Page"), copy the current page See "Copying a Page"), export the current page (See "Exporting a Page") and import a 
page (See "Importing a New Page"). Note: Page Editors will have access to one or more of these tools according to the permissions 
granted to them. Access will change depending on the permissions for the current page.

Module Insertion Section
The Module Insertion section (center) is accessible to Page Editors (users with Add Content or Full Control permissions in Professional 
Edition, or Edit Page permissions in DNN Community Edition) and Administrators. It enables these users to add new or existing modules 
as well as set the role visibility, title, pane and alignment of the module being added. See "Adding a New Module (RibbonBar)", "Adding 
an Existing Module (Iconbar)". and See "Adding an Existing Module (RibbonBar)"

Tip: Users must be authorized to deploy a module and be a page editor to add a module to a page.

Common Tasks Section
Page Editors can access this icon:

 l Help  button which links to the DNN Online Help URL set by the host. This option is disabled if no help link is provided.



Administrators can access these additional icons: 

 l  Site: Opens the Admin > Site Settings page. See "About the Site Settings Page"

 l  Users: Opens the Admin > User Account page. See "About the User Accounts Module"

 l  Roles: Opens the Admin > Security Roles page. See "About the Security Roles Module"

 l  Files: Opens the Admin > File Manager page. See "About the File Manager Module"

 l  Help: Opens the Online Help resource associated with the site.

 l  Extensions: Opens the Admin > Extensions page. See "About the Extensions Module"

Console Quick Links

 l Click the  Admin link (top right) to view the Admin Console page. This link is displayed to Administrators and SuperUsers.

Setting the IconBar Mode
How to set the mode of the Iconbar Control Panel.

 1. At Mode, select from the following options:

 l View: View the page with module editing tools hidden. This option shows you how the page appears to site visitors.

 l Edit: Displays all module editing tools available to the current user. E.g. Module menu, add/edit links, Settings button. 
Important.. This option must be selected to edit the page.

 l Layout: Displays the layout of page panes and any modules within those panes. Module content is hidden. This option 
enables you to view the design of the page skin without the distraction of module content.

Maximizing/Minimizing the IconBar
How to hide or display the IconBar using the Maximize/Minimize button. Permissions. This functionality isn't available to Module Editors. 
The default visibility is set by Administrators.

 1. In the top right hand corner of the Control Panel, select from these options:

 l Click the Minimize   button to hide the Control Panel.

 l Click the Maximize  button  to display the Control Panel.



About the Admin Console
The Admin Console can be accessed either by hovering over or clicking on the Admin link in the Control Panel. This area, which is only 
available to Administrators and SuperUsers, enables them to manage settings and tools for this portal. Note: The Admin page is hidden 
from the site navigation by default however it can be restored using the Pages module.

The Admin Console

Overview of the Admin Child Pages

Icon Page Name Description and tutorial Link
Site Set-
tings

The  Admin > Site Settings page displays the Site Settings module. This module cannot be deployed on site 
pages and is therefore only accessible to Administrators and SuperUsers. See "About the Site Settings Page"

Pages The  Admin > Pages page displays the Tabs module which enables full page management including the ability 
to modify page hierarchy. See "About the Pages (Tabs) module"

Extensions The  Admin > Extensions page displays the Extensions module which enables Administrators to manage exten-
sions which have been installed on the site by the Host. See "About the Extensions Module"

Languages

The  Admin > Languages page displays the Languages module which enables Administrators and authorized 
users to enable and manage the languages files associated with a site. See "About the Languages Module"

Tip: A large section of language packs are available from the DotNetNuke Web site and the DotNetNuke Mar-
ketPlace. 

Skins

The Admin > Skins page displays the Skins module, also titled the Skin Editor and the Skin Designer module. 
The Skin module, which can be deployed on any site page, enables authorized users to preview and apply 
skins to the site. The Skin Designer module, which cannot be deployed on site pages, enables Administrators to 
set container and skin token values. See "About the Skins Module" and "About the Skin Designer Module".

Security 
Roles

The  Admin > Security Roles page displays the Security Roles module which enables the management of secu-
rity roles as well as role assignment. See "About the Security Roles Module"

User 
Accounts

The  Admin > User Accounts page displays the User Accounts module which enables the creation and man-
agement of user accounts, as well as configuration of user settings relating to authentication. See "About the 
User Accounts Module"

Vendors
The Admin > Vendors page displays the Vendors module which enables the creation and management of ven-
dor accounts, vendor banners and affiliate accounts using the Vendors module. Vendor accounts and banners 
maintained under the Admin page are only available to this site. See "About the Vendors Module"

http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://marketplace.dotnetnuke.com/s-9-components.aspx
http://marketplace.dotnetnuke.com/s-9-components.aspx
http://marketplace.dotnetnuke.com/s-9-components.aspx
http://marketplace.dotnetnuke.com/s-9-components.aspx
http://marketplace.dotnetnuke.com/s-9-components.aspx


Icon Page Name Description and tutorial Link

Site Log The Admin > Site Log page displays the Site Log module which enables viewing of statistical reports for the site. 
See "About the Site Log Module"

 Newsletters The Admin > Newsletters page displays the Newsletters module which enables sending bulking email mes-
sages to individual email addresses and security roles. See "About the Newsletters Module"

File Man-
ager

The Admin > File Manager page displays the File Manager module which enables management of site files. See 
"About the File Manager Module"

Recycle Bin The Admin > Recycle Bin page displays the Recycle Bin module which enables users to restore or permanently 
delete pages and modules. This module can be deployed on site pages. See "About the Recycle Bin Module"

Event 
Viewer

The  Admin > Event Viewer page displays the Log Viewer module (also called the Event Viewer module) which 
provides a log of database events. See "About the Log Viewer Module"

Site Wizard
The  Admin > Site Wizard page  displays the Site Wizard module which enables authorized to view the module to 
configure basic site settings, page design as well as apply a template to the site using a simple step-by-step wiz-
ard. See "About the Site Wizard Module"

Google Ana-
lytics Pro

The  Admin > Google Analytics page displays the Google Analytics module which improves your site results 
online. See "About the Google Analytics Module"

Taxonomy The  Admin > Taxonomy page displays the Taxonomy Manager module. See "About the Taxonomy Manager 
Module"

Search 
Engine Site 
Map

The  Admin > Search Engine SiteMap page displays the Sitemap module. See "About the Search Engine Site-
Map Module"

Content 
Staging

The  Admin > Content Staging page displays the Content Staging module which enables users to publish con-
tent from a staging portal to a target (production) portal. See "About the Content Staging Module"

Only available in DotNetNuke Enterprise Edition

Tip: Click the Admin button in the main menu to go to the Admin page which displays icons linking to each child page.



Configuring Your Site Settings
About the Site Settings Page
The Site Settings page (Admin > Site Settings) enables Administrators to configure basic and advanced site settings including design, 
advertising, payment, DNN usability, and user registration settings, etc. Where two or more languages are enabled on a site, different site 
settings can be configured for each language as required.

Tip: To quickly configure the basic site settings and get started with building your portal, See "About the Site Wizard Module"

The Basic Settings tab of the Site Settings Module

Basic Settings
Site Details
Configuring your Site Details
How to view the GUID for your site and set the  site title, description, keywords and copyright notice.



Note 1: The copyright notice displays on pages where the applied skin contains the Copyright skin object. In the default DNN skin, the 
copyright notice appears at the bottom right of all pages.

Note 2: Title is the only required field.

 1. Navigate to  Admin >  Site Settings. 

 2. Go to  Basic Settings > Site Details.

 3. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 4. In the Title text box, enter a title for the site. This title displays in the title bar of the Web browser and is used in language files such 
as the privacy statement, terms of use, etc. Note: This title is also used as a tool tip when a user places their mouse over the site 
logo. See "Setting the Site Logo"

 5. In the Description text box, enter a description which will be used by search engines to index this site. 

 6. In the Keywords text box, enter one or more keywords separated by commas which will be used by search engines to index this 
site. E.g. toys,eco-friendly,organic toys,fair trade toys,fair labor toys,

 7. In the Copyright text box, perform one of the following:

 l Dynamic Copyright Notice: Leave the Copyright field blank to automatically display the current year and the site title as the 
copyright notice. E.g. If the title of your site is My Website, the copyright notice displays as 'Copyright (c) 2011 My Website'. 
If the Title field is also blank, then the copyright notice displays as              'Copyright (c) 2011'

 l Static Copyright Notice: Enter the copyright notice as you wish it to appear. This information will not update and doesn't 
include any site information. E.g. In the below image, the entered text is 'Copyright (C) 2005-2007 My Website'

 8. At GUID , you can view the GUID (globally unique identifier) which can be used to identify this site. Wikipedia defines a GUID as 
"a special type of identifier used in software applications in order to provide a reference number which is unique in any context 
(hence, "Globally"), for example, in defining the internal reference for a type of access point in a software application, or for cre-
ating unique keys in a database".

http://en.wikipedia.org/wiki/Globally_Unique_Identifier


 9. Click the  Update link.

Site Marketing
Submitting your Site to Search Engines 
How to submit the site to one or more search engines for indexing. This will add the site to the search engine's list of sites to be indexed.  

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Basic Settings > Site Details and ensure the Title, Description and Keywords fields are complete.

 4. Go to  Basic Settings > Site Marketing. 

 5. At Search Engine, select either the Google, Yahoo or Microsoft search engines.



 6. Click the Submit link.

 7. Repeat Steps 5-6 to submit your site to one or both of the other search engines. 

Tip: Page Editors and Administrator can also to add a title, description and keywords to each site page. The quality of this information will 
affect your ranking on search engines, therefore it is recommended that these fields are completed for all pages before submitting the 
site.

Submitting your Site Map URL to Google
How to submit a site map URL of your site to Google for improved search optimization.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"This field only displays when multiple languages are 
enabled.

 3. Go to the Basic Settings > Site Details section and ensure the Title, Description and Keywords fields are complete.

 4. Go to  Basic Settings > Site Marketing.

 5. At Site Map URL,  click the Submit link. This opens the Google Webmaster Tools web page in a new Web browser.

 6. On Google Webmaster Tools:

 a. If you do not have a Google Account, sign up for one.

 b. Sign in to Google Webmaster Tools with your Google account.

 c. Go to the Dashboard.

 d. In the Add Site text box, enter the URL of your site. E.g. http://www.domain.com/

 e. Click the OK button to confirm.

 f. Click the Verify link.

 g. Select Upload an HTML file. This will display a unique file name. Copy this name.

 7. Return to the Site Settings page:

 a. In the Verification text box, enter the file name.

 b. Click the Create link.

 8. Return to Google Webmaster Tools:

 a. Click the Verified button. 

 b. On the Google Sitemaps tab, select Add General Web Sitemap.

 c. Copy and paste the URL displayed into the Site Map URL text box on your Site Setting page.

Submitting your Site Map URL to Google



Signing up for AdWords
How to sign up to advertise the site on Google AdWords. Once you have signed up your text banners (maintained under Admin > 
Banners) appear in the Google search results as well as affiliate web site.

 1. Navigate to  Admin >  Site Settings. 

 2. Go to  Basic Settings > Site Marketing.

 3. At Advertise, click the Sign up for AdWord link. This goes to the Google Adwords Web site.

 4. Click the Start Now button and complete the Sign-up steps. View the Sign-up demos on this page for full details.

Enabling/Disabling Banner Advertising
How to enable or disable site wide banner advertising. If this feature is enabled, a single banner is displayed on each site page where 
the skin object [Banner] is included in the page skin design.  The banner displayed changes to a new banner each time a page is 
refreshed or revisited. Note: This feature only works for banners whose type is set as 'banner'.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Basic Settings > Site Marketing.

 4. At Banners, select from these options:

 l None: Select to disable banner advertising.

 l Site: Select to enable banner advertising for vendors maintained on this site under Admin > Vendors, or using a Vendors 
module which has been added to a page.

 l Host: Select to enable banner advertising for vendors maintained on this installation under Host > Vendors. 

 5. Click the  Update link.

Banner Advertising set as Disabled

Appearance
Setting the Site Logo
How to set the logo for this site as well as update the favorite icon.  The site logo displays on pages where the applied skin contains the 
Logo skin object. A site logo is typically displayed in the top left corner of all site pages, as it is in the default DNN skins.



 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Basic Settings > Appearance.

 4. At Logo, select from these options:

 l Select an existing file by selecting the Folder where the file resides, and then selecting the required file from the File drop-
down box.

 l Upload a new file by clicking the Upload File link; clicking the Browse... button and selecting the file from your computer, 
and then clicking the Save File link. The uploaded file is automatically selected.

 5. Click the  Update link.

The Site Logo

Setting the Body Background
How to set the background image to be tiled on all pages of this site. If the background has been set in the skin, this setting will be over-
ridden.  Upload the image to the Admin > File Manager. 

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"



 3. Go to  Basic Settings > Appearance.

 4. At Body Background, select from these options:

 l Select an existing file by selecting the Folder where the file resides, and then selecting the required file from the File drop-
down box.

 l Upload a new file by clicking the Upload File link; clicking the Browse... button and selecting the file from your computer, 
and then clicking the Save File link. The uploaded file is automatically selected.

 5. Click the  Update link.

Setting the Favicon
How to set the favicon  for your site. A favicon (short for favorites icon)  is an icon file, most commonly 16x16 pixels, associated with a par-
ticular Web site or web page.  A web designer can create such an icon and install it into a web site (or web page) by several means, and 
graphical web browsers will then make use of it. Browsers that provide favicon support typically display a page's favicon in the browser's 
address bar and next to the page's name in a list of bookmarks. Browsers that support a tabbed document interface typically show a 
page's favicon next to the page's title on the tab, and site-specific browsers use the favicon as desktop icon. The favicon is an important 
aspect of a site's brand identity and is an important attribute which needs to be customized for marketing purposes.

Note 1: If no favicon is set and there is a favicon.I Co file in the root of the site (not portal) that favicon.Ico will be detected by browsers and 
used. We ship with a favicon.I Co in the root by default.

Note 2: Only files with an *.ico extension can be selected at this field, as these are the only files supported by Internet Explorer.

 1. Navigate to  Admin >  Site Settings. 

 2. Go to  Basic Settings > Appearance.

 3. At Favicon.ico, select from these options:

 l For no favicon: Select  <None Specified> from the File drop-down box.

 l To select an existing file: Select the Folder where the file resides and then selecting the required file from the File drop-
down box.

 l To upload a new file: Click the Upload File link; clicking the Browse... button and selecting the file from your computer, 
and then clicking the Save File link. The uploaded file is automatically selected.

 4. Click the  Update link.



Enabling/Disabling Skin Widgets
How to enable or disable widget functionality in skins. Enable this setting to enable JavaScript/HTML widgets that have been included in 
skins. The skin widget field is associated with the Widget skin object.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Basic Settings > Appearance.

 4. At Enable Skin Widgets, select from these options:

 l Check   the check box to enable skin widgets.

 l Uncheck  the check box to disable skin widgets.

 5. Click the  Update link.

Setting the Default Portal Skin and Container
How to set the default skin which is applied to all site pages including the Admin pages, as well as the container which is applied to all 
existing and new modules on these pages.

Note 1: The page skin can be overridden for individual site pages as can the containers on that page. See Page Settings - Page Man-
agement for more details. See "Advanced Settings for Existing Pages"

Note 2: The container can be overridden for an individual module by setting the Module Container field. See "Configuring Advanced 
Page Settings for a Module"

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Basic Settings > Appearance.

 4. At Portal Skin, select the required skin from the drop-down list.

 5. At Portal Container, select the required container from the drop-down list. 

 6. Optional. Click the Preview Portal Skin and Container link to preview the selected skin and container in a new Web browser.

 7. Click the  Update link.

Setting the Default Portal Edit Skin and Container
How to set the skin  which is applied to the editing pages of the site and the container which is applied to the modules on those pages. 
E.g. module editing pages, module settings pages, page settings pages, etc.

Tip: Choose a skin and container with minimal design and images to speed up editing time!



 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Basic Settings > Appearance.

 4. At Edit Skin, select the required skin from the drop-down list.

 5. At Edit Container, select the required container from the drop-down list.

 6. Optional. Click the Preview Portal Skin and Container link to preview the selected skin and container in a new Web browser.

 7. Click the  Update link.

Advanced Settings
Page Management
Enabling/Disabling a Splash Page
How to enable or disable a Splash page for this site. When a visitor first comes to the standard URL of your site, that is the main URL 
(E.g. http://www.domain.com or http://www.domain.com/default.aspx) rather than a specific page (E.g. http://ww-
w.domain.com/ContactUs/tabid/103/Default.aspx) the Splash page is displayed.

A Splash page must be created by a Page Editor or an Administrator. The Splash page is typically not included in the site menu. The 
Splash page should include some form of redirection to one or more site pages. This can be done by adding a link to a site pages, or add-
ing a Flash animation with an automatic redirect feature to the Splash page.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.

 4. At Splash Page, select from the following options:

 l To set the splash page, select the page name from the drop-down list.

 l To disable the splash page, select <None Specified>.



 5. Click the  Update link.

A Sample Splash Page

Setting the Home Page
How to set any page as the Home page of this site. Visitors are taken to the Home page when they navigate to the URL of the site (E.g. 
http://www.domain.com or http://www.domain.com/default.aspx), unless a Splash page is displayed. Visitors are also taken to the Home 
page when they click on the site logo. If a Home page is not set, the page located on the far left or top of the menu is the default Home 
page.

Tip 1: You cannot delete the page set as the Home page. To do so, you must first select a new home page or select None Specified. 

Tip 2: If this setting is set to None Specified, you can delete any site page (unless they are set as one of the other special pages) includ-
ing the page named 'Home'.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.



 4. At Home Page, select from the following options:

 l To set the Home page, select the page name from the drop-down list.

 l To use the default Home page, select <None Specified>.

 5. Click the  Update link.

Enabling a Custom Login Page
How to set any page as the Login page for the site. This setting enables you to create a custom Login page rather than using the default 
login page which only displays the Account Login module. If a Login page is not set, the default Login page is used. The default login 
page requires the Login skin object to be included in the skin.

Warning: Do not apply this setting without first adding an Account Login module to the page you are selecting and ensure the page is 
available to All Users. If you have logged out of the portal and do not have an Account login module viewable by 'All Users' you will be 
unable to log in again. If this occurs, enter your portal URL into the address bar of your Web browser and add 
Default.aspx?tabid=1&ctl=Login at the end of the URL. E.g. http://www.domain.com/Default.aspx?tabid=1&ctl=Login. This will display the 
default login page. 

 1. Add a new page to your site (E.g. Login page). Your Login page must include the following:

 l Ensure the View Page Permissions enable All Users to view the page.

 l Ensure an Account Log In module is added to the page.

 2. Navigate to  Admin >  Site Settings. 

 3. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 4. Go to  Advanced Settings > Page Management.

 5. At Login Page, select the name of the Login page you created from the drop-down list.



 6. Click the  Update link.

Restoring the Default Login Page
How to restore the default Login page to the site.

Warning: The Login skin object must be included in the Portal Skin to access the default login page. Don't restore the default Login page 
if you are using a custom Portal Skin that doesn't include this skin object.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.

 4. At Login Page, select <None Specified>.

 5. Click the  Update link.

Setting a Custom Registration Page
How to set a custom  registration page for this site. This page enables visitors to register for a new account.

Warning. Do not apply this setting without first creating a registration page.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.



 4. At Registration Page, select the registration page you created from the drop-down list. E.g. Register

 5. Click the  Update link.

Restoring the Default Registration Page
How to restore the default user registration page to this site.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.

 4. At Registration Page, select <None Specified>.

 5. Click the  Update link.

Setting a Custom User Profile Page
How to create and set a custom  user profile page for this site. The user profile enables authorized users to maintain their user cre-
dentials, profile, password and services. In addition, users manage messages from and to other site members using the Messaging mod-
ule, and manage modules they are authorized to using the My Modules module. Only available in DotNetNuke Professional 
Edition

Warning. Do not apply this setting without first creating a User Profile page. 

 1. Create a User Profile page:



 a. Create a new page to your site (E.g. Profile), ensuring permission to view the page is granted to All Users. You may like to 
set the page as not included in the menu. See "Adding a New Page via the Site Settings Page"

 b. Important. Add a View Profile module to the page. See "Adding a New Module (RibbonBar)"

 c. Add other modules and content as desired.

 2. Set the custom user profile page:

 a. Navigate to  Admin >  Site Settings. 

 b. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when 
multiple languages are enabled. See "Viewing a Site in a Secondary Language"

 c. Go to  Advanced Settings > Page Management.

 d. At User Profile Page, select the user profile page you created from the drop-down list.

 e. Click the  Update link.

Restoring the Default User Profile Page
How to restore the default user profile page of this site.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.

 4. At User Profile Page, select User Profile.

 5. Click the  Update link.

Setting the Search Results Page
How to set a custom or a default search results page for  this site using the Site Settings page.

 1. Navigate to  Admin >  Site Settings. 

 2. Go to  Advanced Settings > Page Management.



 3. At Search Results Page, select from the following options:

 l To set a custom search results page, select the page name from the drop-down list.

 l To use the default search results page, select <Search Results>.

 4. Click the  Update link.

Related Topics:

 l See "Configuring Search Crawler  Modules for Upgrade Portals"

Viewing the Home Directory
How to view the Home Directory used for the storage of files in this site as configured when the site was created. The Home Directory can-
not be modified.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Page Management.

 4. At Home Directory, the home directory is displayed.

Viewing the Home Directory

Security Settings
Enabling/Disabling User Registration
How to disable or enable site visitors to apply to become a registered user of the site.  Enabling user registration displays the Register link  
on pages where the applied skin contains the Register skin object.



 1. Navigate to  Admin >  Site Settings. 

 2. Optional. At Select Language, select which language you wish to update. This field only displays when multiple languages are 
enabled.

 3. Go to  Advanced Settings > Security Settings.

 4. At User Registration, select from the following:

 l None: Registration is disabled.

 l Private: Registering visitors can apply to become a site member. This creates a user account for them, however access to 
the Registered User role is restricted until the account is authorized ( See "Authorizing an Unauthorized User" ). Note: The 
Primary Administrator receives email notification of each new registration.

 l Public: Registering visitors gain immediate access to the Registered User security role.

 l Verified: Access to the Registered User role is conditional on the user verifying their account by entering a verification 
code the first time they log in to the site. The verification code is emailed to them in a welcome email when they register, 
thereby verifying the user's email address.

 5. Click the  Update link.

Setting the Primary Administrator
How to set which user in the Administrator role is the primary administrator for this site. This Administrator receives email notification of 
member activities such as new registrations, unregistered accounts and feedback submitted using the Feedback module (unless this is 
overridden on the Feedback module).

Tip: To create new Administrators, add a new user account ( See "Adding a User Account" ) and then add the user to the Administrators 
security role ( See "Managing User Roles" ).

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Security Settings.

 4. At Administrator, select the  display name of the required administrator.



 5. Click the  Update link.

Setting the Portal TimeZone
How to set which time zone is the default for this site. This sets all time related information on this site including the default setting for the 
current time and date ( [DateTime:Now] ) replacement token. See "Replacement Tokens" for more details.

 1. Navigate to  Admin >  Site Settings. 

 2.  Optional. At Select Language, select which language you wish to update. This field only displays when multiple languages are 
enabled.

 3. Go to  Advanced Settings > Security Settings.

 4. At Portal TimeZone, select the time zone for the location of this site.

 5. Click the  Update link.

Payment Settings
Setting the Payment Processor
How to configure payment processing for this site. This enables you to receive payment from users who subscribe to Member Services 
(roles) on this site.  PayPal is the only payment processor included by default, however your DNN developer can configure DNN to work 
with other providers. PayPal is used as the example in this topic.

Tip: Enabling the sandbox allows test orders to be sent to the payment gateway without taking live transactions.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"



 3. Go to  Advanced Settings > Payment Settings.

 4. At Currency, select the currency to process payments with.

 5. At Payment Processor, select a payment processing company from the drop-down list. E.g. PayPal

 6. Click Go To Payment Processor WebSite and sign up for an account.

 7. In the Processor UserId text box, enter the UserID code provided by PayPal.

 8. In the Processor Password text box, enter the Password provided by PayPal.

 9. Optional. In the PayPal Return URL text box, enter the page URL that subscribers are redirected to after payment. Leave blank to 
return to the Home page.

 10. Optional. In the PayPal Cancel URL text box, enter page URL that subscribers are redirected if payment is canceled. Leave blank 
to return to the Home page.

 11. At Use Sandbox?, select from these options

 l Check   the check box to enable PayPal Sandbox.

 l Uncheck  the check box to disable Sandbox and enable live transactions.

 12. Click the  Update link.

Usability Settings
Enabling/Disabling Inline Editing
How to enable pop-up edit pages throughout this site, or to navigate to a new page for editing.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings > Usability Settings.

 4. At Enable Pop-Ups?, select from these options:

 l Check   the check box to enable pop-ups.



 l Uncheck  the check box to use separate edit pages.



 5. Click the  Update link.

Enabling/Disabling Inline Editing
How to enable or disable inline editing. Inline editing enables authorized users to perform basic editing of HTML module content directly 
on the web page. It also enables inline editing of all module titles. Inline editing doesn't affect the standard method for editing content and 
module titles.



 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings >  Usability Settings.

 4. At Inline Editor Enabled?, select from these options:

 l Check   the check box to enable inline editing.

 l Uncheck  the check box to disable inline editing.

 5. Click the  Update link.

Editing content inline

Inline editor enabled for module title editing

Hiding System Folders
How to prevent or allow adding  hidden folders or folders that start with underscore when performing folder  synchronization.



 1. Navigate to  Admin >  Site Settings. 

 2. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 3. Go to  Advanced Settings >  Usability Settings.

 4. At Hide System Folders, select from these options:

 l Check   the check box to prevent adding hidden and underscore folders.

 l Uncheck  the check box to allow.

 5. Click the  Update link.

Configuring the Control Panel Options
How to configure the default settings for the Control Panel. When an authorized user uses the control panel, the mode and visibility are 
personalized so that they remain set however they were last used by that user.

 1. Navigate to  Admin >  Site Settings. 

 2. Optional. At Select Language, select which language you wish to update. This field only displays when multiple languages are 
enabled.

 3. Optional. Click on the country flag icon associated with the culture (language) to be updated. This field only displays when mul-
tiple languages are enabled. See "Viewing a Site in a Secondary Language"

 4. Go to  Advanced Settings >  Usability Settings.

 5. At Control Panel Mode, select either the View or Edit mode.

 6. At Control Panel Visibility, select to display the control panel as either Minimized or Maximized.



 7. At Control Panel Security, select from the following options to set which editors (Page Editors and Module Editors, or Page 
Editors only) can view the Control Panel. Tip:  Module Editor is any user authorized to edit module content, manage module con-
tent, etc. A Page Editor is any user authorized to create and manage pages and page settings.

 l Page Editors: Select this option to display the Control Panel to Page Editors only.

 l Module Editors: Select this option to display the Control Panel to both Page Editors and Module Editors. This enables 
these users to view the site in either View or Edit  mode.

 8. Click the  Update link.

Stylesheet Editor
About the Stylesheet Editor
DNN uses a CSS (cascading style sheet) to control the fonts, styles and colors applied across the portal. The CSS maintained in this 
editor is the default CSS applied to all portal pages. Where a skin package containing a CSS file is applied to a page or the site, this CSS 
will override the CSS maintained on the Admin > Site Setting page.

For information on using CSS, visit http://www.w3.org/Style/CSS/

The DNN Stylesheet Editor

Editing the Stylesheet
How to edit and save changes to the default stylesheet. This doesn't affect any styles that are part of a skin package uploaded to this site.

http://www.w3.org/Style/CSS


 1. Navigate to  Admin >  Site Settings. 

 2. Select the Stylesheet Editor tab.

 3. In the multi-line text box, edit the current stylesheet.

 4. Click the Save Style Sheet link.

 5. Hold down the Ctrl button and press the F5 button - OR - Click the Refresh button on your Web browser to view the changes.

Editing the Stylesheet

Restoring the Default Stylesheet
Restore the default stylesheet to the site. Any modifications to the stylesheet on this page will be deleted. The portal uses a CSS (cas-
cading style sheet) to control the fonts and colors applied across the site. Note: this will not affect any stylesheets that are part of a skin 
package.

 1. Navigate to  Admin >  Site Settings. 

 2. Select the Stylesheet Editor tab.

 3. Click the Restore Default Style Sheet link. This displays the  message "Are You Sure You Want To Restore The Default Stylesheet 
(All Changes To The Current Stylesheet Will Be Lost)?"

 4. Click the OK button to confirm.

 5. Hold down the Ctrl button and press the F5 button - OR - Click the Refresh button on your Web browser to view the changes.



Restoring the Default Stylesheet



Building Your Portal
Quick Start to Building a Portal
Creating the content for a DNN site is as simple as adding pages, adding modules and then adding content to those modules. 

For a quick start to adding pages and content to your DNN site:

 l See "About the Site Wizard Module", to configure basic site settings, page design as well as apply a template to the site using a 
simple step-by-step wizard.

 l See "Adding A New Page Visible to Administrators only using the RibbonBar"

 l See "Adding a New Module (RibbonBar)"

 l See "Adding Module Content"

If your site will be managed by multiple users or if you wish to create areas which are restricted to specific users, such as staff members 
or customers, see these areas:

 l See "Controlling Site Access"and related tutorials in the Advanced Site Management > Users and Roles section of this manual.

Key Concepts
About DNN Pages

DNN sites are created by adding one or more pages to the site and then adding content (using modules) to each page. Members of the 
Administrator and SuperUser security roles can add pages. Other users can be can also be given permission to manage the settings of 
specific pages and create new pages as children of those pages. See "Setting Page Permissions".

DNN also includes special pages which enable Administrators to manage their site.

The below image displays a site with four publicly accessible pages (Home, Services, Products and Contact Us) as well as the Admin 
and Host pages.



About Modules

DNN uses a modular design system to display content on a page. One or more modules are added to each site page to create and man-
age the site content.  There are many different types of modules, each managing a different type of site content or site administrative 
tasks. 

Your Host can install additional modules. Additional modules can be purchased from the DotNetNuke Store (Snowcovered.com).

http://www.snowcovered.com/Snowcovered2/Default.aspx


Web site with the Account Login, HTML and Search Input modules

Role Based Access

Access to view and manage the content (pages and modules) and settings of all portals is controlled using role based access. By asso-
ciating a user's account with one or more roles (also called Security Roles) you can permit or deny them access to view and/or edit site 
pages and modules. 

Here is a brief overview of User Accounts and Roles (also called Security Roles) in DNN: 

Working with User Accounts

 l Administrators and authorized users can create user accounts for any person. See "Adding a User Account"

 l Administrators can enable site visitors to register themselves for a user account. See "Enabling/Disabling User Registration" and 
other topics in this section.

 l Once a user has an authorized user account, they can access all pages and modules that are restricted to members of the Reg-
istered Users role. 

 l Individual users (including unauthorized users) as well as role members can be granted a range of permissions to manage the 
content and settings of pages and modules. See "Page Details Settings for Existing Pages", and "Setting Module Permissions".

About the Site Wizard Module
The Site Wizard module enables all users who are authorized to view the module to configure basic site settings, page design as well as 
apply a template to the site using a simple step-by-step wizard.

Permissions. All users who are authorized to view the Site Wizard module can complete all steps of the wizard, however they require 
permission to select or change the site logo.



Using the Site Wizard
How to use the Site Wizard module which is located on the Admin > Site Wizard page and can be added to any site page.

Tip: All settings of the Site Wizard are option so you can click the  Next link to skip any page.

Step 1 - Site Configuration Wizard

 1. Optional. Read the introductions.

 2. Click the   Next link.

Step 2 - Choose a Template for your site

This step enables you to choose a template for your site. Templates contain pages with modules which may or may not include content.  



 1. At Build your site from a template (below), check   the check box. This displays a list of the available templates. 

 2. Click on the name of a template to select it. This displays a description of the selected template. 

 3. Choose one of the following options to set how duplicate modules will be handled: 

 l Ignore: Places a copy of any duplicated modules on the same page. 

 l Replace: Deletes the existing copy of the duplicate content and replaces it with the  template copy. 

 l Merge: Combines the existing information and template information into one module.

 4. Click the   Next link.



Step 3 - Select a Skin for your Site

How to select a new skin to be applied to the site pages. This will not override settings on individual pages.

Tip: From this page onwards, you can click the  Previous link to return to any of the previous pages of the Site Wizard

 1. Optional. To preview a skin, click on the thumbnail image (where provided). This displays a larger image of the skin in a new Web 
browser. 

 2. Select a skin.

 3. Click the   Next link.

Step 4 - Choose a Default Container for your site

How to select new default containers for modules on the site. This doesn't override module setting which have been set for individual 
modules.

 1. If you selected a skin at Step 3, the matching containers are displayed here and the default container is pre-selected. 

 2. Optional. Check  the  Show All Containers check box to view all of the available containers.



 3. Optional. To preview a container click on a thumbnail image (where provided). This displays a larger image of the container in a 
new Web browser.

 4. Select a container.

 5. Click the   Next link.

Step 5 - Add Site Details

How to enter or edit the site details for this site. These are the default details used by search engines to index your site.  

 1. In the Name/Title text box, enter the name or title to be applied to the site. This will show in visitor's Web browser title. 

 2. In the Description text box, enter description to be applied to the site. This will be the description that Internet search engines will 
display to visitors. The site must be submitted to these search engines. 

 3. In the KeyWords text box, enter keywords to be applied to the site. This will be what the Internet search engines look for if you 
choose to submit your site to them.

 4. At Logo, select or upload a logo.  Note: You must be logged in or have permissions to upload/select files.



 5. Click the  Finish link. A message reading "If you changed the skin for your site, it should change when you leave this page" is 
displayed. 

 6. Click on the Home  page (or any other site page) to view any skin or module changes and to view any new pages or modules 
added using a template.

Related Topics:

 l See "Setting a File Link"

 l See "Uploading and Linking to a File"

Pages
About Pages
DNN sites are created by adding one or more pages and then adding modules which display content onto those pages.

Pages can be created and managed using the Control Panel, or using the Pages module. 

Important. Only the Control Panel tools are covered in this section. See "About the Pages (Tabs) module". for details on its additional 
functionality.

Viewing Any Page
How to view any page within a site, including those which are not included in the menu.



 l Option One: If the page is included in the menu, then navigate to the page using the site menu.

 l Option Two: If the page is not included in the menu click on a link to the page. Authorized users can create a page link using the 
Links module. See "Setting a Page Link"

 l Option Three: See "Viewing any Page (Pages Module)"

Adding A New Page Visible to Administrators only using the RibbonBar
How to add a new page to a site using the RibbonBar. Page added using this method are only visible to Administrators. 

Note: If content localization is enabled, this task adds a page which is a neutral culture and will be the same for all languages. This topic 
assumes you are viewing the site in its default language.

Name is the only required field. If you accept all default settings the new page will be added to the menu to the right of the page you were 
located on at Step 1. Pages added using this tutorial are only visible to Administrators, allowing you to add content to the page before set-
ting it as viewable by one or more user roles. See "Setting Page Permissions"

 1. Hover over the Pages link until the Control Panel displays.

 2. Go to the Add New Page section.

 3. In the Name text box, enter a name for the page. This is the name which appears in the menu.

 4. Optional. At Template, select a page template. Page templates add one or more modules with optional content to the page - OR - 
Select No template. The Default template included with DNN adds a HTML module without any content into the Content Pane.

 5. Optional. At Insert, select from these options:

 l Skip this step to add the page after (to the right of) the page you are currently on.

 l Select to add the page either Before (to the left of) or After (to the right of) the page name selected in the second drop-
down box. 

 l Select to add the page as a Child Of the page name selected in the second drop-down box.

 6. Optional. At Include In Menu, check  the check box to include this page in the menu - OR - Uncheck  the check box to hide 
the page in the menu. Note: You can provide users another way to navigate to the page by adding a link to that page using the 
HTML or Links module. Administrators can navigate to the page using the Pages module.

 7. Click the Add Page button.



Adding a New Page using the RibbonBar

Adding a New Page via the Site Settings Page
How to add a new page to a site. This topic shows how to add a page with only the basic settings configured.

Page Name is the only required field. If you accept all default settings the new page will be added to the menu to the right of the page you 
were located on at Step 1. Pages added using this tutorial are only visible to Administrators, allowing you to add content to the page 
before setting it as viewable by one or more user roles.

 1. Hover over the Pages link until the Control Panel is displayed and then select  Add from the Actions section. Note: If you are 
using the Iconbar,  select the  Add link from the Page Functions section.



 2. In the Page Name text box, enter a page name as it will appear in the menu. This is the only required field. If you choose to 
update the new page now this will accept all the defaults and add a page in a neutral language.

 3. Recommended. Complete the remaining optional page details for this page. See "Page Details Settings for New Pages"

 4. Optional. Select the Permissions tab to set which users can view this page. ( See "Setting Page Permissions" ). The default per-
missions is visible and editable by Administrators only. Note: If permissions are not displayed, this means you are not authorized 
to manage permissions. In this scenario, the new page will inherit permissions from its parent page.

 5. Optional. Select the Advanced Settings tab and complete any of the optional advanced page settings. "Advanced Settings for 
New Pages".

 6. Optional. In the Localization section, select the required option. See "Localization Settings for New Pages"

 7. Click the  Update link.

Related Topics:

 l See "Adding a New Page (Default Language)"

Updating Current Page
How to update some basic settings for the current page using the RibbonBar. This tutorial enables Page Editors to update the page 
name, change the visibility of the page in the menu, disable the page link, or change the page skin. Administrators can also change the 
location of the page in the menu.

 1. Go to the required page. See "Viewing Any Page".

 2. Hover over the Pages link until the Control Panel is displayed.

 3. Go to the Update Current Page section and update any of these optional settings.



 4. In the Name text box, edit the page name if required.

 5. At Insert, select from these options to change the page location in the menu:

 l Skip this step to add the page after (to the right of) the page you are currently on.

 l Select to add the page either Before (to the left of) or After (to the right of) the page name selected in the second drop-
down box. 

 l Select to add the page as a Child Of the page name selected in the second drop-down box.

 6. At Include In Menu, check  the check box to include this page in the menu - OR - Uncheck  the check box to hide the page in 
the menu. Note: You can provide users another way to navigate to the page by adding a link to that page using the HTML or Links 
module. Administrators can navigate to the page using the Pages module.

 7. At Disabled, check  the check box to disable clicking on this page - OR - Uncheck  the check box to enable.

 8. Click the Update Page link.

Moving Page Location (IconBar)
How to move a page to a new location on the site menu using the IconBar Control Panel.

Admin Tip: Additional options are available to Administrators. See "Moving Page Position in Menu".



 1. Go to the required page. See "Viewing Any Page".

 2. Go the Page Functions section and then select  Settings.

 3. Go to the Basic Settings - Page Details section.

 4. At Parent Page, select a new parent page, or select <None Specified> to change this page to a parent page.

 5. Click the  Update link.

Copying a Page
How to copy any existing page including the modules and optional module content. 

Note: Page Name is the only required field.      If you don't set new permissions, then the page will be visible and editable by Administrators 
only. Note: If permissions are not displayed, this means you are not authorized to manage permissions. In this scenario, the new page 
will inherit permissions from its parent page.

Also note that if you are on a Page with a different locale setting you will not be able to copy the page.

 1. Optional. Navigate to the page you want to copy.

 2. On the RibbonBar, hover over the Pages link until the Control Panel displays and then select  Copy from the Actions section. 

This opens the Page Details tab of the Page Settings page. Note: For the Iconbar,  select  Copy from the Page Functions sec-
tion.

 3. In the Page Name text box, enter a name for the new page. The page name is displayed in the menu.

 4. Recommended. Complete the additional basic settings for this page. "Page Details Settings for New Pages".

 5. At Copy From Page, select the page be copied. If you selected a page at Step 1 it will be displayed here.



 6. At Specify Modules, complete the following fields from left to right for each module listed:

 a. Check    the check box (typically located to the left of the module title) beside the module title to be copied to the new 
page - Uncheck    the check box beside any module you do NOT want copy.

 b. Optional. In the  text box where the Module Title is displayed, edit the title if required. 

 c. In the next field you can view the name of the pane where the module will be inserted.

 d. Set the content option for this module:

 l New: Select to add the module without any content.

 l Copy: Select to add the module with an independent copy of the module content. Modifying copied content doesn't 
update the content of the original module. Note: This option will be disabled for modules which don't have content 
which can be copied such as the Feedback and Account Login modules.

 l Reference: Select to add the module with a referenced version of the copied content. If you modify the content on 
either instance this module in the future, the content on both copies of the module are updated.

 7. Optional. Select the Permissions tab to set which users can view this page. See "Setting Page Permissions"

 8. Optional. Select the Advanced Settings tab and complete any of the optional advanced page settings. See "Advanced Settings 
for New Pages",

 9. Optional. In the Localization section, select the required option. See "Localization Settings for New Pages"

 10. Click the  Update link. You are now taken to the new page.

Copying Design to Children Pages
How to copy the design applied to a page to all of its child (descendant) pages. This applies the Page Skin and Page Container settings 
of the parent page to all child pages. This setting is only available for existing pages with child pages.

Using the Ribbonbar

 1. Navigate to the parent page whose design you want to copy.

 2. On the Control Panel, hover over the Pages link until the Control Panel displays.

 3. In the Copy Actions section, select  Copy Design to Children. This displays the message "Skin and container will be replaced 
for all children of this page. Are  you sure you want to continue?"

 4. Click the Yes button to confirm.

Using the Iconbar

 1. Go to the required page. See "Viewing Any Page".

 2. Go the Page Functions section and select           Settings. This opens the Page Settings page.



 3. Go the Advanced Settings - Appearance section.

 4. At Copy Design to Descendants, click the Copy Design link.

 5. Click the  Update link.

Editing Page Settings
How to edit the settings of the current page via the Control Panel

 1. Go to the required page. See "Viewing Any Page".

 2. Hover over the Pages link until the Control Panel is displayed.

 3. Edit page settings as required. See "Page Details Settings for Existing Pages", and                "Advanced Settings for Existing Pages".

 4. Click the  Update link.

Tip: If you are using the Iconbar, select the  Settings link from the Page Functions section.

Accessing Page Settings using the Iconbar



Copying Permissions to Descendant Pages
How to copy the permissions applied to a parent page to all of its descendant (child) pages. This applies the Permissions set for viewing 
and editing pages. This setting is only displayed for pages with existing child pages.

Using the RibbonBar

 1. Navigate to the parent page whose design you want to copy.

 2. On the Control Panel, hover over the Pages link until the Control Panel displays.

 3. In the Copy Actions section, select  Copy Permissions to Children. This displays the message "Skin and container will be 
replaced for all children of this page. Are  you sure you want to continue?"

 4. Click the Yes button to confirm.

Using the Iconbar

 1. Navigate to the required parent page.

 2. Maximize the Control Panel.

 3. Go the Page Functions section and select  Settings.

 4. Go the Basic Settings - Page Details section.

 5. At Copy Permissions to Descendants, click the Copy Permissions link.

 6. Click the  Update link.

Exporting a Page
How to export a page which will be saved as a page template which can then be imported into any DNN site.

 1. Navigate to the required page. "Viewing Any Page".

 2. On the RibbonBar, hover over the Pages link until the Control Panel displays and then select  Export from the Actions section - 

OR - For the Iconbar, select  Export from the Page Functions section. 

 3. At Folder, select a folder of the site's File Manager where the exported page will be stored.

 4. In the Template Name text box, the name of the exported page is displayed. You can either use this as the name of the page tem-
plate or change it to a new name.

 5. In the Description text box, enter a description of the page you are exporting. This description is exported with the page template. 
Typically the description provides a brief overview of the page and (if included) it's content.



 6. Optional. At Include Content?, check    the check box to include module content - OR - Uncheck   the check box to add the 
modules without any content. 

 7. Click the Export   button. 

 8. The path where the page template has been created is now displayed.

Importing a New Page
How to add a new page using the Import function. This enables you to apply a page template that has previously been exported.  The 
new page is added to the site before user can change the page settings. 

 1. On the RibbonBar, hover over the Pages link until the Control Panel displays and then select  Import from the Actions section. 

For the Iconbar, select  Import from the Page Functions section.

 2. At Folder, select the folder of your File Manager where the template is located. This enables the template field below and pop-
ulates the drop-down list with all templates within this folder.

 3. At Template, select a template from the drop-down list.  This displays a description of the selected template providing more details 
of the template. 

 4. At Import Mode, select Create A New Page.

 5. In the Page Name text box, the name of the template will be displayed. You can choose to enter a new page name or use this 
name,



 6. At Parent Page, select <None Specified> to set this page as a parent page - OR - Select the parent page from the drop-down 
box. Note: Page Editors can only select parent pages which they are editors of.

 7. At Insert Page, select from these options to choose the location of the new page in the menu:

 l Select a page from the drop-down box and then select to add the new page either Before or After that page in the menu 
on the current level.

 l Select Add to End to add the new page to the end of the menu on the current level. 

 8. At Redirect Mode? select from the following options to set where you will be redirected to once you complete this importing:

 a. Select View Imported Page to be redirected to the newly created page upon creation (Import).

 b. Select Edit Imported Page to be redirected to the Page Settings page of the newly created page upon creation (Import). 
This enables you to configure the page settings immediately.

 9. Click the Import link.

Importing a New Page

Tip: View the new page to ensure that any modules that are set to display on all pages are not duplicated. This may occur if the selected 
template includes modules that are displayed on all pages. 

Replacing the Current Page with a Page Template (Import Page)
How to replace the modules on the current page with a page template.



 1. On the RibbonBar, hover over the Pages link until the Control Panel displays and then select  Import from the Actions section - 

OR - For the Iconbar, select  Import from the Page Functions section.

 2. At Folder, select the folder of your File Manager where the template is located. This will enable the template field below and pop-
ulate the drop-down list with all templates within this folder.

 3. At Template, select a template from the drop-down list.  The description of the selected template will be displayed providing you 
with more details of the template.

 4. At Import Mode, select Replace The Current Page.

 5. At Redirect Mode? select from the following options to set where you will be redirected to once you complete this importing:

 l Select View Imported Page to be redirected to the newly created page upon creation (Import).

 l Select Edit Imported Page to be redirected to the Page Settings page of the newly created page upon creation (Import). 
This enables you to configure the page settings immediately.

 6. Click the Import link. The new page will now be added to the top level of the menu. If Edit Imported Page was selected at Step 6 
you can now edit page settings as required.

Tip: View the new page to ensure that any modules that are set to display on all pages are not duplicated. This may occur if the selected 
template includes modules that are displayed on all pages.

Replacing the Current Page with a Page Template (Import Page)



Deleting a Page
How to delete a page from a site. Pages set as either the Splash page, Home page, Login page, or the User page cannot be deleted until 
the setting is removed. The last visible portal page can also not be deleted. Deleted pages are stored in the  Recycle Bin where they can 
be restored or permanently deleted by authorized users.

 1. Navigate to the required page.

 2. On the RibbonBar, hover over the Pages link until the Control Panel displays and then select  Delete from the Actions section - 

OR - On the Iconbar, select  Delete from the Page Functions section. This displays the message "Are you sure you want to 
delete this page?"

 3. Click the OK button to confirm.

Tip: You can also delete a page via Page Settings.

Related Topics:

 l See "About the Recycle Bin Module"

 l See "Deleting a Page from a Secondary Language"

Page Settings
Page Details Settings for New Pages
How to set page details settings for new pages using the Page Settings page.  Note: The Page Name field is the only mandatory field. 
This topic assumes you have already begun the process of adding a new page. See "Adding a New Page via the Site Settings Page"

 1. Select the Page Details tab.

 2. In the Page Name text box, enter a name for the page. If this page is displayed in the menu, this will be the name in the menu. 



 3. In the Page Title text box, enter a short, descriptive sentence summarizing the page content. The title is used by search engines to 
identify the information contained on the page. It is recommended that the title contains at least 5 highly descriptive words and 
does not exceed 200 characters. 

 4. In the Description text box, enter a description of the page content. The description is used by search engines to identify the infor-
mation contained on the page. It is recommended that the description contains at least 5 words and does not exceed 1000 char-
acters. 

 5. In the Keywords text box, enter key words for this page separated by comma.

 6. At Tags, select one or more tags associated with this page. Page tagging is a way of categorizing content for more meaningful 
search results.

 7. At Parent Page, select <None Specified> to set this page as a parent page - OR - Select the parent page from the drop-down 
box. Note: Page Editors can only select parent pages which they are authorized to edit.

 8. At Insert Page, select from these options to choose the location of the new page in the menu:

 l Select a page from the drop-down box and then select to add the new page either Before or After that page in the menu 
on the current level.

 l Select Add to End to add the new page to the end of the menu on the current level. 

 9. Optional. Set a page template which allows you to add modules with optional content to a new page. Note: This option is not avail-
able when copying a page. Complete the following  to set the template for this page:

 a. At Template Folder, select the folder where the required template is located.

 b. At Page Template, select the required template.

 10. At Include In Menu?, check  the check box to include this page in the menu- OR - Uncheck  the check box to hide the page.

 11. Click the  Update Page link.



Basic Settings for New Pages

Related Topics:

 l See "About the Taxonomy Manager Module"

Page Details Settings for Existing Pages
How to set page details settings for existing pages using the Page Settings page. See "Editing Page Settings" to begin this process. Note: 
Page Name is the only required field.

 1. Select the Page Details tab.

 2. In the Page Name text box, enter a name for the page. If this page is displayed in the menu, this will be the name in the menu. 

 3. In the Page Title text box, enter a short, descriptive sentence summarizing the page content. The title is used by search engines to 
identify the information contained on the page. It is recommended that the title contains at least 5 highly descriptive words and 
does not exceed 200 characters. 



 4. In the Description text box, enter a description of the page content. The description is used by search engines to identify the infor-
mation contained on the page. It is recommended that the description contains at least 5 words and does not exceed 1000 char-
acters. 

 5. In the Keywords text box, enter key words for this page separated by comma.

 6. At Tags, select one or more tags associated with this page. Page tagging is a way of categorizing content for more meaningful 
search results. Note: Tags can be created by users (See "Tagging Page Content") or editors (See "Creating a Vocabulary").

 7. At Parent Page, select <None Specified> to set this page as a parent page - OR - Select the parent page from the drop-down 
box. Note: Users can only select parent pages which they have been granted Add, Full Control permissions for (Edit permissions 
in Community Edition)

 8. At Include In Menu?, check  the check box to include this page in the menu - OR - Uncheck  the check box to hide the page.

 9. Click the  Update Page link.

Setting Page Permissions
How to set page permissions by username and roles. This topic assumes you are on the Page Settings page of a page. Note: Access to 
view and set page permissions are only available to Administrators and users with Edit/Full Control permissions for the page. See "About 
Page Permissions"



Tip: When setting Permissions, you can change the selection at Filter By Group and set permissions for any of the roles within that group 
before updating.

Important. In DNN Community edition, page management permissions consist of View and Edit permissions only. In DNN Professional, 
page management includes ten different permissions for page management which  are the same for both users and roles. See "About 
Page Permissions"

 1. Select the Permissions tab.

 2. At Username, enter the username of a user that you want to grant or deny page viewing permissions to, and then click the  
Add link.

 3.  Optional. At Filter By Group, select from the following options: 

 l < All Roles >: Select to view all roles (both global role and roles groups) in one single list. 

 l < Global Roles >: Select to view all roles which are not associated with a Role Group. E.g. Administrators, All Users, Reg-
istered Users, and Unauthenticated Users. 

 l [Role Group Name]: Select the name of a Role Group to view the roles within that group.

 4. In the View (or View Page) column, click on the check box beside a user/role repeatedly until the correct permission is displayed.

 l  Permission Granted:: Permission to view the page is granted.

 l  Permission Denied: Permission to view the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users cannot view the page unless they belong to another role/user-
name which has been granted permission, or are granted Full Control/Edit Page permissions. 

 5. If you are using DNN Community Edition, skip to the final step in this tutorial.

 6.  In the Add column, select from these options:

 l   Permission Granted: Users with Add permissions for a page can add  child pages to that page. They cannot add any 
parent pages, and they cannot add child pages to any other pages.

 l  Permission Denied: Permission to add child pages is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to add pages unless they belong to another role/user-
name which has been granted permission.

 7. In the Add Content column, select from these options:

 l  Permission Granted: Users with Add Content permissions for a page can edit content on the page. These users can 
add, move and delete modules, as well as manage the content and settings for modules on the page.

 l  Permission Denied: Permission to add and manage module content is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to view the page unless they belong to another 
role/username which has been granted permission.

 8. In the Copy column, select from these options:

 l   Permission Granted: Users with Copy permission can make a  copy any page they can view. The new page can only 
be a child of the page they have copy permissions for.



 l  Permission Denied: Permission to copy the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to copy the page unless they belong to another 
role/username which has been granted permission.

 9. In the Delete column, select from these options:

 l  Permission Granted: Users with Delete permissions can delete the page. If the page has child pages they are also 
deleted when the parent is deleted, however the user does not automatically have Delete permissions for these child 
pages.

 l  Permission Denied: Permission to delete the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to delete the page unless they belong to another 
role/username which has been granted permission.

 10. In the Export column, select from these options:

 l   Permission Granted: Users with Export permissions can export a page.

 l  Permission Denied: Permission to export the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to export the page unless they belong to another 
role/username which has been granted permission.

 11. In the Import column, select from these options:

 l   Permission Granted: Users with Import permissions can import a page.

 l  Permission Denied: Permission to import the page is denied, unless Full Control is granted.

 l  Not Specified: Users cannot import the page unless Full Control/Edit permission is granted. 

 12. In the Manage Settings column, select from these options:

 l   Permission Granted: Users with Manage Settings permissions can change the page settings. Users can edit all of the 
settings on the Settings page, except for the permissions section which will not be visible.

 l  Permission Denied: Permission to manage settings the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to manage settings for the page unless they belong to 
another role/username which has been granted permission. 

 13. In the Navigate column, select from these options:

 l  Permission Granted: Users with Navigate permissions can view a page in the navigation menu. Users can have this 
permission without view permissions, in which case they will not be able to view any content on the page but the page will 
be visible in the menu.

 l  Permission Denied: Permission to navigate to the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified. Users are unable to navigate to the page unless they belong to another 
role/username which has been granted permission.



 14. In the Full Control (or Edit Page) column, select from these options:

 l   Permission Granted: Users with Full Control permissions have full administrative rights for the page. This permission 
is the same as the Edit Page permission in the Community Edition. This role overrides other settings.

 l  Permission Denied: Permission to delete the page is denied, unless Full Control is granted.

 l  Not Specified: Permissions are not specified.

 15. Click the  Update Page link.

Page Permissions in DNN Professional Edition

About Page Permissions
How to set access to view, edit and manage pages and page content  setting permissions by roles and/or usernames. This topic provides 
an overview of the different page permissions available. For full details                   See "Setting Page Permissions".

Important. In DNN Community edition, page management permissions consist of only two settings: View Page and Edit Page. In DNN 
Professional, page management has ten permissions.

Professional Edition Permissions

Only available in DotNetNuke Professional Edition
Here is the full list of page permissions available in Professional Edition:



 l View: View permissions enable users  to view the page.

 l Add: Users with Add permissions for a page can add  child pages to that page. They cannot add any parent pages, and they can-
not add child pages to any other pages.

 l Add Content: Users with Add Content permissions for a page can edit content on the page. These users can add, move and 
delete modules, as well as manage the content and settings for modules on the page.

 l Copy: Users with Copy permission can make a  copy any page they can view. The new page can only be a child of the page they 
have copy permissions for.

 l Delete: Users with Delete permissions can delete the page. If the page has child pages they are also deleted when the parent is 
deleted, however the user does not automatically have Delete permissions for these child pages.

 l Export: Users with Export permissions can export the page.

 l Import: Users with Import permissions can import a page.

 l Manage Settings: Users with Manage Settings permissions can change the page settings. Users can edit all of the settings on the 
Settings page, except for the permissions section which will not be visible.

 l Navigate: Users with Navigate permissions can view a page in the navigation menu. Users can have this permission without view 
permissions, in which case they will not be able to view any content on the page but the page will be visible in the menu.

 l Full Control: Users with Full Control permissions have full administrative rights for the page. This permission is the same as the 
Edit Page permission in the Community Edition. 



Page Permissions in DNN Professional Edition

Community Edition Permissions
Here is the list of page permissions available in Community Edition:

 l View Page: View permissions enable users  to view the page.

 l Edit Page: Edit permissions give users full administrative rights for the page.



Page Permissions in DNN Community Edition

Advanced Settings for New Pages
An overview of the  advanced settings for new pages. All advanced page settings are optional. This topic assumes you are in the process 
of adding a new page ( See "Adding a New Page via the Site Settings Page",) or editing an existing page (See "Editing Page Settings"

 1. Select the Advanced Settings tab.

 2. In the Appearance section, complete any of the following optional               settings: 

 a. At Icon,  select the image to be displayed beside the page name in the menu. This image is also used as the Small Icon 
for any Console module relating to this page. Select the location of the required icon from these options:

 l File (A File On Your Site ), select to choose any imageSee "Uploading and Linking to a File"

 i. Set the link to an existing file ( See "Setting a File Link",or a new file ( "Uploading and Linking to a 
File".. Note: You can remove the icon from this and the following field by selecting < None Specified > 



as the File Name when setting a file link.

 l System Image: Select to choose an icon which is part of your DNN application. This displays a list of available 
images.

 i. Select the required image.

 b. At Large Icon, using the same steps as for the above field, select an image to be used as the Large Icon for any Con-
sole module relating to this page.

 c. At Page Skin, select Host or Site to view the associated skins and then select a skin from the drop down list. The 
default option of                             <Use Portal Default> uses whichever skin is set as the default for this site. See "Setting the Default 
Portal Skin and Container"

 d. At Page Container, select Host or Site to view the associated containers and then select a container from the drop 
down list. Note: The default option of                       <Use Portal Default> uses the skin is set as the default for this site. See "Setting 
the Default Portal Skin and Container"

 e. In the Refresh Internal (seconds) text box, enter the interval to wait between automatic page refreshes. (E.g. Enter "60" 
for 1 minute or 60 seconds.) Leave field blank to disable. 

 f. In the Page Header Tags text box, enter any tags that should be rendered in the "HEAD" tag of the HTML for this page.



 3. In the Cache Settings section, the following setting is available:

 a. At Output Cache Provider, select the provider to use for this page from these options: 

 l FileOutputCachingProvider

 l DatabaseOutputCachingProvider

 l MemoryOutputCachingProvider



 4. In the Other Settings, the following optional settings are available: 

 a. At Secure? check  the check box to force this page to use a secure connection or secure socket layer (SSL). This 
option requires the Administrator to configure the SSL Settings on the Admin > Site Settings page. 

 b. At Site Map Priority, enter the desired priority (between 0 and 1.0). This helps determine how this page is ranked in 
Google with respect to other pages on your site (0.5 is the default). 

 c. At Start Date, click the Calendar link and select the first date the page is viewable.

 d. At End Date, click the Calendar link and select the last date the page is viewable. Note: Expired pages can be viewed 
by Administrators via the Admin > Pages page.

 e. At Link URL, to set this page to be a navigation link to another resource (rather than displaying the page itself), select 
or add the link here. "About the Link Control".

 f. At Permanently Redirect?, check  the check box to notify the web browser that this page should be considered as 
permanently moved. This enables Search Engines to modify their URL's to directly link to the resource. Note: This set-
ting is ignored if the Link Type is set to None.

 5. Click the  Update Page link.

Tip: If a Small Icon is set for the page, it will also be used as the small icon for any Console module which is added to the page.

Related Topics:



 l See "Working with the Calendar"

 l See "About The Console Module"

Advanced Settings for Existing Pages
How to set the  advanced settings for existing pages on the Page Settings page.  See "Editing Page Settings". All advanced page settings 
are optional.

 1. Select the Advanced Settings tab. 

 2. In the Appearance section, complete any of the following optional settings: 

 a. At Icon,  select the image to be displayed beside the page name in the menu. This image is also used as the Small Icon 
for any Console module relating to this page. Select the location of the required icon from these options:

 l File (A File On Your Site ), select to choose any imageSee "Uploading and Linking to a File"

 i. Set the link to an existing file ( See "Setting a File Link",or a new file ( "Uploading and Linking to a 
File".. Note: You can remove the icon from this and the following field by selecting < None Specified > 
as the File Name when setting a file link.

 l System Image: Select to choose an icon which is part of your DNN application. This displays a list of available 
images.

 i. Select the required image.

 b. At Large Icon, using the same steps as for the above field, select an image to be used as the Large Icon for any Con-
sole module relating to this page.

 c. At Page Skin, select Host or Site to view the associated skins and then select a skin from the drop down list. The 
default option of                                <Use Portal Default> uses whichever skin is set as the default for this site. See "Setting the Default 
Portal Skin and Container"

 d. At Page Container, select Host or Site to view the associated containers and then select a container from the drop 
down list. The default option of                        <Use Portal Default> uses whichever skin is set as the default for this site. 

 e. At Copy Design to Descendants, click the Copy Design link. "Copying Design to Children Pages".

 f. At Disabled, select from these options:

 l Check  the check box if the page name is not a link. I.e. When you click on the page name in the menu 
nothing happens. This option is typically selected for a parent page to provide a way for users to navigate 
to its child pages.

 l Uncheck  the check box for this page name to be a link to the page. This is the default option. 

 g. In the Refresh Internal (seconds) text box, enter the interval to wait between automatic page refreshes. (E.g. Enter "60" 
for 1 minute or 60 seconds.) Leave field blank to disable. 

 h. In the Page Header Tags text box, enter any tags (i.e. meta-tags) that should be rendered in the "HEAD" tag of the 
HTML for this page



 3. In the Cache Settings section, the following setting is available:

 a. At Output Cache Provider, select the provider to use for this page from these options: 

 l FileOutputCachingProvider

 l DatabaseOutputCachingProvider



 l MemoryOutputCachingProvider

 4. In the Other Settings section, the following optional settings are available: 

 a. At Secure?, check  the check box to force this page to use a secure connection (SSL). This option will only be ena-
bled if  the host has enabled SSL ( See "Setting SSL Settings for a Single Portal" ) - OR - Uncheck  the check box 
remove use of SSL connection.

 b. In the Site Map Priority text box, enter the desired priority (between 0  and 1.0). This helps determine how this page is 
ranked in Google with respect to  other pages on your site (0.5 is the default).

 c. At Start Date, click the Calendar link and select the first date the page is viewable.

 d. At End Date, click the Calendar link and select the last date the page is viewable. Note: Expired pages can be viewed 
by Administrators via the Admin > Pages page. See "Viewing any Page (Pages Module)".

 e. At Link URL, to set this page to be a navigation link to another resource, select or add the link here. "About the Link 
Control".

 f. At Permanently Redirect?, check  the check box to notify the client that this page should be considered as per-
manently moved. This would allow Search Engines to modify their URL's to directly link to the resource. Note: This set-
ting is ignored if the Link Type is set to None.

 5. Click the Update Page link.



Localization Settings for New Pages
How to set the localization setting for new pages on the Page Settings page. Note: The Localization section only displays if content local-
ization is enabled.   

In the Localization section, select from the following:

 l Create Single Neutral Culture Page: Select to create a single page which is shared for all languages.

 l Create in Current Culture only: Select to create a page for the language you are currently viewing the site in.

 l Create Localized Versions of Page: Select to a version of this page for each language. This is the default option.

Setting Localization Settings for New Pages

Modules
About Modules
DNN uses a modular design system to display content on a page. One or more modules are added to each page allowing you to create 
and manage content.  There are many different types of modules, each managing a different type of site content or site administrative 
tasks.

Your Host can install additional modules which can be purchased from the DotNetNuke Store (Snowcovered.com).

http://www.snowcovered.com/Snowcovered2/Default.aspx


A page which has the Search Input, HTML and Media modules added to it

Note: All users can perform the following actions on modules, however these actions may be disabled on one or more modules.

 l See "Minimizing and Maximizing Content"

 l See "Printing Content"

 l See "Subscribing to Syndicated Content"

 l See "Tagging Page Content"

Related Topics:

 l See "About Module Settings" and the related section for details on setting the module settings which are common to all modules

Module Actions Menu
The module actions menu, enables users with the correct permissions to add and edit module content, delete or move modules, 
import/export module content, print module content, and view a Syndicated URL of the module content. The menu also provides access 
to the Module Settings page where users can set module specific setting such as view and edit permissions and design settings can be 
configured.



The Module Actions Menu

Opening the Module Actions Menu
How to view the options available to you on the module actions menu. Note: Some menu options are role restricted.

Important. If the Control Panel is displayed, ensure Mode is set to Edit to view and access this menu.

Tip: You can drag the Manage button to any location within the boundaries of its module.

 1. Mouse over the Manage  button to view the drop-down menu.



Function of Menu Icons

Icon Name Function
Edit

Edit Content Add a new record to the module or edit the existing content.
My Work View your current workflow tasks in the HTML/HTML Pro module.

Admin

Export Content

Export content from the module. Exported content can then be imported it into another module of the same 
type. E.g. You can only import content from a Links module into another Links module. Modules which allow 
content import/export are known as IPortable modules. Examples include the Announcements, FAQ, Help, 
Links, Media,  Repository, Survey, HTML/HTML Pro and XML modules.

This option may be disabled in the menu.

 1. Select  Export Content from the module actions menu. This opens the Export Module page.

 2. At Folder, select the folder where you want to save the exported content.

 3. In the File text box, enter a name for the export file. Note: The module type is entered by default. It is 
useful to keep this as the start of the file name so you can easily identify the module type in the future. 
E.g. Links_Sponsors_December2011

 4. Click the Export link. This creates an XML file which is saved to the selected folder.

Exporting Module Content

Import Content

Enables exported content to be imported into IPortable modules. Note: Content must first be exported from a 
module of the same type. E.g. You can only import content from a Links module into another Links module.

This option may be disabled in the menu.

 1. Select  Import Content from the  module actions menu. This opens the Import Module page.

 2. At Folder, select the folder where exported file is located from the drop-down list.

 3. At File, select the file name from the drop-down list.

 4. Click the Import link.

Tip: If the module already contains content, the imported content is merged with the existing content.



Icon Name Function

Importing Module Content

Syndicate
Enables users to view a syndicated feed of the module content. This feed can be downloaded to your com-
puter or displayed in another module such as the News Feeds (RSS) module. Syndication must be enabled  
on the Module Setting page of a module. See "Configuring Basic Page Settings for Modules"

Help

Opens the Module Help page for this module. Here you can view basic module information and help.

 1. Optional. Click the View Online Help link to view detailed help for this module online. This opens the 
Online Help resource in a new Web browser.

 2. Click the  Cancel link to return to the module.



Icon Name Function

Online Help
Select to view the Online Help Web site associated with your site. The default option is the free resource 
called DNN Online Help which is maintained by DNN Corp however your Host may use another resource. 
This option may be disabled in the menu.

Print Provides a print friendly copy of the module content for printing. Print must be enabled  on the Module Setting 
page of a module. See "Configuring Basic Page Settings for Modules"

Settings

Opens the module settings page for this module. This page provides Page Editors and Administrators with 
access to configure a wide range of module settings.

Tip: Ensure Mode is set to Edit on the Control Panel. 

 1.  Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. This opens the Module Settings page.

 3. Edit one or more settings as required. 

 4. Click the  Update link.
Delete Delete the module.        See "Restoring Deleted Modules"
Refresh Refreshes the module with the latest content.

Move Section
To Top Move the module to the top (above all other modules) within the current pane.
To Up Move the module up one position within the current pane.
To Down Move the module down one position within the current pane.
To Bottom Move the module to the bottom (below all other modules) within the current pane.
To [PaneName] Move the module to another pane on the current page.

Adding a New Module (RibbonBar)
How to a new module to a page using the RibbonBar. Adding a new module inserts a module without content into the current page.

Permissions. You must be authorized to deploy a module and have the appropriate page editing permissions to add a module to a 
page.

Important. If content localization is enabled, See "Adding a Module to all Languages" or "Adding Modules to a Secondary Language 
Only". as required.

 1. On the RibbonBar, hover over the Modules tab until the Add Module window appears.  Add New Module is pre-selected. Note: On 
the Iconbar, go the Module Insertion section and select Add New Module.

 2. At Module Selection, set the following options:

 a. At Category, select one of the following module categories from the drop-down list to populate the Module field below with 
the related modules.

 l Admin: Modules which are typically used for site administration rather than managing content.

 l Common: Modules selected as frequently used.

 l Enterprise: Modules specific to DNN Enterprise Edition.

 l Professional: Modules specific to DNN Professional Edition.

 l All Categories: Modules within all categories including those which haven't been associated with a category). 



 b. At Module, select the module to be added. E.g. HTML

 3. Optional. In the Title text box, enter a title for this module. E.g. About Us. If no title is entered, the module name is used by default. 

 4. Optional. At Visibility, select from the following options:

 l Same As Page: This sets the module as visible to all roles/users who can view this page.  This is the default setting.

 l Page Editors Only: The sets module as only visible only to the roles/user who can edit this page. Select this option if you 
want to add content and configure the module settings before others can view the module.

 5. Optional. At Pane,  select the pane you want to insert the module into.  The module is added to the Content Pane by default. The 
names of other panes will depend upon the skin applied to this page. If you select a pane other than the Content Pane, the posi-
tion of the pane is briefly shown on the page.

 6. Optional. At Insert, select the placement of the module from the first drop-down box. One or more of the following options is avail-
able, depending on the number of modules located in the selected pane:

 l Top: Select to add the module above all existing modules within the selected pane. Skip to Step 9.

 l Above: Select to add the module above another chosen module  within the selected pane.

 a. At Module, select the module the new module will be added above.

 l Below: Select to add the module below another module within the selected pane.

 a. At Module, select the module the new module will be added  below.

 l Bottom: This adds the module below all existing modules within the selected pane.  This is the default option.

 7. Click the Add Module button on the RibbonBar - OR - Click the  Add Module To Page link on the Iconbar. For modules that enable 
you to add content, "Adding Module Content".

Tip: When you add the module listed as Users & Roles, three separate modules (Security Roles, My Profile and User Accounts) are 
added to the page. These modules do not need to be used on the same page. You can delete one or all of them, or move them to dif-
ferent pages as you like.

Adding a New Module using the RibbonBar

Adding a New Module using the Iconbar



Adding an Existing Module (RibbonBar)
How to add an existing module to the current page using the RibbonBar. The content of this module is shared with the existing module, 
therefore updating the content on any version of this module will update the content in all of the other versions as well.

Important. You cannot add an existing module to the page where it already exists.

Tip: You must be authorized to deploy a module and have the appropriate page editing permissions to add  modules to the current page.

 1. Maximize  the Control Panel.

 2. Select the Common Tasks tab and at Add Module select  Existing.

 3. At Page, select the page where the existing module is located.

 4. At Category, select the category this module belongs to from these options:

 l Uncategorized: Modules which have not been assigned to a category.

 l Admin: Modules which are located on the Admin Console (e.g. File Manager, User Accounts) or require some Admin 
assistance (e.g. Banners). These modules are typically available only to Administrators, however they can be configured 
to enable other users to deploy them to the site.

 l Host: Modules which are located on the Host Console (e.g. SQL, Schedule). These modules only to Host.

 5. At Module, select the module to be added. Note: Selecting the module here appends either 'with content' or 'without content' to the 
Copy Module field below depending on whether the selected module supports copying of content.

 6. Optional. At Visibility, select from the following options:

 l Same As Page: This sets the module as visible to all roles/users who can view this page.  This is the default setting.

 l Page Editors Only: The sets module as only visible only to the roles/user who can edit this page. Select this option if you 
want to add content and configure the module settings before others can view the module.

 7. Optional. At Pane,  select the pane you want to insert the module into.  The module is added to the Content Pane by default. The 
names of other panes will depend upon the skin applied to this page. If you select a pane other than the Content Pane, the posi-
tion of the pane is briefly shown on the page.

 8. Optional. At Insert, select the placement of the module from the first drop-down box. One or more of the following options is avail-
able, depending on the number of modules located in the selected pane:

 l Top: Select to add the module above all existing modules within the selected pane. Skip to Step 9.

 l Above: Select to add the module above another chosen module  within the selected pane.

 a. At Module, select the module the new module will be added above.

 l Below: Select to add the module below another module within the selected pane.

 a. At Module, select the module the new module will be added  below.

 l Bottom: This adds the module below all existing modules within the selected pane.  This is the default option.



 9. At Copy Module, select from these options:

 l Check  the check box to create an independent instance of this module. This new module contains both the settings and 
(where applicable) the content of the existing module however you can modify this module without affecting the existing 
module.

 l Uncheck  the check box to display the existing module on this page. This module shares the settings and (where appli-
cable) the content of the existing module and modifying either instance will update both versions.

 10. Click the Add Module button.

Related Topics:

 l "Adding Module Content".

 l See "Setting Permissions to Deploy a Module"

Adding an Existing Module (Iconbar)
How to add an existing module to the current page using the Iconbar. The module content is shared so if you update the content on one 
module the content in the other module also updates. 

Important. You cannot add an existing module to the page where it already exists.

Tip: You must be authorized to deploy a module and have the appropriate page editing permissions to add a module to a page.

 1. Maximize  the Control Panel.

 2. Go the Module Insertion section and select Add Existing Module.

 3. At Page, select the page where the existing module is located.

 4. At Module, select the module to be added.

 5. Optional. At Visibility, select from the following options:

 l Same As Page: This sets the module as visible to all roles/users who can view this page.  This is the default setting.

 l Page Editors Only: The sets module as only visible only to the roles/user who can edit this page. Select this option if you 
want to add content and configure the module settings before others can view the module.

 6. Optional. At Pane,  select the pane you want to insert the module into.  The module is added to the Content Pane by default. The 
names of other panes will depend upon the skin applied to this page. If you select a pane other than the Content Pane, the posi-
tion of the pane is briefly shown on the page.

 7. Optional. At Insert, select the placement of the module from the first drop-down box. One or more of the following options is avail-
able, depending on the number of modules located in the selected pane:



 l Top: Select to add the module above all existing modules within the selected pane. Skip to Step 9.

 l Above: Select to add the module above another chosen module  within the selected pane.

 a. At Module, select the module the new module will be added above.

 l Below: Select to add the module below another module within the selected pane.

 a. At Module, select the module the new module will be added  below.

 l Bottom: This adds the module below all existing modules within the selected pane.  This is the default option.

 8. Click the  Add Module To Page link. For modules that enable you to add content.

Related Topics:

 l "Adding Module Content".

Editing Module Title Inline
How to edit the title of a module inline. Note: If this setting has been disabled, the title can instead be edited by a Page Editor on the Mod-
ule Settings page. See "About Module Settings".

 1. Place your mouse over the module title to be edited. This displays the Edit  button above the module title.

 2. Click the Edit  button. This enables inline title editing.

 3. Edit the title.



 4. Click the Update  button to save your changes - OR - Click the Cancel  button to cancel your changes.

Adding Module Content
How to add content to a module. This topic demonstrates how content is typically added to modules, however this is not typical of all mod-
ules. For details on adding content to different module types, see the "Managing Module Content" and "Advanced Site Management" sec-
tions of this manual. 

Tip: If the Control Panel is displayed, ensure Edit mode is selected.

 1. Select  Add [Item] from the  module actions menu - OR - Click the  Add [Item] link (typically located at the base of the mod-
ule).

 2. Complete the form fields.

 3. Click the  Update link.

Editing Module Content
How to edit module content. This topic demonstrates how content is typically edited on modules, however this is not applicable to all mod-
ules. For detailed information on editing content for individual module types, see the "Managing Module Content" section of this manual.

Tip: If the Control Panel, ensure EDIT mode is selected.

Editing modules with a single content item such as the HTML and IFrame modules:

 1. Select  Edit [Item] from the  module actions menu - OR - Click the Edit [Item] link (typically located at the base of the mod-
ule). This opens the Edit page for this module.



 2. Edit the fields.

 3. Click the  Update link.

Editing modules with multiple items such as the Announcements and Links modules:

 1. Click the Edit  button located beside the content to be edited. This opens the edit page for this module.

 2. Edit the fields.

 3. Click the  Update link.

Related Topics:

 l See "Editing (Translating) Localized Module Content"

 l See "Editing the Content of Shared Modules"

Deleting Module Content
How to delete module content. This topic demonstrates how content is typically deleted from a module, however this is not applicable to 
all modules. For full details on deleting content for individual module types, see the "Managing Module Content" section.

Tip: If the Control Panel, ensure EDIT mode is selected.

 1. Click the Edit  button located beside the content to be deleted.



 2. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 3. Click the OK button to confirm.

Tip: To delete content from modules with a single content item such as the HTML and IFrame modules you can either remove all the con-
tent or simply delete the module.

Deleting a Module
How to delete a module from a page.

Tip: Deleted modules are stored in the Recycle Bin.  

 1. Select  Delete from the  module actions menu. This displays the message "Are You Sure You Want To Delete This Module?"

 2. Click the OK button to confirm.

Related Topics:

 l See "Delete Modules from Secondary Language"

Module Settings
About Module Settings
All modules include a Module Settings page which  enables authorized users to modify basic settings related to the module content (e.g. 
module title, module header and footer, module start and end dates) and module permissions (e.g. which roles or users are able to view 



and manage the module).  This page also controls more advanced settings related to the design of the module (containers, borders, print-
ing) and site wide module settings.

All modules have a Settings page which is accessed by selecting  Settings from the module actions menu.  The Module Settings page 
enables authorized users to modify basic module settings related to the module content (e.g. module title, module header and footer, 
module start and end dates) and module permissions (e.g. which roles are able to view and edit a module).  This page also controls more 
advanced settings related to the design of the module (containers, borders, printing) and site wide module settings.

The page is divided into these tabs:

 l Module Settings: Settings relating to the Module content.  Module Settings are settings which are the same on all pages where 
the Module appears. This section is divided into Basic Settings, Advanced Settings and Added to Pages. 

 l Permissions: This section includes module permissions where access to view, edit and manage the module is set. Note:  Some 
modules  have additional permissions to add/edit and manage module content. 

 l Page Settings: Settings specific to this particular occurrence of the module for this page.  This section is divided into Basic Set-
tings and Advanced Settings.

 l Localization Settings: The Localization section only displays if content localization is enabled. For full details on working with this 
section, See "About Content Localization"

 l Module Specific Settings: Several modules have additional settings which are specific to this module type. This section is typ-
ically named according to the module type.  E.g. This section is named Links Settings on the Links module. Modules which have 
specific settings include the Announcements, Documents, Events, FAQ and many more.

Module Settings
Configuring Basic Module Settings
How to view basic module settings and set the module title and tags,  which is a way of categorizing content for more meaningful search 
results. Note: In order to view the Module Title, the Display Container? setting must be checked and the  container applied to the module 
must include the [TITLE] skin token. 

Tip: You may also be able to edit to title inline. See "Editing Module Title Inline".

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the Module Settings - Basic Settings section.

 3. At Module Culture, the culture associated with this module is displayed.

 4. At Module, view the name of the module. This field cannot be edited. E.g. Announcements, HTML, etc.

 5. In the Module Title text box, edit the module title.

 6. At Tags, click on the drop-down box and then check  the check box beside the tag you want to associate with this module. 
Repeat to select additional tags. Tagging is a way of categorizing content for more meaningful search results. Note: Tags can be 
created by users (See "Tagging Page Content") or editors (See "Creating a Vocabulary").



 7. Click the  Update link.

Tip: You may be able to edit the module title directly on the page. See "Editing Module Title Inline".

Related Topics:

 l See "Tagging Page Content"

 l See "Creating a Vocabulary"

Configuring Advanced Module Settings
How to  set a module to display on all pages including the Admin Console pages, or to only on newly added pages. Module content is 
shared  therefore changes made  on one instance of the module are reflected on all instances of the module. If you choose to only display 
the module on new pages, this doesn't affect the pages where it is already located.

Once a module is set to display on all/new pages, if you make changes to any module settings located on the Module Settings tab, then 
these changes will be reflected on all copies of the module. However, changes to module settings located on the Page Settings tab are 
unique to the module which you changed. Note: If the control panel is displayed, ensure the Mode is set to Edit.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the Module Settings - Advanced Settings section.

 3. At Display Module On All Pages?, select from these options:

 l Check   the check box. This displays the Add To New Pages Only? field.*

 a. Optional. At Add To New Pages Only?, select from these options:

 l Check   the check box to only add the module to any new pages which are added.

 l Uncheck  the check box to add the module to both existing and new pages.

 l Uncheck  the check box to disable.

 4. At Hide Admin Border, select from these options to set the visibility of the "Visible By Administrators Only" message. The mes-
sage is displayed to Administrators and SuperUsers on modules which are only visible to Administrators. This message appears 
on the page where the module is located as well as on the Module Settings page for that module. This message is also displayed 
by default for any modules which are added to the Admin pages. 

 l Check   the check box to hide the message. This will hide the message even if the module is only visible by admin-
istrators.

 l Uncheck  the check box to display the message. This displays the message even if the module is only visible to 
members in the Administrator role (which by default includes all hosts).

 5. In the Header text box, add, edit or delete the header which displays above the module content. Plain text and basic HTML such 
as headings, italic and bold can be used.

 6. In the Footer text box, add, edit or delete the footer which displays below the module content.



 7. At Start Date, click the Calendar link and select the first day that the module will be visible on the site. Modules with a start date 
are only visible to Page Editors and Administrators prior to that date, enabling them to create content in advance. A "Module Effec-
tive - [start date]" message is displayed to these users prior to the start date.

 8. At End Date, click the Calendar link and then select the last day that the module will be visible on the site. Once the end date is 
reached, the module is only visible to Page Editors and Administrators, enabling them to retain, edit and republish the content as 
desired.  A "Module Expired [end date]" message is displayed to these users once the module has expired.



 9. Click the  Update link.



Module with a start date, header and footer

The message displayed when Admin Border is displayed

* Tip: You can delete any instance of a module from any page without is affecting this setting.

See "Working with the Calendar".

 l See "Working with the Calendar".

Viewing Added To Pages Module Settings
How to view a list of the pages where a module is located. This setting includes a link to view the module on any of the listed pages.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the Module Settings - Added To Pages section. This displays a hierarchical list of all pages (apart from the current page) 
where this module is located. 

 3. Optional. Click on the linked [Page Name] to view the module on that page.

The Added To Pages List

Related Topics:

 l "Configuring Advanced Module Settings".

Permissions
About Module Permissions
How to set access to view, edit and manage module content by roles and/or usernames. Here you will find an overview of the different 
module permissions available. For full details                    See "Setting Module Permissions"

Important. In DNN Community edition, module management permissions consist of only two settings: View and Edit. In DNN Pro-
fessional, module management has seven permissions.

Professional Edition Module Permissions:

Only available in DotNetNuke Professional Edition
Here is the full list of module permissions available in Professional Edition:

 l View: Users  can view the module on the page.

 l Edit Content: Users can edit the module content.

 l Delete: Users can delete the module through the module actions menu.

 l Export: Users can export the module content using the module actions menu.

 l Import: Users can import the module content using the module actions menu.

 l Manage Settings: Users can change access the module settings page for this module and manage all setting excluding per-
missions.

 l Full Control: Users have full administrator rights for the module.



Module Permissions in DNN Professional Edition

Community Edition Module Permissions: 

Here is the list of module permissions available in Community Edition:

 l View Module: Users  can view the module on the page.

 l Edit Module: Users can add and edit the module content.

Module Permissions in DNN Community Edition

Setting Module Permissions
How to set permissions to view and edit a module. Permission can be granted or denied for a role or for an individual user. Additional per-
mission options are available on some modules such as the Events module. 

Fine grain management of modules is available in Professional Edition by providing these additional settings: Delete, Import, Export, 
Manage Settings, and Full Control. Only available in DotNetNuke Professional Edition



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Permissions tab.

 3. Optional. In the Username text box, enter the username of a user to whom you wish to grant or deny module permissions, and 
then click the  Add link. Repeat for additional usernames.

 4. Optional. At Filter By Group, select from the following options: 

 l < All Roles >: Select to view all roles (both global and group roles) in one single list. 

 l < Global Roles >: Select to view all roles which are not associated with a Role Group. This includes Administrators, All 
Users, Registered Users, and Unauthenticated Users. 

 l [Role Name]: Select the name of a Role Group to view the roles within that group. 

 5. Optional. At Inherit View permissions from Page, select from these options:

 l Check   the check box if the users which are authorized to view this module should be the same as the page it is located 
on. This displays the  Security Roles image in the View (or View Module) column indicating that the view security is 
'locked'. Skip to step 7.

 l Uncheck  the check box to set different permissions for viewing this module than set for the page it is located on. If you 
choose to uncheck this option, the check boxes at View Module will become available.

 6. In the View (or View Module) column, click on the check box beside a role/username repeatedly until the correct permission is dis-
played. The following options are available:

 l  Not Specified: Permissions are not specified. Users cannot view the module unless they belong to another role/user-
name which has been granted permission, or are granted Full Control permissions. Note: Users with Edit Module per-
missions in DNN Community Edition cannot view the module.

 l  Permission Granted: Users can view the module.

 l  Permission Denied: Users cannot view the module, unless Full Control is granted.

 7. If you are using DotNetNuke Community Edition, Skip to Step 14.

 8. In the Edit Content column, click on the check box beside a role/username repeatedly until the correct permission is displayed. 
The following options are available:

 l  Not Specified: Permissions are not specified. Users cannot edit content unless they belong to another role/username 
which has been granted permission, or are granted Full Control permissions. 

 l  Permission Granted: Users can edit content.

 l  Permission Denied: Users cannot edit content, unless Full Control is granted.

 9. In the Delete column, click on the check box beside a role/username repeatedly until the correct permission is displayed. The fol-
lowing options are available:

 l  Not Specified: Permissions are not specified. Users cannot delete the module unless they belong to another role/user-
name which has been granted permission, or are granted Full Control permissions. 

 l  Permission Granted: Users can delete the module.

 l  Permission Denied: Users cannot delete the module, unless Full Control is granted.



 10. In the Export column, click on the check box beside a role/username repeatedly until the correct permission is displayed. The fol-
lowing options are available:

 l  Not Specified: Permissions are not specified. Users cannot export the module unless they belong to another role/user-
name which has been granted permission, or are granted Full Control permissions. 

 l  Permission Granted:: Users can export the module.

 l  Permission Denied: Users cannot export the module, unless Full Control is granted.

 11. In the Import column, click on the check box beside a role/username repeatedly until the correct permission is displayed. The fol-
lowing options are available:

 l  Not Specified: Permissions are not specified. Users cannot import the module unless they belong to another role/user-
name which has been granted permission, or are granted Full Control permissions. 

 l  Permission Granted: Users can import the module.

 l  Permission Denied: Users cannot import the module, unless Full Control is granted.

 12. In the Manage Settings column, click on the check box beside a role/username repeatedly until the correct permission is dis-
played. The following options are available:

 l  Not Specified: Permissions are not specified. Users cannot manage module settings unless they belong to another 
role/username which has been granted permission, or are granted Full Control permissions.

 l  Permission Granted: Users can manage module settings.

 l  Permission Denied: Users cannot manage module settings, unless Full Control is granted.

 13. In the Full Control ( or Edit Module ) column, click on the check box beside a role/username repeatedly until the correct per-
mission is displayed. The following options are available:

 l  Not Specified: Permissions are not specified.

 l  Permission Granted: Users have full control to view the module, manage module content and manage module set-
tings. Note: In DNN Community Edition, View Module permissions must also be granted.

 l  Permission Denied: Users are denied full control.

 14. Click the  Update link.

Tip: When setting Permissions, you can change the selection at Filter By Group and set permissions for any of the related roles before 
updating.

For Example: In the below screen capture, permission to view the module are inherited from the page and permission to edit the module 
has been granted to all Registered Users, apart the user with the username John who has been denied access to edit the module.



Setting Module Permissions

 

Page Settings
Configuring Basic Page Settings for Modules
How to set the Module Settings in the Page Settings - Basic Settings section of the Module Settings page. 

Note: Some module containers may not include the skin token required to view the icon, module title, Minimize/Maximize button, Print but-
ton or Syndicate button.

Important. The Display Container? setting must be checked to view the Icon, Module Title, Expand/Collapse, Print and Syndicate set-
tings.

The below diagram shows the settings which you can set in this section.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Page Settings tab.

 3. Go to the Basic Settings section.

 4. At Display Container?, check  the check box to display the module container - OR - Uncheck the check box to hide the module 
container

 5. At Icon, choose whether to display an icon in the module container. The icon can be any common image type such as a JPEG, or 
GIF. The icon is typically displayed to the left of the module title.

 a. At Link Type, select from the following:

 l None: Select for no icon.

 l File ( A File On Your Site): Select to choose an image from the File Manager or upload a file. See "Uploading a 
File and Linking to the File"

 i. See "Setting a File Link",

 ii. At File Name, select the file from the drop-down list. See "Setting a File Link",. Tip: Another way to set no 
icon is to select <None Specified> at this field.



 l System Image: Select to choose from the system icon library.

 i. At Image, select an image from the drop-down list.

 6. At Alignment, select the default alignment for module content. Content which has been formatted using the RTE will override this 
setting.

 l Left, Center, Right: Select content alignment.

 l Not Specified: Select to use default alignment.

 7. In the Color text box, enter a color name or hex number. E.g. Navy or #CFCFCF. Find Color code charts  at 
http://www.w3schools.com/Html/html_colors.asp.

 8. In the Border text box, enter a number to set the width of the border in pixels.  E.g. 1 = 1 pixel width. Leave this field blank for no 
border.

http://www.w3schools.com/Html/html_colors.asp
http://www.w3schools.com/Html/html_colors.asp


 9. At Collapse/Expand, select from the following options to set the visibility of module content. 

 l Maximized: Select to display the module content on the page. The Minimize  button is displayed enabling users to mini-
mize the content. 

 l Minimized: Select to hide the module content. The  module title, header and footer are still visible. The Maximize  button 
is displayed enabling users to maximize the content.

 l None: Select to display module content and remove the Maximize  / Minimize  button.

 10. At Display Container?, check  the check box to display the module container - OR - Uncheck  the check box to hide the mod-
ule   container including the icon, module title, Minimize/Maximize button, Print button or Syndicate button.

 11. At Allow Print?, select from the following options to set the visibility of the Print  button which enables users to print the module 
content. The Print icon displays in the menu and on the module container. 

 l Check  the check box to display the  Print  button and allow printing.

 l Uncheck  the check box to disable.

 12. At Allow Syndicate?, select from the following options to enable or disable the Syndicate  button. Syndication enables  users 
to create an XML syndication of module content.

 l Check  the check box to allow syndication and display the  Syndicate  button.

 l Uncheck  the check box to disable syndication.

 13. At Is a WebSlice?, optionally set this module as a WebSlice.

 l Check  the check box to enable WebSlice and set any of these optional settings:

 a. Optional. In the Web Slice Title text box, enter a title for the Web Slice - OR - Leave blank to use the module title.      

 b. Optional. At Web Slice Expires:   Enter a date when the Web Slice will expire - OR - Leave blank to use the End 
date . See "Working with the Calendar".



 c. Optional. In the Web Slice TTL text box, enter the Time to Live (TTL) for this web slice in minutes - OR - Leave 
blank to use the default to the cache time (converted as minutes).

 l Uncheck  the check to disable WebSlice

 14. At Module Container, select the name of the module container you want to use on this module from the drop-down list.

 a. Optional. Click the Preview link to view the module with this container applied in a new browser window.

 15. Click the  Update link.

Related Topics:

 l See "Adding News Feeds from Syndicated Modules"

Configuring Cache Settings for a Module
How to set the provider used for cached files and set the period before the cache in DNN refreshes. 

File: The default setting. Suitable for a shared hosting environment.

Memory: This is the fastest caching method. Select this option if you have web site has a large amount of RAM allocated. This is typically 
not suitable for a shared hosting environment.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Page Settings tab.

 3. Go to the Cache Settings section.

 4. At Output Cache  Provider, select  the provider to use for this page. The following options are available:

 l None Specified: Click to disable caching. It this option is selected, skip to Step 6.

 l Select either File, or Memory.

 a. In the Cache Duration (Seconds) text box, enter the duration (in  seconds) the information for this page will be 
refreshed. The default setting is 1200. I.e. Entering 60 will mean that every 60 seconds DNN will refresh module 



content from the database. Set to a low number like 0 if your module content changes frequently or set it to a higher 
number like 1200 if the content doesn't change all that often and you would like better performance out of your site.

 5. Click the  Update link.

Configuring Advanced Page Settings for a Module
How to set the Advanced Page Settings on this module  as the default settings for all new modules. You can optionally set these settings 
for all existing modules.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to Page Settings - Advanced Settings.

 3. At Set As Default Settings?, check   the check box to use these page settings for all new modules.

 4. Optional. At Apply To All Modules?, check   the check box to apply these page settings to all existing modules.

 5. At Move To Page, select the page name where the module will be moved to from the drop-down list.

 6. Click the  Update link.

Content Staging
About the Content Staging Module
Content staging enables users to publish content from a staging portal to a target (production) portal. It eliminates the need to make con-
tent changes to your live production portal.
Only available in DotNetNuke Enterprise Edition
The following types of entities are deployed to the production sever during a publish action

 l Pages (also called Tabs), Page Settings and Permissions (also called Tab Settings and Permissions). Note: Permissions are only 
applied for the users and roles that exist in the target portal.



 l Modules:

 l Module Settings for all modules regardless of whether they are iPortable (i.e. allow import/export of content). For modules 
such as the Feedback module where there is no content, only settings managed on the 

 l Module Content. Note: Content is only published for modules that allow import/export of content.

 l Files and File Content

 l Folders and Folder Settings and Permissions

 l Portal Settings 

Note: Content staging is only supported between cloned portals, your staging portal should be created using a backup of your production 
portal.

Creating a Staging Portal

How to create a staging portal from a production portal. Only available in DotNetNuke Professional Edition

 1. Create a backup of your production SQL database.

 2. Create a new database for your staging portal.

 3. Restore the production site database into your staging database.

 4. Open the Portal Alias table in the new staging database.

 5. Delete the records in the Portal Alias table. This will be regenerated the first time the staging portal is accessed.

 6. Open Windows Explorer and make a copy of the folder that is the physical location for the production web site. This will be the 
physical location for the staging portal.

 7. Rename the folder to help you identify it as the physical location of your staging portal.

 8. Edit the web.config file for the staging portal to update the connection string to connect to the staging database.

 9. Create a new IIS web site for the staging portal with the physical location set to the folder you created in step 6.

Configuring Content Staging
How to configure content staging using the Content Staging module. This must be done before you can publish content from a server to a 
target server you have to pair the two servers together.
Only available in DotNetNuke Enterprise Edition
Pairing Your Portals
Two pieces of information are required to pair two portals, Portal Address and Publishing Token. 

Important. Content Staging relies upon Windows Communication Foundation (WCF) services which must be enabled on your production 
web server before commencing the below topic. To do this turn on Windows feature Windows Communication Foundation 
HTTP Activation.



 1. Login to your production portal.

 2. Navigate to Admin > Content Staging - OR - Go to a Content Staging module.

 3. Copy  the information displayed at the  Local Site Address and Local Publishing Token fields. Tip: You may find it helpful to copy 
and paste this information into a text file.



 4. Login to your staging portal.

 5. Navigate to Admin > Content Staging - OR - Go to a Content Staging module.

 6. Enter (or paste) the information you copied at Step 4 into Production Site Address and Production Publishing Token fields 
respectively. Note: If the domains you are using are not entered into a DNS server you will need to add the URL and IP Address of 
BOTH servers into the HOSTS file on BOTH servers so that they can communicate.

 7. Click the  Test Connection link. If successful,  the  Connection Verified Successfully message is displayed.

 8. Click the  Connect Portals link. You have successfully paired your production and staging portals and are ready to publish 
staged content. See "Publishing Staged Content"

Publishing Staged Content
How to publish content from your staging site to your production site. 

Note 1: All modules and languages which are present on the Staging site must be installed on the production site before staged content 
can be published.

 1. Login to your staging portal.

 2. Navigate to Admin > Content Staging - OR - Go to a Content Staging module.

 3.  Go to the Publish Staged Content section.

 4. In the User Name/Password text boxes, enter either the Host or Admin login details. Note: Even though the user name and pass-
word are entered in the staging site, the authentication is done at the production site; the user should either be a Host user or be 
in the Administrator role in the production server for the login attempt to be successful. Note: You will need to re-enter these 
details every time you navigate to the Content Staging module to publish content.

 5. Click the  Authenticate link.



This displays the following Publish Summary details:

Summary Table
A table is now displayed which summarizes the status of the content on the Staging site. In the below image, the table shows that there 
has been one page and one module added to the site. Note: The number of pages which have been updated (as shown in the Updated 
column) is greater than one. This refers to the number of updates which occurred in the database, such as the automatic reordering of 
pages, when the page was added.

Detailed Tree Folder
A tree folder providing detailed information of the content changes is displayed below the summary table.  Maximize any node to view 
more details. Changes which have not been published to the Production site are colored green. In the below image, you can see that a 
page called "About Us" was created, as well as a module called "About EcoZany"



 6. Optional. Click the Analyze Content link if it is possible that additional changes may have been made recently.

 7. Click the  Publish Content link. This publishes the content changes to your production site.



Common Tools
Working with the Calendar
The Calendar is an ASP.Net control widely used to select and maintain dates in module content, module settings, page settings, Admin 
Console, etc.  The Calendar is typically accessed by clicking on the Calendar link, however some modules have other link names. E.g. 
Events module displays the View Date link.

Default Calendar
The default Calendar control is used throughout the DNN Framework and in a growing number of modules. 

To view the Calendar, click the Calendar link or the Calendar  button.

Step One: Locating the required date

 l Modifying the Month and/or Year:

 1. Click on the Month Year information located above the monthly calendar.

 2. Select the required month and/or year. If the required year isn't displayed, use the Double Right Arrow  or Double Left 
Arrow  buttons to view the other years.

 3. Click the OK button to select.



 l Viewing Today's Date:

 1. Click on the Month Year information located above the monthly calendar.

 2. Click the Today button to view the current month/year with Today's date.

 l Navigating to Other Months:

 o Click the Left Arrow  button above the calendar month to view the calendar for the previous month.

 o Click the Double Left Arrow  button above the calendar month to view the calendar for the three months previous.

 o Click the Right Arrow  button above the calendar month to view the calendar for the next month.

 o Click the Double Right Arrow  button above the calendar month to view the calendar for the three months in the future.

Step Two: Selecting the Required Date

 l To Select a Date: Click on the date cell in the calendar. This will close the calendar and the selected date will be displayed in the 
associated text box. Note: You may be unable to select dates prior to today, depending on where the Calendar is in use.

 l To close the Calendar without selecting a Date: Click off the calendar.

Module Calendar
Several of the available project modules (e.g. Events) use the Calendar control which was standard in previous versions on DNN. These 
modules are currently being updated to use the default calendar.



The following options are available to locate the required date using the calendar:

 1. Click the Calendar link or the Calendar  button. 

 2. To locate the required date, perform any of the following options: 

 l Go to the Previous Year: Click the previous year (E.g. 2007) located at the top left of the calendar. 

 l Go to Today's Date: Click Today located in the top center of the calendar to return to the current month. Today's date is dis-
played as red. 

 l Go to the Next Year: Click next year (E.g. 2009) located at the top right of the calendar. 

 l Go to the Previous Month: Click the previous month (E.g. January) located to the left of the current month. 

 l Go to the Next Month: Click the next month (E.g. March) located to the right of the current month. 

 3. Once you have located the required date the following options are available: 

 l To Select a Date: Click on the date in the calendar. The calendar will close and the date will be selected. 

 l To close the Calendar without selecting a Date: Click the Close button located below the calendar. The calendar will 
close and no date will be selected.

File Upload
Delete this text and replace it with your own content.

About the Pager
The Pager is a control which enables you to easily navigate to other pages of records and is used on a number of DNN Admin and Host 
modules such as the Event Viewer and the User Accounts modules.

Here's an overview to this control:



 n The current page and total number of pages is displayed to the left.

 n Page navigation links are displayed on the right enabling you to quickly move to: 

 l The First page of all records, 

 l The Previous page of records 

 l A specific page by number. E.g. Page 1, 2, 3, etc.

 l The Next page of records 

 l The Last page of records

 
The Pager Control

Tip: On the User Account page, the default number of records displayed per page can be set and the pager control can also be sup-
pressed. 

Replacement Tokens
By adding one or more of the below replacement tokens into content you can display portal or user data to site users. Some examples 
how you might use a replacement token are to display the portal name and description as the content of a module, or to add a per-
sonalized salutation at the beginning of each newsletter.

Replacement tokens  can be added to the content of the HTML, HTML Pro and Newsletters modules. They can also be added in the 
HTML of skins and containers by your designer.

Replacement Token Example Replacement Token Description
[Portal:Currency] USD Displays the portal currency type as set on the Site Settings page.

[Portal:Description]
The EcoZany toy store is an online 
shop that sells a wide range of Eco-
Friendly toys and games.

Displays the portal description as set on the Site Settings page.

[Portal:Email] admin@ecozany.com Displays the email address of the primary Administrator as set on 
the Site Settings page.

[Portal:FooterText] Copyright 2011 by EcoZany Displays the copyright text entered in the Copyright field on the Site 
Settings page.

[Portal:HomeDirectory]  /Portals/0/EcoZany/ Portal (relative) Path of Home Directory.

[Portal:LogoFile] logo.gif Portal Path to Logo file. E.g. logo.gif

[Portal:PortalName] EcoZany The portal name as set on the Site Settings page.

[Portal:TimeZoneOffset] -480 Difference in minutes between Portal default time and UTC.

 User Tokens   

[User:DisplayName] Rose Booth The display name of the user.

[User:Email] Rose.Booth@ecozany.com The email address of the user.

[User:FirstName] Rose The first name of the user.

[User:LastName] Booth The last name of the user.

[User:Username] Rosie The username of the user.

 Membership Tokens   

[Membership:Approved] Yes / No Indicates if the user is approved.



[Membership:CreatedDate] 10/4/2011 1:08 PM Displays the date and time when the user registered on the site.

[Membership:IsOnline] Yes / No Indicates if the user is currently online.

 Page (Tab) Tokens   

[Tab:Description] Welcome to EcoZany Displays the description of the current page.

[Tab:FullUrl] http://www.ecozany.com/Services/
tabid/73/Default.aspx Displays the full URL of the current page.

[Tab:IconFile] icon.gif Page relative path to icon file.

[Tab:KeyWords] toys, dolls, games, fair trade, Displays the keywords for the current page.

[Tab:TabName] Home Page name

[Tab:TabPath] //HTML Page relative path

[Tab:URL]  Page URL

 Date Tokens   

[DateTime:Now] 10/15/2011 5:39 PM Current date and time.

[DateTime:Now|f] Tuesday, October 26, 2011 5:39 PM Displays long date and short time.

[DateTime:Now|F] Tuesday, October 26, 2011 5:39:20 PM Displays long date and long time.

[DateTime:Now|g] 10/26/2011 5:39 PM Displays short date and short time.

[DateTime:Now|G] 10/26/2011 5:39:20 PM Displays short date and long time.

[DateTime:Now|Y] October, 2011 Displays year and month.

[DateTime:UTC] 10/15/2011 5:39 PM Co-ordinated Universal Time. 

[DateTime:UTC|f] Tuesday, October 26, 2011 5:39 PM Co-ordinated Universal Time - long date and short time. Other 
appended options are F, g, G and Y; as for DateTime above.

[DateTime:System] 10/15/2011 5:39 PM Displays date and time as per your local settings.

[DateTime:System|f] Tuesday, October 26, 2011 5:39:20 PM
Displays date and time as per your local settings. This example dis-
plays long date and short time. Other appended options are F, g, G 
and Y; as for DateTime above.

 Tick Tokens   

[Ticks:Now] 633282985407609550 CPU tick count for current second.

[Ticks:Today] 633282624000000000 CPU tick count since midnight.

[Ticks:TicksPerDay] 864000000000 CPU ticks per day (for calculations)

Upload New Extension Package
Delete this text and replace it with your own content.

Editor
About the Editor
The Editor is an ASP.Net control provides basic and rich text editing capabilities across numerous modules including Announcements, 
FAQ, Events and HTML/HTML Pro. The Basic Text Box associated with the Editor is the same for all DNN versions. The Rich Text Editor 
(RTE) associated with the Editor provider is an asp.net control. The RTE used on your site will depend upon the version and edition of 
DNN you are  using. 

This manual details how to use two different providers for the RadEditor control which are the DotNetNuke.RadEditorProvider (default) 
and the TelerikEditorProvider which are both included with DNN 6+.

Other RTE's which can be integrated with DNN include the FCKEditor and the Free Text Box.



The Default  Editor for DNN 6.0+ (DotNetNuke.RadEditorProvider for the RadEditor) 

Related Topics:

 l See "About the HTML Editor Manager"

Adding Basic Text using Editor
How to add basic text into the Basic Text Box of the Editor. You can also paste basic HTML into the basic text box.

 1. Select the Basic Text Box radio button located above the Editor.

 2. At Render Mode (located below the Editor) select the Text radio button.



 3. Click inside the Editor and then enter or paste (Ctrl + V) your text.

Adding Rich Text Using The Editor
How to add rich text to the Editor. This enables the Editor toolbars and displays the content of the Editor as rich text.

Note: This is the default view for this Editor, however if you last viewed the Editor as the Basic Text Box, it will display as such until it is 
changed.

 1. Select the Rich Text Editor radio button located above the Editor.



 2. Click inside the Editor and then enter your text, insert images, links, etc.

Pasting HTML Content
How to paste HTML content into the Editor control.

 1. Select the Basic Text Box radio button located above the Editor. This displays the Editor as a Basic Text Box. The content 
within the Editor is displayed as HTML.

 2. At Render Mode (located below the Editor), select Html.

 3. Paste in your Html.

Tip: HTML can also be pasted into the Raw Render Mode



Pasting HTML into the HTML module

Viewing Content in Design or HTML View
How to switch between Design and HTML view in the RadEditor.

 1. Click either the Design or HTML tab located below the editor.



RadEditor
About the RadEditor
The RadEditor  is a RTE provides rich text editing capabilities for numerous modules including the HTML, FAQ, Announcements and 
Events modules. The RadEditor provides extensive  text formatting tools, page links, images, flash, script or table insertion. The RadEditor 
offers great table management and design including content layout templates.

This manual details how to use two different providers for the RadEditor control which are the DotNetNuke.RadEditorProvider (default) 
and the TelerikEditorProvider which are included with DNN 6+.



The DotNetNuke.RadEditorProvider (default)



The TelerikEditorProvider

Modifying Editor Size
How to increase or decrease the size of the RadEditor.

 1. Position your mouse over the bottom right corner of the Editor until it becomes a two directional arrow.

 2. Click and drag the Editor larger or smaller as desired. Release when the desired size is displayed.

Tip: An alternative option is to click the  Toggle Full Screen Mode (F11) button to toggle Editor to/from full screen mode.



Modifying Editor Size

Viewing Word and Character Count
The number of words and characters inside the RadEditor is displayed in the bottom right corner. These are updated each time you click 
inside the editor after a modification.



DotNetNuke.RadEditorProvider
About the DotNetNuke.RadEditorProvider
The DotNetNuke.RadEditorProvider is the default RTE provider packaged with DNN (06.00+). It provides rich text editing tools for numer-
ous modules including the HTML, FAQ, Announcements and Events modules.



The DotNetNuke.RadEditorProvider Editor

Related Topics:

 l See "About the HTML Editor Manager"

Toolbars
Main Toolbar
The main toolbar of the DotNetNuke.RadEditorProvider has the following tools:

Tool Icon Description

AJAX Spellchecker Click to enable Spell checking mode. Misspelled words are highlighted in yellow. See "Check 
Spelling"

Find And Replace 
(CTRL + F)

Click the Find And Replace  icon (or CTRL + F) to open the Find / Find And Replace 
dialog box.

Choose to either find, find and replace, or find and replace all instances of the text entered into 
the Find text box. Additional options include Match Case, Match Whole Words, and search up 
or down from the current cursor position.

Select All (CTRL + A) N/A Select all content within the Editor.
Cut (CTRL + X) N/A Cut selected content.
Copy (CTRL + C) N/A Copy selected content.
Paste (CTRL + V) N/A CTRL + V to paste cut or copied content into the Editor.

Paste Options Paste copied content into the Editor. Paste options are Paste; Paste From Word; Paste from 
Word, Strip Font; Paste Plain Text; Paste As Html, PasteHTML.



Tool Icon Description

Undo (CTRL + Z)

Option One: Click the Undo  icon to undo the last action.

Option Two: Click the Arrow  icon to view a list of previous actions and undo multiple 
actions at one time.

Redo (CTRL + Y)

Option One: Click the Redo  icon to redo the last action.

Option Two: Click the Arrow  icon to view a list of previous actions and redo multiple actions 
at one time.

Check Spelling
How to check spelling using the DotNetNuke.RadEditorProvider for the RTE. 

 1. Place your cursor inside the Editor.

 2. Click the AJAX Spellchecker  icon. This starts spell checking. Misspelled words are highlighted in yellow. The first misspelt 
word is ready to perform one of the following actions against:

 l Choose Suggested: Select the correct word from the list of suggested words. If no suggestions are available, then (no sug-
gestions) is displayed.

 l  Ignore/Ignore All: Select to ignore this word and continue with spell checking.

 l  Change Manually: Select and enter word into the provided text box and then click the Change Manually  icon.

 l  Add to Dictionary: Select to add the word to your dictionary.

 3. Repeat for each misspelt word.

 4. Click the Finish Spellchecking button when you are finished - OR - Click the Cancel button to exit Spell checking mode.

Tip: Edit any misspelt word by clicking on it.



Spell Checking using the DotNetNuke.RadEditorProvider RTE

Insert Toolbar
The Insert toolbar of the DotNetNuke.RadEditorProvider RTE has the following tools:

Tool Icon Description

Insert Media

Click the Insert Media icon to open the drop-down list of media insertion tools. Select 
from these options: Insert Media, Document Manager, Flash Manager, Media Man-
ager, or Image Map Editor.

Once you have selected an option, the icon associated with that option is displayed in 
the toolbar. This icon changes each time you make a new selection, which means the 
last selected option is always displayed.



Tool Icon Description

To choose an option other that the one displayed in the toolbar, click the Arrow  
icon.

Insert Media *
Opens the Image Manager which enables you to insert images into the Editor.  The 
properties tab enables you to set the properties of the image to be inserted. See "Insert-
ing Images"

Document Manager * Opens the Document Manager which enables you to  insert a document link into the 
Editor.  Additional link settings are available. See "Inserting a Document"

Flash Manager *
Opens the Flash Manager which enables you to insert Flash (*.swf) into the Editor.  The 
properties tab enables you to set properties of the flash to be inserted. See "Inserting 
Flash"

Media Manager *
Opens the Media Manager which enables you to insert media into the Editor.  The prop-
erties tab enables you to set properties of the media to be inserted. See "Inserting 
Media"

Image Map Editor Opens the Image Map Editor which enables you to create an image map. You must 
first select the image to be mapped. See "Creating an Image Map"

Template Manager * Opens the Template Manager which enables you to insert a template (*.htmtemplate) 
into the Editor. See "Inserting a Template"

Save Template Save the content in the Editor as a new template. See "Saving a Template"

Hyperlink Manager 
(CTRL + K) *

Insert a link, anchor or email link. Additional settings are available. See "Adding an 
Email Link",  "Adding a URL Link"., or "Adding an Anchor".

Remove Link 
(CTRL +SHIFT + K) Removes a link from selected content. See "Deleting a Link"

Link to Portal Page Link to a site of your page. See "Linking to a Portal Page"

* These tools provide access your portal's File Manager where, depending on your authorization level, you can also create folders, as 
well as upload and manage files.

Dropdown Toolbar
The Dropdown toolbar of the DotNetNuke.RadEditorProvider has the following tools:

Tool Icon Description

Insert Symbol

Option One: Click the  Arrow  icon to open the symbol gallery and then select the required 
symbol to be inserted.

Option Two: Click the Insert Symbol  icon to insert the symbol that was inserted pre-
viously.

Insert Table Click the Insert Table  icon to insert a table in the current location - OR - Select Table 
Wizard to design a more complex table. See "Inserting a Table"

New Paragraph Place your cursor in the required location and then select the New Paragraph  icon (or 
CTRL + M) to insert a paragraph break.

Toggle Full Screen Mode 
(F11) Select to toggle the Editor to/from full screen mode.

Formatting Toolbar
The Formatting toolbar of the DotNetNuke.RadEditorProvider RTE has the following tools:



Tool Icon Description
Text Formatting

Bold (CTRL + B) Add/remove bolding to selected content.

Italicize (CTRL + I) Add/remove italics  to selected content.

Underline (CTRL + U) Add/remove underline   to selected content.

Strikethrough Add/remove strikethrough  to selected content.

Indent and Lists

Indent Indent selected content.

Outdent Outdent selected content.

Numbered List Create a numbered list.

Bullet List Create a bullet list.

Other

Convert to Lower Case Transforms all letters in the select text to lower case.

Convert to Upper Case Transforms all letters in the select text to upper case.

Horizontal Rule Inserts a horizontal rule where the cursor is currently located

Paragraph Style Select the paragraph style for the selected text.

Apply CSS Class Select the CSS Class to be applied to the selected content.

Format Stripper

 1. Select the content you want to strip formatting from (such as font color, font 
heading).

 2. Click the  Arrow  icon beside the Strip Formatting button and then select the 
type of formatting to be stripped from these options: Strip All Formatting, Strip 
Css Formatting, Strip Font Elements, Strip Span Elements, Strip Word For-
matting

Content Toolbar
The Content toolbar of the DotNetNuke.RadEditorProvider RTE.

Tip: This toolbar is located below the editor.



Tool Icon Description
Design Click to view content in design mode. This enables all toolbars.

HTML Click to view, add or edit the HTML for this content. This disables all tools 
and toolbars with the exception of the Design button.

Preview Click to preview content inside editor. This disables all tools and toolbars 
with the exception of the Design and Preview buttons.

Words* N/A Displays the number of words inside the RadEditor.
Characters* N/A Displays the number of characters inside the RadEditor.

Resize Editor**

How to increase or decrease the size of the Editor.

 1. Position your mouse over the bottom right corner of the Editor until 
it becomes a two directional arrow.

 2. Click and drag the Editor larger or smaller as desired. Release 
your mouse button when you are finished.

* These fields are updated each time you click inside the editor after a modification.

Managing Images and Media
Using the Resource Manager
How to navigate to, select or manage folders and files using the Resource Manager of the DotNetNuke.RadEditorProvider for the RTE. 
The Resource Manager is commonly used for the Image Manager, Document Manager, Flash Manager, Media Manager and Template 
Manager of the RadEditor.

Note: Access to some tools is restricted by role.

The Resource Manager consists of the following toolbar and windows: Resource Manager Toolbar, Folder Window, Filename Window, 
Preview/Properties Window. 



Resource Manager Toolbar

Tool Icon Description

Back Go back by one folder in the Folders window.

Forward Move forward by one folder in the Folders window.

Refresh Refresh to retrieve newly updated files. 

New Folder
In the Folders window, select the parent folder and then click the New Folder  button.

Delete

 1. Select the image or folder to be deleted and then click the Delete button. This displays the 
message "Are you sure you want to delete the selected file? The selected file may be in 
use. If deleted, some pages will not be displayed properly. Press "OK" to confirm deletion."

 2. Click the OK button to confirm.

Upload
In the Folders window, select the folder where the file will be uploaded to and then click the Upload 

  button.

Folder Window: This window displays the folders of the File Manager using a hierarchical tree structure. Select a folder to view its sub-
folders and/or files in the Filename Window. Folders can be moved by dragging into a different folder. Right click a folder to perform 
Delete, Rename, New Folder or Upload.

Filename Window: Displays a list of the folders and/or files within the selected folder. Select a file to view a preview and/or properties 
information in the Preview/Properties Window.  Files can be moved by dragging into a different folder. Right click an image or folder to per-
form Delete, Rename, New Folder or Upload.

Tip: Click the Collapse/Expand the left pane button to hide/show the Folder Window. This is useful once you have navigated to the 
required folder as it provides additional space to view files details.



Collapse/Expand the left pane

Preview/Properties Window: Displays a preview and/or properties of the selected file. Properties can be modified as required.

Inserting a Document
How to insert a document using the DotNetNuke.RadEditorProvider RTE.

 1. Select  Document Manager from the actions toolbar. This will open the Document Manager.



 2. Navigate to and select the required document. See "Using the Resource Manager"

 3. Optional. In the Link Text text box, modify the text associated with this document. The filename is used by default.

 4. Optional. At            Target select the target window for this link.

 5. Optional. In the Tooltip text box, enter a tool tip to be displayed when a user places their mouse over this link.

 6. Optional. At CSS Class, select a class for the document link.

 7. Click the Insert button.

Tip: Additional document properties are available. See "Setting Document Properties"

The Document Manager

Setting Document Properties
How to set/edit the optional properties of documents inserted using the DotNetNuke.RadEditorProvider for the RTE.

 1. Insert the document.

 2. Right-click on the document and click the                     Properties...  button from the drop-down menu. This opens the Hyperlink Man-
ager.



 3. Add/edit the link, anchor or email address as required.

 4. Click the OK button to confirm.

Inserting Flash
How to insert Flash media using the DotNetNuke.RadEditorProvider for the RTE.  

 1. Select  Flash Manager from the actions toolbar button. This opens the Flash Manager.

 2. Navigate to and select the required Flash. See "Using the Resource Manager"

 3. Optional. Click the Properties tab and set the properties.

 a. At Specify Class ID, select from these options:

 l Check  the check box to set a class for this media. This reveals the Class ID text box.

 i. In the Class ID text box, enter the name of the CSS class to be applied to this Flash.

 ii. Uncheck  the Specify Class ID check box to hide the Class ID field and ensure all other fields can be set.

 l Uncheck  the check box to use the default class.

 b. In the Width text box, enter a pixel value to set the Flash width. Leave this field blank to use the width defined by the Flash.

 c. In the Height text box, enter a pixel value to set the Flash height. Leave this field blank to use the height defined by the 
Flash.

 d. At Quality, select High, Medium or Low as the quality of the Flash.

 e. At Play, check  the check box to auto play the Flash - OR - Uncheck  the check box if the user must select to play the 
Flash.

 f. At Loop, check  the check box to automatically loop the Flash movie repeated - OR - Uncheck  the check box if the 
user must select to replay the Flash.

 g. At Flash Menu, check  the check box to display the Flash menu - OR - Uncheck  the check box to hide it.

 h. At Transparent, check  the check box for a transparent background - OR - Uncheck  the check box to disable.

 i. At HTML Align, select the HTML alignment.



 j. At Flash Align, select the Flash alignment.

 k. At Background Color, select No Color for no background color or select a color from the drop-down box.

 4. Click the Insert button.

Tip: You cannot edit the properties of Flash once it has been inserted. To modify Flash, simply delete it and reinsert it with the required 
properties.

The Flash Manager

Inserting Media
How to insert media (such as sound and movie files) using the DotNetNuke.RadEditorProvider for the RTE.      

 1. Select  Media Manager from the actions toolbar. This opens the Media Manager.



 2. Navigate to and select the required media. See "Using the Resource Manager"

 3. Optional. Click the Properties tab and set the properties.

 a. At Specify Class ID, select from these options:

 l Check  the check box to set a class for this media. This reveals the Class ID text box.

 i. In the Class ID text box, enter the name of the CSS class to be applied to this Flash.

 ii. Uncheck  the Specify Class ID check box to hide the Class ID field and ensure all other fields can be set.

 l Uncheck  the check box to use the default class.

 b. In the Width text box, enter the pixel value to set the media width. Leave blank to use the actual media size.

 c. In the Height text box, enter the pixel value to set the media height. Leave blank to use the actual media size.

 d. At Align, select the alignment.

 e. At Properties select a property to view more information on that property and select Yes or No as required. Repeat for 
each property as required.

 4. Click the Insert button.

Tip: You cannot edit the properties of media once it has been inserted. To modify media, simply delete it and reinsert it with the required 
properties.



The Media Manager

Inserting Images
How to insert an image using the DotNetNuke.RadEditorProvider for the RTE.      

 1. Select  Insert Media (CTRL + G) from the actions toolbar. This opens the Image Manager.

 2. Navigate to and select the required image. See "Using the Resource Manager"

 3. Optional. Use the Best Fit, Actual Size, Zoom In and Zoom Out buttons to modify the previewed image - these changes cannot 
be saved.

 4. Optional. Click the Image Editor button to edit the way the image is displayed. See "Working with the Image Editor"



 5. Optional. Click the Properties tab and set image properties. See "Setting Image Properties"

 6. Click the Insert button.

The Image Manager

Editing an Image
How to edit an image inserted in the DotNetNuke.RadEditorProvider for the RTE.

 1. Select the image to be edited.

 2. Right-click on the image.

 3. Select Properties... from the drop-down menu. This opens the Properties window.

 l To change the image: At Image Src, click the Image Manager  button and then locate and select the new image.

 l Modify any other properties as required. See "Setting Image Properties"

 4. Click the OK button to confirm.

Tip: The new image will inherit the properties of the previous image.

Working with the Image Editor
How to use the Image Editor tool in the Image Manager of the DotNetNuke.RadEditorProvider RTE. This topic  assumes you are currently 
inserting a new image. See "Inserting Images"



 1. Click the Image Editor  button. This opens the Image Editor.

 2. Select from these editing options:

 a. At Opacity, drag the slider to the preferred percentage (%) - OR - Enter the opacity percentage into the % text box.

 b. In the Resize section:

 i. At  Constrain proportions? check  the check box to lock the width/height ratio - OR - Uncheck  the check box 
to allow the width and height to be modified independently.

 ii. At Width and/or Height, drag the slider to the preferred image size - OR - Click the Decrease and Increase buttons. 
The pixel size is displayed in the respective Px text boxes to the right.

 c. At Flip, select a direction to flip the image from these options: None, Flip Horizontal, Flip Vertical, or Flip Both.

 d. At Rotate, select from None, 90°, 180°, or 270°.

 e. At  Crop, click the Enable Crop button. This displays a red box which defines the area to be cropped. You can now define 
the area to be cropped:                        

 i. In the X and Y text boxes, enter the X (vertical) and Y (horizontal) coordinates for the crop area.

 ii. In the Width and Height text boxes, enter the width and height in pixels for the crop area.

 3. In the Save As... text box, a new name for this edited image is displayed. It is in the format of filename_thumb. Modify this name 
as desired. Tip: Remove the _thumb from the file name to override the original file. The image will be saved as a .jpg extension 
file.

 4. At Overwrite If File Exists?, check  the check box to overwrite a file that exists with the name entered in the Save As... text box 
- OR - Uncheck  the check box if you don't want to override an existing file. This enables warning message if the filename 
already exists.

 5. Click the Save button.



Troubleshooting. If the message "A file with a name same as the target already exists!" is displayed, this is preventing you from over-
writing an existing image. Repeat Steps 4 and 6.

Tip: When Cropping an image drag and resize the crop area on the preview image.

Creating an Image Map
How to create an image map using the  DotNetNuke.RadEditorProvider for the RTE.

 1. Insert an image.

 2. Right-click on the image and then select  Image Map Editor from the drop-down list - OR - Select  Image Map Editor from 
the actions toolbar. This will open the Image Map Editor.



 3. To create an area:

 a. At Select Area Shape, select either Rectangle or Circle.

 b. Click the New Area button. This displays a gray box defining the area.

 c. Move and resize the area as required. This updates the Define Area Properties fields for Left, Width, Top and Height.

 d. Optional. In the URL text box, enter the URL to open when a user clicks on this Area.

 i. At Target, select the target for the URL.

 l Target: No target is set and the link will open in the same window. 

 l New Window: Will open a new window.

 l Parent Window: If web page consists of frames, the link will open in the parent frame.

 l Same Window: The link will open in the same window.

 l Browser Window:  The link will open in the same window.

 l Search Pane:

 l Media Pane:Optional. 

 e. In the Alt Text text box, enter the text to be displayed for this area.

 f. Click the Update Area button.

 4. Repeat Step 3 to add additional areas.

 5. These additional editing options are available:

 l To edit an existing area, click on it in the preview window, edit the properties as required and then click the Update Area 
button.

 l To remove an area, click the Remove Area button.

 l To remove all areas, click the Remove All button.

 6. Click the OK button to confirm.



Creating an Image Map

Setting Image Properties
How to set the optional properties of an image using the Image Manager of the  DotNetNuke.RadEditorProvider for the RTE.

 1. If the image has already been inserted, right-click on the image and select Properties... from the drop-down list. Alter-
natively, if you are currently adding the image, click on the Properties tab of the Image Manager.

 2. Click the Lock Ratio  / Unlock Ratio  button  to unlock or lock the width/height ratio at any time. Unlocking the ratio enables 
the width and/or height to be modified independently.

 3. In the Width text box, enter the width in pixels which the image will be displayed as.

 4. In the Height text box, enter the height in pixels which the image will be displayed as.

 5. At Border Color, click the Color Picker button and select the border color. Note: A Border Width must be entered to display the 
border.

 6. In the Border Width text box, enter the pixel width for the border - OR - use the Increase and Decrease arrows.

 7. In the Alt Text text box, enter the alternative text for this image.

 8. In the Long Description text box, enter the long description for this image.

 9. At Image Alignment, click the Alignment Selector button and select the alignment for this image.



 10. At Margin, set any of these fields: 

 a. In the Top text box, enter a pixel value  or use the Increase and Decrease arrows to set the top margin.

 b. In the Bottom text box,  enter a pixel value  or use the Increase and Decrease arrows to set the bottom margin.

 c. In the Right text box, enter a pixel value or use the Increase and Decrease arrows to set the right margin.

 d. In the Left text box, enter a pixel value or use the Increase and Decrease arrows to set the left margin.

 11. At CSS Class, select a class for this image.

 12. Click the OK button.

Setting the properties of an existing image



Setting the properties of an image during insertion

Editing an Image Map
How to edit an image map using the  DotNetNuke.RadEditorProvider for the RTE..

 1. Select the mapped image.

 2. Click the Image Map Editor  button in the toolbar - OR - Right click on the image and then select  Image Map Editor from the 
drop-down menu. This opens the Image Map Editor window.

 3. Add, edit/update and delete mapped areas as required. See "Creating an Image Map"

 4. Click the OK button to save.



Creating an Image Map

Troubleshooting: Image Not Displaying 
Some images may not display in the Editor.

This can occur if the image is set as hidden.

 1. Remove the Hidden property from the image. See "Setting the Hidden Property of a File".

 2. Return to the module to see if the image is displaying. You may need to Refresh (Hold down the Shift key and strike the F5 key) 
the page to see the changes.

This can also occur if module caching is set for too longer period. In this case, extend the caching time as required. See "Configuring 
Cache Settings for a Module"



Troubleshooting: Image Not Displaying in HTML Module

Managing Links and Anchors
Adding an Email Link
How to add an email link to text or an image using the  DotNetNuke.RadEditorProvider for the RTE. Clicking the link opens the user's 
email program with the selected email address in the "Send To" field.

Tip: If you type an email address with a recognized extension directly into the Editor it will  automatically add a "send to" link to the 
address.

 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Select the E-mail tab.

 4. In the Address text box, enter the email address. If you have selected a recognized email address it will be displayed here.

 5. In the Link Text text box, enter the text for this link. Note: This field is not displayed when adding a link to an image.

 6. In the Subject text box, enter a subject which will populate the subject field of the email message.

 7. Optional. At CSS Class, select a class for the link - OR - Select Clear Class to use the default class.



 8. Click the OK button to confirm.

Adding a Page Link
How to insert a link to a page within this site using the TelerikEditorProvider RTE.

 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager with the Hyperlink tab selected.

 3. At Page, select the page for this link from the drop-down list. This displays the URL of the selected page in the URL field below. 
Note: Disabled pages  appear in the list, however they cannot be selected.



 4. The following optional setting are available:

 a. In the Link Text text box, edit the linked text. Note: This field is not displayed when adding a link to an image.

 b. At Target, select the target window for this link. The default option is None which opens the link in the current window.

 c. In the Tooltip text box, enter a tool tip to be displayed when a user places their mouse over this link.

 d. At CSS Class, select a class for the link - OR - Select Clear Class to use the default class.

 e. Check  the Track the number of times this link is clicked check box to enable Link Tracking for this link. The link must 
be saved before you can view the Tracking tab where tracking information is displayed.

 i. Check  the Log the user, date and time for each click check box to also enable the Link Log.

 5. Click the OK button.

Related Topics:

 l See "Viewing Link Tracking Report" 

Adding an Anchor Link
How to create a link  to an anchor using the DotNetNuke.RadEditorProvider for the RTE.

 1. Highlight the text/object to be linked to the anchor.

 2. Click the  Hyperlink Manager (CTRL + K)   button. This opens the Hyperlink Manager with the Hyperlink tab pre-selected.



 3. At Existing Anchor, select the anchor name. This displays the anchor URL in the URL field. E.g. #Fair Labor

 4. The following optional settings are available:

 a. In the Link Text text box, enter/edit the linked text as required.

 b. At Target, select the target for this link - OR - Select None to use the existing window.

 c. In the Tooltip text box, enter the text to be displayed when a user places their mouse over this link.

 d. At       CSS Class, select the CSS class to use.

 e. Check  the Track the number of times this link is clicked check box to enable Link Tracking for this link. The link must 
be saved before you can view the Tracking tab where tracking information is displayed.

 i. Check  the Log the user, date and time for each click check box to also enable the Link Log.

 5. Click the OK button to confirm.

Related Topics:

 l See "Adding an Anchor"

Adding a URL Link
How to insert a link to a URL located on another web site using the  DotNetNuke.RadEditorProvider for the RTE.

 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager with the Hyperlink tab pre-selected.

 3. In the URL text box, enter the URL address for this link.



 4. Optional. In the Link Text text box, enter the text for this link. If you highlighted text at Step 1, then this field will be pre-populated 
with that text. Note: This field is not displayed when adding a link to an image.

 5. Optional. At Target, select the target window for this link.

 6. Optional. In the Tooltip text box, enter a tool tip to be displayed when a user places their mouse over this link.

 7. Optional. At CSS Class, select a class for the link - OR - Select Clear Class to use the default class.

 8. Click the OK button to confirm.

Linking to a Portal Page
How to link to any page of your portal using the  DotNetNuke.RadEditorProvider for the RTE. Note: You can only select links which you 
are authorized to view. E.g. Only Administrators can link to the Admin Console pages.

 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the Link to Portal Page drop-down box on the actions toolbar.



 3. Maximize  the Portal Links heading to display a list of your site pages.

 4. Locate and select the page for this link.

Tip: If you didn't select any text/object at Step 1, then the page name is used as the linked text. E.g. If you link to the Home page, then a 
Home link is inserted.

Viewing Link Tracking Report
How to view tracking information for a tracked link within the TelerikEditorProvider RTE. In additional the tracking report displays data for 
the selected date range.

 1. Select the linked text or object, and then click the  Hyperlink Manager (CTRL + K)  button - OR - Right-click on the linked item 
and select Properties... from the drop-down menu. This opens the Hyperlink Manager with the Hyperlink tab selected.

 2. Select the Tracking tab. 

 3. In the Link Info section, the following information is displayed:

 l URL: The URL for this link. E.g. http://ecozany.com/Store.aspx

 l Created: The date this link was created. 12/22/2010 8:42:27 AM

 l Tracking URL: The tracking URL for this link. E.g. http://ecozany.com/LinkClick.aspx?link=63&tabid=41&mid=386

 l Clicks: The number of times this link has been clicked.

 l Last Click: The date and time when the link was last clicked.



 4. In the Tracking Report section, complete the following to view the report:

 a. At Start Date, click the Calendar  button. This displays the current month with today's date highlighted. Select a new 
date if required. See "Working with the RADCalendar"

 b. At End Date, click the Calendar  button. This displays the current month with today's date highlighted. Select a new 
date if required.

 c. Click the Display button. This displays the date and time when the link was clicked and the first and last name of authen-
ticated users.



 5. Click the Cancel button to close the Hyperlink Manager.

Working with the RADCalendar
The RADCalendar is  date selection tool which is used when viewing link tracking reports within the TelerikEditorProvider RTE.

Selecting a Date
Step One - View the required Month/Year in Calendar



 1. Click the Calendar  button. This opens the RADCalendar. Here's an overview of the date selection options available for the 
RADCalendar:

 l View Calendar for Another Month:

 l Click the <<  button view calendar from three months ago

 l Click the <  button to view calendar for the previous month

 l Click the >  button to advance the calendar by one month

 l Click the >>  button advance the calendar by three months

 l View Calendar for Today:

 1. Click the Month/Date  above the calendar.

 2. Click a month to view that month for the selected year.

 3. Click the Today link.

 l View Calendar for Another Month/Year:

 1. Click the Month/Date  above the calendar.

 2. Click a month to view that month for the selected year. 

 3. Click a different year to view if required.

 4. Optional. If the required year is not displayed, then click either the << or >> buttons below the displayed years. This dis-
plays the previous or next ten years respectively.

 5. Click the OK button to view the calendar for the selected month/year.

Tip: Click the Cancel link to cancel any selection and return to calendar. 

Step Two - Selecting the Date

 1. Click on a date in the calendar to select it. This closes the pop-up window and displays the selected date in the associated field.

Related Topics:



 l See "Viewing Link Tracking Report"

Editing an Email or URL Link
How to edit a link in the  DotNetNuke.RadEditorProvider for the RTE.

Option One:

 1. Select the linked text or object.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Edit the link as required. For more details on the available fields, See "Adding an Email Link"  or See "Adding a URL Link"

 4. Click the OK button.

Option Two:

 1. Right-click on the linked text or object.

 2. Select Properties... from the drop-down menu. This opens the Hyperlink Manager.

 3. Edit the link as required. For more details on the available fields, See "Adding an Email Link" or See "Adding a URL Link"

 4. Click the OK button.

Editing a Portal Page Link
How to edit a link to a page in your site in the DotNetNuke.RadEditorProvider for the RTE.

 1. Click on or highlight the linked text/object.

 2. Click the Link to Portal Page drop-down box on the actions toolbar.

 3. Select a new link.

Deleting a Link
How to remove a link from the  DotNetNuke.RadEditorProvider for the RTE.

Option One:

 1. Select the linked text or object. 

 2. Click the  Remove Link (CTRL + SHIFT + K) button.

Option Two:

 1. Right-click on the linked text or object.

 2. Select Remove Link from the drop-down menu. This opens the Hyperlink Manager.

Adding an Anchor
How to create an anchor using the  DotNetNuke.RadEditorProvider for the RTE. An anchor is a location within this content which can be 
linked to using the Hyperlink Manager. Note: Links to this anchor can only be created in this instance of this module.

 1. Place your cursor where you want to insert the anchor - OR - Highlight the text or object for the anchor. Note: Text may display link 
formatting even though there is no link.



 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Select the Anchor tab.

 4. In the Name text box, enter an anchor name.

 5. Click the OK button to confirm.

Editing an Anchor
How to edit an anchor using the  DotNetNuke.RadEditorProvider for the RTE.

Option One:

 1. Select the anchored text or object. 

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Edit the anchor as required.

 4. Click the OK button to confirm.

Option Two: 

 1. Right-click on the linked text or object.

 2. Select Properties... from the drop-down menu. This opens the Hyperlink Manager.

 3. Edit the anchor as required.

 4. Click the OK button to confirm.

Deleting an Anchor
How to delete an anchor (bookmark) from the DotNetNuke.RadEditorProvider for the RTE.



Option One: Use this option when the anchor has been created by first selecting text or an object.

 1. Select the linked text or object.

 2. Click the  Remove Link (CTRL + SHIFT + K)  button.

Option Two: Use this option when the anchor has been added to the editor by placing the cursor in a location.

 1. Select the HTML tab.

 2. Locate and delete the anchor HTML which will look something like <a name="anchor name"></a>

Managing Tables
Inserting a Table
How to insert a table using the DotNetNuke.RadEditorProvider.

 1. Place you cursor where you want to insert the table.

 2. Click the  Insert Table  button.

 3. Select for these options:

 l To insert a basic table, move your cursor to highlight the number of rows or columns for the table and then click to select 
it. This displays the basic table  in the Editor.

 l To design a more complex table, click the Table Wizard button. See "Setting the Table Design"



Editing a Table
How to edit a table using the right click menu or the Table Wizard of the DotNetNuke.RadEditorProvider for the RTE.

 1. Place your cursor inside the table. Note: If you want to use the drop-down menu to modify the table design (rather than the Table 
Wizard) then place your cursor in the cell where you want to perform the modification.

 2. Right-click using your mouse. This displays the drop-down menu. 

 3. Select an option to modify the rows, columns or cells of the table - OR - Select either the  Table Properties or  Cell Prop-
erties option to use the Table Wizard to modify the table.

 4. Click the OK button to confirm.



Editing a Table

Setting Table Properties
How to set the optional properties of a new or existing table using the Table Wizard of the DotNetNuke.RadEditorProvider for the RTE.

 1. Open the Table Wizard. See "Inserting a Table" - OR - Right-click on an existing table and then select  Table Properties from 
the drop-down menu.

 2. Go to the Table Properties tab and set any of these optional settings:

 3. In the Dimensions section:

 a. In the Height text box, set the table height in either pixels or as a percentage by either typing a value into the text box or by 
using the Increase  and Decrease  buttons. The value will automatically be saved in pixels unless you enter the per-
centage symbol (%) into the text box. E.g. Enter 100px or 100 to set the height as 100 pixels, or enter 100% to set the 
height as 100%. Leave blank for no specified height.

 b. In the Width text box, set the table width in either pixels or as a percentage as for height. Leave blank for no specified 
width.

 4. In the Layout section:

 a. In the Cell Spacing text box, enter a number to set the pixel spacing between cells - OR - Use the Increase  and 
Decrease  buttons. 



 b. In the Cell Padding text box, enter a number to set the pixel padding between cells - OR - Use the Increase  and 
Decrease  buttons.

 c. At Alignment, click the arrow of the Alignment Selector  button and select the table alignment.

 d. At Background Color, click the Color Picker  button and select the background color.

 e. At Style Builder, click the Style Builder  button and build one or more styles. See "Using the Style Builder"

 f. At CSS Class, select a class for the content of this table.

 g. At Back Image, click the Image SRC  button and select a background image for the table.

 h. In the Id text box, enter an Id reference for this table.

 5. In the CSS Class Layout section:

 a. Select a CSS layout design from the drop-down box. The design is displayed in the Preview window below.

 b. At Apply Special Formats To, select which rows or column you want to apply special formatting to. You can see the 
changes in the Preview window below.

 6. Optional. Select a new tab to set additional properties. 

 7. Click the OK button.



Setting Table Properties

Showing/Hiding Table Border
How to hide or show the table borders using the Table Wizard of the DotNetNuke.RadEditorProvider for the RTE.

 1. Place your cursor on the outer edge of the table. The cursor will change to show the table can be selected.

 2. Right-click and select  Show/Hide Border from the drop-down menu to either hide or show the table border.



Setting Cell Properties
How to set the optional cell properties of a new or existing table using the Table Wizard of the DotNetNuke.RadEditorProvider for the 
RTE. The below tutorial demonstrates how to add a background color to the first row of your table.

 1. Right-click inside a cell of an existing table and select  Cell Properties from the drop-down menu. 



 2. This opens the Cell Properties tab of the Table Wizard.



 3.  At Preview, select the cells you want to set the properties of:

 l  To select a single cell, click on that cell. The selected cell is highlighted.

 l To select multiple cells, hold down the Ctrl key and click on cell to select it - OR - Click the                     Select All link and then hold 
down the Ctrl key and click on one or more cells to deselect them. The selected cells are highlighted.

 4. At Cell Properties, set any of the following:

 a. In the Height text box, set the cell height in either pixels or as a percentage by either typing a value into the text box or by 
using the Increase  and Decrease  buttons. The value will automatically be saved in pixels unless you enter the per-
centage symbol (%) into the text box. E.g. Enter 100px or 100 to set the height as 100 pixels, or enter 100% to set the 
height as 100%. Leave blank for no specified height.

 b. In the Width text box, set the cell width in either pixels or as a percentage as for height. Leave blank for no specified width.

 c. At Content Alignment, click the arrow of the Alignment Selector button and select the alignment of content.

 d. At Background Color, click the Color Picker  button and select the background color.



 e. At Style Builder, click the Style Builder  button and build one or more styles. See "Using the Style Builder"

 f. At CSS Class, select a class for this/these cells.

 g. At Back Image, click the Image Manager   button and select a background image for the table.

 h. In the Id text box, enter an Id reference for this/these cells.

 i. At No Text Wrapping, check  the check box to disallow text within this/these cells from wrapping to another line - OR - 
Uncheck  the check box to allow text to wrap.

 5. Click the OK button to confirm. Alternatively, you can select another tab of the Table Wizard to set more properties.



Setting Cell Properties

Setting Table Accessibility
How to set the accessibility of a new or existing table using the Table Wizard of the DotNetNuke.RadEditorProvider for the RTE. The 
below tutorial demonstrates how to set one heading row and add a caption to the table.

 1. Right-click inside a cell of an existing table and select  Table Properties - OR - Open the Table Wizard (See "Inserting a 
Table"



 2. Select the Accessibility tab and set any of these Accessibility Options:

 a. In the Heading Rows text box, enter the number of rows which are headings. The maximum number of  heading rows for 
the current table is displayed to the right of this field. E.g. 1

 b. In the Heading Columns text box, enter the number of columns which are headings. The maximum number of  heading col-
umns for the current table is displayed to the right of this field.

 c. In the Caption text box, enter a caption to be displayed above the table.

 d. row associated with the Alignment Selector button and then select the alignment of the caption. If no alignment is 
selected, the default is center alignment.

 e. In the Summary text box, enter a summary of the table contents. The table summary isn't displayed on the page, but can 
be read using accessibility tools such as text readers.

 f. At Associate Cells With Headers, check  the check box to associate cells with headers - OR - uncheck  the check 
box to disable. 

 g. Optional. Select a new tab to set additional properties.

 3. Click the OK button to confirm.



Setting Table Accessibility by adding a table caption and a header row.

Using the Table Wizard
How to design a table using the Table Wizard of the DotNetNuke.RadEditorProvider for the RTE.

 1. Click the  Insert Table  button.

 2. Select Table Wizard. This opens the Table Wizard on the Table Design tab. A table of two columns by two rows is displayed as 
the basis for your design.

 3. Optional. Select a cell. This enables the Increase and Decrease buttons which are available to change the design.

 4. Select an Increase or Decrease button to modify the table design. You can choose to add columns and rows, as well as span col-
umns and rows.

 5. Optional. Change tabs to set other properties. 

 6. Click the OK button to confirm.

Setting the Table Design
How to set the design a table using the Table Wizard of the DotNetNuke.RadEditorProvider for the RTE.

 1. Right-click on an existing table and select  Table Properties - OR - Open the Table Wizard. See "Inserting a Table" 

 2. Select the Table Design tab. If you are adding a new table, a table of two columns by two rows is displayed as the basis for your 
design. If you are editing an existing table, your current design is displayed.

 3. To modify the table, perform any of these actions:

 l To add a column: At Columns, click the Increase  button.

 l To remove a column: At Columns, click the Decrease  button.



 l To insert a column span: select a cell and then at Column Span, click the Increase  button.

 l To remove a column span: select a cell and then at Column Span, click the Decrease  button.

 l To add a row: At Rows, click the Increase  button.

 l To remove a row: At Row, click the Decrease  button.

 l To insert a row span: select a cell and then at Row Span, click the Increase  button.

 l To remove a row span: select a cell and then at Row Span, click the Decrease  button.

 4. Optional. Select a new tab to set additional properties.

 5. Click the OK button to confirm.

Deleting a Table
How to delete a table from the DotNetNuke.RadEditorProvider for the RTE.

Option One:



 1. Click on the corner of the table to select it.

 2. Strike the Delete button on your keyboard.

Option Two: 

 1. Click on the corner of the table to select it.

 2. Click on the corner of the table to select it. and select Delete Table  from the drop-down menu.

Option Three:  

 1. Place your cursor before or after the table.

 2. Strike either the Backspace or Delete button on your keyboard respectively.

Managing Templates
Inserting a Template
How to insert a template using the DotNetNuke.RadEditorProvider for the RTE.

 1. Place you cursor where you want to insert the template.

 2. Select  Template Manager from the actions toolbar. This opens the Template Manager.



 3. Navigate to and select the required template. Note: Templates are typically stored in the Portal Root > Templates folder. See 
"Using the Resource Manager"

 4. Click the Insert button. This inserts the template into the editor read for you to edit.

Saving a Template
How to create and save a template using the DotNetNuke.RadEditorProvider for the RTE.

 1. Create your template by adding text, images, tables, etc as desired.

 2. Select  Save Template from the actions toolbar. This opens the Save As Template window.

 3. At Folder, select the folder where the template will be saved to.

 4. In the File Name text box, enter a name for this template.

 5. At Overwrite If File Exists?, check  the check box to overwrite any template that exists with this template - OR - Uncheck  the 
check box if you don't want to override an existing file. This enables warning message if a template with this name already exists.

 6. Click the Save button. 

 l If there is no conflict with overwriting, the message "The template was saved successfully'" is displayed. Click OK to close 
the window. 

 l If there is a conflict, a message reading "The template was not saved. The following error was reported:   The file already 
exists" is displayed. In this case, repeat Steps 2-6, entering a different file name.



TelerikEditorProvider
Overview of the TelerikEditorProvider
The TelerikEditorProvider for the RTE is included with DNN, however since it isn't the default provider, it must be set as the preferred RTE 
by your Host.

The TelerikEditorProvider RadEditor

Toolbars
Actions Toolbar
The actions toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description

Print (CTRL + P)

Print all Editor content. Depending on your computer set-up you may be able to print to a 
printer and/or create  an XPS document.

Print Options:

 l Print All Linked Documents: Creates separate printouts for each link. E.g. Page links dis-
play the page. Document content is not printed in full.

 l Print Table of Links: A reference table of any links is appended to the printout.



Tool Icon Description

AJAX Spellchecker Click to enable Spell checking mode. Misspelled words are highlighted in yellow. See "Check 
Spelling"

Find & Replace 
(CTRL + F)

Click the Find And Replace  icon (or CTRL + F) to open the Find / Find And Replace 
dialog box.

Choose to either find, find and replace, or find and replace all instances of the text entered into 
the Find text box. Additional options include Match Case, Match Whole Words, and search up 
or down from the current cursor position.

Select All (CTRL + A) Select all content within the Editor.

Cut (CTRL + X) Cut selected content.

Copy (CTRL + C) Copy selected content.

Paste (CTRL + V) CTRL + V to paste cut or copied content into the Editor.

Paste Options Paste copied content into the Editor. Paste options are Paste; Paste From Word; Paste from 
Word, Strip Font; Paste Plain Text; Paste As Html, PasteHTML.

Undo (CTRL + Z)

Option One: Click the Undo icon to undo the last action.

Option Two: Click the Arrow icon to view a list of previous actions and undo multiple actions at 
one time.

Redo (CTRL + Y)

Option One: Click the Redo icon to redo the last action.

Option Two: Click the Arrow icon to view a list of previous actions and redo multiple actions at 
one time.

Check Spelling
How to check spelling using the TelerikEditorProvider RTE.

 1. Place your cursor inside the Editor.

 2. Click the AJAX Spellchecker  icon. This starts spell checking. Misspelled words are highlighted in yellow. The first misspelt 
word is ready to perform one of the following actions against:

 l Choose Suggested: Select the correct word from the list of suggested words. If no suggestions are available, then (no sug-
gestions) is displayed.

 l  Ignore/Ignore All: Select to ignore this word and continue with spell checking.

 l  Change Manually: Select and enter word into the provided text box and then click the Change Manually  icon.

 l  Add to Dictionary: Select to add the word to your dictionary.

 3. Repeat for each misspelt word.

 4. Click the Finish Spellchecking button when you are finished - OR - Click the Cancel button  to exit Spell checking mode.

Tip: Edit any misspelt word by clicking on it.



Spell Checking using the RadEditor

Color and CSS Toolbar
The Color and CSS toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description

Foreground Color
Option One: Click the  Arrow  icon associated with the Foreground Color button open 
the color picker and then select the required foreground color for the selected content.

Option Two: Click the Foreground Color icon to apply the used last color to the content.

Background Color

Option One: Click the  Arrow  icon associated with the Background Color button to open 
the color picker and then select the required background color for the selected content.

Option Two: Click the Background Color icon to apply the used last color to the selected 
content.

Apply CSS Class Select the CSS Class to be applied to the selected content.

Format Stripper
 1. Select the content you want to strip formatting from (such as font color, font head-

ing).



Tool Icon Description

 2. Click the  Arrow  icon associated with the Strip Formatting button and then select 
the type of formatting to be stripped from these options: Strip All Formatting, Strip 
Css Formatting, Strip Font Elements, Strip Span Elements, Strip Word Formatting.

Content Toolbar
The Content toolbar of the TelerikEditorProvider RTE.

Tip: This toolbar is located below the editor.

Tool Icon Description
Design Click to view content in design mode. This enables all toolbars.

HTML Click to view, add or edit the HTML for this content. This disables all 
tools and toolbars with the exception of the Design button.

Words* N/A Displays the number of words inside the RadEditor.
Characters* N/A Displays the number of characters inside the RadEditor.

Resize Editor**

Increase or decrease the Editor window size.

 1. Position your mouse over the bottom right corner of the Editor 
until it becomes a two directional arrow.

 2. Click and drag the Editor larger or smaller as desired. Release 
your mouse button when you are finished.

Tip: A similar tool is the  Toggle Full Screen Mode (F11) button 
which toggles the Editor between the current editor size and the full 
screen of the edit page.

* These fields are updated each time you click inside the editor after a modification.

Fonts and Font Size Toolbar
The Fonts and Font Size toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description
Paragraph Style Set the paragraph style for the selected text.

Font Name Set the font for the selected text.



Tool Icon Description
(CTRL + SHIFT + F) 
Real Font Size 
(CTRL + SHIFT + P) Set the font size in pixels for the selected text.

Formatting Toolbar
The Formatting toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description
Text Formatting
Bold (CTRL + B) Add/remove bolding to selected content.

Italicize (CTRL + I) Add/remove italics  to selected content.

Underline (CTRL + U) Add/remove underline   to selected content.

Strikethrough Add/remove strikethrough  to selected content.

Alignment
Align Left Left  align the selected content.

Align Center Center  align the selected content.

Align Right Right align the selected content.

Justify Justify align the selected content.

Remove Alignment Remove alignment formatting from selected content.

Indent and Lists
Indent Indent selected content.

Outdent Outdent selected content.

Numbered List Create a numbered list.

Bullet List Create a bullet list.

Other
Show/Hide Borders Click to show or hide all table borders. This is useful where table borders are not displayed.

XHTML Validator
Click to open the XHTML Validator window. At the very top of the window, select the radio but-
ton to set the type of XHTML validation you wish to perform. This displays the validation results 
and details.

Paragraph  Toolbar
The Paragraph toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description
SuperScript Transforms selected content to superscript.

Subscript Transforms selected content to subscript.

New Paragraph Inserts a new paragraph.

Insert Groupbox Inserts a group box. Use to layout forms and to label sections of your content.



Tool Icon Description
Horizontal Rule Inserts a horizontal line.

Insert Date Inserts the current date according to your computer.

Insert Time Inserts the current time according to your computer.

Format Code Block Enables you to insert and format a block of code and have it render as text. See "Formatting 
Code Block"

Formatting Code Block
How to insert a code block in the TelerikEditorProvider RTE.

 1. Place your cursor where you want to place the code block.

 2. Click the Format Code Block  button. This opens the Format Code Block window.

 3. In the Paste Source Code Below text box, paste the source code.

 4. In the Options section complete the following:

 5. Optional. In the Max Snippet Width text box, set the maximum width of the code block in either pixels or as a percentage. Do this 
by either typing a value into the text box or by using the Increase  and Decrease  buttons. The value will automatically be 
saved as pixels unless you enter the percentage symbol (%) into the text box. E.g. Enter 100px or 100 to set the width as 100 pix-
els, or enter 100% to set the width as 100%. Leave blank for no specified width.

 6. Optional. In the Max Snippet Height text box, set the maximum height of the code block in either pixels or as a percentage. Leave 
blank for no specified width.

 7. At Select Language, select the language of the code block from these options: Markup - (x)HTML, XML, ASPX, ..."; Javascript, 
CSS, C#, CPP, VB, Php, SQL, Delphi, or Python.

 8. At Display Line Numbers, check  the check box to display line numbers for each line of code - OR - Uncheck  the check box 
to disable numbering.



 9. Optional. Click the Preview button to preview the code in the Preview window below.



 10. Click the OK button to insert the code block.

Resources Toolbar
The Resources toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description
Image Manager  
(CTRL + G) *

Opens the Image Manager which enables you to insert images into the Editor.  The properties 
tab enables you to set properties of the image to be inserted.

Document Manager * Opens the Document Manager which enables you to  insert a document link into the Editor.  
Additional link settings are available.

Flash Manager * Opens the Flash Manager which enables you to insert Flash (*.swf) into the Editor.  The prop-
erties tab enables you to set properties of the flash to be inserted.

Media Manager * Opens the Media Manager which enables you to insert media into the Editor.  The properties 
tab enables you to set properties of the media to be inserted.

Template Manager * Opens the Template Manager which enables you to insert a template (*.htmtemplate) into the 
Editor.



Tool Icon Description
Save Template Save the content in the Editor as a new template.

Hyperlink Manager 
(CTRL + K) * Insert a link, anchor or email link. Additional settings are available.

Remove Link 
(CTRL +SHIFT + K) Removes a link from selected content.

* These tools provide access your portal's File Manager where, depending on your authorization level, you can also create folders, as 
well as upload and manage files.

Tables and Tools Toolbar
The Tables and Tools toolbar of the TelerikEditorProvider RTE has the following tools:

Tool Icon Description

Insert Sym-
bol

Option One: Click the  Arrow  icon to open the symbol gallery and then select the required symbol to be inserted.

Option Two: Click the Insert Symbol icon to insert the symbol that was inserted previously.
Insert 
Table Click on the number of rows/columns to insert a basic table - OR - Select Table Wizard to design a more complex table.

Insert Code 
Snippet Click to insert a predefined code snippet.

Set Abso-
lute Posi-
tion

Select the required image and then click the                    Set Absolute Position  button. Drag the image to the required absolute posi-
tion.

Image Map 
Editor Click to open the Image Map Editor where you can configure an image map for this image.

Convert to 
Lower 
Case

Transforms selected text to lower case.

Convert to 
Upper 
Case

Transforms selected text to upper case.

Module 
Manager

Click the Arrow  icon to access the drop-down menu and choose to enable or disable Statistics. Enabling Statistics displays the 
current number of words and characters inside the RadEditor in the bottom right corner of the Editor. These statistics are updated 
each time you click inside the editor following a edit.



Tool Icon Description

Toggle Full 
Screen 
Mode (F11)

Select to toggle the Editor to/from full screen mode.

Track 
Changes

Click to view the changes between your initial content and current content. Content changes are marked up with green back-
ground for new content and red strikethrough for deleted content.

Emoticons Insert Current Emoticon: Click on the Emoticons  icon to insert the emoticon which is currently displayed on the button. 
Note: The last emoticon inserted during this editing session is displayed. The Angel Smile emoticon is displayed by default.

  Insert Different Emoticon: Click on the Arrow  icon to select a different emoticon. This will insert the selected emoticon and 
set it as the default emoticon for this session.



Tool Icon Description

About Rad-
Editor Opens the About RadEditor window which has a link more information on the RadEditor.

General Tools
Formatting Toolbar
The Formatting toolbar of the RadEditor has the following tools:

Tool Icon Description
Text Formatting
Bold (CTRL + B) Add/remove bolding to selected content.

Italicize (CTRL + I) Add/remove italics  to selected content.

Underline (CTRL + U) Add/remove underline   to selected content.

Strikethrough Add/remove strikethrough  to selected content.

Alignment
Align Left Left  align the selected content.

Align Center Center  align the selected content.

Align Right Right align the selected content.

Justify Justify align the selected content.

Remove Alignment Remove alignment formatting from selected content.

Indent and Lists
Indent Indent selected content.

Outdent Outdent selected content.

Numbered List Create a numbered list.

Bullet List Create a bullet list.

Other

Show/Hide Borders Click to show or hide all table borders. This is useful where table borders are not dis-
played.

XHTML Validator
Click to open the XHTML Validator window. At the very top of the window, select the 
radio button to set the type of XHTML validation you wish to perform. This displays the 
validation results and details.

Formatting Code Block
How to insert a code block in the RADeditor Rich Text Editor



 1. Place your cursor where you want to place the code block.

 2. Click the Format Code Block  button. This opens the Format Code Block window.

 3. In the Paste Source Code Below text box, paste the source code.

 4. In the Options section complete the following:

 5. Optional. In the Max Snippet Width text box, set the maximum width of the code block in either pixels or as a percentage. Do this 
by either typing a value into the text box or by using the Increase  and Decrease  buttons. The value will automatically be 
saved as pixels unless you enter the percentage symbol (%) into the text box. E.g. Enter 100px or 100 to set the width as 100 pix-
els, or enter 100% to set the width as 100%. Leave blank for no specified width.

 6. Optional. In the Max Snippet Height text box, set the maximum height of the code block in either pixels or as a percentage. Leave 
blank for no specified width.

 7. At Select Language, select the language of the code block from these options: Markup - (x)HTML, XML, ASPX, ..."; Javascript, 
CSS, C#, CPP, VB, Php, SQL, Delphi, or Python.

 8. At Display Line Numbers, check  the check box to display line numbers for each line of code - OR - Uncheck  the check box 
to disable numbering.



 9. Optional. Click the Preview button to preview the code in the Preview window below.

 10. Click the OK button to insert the code block.

Resources Toolbar
The Resources toolbar of the RadEditor has the following tools:

Tool Icon Description

Image Manager  (CTRL + G) * Opens the Image Manager which enables you to insert images into the Editor.  
The properties tab enables you to set properties of the image to be inserted.

Document Manager * Opens the Document Manager which enables you to  insert a document link into 
the Editor.  Additional link settings are available.

Flash Manager * Opens the Flash Manager which enables you to insert Flash ( *.swf ) into the 
Editor.  The properties tab enables you to set properties of the flash to be inserted.



Tool Icon Description

Media Manager * Opens the Media Manager which enables you to insert media into the Editor.  The 
properties tab enables you to set properties of the media to be inserted.

Template Manager * Opens the Template Manager which enables you to insert a template ( *.htmt-
emplate ) into the Editor.

Save Template Save the content in the Editor as a new template.

Hyperlink Manager (CTRL + K) * Insert a link, anchor or email link. Additional settings are available.

Remove Link (CTRL +SHIFT + K) Removes a link from selected content.

* These tools provide access your portal's File Manager where, depending on your authorization level, you can also create folders, as 
well as upload and manage files.

Tables and Tools Toolbar
The Tables and Tools toolbar of the RadEditor has the following tools:

Tool Icon Description
Insert Sym-
bol

OPTION ONE: Click the  Arrow icon to open the symbol gallery and then select the required symbol to be inserted.
OPTION TWO: Click the Insert Symbol icon to insert the symbol that was inserted previously.

Insert 
Table Click on the number of rows/columns to insert a basic table - OR - Select Table Wizard to design a more complex table.

Insert 
Code 
Snippet

Click to insert a predefined code snippet.

Set Abso-
lute Posi-
tion

Select the required image and then click the          Set Absolute Position  button. Drag the image to the required absolute posi-
tion.

Image 
Map 
Editor

Click to open the Image Map Editor where you can configure an image map for this image.

Convert to 
Lower 
Case

Transforms selected text to lower case.

Convert to 
Upper 
Case

Transforms selected text to upper case.

Module 
Manager

Click to access the drop-down menu and choose to enable or disable Statistics. Enabling Statistics displays the current number 
of words and characters inside the RadEditor in the bottom right corner of the Editor. These statistics are updated each time you 
click inside the editor following a edit.



Tool Icon Description

Toggle 
Full 
Screen 
Mode
(F11)

Select to toggle Editor to/from full screen mode.

Track 
Changes

Click to view the changes between your initial content and current content. Content changes are marked up with green back-
ground for new content and red strikethrough for deleted content.

Emoticons Insert Current Emoticon: Click on the Emoticons  icon to insert the emoticon which is currently displayed on the button. 
Note: The last emoticon inserted during this editing session is displayed. The Angel Smile emoticon is displayed by default.

  
Insert Different Emoticon: Click on the Arrow button to select a different emoticon. This will insert the selected emoticon and set 
it as the default emoticon for this session.



Tool Icon Description

About 
RadEditor Opens the About RadEditor window which has a link more information on the RadEditor.

Managing Images and Media
Using the Resource Manager
How to navigate to, select or manage folders and files using the Resource Manager provided with the TelerikEditorProvider for the RTE. 
The Resource Manager is commonly used for the Image Manager, Document Manager, Flash Manager, Media Manager and Template 
Manager tools of the RadEditor.

Note: Access to some tools is restricted by role.

The Resource Manager consists of the following toolbar and windows: Resource Manager Toolbar, Folder Window, Filename Window, 
Preview/Properties Window. 

Resource Manager Toolbar



Tool Icon Description

Back Go back by one folder in the Folders window.

Forward Move forward by one folder in the Folders window.

Refresh Refresh to retrieve newly updated files. 

New Folder
In the Folders window, select the parent folder and then click the New Folder  button.

Delete

 1. Select the image or folder to be deleted and then click the Delete button. This displays 
the message "Are you sure you want to delete the selected file? The selected file may 
be in use. If deleted, some pages will not be displayed properly. Press "OK" to confirm 
deletion."

 2. Click the OK button to confirm.

Upload
In the Folders window, select the folder where the file will be uploaded to and then click the  

Upload   button.
   

Folder Window: This window displays the folders of the File Manager using a hierarchical tree structure. Select a folder to view its sub-
folders and/or files in the Filename Window. Folders can be moved by dragging into a different folder. Right click a folder to perform 
Delete, Rename, New Folder or Upload.

Filename Window: Displays a list of the folders and/or files within the selected folder. Select a file to view a preview and/or properties 
information in the Preview/Properties Window.  Files can be moved by dragging into a different folder. Right click an image or folder to per-
form Delete, Rename, New Folder or Upload.

Tip: Click the Collapse/Expand the left pane button to hide/show the Folder Window. This is useful once you have navigated to the 
required folder as it provides additional space to view files details.



Preview/Properties Window: Displays a preview and/or properties of the selected file. Properties can be modified as required.

Inserting a Document
How to insert a document using the TelerikEditorProvider for the RTE.

 1. Click the  Document Manager  button. This opens the Document Manager.

 2. Navigate to and select the required document. See "Using the Resource Manager"

 3. Optional. In the Link Text text box, modify the text associated with this document. The filename is used by default.

 4. Optional. At            Target select the target window for this link.

 5. Optional. In the Tooltip text box, enter a tool tip to be displayed when a user places their mouse over this link.

 6. Optional. At CSS Class, select a class for the document link.

 7. Click the Insert button.

Tip: Additional document properties are available. See "Setting Document Properties"



Inserting a Document

Setting Document Properties
How to set/edit the optional properties of documents inserted using the TelerikEditorProvider for the RTE.

 1. Insert the document.

 2. Right-click on the document and click the                  Properties...  button from the drop-down menu. This opens the Hyperlink Man-
ager.

 3. Edit the link as required.

 4. Click the OK button to confirm.

Inserting Flash
How to insert Flash media using the TelerikEditorProvider for the RTE.  

 1. Click the  Flash Manager  button. This opens the Flash Manager.

 2. Navigate to and select the required Flash. See "Using the Resource Manager"



 3. Optional. Click the Properties tab and set the properties.

 a. At Specify Class ID, select from these options:

 l Check  the check box to set a class for this media. This reveals the Class ID text box.

 i. In the Class ID text box, enter the name of the CSS class to be applied to this Flash.

 ii. Uncheck  the Specify Class ID check box to hide the Class ID field and ensure all other fields can be set.

 l Uncheck  the check box to use the default class.

 b. In the Width text box, enter a pixel value to set the Flash width. Leave this field blank to use the width defined by the Flash.

 c. In the Height text box, enter a pixel value to set the Flash height. Leave this field blank to use the height defined by the 
Flash.

 d. At Quality, select High, Medium or Low as the quality of the Flash.

 e. At Play, check  the check box to auto play the Flash - OR - Uncheck  the check box if the user must select to play the 
Flash.

 f. At Loop, check  the check box to automatically loop the Flash movie repeated - OR - Uncheck  the check box if the 
user must select to replay the Flash.

 g. At Flash Menu, check  the check box to display the Flash menu - OR - Uncheck  the check box to hide it.

 h. At Transparent, check  the check box for a transparent background - OR - Uncheck  the check box to disable.

 i. At HTML Align, select the HTML alignment.

 j. At Flash Align, select the Flash alignment.

 k. At Background Color, select No Color for no background color or select a color from the drop-down box.

 4. Click the Insert button.

Tip: You cannot edit the properties of Flash once it has been inserted. To modify Flash, simply delete it and reinsert it with the required 
properties.



Inserting Flash

Inserting Media
How to insert media (such as sound and movie files) using the TelerikEditorProvider for the RTE.  

 1. Click the  Media Manager  button. This opens the Media Manager.

 2. Navigate to and select the required media. See "Using the Resource Manager"

 3. Optional. Click the Properties tab and set the properties.

 a. At Specify Class ID, select from these options:

 l Check  the check box to set a class for this media. This reveals the Class ID text box.

 i. In the Class ID text box, enter the name of the CSS class to be applied to this Flash.

 ii. Uncheck  the Specify Class ID check box to hide the Class ID field and ensure all other fields can be set.

 l Uncheck  the check box to use the default class.

 b. In the Width text box, enter the pixel value to set the media width. Leave blank to use the actual media size.

 c. In the Height text box, enter the pixel value to set the media height. Leave blank to use the actual media size.



 d. At Align, select the alignment.

 e. At Properties select a property to view more information on that property and select Yes or No as required. Repeat for 
each property as required.

 4. Click the Insert button.

Tip: You cannot edit the properties of media once it has been inserted. To modify media, simply delete it and reinsert it with the required 
properties.

Inserting Media

Inserting Images
How to insert an image using the TelerikEditorProvider for the RTE.  

 1. Select  Insert Media 

 2. Click the  Image Manager (CTRL + G)  button. This opens the Image Manager.

 3. Navigate to and select the required image. See "Using the Resource Manager"

 4. Optional. Use the Best Fit, Actual Size, Zoom In and Zoom Out buttons to modify the previewed image - these changes cannot 
be saved.

 5. Optional. Click the Image Editor button to edit the way the image is displayed. See "Working with the Image Editor"



 6. Optional. Click the Properties tab and set image properties. See "Setting Image Properties"

 7. Click the Insert button.

Editing an Image
How to edit an image inserted in the TelerikEditorProvider for the RTE.

 1. Select the image to be edited.

 2. Right-click on the image.

 3. Select Properties... from the drop-down menu.

 l To change the image: At Image Src, click the Image Manager  button and then locate and select the new image.

 l Modify any other properties as required. See "Setting Image Properties"

 4. Click the OK button to confirm.

Tip: The new image will inherit the properties of the previous image.

Working with the Image Editor
How to use the Image Editor tool in the Image Manager of the TelerikEditorProvider for the RTE. This topic  assumes you are currently 
inserting a new image. See "Inserting Images"



 1. Click the Image Editor  button. This opens the Image Editor.

 2. Select from these editing options:

 a. At Opacity, drag the slider to the preferred percentage (%) - OR - Enter the opacity percentage into the % text box.

 b. In the Resize section:

 i. At  Constrain proportions? check  the check box to lock the width/height ratio - OR - Uncheck  the check box 
to allow the width and height to be modified independently.

 ii. At Width and/or Height, drag the slider to the preferred image size - OR - Click the Decrease and Increase buttons. 
The pixel size is displayed in the respective Px text boxes to the right.

 c. At Flip, select a direction to flip the image from these options: None, Flip Horizontal, Flip Vertical, or Flip Both.

 d. At Rotate, select from None, 90°, 180°, or 270°.

 e. At  Crop, click the Enable Crop button. This displays a red box which defines the area to be cropped. You can now define 
the area to be cropped:                         

 i. In the X and Y text boxes, enter the X (vertical) and Y (horizontal) coordinates for the crop area.

 ii. In the Width and Height text boxes, enter the width and height in pixels for the crop area.

 3. In the Save As... text box, a new name for this edited image is displayed. It is in the format of filename_thumb. Modify this name 
as desired. Tip: Remove the _thumb from the file name to override the original file. The image will be saved as a .jpg extension 
file.

 4. At Overwrite If File Exists?, check  the check box to overwrite a file that exists with the name entered in the Save As... text box 
- OR - Uncheck  the check box if you don't want to override an existing file. This enables warning message if the filename 
already exists.

 5. Click the Save button.



Troubleshooting. If the message "A file with a name same as the target already exists!" is displayed, this is preventing you from over-
writing an existing image. Repeat Steps 4 and 6.

Tip: When Cropping an image drag and resize the crop area on the preview image.

Creating an Image Map
How to create an image map using the TelerikEditorProvider for the RTE.

 1. Insert an image.

 2. Right click on the image and click the Image Map Editor  button. This opens the Image Map Editor window.

 3. To create an area:

 a. At Select Area Shape, select either Rectangle or Circle.

 b. Click the New Area button. This displays a gray box defining the area.

 c. Move and resize the area as required. This updates the Define Area Properties fields for Left, Width, Top and Height.



 d. Optional. In the URL text box, enter the URL to open when a user clicks on this Area.

 i. At Target, select the target for the URL.

 l Target: No target is set and the link will open in the same window. 

 l New Window: Will open a new window.

 l Parent Window: If web page consists of frames, the link will open in the parent frame.

 l Same Window: The link will open in the same window.

 l Browser Window:  The link will open in the same window.

 l Search Pane:

 l Media Pane:Optional. 

 e. In the Alt Text text box, enter the text to be displayed for this area.

 f. Click the Update Area button.

 4. Repeat Step 3 to add additional areas.

 5. These additional editing options are available:

 l To edit an existing area, click on it in the preview window, edit the properties as required and then click the Update Area 
button.

 l To remove an area, click the Remove Area button.

 l To remove all areas, click the Remove All button.

 6. Click OK to save.



Creating an Image Map

Setting Image Properties
How to set the optional properties of an image using the Image Manager of the TelerikEditorProvider for the RTE.

 1. If the image has already been inserted, right-click on the image and select the Properties...  button. Alternatively, if you are 
currently adding the image, click on the Properties tab of the Image Manager.

 2. Click the Lock Ratio  / Unlock Ratio  button  to unlock or lock the width/height ratio at any time. Unlocking the ratio enables 
the width and/or height to be modified independently.

 3. In the Width text box, enter the width in pixels which the image will be displayed as.

 4. In the Height text box, enter the height in pixels which the image will be displayed as.

 5. At Border Color, click the Color Picker button and select the border color. Note: A Border Width must be entered to display the 
border.

 6. In the Border Width text box, enter the pixel width for the border - OR - use the Increase and Decrease arrows.

 7. In the Alt Text text box, enter the alternative text for this image.

 8. In the Long Description text box, enter the long description for this image.

 9. At Image Alignment, click the Alignment Selector button and select the alignment for this image.



 10. At Margin, set any of these fields: 

 a. In the Top text box, enter a pixel value  or use the Increase and Decrease arrows to set the top margin.

 b. In the Bottom text box,  enter a pixel value  or use the Increase and Decrease arrows to set the bottom margin.

 c. In the Right text box, enter a pixel value or use the Increase and Decrease arrows to set the right margin.

 d. In the Left text box, enter a pixel value or use the Increase and Decrease arrows to set the left margin.

 11. At CSS Class, select a class for this image.

 12. Click the OK button.

Setting Image Properties

Editing an Image Map
How to edit an image map using the TelerikEditorProvider for the RTE.

 1. Select the mapped image.

 2. Click the Image Map Editor  button in the toolbar - OR - Right click on the image and then select  Image Map Editor from the 
drop-down menu. This opens the Image Map Editor window.

 3. Add, edit/update and delete mapped areas as required. See "Creating an Image Map"

 4. Click the OK button to save.



Creating an Image Map

Troubleshooting: Image Not Displaying 
Some images may not display in the Editor.

This can occur if the image is set as hidden.

 1. Remove the Hidden property from the image. See "Setting the Hidden Property of a File".

 2. Return to the module to see if the image is displaying. You may need to Refresh (Hold down the Shift key and strike the F5 key) 
the page to see the changes.

This can also occur if module caching is set for too longer period. In this case, extend the caching time as required. See "Configuring 
Cache Settings for a Module"



Troubleshooting: Image Not Displaying in HTML Module

Managing Links and Anchors
Adding an Email Link
How to add an email link to text or an image using the TelerikEditorProvider for the RTE. Clicking the link opens the user's email program 
with the selected email address in the Send To field.

Tip: If you type an email address with a recognized extension directly into the Editor it will  automatically add a "send to" link to the 
address.

 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Select the E-mail tab.

 4. In the Address text box, enter the email address. If you have selected a recognized email address it will be displayed here.

 5. In the Link Text text box, enter the text for this link. Note: This field is not displayed when adding a link to an image.

 6. In the Subject text box, enter a subject which will populate the subject field of the email message.

 7. Optional. At CSS Class, select a class for the link - OR - Select Clear Class to use the default class.

 8. Click the OK button.



Adding an Email Link

Adding a Page Link
How to insert a link to a page within this site using the TelerikEditorProvider for the RTE.

 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager with the Hyperlink tab selected.

 3. At Page, select the page for this link from the drop-down list. This displays the URL of the selected page in the URL field below. 
Note: Disabled pages  appear in the list, however they cannot be selected.



 4. The following optional setting are available:

 a. In the Link Text text box, edit the linked text. Note: This field is not displayed when adding a link to an image.

 b. At Target, select the target window for this link. The default option is None which opens the link in the current window.

 c. In the Tooltip text box, enter a tool tip to be displayed when a user places their mouse over this link.

 d. At CSS Class, select a class for the link - OR - Select Clear Class to use the default class.

 e. Check  the Track the number of times this link is clicked check box to enable Link Tracking for this link. The link must 
be saved before you can view the Tracking tab where tracking information is displayed.

 i. Check  the Log the user, date and time for each click check box to also enable the Link Log.

 5. Click the OK button.

Related Topics:

 l See "Viewing Link Tracking Report" 

Adding an Anchor Link
How to create a link  to an anchor using the TelerikEditorProvider for the RTE.

 1. Highlight the text/object to be linked to the anchor.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.



 3. At Existing Anchor, select the anchor name. This displays the anchor URL in the URL field. E.g. #Fair Labor

 4. The following optional settings are available:

 a. In the Link Text text box, enter/edit the linked text as required.

 b. At Target, select the target for this link - OR - Select None to use the existing window.

 c. In the Tooltip text box, enter the text to be displayed when a user places their mouse over this link.

 d. At       CSS Class select the CSS class to use.

 e. Check  the Track the number of times this link is clicked check box to enable Link Tracking for this link. The link must 
be saved before you can view the Tracking tab where tracking information is displayed.

 i. Check  the Log the user, date and time for each click check box to also enable the Link Log.

 5. Click the OK button.

Related Topics:

 l See "Adding an Anchor"

Adding a URL Link
How to insert a link to a URL located on another web site using the TelerikEditorProvider for the RTE.



 1. Highlight the text/object for the link - OR - Place you cursor where you want to insert the link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager with the Hyperlink tab pre-selected.

 3. In the URL text box, enter the URL address for this link.

 4. Optional. At Track Clicks, check  the check box to  track the number of clicks on this link - OR - Uncheck  the check box to dis-
able link tracking. Enabling this option will update the URL displayed in the URL field above.

 5. In the Link Text text box, enter/edit the text for this link. If you highlighted text at Step 1, then this field will be pre-populated with 
that text. Note: This field is not displayed when adding a link to an image.

 6. Optional. At Target, select the target window for this link.

 7. Optional. In the Tooltip text box, enter a tool tip to be displayed when a user places their mouse over this link.

 8. Optional. At CSS Class, select a class for the link - OR - Select Clear Class to use the default class.

 9. Click the OK button.

Viewing Link Tracking Report
How to view tracking information for a tracked link within the TelerikEditorProvider for the RTE. In additional the tracking report displays 
data for the selected date range.

 1. Select the linked text or object, and then click the  Hyperlink Manager (CTRL + K)  button - OR - Right-click on the linked item 
and select Properties... from the drop-down menu. This opens the Hyperlink Manager with the Hyperlink tab selected.

 2. Select the Tracking tab. 

 3. In the Link Info section, the following information is displayed:

 l URL: The URL for this link. E.g. http://ecozany.com/Store.aspx

 l Created: The date this link was created. 12/22/2010 8:42:27 AM

 l Tracking URL: The tracking URL for this link. E.g. http://ecozany.com/LinkClick.aspx?link=63&tabid=41&mid=386

 l Clicks: The number of times this link has been clicked.

 l Last Click: The date and time when the link was last clicked.



 4. In the Tracking Report section, complete the following to view the report:

 a. At Start Date, click the Calendar  button. This displays the current month with today's date highlighted. Select a new 
date if required. See "Working with the RADCalendar"

 b. At End Date, click the Calendar  button. This displays the current month with today's date highlighted. Select a new 
date if required.

 c. Click the Display button. This displays the date and time when the link was clicked and the first and last name of authen-
ticated users.



 5. Click the Cancel button to close the Hyperlink Manager.

Working with the RADCalendar
The RADCalendar is  date selection tool which is used when viewing link tracking reports within the TelerikEditorProvider for the RTE.

Selecting a Date
Step One - View the required Month/Year in Calendar



 1. Click the Calendar  button. This opens the RADCalendar. Here's an overview of the date selection options available for the 
RADCalendar:

 l View Calendar for Another Month:

 l Click the <<  button view calendar from three months ago

 l Click the <  button to view calendar for the previous month

 l Click the >  button to advance the calendar by one month

 l Click the >>  button advance the calendar by three months

 l View Calendar for Today:

 1. Click the Month/Date  above the calendar.

 2. Click a month to view that month for the selected year.

 3. Click the Today link.

 l View Calendar for Another Month/Year:

 1. Click the Month/Date  above the calendar.

 2. Click a month to view that month for the selected year. 

 3. Click a different year to view if required.

 4. Optional. If the required year is not displayed, then click either the << or >> buttons below the displayed years. This dis-
plays the previous or next ten years respectively.

 5. Click the OK button to view the calendar for the selected month/year.

Tip: Click the Cancel link to cancel any selection and return to calendar. 

Step Two - Selecting the Date

 1. Click on a date in the calendar to select it. This closes the pop-up window and displays the selected date in the associated field.

Related Topics:



 l See "Viewing Link Tracking Report"

Editing a Link
How to edit a link in the TelerikEditorProvider for the RTE.

Option One:

 1. Select the linked text or object.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Edit the link as required. For more details on the available fields, See "Adding an Email Link", "Adding a Page Link". or See "Add-
ing a URL Link".

 4. Click the OK button.

Option Two:

 1. Right-click on the linked text or object.

 2. Select Properties... from the drop-down menu. This opens the Hyperlink Manager.

 3. Edit the link as required. For more details on the available fields, See "Adding an Email Link", "Adding a Page Link". or See "Add-
ing a URL Link".

 4. Click the OK button.

Deleting a Link
How to remove a link from the TelerikEditorProvider for the RTE.

Option One:

 1. Select the linked text or object. 

 2. Click the  Remove Link (CTRL + SHIFT + K)  button.

Option Two:

 1. Right-click on the linked text or object.

 2. Select Remove Link from the drop-down menu. This opens the Hyperlink Manager.

Adding an Anchor
How to create an anchor using the TelerikEditorProvider for the RTE. An anchor is a location within this content which can be linked to 
using the Hyperlink Manager. Note Links to this anchor can only be created in this instance of this module.

 1. Place your cursor where you want to insert the anchor - OR - Highlight some text or an object to add an anchor to it. Note: Text 
may display link formatting even though there is no link.

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Select the Anchor tab.

 4. In the Name text box, enter an anchor name.



 5. Click the OK button.

Editing an Anchor
How to edit an anchor using the TelerikEditorProvider for the RTE.

Option One:

 1. Select the anchored text or object. 

 2. Click the  Hyperlink Manager (CTRL + K)  button. This opens the Hyperlink Manager.

 3. Edit the anchor as required.

 4. Click the OK button.

Option Two: 

 1. Right-click on the linked text or object.

 2. Select Properties... from the drop-down menu. This opens the Hyperlink Manager.

 3. Edit the anchor as required.

 4. Click the OK button.

Deleting an Anchor
How to delete an anchor (bookmark) from the TelerikEditorProvider for the RTE.

Option One: Use this option when the anchor has been created by first selecting text or an object.



 1. Select the linked text or object. 

 2. Click the  Remove Link (CTRL + SHIFT + K)  button.

Option Two: Use this option when the anchor has been added to the editor by placing the cursor in a location.

 1. Select the HTML tab.

 2. Locate and delete the anchor HTML which will look something like <a name="anchor name"></a>

Managing Tables
Inserting a Table
How to insert a table using the TelerikEditorProvider for the RTE.

 1. Place you cursor where you want to insert the table.

 2. Click the  Insert Table  button.

 3. Select for these options:

 l To insert a basic table, move your cursor to highlight the number of rows or columns for the table and then click to select 
it. This displays the basic table  in the Editor.



 l To design a more complex table, click the Table Wizard button. See "Setting the Table Design"



Editing a Table
How to edit a table using the right click menu or the Table Wizard of the TelerikEditorProvider for the RTE.

 1. Place your cursor inside the table. Note: If you want to use the drop-down menu to modify the table design (rather than the Table 
Wizard) then place your cursor in the cell where you want to perform the modification.

 2. Right-click using your mouse. This displays the drop-down menu. 

 3. Select an option to modify the rows, columns or cells of the table - OR - Select either the  Table Properties or  Cell Prop-
erties to use the Table Wizard to modify the table.

 4. Click the OK button.

Editing a Table

Setting Table Properties
How to set the optional properties of a new or existing table using the Table Wizard of the TelerikEditorProvider for the RTE.

 1. Open the Table Wizard. See "Inserting a Table" - OR - Right-click on an existing table and then select  Table Properties from 
the drop-down menu.

 2. Go to the Table Properties tab and set any of these optional settings:



 3. In the Dimensions section:

 a. In the Height text box, set the table height in either pixels or as a percentage by either typing a value into the text box or by 
using the Increase  and Decrease  buttons. The value will automatically be saved in pixels unless you enter the per-
centage symbol (%) into the text box. E.g. Enter 100px or 100 to set the height as 100 pixels, or enter 100% to set the 
height as 100%. Leave blank for no specified height.

 b. In the Width text box, set the table width in either pixels or as a percentage as for height. Leave blank for no specified 
width.

 4. In the Layout section:

 a. In the Cell Spacing text box, enter a number to set the pixel spacing between cells - OR - Use the Increase  and 
Decrease  buttons. 

 b. In the Cell Padding text box, enter a number to set the pixel padding between cells - OR - Use the Increase  and 
Decrease  buttons.

 c. At Alignment, click the arrow of the Alignment Selector  button and select the table alignment.

 d. At Background Color, click the Color Picker  button and select the background color.

 e. At Style Builder, click the Style Builder  button and build one or more styles. See "Using the Style Builder"

 f. At CSS Class, select a class for the content of this table.

 g. At Back Image, click the Image SRC  button and select a background image for the table.

 h. In the Id text box, enter an Id reference for this table.

 5. In the CSS Class Layout section:

 a. Select a CSS layout design for your table from the drop-down box. The design is displayed in the Preview window below.

 b. At Apply Special Formats To, check or uncheck one or more check box to apply/remove one or more styles as desired. 
The changes can be viewed in the Preview window below.

 6. Optional. Select a new tab to set additional properties. 

 7. Click the OK button to confirm.



Setting Table Properties

Showing/Hiding Table Border
How to hide or show the table borders using the Table Wizard of the TelerikEditorProvider for the RTE.

 1. Place your cursor on the outer edge of the table. The cursor will change to show the table can be selected.

 2. Right-click and select  Show/Hide Border from the drop-down menu to either hide or show the table border.

Showing/Hiding Table Border

Setting Cell Properties
How to set the optional cell properties of a new or existing table using the Table Wizard of the TelerikEditorProvider for the RTE.



 1. Right-click inside a cell of an existing table and select  Cell Properties from the drop-down menu. This opens the Cell Prop-
erties tab of the Table Wizard.

 2.  At Preview, select which cells you want to set the properties of:

 l  To select a single cell, click on that cell. The selected cell is highlighted.

 l To select multiple cells, hold down the Ctrl key and click on each required cell - OR - click the                         Select All link and then hold 
down the Ctrl key and click on one or more cells to deselect them. The selected cells are highlighted.

 3. At Cell Properties, set any of the following:

 a. In the Height text box, set the cell height in either pixels or as a percentage by either typing a value into the text box or by 
using the Increase  and Decrease  buttons. The value will automatically be saved in pixels unless you enter the per-
centage symbol (%) into the text box. E.g. Enter 100px or 100 to set the height as 100 pixels, or enter 100% to set the 
height as 100%. Leave blank for no specified height.

 b. In the Width text box, set the cell width in either pixels or as a percentage as for height. Leave blank for no specified width.

 c. At Content Alignment, click the arrow of the Alignment Selector button and select the alignment of content.

 d. At Background, click the Color Picker  button and select the background color.

 e. At Style Builder, click the Style Builder  button and build one or more styles. See "Using the Style Builder"

 f. At CSS Class, select a class for this/these cells.

 g. At Back Image, click the Image Manager  button and select a background image for the table.

 h. In the Id text box, enter an Id reference for this/these cells.

 i. At No Text Wrapping, check  the check box to disallow text within this/these cells from wrapping to another line - OR - 
Uncheck  the check box to allow text to wrap.



 5. Click the OK button to save or go to another tab of the Table Wizard to set more properties.



Setting Cell Properties

Setting Table Accessibility
How to set the accessibility of a new or existing table using the Table Wizard of the TelerikEditorProvider for the RTE. The below tutorial 
demonstrates how to add a background color to the first row of your table.

 1. Right-click on an existing table and select  Table Properties - OR - Open the Table Wizard. See "Inserting a Table"

 2. Go to the Accessibility tab and set any of these Accessibility Options:

 a. In the Heading Rows text box, enter the number of rows which are headings. The maximum number of  heading rows for 
the current table is displayed to the right of this field.

 b. In the Heading Columns text box, enter the number of columns which are headings. The maximum number of  heading col-
umns for the current table is displayed to the right of this field.

 c. In the Caption text box, enter a caption to be displayed above the table.

 d. At Caption Align, click the arrow of the Alignment Selector button and select the alignment of the caption. 

 e. In the Summary text box, enter a summary of the table contents. The table summary isn't displayed on the page, but can 
be read using accessibility tools such as text readers.

 f. At Associate Cells With Headers, check  the check box to associate cells with headers - OR - uncheck  the check 
box to disable. 

 g. Optional. Select a new tab to set additional properties. 

 3. Click the OK button.



Setting Table Accessibility

Using the Table Wizard
How to design a table using the Table Wizard of the TelerikEditorProvider for the RTE.

 1. Click the  Insert Table  button.

 2. Select Table Wizard. This opens the Table Wizard on the Table Design tab. A table of two columns by two rows is displayed as 
the basis for your design.

 3. Optional. Select a cell. This enables the Increase and Decrease buttons which are available to change the design.

 4. Select an Increase or Decrease button to modify the table design. You can choose to add columns and rows, as well as span col-
umns and rows.

 5. Optional. Change tabs to set other properties. 

 6. Click the OK button.

Setting the Table Design
How to set the design a table using the Table Wizard of the TelerikEditorProvider for the RTE.



 1. Open the Table Wizard. See "Inserting a Table" - OR - Right click on an existing table and select  Table Properties.

 2. Go to the Table Design tab. If you are adding a new table, a table of two columns by two rows is displayed as the basis for your 
design. If you are editing an existing table, your current design is displayed.

 3. To modify the table, perform any of these actions:

 l To add a column: At Columns, click the Increase  button.

 l To remove a column: At Columns, click the Decrease  button.

 l To insert a column span: select a cell and then at Column Span, click the Increase  button.

 l To remove a column span: select a cell and then at Column Span, click the Decrease  button.

 l To add a row: At Rows, click the Increase  button.

 l To remove a row: At Row, click the Decrease  button.

 l To insert a row span: select a cell and then at Row Span, click the Increase  button.

 l To remove a row span: select a cell and then at Row Span, click the Decrease  button.

 4. Optional. Select a new tab to set additional properties.

 5. Click the OK button.



Designing a Table

Using the Style Builder
How to create CSS styles for tables using the Style Builder of the TelerikEditorProvider for the RTE. The Style Builder can be accessed 
from the Table Properties tab of the Table Wizard when adding or editing a table. See "Setting Table Properties"

 1. At Style Builder, click the Style Builder button. This opens the Style Builder window. The Font tab will be displayed.

 2. Set the following Font properties:

 a. Go to the  Font Name section.

 i. At Family, select the required font type.



 b. Go to the  Font Attributes section.

 i. At Color, click the Color Picker button and select the font color.

 ii. At Italics, select from these options:

 l Normal: No italics

 l Italics: Italics (text leans forward)

 l Oblique: Oblique italics (text leans backwards)

 iii. At Small Caps, select from these options:

 l Normal: No capitalization

 l Small Caps: Small capitalization.

Deleting a Table
How to delete a table from the TelerikEditorProvider for the RTE.

Option One:

 1. Click on the corner of the table to select it.

 2. Strike the Delete button on your keyboard.

Option Two: 

 1. Click on the corner of the table to select it.

 2. Right click to view the drop-down menu.

 3. Click the Delete Table  button.

Option Three:  

 1. Place your cursor before or after the table.

 2. Strike either the Backspace or Delete button on your keyboard respectively.



Deleting a Table

Managing Templates
Inserting a Template
How to insert a template using the TelerikEditorProvider for the RTE.

 1. Place you cursor where you want to insert the template.

 2. Click the Template Manager  button. This opens the Template Manager.

 3. Navigate to and select the required template. Note: Templates are typically stored in the Portal Root > Templates folder. See 
"Using the Resource Manager"

 4. Click the Insert button. This inserts the template into the editor read for you to edit.



Inserting a Template

Saving a Template
How to create and save a template using the TelerikEditorProvider for the RTE.

 1. Create your template by adding text, images, tables, etc as desired.



 2. Click the  Save Template  button. This opens the Save As Template window.

 3. At Folder, select the folder where the template will be saved to.

 4. In the File Name text box, enter a name for this template.

 5. At Overwrite If File Exists?, check  the check box to overwrite any template that exists with this template - OR - Uncheck  the 
check box if you don't want to override an existing file. This enables warning message if a template with this name already exists.

 6. Click the Save button. 

 l If there is no conflict with overwriting, the message "The template was saved successfully'" is displayed. Click OK to close 
the window. 

 l If there is a conflict, a message reading "The template was not saved. The following error was reported:   The file already 
exists" is displayed. In this case, repeat Steps 2-6, entering a different file name.



Saving a Template

Link Control
About the Link Control
The Link Control tool enables Module and Page Editors to select a link to a URL, a page on the web site, a file that has been uploaded to 
the site, a user's profile or to set no link. The Link Control is displayed on the add and edit page of many modules including the Links, 
Announcement, Documents, Events, Media and the Form & Lists modules. It is also used on the Administrator and Host only pages such 
as the Vendor directories. Depending on where it is used, the range link types will vary. E.g. The Announcements module uses two Link 
Controls when adding or editing announcements. One sets a link to an image and only includes options to link to a URL, a file, or to set 
no link. The second one enables linking to all of the link types which are to set a link to a URL, a page, a file, a user profile, or to set no 
link.  

Optional Settings:

 l Track the number of times a link is clicked. See "Enabling/Disabling Tracking of Link Clicks"

 l Log the user, date and time for every link click. See "Enabling the Link Log"

 l Open a link in a new Web browser window. See "Setting a Link to Open in a New Web Browser Window"



The Link Control

Related Topics:

 l "Setting a File Link".

 l "Setting a Page Link".

 l "Setting a URL Link".

 l "Adding a User Profile Link".

Module Editors
Setting a File Link
How to set a link to a file that has been uploaded to the site using the Link Control. This topic assumes the file has already been 
uploaded to the site's File Manager.

 1. At Link / Link Type, select File ( A File On Your Site ). Note: This field may not be displayed on some modules.

 2. At Link / File Location, select the folder where the file is located. This will populate the File Name field below with the file in this 
folder. Note: The My Folder folder is your own personal folder where you can manage your personal files such as your profile 
image.

 3. At Link / File Name, select the file from the drop-down list.



 
Setting a File Link

Uploading and Linking to a File
How to upload a file and then set a link to that file using the Link Control. Note: Editors must have permission to upload files to at least 
one folder in the File Manager.

 1. At Link / Link Type, select File ( A File On Your Site ). Note: This field may not be displayed on some modules.

 2. At Link / File Location, select a folder that you have access to upload files to. When you select a folder that you have access to 
upload files to the Upload New File link is displayed. This will populate the File Name field below with the file in this folder. Note: 
The My Folder folder is your own personal folder where you can manage your personal files such as your profile image.

 3. At Link / File Name, click the Upload New File link. This displays the Browse... button.

 4. Click the Browse... button.

 5. Locate and select the required file on your computer.

 6. Click the Uploaded Selected File link.

 
Uploading and Linking to a File



Setting a Page Link
How to set a link to an existing page on the site using the Link Control.

 1. At Link / Link Type, select Page ( A Page On Your Site ). 

 2. At Link / Select A Web Page From Your Site, select the page from the drop-down box. Note: Pages that are not included in the 
menu and which have not been given a Parent page will be displayed at the end of this list. 

Tip: Pages which are set as disabled are displayed in the list of pages. Disabled pages can be linked to, however the link will only work 
for Administrators and SuperUsers. Other users will see the link but nothing will happen when they click on it. It is therefore rec-
ommended that you test page links.

Setting a URL Link
How to set a link to any URL using the Link Control. The URL can be to a web site domain, a web page, a file, an image, etc.

 1. At Link / Link Type, select URL ( A Link To An External Resource ). 

 2. In the Link / Location ( Enter The Address Of The Link ) text box, enter the URL. 



Setting a URL link

Selecting an Existing URL Link
How to select a link to an existing URL link using the Link Control. The Link Control can be used to set a URL link to any URL. The URL 
can be to a web site, a web page, a file, an image, etc. Once a link to a URL has been saved (updated), that URL will then be added to 
the drop down list of existing URL's that can be selected. This topic explains how to set a link to a URL that has already been saved using 
the Link Control.

 1. At Link / Link Type, select URL ( A Link To An External Resource ).

 2. Below the Link / Location: ( Enter The Address Of The Link ) text box, click the Select An Existing URL link. This displays a list 
of the existing URL's in the Link / Location: ( Enter The Address Of The Link ) drop-down list.



 3. At Link / Location: ( Enter The Address Of The Link ): select the URL from the drop-down list.

Adding a User Profile Link
How to set a link to a User Profile using the Link Control. The user can control which profile fields are visible to the public, site members 
or Administrators only.

 1. At Link / Link Type, select User ( A Member Of Your Site ).

 2. In the Enter The Username Of A Member Of Your Site text box, enter the user name of an existing user.

Note: If you enter a user name which does not exist in the User Accounts module, then a message reading "Username entered does not 
match a User in this web site" is displayed when you select update.



 
The User's Profile

Setting No Link
This topic explains how to set the Link Control for no link. This option is only available on modules where a link is optional such as the 
Announcements module.

 1. At Link / Link Type, select None. 

 
Setting No Linking

Setting a Link to Open in the Same Web Browser Window
How to set a link to open in the same Web browser window using the Link Control.

 1. At Open This Link In New Browser Window?, uncheck  the check box.

 2. Click the  Update link.



Setting a Link to Open in the Same Web Browser Window

Setting a Link to Open in a New Web Browser Window
How to set a link to open in a new Web browser window using the Link Control.

 1. At Open This Link In New Browser Window?, check  the check box.

 2. Click the  Update link.

Setting a Link to Open in a New Web Browser Window

Enabling/Disabling Tracking of Link Clicks
How to track the number of times a link is clicked using the Link Control. This option can be used with any of the link types (URL, Page, 
File or User) and will create a Tracking URL for the link, list the number of times the link has been clicked and record the last time the link 
was clicked. The Link Tracking information is displayed on the Edit Item page of any link it is enabled for.



 1. At Track Number Of Times This Link Is Clicked? check  the check box to track the number of times the link is clicked - OR - 
Uncheck  the check box to disable this feature.

 2. Click the  Update link.

Link Tracking Enabled

About the Link Log 
How to view details of links which are logged using the Link Control. Each time a link is clicked the Link Log records the date, time 
and the name of the user. The Link Log is displayed on the Edit Item page of any logged links.



 1. Go to the Edit page associated with the logged link. E.g. Click the Edit button beside the item which may be an announcement, a 
link, etc. 

 2. At Log Start Date the first day of the current week is displayed. To choose a different start date click the Calendar link and select 
a new date. See "Working with the Calendar"

 3. At Log End Date the last day of the current week is displayed. To choose a different end date, click the Calendar link and select 
a new date. 

 4. Click the Display link.

The Link Log

Important. The RadEditor has a different method for adding and managing link tracking. See "Adding a Page Link" and See "Viewing 
Link Tracking Report".

Enabling the Link Log
How to enable the Link Log using the Link Control. The Link Log is displayed on the Edit Item page of any link that it is enabled on.

 1. At Track Number Of Times This Link Is Clicked? check  the check box. The Link Log performs best with this enabled. 

 2. At Log The User, Date, And Time For Every Link Click? check  the check box to enable the Link Log.

 3. Click the  Update link.



Enabling the Link Log

Disabling the Link Log
How to disable the Link Log using the Link Control module. The Link Log is displayed on the Edit Item page of any link that it is enabled 
on.



 1. At Log The User, Date, And Time For Every Link Click? uncheck  the check box. 

 2. Click the  Update link.

Disabling the Link Log

Troubleshooting: Restricted File Type Warning Message 
You may receive a Restricted File Type warning message when attempting to upload a file via the Link Control to a module. This mes-
sage is displayed when you attempt to upload a file with an extension that you are not enabled to upload such as a movie or a sound file. 
E.g. .avi, .wma.

Resolution: Contact your Administrator or Host to request the file types you wish to upload are permitted.

The Restricted File Type Warning Message

Administrators
Deleting a URL from the Links URL List 
How to delete a URL from the existing URL's list on the Link Control. URL's that have been set using the Link Control are stored on the 
Link Control. These URL's can then be selected by Editors to quickly and easily reuse without re-entering the URL. Administrators can 
delete URL's from this list. Deleting a URL will not remove any links that have been set to the URL using a module.



 1. At Link / Link Type, select URL (A Link To An External Resource). 

 2. Below the Link / Location: ( Enter The Address Of The Link ) text box, click the Select An Existing URL link. This displays a list 
of the existing URL's in the Link / Location: ( Enter The Address Of The Link ) drop-down box. 

 3. At Link / Location: ( Enter The Address Of The Link ), select the URL to be deleted. 

 4. Click the Delete Selected URL From The List link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 5. Click the OK button to confirm.



Managing Module Content
Managing Module Content
This section details how to manage content and settings for the different types of modules included with DotNetNuke.

Related Topics:

 l See "About Modules" for general module information.

 l See "About Module Settings" and the related section for details on setting the module settings which are common to all modules

Admin Page Modules

 l See "About the Admin Console" for full list of the child pages of the Admin page and their related modules.

The following modules are located on the Admin Console, however they can also be deployed and added to site pages. These modules 
(sometimes referred to as Admin or Administration modules) enable authorized users to undertake site administrative tasks, such as man-
aging user accounts, security roles, or vendor accounts.

Here’s a list of the Administration modules and information regarding which section of this manual you can learn more about each one:

Icon Module Name Manual Section Name and Tutorial Link Tutorial Link

Extensions Advanced Site Management > Extensions. See "About the Extensions Module"

File Manager Building Your Portal > File Manager See "About the File Manager Module"

Google Analytics Advanced Site Management > Search Engine Opti-
mization See "About the Google Analytics Module"

Languages Advanced Site Management > Languages See "About the Languages Module"

Event Viewer/Log 
Viewer Advanced Site Management > Logs See "About the Log Viewer Module"

Newsletters Managing Individual Modules > Newsletters See "About the Newsletters Module"

Recycle Bin Advanced Site Management > Recycle Bin See "About the Recycle Bin Module"

Security Roles Advanced Site Management > Users and Roles See "About the Security Roles Module"

Site Log Advanced Site Management > Logs See "About the Site Log Module"

Site Wizard Building Your Portal > Site Wizard See "About the Site Wizard Module"

Search Engine Site 
Map Advanced Site Management > Search Optimization See "About the Search Engine SiteMap Mod-

ule"

Skins Managing Site Design > Skins See "About the Skins Module"

Pages/Tabs Managing Individual Modules > Pages (Tabs) module See "About the Pages (Tabs) module"

Taxonomy Manager Advanced Site Management > Search Optimization See "About the Taxonomy Manager Module"



Icon Module Name Manual Section Name and Tutorial Link Tutorial Link

User Accounts Advanced Site Management > Users and Roles See "About the User Accounts Module"

Vendors Managing Individual Modules > Vendors See "About the Vendors Module"

Account Login
About the Account Login Module
The Account Login module (also titled User Log In) enables registered users to log in to a site using their login credentials. The Account 
Login module can be deployed to any page and is automatically displayed on the default User Log In page. The module includes an 
optional Register link which enables visitors to register on the site and help with forgotten passwords.

Important. This chapter covers a number of ways you can login to DNN using this module. However, the majority of information on work-
ing with the Account Login module is covered in the "Managing Your User Account > Logging In and Out" section of this manual. See 
"Logging into a Site" and other topics in that section for more.

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.

The Account Login module enabling login

Skin Token: The [LOGIN] skin token displays the Login link which opens the User Log In page. The login link is located in the top right 
corner of the default DNN skin.

The Login skin token

Related Topics:

 l See "Example: Adding/Editing the Login Message" 

 l See "Restoring the Default Login Page"

 l See "Enabling a Custom Login Page"



All Users
Logging in with a Verification Code
You may be required to enter a verification code the first time you login to a DNN site. This code is provided in the Welcome email with 
your other login information or can be retrieved using the Forgot Password? option. 

 1. Click the Login link (typically located in the top right corner) to display the User Log In page - OR - Navigate to an Account Login 
module.

 2. In the User Name text box, enter your user name.

 3. In the Password text box, enter your password.  

 4. Click the  Login button. This displays the Verification Code field.

 5. In the Verification Code text box, enter your verification code. Note: the Verification Code is a number so if it begins with a 0; it is 
a Zero and not the letter 'O'. 

 6. In the Password text box, re-enter your password.

 7. Click the Login button again.

Logging in with a Security Code
How to login to a site when a security code is required. This is a unique code that is generated as a picture each time you login. 

 1. Click the Login link (typically located in the top right corner) to display the User Log In page - OR - Navigate to an Account Login 
module.

 2. In the User Name text box, enter your user name.



 3. In the Security Code text box, enter the code displayed as a picture.

 4. In the Password text box, enter your password.

 5. Click the  Login button. 

Admin Tip: See the Security Roles section to find out how to enable the CAPTCHA Security Code.

Logging in with a Security Code

Logging in with LiveID
How to login to a DNN web site using your LiveID credentials.

 1. Click the Login link (typically located in the top right corner) to display the User Log In page - OR - Navigate to an Account Login 
module.

 2. Click the LiveID button.



 3. Click the Login button to be redirected to the LiveID web site.

 4. Select your profile (and Sign In if required) - OR - Add a new profile. 



 5. You are now returned to the web site and are logged in authenticated. Complete one of the following:

 l Associate with Existing Account:

 a. Go to the Associate with Existing Account section.

 b. In the User Name text box, enter your user name.

 c. In the Password text box, enter your password.

 d. Click the Associate with User Account link. 

 l Register a new Account:

 a. Go to the Register a new Account section.

 b. In the User Name text box, enter your user name.

 c. In the First Name text box, enter your first name.

 d. In the Last Name text box, enter your last name. 

 e. In the Display Name text box, enter your preferred display name.

 f. Click the Register link.



Logging In With LiveID

Logging in with a Verification Code and a Security Code
How to login to a site when a verification code and two security codes are required. The Verification code is provided in the Welcome 
email with your other login information, whereas the security codes are generated as a picture when you log in.

Tip: Don't worry that this is a long process as you will only have to do this long login process the first time. The next time you will not have 
to enter the verification code and you will only have to enter one security code. 



 1. Click the Login link (typically located in the top right corner) - OR - Navigate to an Account Login module. This displays the 
Account Login module which may be titled User Log In.

 2. In the User Name text box, enter your user name.

 3. In the Security Code text box, enter the code displayed as a picture. 

 4. In the Password text box, enter your password.

 5. Click the Login button. This displays the Verification Code field and a new security code.

 6. In the Verification Code text box, enter your verification code. Note: the verification code is a number so if it begins with a 0; it is a 
Zero and not the letter 'O'.

 7. In the Security Code text box, enter the new code displayed as a picture.

 8. In the Password text box, re-enter your password.

 9. Click the Login  button again.



Logging in with a Verification Code and a Security Code

Administrators
Editing the Password Reminder Email
How to edit the message sent to users when they request a password reminder.

 1. Navigate to Admin > Languages. 

 2. Click the Language Editor link. 

 3. At Available Locales, select a language from the drop-down list. The related email messages will be displayed below. 

 4. Go to Resource Name: EMAIL_PASSWORD_REMINDER_BODY.Text. A quick way to do this is to use the Find (Ctrl + F) feature 
of your Web browser. 

 5. To view the current details click the Maximize  button at Default Value. 

 6. To edit the message, perform one of the following options: 

 7. Edit the message body using HTML tags in the Localized Value text box below
- OR - 



 a. Click the Edit  button. This displays the message "All unsaved changes will be lost if you continue. Are you sure you 
want to continue?"

 b. Click the OK button. 

 c. Copy, Paste and Edit the default value into the RTE, or enter your new message into the RTE ensuring you include 
the replacement tokens displayed at Default Value. 

 d. Click the Update link to return to the Language Editor.

 8. To edit the email subject go to Resource Name: EMAIL_PASSWORD_REMINDER_SUBJECT.Text which is the next field down 
the list. 

 9. Edit the subject in the Localized Value text box.

 10. Click the  Update link.

 11. Repeat all of the above steps to update this message for another language.

Enabling a Custom Login Page
Set any page as the portal Login page. The default login page only displays the Account Login module however this setting enable you 
to create your own Login page. If no page is selected here, the default Login page will be used. Note: The default login page requires the 
[LOGIN] skin token to be included.

 1. Create a Login page ensuring the Permissions to View Page are set to All Users. The Login page must also have the Account 
Log In module added to it. You can add any other modules and content to this new Login page. 

 2. Navigate to Admin > Site Settings - OR - Select Site  from the Control Panel. 

 3. Maximize  the Advanced Settings section. 



 4. Go to the Page Management section. 

 5. At Login Page, select the Page Name from the drop down list. 

 6. Click the  Update link.

Warning. Do not apply this setting without first adding an Account Login module to the page you are selecting and ensure the page is 
available to All Users. If you have logged out of the portal and do not have an Account login module viewable by 'All Users' you will be 
unable to log in again. If this occurs, enter your portal URL into the address bar of your Web browser and add 
Default.aspx?tabid=1&ctl=Login at the end of the URL. E.g. http://www.domain.com/Default.aspx?tabid=1&ctl=Login. This will display the 
default login page.

Restoring the Default Login Page
How to restore the default Login page to this portal.

Warning. The [LOGIN] skin token must be included on the portal skin to access the default login page. Don't restore the default User Log 
In page without this skin token.

 1. Navigate to Admin > Site Settings - OR - Select Site  from the Control Panel. 

 2. Maximize  the Advanced Settings section. 

 3. Go to the Page Management section. 

 4. At Login Page, select <None Specified>. 

 5. Click the  Update link.



Setting Account Login Module as Visible to Unauthenticated Users Only
You can optionally set an Account Login module as only visible to unauthenticated users. This means the module will 'hide' once a user 
logs into the portal. This setting is unique to the module and won't affect the Account Login module associated with the default User Log 
In page.

 1. Navigate to the required Account Login module. 

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. At Permissions, uncheck  the Inherit View permissions from Page check box. 

 4. At Permissions, check  the View Module check box for Unauthenticated Users and ensure all other View Module check 
boxes are unchecked. 

 5. Click the  Update link.

Troubleshooting: Cannot Access the Login Page (Friendly URL's Disabled)
If the Login Page setting on your portal has been configured incorrectly you may not be able to access the login page.  This may happen 
if:

 l You set the Login page to a page which doesn't have a Login module on it and then logout of the portal. 

 l The Login page or the Account Login module on that page is set as not visible to All Users.

Here's how you can display the default User Log In page (for portals with friendly URL's disabled).

 1. Navigate to any on your portal and in the address bar of the Web browser, add &ctl=login to the URL. 

The URL will then be something like http://www.domain.com/Default.aspx?tabid=24&ctl=login.

Troubleshooting: Cannot Access the Login Page (Friendly URL's Enabled)
If a Login page is set (see Admin > Site Settings) on your site it is possible to incorrectly configure the site so that you cannot access the 
login page.  This may happen if:

 1. You set a Login page but do not add a Login module to the page and then logout of the site. 

 2. You set a Login page but accidentally delete the page and logout of the site.

To display the login page where friendly URL's have been enabled:

 1. Navigate to any other page on the site and replace Default.aspx with /ctl/Login/Default.aspx in the URL.

E.g. If the URL is http://www.domain.com/Home/tabid/36/Default.aspx, the login page will be http://ww-
w.domain.com/Home/tabid/36/ctl/Login/Default.aspx

Announcements
About the Announcements Module
The Announcements module displays a list of announcements.  Each announcement includes a title and a rich text description. 
Announcements are ordered by their publish date by default; however view order can be specified. Optional fields include an image, 
date of publication and a read more... link.

Module Version: 04.00.03

Minimum DNN Version: DNN 04.07.00

Features: IPortable, ISearchable

http://www.domain.com/Default.aspx?tabid=24&ctl=login
http://www.domain.com/Home/tabid/36/Default.aspx
http://www.domain.com/Home/tabid/36/ctl/Login/Default.aspx
http://www.domain.com/Home/tabid/36/ctl/Login/Default.aspx
http://www.domain.com/Home/tabid/36/ctl/Login/Default.aspx


The Announcements Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleAnnouncements/tabid/924/Default.aspx 

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/12/scope/threads/Default.aspx

 l Issue Tracker: http://dnnannouncements.codeplex.com/workitem/list/basic

Module Editors
Adding an Announcement
How to add an announcement to the Announcements module.

 1. Select  Add New Announcement from the  module actions menu - OR - Click the Add New Announcement link. 

 2. Complete the following mandatory fields: 

 a. In the Title text box, enter a title for the announcement.

 b. In the Description Editor, enter a description for the announcement.

 3. The following optional settings are also available: 

 a. At Image, set the link to display an image on this announcement or select None if no image is required. See "Setting a File 
Link"

 b. At Link set the Read more... link for this announcement or select None for no link. See "About the Link Control"

 c. At Publish Date, set these options:

 l Click the Calendar link and select the date when the announcement will be published on the module. The publish 
date is displayed beside the announcement title in the default template. 

 l Optional. Select the Hour, Minute and AM/PM to set a publish time. The default time is 12:00 AM.

http://www.dotnetnuke.com/Products/Development/Forge/ModuleAnnouncements/tabid/924/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/12/scope/threads/Default.aspx
http://dnnannouncements.codeplex.com/workitem/list/basic


 d. At Expire Date, set these options:

 l Click the Calendar link and select the date when the announcement will expire from the module. Expired 
announcements can still be viewed and managed by content editors. 

 l Optional. Select the Hour, Minute and AM/PM to set an expiry time. The default time is 12:00 AM.

 e. In the View Ordertext box, enter a number to order this announcement. E.g. 0 = First announcement; 1 = Second 
announcement, etc. This will override the default order which lists announcements from most recent publish date to oldest 
publish date.

 4. Click the  Update link.

Related Topics:

 l See "Working with the Calendar"





Adding an Announcement

Editing an Announcement
How to edit an announcement on the Announcements module.

 1. Optional. If the announcement isn't displayed go to the Select View drop-down box and select All.

 2. Click the Edit  button beside the announcement.

 3. Edit any fields as required. 

 4. Click the  Update link.

Modifying the Announcement Publish Date
How to change the publish date of an announcement on the Announcements module.

 1. If the announcement isn't displayed select Expired, Future or All from the Select View drop-down list. 

 2. Click the Edit  button beside the announcement to be edited. 

 3. At Publish Date, edit these options:

 l Click the Calendar link and select the date when the announcement will be published on the module. The publish date is 
displayed beside the announcement title in the default template. 

 l Optional. Select the Hour, Minute and AM/PM to set a publish time. The default time is 12:00 AM.

 4. Click the  Update link.

Deleting an Announcement
How to permanently delete an announcement from the Announcements module.



 1. Optional. If the announcement isn't displayed go to the Select View drop-down list and select All. 

 2. Click the Edit  button beside the announcement to be deleted. 

 3. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?"   

 4. Click the OK button.

Settings
Setting Announcement History By Days
How to set the default number of days each announcement is published for on the Announcements module. Once the number of days set 
is reached the announcements are stored as Expired.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Announcements Settings tab. 

 3. In the History (Days) text box, enter a number. E.g. 14 will display announcements with a publish date from 1 to 14 days ago. 
Announcements which are more than 14 days old will automatically expire. 

 4. Click the  Update link.

Setting the  Description Length for Search and RSS
How to set the length of the description of an announcement on the Announcements module when it is used in DNN searches and in 
RSS feeds.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Announcements Settings tab. 

 3. In the Description Length (Search & RSS) text box, enter the number of characters to be included. To use the maximum number 
(2000) enter 0.

 4. Click the  Update link.

Setting the Default View for Announcements  
How to set the default view for announcements in the Announcements module. This setting enables users who are authorized to add a 
copy of an existing Announcements module on a different page and then set the default view of that module to expired, future, current or 
all. This enables you to display an automatic archive of your announcements.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Select the Announcements Settings tab. 

 3. In the Default View text box, select one of the following from the drop-down box:

 l Current: Current announcements are displayed by default.

 l Expired: Expired announcements are displayed by default.

 l Future: Future announcements are displayed by default.

 l All: All announcements are displayed by default.

 4. Click the  Update link.

Loading the Default Template
How to restore any of the five default templates that defines the content, layout and style of announcements for an Announcements mod-
ule.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Announcements Settings tab. 

 3. Click the Load Default link beside the required template. This displays the message "Are you sure? This will overwrite the existing 
template." 

 4. Click the OK button to confirm.

 5. Click the  Cancel link to return to the module.

Modifying the Announcement Templates
How to modify the five templates that defines the content, layout and style of announcements in an Announcements module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Announcements Settings tab. 

 3. In the Header Template text box, edit the template as required. This template controls the section before the first announcement 
item. 



 4. In the Item Template text box, edit the template as required. This template controls each announcement items. 

 5. In the Alternate Item Template text box, edit the template as required. This template controls each alternate announcement item. 
E.g. Announcement 2, Announcement 4, etc. Leave blank to use the Item Template for all items. 

 6. In the Separator Template text box, edit the template as desired. 

 7. Click the  Update link.

Note: In the below images an Alternate Item Template has been created which displays the description in italics and the image column to 
the right, a Separator Template has also been created with a horizontal rule.

Tip: To hide the publish date, delete- [PUBLISHDATE] from the Template window. 



The Announcement Templates



The New Template Layout

Banners
About the Banners Module
The Banners module displays vendor banner advertising. Banners can be either a static or an animated image, HTML or plain text, as 
well as script such as JavaScript. You can set the number of banners displayed in the module as well as set a number of layout options. 
Where more banners are available than the module is set to display at one time, then different banners are displayed each time the page 
is visited.

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.



 

Related Topics:

 l See "About the Vendors Module"

 l See "Adding an Image Banner to a Vendor"

 l See "Enabling/Disabling Banner Advertising"

Module Editors
About Banner Types
An overview of the different types of banners that can be associated with a vendor account and displayed using the banners module. 
Five sizes of image banners are provided: Banner, MicroButton, Button, Block and Skyscraper. The Banner Type 'Banner' can be dis-
played either using a Banners module, or by adding the [BANNER] skin object to the skin applied to the portal or to a page of the portal. 
The [BANNER] skin object can be enabled or disabled on the Admin > Site Settings page and is a portal wide setting. This can be set to 
either Site or Host.

Below are examples of the industry standard sizes for banner images. These sizes are recommendations only.

Banner
468 x 60 pixel

This type of banner can be displayed either 
using a Banners module, or it can display 
where ever the  [BANNER] skin object is 
included in the skin applied to a page. See "Ena-
bling/Disabling Banner Advertising"
 

Micro Button
120 x 60 pixels

 

Button
120 x 90 pixels
  



Block
125 x 125 pixels

Skyscraper
120 x 600 pixels

Script Banner

Script type banners can contain java-script 
which is executed when the banner is shown on 
the portal.

 



Text Banner
Text banners can be either plain text or HTML. 
Stylesheet styles are applied.

Displaying a Banner
How to display banners of a using the Banners module. Banners must be added to a vendor account before they can be displayed in the 
module. See the Vendors module for more details.

 1. Select  Banner Options from the module actions menu - OR - Click the Banner Options link.

 2. At Banner Source, select from these options:

 l Host: Displays banners managed on the Host portal. These banners are available to all portals within this 
DNN installation.

 l Site: Displays banners managed on this site. These banners are exclusive to this site.

 3. At Banner Type, select <All Types> to display banners of all types - OR - Select a single banner type (Banner, MicroButton, 
Button, Block, Skyscraper, Text, or Script) to restrict the module to display only one type of banner. See "About Banner Types"

 4. The following optional settings lets you control which banners display: 

 a. In the Banner Group text box, enter the banner group name. This sets this module to only display banners belonging to 
this group ( A group name can be enter when added banners) - OR - Leave this field blank to display all banners 
regardless of group name.

 b. In the Banner Count text box, enter the maximum number of banners to be displayed at one time.

 5. The following optional settings control how the banners displays in the module: 

 a. At Orientation, select Vertical or Horizontal to set how the banners are displayed in the module. Vertical is the default 
setting. 

 b. In the Border Width text box, enter a number to set the border width (pixels)- OR - Enter 0 (zero) for no border. No 
border is the default setting.

 c. In the Border Color text box, enter a color for the border. E.g. DarkOrange. Border Width must be set to enable this set-
ting. See Reference > Color Codes and Names for more details. Note: A Border Width must be set for this field to work.

 d. In the Cell Padding text box, enter a number to set the space between banners and the border. Border Width must be 
set to enable this setting. 

 e. In the Row Height text box, enter a number to set the height for each banner cell (pixels). 

 f. In the Column Width text box, enter the pixel width for each banner cell.

 6. In the Banner Click Through URL text box, enter an   redirect page which applies to all banners in this module.



 7. Click the Update link.

Editing Banner Options
How to edit the settings applied to the Banners module.

 1. Select  Banner Options from the module actions menu - OR - Click the Banner Options link.

 2. Edit the options as required.

 3. Click the Update link.

Displaying Banners Horizontally
How to set the Banners module to display banners horizontally across the page.

 1. Select Banner Options from the module actions menu. 

 2. At Orientation, select Horizontal. 

 3. Optional. In the Column Width text box, enter a number to set the width of each column cell. If this setting is left empty  the 
banners may not align evenly across the module. 

 4. Click the Update link.



 
Displaying Banners Horizontally

Displaying Banners Vertically
How to set the banners module to display banners vertically down the page.

 1. Select Banner Options from the module actions menu. 

 2. At Orientation, select Vertical. 

 3. Click the Update link.

 
Displaying Banners Vertically

Setting Banner Spacing

 1. How to set the width and height of the (invisible) table cells which each banner is displayed within.

 2. Select Banner Options from the module actions menu. 

 3. In the Cell Padding text box, enter the pixel height of the row. The default value is 4

 4. In the Row Height text box, enter the height for each banner cell in pixels.

 5. In the Column Width text box, enter the width for each banner cell in pixels.



 6. Click the Update link.

Setting Banner Spacing

Setting the Banner Border
How to set the width and color of the border around each banner that is displayed in a banners module.



 1. Select Banner Options from the module actions menu. 

 2. At Border Width, enter the pixel width of the border. E.g. 3 

 3. At Border Color, enter a hex number (#6495ED) or color code (CornflowerBlue) to set the color of the border.

 4. Click the Update link.

Tip: You may like to uncheck  the Display Container? check box on the Settings page of this module to hide the module container.



Banners Module with Borders Displayed

Troubleshooting: Image Not Displaying 
Depending upon the caching set, an image may not display in the Banners module if its properties are set as hidden.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel. 

 2. Locate the required file.

 3. Click the Rename File  button beside the file to be edited. 

 4. Uncheck  the H: check box to remove the hidden property from the file. 

 5. Click the Save Changes  button to save your changes.



 6. Return to the module to see if the image is displaying. You may need to Refresh (Hold down the Shift key and strike the F5 key) 
the page to see the changes.

Troubleshooting: Image Not Displaying in HTML Module

Blog
About the Blog Module
The Blog module consists of nine integrated modules which enable authorized users to create and manage one or more blogs (Web 
blog).

Module Version: 04.01.00



Minimum DNN Version: 04.06.02

Features: ISearchable

Here's an overview of the nine Blog modules:

Blog_Archive: Displays a monthly calendar. By selecting a date, users can view all blog entries for that date in the View_All_Recent_
Entries module. Days which have a blog entry are highlighted on the calendar. Below the calendar a Monthly list of links to all previous 
months with blog entries is provided.

Blog_Categories: Enables the creation and management of blog categories. By clicking on a category users can view associated entries 
in the View_Blog module.

Blog_List: Displays a linked list of all existing blogs and a View All Recent Entries link to all recent blog entries. Links to private blogs are 
only visible to the blog owner.

Blog_Tags: Displays the tags which bloggers have created when adding blog entries. By clicking on a tag users can view associated 
entries in the View_Blog module. Tags can be displaying as a tag cloud or tag list.

New_Blog: Enables authorized users to create a new blog, access the Blog Settings page and add a blog entry to their own blog(s).

Search_Blog: Enables all users to search blogs by keywords or a phrase. Searches can be made across all blogs or can be limited to a 
single blogs. Results are displayed in the View_Blog module.

Recent_Comments: Displays recent comments for the selected blog. Comment layout can be modified.

Recent_Entries: Displays the recent entries for the selected blog.  Recent Entries layout can be modified.

View_Blog: Provides these tools to these user groups:

 l All Users can view blog entries and blog search results in this module. Users may be enabled to add comments. 

 l Bloggers can create, edit and delete their own blog entries as well approve, edit or delete comments added to their blog. This 
module also provides access to the Blog Settings page where blog details and setting are configured, where comments can be 
enabled or disabled and where child blogs can be created. 

 l Page Editors/Administrators have access all of the above functionality as well as access to the Module Options page of this mod-
ule where they enable and setup blog comments, set the layout and word limit of blogs in this module, and enable DNN Search. 
Administrators can optionally provide bloggers with to access the Blog Settings page via this module's menu. They can also 
choose to add a new blog module part. E.g. One of the modules which make up the full Blog module suite. Permissions: Page 
Editors must have Manage Settings (DNN Community Edition) or Full Control (DNN Professional Edition) permission granted.



The Blog Modules

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleBlog/tabid/842/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/92/scope/threads/Default.aspx

 l Issue Tracker: http://dnnblog.codeplex.com/workitem/list/basic

Configuration
Laying out the Blog Modules
Here's a suggested way to layout the Blog modules on a page. 

http://www.dotnetnuke.com/Products/Development/Forge/ModuleBlog/tabid/842/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/92/scope/threads/Default.aspx
http://dnnblog.codeplex.com/workitem/list/basic


 1. Add the Blog modules to a page. See "Adding a New Module (RibbonBar)" This adds one of each of the eight modules in the 
Blog module suite.

 2. Move the modules to your preferred pane layout. A typical layout would be:

 l Left Pane or Right Pane (Recommended): Search_Blog, Blog_Archive and Blog_List module. The width of these mod-
ules is designed to fit in these 'thin' panes on the standard DNN skin.

 l Content Pane (Recommended): View_Blog. This module displays blog entries which can be lengthy, therefore it is best 
suited for the main content pane.

 l Any Pane: Blog_Categories, Recent_Entries, Recent_Comments, Blog_Tags. These modules are suitable for any pane.

Now you should determine which users or roles are able to create their own blog. See "Enabling Users to Create Blogs"

Enabling Users to Create Blogs
How to enable users (including unauthenticated users if desired) and roles to create and manage their own blog.

 1. Go to the New_Blog module. 

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Permissions tab.

 4. At Permissions select one of the following options:

 l Option One:  Hide the New_Blog module from users who cannot create and manage blogs.

 a. Uncheck  the Inherit View permissions from Page check box. 

 b. At View/View Module, select the roles/usernames that are authorized to create a blog. 

 c. At Full Control/Edit Module, select the roles/usernames that are authorized to create a blog.

Enabling registered users to view the New_Blog module and create their own blog - DNN Community Edition



Enabling registered users to view the New_Blog module and create their own blog - DNN Professional Edition

 l Option Two:  Display the New_Blog module to users who cannot create blogs or need to login to create/manage their 
blog. This displays the "You must be logged in and have  permission to create or edit a blog" to unauthenticated users.

 a. Leave the Inherit View permissions from Page check box checked . This allows all users who can view this 
page to view this module.

 b. At Full Control/Edit Module, select each role/username that is authorized to create a blog.

All users authorized to view the page can view the New_Blog module, however only registered users can create their own blog - DNN Community Edition



All users authorized to view the page can view the New_Blog module, however only registered users can create their own blog - DNN Professional Edition

 5. Click the  Update link. This displays the                         Create My Blog link on the New_Blog module.

The Create My Blog link is enabled

Related Topics:

 l See "Setting Module Permissions".

 l See "Enabling Bloggers Blog Management Rights"

Enabling Bloggers Blog Management Rights
How to enable bloggers to access blog management tools (Edit Blog Settings, Add Blog Entry and Mass Edit Blog Posts) using the View_
Blog module.  Note: Bloggers must be viewing their own blog to access these tools.

Tip: Bloggers can also access these tools using the New_Blog module.

 1. Go to the View_Blog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Permissions tab.

 4. At Edit Module (DNN Community Edition) or Full Control (DNN Professional), select the roles/usernames who are authorized to 
create a blog.



Setting Blog permissions in DNN Community Edition

Related Topics:

 l See "Enabling Users to Create Blogs"

 l See "Setting Module Permissions"

Adding a Blog Module Part
How to add one or more individual modules which are part of the Blog module suite. Note: You must be a Page Editor tor Administrator to 
perform this task.

 1. Go to the View_Blog module.

 2. At Add Blog Module Part, complete the following steps (use fields from left to right):

 a. At the first drop-down box, select the required Blog module part.

 b. At the second drop-down box, select the pane to add the Blog module part to.

 c. At the third drop-down box, select where to insert the Blog module part.

 d. In the text box, enter the title for the blog module part. The default option is "Title". Leave blank to use the standard title for 
this blog module part. E.g. Search_Blog, New_Blog, etc.

 e. Click the Add link.

Adding a Blog Module Part

Configuring Blog Tag Settings
How to set the way blog tags are displayed on the Blog_Tags module which forms part of the Blog module suite.



 1. Go to the Blog_Tags module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Blog Tag Settings tab.

 4. Select from the following options:

 l Tag Cloud: Select to display tag names.

 l Tag List: Select to display tags in a list. The number of entries associated with each tag is listed beside the tag name. This 
is the default setting.

 5. Click the  Update link.

Configuring Blog Tag Settings

Modifying Recent Comments Template
How to modify the template which defines the content, layout, style and number of blog comments on the Recent_Comments module 
which forms part of the Blog module suite.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Recent Blog Comments Settings tab.

 3. In the Display Template text box, modify the HTML template as required.

 4. In the Maximum Comments text box, modify the maximum number of comments to be displayed. The default setting is ten (10) 
comments.



 5. Click the  Update link.

The default Display Template is:

<div class="Blog_RecentComments"><a href="[PERMALINK]" class="Blog_RecentComments_
Title">[TITLE]</a><div class="Normal">[COMMENT]</div><div class="Blog_RecentComments_Date-
line">By [AUTHOR] on: [ADDEDDATE]</div></div>

Recent Comments module with a modified Display Template

Creating a Personal Blog Page
How to display a single blog on a new page or on a page other than the page where all blogs are displayed. This enables you to create a 
personal blog page for a blogger and sets the View_Blog, Search_Blog and Blog_Archive modules display information exclusively for 
this blog.

 1. Optional. Add a new page for the personal blog page (E.g. "Rose Booth's Blog") - OR - Go to the page where you want to place 
the personal blog. See "Adding A New Page Visible to Administrators only using the RibbonBar"

 2. Add an existing copy of the View_Blog module to the page. See "Adding an Existing Module (RibbonBar)" - OR - "Adding an 
Existing Module (Iconbar)".

 3. Using the View_Blog module, set the required page at Personal Blog Page. See "Configuring Advanced Settings for the Blog 
Module"



 4. Optional. You may like to add Search_Blog and Blog Archive modules to this page. These are the only modules that function 
exclusively as a personal blog. You can add other blog module parts (E.g. Blog_Comments) to the page however they will dis-
play information from other blogs.

A Personal Blog Page Including the Search_Blog and Blog Archive Modules

Blog Categories
Adding Blog Categories
How to add blog categories using the Blog_Categories module which forms part of the Blog module suite.

 1. Select Edit Categories from the Blog_Categories module actions menu.

 2. In the Required. Enter the  name of your category text box, enter the category name.



 3. Optional. Select a parent category from the drop-down box if this new category should become a child category (sub-category) of 
an existing category.

 4. Click the Add link. The category is now listed in the Portal Categories list displayed on the right of this page.

A Newly Added Blog Category

Editing Blog Categories
How to edit blog categories using the Blog_Categories module which forms part of the Blog module suite.

 1. Select Edit Categories from the Blog_Categories module actions menu.

 2. In the Portal Categories list (displayed on the right of this page) click on the category to be edited.

 3. In the Required. Enter the  name of your category text box, edit the category name.

 4. At the drop-down box, select a new parent for this category - OR - select None to make this a parent category.

 5. Click the Update link.



Editing Blog Categories

Deleting Blog Categories
How to delete blog categories using the Blog_Categories module which forms part of the Blog module suite.

 1. Select Edit Categories from the Blog_Categories module actions menu.

 2. In the Portal Categories list (displayed on the right of this page) click on the category to be deleted.

 3. Click the Delete link.



Deleting Blog Categories

Blog Module Options
Configuring Basic Settings for the Blog Module 
How to configure the basic settings for the Blog module using the View_Blog module.

 1. Select  Module Options from the View_Blog module actions menu. This opens the Blog Module Options page.

 2. Go to the Basic Settings section. 

 3. At Make Entry Summary Mandatory, select from these options:

 l Check  the check box to set the Summary field on the Add Blog Entry page of the View_Blog as mandatory.

 l Uncheck  the check box to set the Summary field as optional. This displays the following settings which you may wish 
to modify.

 a. In the Limit Auto-Generated Entry Summary To text box, edit the maximum number of characters for the auto-
generated summary of blog entries. To set no limit, enter the value 0. The default setting is 1024. 

 b. In the Limit Search Summary text box, edit the maximum number of characters to be returned when a search is 
made. To set no limit, enter the value 0. The default setting is 255. Note: It is strongly recommended that  a limit 
is set to ensure speedy results for searches.



 4. In the Limit Upload Image Width To text box, enter the maximum pixel width for images which can be uploaded by bloggers 
when adding an entry. Larger images can be uploaded, however they will be scaled down to this width. The default setting is 
400.

 5. In the Limit Recent Entries To text box, enter the maximum number of recent entries  displayed when a user clicks the View All 
Recent Entries link on the Blog_List module. The default setting is 10.

 6. In the Limit Recent RSS Entries To text box, edit the maximum number of recent RSS entries to be displayed. The default set-
ting is 10.

 7. Click the Update link.



Example of the Summary field set as optional when adding a new blog entry

Related Topics:

 l See "Configuring Advanced Entry Summary Settings"

 l See "Allowing Bloggers to Upload Files"

Configuring Blog Comment Settings
How to  enable avatars and manage comment settings on the View_Blog module. Avatars are displayed the beside user comments on 
the View_Blog module. The Blog module uses Gravatars (Globally Recognized Avatars) as the default option for user avatars. For more 

information, visit http://gravatar.com. For users without a Gravatar, the fallback options are available the "Gray Man"  icon, one of 
three avatars generation tools, or you can enter any image URL.

 1. Select Module Options from the View_Blog module actions menu. 

 2. Go to the Comment Settings section.

 3. At Show Avatars, select from these options:

 l Uncheck  the check box to disable avatars. Skip to Step 4.

http://gravatar.com/


 l  Check  the check box to enable avatars. This displays the below fields:

 a. In the Image Width text box, enter a pixel width for the avatar. The default setting of 48 is recommended if you 
are using the default style of the comments.

 b. At Image Rating, select an avatar rating which is suitable for your indented audience.

 c. At Default Image URL, select the avatar to be used for comments made by users without a Gravatar:

 l  Gray Man: Select to display the Gray Man image as pictured.

 l  Identicon: Select to generate a unique identifying image  based on  the IP address of the user's 
computer, or on their email address if provided.

 l  Wavatar: As above.

 l  MonsterID As above.

 l Custom: Select to use your own image.

 i. In the Custom Image URL text box, enter the URL where your image is located. E.g. http://ww-
w.domain.com/myimage.jpg



 4. At Show Website, check  the check box to display a user web site address (as set on their profile)  with their comments - OR - 
Uncheck  the check box to hide.

 5. At Show Title, check  the check box to enable users to create unique titles for entry comments - OR - Uncheck  the check 
box to disable.

 6. At Allow Hyperlinks in Comments , check  the check box to enable users to include hyperlinks in comments - OR - Uncheck 
 the check box to disable.

 7. At Allow Images in Comments, check  the check box to enable images to be included in comments - OR - Uncheck  the 
check box to disable.

 8. At Allow Basic Formatting in Comments, check  the check box to enable users to use basic HTML tags in their comments 
such as bold, strong, underline - OR - Uncheck  the check box to disable.



 9. Click the Update link.





Avatars Enabled on the View_Blog module. In this scenario, Wavatar has been selected as the fallback.

Configuring Blog Search Engine Optimization Settings
How to configure settings related to Search Engine Optimization for the Blog module.

 1. Select Module Options from the View_Blog module actions menu. 

 2. Go to the SEO Settings section. 

 3. At Show Unique Title, check  the check box to display the blog title in the Web browser - OR - Uncheck  the check box to dis-
play the page title.

 4. At Show SEO Friendly URL, select from these options:

 l Check  the check box to show search engine friendly URL's. This modifies the URL to replace default.aspx with the 
title of the blog entry as follows: .../Blog-Entry-Title.aspx. This URL format can help with search engine optimization.

 l Uncheck  the check box to disable.

 5. At Manage Entry Links, click the Regenerate all Permalinks for this Module link. You would typically perform this task after a 
change has been made to the URL format for a site.

 6. Click the Update link.

Configuring RSS Settings for Blogs
How to configure RSS (really simply syndication) settings for the Blog module. Note: Syndication must be enabled on individual blogs.

 1. Select Module Options from the View_Blog module actions menu. 

 2. Go to the RSS Settings section. 

 3. At Show Unique Title, check  the check box to display the blog title in the Web browser - OR - Uncheck  the check box to dis-
play the page title.

 4. At Include Body, select from these options:

 l Check  the check box to include the body of blog posts if it requested by the RSS feed.

 l Uncheck  the check box to exclude the body of blog posts regardless of whether they are requested by the RSS feed.

 5. At Categories in Description, select from these options:

 l Check  the check box to include a  text underneath the summary of the post with the categories.

 l Uncheck  the check box to disable.



 6. At Tags in Description, select from these options:

 l Check  the check box to include a  text underneath the summary of the post with the tags.

 l Uncheck  the check box to disable.

 7. In the RSS Cache Time text box, enter the number of minutes until cached RSS feeds are refreshed. The default setting is  10.

 8. Click the Update link.

Related Topics:

 l See "Enabling/Disabling Blog Syndication"

 l See "Limiting Recent RSS Entries"

Windows Live Writer Settings
How to configure the Windows Live Writer Settings (WLW) for the View_Blog module.

 1. Select Module Options from the View_Blog module actions menu. This opens the Blog Module Options page.

 2. Go to the Windows Live Writer Settings section. 

 3. At Allow Windows Live Writer, check  the check box enable users to use WLW (or other remote blogging tools that use the 
MetaWeblog API) to post and edit blog posts - OR - Uncheck  the check box to disable.

 4. At Use Excerpt in Windows Live Writer, check  the check box to enable the user to use the Excerpt text box in WLW at the 
bottom to create a summary of the post in plain text. Any split in the post will be ignored and the excerpt will be used instead. 
This is useful if you want to ensure the summaries are text only (I.e. not HTML).

 5. Click the Update link.

Loading Additional Blog Files to the Web browser
How to enable the Blog module to load additional files to the client (typically your Web browser) when the blog is rendered. This allows 
you to choose a stylesheet or enable syntax highlighting.



 1. Select Module Options from the View_Blog module actions menu. This opens the Blog Module Options page.

 2. Go to the Load Additional Files section. 

 3. At Add jQuery, check  the check box to enable the jQuery library (http://www.jquery.com) - OR - Uncheck  the check box to 
disable.

 4. At Files On Host, check the check box beside one or more of the listed files. supplied with the Blog module by default:

 l css/shCoreDefault.css: Check to select a new stylesheet.

 l js/syntaxHighlighter.js: Check to enable this syntax highlighting tool. Syntax highlighting displays any code entered into 
the body of a blog entry "as is", rather than displaying the text as formatted. 

 5. At Files On Portal, check the check box beside one or more of the listed files. The listed files are managed under [portal home 
directory]/Blog/Include.

 6. Click the Update link.

Configuring Advanced Settings for the Blog Module
How to configure the Advanced Settings for the View_Blog module.

 1. Select Module Options from the View_Blog module actions menu. 

 2. Go to the Advanced Settings section.

 3. At Allow Multiple Categories, check  the check box to enable bloggers to associate posts with more than one category - OR -              
Uncheck  the check box to disable.

 4. At Allow Upload Options, check  the check box to enable bloggers to upload files such as attachments and images to their 
blog - OR -              Uncheck  the check box to disable.

 5. At Personal Blog Page, select the required blog name. See "Creating a Personal Blog Page"

 6. At Enable DNN Search, check  the check box to enable the DNN Search module to index all blog entries - OR -               Uncheck 
 the check box to disable DNN Search.  Tip: DNN Search includes both the [SEARCH] skin token and the search module. Warn-
ing. If you enable this option, please ensure you only enable this option on one module (your main blog page). If you enable this 
option for more than one module search results will be duplicated.

 7. At Enable Social Bookmarks, check  the check box to display the social bookmarks toolbar - OR -                        Uncheck  the check box 
to disable them. The toolbar is displayed  beneath a blog entry when comments are being viewed.

http://www.jquery.com/


 8. At Enforce Entry Summary Limit, check  the check box to force both the auto-generated and actual entry summaries to be 
truncated based on the value entered in the 'Limit Entry Summary To' setting - OR - Uncheck  the check box to disable. 

 9. At Include Summary In Entry, check  the check box to include the summary of each blog displays below the blog title when 
the user clicks View All Recent Entries link on the Blog_List module - OR -      Uncheck  the check box to hide summary. 

 10. At Allow Summary HTML, check  the check box enable HTML markup to be used in the summary field - OR - Uncheck  the 
check box to disable HTML markup.

 11. At Allow Child Blogs, check  the check box to allow child blogs to be created - OR -              Uncheck  the check box to disable child 
blogs. Note: Child blogs were superceded by categories from Blog (04.00.00+), therefore you may choose to disable child blogs 
and manage blogs solely using categories.

 12. At Use Drop Down List For Archive, check  the check box to display the list of archived months as a drop down list instead of 
the default data list.

 13. Click the Update link.

Related Topics:

 l See "Limiting Image Upload Width"

 l See "Configuring Blog Entry Summary"

Migrating Child Blogs
How to manage child blogs from previous versions of DNN. Child blogs are  succeeded by categories as of Blog module Version 4. You 
can migrate existing  child blogs to categories here. Note: You can keep working with child blogs as  before if you wish.

 1. Select Module Options from the View_Blog module actions menu. 

 2. Go to the Advanced Settings section. The number of child blogs which currently exist in this portal is listed at Manage Child 
Blogs.



 3. At Manage Child Blogs, click the Migrate Child Blogs link. This displays the message "Are you sure you wish to eliminate all 
child blogs and move their content to categories instead?"

 4. Click the OK button. Child blogs are now removed from the Blog_List module and listed in the Blog_Categories module. When 
adding a new blog entry, bloggers can select a category (E.g. what was previously a child blog) for the entry.

Tip: See "Configuring Advanced Settings for the Blog Module" to disable child blogs to be created once you have migrated existing child 
blogs. This enables all future child blogs to be managed using categories.

Comment Settings
Managing Comment Avatars
How to enable or disable avatars to be displayed next to comments on the View_Blog module, as well as configure optional settings. The 
Blog module uses Gravatars (Globally Recognized Avatars) which enable you to choose avatars suitable for your audience. Visit 
http://www.gravatar.com for more details.

 1. Select Module Options from the View_Blog module actions menu. 

 2. Go to the Comment Settings section.

 3. At Show Avatars, select from these options:

 l Uncheck  the check box to disable avatars. Skip to Step 4.

 l Check  the check box to enable avatars. This displays these optional fields:

 a. In the Image Width text box, enter a pixel width for the avatar. The default setting of 48 is recommended if you 
are using the default style of the comments.

 b. At Image Rating, select from these options to set avatars appropriate for your audience:

 l G: Suitable for all audiences 

 l PG: Possibly offensive, typically suitable for audiences 13 and above  

 l R: Intended for audiences 17 and above  

 l X: Even more mature than R 

 c. At Default Image URL, select the images to be used for comments made by users without a Gravatar:

 l  Gray Man: Displayed as is for all users without a gravatar.

 l  Identicon: Gravatar will be displayed for users who have one, otherwise, a unique identifying 
image will be created for them based on the IP address of their computer, or on their email address if pro-
vided.

 l  Wavatar: As above.

 l  MonsterID: As above.

http://www.gravatar.com/


 l Custom: Enter a complete URL to the image. E.g. http://www.domain.com/myimage.jpg 

 i. In the Custom Image URL, if Custom was selected at the above field, enter the URL here.

 4. Click the Update link.

Enabling Comment Avatars

All Users
Viewing All Recent Entries
How to view all recent blog entries.

 1. Click the View All Recent Entries link on the Blog_List module. This displays all recent entries in the Recent_Entries module.

 2. Click on an entry title to view an entry in full.

All Recent Blog Entries Displayed



Viewing Blog Entries by Tags
How to view all of the blog entries that have been associated with a tag.

 1. Go to the Blog_Tag module. This module displays a list of all of the existing tags with the number of each blog entry associated 
with each tag.

 2. Click on a linked [Tag Name]. This displays associated blog entries results are displayed in the View_Blog module.

Viewing Blog Entries by Tags

Viewing Blog Entries for a Month
How to view all of the blog entries made during a month on the Blog module. Any months when a blog entry has been made are listed on 
the Blog_Archive module in the Monthly list below the calendar.

 1. Go to the Blog_Archive module.

 2. Click on the [Month/Year] link below the calendar. Results are displayed in the View_Blog module.

Viewing entries for the month/year

Viewing Blog Entries for a Single Date
How to view all of the blog entries made on a selected date on the Blog module.

Tip: Days with blog entries are shaded gray on the calendar. the current day is shaded yellow.



 1. Go to the Blog_Archive module.

 2. Locate the required month using the Calendar as follows:

 l Go to the Previous Month: Click the < button located in the top left corner of the calendar.

 l Go to the Next Month: Click the > button located in the top right corner of the calendar.

 3. Select the required date. This displays the related blog entries in the View_Blog module.

Viewing all blog entries for a date

Viewing Recent Entries for a Single Blog
How to view the recent blog entries for a single blog in the Blog module.

 1. Go to the Blog_List module.

 2. Click the [Blog Name] link. Results are displayed in the blog in the View_Blog module.

 3. Optional. If the blog is a parent blog, the names of all public child blogs are now displayed, click on the name on a child blog to 
limit results to that child blog.

Searching Blogs
How to search one or all blogs for a phrase or key word using the Blog module.

 1. Go to the Search_Blog module. 

 2. In the drop down box, select All Blogs to search all the blogs, or select a blog name to restrict the search to that blog. 



 3. In the text box, enter one or more keywords (E.g. doll toy) or a phrase (E.g. rag doll). Note: Do not separate keywords 
by punctuation.

 4. Select either Keywords or Phrase.

 5. Click the Search button. This displays the search results in the Recent_Entries module which is titled Search Results.

 6. Click the Read More... link to read the post.

Search Results Display In The Recent_Entries module

Viewing Blog Comments
How to view comments associated with a blog entry on the Blog module. Note: You may not be authorized to view blog comments.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments (1) link to the bottom left corner of the blog entry. This displays the post in full with all related comments 
displayed below.



Tip: The Comments link beside each blog entries indicates the number of approved comments for that entry. E.g.  Comments (0) rep-
resents no (0) comments, whilst   Comments (8) indicates eight (8) comments.

Viewing Blog Comments



Viewing Recent Comments
How to view recently added blog comments using the Blog module.

 1. Go to the Recent _Comments module.

 2. Click on the title of a comment to view it in full. This displays the blog entry associated with the selected comment below.



Viewing Recent Comments

Adding a Blog Comment (Authenticated Users)
How to add a blog entry comment on the Blog module as an authenticated user. Note: Comments may be disabled, may require approval 
or may use the CAPTCHA security code. 



 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments link in the bottom right corner of the View_Blog module. This displays the comment entry section.

 3. In the                   Your Name text box, your username (as set in your profile) is displayed. This is the name included on your comments. 
Edit your name if desired.

 4. Optional. If the Your Email field is displayed, it displays the email address entered on your profile. This email will be used to 
show your Gravatar. You can edit your email address if desired.

 5. Optional. If the Your Website field is displayed, it displays the Web site entered on  your profile. When your comments display, 
your user name will include a link to this Web site. You can edit your  address if desired.



 6. Optional. In the Title text box, edit the comment title. Note: Editing of this field may be disabled.

 7. In the Comment text box, enter your comment. Note: Basic HTML formatting may be permitted. 

 8. Optional. In the Security Code text box, enter the displayed security code. 

 9. Click the Add Comment link.

 10. Optional. If comments require approval a dialog box reading "Your comment MUST be approved by the blog owner BEFORE it 
is displayed on the web site. Do you wish to save your comment now?" is displayed.

 11. Click the OK button. If approval isn't required, the comment is now displayed below the entry.



The Approved Comment Displays Below The Post

Adding a Blog Comment (Unauthenticated Users)
How to add a blog entry comment on the Blog module. Note: Comments may be disabled, may require approval or may use the CAPT-
CHA security code.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments link located bottom left corner of the View_Blog module. This displays the comment entry section.



 3. In the Your Name text box, enter your name.

 4. In the Comment text box, enter your comment. Note: Basic HTML formatted may be permitted.

 5. Optional. If the Your Email text box is displayed, enter an email address to be used to show your Gravatar. 

 6. Optional. In the Your Website text box, enter your Web site address. When your comments are published, your user name will 
include a link to this web site. Note: This field may not be displayed.

 7. Optional. In the Title text box, edit the comment title. Note: Editing of this field may be disabled.

 8. Optional. In the Security Code text box, enter the displayed security code. 

 9. Click the Add Comment link.



 10. Optional. If comments require approval, this displays the message "Your comment MUST be approved by the blog owner 
BEFORE it is displayed on the web site. Do you wish to save your comment now?"

 11. Click the OK button. If the comment doesn't require approval it will be displayed on the View_Blog module below the related 
post.

Tip: As an unauthenticated user you are unable to delete or edit your comments.

Editing Your Comments
How to edit comments you added to a blog entry on the Blog module. Note: You can only edit your comments if you were logged in when 
adding them and if you are currently logged in.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments link to the bottom left corner of the blog entry. This displays the post in full with all related comments dis-
played below.

 3. Click the  Edit  button or the Edit link beside the comment to be edited. This displays the comment in the comment entry sec-
tion below.



 4. Edit the comment as required.

 5. Optional. In the Security Code text box, enter the displayed security code. 

 6. Click the Update Comment link.



 7. Optional. If comments require approval a dialog box reading "Your comment MUST be approved by the blog owner BEFORE it 
is displayed on the web site. Do you wish to save your comment now?" is displayed.

 8. Click the OK button to confirm. If approval isn't required, the edited comment is displayed below the entry.

Deleting Your Comments
How to delete comments you added to a blog entry on the Blog module. Note: You can only delete your comments if you were logged in 
when adding them and if you are currently logged in.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments link to the bottom left corner of the blog entry. This displays the post in full with all related comments dis-
played below.

 3. Click the  Delete  button or the Delete link.

Editing Your Comments

Adding Social Bookmarks
How to add a social bookmark comment relating to a blog entry on the Blog module. Note: Social Bookmarks may be disabled. The fol-
lowing social web sites are included on the toolbar:  Delicious,  Facebook,  Digg,  Google,  Live Bookmarks,  News-
vine,  StumbleUpon,  Technorati,  Yahoo, and  DotNetKicks.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments link in the bottom right corner of the View_Blog module.



 3. This displays the Social Bookmark toolbar directly below the blog entry.

 4. Click on an icon to go  to the related web site where you can login and add your bookmark. 

Bloggers
Blogging
Viewing Your Blog
How to view your blog on the Blog module.

 1. Click the        View My Blog link on the New_Blog module. Your blog is now displayed in the View_Blog module. 



Viewing Your Blog

Adding an Advanced Blog Entry
How to add a blog entry including all optional settings using the Blog module.

 1. Click the Add Blog Entry link on the New_Blog module - OR - Click on blog name on the Blog_List module and then select Add 
Blog Entry from the View_Blog module actions menu. This opens the Add Blog Entry page. 

 2. Optional. In the Entry Date (local  time) text box, edit the date and time for this blog post if you want it to display at a date and 
time other than the current one when this entry is published.

 3. At Parent Blog, select which blog this entry will be added to. If Child Blogs are disabled or if you prefer using categories for 
blogs, use the Categories field below.

 4. In the Title text box, enter a title for this blog post.

 5. In the Summary Editor/text box, enter a summary of the blog entry. Note: This field may be optional and may allow HTML.                    See 
"Configuring Blog Entry Summary"

 6. In the Blog Editor, enter your blog post.

 7. Optional. In the Tags text box, enter one or more tags for this blog separated by a comma ( , ) E.g. dolls,toys. Note: This field 
includes an auto-complete option so when you begin entering a tag, if all or part of the word being entered already exists as a 
tag, buttons with matching tag names appear to the right of the text box enabling you to choose one of those existing tags.

 8. Optional. At Categories, check the categories related to this blog.





 9. Optional. Go to the Upload Options section.

 l To add an image to this blog post:

 a. At Picture, click the Browse... button.

 b. In the Alt Text text box, enter the alternative text for this image.

 c. Click the Upload button. The image is now displayed in the Blog field Editor and is listed in the Linked Files sec-
tion below.

 d. Repeat the above 3 steps to add additional images.

 l To add an attachment to this blog post:

 a. At Attachment, click the Browse... button.

 b. In the Alt Text text box, enter the alternative text for this attachment.

 c. Click the Upload button. Click the Upload button. The attachment is now displayed in the Blog field Editor and is 
listed in the Linked Files section below.

 d. Repeat the above 3 steps to add additional attachments.

 10. Optional. Maximize the Linked Files section.

 a. Click the Delete File  button beside any file that should not be included in this post. This displays the message "Are 
you really sure to delete the file?"

 b. Click the OK button to confirm.

 c. Repeat the above 2 steps to delete additional files.

 11.  Optional. Go to the Entry Options section. 

 a. At Allow users to comment on this entry (overrides Blog Setting), check  the check box to enable authenticated 
users to add comments to this blog entry - OR - Uncheck  to use the Blog Settings for this blog. 



 b. At Display Copyright notice at the bottom of your entry, select from these options:

 l Check  the check box to display a copyright notice for this entry. If checked, this will display the default Copy-
right message "Copyright ©[Current Year] [Username/Display Name]" (E.g. Copyright 2010 Rose Booth) which 
you can choose to edit.

 l Uncheck  the check box for no copyright notice.

 c. In the Trackback URL text box enter the trackback URL of another blog.

 12. Click the Save As Draft link to save this entry for later publication - OR - Click the Save And Publish link to publish this entry now. 
The entry is now displayed to you in the Most Recent Blog Entries module. It will be visible to others only if it is published and in 
a public blog.

Adding a Blog Entry

Adding a Basic Blog Entry
How to add a basic blog entry using the Blog module. This topic  excludes all optional settings.



 1. Click the Add Blog Entry link on the New_Blog module - OR - Click on blog name on the Blog_List module and then select Add 
Blog Entry from the View_Blog module actions menu. This opens the Add Blog Entry page. 

 2. At Parent Blog, select which blog this entry will be added to. If Child Blogs are disabled or if you prefer using categories for 
blogs, use the Categories field below.

 3. In the Title text box, enter a title for this blog post.

 4. In the Summary Editor/text box, enter a summary of the blog entry. Note: This field may be optional and may allow HTML.                See 
"Configuring Blog Entry Summary"

 5. In the Blog Editor, enter your blog post.





 6. Click the Save As Draft link to save this entry for later publication - OR - Click the Save And Publish link to publish this entry now. 
The entry is now displayed to you in the Most Recent Blog Entries module. It will be visible to others only if it is published and in 
a public blog.

Adding a Blog Entry

Editing a Blog Entry
How to edit a blog entry. This task can be performed by bloggers on their own blogs and by Administrators on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Edit Entry link.



 3. Edit one or more fields as required. See "Adding a Basic Blog Entry" 

 4. Click the Save link.



Saving an Edited Blog Entry

Publishing a Blog Entry
How to publish a draft blog entry using the Blog module. This task can be performed by bloggers on their own blogs and by Admin-
istrators on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Edit Entry link.



 3. Click the Save and Publish link.



Saving and Publishing a Draft  Blog Entry

Unpublishing a Blog Entry
How to take a blog entry offline using the Blog module. This allows the entry to be removed from the web site without deleting it. This task 
can be performed by bloggers on their own blogs and by Administrators on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Edit Entry link.



 3. Click the Save and Take Offline link. This displays the message "This will save your changes and take the post offline. Other users 
will not be able to see it any longer. Do you wish to continue?"

 4. Click the OK button to confirm. This displays the message "This entry is still a  draft: it will not be visible to readers until it is pub-
lished."



 5. Click the  Cancel link to return to the module.



An Unpublished Blog Entry

Deleting a Blog Entry
How to delete a blog entry from the Blog module. This task can be performed by bloggers on their own blogs and by Administrators on all 
blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Edit Entry link.



 3. Click the Delete link located at the base of this page. This displays the message "Are You Sure You Wish To Delete This Item?"    

 4. Click the OK button to confirm.



Deleting a Blog Entry

Creating Your Blog
Creating a Parent Blog (Create My Blog)
How to create your first blog using the New_Blog module. This blog will be a parent blog under which you can create multiple child 
blogs. Each of your blogs can be set as either public (can be viewed by others) or private (only you can view private blogs). 

Note: Only authorized users can create blogs. See "Enabling Users to Create Blogs"

 1. Click the Create My Blog link on the New_Blog module - OR - Select Create Blog from the Blog_List module actions menu. This 
opens the Create New Blog page.

 2. In the Blog Options section, complete these settings:

 a. In the Title text box, enter a title for the blog. This title is displayed in the Blog_List module.

 b. In the Description text box, enter a description of the content of your blog.



 c. Optional. At Make This Blog Public, select from these options:

 l Check  the check box to make this blog viewable to all users who are authorized to view this module.

 l Uncheck  the check box to set this blog as private. Private blogs can only be viewed by the blog owner. I.e. 
They cannot be viewed by any other user including Page Editors and Administrators.

 3. Click the Update link. The blog name is now listed in the Blog_List module and the blog is displayed in the View Blog module. 
You can now add your first blog entry. 



The newly created blog

Related Topics:

 l See "Adding a Basic Blog Entry"

 l See "Creating a Child Blog"

Creating a Child Blog
How to create a public or a private child blog using the New_Blog module. Note: A parent blog must first be created before a child blog 
can be added. Child blogs may be disabled and replaced with categories.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. In the Child Blogs section (located at the base of this page), click the Add button. This displays the Create New Child Blog page. 

 3. In the Blog Options section, complete these settings:

 a. In the Title text box, enter a title for the blog. This title is displayed in the Blog_List module.

 b. In the Description text box, enter a description of the content of your blog.



 c. Optional. At Make This Blog Public, select from these options:

 l Check  the check box to make this blog viewable to all users who are authorized to view this module.

 l Uncheck  the check box to set this blog as private. Private blogs can only be viewed by the blog owner. I.e. 
They cannot be viewed by any other user including Page Editors and Administrators.

 4. Click the Update link. This returns you to the Edit Blog where the child blog is now listed in the Child Blogs list.

 5. Click the  Cancel link to return to the module.

 6. Optional. Click on the name of the parent blog on the Blog_List module to view the child blog.

Adding a blog. This blog is set as public.

The child blog

Related Topics:



 l See "Creating a Parent Blog (Create My Blog)"

 l See "Enabling/Disabling Child Blogs"

Managing Your Blog
Editing Blog Title and Description
How to edit the title and description of a single blog on the Blog module. This can be performed by bloggers on their own blog and by 
Administrators on any blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. In the Title text box, edit the blog title. 

 3. In the Description text box, edit the blog description. 

 4. Click the Update link.



Blog Title and Description displayed on the Blog

Enabling/Disabling Blog Syndication
How to enable or disable syndication of your blog. This can be performed by bloggers on their own blog and by Administrators on all 
blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Syndication Options section. 

 3. At Syndicate this blog, check  the check box enable syndication - OR - Uncheck  the check box to disable it. 

 4. In the Use this email for the "ManagingEditor" RSS text box, enter an email address. 

 5. Click the Update link.



RSS Button displays on Syndicated Blogs on the View_Blog module

RSS Button displays beside Syndicated Blogs on the Blog_List module

Related Topics:

 l See "Configuring RSS Settings for Blogs"

Integrating With Twitter
How to configure a single blog to tweet when a blogger posts a new entry. This can be performed by bloggers on their own blog and by 
Administrators on any blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Twitter Integration section.

 3. At Tweet When I Post A Blog, check  the check box to enable - OR - uncheck  the check box to disable.

 4. In the Twitter Username text box, enter your twitter username.

 5. Optional. In the Password text box, enter your new twitter password - OR - Leave blank to use your standard password.



 6. Optional. In the Tweet Template text box, edit the template of the tweets. The default template is: Blogged: {title} - {url}

 7. Click the Update link.

Available template tokens:

 l {title}: Displays the title of the blog entry 

 l {url}: Displays a URL link to the blog entry

Twitter Integration

Managing Blog Comment Options
How to enable/disable and configure blog comments for a single blog on the Blog module. This can be performed by bloggers on their 
own blog and by Administrators on any blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Comment Options section and set any of these options settings:

 3. At Approval for user comments required, check  this check box if comments by authenticated users require approval before 
being published - OR - Uncheck  to publish these comments without approval. 

 4. At Comments by Registered Users, select for these options:

 l Allow: Select to allow registered users to add comments. Comment approval isn't required.

 l Require Approval: Select to allow registered users to add comments. Comments must be approved by the blog owner or 
an Administrator before they are displayed.

 l Disallow: Select to disallow registered users from adding comments.

 5. At Comments by Unauthenticated Users, select for these options:

 l Allow: Select to allow unauthenticated users to add comments. Comment approval isn't required.         



 l Require Approval: Select to allow unauthenticated users to add comments. Comments must be approved by the blog 
owner or an Administrator before they are displayed.

 l Disallow: Select to disallow unauthenticated users from adding comments.

 6. At Trackback Comments, select for these options:

 l Allow: Select to allow trackback comments. Comment approval isn't required.         

 l Require Approval: Select to allow trackback comments. Comments must be approved by the blog owner or an Admin-
istrator before they are displayed.

 l Disallow: Select to disallow trackback comments.

 7. At Send mail notification after comment and trackbacks are posted, check  the check box to enable email notification 
when comments and trackbacks are posted to this blog - OR - Uncheck  the check box to disable mail notification.

 8. At Use CAPTCHA for comments, check  the check box enable CAPTCHA - OR - Uncheck  the check box to disable.

 9. Click the Update link.

Managing Blog Comment Options

Managing Trackback Options
How to enable or disable trackback auto discovery for a single blog on the Blog module. This can be performed by bloggers on their own 
blog and by Administrators on any blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Trackback Options section. 

 3. At Trackback Auto Discovery (Client Mode), check  the check box to enable - OR - Uncheck  the check box to disable.

 4. Click the Update link.



Managing Trackback Options

Regenerating Blog Permalinks
How to regenerate all permalinks on a single blog using the Blog module. This link can be used after the Friendly URL's setting has been 
changed for the site. This can be performed by bloggers on their own blog and by Administrators on any blogs.     

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Regenerate Blog PermaLinks section to view the URL.

 3. Click the Regenerate Blog Permalinks link.

 4. Click the  Cancel link to return to the module.

Regenerating Blog Permalinks

Setting Blog Date, Time and Culture Options
How to set the time zone, culture (language) and date format on a single blog on the Blog module. This can be performed by bloggers on 
their own blog and by Administrators on any blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Date and Time Options section.

 3. At Time Zone, select your time zone.

 4. At Culture, select your culture (language).

 5. At Date Format, select your preferred date or date/time format.

 6. Click the Update link.



Blog Date and Time displayed on the View_Blog module

Related Topics:

 l See "Enabling/Disabling a Language"

Setting Blog Visibility (Public or Private)
How to set a blog as either private or public. Public blogs are visible to all users authorized to view the View_Blog module. Private blogs 
are only visible to the blog owner, as such they cannot be viewed by either Page Editors or Administrators. 

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the Blog Options section. 

 3. At Make this blog public, check  the check box to set this blog as public - OR - uncheck  the check box set it as private. 

 4. Click the Update link.



A Blog Set as Public

Setting a Bloggers Identity
How to set a blog to display either the blogger's user name or full name as the blog author using the Blog module. This can be performed 
by bloggers on their own blog and by Administrators on any blogs.

Tip: The name displayed at the Author field at the top of your blog is always your Display Name as set on your profile.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.  

 2. Go to the Blog Options section. 

 3. At When Displaying Your Identity Use, select from these options: 

 l Select User Name to display your user name. This is the default option. E.g. Rosie

 l Select Full Name to display your first name and last name. E.g. Rose Booth



 4. Click the Update link.

Blog Identity as displayed on the View_Blog module



Setting MetaWeblog Options
How to view the URL to use to connect to your blog using a MetaWeblog enabled client such as Windows Live Writer or Word 2007. This 
can be performed by bloggers on their own blog and by Administrators on any blogs.

 1. Click the Blog Settings link on the New_Blog module - OR - Click the blog name on the Blog_List module and then select Edit 
Blog Settings from the View_Blog module actions menu. This opens the Edit Blog page.

 2. Go to the MetaWeblog Options section to view the URL. Change the tabid parameter as needed if this blog appears on a dif-
ferent tab. 

 3. Click the  Cancel link to return to the module.

Setting MetaWeblog Options

Managing Comments
Approving a Blog Comment
How to approve blog comments on the Blog module. This task can be performed by bloggers on their own blog as well as by the Admin-
istrator on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments (1) link.



 3. Click the Approve  button or the Approve link. Note: You cannot undo approval for a comment, however you can edit or 
delete it.

Tip: Bloggers can enable a notification email to be sent when comments are posted which helps you know where to locate comments 
requiring approval. See "Blog Settings (Bloggers)" for details on enabling comments and comment options.

Editing a Blog Comment
How to edit a comment associated with a blog entry on the Blog module. This task can be performed by bloggers on their own blog or by 
the Administrators on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments (1) link.

 3. Click the Edit  button or the Edit link beside the comment. The comment is now displayed in the Comment text box below.

 4. In the Comment text box, edit the comment.



 5. Click the Update Comment link. 

Deleting a Blog Comment
How to delete a comment associated with a blog entry in the Blog module. This task can be performed by bloggers on their own blog or 
by Administrators on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments (1) link. This displays the comments associated with the selected entry. 

 3. Click the Delete  button or the Delete link beside the comment to be deleted.

 4. Repeat Step 3 to delete additional comments from this blog entry.



Deleting all Unapproved Comments
How to delete all unapproved comments associated with a blog entry in the Blog module. This task can be performed by bloggers on 
their own blog or by Administrators on all blogs.

 1. Locate the required blog entry. "Viewing Blog Entries for a Month"., "Viewing Blog Entries for a Single Date"., or "Viewing Recent 
Entries for a Single Blog".

 2. Click the  Comments (1) link. This displays the comments associated with the selected entry.  All unapproved comments dis-
play the  Approve link.

 3. Click the Delete all unapproved comments link located above all the comments associated with this entry.

Chat
About the Chat Module
The Chat module enables multiple users to chat with one another in real time. The module has a unique set of module permissions ena-
bling the Administrator to set the roles and/or users that are permitted to join the chat. A range of basic formatting tools are provided 
which enable chat members to format the text of their messages as well as send Smiley's.

Module Version: 01.00.01 

Minimum DNN Version: 04.06.02



The Chat Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleChat/tabid/965/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/133/scope/threads/Default.aspx

 l Issue Tracker: http://dnnchat.codeplex.com/workitem/list/basic

Chat Members
Chatting in the Chat Room
How to join a chat and add your message to the Chat module. If you are authorized to join the chat, the Chat module will display the mes-
sage [[username] Joined] inside the chat room when you go to the page where the Chat module is located. If you are not authorized to 
join the chat the Chat module will instead display the message [[username] Is Reading]. If the read only message is displayed, try log-
ging in to see if you have role access.

 1. Click inside the text box below the chat room. 

 2. Enter your message. 

 3. Click the Send button.

http://www.dotnetnuke.com/Products/Development/Forge/ModuleChat/tabid/965/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/133/scope/threads/Default.aspx
http://dnnchat.codeplex.com/workitem/list/basic


 4. Your message will now appear in the chat room.

Formatting your Chat Message
How to format your message text before sending it on the Chat module. Note: Formatting can be disabled under module settings.

 1. Click on one of the following buttons to choose your formatting: 

 l To bold text, click the Bold button.

  

 l To italicize text, click the Italic button.

 l To underline text, click the Underline button.



 l To change text size, mouse over the Size button and select a text size.

 l To add a strike through text, click the Strikethrough button.

 l To set text as a hyperlink, click the Hyperlink button.

 l To set text as subscript, click the Subscript button.

 l To set text color, mouse over the Color button and select a color.



 l To set text as superscript, click the Superscript button.

 2. Enter your text.

 3. Move your cursor to the end of the text box. 

 4. Repeat steps 1-2 to add additional text formatting. 

 5. Click the Send button. Your message will now appear in the chat room.

Settings
Setting Chat Permissions
How to set the roles and users that are authorized to join the chat in the Chat module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the Permissions tab. 

 3. In the Join Chat column, check  each role that is able to participate in the chat on this Chat module. 

 4. In the Username text box, enter the username of a user who is able to participate in the chat, click the Add link and then check  
the check box beside their username.





 5. Click the  Update link.

Setting Chat Formatting and Styles
How to set the formatting and style settings for the Chat module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the   Chat Settings tab. 

 3. In the Display Capacity text box, enter the maximum number of messages to be displayed in the chat room. 

 4. At Allow Formatting, check  the check box to enable text formatting - OR - Uncheck  the check box to disable. 

 5. In the Height text box, enter the height of the chat window. 

 6. In the Usertext text box, enter the text that displays when a user's message is displayed. The default value is {0} says. {0} dis-
plays the user's username. 

 7. In the Entered Message text box, enter the text to display when a user enters the chat. The default value is [entered]. 

 8. In the Exited Message text box, enter the text to display when a user enters the chat. The default value is [left]. 

 9. In the Message CSS Class text box, enter the Css class to be used for messages. The default class is Normal.

 10. In the Sender CSS Class text box, enter the Css class to be used for your messages. The default class is NormalBold. 

 11. Click the  Update link.



Setting Chat Formatting and Styles

Setting Chat Room Speed and History
How to set the speed of the chat room and the history of messages.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the   Chat Settings tab.

 3. In the Polling Time text box, enter the time in milliseconds that new messages will be checked for. 

 4. In the History Capacity text box, enter the maximum number of messages to be kept on the server. 

 5. Click the  Update link.



Setting the Chat Room Speed and History

Commerce
About the Commerce Module
The Commerce  module (titled Pro-Commerce) is a lightweight, yet extremely powerful module that allows DNN sites to process pay-
ments, assign roles, and sell products, services and access to content on the site. Only available in DotNetNuke Professional Edi-
tion

Module Version: 06.00.00

Minimum DNN Version: 06.00.00



The Commerce Module

Configuring the Commerce Module
How to configure the commerce module.

 1. Select  Control Panel from the module actions menu. Once you have entered the control panel, you will see the Dashboard.

 2. Select Options & Settings from the left hand panel.

 3. Click the Payment Options tab where you can configure the payment options.

 4. Check  the check box for to each payment type you want to enable. If you select one of the four credit card types, you will need 
to configure the Credit Card Payment Provider section below. If you select PayPal, you will need to complete the PayPal details 
section. If you select either Bank Transfer, Other and Purchase Order these options all require manual payment processing.

 



 5. Go to the Credit Card Payment Provider section. By default the Assembly, Class and Payment URL fields are specific to author-
ize.net. You will need to enter the Login ID and Password/Key from your authorize.net account. If you are using a sandbox 
account, you will need to enable Test Mode and change the Payment URL to https://test.authorize.net/gateway/transact.dll

 6. Go to the PayPal Details section.

 a. In the Account ID text box, enter your PayPal ID. This information will come directly from the PayPal Web site.

 b. In the PayPal URL text box, enter the PayPal URL you want to use for processing. This information will come directly from 
the PayPal Web site.

 c. In the Language text box, enter the two letter language code for the language to be used. The PayPal language codes 
are: Australian - AU, Chinese - CN, English - EN, French - FR, German - DE, Italian - IT, Japanese - JP, Spanish - ES, or 
United Kingdom – GB.

 7. Click the Save button to save these payment options. Now that you can process payments, you need something to sell.

 8. Click the Products link on the left hand panel to open the Products page.

 9. Click the Create Product button.

 10. Required. In the Name text box, enter the name of your product.

 11. Required. In the SKU text box, enter a Stock Keeping Unit which is a brief sequence of letters and numbers to help keep products 
unique and provide better reporting options.

 12. Recommended. In the Price text box, enter a price for this product.

 13. Recommended. At Active, check  the check box to set this product as available for purchase

 14. Recommended. At Visible, check  the check box to set this product as visible.



 15. Click the Save link.

 16. Click the Exit button in the left hand panel. You will now see the Product Display view. The module is ready to process purchases. 

Tip: Clicking the Buy Now button will add the “Test Product” to the Shopping Cart and begin the purchase process.

Purchasing a Product
An overview of the functionally available when purchasing a product and the purchasing process using the Commerce module.

Product Display
An overview of the details displayed for each product and how to select a product to purchase.



 l Product Group: Large bold letters display the name of the product group.

 l Name: The name of the product.

 l Page Link: Clicking on the name of a product will lead to the details page. If a details page was not entered when the product was 
created, the product name will not be a hyperlink.

 l Description: A short description of the product.

 l Price: The amount the customer has to pay. This value may be temporarily reduced with discounts.

 l Buy Now: Clicking this button will add the product to the shopping cart. Note: After clicking Buy Now, the customer will need to 
enter values for any required product properties.

Shopping Cart

 l Delete: Hovering over a product will cause a small gray X icon to display. Clicking the icon will remove the product from the shop-
ping cart.

 l Qty: The quantity of the product being purchased. The number can be adjusted by clicking the up and down arrows, after the prod-
uct has been added to the cart.

 l Name: The name of the product.

 o Properties: The values entered for the product's properties will be displayed below the name.

 l Price: The price of an individual product.

 l Discount: Any discount that is automatically applied to the product price.

 l Total: Total price of the product (Price X Qty)

 l Back to Products: Clicking this button will return the customer to the Product Display view.

 l Proceed to Checkout: Clicking this button will continue the purchase process. 

Billing & Shipping
An overview of the Billing and Shipping page and how to complete the required fields:



 l Your Information:

 o First Name: Entered by the customer.

 o Last Name: Entered by the customer.

 o Email: The customers email.

 l Billing Address: This will usually need to be the address on file with the customer's credit card company.

 o Name: Enter the full name.

 o Street: This must include the numerical address.

 o City: The city where the customer resides.

 o Region: This may be a state, or other region. The values in the drop down list will depend on the county selected below.

 o Postal Code: Also known as Zip code.

 o Country: Select a value from the drop-down list.

 l Shipping Address: An alternate address can be supplied if the product requires shipping. If this is left blank it will use the same 
address as the Billing Address. This will only appear if the product requires shipping, and shipping is also enabled in the Options 
& Settings.



 l Back to Products: Clicking this button will return to the Product Display view.

 l Proceed to Payment: Clicking this button will continue the purchase process.

Review & Payment
An overview of the Review and Payment page and how to complete the required fields.



 l Shopping Cart: Displays all products included in the order. This is the last chance to change quantities, or delete products. If addi-
tional products need to be added, click Back to Products. If the customer wishes to cancel the order, they can delete all the prod-
ucts and be redirected to the Product Display view.

 l Any special instructions or comments?: A text area where the customer adds any additional information regarding the pur-
chase.

 l Apply Discount Code?: Enter any valid discount Coupon Codes, and then click Apply.

 l Total Price:

 l Sub Total: The total before tax, shipping, discounts and any other miscellaneous fees.

 l Tax: Automatically calculated based on Tax Rates defined in the control panel.

 l Shipping: Applied if enabled, and required for the product.

 l Misc.: Miscellaneous fees.

 l Discount: The total amount the price was reduced.

 l Grand Total: The total price after tax, shipping, discounts and other fees have been calculated.



 l Your Billing and Shipping Information: Information regarding the customer. This information was entered on the previous step. If 
there is an error, click Back to Products and begin again. Clicking the back button in the browser will work as well, but may not be 
recommended.

 l Your Payment Information:

 l Other: If the Other, Bank Transfer or Purchase Order options are selected, no payment information is required. However the seller 
must contact the customer, in order to get the payment information, to complete the purchase.

 l Credit Card: Complete these fields:

 l Name on Card: The name of the credit card holder as it appears on the card.

 l Card Number: The credit card number.

 l Expiration Date: Select the expiration date for the card.

 l CCV: The short 3 or 4 digit security code on the back of the credit card.

 l PayPal: Clicking Process My Order will redirect the customer to the PayPal website.

 l Back to Products: Clicking this button will return to the Product Display view.

 l Process My Order: Clicking this button will complete the purchase process.

Order Completion

 l Additional Instructions: The contents of the additional instructions tab in the product details is displayed below the name of the 
product.

 l File Downloads: Any files that were attached to a product are shown as hyperlinks below the name of the product.

FAQ's
Frequently asked questions regarding the Commerce module.

Q: Why does PayPal say the payment has already been completed, when the customer did not log in to PayPal yet?



A: PayPal has a setting that prevents charging a customer twice for the same purchase. If you have reinstalled Commerce at any point, 
the Invoice numbers it is currently using may be conflicting with invoice numbers stored in the PayPal system from the last time the Com-
merce module was installed. Changing the Order Number to a value higher than any previously used will avoid this issue. This setting is 
found on the General tab of the Options & Settings page in the control panel.

Q: How do I create a portal specific list for the List type product property?

A: To create a portal specific list, you may need to download an additional module. One such module is available here: http://-
portallists.codeplex.com

Q: How do I select a different Credit Card Payment Provider?

A: This information will be available in the Wiki on www.dotnetnuke.com.

Q: How do I create a PayPal test account?

A: Complete the below tutorial:

 1. Navigate to https://developer.paypal.com/

 2. Click the orange Sign Up Now button.

 3. Complete the required fields. You should use a valid email address, but not one associated with a live PayPal account. Click 
Agree and Submit when finished.

 4. PayPal will send an email to you. Locate the email and click the link to verify your email address.

 5. Login with the new account.

 6. Click Test Accounts.

 7. Click New Test Account: Preconfigured

https://developer.paypal.com/


 8. Set the Account Type to Seller. The email address is only used in the sandbox test area, so choose something you will remember. 
The password will probably change when you reset the test account later, so write this down. Add a bank account and a credit 
card, to make sure the account is "verified".



 9. Click Create Account. After the system finishes creating the account, click Preconfigured again.

 10. This time you will configure the Buyer account. The email address should be different, and the account balance should not be 
zero.



 11. You should now see the two accounts listed. If at any point you need to create a new password, or change the account balance, 
click the Reset link next to the appropriate account.

 12. Copy the email address for the buyer account. It is likely that PayPal added a bunch of numbers and _biz to the address.

 13. In another browser tab, navigate to the Commerce control panel > Options & Settings > Payment Options tab.

 14. Paste the seller test account email address in the Account Id box in the PayPal Details section.

 15. Back on the PayPal site, check the radio button next to the buyer account and then click the Enter Sandbox Test Site button.

 16. Copy the URL then paste it in the PayPal URL box in the Commerce control panel.

 17. Close the Sandbox Test Site window, but do not logout of the Sandbox account. You will need to remain logged in to https:/-
/developer.paypal.com/ while doing any PayPal testing.

 18. Enter a value in the Language box in the Commerce control panel. The Language is to be entered using the PayPal language 
code. The PayPal language codes are: Australian - AU, Chinese - CN, English - EN, French - FR, German - DE, Italian - IT, Jap-
anese - JP, Spanish - ES, or United Kingdom – GB.

 19. Confirm that PayPal is selected as one of the Payment Options then click Save in the control panel.

 20. Exit the control panel, and begin a new purchase. At the Review & Payment step, select PayPal from the drop-down list. Click 
Process My Order.

 21. You will be redirected to the PayPal Sandbox Test Site. The details of the purchase should be visible on the left side of the 
screen. 

 22. Click Have A PayPal Account? Log in using the Buyer test account email and password.

 23. Click Pay Now.

 24. Click Return to Your Name’s Test Store.

 25. You should now see the usual Order Completed step in Commerce.

 26. Enter the control panel, go to the Orders page, and confirm that the order processed correctly.

 27. Viewing the Order Details > Post Purchase Log will show information about the transaction. There should be an IPN Received 
entry if it processed correctly.

https://developer.paypal.com/
https://developer.paypal.com/
https://developer.paypal.com/


Control Panel
Commerce Control Panel - Dashboard
The Dashboard section of the Control Panel of the Commerce module provides a simple heads-up-display regarding the current status of 
Commerce. The dashboard is divided into the six sections described below. 

 1. Recent Sales: A snapshot of the most recent products sold processed by DNN Commerce, showing the most important infor-
mation. This includes date, product name, grand total of the sale, and a link to the full details for each sale. 

 2. Recent Customers: Corresponding to the recent sales, this section displays information about the customers who made the most 
recent purchases. This information includes date, the customer’s name, the customer’s email and a link to the full customer 
details.

 3. Top Products: This section is a running tally of the most successful products for the current month. This is based on the grand 
total of combined sales for each distinct product. The number of units sold for each product is also displayed.

 4. Quick Links: This section allows the administrator to easily access some basic tasks in the control panel. 

 l Add Products: opens the product creation page on the products section. 

 l Create Invoice: opens the order creation page found on the Orders section. 

 l Create Discount: opens the discount creation page found on the Discounts section.

 5. Quick Stats: This section shows the total sales figures for the current day, month, quarter and year.

 6. Pending Orders: This section displays orders that have been initiated but not completed. Purchases that have not received a pay-
ment are considered pending.

Commerce Control Panel - Orders
The Orders section of the Control Panel of the Commerce module provides a comprehensive list of all the order processed by DNN Com-
merce.



Order List: The order list shows the most recent orders processed by DNN Commerce. Each grey box is a single order with an invoice 
number, customer name, time and date of purchase, grand total and payment status indicator. Clicking on a single order will expand that 
order’s details.

Search: The search box allows you to enter a customer name, order number, or grand total amount to filter the list. The order list will 
instantly display the filtered results of your search as you type.

Search Options: Clicking the small lightning bolt icon to the right of the Search button will expand the search options.

 l Status Choose to display only paid or only not-paid orders.

 l Sort Column: Change which value is used to sort the list.

 l Sort Order: Change the direction that the list is displayed.

 l Rows: Select how many rows to display at once.

Order Details: Clicking on a single order in the list will display the order’s details. A single order has many details associated with it.



Order Information

 l Invoice: The invoice number for the purchase. This value is unique per purchase and can be used to track specific orders.

 l Date: The date and time of the purchase.

 l Source: The channel used to process the sale. (Example: Phone, web, email, other)

 l Sales Rep: An optional detail, clicking the down-arrow will show a list of available sales reps. Select one to designate that user as 
the sales representative responsible for the current order.

 l Status: An optional detail, clicking the down arrow will show a list of available statuses.

Customer Information

 l Clicking on the name will lead to the customer’s details view. 

 l Clicking edit will display a screen used to select a customer to associate with the purchase. 

 l If the customer does not exist as a DNN user, the New Customer tab can be used to create a new user to attach to the order.



Payment Details: A brief description of the payment information for the order.

 l Method: The type of currency used. Credit Card, PayPal, Other, etc.

 l Last 4: If a credit card was used, this will show the last four digits of the credit card number

 l Transaction ID: The transaction ID for the purchase.

 l Authorization: The authorization code from the payment processor.

Billing Address: The billing address for the customer. Clicking the pencil will display the currently available addresses, and the option to 
add a new address.

Shipping Address: The shipping address for the customer. This might be the same as the billing address. Clicking the pencil will display 
the currently available addresses, and the option to add a new address.

Items Ordered List: Below the header is a list of the products included in the current order. Listed here is the name of the product, per 
unit price, quantity purchased, miscellaneous fees and the total price per product.



 l Clicking the pencil will display the Order Item Details which is used to modify properties of the product in the order. The properties 
are the same as those listed in the product list, with the addition of a notes field.

 l Clicking the trash can icon will delete a product from the order.

 l Clicking Add Items will display the Order Item Details. Selecting a product that does not currently exist in the order will add it.

Post Purchase Log: The post purchase log is a list of the actions taken by Commerce after a customer completes a purchase. If one of 
these actions fails it will have a red X icon instead of the green check mark. The information displayed includes the timestamp of when 
the action occurred, the type of action, if it was successful or failed, and any additional information regarding the action. The note field will 
show error codes from the payment processors, which email template was sent and other specific codes.

Create Order: Clicking the Create Order button on the order list will display a blank Order Details page. When creating an order it is 
important to complete as many fields as possible. The various Edit buttons and Add Items button, in addition to the drop down lists are 
used to add content.

Commerce Control Panel - Products
The Products section of the Control Panel of the Commerce module provides a comprehensive list of all the order processed by DNN 
Commerce. The Products page allows you to view all existing products, the individual product details, and create new products.



Product List: The products page displays a list of all the available products. Clicking on an individual product will display the product 
details.

Create Product: Clicking the Create Product button will display a blank Product Details page, where the information about the new prod-
uct is entered. Click Save when all relevant information is entered.

Product Details

 l Group: Available product groups are in the drop down list. If there are none available, clicking the green + icon will display the 
Edit Product Group window. Product groups are used to categorize similar products. The name of any product group that currently 
has products assigned to it will be visible to customers on the Product Display view.

 l Edit Product Group: Enter the desired name of the new product group, then click Save.

 l Name: The name of the product. The text you enter here will be displayed in large bold letters on the Product Display view, so 
entering a clear, concise title is appropriate.

 l SKU: A SKU (Stock Keeping Unit) is a short, simple, unique alphanumeric code used to keep track of different products.

 l Details Page: Enter a URL, including the protocol (http://), that contains more information about the product. The product name on 
the Product Display view will become a hyperlink that directs the customer to the URL.

 l Price: The amount that you wish to charge customers who purchase the product.

 l Cost: The amount that it cost to produce the product.

 l Shipping Fee: The amount that it costs to ship the item.

 l Active: Enabled or disable the product. Disabled products cannot be sold.

 l Visible: Toggle whether the product will be displayed on the Product Display view or hidden. A product can be active, but not vis-
ible. In that situation, an alternative method such as a direct link or a custom action must be used to allow customers to purchase 
the product.

 l Taxable: Toggle whether the product requires a sales tax applied to it.

 l Requires Shipping: Toggle whether or not the product will need to be physically shipped. (As opposed to electronic distribution.)

 l Description: A short summary of the products features. This text will be shown on the Product Display view below the name of the 
product.



Product Options

 l Allowed Roles: Select a role from the drop down list then click Add Role. Any role that is added will be able to purchase the item. 
If no roles are added, it will be available to any user with permission to view the Product Display view.

 l Add To Roles: Select a role from the drop down list then click Add Role. When a customer purchases the product, the customer 
will be added to any DNN role added here.

 l Custom Action: Enter the class name and assembly that contains instructions to carry out custom actions after a customer com-
pletes a purchase.

 l Product Email Template: Select an email template that will be sent when a customer purchases the product. By default the email 
template should be Order Shipment Notification.

 l Billing Type



 l One-time Payment: A typical situation where a customer pays once, then receives the product. 

 l Recurring Payment: Used for subscriptions or products that require multiple payments from the customer.

 l Interval: Select Days if you want the payment to occur after a specific number of days have passed. Select Months if you 
want the payment to occur after a specific number of months have passed, on the same day of the month as the initial pur-
chase.

 l Units: The specific length of the interval. Enter a value between 7 and 365.

 l Occurrences: The number of times a customer is to be billed, not including the initial purchase. Enter a number between 
1 and 9999.

Note: The interval, units and occurrences work together to control the schedule of recurring payments. Example: If the values “Days”, “7”, 
and “10” are entered, then the customer will be billed every 7 days, starting 7 days after the initial purchase, until a total of 10 additional 
periodic payments are made.

Properties: Product properties are descriptive attributes, used to capture values from the customers. Product properties are defined in 
the control panel, and then displayed during the purchase process. An example of a product property when selling a product: The prop-
erty could be “Size”, and during the purchase process, the customer selects the value “Medium” from a list of “Small”, “Medium” and 
“Large”.



Property List: A list of existing properties for the product. Clicking the name of a property will display the Property Editor. Click and drag 
the small 0-9 icon to change the order of the list.

 l Add Property: Clicking the Add Property button will display the Property Editor.

 l Property Name: A short name for the product property.

 l Label: The localized value that will be displayed to the customer during the purchase process. It may be the same 
value as the property name.

 l Data Type:

 l Text: Used for a product property where the customer enters a text value. Useful for less specific properties. 
Example: Custom inscription on the product.

 l List: Used when there is a distinct number of possible values and you only want the customer to select one. 
Example: Size (values: Small, Medium, Large) 

 l List Name: Select a portal specific list created previously. View the FAQs section for information on 
creating portal specific lists.

 l Required: Choose whether or not the product property requires a value before the purchase can be completed.

 l Input Validation: Use a REGEX value to control the values that are entered by the customer.

 l Default Value: The value that will be entered into the property by default. The customer can delete or change the 
value during the purchase process.

 l Enabled: Select No if you wish to hide the Profile Property from the customer during the purchase process.

 l Special Instructions: If enabled, these instructions will be displayed after the customer completes their purchase. Instructions 
such as where to download files, where to get support, or where to register would be common here.



 l Downloads: These files are available to the customer after they complete their purchase.

 l File List: Files that have been previously uploaded are listed here. Clicking the small trash can icon will delete the file.

 l Add File: Clicking Add File will display the Upload File interface.

 l Title: Enter the name of the file. This name will be displayed to customers who purchase the product.

 l Date of Purchase: The file will only be available for download to customers who purchase after this date.

 l File: Use the file browser to select the file to upload. Click Upload File when finished.

Commerce Control Panel - Discounts
The Discounts section of the Commerce module Control Panel includes two types of discounts. Coupon Codes can be applied during the 
purchase process to reduce the price of a product. Default Discounts are temporary price decreases that are automatically applied to spe-
cific products.

Create Discount: Clicking Create Discount will display an empty Discount Details page, enter all the information described below then 
click save.

Discount Details: Clicking on a discount in the list will display the discount details.



 l Description: A brief statement describing the discount.

 l Discount Code: The alphanumeric code entered by the customer during the purchase process.

 l Require Discount Code:

 l If Yes is selected, the discount will use a Coupon Code. The discount will not be applied until the customer enters the dis-
count code in the box during checkout.

 l If No is selected, the discount will be a Default Discount. It will automatically reduce the price of applicable products. A Spe-
cific Product Discount Restriction must be added in order to activate a Default Discount.

 l Amount: The static value of currency that should be discounted from the price. If you enter a value here, Percent should be 0 
(zero).

 l Percent: The percentage value that should be discounted from the price. If you enter a value here, Amount should be 0 (zero).

 l Max Use Per User: Enter a number indicating how many times a particular customer can use the discount code.

 l Max Use Total: Enter a number indicating how many times the discount code can be used by all customers combined.

 l Start Date: The date when the discount becomes active.

 l End Date: The date when the discount code will no longer work.

 l Enabled: Discounts that are not enabled will not reduce the price of a product.

Discount Restrictions

Restriction List: Click the red X to delete a restriction.

Add Restriction: Click the Add Restriction button to create a new discount restriction.

 l Restriction Type: Select a type from the drop-down list.



 l Specific Product(s): This restriction causes the discount to only be applied to a specified product. Select the name 
of an existing product. Multiple restrictions can be created to apply the discount to multiple products.

 l Products Purchased: This restriction causes the discount to only be available to customers who have previously 
purchased a specified product. Select the name of an existing product from the drop-down list. Enter a date range 
for qualifying purchases (MM/DD/YYYY or DD/MM/YYYY depending on locale). If a customer purchased the spec-
ified product in the time frame between the “After” date and the “Before” date, then they will be eligible for the dis-
count.

 l Specific Role(s): This restriction causes the discount to only be available to members of the specified role. Select 
a role from the drop-down list.

Discount List: A list of available discounts.

 l Search: Enter the name or code of a discount to filter the list. Click on a single discount to view the details, and to enable/disable 
it.

 l Search Options:

 l Active Only: Only display Active Discounts

 l Sort Column: Change how the discounts are sorted.

 l Sort Order: Change the direction of the sorted list.

 l Rows: Specify how many rows to display.

Commerce Control Panel - Customers
The Customers page allows you to browse for customers, and view their account and order information.

Customer List

After searching, a list of customers will be displayed here. Click on a single user to display additional details.



 l Search: Enter the first few letters of a customer’s first name, last name, username or display name. The results should be dis-
played instantly.

Customer Details: Clicking on the name of a customer will display their details. Clicking the Up or down arrows will collapse and expand 
the sections.

 l Personal Information

 l Name: The customers first and last name.

 l Display Name: The customers DNN Display Name.

 l User ID: The customer’s User Id. This is designated by DNN when the user registers and cannot be changed.

 l Username: The username the customer chose to represent them.

 l Email: The customers email address.

 l Date Created: The date the customer was recorded in the system.

 l Order History

 l Order Number: The invoice numbers of the customer’s previous purchases. Clicking an order number will display the 
order details.

 l Date of Purchase: The date the purchases were made.

 l Grand Total: The total amount they spent on the purchase.

 l Security Roles: Roles are defined in DNN, and used to control and group users.

 o Role Name: The name of the role.

 o Effective Date: The date the user becomes a member of the role.

 o Expiration Date: The date when the user is no longer a member of the role.

Configuring Module Options & Settings
How to configure the settings for the Commerce module.



 l Order Number: The number of the most recent invoice. If no purchases have been made, any number entered will be the starting 
point for invoice numbers.

 l Store Email: The email address that appears as the “From” address in outgoing email notifications. 

 l Do you collect tax?: Toggle if sales tax needs to be added to purchases

 l Do you charge shipping?: Toggle if a charge needs to be added to ship physical goods.

 l Theme: Select a theme. Different themes affect the colors and styles of the Product Display view.

 l Order Sources: Comma separated values are used to define all the possible sources of a sale. 

 l Sales Reps: Select a role that contains existing users. These users can be specified as the sales representatives for orders.

 l Date Format: How dates are displayed.

 l Time Format: How times are displayed.

 l Roles to Notify: Select a role then click add role. The members of any role that is selected will receive the Order Notification tem-
plate, when a purchase is completed.

 l Email Templates

 o Order Notification: Sent to administrators and other specified roles when a purchase is completed.

 o New Customer: Sent to new customers that register during the purchase process.



 o Order Details: Sent to a customer after they complete a purchase.

 o Pending Payment: Sent to a customer when the purchase has not been completed due to a pending payment.

Payment Options

 l Payment Options Selection: Select one or more payment options that will be available to customers during the purchase proc-
ess.

 l Visa: A common Credit Card

 l MasterCard: A common Credit Card

 l American Express: A common Credit Card

 l Discover: A Common Credit Card

 l PayPal: A popular online payment processor. Selecting this option will route the customer to the PayPal website after the 
purchase. Additional configuration is described below.

 l Bank Transfer: Direct electronic funds transfer. This option will require manual interaction with the customer to get the 
details of the bank accounts.

 l Other: Any type of payment not listed. This could include a cash, check or money order payment. This type of payment 
requires manual interaction with the customer after the purchase has been completed.

 l Purchase Order: A purchase order is a commercial document issued by a buyer to a seller, indicating types, quantities, 
and agreed prices for products or services the seller will provide to the buyer.



 l Enable SSL: Selecting this option will ensure that purchases are processed using SSL.

 l Currency: The currency type used for transactions. The four credit card options processed by the default Credit Card payment pro-
vider, authorize.net, will only process transactions using US Dollars. PayPal and the other manual options can use the other cur-
rencies.

 l Credit Card Payment Provider: Information regarding the entity that will process credit card payments.

 o Assembly Name: Enter the name of the assembly that is located in your bin directory that will handle your payment proc-
essing.

 o Class Name: Enter the full name of the class that is within the assembly you specified above that will be used to process 
payments. The default class points to authorize.net.

 o Login ID: The ID used to authenticate with the payment provider.

 o Transaction Key: The unique key used to perform transactions. Provided by the payment processor.

 o Test Mode: Set the module into Test Mode, which will not process actual real money transactions.

 o Payment URL: The location of the payment provider gateway. By default it uses the authorize.net gateway.

 l PayPal Details

 o Account Id: The email address associated with your PayPal store.

 o PayPal URL: The page that the customer will be directed to after the purchase is complete.

 o Language: The language desired for the PayPal page. The Language is to be entered using the PayPal language code. 
The PayPal language codes are: Australian - AU, Chinese - CN, English - EN, French - FR, German - DE, Italian - IT, Jap-
anese - JP, Spanish - ES, or United Kingdom – GB.

Tax Rates

 l Identifier: Used to specify when a specific tax should be applied. If the customer resides in an identifier zone, the tax will be 
applied. Options include City, State, Postal Code, and Country. 

 l Qualifier: Used to list a specific instance of the identifier zone. When a customer enters a value found in the qualifier column for a 
matching identifier, the tax will be applied. The values for City, State and Postal Zone must be the full name of the zone (Example 
San Mateo, California, 94402) The Country qualifier uses the country code (Example US, CA and JP for United States, Canada 
and Japan) If multiple zones need to be taxed, multiple tax rate entries must be created for each specific zone.

 l Rate: Enter the percentage value of the tax rate.

 l Tax Rate List: A list of previously created tax rates. The qualifier and percent rate are displayed. Click the red X icon to delete a 
tax rate.

Order Status Options: These options are potential statuses for a purchase completed by a customer. The default options available are: 
Complete, Pending Payment, Processing, Shipped, and Canceled.



 l Edit: Click the pencil and paper icon to change the name of an existing option.

 l Delete: Click the red X to delete and existing option.

 l New: Enter a name in the text box, then click Save to create a new option.

Console
About The Console Module
The  Console module displays a list of icon links to site pages. The module can be configured to display links to the child pages of the 
page it is located on, or any other parent page. This content module can be deployed on any page by authorized users. It is also located 
on the Admin and Host pages in the main menu, enabling Administrators and the Host to view icons which link to the various Admin or 
Host pages respectively.

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.

The Console Module on a Site Page

Settings
Configuring Console Settings
How to configure the module settings which are specific to the Console module.

Tip: The default Small and Large Icons can be set for individual pages. See "Advanced Settings for New Pages", or "Advanced Settings 
for Existing Pages".

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Console Settings tab.

 3. At Show Children Of, select from these options:

 l Select a page display all child pages for that page.

 l Leave this field blank to display all child pages for the current page.



 4. At Default Icon Size, select from the following:

 l Small Icons (16 px): Displays small 16 pixel icons.

 l Large Icons (32 px): Displays large 32 pixel icons.

 5. At Allow Icon Resize, select from these options:

 l Check  the check box to enable users to resize the default icon size. This displays a drop-down box above the icons 
on the module.

 l Uncheck  the check box to disable icon resizing. This removes the drop-down control.

 6. At Default View, select from these options:

 l Simple View: Displays an icon and page name for each item.

 l Detailed View: Displays an icon, page name and page description for each item.

 7. At Allow View Change, select from these options:

 l Check  the check box to enable users to change the default view. This displays a drop-down box above the icons on 
the module.

 l Uncheck  the check box to hide this control. This removes the drop-down control.

 8. At Show Tooltip, select from these options:

 l Check  the check box to display a tooltip  when hovering over icons in Simple View. The tooltip is the description 
which is shown in Detailed View.

 l Uncheck  the check box to hide the tooltip.

 9. In the Width text box, select from these options:

 l Enter a pixel width to set the width of this module. For example, enter 400 to display 2 columns of icons in the content 
pane. 

 l Leave this field blank to allow the icons to expand horizontally.

 10. Click the Update link.



The Console Settings Page

The Console module displayed with Large Icons and Detailed View

Document Library
About the Document Library  Module
The Document Library  (also referred to as the Open-Document Library module) module enables users manage and share documents in 
a flexible, intelligent way, offering granular control over Folder and Document access. The module offers the possibility to organize doc-
uments by physical Folder and by logical Categories, thus making it easy for your users to look for and find documents according to 
areas of interest.

Module Version: 06.00.00

Minimum DNN Version: 06.00.00

Features: ISearchable, Upgradable



Important. There can be only one Document Library module per portal and only one instance of the module on any given page. You can 
however have 100 pages on your site each with an instance of the module. A wide range of settings allows you to configure each 
instance to display different information. If you have child portals, and you install Document Library on a child portal, it is considered an 
entirely separate library.

The Document Library  Module

Configuration
Creating a Library from Scratch (Adding a Parent Folder)
How to create a library from scratch by adding the first folder (also called the root folder) to the Document Library module. Multiple sub-
folders (child folders) can be added beneath the parent category. Only Administrators can perform this task.

Important. Alternatively, to use an existing folder structure rather than create a library from scratch, see "Importing a Library".

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. Click the  Click To Add To Root Folder link in the navigation tree. This displays the Add Folder section.



 3. In the Add Folder section, go to the General tab.

 4. In the Folder Name text box, enter the name of your root folder. See "Configuring General Settings for Folders"

 5. Select the Security tab.  

 6. At Role Security, check  the check box beside each role which can access this folder and associated documents. See "Con-
figuring Security Settings for Folders"



 7. Click the Update link. The root folder is now created.

Tip: There is no Administrators role in the list of security roles. This is because Administrators and SuperUsers  always have full rights to 
the library.

Related Topics:

 l See "Setting User Security for  Folders"

Adding the Parent Category to Library
How to create the parent category (also called root category) to the Document Library module. Multiple sub-categories (child categories) 
can be added below the parent category. Only Administrators can perform this task.

Like in a real library, a document belongs to a single folder, but can belong to multiple categories. Categories are represented as a hier-

archy tree, just like the folder tree, and can be seen by clicking the Category  icon in the toolbar. Categories work similar to folders 



except for versioning and user level access rights and that you do not create a "physical" category in order to store a document in a 
category. 

 1. Click the Category  icon in the toolbar. This displays the Category navigation tree.

 2. Click the  Click To Add To Root Category link in the navigation tree. This displays the Add Category section.

 3. In the Add Category section, go to the General tab.

 4. In the Category Name text box, enter the name of your root category. See "Configuring General Settings for Categories"

 5. Select the Security tab.  

 6. At Role Security, select the roles which can access categories and associated documents. See "Configuring Security Settings for 
Categories"



 7. Click the Update link. The root category is now created.

Tip: There is no Administrators role in the list of security roles. This is because Administrators and SuperUsers  always have full rights to 
the library.

Importing a Library
How to build a library starting from a pre-existing set of directories and documents using the Document Library module. 

This option allows you to automatically import both your directory/folder structure as well as the documents directly into the library. Note: 
You can also opt to secure your files before synchronizing. If you do secure your files, then the documents in your pre-existing structure 
will have an extension added to it: for example a document.doc will be renamed document.doc.xsdl.resx in order to prevent direct 
download. This change is transparent to the user, and the appropriate extension will be reinstated when the document is downloaded. 

To get started, you should copy or create your folder structure under the Home Directory of your portal, or, if you choose the UNC Share 
option, a UNC Share or a local folder. In a typical DNN installation, the default home directory is created under the “<dnn root>/Portals” 
directory.

Remember that in DNN, folders are required to grant read, write and modify permissions to the ASP.NET or Network Services user, 
depending on the operating system you are using. Your newly created folders will inherit these permissions from the parent folder you 
place them in (in the example Portals/0), but you should check, especially if you are using the UNC Share option.

Note: This version of Document Library module allows the "root" folder of the library to be of type Portal or type UNC Share.



 l Type Portal: When of type Portal, the root directory will be located under the "Default Directory" of your DNN portal or child portal. 
In a default portal DNN installation, the default directory would have the following route: <DNN virtual root>/Portals/0 In a child por-
tal (named child), the default directory would have the following route: <DNN virtual root>/Portals/child

 l Type UNC Share: Support for UNC Shares is available through the Global Settings. You can basically point the library to any 
path local to your computer or to a UNC Share, as long as the ASP.NET/Network Services user  has the appropriate 
read/write/change rights.

Now that we know what we want to import, here's how to import:

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Click on the Global Settings tab.

 3. At Root Folder, set the following:

 a. Select either Portal or UNC Share as discussed above.

 b. Click the Locked  button to unlock the Root Folder field. This displays the message "Clicking this option will allow you 
to change the Root Folder. Once you update your changes, the Database and the File System will be automatically Syn-
chronized".

 c. Click the OK button to confirm. This displays the Unlocked  button.

 d. Select the required Root Folder from the drop-down list. E.g. My Documents.



 4. Click the  Update link. This returns you to the Document Library main view.  You are now presented with the list of newly created 
folders. Under the folders you will be able to see the documents that have been added to the library.

 a. Optional. Since the Synchronization process is asynchronous, the folder may not have been fully synchronized yet. In this 
case a warning message is displayed. By refreshing the page, or by looking at the log, you will know when the process is 
done, and the warning message is removed. Non admin users will get a much more discreet message.

An Imported Folder Structure

Contributors
Managing Categories
Adding a Sub-Category
How to add a sub-category (child category) to the selected category in the Open-Document Library module. Note: The parent category 
must first be created by an Administrator. See "Adding the Parent Category to Library".



 1. Optional. Click the Category  icon in the toolbar. This displays the Category navigation tree.

 2. Right-click on the required category and select  Add Sub-Category.

 3. Configure the General and Security tab settings.  Note: Security tab is only visible to authorized users. See "Configuring General 
Settings for Categories" and "Configuring Security Settings for Categories"..

 4. Click the Update link. This displays the new category in the category navigation tree.

Adding a Sub-Category



Editing Category Settings
How to edit category setting such as category name, parent category and security on the Document Library module.  Note: The available 
options are controlled by user permissions. E.g. If a user has edit rights but no security rights, the “Security” tab is not displayed.

 1. Click the Category  icon in the toolbar. This displays the Category navigation tree.

 2. Right-click on the required category and select  Edit Category Settings from the drop-down menu.

 3. Configure the General and Security tab settings. See "Configuring General Settings for Categories" and "Configuring Security Set-
tings for Categories"..

 4. Click the Update link.

Tip: The parent category of a specific category can be also changed through drag & drop utility. Just select the category you want to 
move, click the left button and drag the category to the chosen parent category.

Deleting a Category
How to delete a category in the Document Library module.



 1. Click the Category  icon in the toolbar. This displays the Category navigation tree.

 2. Right-click on the required category and select  Delete Category from the drop-down menu. This displays the category details 
in the Delete Category section.

 3. Click the Delete link. This displays the message "Are you sure you want to delete this Category and all of its SubCategories?"

 4. Click the OK button to confirm.

Deleting a Category from the Document Library Module

Configuring General Settings for Categories
How to configure the General settings for categories in the Document Library module. This topic  assumes you are currently adding or edit-
ing a category.

"Editing Category Settings".



 1. At Category Name, enter or edit name for the category.

 2. Optional. At Parent Category, select the parent category for the current category from the drop-down box. Note: This setting is dis-
abled for the parent category.

 3. In the  Category Access section, set the follow attributes to determine if and how a category can be accessed directly through a 
URL or though settings specifications:

 4. At Direct Access Only select from these options:

 l Check  the check box to set this category as hidden from general view, unless accessed directly through the 'Direct 
URL' (as set below) or through setting the value of 'Restrict List to 1 Category' in the module settings. If the category 
marked for direct view contains sub-categories, all sub-categories will also be visible, unless those sub-categories have 
also been marked for direct view as well.

 i. At Direct Access Key, enter a unique key which will be required in order to access this "Direct Access Only” cat-
egory.  If you do add a key, and you access the category through the 'Direct URL' method, then you'll need to place 
both the xsfid parameter as well as a new key parameter in the URL. If you access the category through the 
'Restrict List to 1 Category' method, then you'll need to place only the new key parameter in the URL. [url format: 
xsfid=id&xsfk=key]

 ii. At Category Direct URL the direct URL for this category is displayed. If linking to this page through an external 
link, and you only want to show the contents of this specific category (and all of its sub-categories), this is the 
parameter to be added to the URL. Adding this parameter to the URL will achieve the same results as setting the 
value of 'Restrict List to 1 Category' in the module settings.

 l Uncheck  the check box to enable access to all authorized users using the Navigation tree.

Configuring Category General Settings

Configuring Security Settings for Categories
How to configure the Security settings for categories in the Document Library module. This topic  assumes you are currently adding or edit-
ing a category.

The following options are available on the Security tab:



 1. Optional. At Inherit Security, check  the check box to set this category to inherit security permissions from its parent folder.

 2. Check  the check box beside any of the below permissions for each role as required:

 l View: Enables users to view the category in the navigation tree.  This right only allows view access to the category and 
documents.  There is no context menu associated with this right.

 l Add: Enables users to add sub-categories to this category.

 l Edit: Enables users to edit the category.

 l Delete: Enables users to delete the category.

 l Edit Security: Enables users to view the Security Tab when editing a folder and thereby assign security rights to the var-
ious roles.

Configuring Category Security Settings

Managing Documents
Adding a Document
How to add documents to the Document Library module. This topic  assumes you have already created a library. See "Option 1: Creating 
a Library from Scratch". 

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. Option One: Right-click on the required folder and then select  Add Document(s) from the drop-down menu.



Option Two: Click on a folder to select it and then click the  select  Add Document(s) button. This displays the Upload  Document sec-
tion.

 3. At File, click the Browse... button and then select the required file from your computer.

 4. Optional. At Unzip File, check  the check box if you are uploading a zip (*.zip) file that you want to unzip. If the .zip package con-
tains a structure of folders and sub-folders, the corresponding folder structure will be created in the module. After unzipping the 
uploaded .zip file, it will be removed.

 5. Optional. At Overwrite File(s), check  the check box if you want to overwrite the file(s) if they already exist.

 6. Click the Update link. Note: that ASP.NET limits the size of file uploads to 4 Megabytes. See "Modifying Maximum Request 
Length"



 7. Optional. If this folder is moderated a message reading "Moderated folder upload. All uploaded documents will be reviewed 
before being published" is displayed.

 a. Click the OK button.

 8. To add document without adding any metadata, click the Cancel link and the document is now uploaded - OR - Complete any of 
the following fields in the Edit Document section:

 a. In the Document Name text box, edit the document name if required.

 b. At Folder, modify the folder this document is located in.

 c. At                    Categories, select each category this document is associated with.

 d. In the Description Editor, enter a description of the document.

 e. At Expiration Date, select a date when the document expires. The selected date is highlighted gray.



 f. Click the Update link. If the folder isn't moderated, the added file is displayed in the list of documents for that folder.



 i. Optional. If this folder is moderated a message reading "Moderated folder edit. All edits will be reviewed before 
being published" is displayed.

 ii. Click the OK button.

Adding Documents to the Document Library Module

Editing a Document
How to edit a document which has been uploaded to Document Library module.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on the required folder.

 3. Click the Edit  button beside the required document. This displays the Edit Document section where you can edit the following 
document properties.

 4. At Folder, select a new folder to store the document in.

 5. At Categories, select the categories you want to associate this document with.

 6. In the Description text box, enter or edit the document description. This description can contain html and images if you want to.  
Also, you always have the option not to display the description by going to the settings and uncheck the “display description” 
option for the document grid.



 7. Click the Update link. If the folder isn't moderated, the added file is displayed in the list of documents for that folder.

 i. Optional. If this folder is moderated a message reading "Moderated folder edit. All edits will be reviewed before being pub-
lished" is displayed.

 ii. Click the OK button.

Editing a Document



Deleting a Document
How to delete a document which has been uploaded to Document Library module.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on a Folder to select it.

 3. Click the Edit  button beside the required document. This displays the Edit Document window where you can edit the following 
document properties.

 4. Click the Delete link. This displays the message "Are you sure you want to delete this Document?"

 5. Click the OK button to confirm.

Tip: If the Delete link is disabled the file may be awaiting moderation.



Deleting a Document

Downloading a Document
How to download the selected document to your local file system.



 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the navigating tree, click on a Folder to select it. 

 3. Click the Download  button. You’ll be asked to either open the document or to store it in a folder in your local file system.

Downloading a Document

Re-Submitting a Document
How to re-submit a document using the Document Library module. This is necessary when you receive notification from a moderator 
requesting you  to revise and  then re-submit a previously uploaded document for approval. This topic  explains how to edit the document 
properties and re-submit it.

 1. On the toolbar, navigate to  Tools >  Moderate and then select  My Items.

 2. Optional. In the Filter Options section, apply one or more filters. See "Moderation Filter Options"

 3. Click the Review  button beside the required file. This opens the Edit Document section.

 4. Optional. Edit one or more document fields and then click the Update link.

 5. Click the Re-Submit link: Select to re-submit the file for moderation.



Re-Submitting a Document

Viewing Statistics
How to view the  comprehensive set of statistics tools  using the Document Library module. Keep track of folder, category and document 
access as well as see who is clicking on folders and categories and downloading documents. All statistics can be filtered by user profile 
and access dates, as well as other folder or category specific parameters. Note: In the below examples we will look at Document sta-
tistics, but keep in mind that the same principles apply to Folder and Category statistics.

 1. Mouse over  Tools >  Statistics in the navigation toolbar and select from these options:

 l  [by Documents]: Select to view document statistics.

 l [by Folder]:  Select to view folder statistics.



 l  [by Category]:  Select  to view category statistics.

 2. This opens either the Document Statistics, Folder Statistics or Category Statistics pane according to your selection and display a  
list with a summary of all download activity.

 3. Optional. In the Filter Options section, apply one or more filters from these options:

 a. At Folder, select which folder you want to restrict results to. Note: This option is only available when viewing Document Sta-
tistics.

 b. At User Name, click on the  User  button to select a single user's items to view. This opens the User Picker window 
where you can view a list of the existing users.

 i. Use the A-Z links across the top to filter  users by the first letter of their username.

 ii. To select a user, click the Select User  button to the right of their name. This displays their username in the User 
Name text box.

 c. At Start Date, click the Calendar  button and select the first date statistical information was retrieved. See "Working with 
the Calendar"

 d. At End Date, click the Calendar  button and select the last date statistical information was retrieved. See "Working with 
the Calendar"

 e. Click the View Statistics link to view items matching the selected filters.



 4. To view more details of any of the items in the list, click the View Details  button. This displays the Download Details section.

Viewing Statistics

Tip: Quick links to change to Folder, Category or Document statistics is displayed at the base of the page.

Enabling Document Tracking
How to enable or disable tracking of a document which has been uploaded to Document Library module.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on the required folder.

 3. In the Tracking  column select from these options beside the required document:

 l Click the Currently Tracking  button to turn tracking off.

 l Click the Not Tracking  button to turn tracking on.



Enabling or Disabling Document Tracking

Managing Document Tracking
How to view a list of tracked documents and disable tracking for one or more documents using the Open-Document module.

 1. On the toolbar, navigate to  Tools >  Tracked Items. A complete list of tracked documents is displayed.

 2. Optional. In the Filter Options section, select a folder it you only want to view files within that folder and then click the View Items 
link.

 3. To disable tracking for one or more documents, select from these options beside the required document, click the Stop Tracking 
 button.

Managing Document Tracking

Adding a Document Version
How to create a version of a document which has been uploaded to Document Library module.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on the required folder.



 3. Click the Edit  button beside the required document. This displays the Edit Document section where you can edit the following 
document properties.



 4. At Document Versioning, click the Add Version  button.

 5. A list of all versions of this document including the newly added version is now displayed. You may now like to edit this latest ver-
sion.



Creating a Document Version

Managing Document Version Info
How to view version information and choose to restore, permanently delete or download previous versions of the document. A version is 
automatically created every time a document is re-uploaded in the same folder and with the same name.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on the required folder.

 3. Click the Version Info  button. This displays a summary list of each version. Note: If there are no versions saved, this section 
will be empty. The following options are now available:

 l Click the Restore  button beside a version to restore it.

 l Click the Delete  button beside a version to permanently delete it.

 l Click the Download  button beside a version to download it.



 4. Click the  Cancel link to return to the module.

Tip: When you restore a document, the restored version becomes the current document, and what was the current document gets added 
as a new version.

Viewing Media
How to view (play) multimedia which has been uploaded to Document Library module.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on the required folder.

 3. Click the Display Media  button. This opens and plays the media in a new window.

Viewing Media

Viewing Media
How to view (play) multimedia which has been uploaded to Document Library module.



 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. In the Navigation tree, click on the required folder.

 3. Click the Display Media  button. This opens and plays the media in a new window.

Viewing Media

Managing Folders
Adding a Sub-Folder
How to add a sub-folder (child folder) to the selected folder in the Document Library module. Note: The parent folder must first be created 
by an Administrator. See "Creating a Library from Scratch (Adding a Parent Folder)" or "Importing a Library".

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. Right-click on the required folder and select  Add Sub-Folder.



 3. Configure the General and Security tab settings. See "Configuring General Settings for Folders" and See "Configuring Security 
Settings for Folders". Note: Security tab is only visible to authorized users.

 4. Click the Update link. This displays the new folder  in the navigation tree.

Adding a Sub-Folder

Editing Folder Settings
How to edit folder setting such as folder name, parent folder and security on the Document Library module.  Note: The available options 
are controlled by user permissions. E.g. If a user has edit rights but no security rights, the “Security” tab is not displayed.



 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. Right-click on the required folder and select  Edit Folder Settings from the drop-down menu.

 3. Configure the General and Security tab settings. See "Configuring General Settings for Folders" and See "Configuring Security 
Settings for Folders".

 4. Click the Update link.

Tip: The parent folder of a specific folder can be also changed through drag & drop utility. Just select the folder you want to move, click 
the left button and drag the folder to the chosen parent folder.

Deleting a Folder
How to delete a folder in the Document Library module. This deletes the folder from both the database as well as the file system.

 1. Click the Folder  icon in the toolbar. This displays the Folder navigation tree.

 2. Right-click on the required folder and select  Delete Folder from the drop-down menu. This displays the folder details in the 
Delete Folder section.

 3. Click the Delete link. This displays the message "Are you sure you want to delete this Folder and all of its Documents and Sub-
Folders?"

 4. Click the OK button to confirm.



Deleting a Folder from the Document Library Module

Configuring General Settings for Folders
How to configure the General settings for folders in the Document Library module. This topic  assumes you are currently adding or editing 
a folder. 

"Editing Category Settings".

 1. At Folder Name, enter or edit the name for this folder.

 2. Optional. At Parent Folder, select the parent folder for the current folder. Note: This setting is disabled for the parent folder.

 3. In the  URL Access section, set the follow attributes to determine if and how a folder can be accessed directly through a URL or 
though settings specifications:

 4. At Direct Access Only select from these options:

 l Check  the check box to set this folder as hidden from general view, unless accessed directly through the 'Direct URL' 
(as set below) or through setting the value of 'Restrict List to 1 Folder' in the module settings. If the folder marked for direct 
view contains sub-folders, all sub-folders will also be visible, unless those sub-folders have also been marked for direct 
view as well.

 i. At Direct Access Key, enter a unique key which will be required in order to access this "Direct Access Only” 
folder.  If you do add a key, and you access the folder through the 'Direct URL' method, then you'll need to place 
both the xsfid parameter as well as a new key parameter in the URL. If you access the folder through the 'Restrict 
List to 1 Folder' method, then you'll need to place only the new key parameter in the URL. [url format: 
xsfid=id&xsfk=key]

 ii. At Direct URL the direct URL for this folder is displayed. If linking to this page through an external link, and you 
only want to show the contents of this specific folder (and all of its sub-folders), this is the parameter to be added to 
the URL. Adding this parameter to the URL will achieve the same results as setting the value of 'Restrict List to 1 
Folder' in the module settings.

 l Uncheck  the check box to enable access to all authorized users using the Navigation tree.



The General tab for Folder Settings

Configuring Security Settings for Folders
How to configure the Security settings for folders in the Document Library module. This topic  assumes you are currently adding or editing 
a folder. See "Creating a Library from Scratch (Adding a Parent Folder)", "Adding a Sub-Folder"., or "Editing Folder Settings"..

The following options are available on the Security tab:

 1. Optional. At Inherit Security, check  the check box to set this folder to inherit security permissions from its parent folder.

 2. Permissions related to Folders are:

 l View: Allows users to view the folder in the navigation tree.  This right only allows view access to the folder and doc-
uments.

 l Add: Allows users to add sub-folders to the folder.                     

 l Edit: Allows users to edit the folder.

 l Delete: Allows users to delete the folder.

 l Enable Track: Allows users to track this folder.

 l Enable Moderate: Allows users to access the Moderate section under tools where they can moderate and approve doc-
uments uploaded to the folder.

 l Edit Security: Allows users to view the Security Tab when editing a folder and thereby assign security rights to the various 
roles.

 3. Permissions related to Documents are those permissions that apply to all documents in the folder.

 l Add: Allows users to add new files to this folder. Note: If this option is selected, "Add Folder" permissions is automatically 
granted to enable zip folder structure uploads.

 l Edit: Allows users to edit the files in this folder.



 l Enable Track: Allows users to manage tracking of files in this folder. Note: Tracking must still be enabled on individual doc-
uments. See "Enabling Document Tracking"

The Security tab for Folder Settings

Setting User Security for  Folders
How to give specific users a specific set of access rights to the parent folder (root folder) of the Document Library module.  Note: This topic  
assumes you have already created the folder.      

 1. Right-click on the required folder and then select  Root Folder Settings (root folder only) or  Edit Folder Settings all other 
folders.



 2. Select the Security tab.

 3. At User Security, click on the User  button. This opens a window where you can view a list of the existing users.

 4. Use the A-Z links above the grid to filter  users by the first letter of their username.

 5. To select a user, click the Select User  button to the right of their name. This displays their username in the User Security text 
box.

 6. Click the Add  button. This adds their name to the User Security section and creates a full list of security options that you can 
select from.

 7. Repeat Steps 3-6 to add additional usernames.



 8. Select one or more permissions for each user.  See "Configuring Security Settings for Folders".

 9. Click the Update link.

Moderation
Moderating Uploaded Files
How to moderate files uploaded using the Document Library module.

 1. On the Document Library module toolbar, navigate to  Tools >  Moderate and then select  Moderate All Items to view 
all files in the moderation queue - OR - Select  My Items to see only files you have submitted which are awaiting moderation.

 2. Optional. In the Filter Options section, apply one or more filters. See "Moderation Filter Options"



 3. Click the Review  button beside the required file. This opens the Edit Document section.

 4. Optional. Edit one or more document fields and then click the Update link.

 5. Select one or these options:

 l Revise: Select to set the file for revision. This notifies the owner requesting they revise the file and then re-submit it for 
approval. The file status is set as Revise and the file remains in the Moderation list.

 l Reject: Select to reject the file. This notifies the owner of the file that it has been rejected and cannot be re-submitted. The 
file status is set as Rejected  and it remains in the Moderation list.

 l Accept: Select to accept the file. This notifies the owner of the file that it has been accepted. This file is published and 
removed from the Moderation list.

Deleting Unmoderated Files
How to permanently delete one or more files from the moderation queue of the Document Library module.

 1. On the toolbar, navigate to  Tools >  Moderate and then select  Moderate All Items to view all items in the moderation 
queue - OR - Select  My Items to see only items you have submitted which are awaiting moderation.

 2. Optional. In the Filter Options section, apply one or more filters. See "Moderation Filter Options"

 3. Optional. Click the Download  button beside the required file to download and view the file.

 4. Optional. Click the Review  button beside the required file to notify the owner that the file has been rejected.

 a. Click the Reject link. This notifies the owner of the file that it has been rejected and cannot be re-submitted. The file is 
status is set as Rejected however the file remains in the moderation queue.



 5. Click the Delete  button beside the file to be deleted. This display the message "Are you sure you want to delete this item per-
manently?"

 6. Click the OK button.

 7. Repeat Steps 2-6 to delete additional files.



Deleting Unmoderated Files

Moderation Filter Options
How to filter files in the moderation queue by one or more criteria on the Document Library module. This topic  assumes you are currently 
performing a moderation task.

 1. In the Filter Options section, apply one or more filters from these options:

 a. At Status, select one of the following from the drop-down box:

 l - Status -: Select to view items of all status. E.g. Submitted, Revised and Rejected.

 l Submitted: Select to view all submitted items that are yet to be moderated.

 l Revise: Select to view all revised items.

 l Rejected: Select to view all rejected items.

 b. At User Name, click on the  User  button to select a single user's items to view. This opens the User Picker window 
where you can view a list of the existing users.

 i. Use the A-Z links across the top to filter  users by the first letter of their username.

 ii. To select a user, click the Select User  button to the right of their name. This displays their username in the User 
Name text box.

 c. At Start Date, click the Calendar  button and select the first date items were submitted on. See "Working with the Cal-
endar"

 d. At End Date, click the Calendar  button and select the last date items were submitted on. See "Working with the Cal-
endar"

 e. Click the View Items link to view items matching the selected filters.



Moderation Queue Filter Options

Settings
Configuring Local Settings - Document Grid
How to configure local settings for the document grid on the Document Library module. Here you can control what  document information 
is displayed as well as the default sort field and direction. Except for Document Name, which is a required field, you can opt to show or 
hide all other fields. Options selected here only apply to this specific instance of the module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Open-Document Library Settings tab.

 3. On the Local tab, go to the Document Grid Options section.

 4. At Display Navigation, select from these options:

 l Check  the check box to display the paging and info navigation bar above and below files in the grid. This is the default 
option.



 l Uncheck  the check box to  remove navigation bar and display all items in the list  at once.

 5. At Items Per Page, select the number of items to be displayed in the grid at once. Available options are: 10, 25, 50, or 100. The 
default setting is 10.

 6. At Layout, select  the layout to be applied to the document grid. The below images show each layout with all available fields dis-
played.

 l Multiple Columns [Default]: 



 l Compact: Displayed here with all fields displayed.

 l Multimedia: Displays a large Play icon.



 l Thumbnails: Displays a large Play icon.

 7. In the Name - Display Length text box, enter the maximum number of characters for document name field (including spaces). E.g. 
If a maximum of 10 is entered and the document name exceeds the display length, then the name will display as "Document N..."

 8. At the follow fields, check  the Display check box to display the document field in the grid - OR - Uncheck  to hide the field:

 a. Description: Select to view the description field of the document in the Document grid. 

 b. Size: Select to view the size field of the document in the Document grid.

 c. Uploaded: Select to view the date and Display Name of the user that uploaded the document in the Document Grid.

 d. Modified: Select to view the date and Display Name of the user that modified the metadata of the document, in the Doc-
ument Grid.

 9. In the Default Sort - Ascending column, select the default field documents are sorted by when displayed in ascending order.

 10. In the Default Sort - Descending column, select the default field documents are sorted by when displayed in descending order.

 11. Click the  Update link.



Configuring Document Grid Options for the Open-Document Library Module

Configuring Local Settings - Navigation Tree
How to configure local settings for the Document Library module. This section allows you to control the way users can navigate through 
the document hierarchies. Options selected here only apply to this specific instance of the module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Open-Document Library Settings tab.

 3. On the Local tab, go to the Navigation Tree Options section and set any of the following optional settings.

 4. At Default Tree Mode, set the default view of the navigation tree as either  Folders (the default setting) or Categories.

 5. At Allow Tree Mode Toggle, select from these options:

 l Check  the check box to display both the  Folder  or  Category icons in the toolbar. This enables users to view 
the navigation tree organized either by folders or categories and access both the Folder and Category drop-down menus.



 l Uncheck  the check box to disallow toggling. This removes both the Folder  or  Category icons from the toolbar. 
The navigation tree displays either Folders or Categories, as selected at Default Tree Mode. Important. If the Default Tree 
Mode is set the Categories, users cannot add documents because they cannot access the drop-down menu. Note: Admin-
istrators will continue to see the toggle options for administrative purposes. A  No Toggle message is also displayed to 
Administrators.

 6. At Restrict Tree to 1 Folder, select a folder to restrict this instance of the module to display only that folder. Users can navigate to 
sub-folders and documents belonging to the selected folder. The below image displays the tree restricted to the Instruction Man-
uals folder. Note: A  Restricted message is displayed to Administrators. 

 7. At Restrict Tree to 1 Category select a category name from the drop-down box to restrict this instance of the module to that cat-
egory. Users can navigate to subcategories and documents belonging to the selected category. The below image displays the 



tree restricted to the Indoor Play category.  Note: A  Restricted message is displayed to Administrators.

 8. At Tree Style, select the style for the navigation tree from these options:

 l Plus-Minus Signs (Default)



 l Up-Down Arrows

 9. At Hide Tree [Flat View], select from these options:

 l Check  the check box hide the navigation tree. This displays all the documents within the selected folder ( as selected at 
"Restrict Tree to 1 Folder" ) or category (as selected at "Restrict Tree to 1 Category" ), including documents within the sub-
folders/sub-categories. Important. Tree must be restricted by folder or category to use this setting. Note: Administrators con-
tinue to see the navigation tree for administrative purposes.

 l Uncheck  the check box to display the navigation tree. 

 10. Allow Tree Horizontal Scroll select from these options:

 l Check  the check box to  prevent the tree from growing in width. This displays a scroll bar below the tree enabling users 
to scroll to the right or left, in order to see the folders.



 l Uncheck  the check box to enable the navigation tree grows in size (horizontally and vertically) according to the number 
of folders that are open at any one time. This is the default option.

 11. Click the  Update link.

Configuring Local Setting for the Document Library Module

Configuring Global Settings
How to configure global settings for the Document Library module. Note: All settings on the Global tab apply to all instances of the mod-
ule in the given portal.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Open-Document Library Settings tab.

 3. Click on the Global tab.



 4. In the File System Options section update any of the following settings:

 a. At Synchronize, click on the Synchronize the Database and the File System  button to perform synchronization. Syn-
chronization adds folders/documents that were added directly to the file system to the database and removes fold-
ers/documents from the database that were removed from the file system manually. The process is asynchronous.

 b. Click the Display The Last Synchronization Log  button review the results in the Synchronization Log. 

 c. At Root Folder,                  See "Importing a Library", which details how to select a new root folder in which to store the folders and 
documents in the physical drive. When a folder is selected from the list, the Database and the File System are auto-
matically synchronized [see File System Options/Synchronize]. You will have the option to use the default DNN home 
directory/subdirectory by selecting the “Portal” option, or to simply choose any folder either local or in a UNC share.  If you 
do choose a folder that is not under the Portal option, then you should make sure that the ASP.NET user or Network Serv-
ices user has the appropriate access rights to the folder (read/write/modify). 

 d. At Secure Files, select from these options:

 l Check  the check box to protect your documents from direct download by renaming them to a type of extension 
that is not directly served by a Web Server [xsdl.resx]. As a result, the only possible way to access the document 
will be through the document library interface.

 l Uncheck  the check box to allow documents to be downloaded directly from a Web browser or to be referenced 
by links as long as they are in a virtual directory or under the DNN Home Directory.  In a UNC share or local folder 
that does not have any of the above prerequisites, direct access will not be possible.

 e. At Huge Uploads,  select from these options:

 l Check  the check box to allow uploads up to 2 Gigabytes. Notice that the  web.config will be automatically mod-
ified (a backup of the actual configuration  file will be created on the same folder). And also, a folder will be created 
in  the root folder of the application.
Note 1: Full trust must be enabled for this setting to work. I.e. A shared server cannot be used.
Note 2: In web.config increase execution timeout. E.g. 3600
Important. Huge uploads must be uncheck before uninstalling this module.

 l Uncheck  the check box to disallow large uploads. Changes to  the web.config and the folder in the root folder 
will be eliminated.

 f. At Enable WebDav,  select from these options:

 l Check  the check box to display an alternative 'open on server' button in the documents grid, next to the 'down-
load\' button. Clicking on the 'open on server' button will open the document in its client environment (MS Word or 
MS Excel).
Note 1: The folder must be a WebDav folder [you will need to configure the server]. To check if the current root 
folder is correctly setup as a WebDav folder, click the Check If WebDav Is Enabled On The Server  button.
Note 2: If WebDav is not correctly setup on the server, and this option is selected, the document will still open in its 
corresponding application, but the [save] and [save as] options will only save the document in a local [to your PC] 
folder.  
Note 3: You must enable ActiveX controls to run on your client PC, by changing the corresponding Zone Security 
Options.

 l Uncheck  the check box to disable WebDav.



 5. In the Document Options section, update any of the following settings:

 a. At Allowed Extensions you can limit the types of files that can be uploaded to Document Library modules in this portal. 
This will override the site wide settings set by the Host. If there is no extension specified, all extensions will be allowed.

 l To Add An Extension: Enter a file extension and then click the Add  button. E.g. .doc

 l To Remove An Extension: Select the file extension and then click the Delete  button.

 b. At Confirm Download [pop-up], Check  the check box to show a pop-up window with additional information before a 
download is started - OR - Uncheck  the check box to set the download to start directly.

 c. At Media Content, set the following:

 i. At Display Media, check  the check box to display a Play  button for media files (audio, images and video) - 
OR - Uncheck  the check box to disable.

 ii. At Box Size, select the size of the box that displays the media content of the documents.

 d. At Versioning, set the following: 

 i. At Versioning  Enabled, select from these options:

 l Check  the check box to enable versioning. Versioning allows you to save a specified number of copies 
of the documents you upload. Every time you re-upload a new version of the same document, the previous 
version is saved and can be restored on demand.  Note: You can also save a version of your document any 
time you want to, by editing the document, and clicking on the Add Version button.

 i. In the Versioning Max Number text box, enter the maximum number of versions which can be 
saved for each document.

 l Uncheck  the check box to disable.

 e. At Search - DNN Search Enabled, select from these options:

 l Check  the check box to enable the documents to be included in the default DNN Search. The searchable  fields 
are the Name and the Description of the document. Note: The default DNN Search does not index document con-
tent. Also, it does not  implement any kind of security. Therefore, unauthorized users may see  descriptions for doc-



uments they may not have access to. Such documents will  still be download protected.

 l Uncheck  the check box to disable.

 6. In the Statistics Options section update the following setting:

 a. In the Stats Log History [Days] text box, enter the number of days that folder, category and document statistics infor-
mation will be kept for.

 7. In the Module Options section update the following setting:

 a. At Style,   select a style to change the look of the module. Note: Once the style has been changed, you may need to hard 
refresh your Web browser a couple of times [Ctrl + F5] in order to replace the cached version of the style with the new one.

 8. Click the  Update link.

Open-Document Module Styles
A pictorial overview of the styles available for the Document Library module.

Tip: All styles can be changed through the module.css style sheet found in the module’s specific directories.

See "Configuring Global Settings"

Default Style:



White:

Gray:



White Web 2.0:

Gray Web 2.0:



Documents
About the Documents Module
The Documents module displays a list of documents which can optionally be set as downloadable. All document records Title and a link 
to view (depending on a user's file associations) or download the document. Link tracking and logging are also available.

Module Version: 05.00.00

Minimum DNN Version: 05.01.00

Features: ISearchable

The follow data can be added for each document record and can be optionally displayed:

 l Title: The title given to the document. This is the only mandatory field. 

 l Description: The description of the document 

 l Category: The category name given to the document. This field can be optionally managed by a drop-down category list 
created by the Host. 

 l Owner: The Display Name of the document owner. By default this is the name of the user who added the document however 
any user can be selected.

The follow data is automatically recorded for each document and can be optionally displayed:

 l Modified Date: The date when the document record was last modified 

 l Size (Kb): The file size of portal documents. Note: The size of documents located on external resources (E.g. other web sites) is 
not displayed. 

 l Download: A link to download the document 

 l Created By: The name of the person who first created the document record 

 l Created Date: The date when the document record was created 



 l Modified By: The name of the person who last modified the document record 

 l Clicks: The number of times the document record has been clicked

Additional Settings:

 l Use a drop-down categories list

 l Set the document title to function as a link to download the document 

 l Set the visibility and order of each field 

 l Set the sort order of documents

The Documents Module (default settings) 

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleDocuments/tabid/826/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/18/scope/threads/Default.aspx

 l Issue Tracker: http://dnndocuments.codeplex.com/workitem/list/basic

All Users
Viewing a Document
How to view a document listed in the Documents module. Note: The Title column must be visible and the Title Link enabled to perform 
this task.

 1. In the Title column, click on the linked document title. 

http://www.dotnetnuke.com/Products/Development/Forge/ModuleDocuments/tabid/826/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/18/scope/threads/Default.aspx
http://dnndocuments.codeplex.com/workitem/list/basic


 2. The document is now viewable in either the current Web browser, a  new Web browser, or it may be available for download. This 
will depend on your Web browser settings.

Related Topics:

 l See "Setting the Visibility of Document Columns"

 l See "Enabling/Disabling the Title Link"

Downloading a Document
How to download a document from the Documents module to your computer. Note: The Download column must be visible to perform this 
task.

 1. Click the Download link located beside the required document.

 2. Open or save the document to your computer as desired.

Module Editors
Adding a Document
How to add a document record to the Documents module.  Note: As the size of external documents is not known by the portal, Unknown 
is displayed for this field. 

Note 1. The Sort Index setting is overridden by automatic sorting. See "Adding Document Sorting by Column Name"

 1. Select Add New Document from the module actions menu - OR - Click the  Add New Document link. This opens the Edit 
Documents page.

 2. In the Title text box, enter a title for the document. Note: This is the only field required by this page, however you should also set 
the Link field. If you update this document now without setting the Link, then the file listed in the File Name  field is used. 



 3. Optional. In the Description text box, enter a description of the document.

 4. Optional. At Category, enter or select a category for the document. 

 5. Optional. At Owner, select from these options:

 l Click the Change Owner link and select a different user to be listed as the owner of this document

 l Select None Specified to leave the owner field blank. 

 6. Recommended. At Link, set the link to this document ( See "Setting a URL Link" or "Setting a File Link". ) - OR - Select None for 
no link. Tip: The default folder for files can be modified. See "Setting the Default Folder for Documents"

 a. Recommended. At Track Number Of Times This Link Is Clicked? check  the  check box to track clicking. If this field 
is unchecked, the number of the  clicks will not recorded. If the clicks are recorded, you have the option of displaying this 
information in the optional Clicks column. See "Setting the Visibility of Document Columns"

 7. Optional. In the Sort Index text box, enter a number to set the order of this document. Leave blank to use zero (0) and display 
documents alphabetically. 

 8. Click the  Update link.



The Newly Added Document

Editing a Document
How to edit the details of document or the file associated with a document record on the Documents module.

 1. Click the Edit  button located to the left of the document record to be edited.

 2. Edit the document fields as required.

 3. Click the Update link.

Changing the Document Owner
How to change the name of the document owner or leave the owner field blank on the Documents module.

 1. Click the Edit  button located to the left of the document to be modified. 

 2. At Owner, click the Change Owner link.

 3. Select from these options:

 l Select the new owner from the drop-down box.

 l Select None Specified to leave the owner name blank for this record.



 4. Click the Update link.

Deleting a Document
How to permanently delete a document from the Documents module.

 1. Click the Edit  button located to the left of the document to be deleted. This opens the Edit Documents page.

 2. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 



 3. Click the OK button to confirm deletion.

Troubleshooting: Security Permissions Warning
The following security permissions warning may be displayed when you attempt to add or edit a document using the Documents module: 

 "Warning: The security permissions for the selected file do not match this module's configured view roles. The module is con-
figured to allow viewing by role 'All Users', but the file does not. For users who are not members of a role that can view the file, this doc-
ument row will not be displayed. You can adjust security settings using the File Manager in the admin menu."

Here are the options to fix this problem:

Option One: Using the Selected File



If you use the file you have already selected, the document will only display to users with the correct permissions to browse or view the 
file.

 1. If you are editing a document, click the Update link. This link isn't displayed when adding a document.

 2. Click the Update Anyway link.

Note 1: The warning message continues to display on the Edit Documents page.

Note 2: You will no longer need to confirm Update Anyway for this document.

Option Two: Modifying the File Location

How to allow all roles authorized to view the module to access the document. This topic  assumes you are currently located on the Edit 
Documents page and are adding or editing the required document. 

Important. You must have permission to  upload files to the folder where you will be uploading the file. To update permissions, See 
"Assigning Folder Permissions by Role"or "Assigning Folder Permissions to a User".



 1. At Link, select a new File Location which is accessible to all users which are authorized to view this module. The Warning mes-
sage is now removed.

 2. Upload the file to the selected folder. See "Uploading and Linking to a File"

 3. The uploaded file should now be displayed. If not, select the file.

 4. Click the Update link.

Troubleshooting: The File Been Deleted
The following warning message may display at the top of the Edit Documents page when you begin to edit a document in the Documents 
module:  "The file that was selected for  this document has been deleted."

To fix this problem either select an existing file, or upload and select a new file.

If you don't update the document link, a  Server Error message (The resource cannot be found. HTTP 404) is displayed to users when 
they attempt to view or download the deleted document.



Settings
Enabling/Disabling the Categories List
How to enable or disable the categories list on the Documents module. Selecting this option displays a drop-down list beside the Cat-
egory field on the Edit Documents page. Categories are disabled by default. Important: Categories can only be created and maintained 
by SuperUsers therefore you should organize with your host to create the required categories prior to enablingthem.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 

 3. At Use Categories List?, check  the check box to enable the categories list - OR - Uncheck  the check box disable it.

 4. At Categories List Name, select the category list name from the drop-down list. E.g. Documents 

 5. Click the Update link.

Setting the Default Folder for Documents
How to set the default folder for documents being added to the Documents module. This setting pre-populates the Link - File Location 
field on the Edit Documents page with the selected folder.  This setting does not restrict users selecting other folders. 

Permissions. The default folder must have the correct Folder Security Settings granted in the File Manager. See "Overview of Folder 
Security Settings"

In DNN Community Edition, users who can view the module must be granted 'Open Files in Folder' permission to the folder. Module 
Editors can be granted either  'Open Files in Folder', 'Browse Files in Folder' or 'Write To Folder' permissions depending on your require-
ments.

In DNN Professional Edition, users who can view the module must be granted 'View' permission to the folder. Module Editors can be 
granted either 'Browse Folder', 'View' or 'Add' permissions depending on your requirements.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 

 3. At Default Folder, select a folder name from the drop-down list. E.g. Documents. The default option is typically the Root folder.



 4. Click the Update link.

Enabling/Disabling the Title Link
How to enable or disable the document title to function as a download link to the associated document for the Documents module. This 
setting is enabled by default. Important. Documents cannot be downloaded if the 'Show Title Link' field is disabled and the 'Download 
Link' is  not Visible. In this scenario, the document titles and visible columns are displayed as static text to all users who can view the mod-
ule.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 

 3. At Show Title Link?, select from these options:

 l Check  the check box to set the title as a link.

 l Uncheck  the check box to disable the link.

 4. Recommended. At Display Columns - Download Links, check  the Visible check box to display download links.

 5. Click the Update link.



Title Link disabled and the alternative Download Link enabled

Setting the Visibility of Document Columns
How to set which columns of document information are displayed in the Documents module. The Title, Owner, Category, Modified Date, 
Size (Kb) and Download Link columns are visible by default. 

Important. Documents cannot be downloaded if the 'Show Title Link' field is disabled and the 'Download Link' is  hidden.  In this scenario, 
the document titles and visible columns are displayed as static text to all users who can view the module.

Note: The Clicks column only displays the number of clicks for documents which have link tracking enabled. I.e. The "Track Number Of 
Times This Link Is Clicked?" field is checked.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 

 3. At Display Columns, check  the Visible check box to set a column as visible  - OR - Uncheck  the check box to set a column 
as not visible.



 4. Click the Update link.

Documents Module with Visible Columns Modified

Setting the Order of Document Columns
How to set the order of columns in the Documents module. 

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 



 3. At Display Columns, perform the following as required:

 a. Click the Up  button to move a column one position up (i.e. one position to the left on the module)

 b. Click the Down  button to move a column one position down (i.e. one position to the right on the module). 

 4. Click the Update link.

A Documents Module with Re-ordered Columns

Enabling Manual Document Sorting
How to enable module editors to manually set the sorting of documents displayed in the Documents module. This displays the Sort Index 
text box on the Edit Documents page where Module Editors can enter a number to order each document.

Tip: Manual Sorting is the default setting for new modules.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 



 3. At Sorting, select Sort Index from the left drop-down box. This may be pre-selected for you.

 4. Click the Add Sort Order link.

 5. This displays a new row of headings and the Delete Sort Order link.

 6. If any other sorting orders are displayed, click the Delete Sort Order link beside each one to delete them. This may occur if sort-
ing has been previously set.

 7.  Click the Update link.



The Sort Index field displayed on the Edit Documents page

Adding Document Sorting by Column Name
How to  set cascading sorting of documents  for this instance of the Documents module. This setting overrides the Sort Order field on the 
Edit Documents page.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab. 

 3. At         Sorting, if Sort Index sorting option is displayed, click the Delete Sort Order link.



 4. At Sorting, select the first column name to sort documents by from the left drop-down box. E.g. Title

 5. Optional. At Sorting, select to display documents in either Ascending ( alpha-numerical 1,2,3,a,b,c... ) or Descending ( alpha-
numerical z,y,x,9,8,7... ) order using the right drop-down box. The default option is Ascending.

 6. Click the Add Sort Order link. The sort order is now listed below.

 7. Optional. Repeat Steps 4-6 to add additional columns to this sort order.

 8. Click the Update link.

Tip: You can click the Delete Sort Order link beside any column name to delete it from sorting order.

Enabling/Disabling Users to Sort Documents
How to enable or disable document sorting by users on the Documents module. If this setting is enabled, the column names become 
links which enables users to sort documents in ascending or descending order by any column title.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Documents Module Settings tab.

 3. At Allow Users To Sort?, check  the check box to enable user sorting - OR - Uncheck  the check box to disable it. 

 4. Click the Update link.

The Documents Module with User Sorting Enabled

Administrators
Formatting the Documents Module
The documents module contains CLASS elements to allow you to use cascading style sheets (CSS) to control the display of the Doc-
uments module. The documents module renders an "outside" DIV tag with a CLASS attribute of "DNN_Documents". Each header cell has 



a CLASS attribute of [Name]Header, where [Name] is the column name - for example "TitleHeader", "SizeHeader", "CategoryHeader".  
Each data cell has a CLASS attribute of [Name]Item, for example "TitleItem", "SizeItem", "CategoryItem". This allows skin developers to 
control the CSS style of individual columns. For example, use the following CSS to render the size column in red and set the column 
width to 50 pixels:

  .DNN_Documents .SizeItem {color: red; width: 50px} 

"Default" class names are assigned for the DataGrid - CssClass="Normal" and HeaderStyle-CssClass="SubHead" so that if no additional 
CSS elements are defined, the module renders using the same CSS styles as in previous versions.

Events
About the Events Module
The Events module displays a list of upcoming events. Events can be displayed in chronological order as list or in a monthly or weekly 
calendar. Each event includes a title, start and end date/time, a description and an optional image. Events can be set to automatically 
expire on a particular date, or to recur by any specified number of days, weeks, months or years. Event moderation is also provided.

Event notification and enrolments can be enabled.

Module Version: 05.01.05

Minimum DNN Version: 05.02.00

Features: ISearchable



The Events Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleEvents/tabid/833/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/20/scope/threads/Default.aspx

 l Issue Tracker: http://dnnevents.codeplex.com/workitem/list/basic

Configuration
Configuring the Events Module
How to quickly configure the Events module. This topic shows how to configure the Events module by only setting Edit Time Interval field 
and then accepting all of the default settings. 

Important: This setting must be set before any events are added. If one or more events exist in the module you will be unable to edit this 
field.

http://www.dotnetnuke.com/Products/Development/Forge/ModuleEvents/tabid/833/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/20/scope/threads/Default.aspx
http://dnnevents.codeplex.com/workitem/list/basic


 1. Select  Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Go to the General Settings section.

 3. At Edit Time Interval, select the time interval in minutes at which events can be scheduled. E.g. Select 15 to set 15 minute inter-
vals. This will enable events to be scheduled at 10:00 AM, 10:15 AM, 10:30 AM, 10:45 AM, etc. The default setting is 30.

 4. Click the  Update Settings link.

All Users
Changing the Event View
How to change the way events are displayed in the Events module.

Important. If the Icon Bar has been disabled, unauthenticated are unable to change the view as access to the module actions menu is 
restricted to authenticated users only.

Note: The design and fields for views displayed in the below images will vary depending on settings.

 1. Select one of the following options from either the module actions menu or the Event module Icon Bar:

 l  Month View: Displays events in a monthly calendar. By default the current date is highlighted. Links to the previous 
month and the next month enable you view other months.



 l  Week View: Displays events for the current week. Click the double arrow links ( << and  >> ) located to scroll back and 
forward one week at a time.



 l  List View: Displays events in a list.

Navigating to Events (Month View)
How to navigate to events when they are displayed in the monthly calendar view. Note: Some options may not be available.

 1. Click the Month View  button and choose from these options:

 l To view another month: Click the linked name of the [Previous Month] or the [Next Month] ( displayed in the top left and top 
right corners of the Calendar respectively ) to scroll back and forward one month at a time.

 l To return to the current month: Click the Today link. The current date is highlighted.

 l To view any month: Click the View Date link and select a date from the calendar - OR - Enter the date into the text box and 
then click the Go button.

 l To view events for a single category: At Categories, select a category name from the drop-down box.



Navigating to Events in Month View

Navigating to Events (Week View)
How to navigate to an event when they are displayed in week view.

 1. Click the Week View  button and choose from these options:

 l To go to the previous or next week: Click on the Previous << or Next >> links.

 l To return to the current week: Click the Today link. The current date is highlighted.

 l To view any week: Click the View Date link and select a date from the calendar - OR - Enter the date into the text box and 
then click the Go button.

 l To view events for a single category: At Categories, select a category name from the drop-down box.

Navigating Events in Week View

Viewing Event Details (List View)
How to view the full details of an event when events are displayed in a list.

Tip: Event details may be displayed when you position your mouse over the event title.



 1. Click the List View  button.

 2. Click on the [Title] link to view event details in full. 

 3. Click the Return link to return to the list.

Viewing Event Details in List View

Viewing Event Details (Month View)
How to view the full details of an event when events are displayed in a monthly calendar.

Tip: Event details may be displayed when you position your mouse over the event title.

 1. Click the Month View  button and navigate to the required date.

 l If event titles are displayed in calendar cells: Click the linked [Event Title].

 l If event titles are not displayed in calendar cells: Mouse over the date in the date cell and click on the date.

 2. Click the Return link to return to the previous page.



Viewing Event Details in Month View

Viewing Event Details (Week View)
How to view the full details of an event when events are displayed in a weekly list. The event details page provides access to other 
options such as event enrollment.

Tip: Event details may be displayed when you hover your mouse over the event title.

 1. Click the Week View  button and navigate to the event. 

 2. Click the [Event Title] link.

 3. Click the Return link to return to the previous page.

Viewing Event Details in Week View



Exporting an Event to your Desktop
How to export an event to your computer and save it to your Microsoft Outlook calendar.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month View)". 
or "Viewing Event Details (Week View)".

 2. At Export Event to Desktop Event, select from these options:

 l Click the Single link to export a single instance of this event.

 l Click the Series link to export the full series of a recurring event. This option is only displayed for recurring events.

 3. Perform one of these actions:

 l To save the file to your computer, click the Save button and then save the file to your preferred location.

 l To save the event to your Outlook calendar, click the Open button and then click Save and Close.

Requesting Event Reminder
How to request notification of an event on the Events module. Note: Reminders may not be available on some or all events. 

Tip: Events which allow notifications typically display the  Reminder icon.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month View)". 
or "Viewing Event Details (Week View)".

 2. In the  Remind me about this Event @ text box, complete the following:

 l Enter  your email address. If you are logged in, your email address is automatically displayed.

 l Set the number of Minute(s), Day(s), or Hour(s) Before Event Starts that you want to be notified.



 3. Optional. At Remind about all Events  in this series? check  the check box to be reminded of all events in this series - OR - 
Uncheck  the check box if you only want to be notified of this instance of this event. This option is only displayed for recurring 
event.

 4. Click the  Remind me about this Event @ link. This displays the message "Are You Sure You Want To Be Reminded?"

 5. Click the OK button to confirm. 

 6. This display a message detailing when you will be notified. E.g. "You will be reminder about this event on [selected date and 
time]" 

 

Related Topics:

 l See "Enabling/Disabling and Configuring an Event Reminder"

Subscribing to New Event Notifications
How to subscribe to receive notifications when a new event is added to the Events module. Note: This option may not be available.



 1. At Notify Me select from the following options:

 l Check  the check box to subscribe to notifications.

 l Uncheck  the check box to unsubscribe  from notifications.

Notification of new events enabled

Related Topics:

 l See "Configuring the Event Email Settings"

Viewing Enrolled Users
How to view details of users who are enrolled to an event on the Events module. Note: This option may not be available to all users.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month View)". 
or "Viewing Event Details (Week View)".

 2. At Enrolled Users, the Display Name of enrolled users and the quantity of attendees enrolled against this person is displayed in 
a table. The Display Name is a link to the enrollee's user profile.



A more detailed table is displayed to Administrators which displays the enrollee's email address, and whether the enrollment is 
approved.

Viewing Enrolled Users as an Administrator

Enrolling for a Free Event
How to enroll to attend a free event using the Events module.

Tip: Events which allow enrollment may display the  Enroll icon.



 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month 
View)". or "Viewing Event Details (Week View)".

 2. Click the  Enroll for this Event? link. This displays the message "Are You Sure You Want To Enroll?"  

 3. Click the OK button.

One of the following messages is now displayed advising of your enrollment status:

 n  You are enrolled for this event, but not yet approved! If this message is displayed, you will be typically be informed by 
email once your enrollment is approved. Once it is approved the below message is displayed. 

 n  You are enrolled and approved for this event!



Completed Event Enrollment

Enrolling for a Paid Event
How to enroll for a paid event using the Events module.

Tip: Events which allow enrollment may display the  Enroll  icon.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month 
View)". or "Viewing Event Details (Week View)".

 2. Click the  Enroll for the Event? link. This displays the message "Are You Sure You Want To Enroll?" 

 3. Click the OK button.



 4. On the Paypal Event Enrollment page, review the event information and then click the Purchase link. This takes you to the Pay-
Pal web site.

 5. Complete the secure payment process. You will then be returned to the web site.

One of the following messages is now displayed advising of your enrollment status:

 n  You are enrolled for this event, but not yet approved! If this message is displayed, you will be typically be informed by email 
once your enrollment is approved. Once it is approved the below message is displayed. 

 n  You are enrolled and approved for this event!

Viewing Your Event Enrollments
How to view details your event enrollments using the Events module.



 1. Select  My Enrollments from the module actions menu - OR - Click the My Enrollments  button in the Event module icon 
bar ( if displayed ). 

The following details are displayed for each event you have enrolled for: 

 l Start: The start date and time of the event. 

 l End: The end date and time of the event. 

 l Event: The title of the event which links to more event details. 

 l Approved: Displays if your enrollment has been approved ( checked  ) or is unapproved ( unchecked  ). 

 l Amount: Displays the amount ( if any ) that has been paid to attend the event.

 l Quantity: The number of attendees you have enrolled for this event.

 l Total: Total amount for this enrolment. 

Viewing your Enrollments

Canceling an Event Enrollment
How to cancel an enrollment to an event using the Events module. Note: You cannot cancel from paid events.

 1. View your enrollments. See "Viewing Your Event Enrollments"

 2. In the Select column, check  the check box beside each enrollment you want to cancel.

 3. Click the  Cancel Selected Enrolments link. This displays the message "Are You Sure You Wish To Cancel the SELECTED 
Enrolments?"

 4. Click the OK button to confirm. The selected enrollments are now removed from the list.



Canceling an Event Enrollment

Module Editors
Adding an Event
How to add an event to the Events module. Newly added events are sorted in the order they are entered within date/time. This topic  cov-
ers the main settings. See related topics below for additional settings.

 1. Select  Add Event from the Events module actions menu - OR - Click the Add Event button at the top right corner of the mod-
ule. This opens the Edit Event page.

 2. Go to the Event Settings section.

 3. In the Title text box, enter a title for this event. Note: Although this is the only mandatory field, however you should also update the 
Notes field to remove/edit the default text. If you choose to create an event using the default settings, the event start date and end 
date will be the current date.  

 4. At All Day Event, select from these options:

 l Check  the check box if the event lasts all day. This removes the time fields from the next two fields. 

 l Uncheck  the check box if the event has a start and end time.

 5. At Start Date/Time, set the following:

 a. Click the Calendar  button and select the start date of the event. See "Working with the Calendar". 

 b. Click the Copy to End Date link. This updates the End Date/Time field so it displays the Start Date you selected.

 6. At End Date/Time, set the following:

 a. Click the Calendar  button and select the end date for the event. 

 b. If the time drop-down box is displayed, select the end time for the event.

 7. At Display End Date, select from these options;

 l Check  the check box to display the end date in all views.

 l Uncheck  the check box to hide the end date in all views. 

 8. Optional. At Importance, select Low, Normal or High from the drop-down box to set the importance of the event. The default set-
ting is Normal. 

 9. Optional. At Category, select the event category. No category is the default setting. See "Adding Event Categories".

 10. Optional. At Location, select the event location. No location is the default setting. See "Adding Event Locations".

 11. Optional. At Owner, select a new owner for this event.

 12. Optional. In the Notes Editor, enter any notes about the event.



 13. Click the  Update link. If the event requires moderation you will be notified when moderation has occurred and whether the event 
was accepted. Once moderated events are accepted they are displayed in the module.





Adding an Event

The New Event displayed in the Month View

Related Topics:

 l See "Enabling/Disabling and Configuring an Event Reminder"

 l See "Enabling/Disabling and Configuring an Event Image"

 l See "Enabling/Disabling and Configuring Recurring Events"

 l Allow Enrollment Section: See "Enabling/Disabling and Configuring Event Enrollment"

Editing an Event
How to edit an event in the Events module. Note: You may only be able to edit your own events.



 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month 
View)". or "Viewing Event Details (Week View)".

 2. Select from these options:

 l Click the  Edit link to edit one time events, on to edit only this instance of a recurring event. 

 l Click the  Edit Series link to edit all instances of a recurring event.

 3. Edit the event details as required.

 4. Optional. At Owner, select a new owner for this event.

 5. Click the  Update link.





Editing an Event

Copying an Existing Event as a New Event
How to copy an existing event and save it as a new event using the Events module.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month View)". 
or "Viewing Event Details (Week View)".

 2. Click the  Edit link.

 3. Edit the event details for the new event.

 4. Optional. At Owner, select a new owner for this event.

 5. Click the  Copy As New Event link. This displays the message "Have you set all the correct details for the new Event?"

 6. Click the OK button to confirm. If the event requires moderation you will be notified when moderation has occurred and whether 
the event was accepted. Once moderated events are accepted they are displayed in the module.





Enabling/Disabling and Configuring an Event Reminder
How to enable or disable a reminder email to be sent for an event on the Events module. Note: Event Reminders must be enabled. See 
"Configuring Event Reminder Settings"

 1. Commence adding a new event ( "Adding an Event". ) but don't click the Update link until completing the below steps - OR - Edit 
an existing event ( "Editing an Event".

 2. Go to the Send Reminder section below the Notes Editor.

 3. At Send Reminder, select from these options:

 l Check  the  check box to enable reminders. This displays the associated settings.

 a. In the Time Before Event text box, enter and select the number of Days, Minutes or Hours before the event start 
time to send the notification. 

 b. Optional. In the Email From text box, modify the email address to be displayed in the From field of in mes-
sage.Optional. 

 c. In the Email Subject text box, modify the email subject including any of the available replacement tokens.*

 d. Optional. In the Email Message text box, modify the email message including any of the available replacement 
tokens*.

 l Uncheck  the  check box to disable reminders. Note: This disables the reminder but any saved reminder settings are 
retained for future use.

 4. Click the  Update link.

* Replacement Tokens for the Email Subject and Email Message fields: 

 l [event:title] = Title

 l [event:startdate] = Start Date and Start Time

 l [event:timezone] = Time Zone

Enabling and Setting Event Reminders



Enabling/Disabling and Configuring an Event Image
How to show or hide an image for an event in the Events module. The image is typically displayed in both the event calendar/list and in 
the detailed event view.

Tip: See Manage Settings section for more on managing images.

 1. Commence adding a new event ( "Adding an Event". ) but don't click the Update link until completing the below steps - OR - Edit 
an existing event ( "Editing an Event".

 2. Go to the Display Image section below the Editor. 

 3. At Display Image, select from these options:

 l Check  the  check box to display an image for this event.

 a. At Image URL select or enter the link to the image.      See "About the Link Control".

 b. In the Width text box, enter the pixel width for this image - OR - Leave this field blank for the original image size. 

 c. Optional. In the Height text box, enter the pixel height for this image - OR - Leave this field blank for the original 
image size.

 l Uncheck  the check box for no image. Note: This removes the image from the event listing; however any saved image 
settings are retained for future use.

 4. Click the  Update link. If the event requires moderation you will be notified when moderation has occurred whether the event was 
accepted. Accepted events are displayed following moderation.



An Event with an Image

Enabling/Disabling and Configuring Recurring Events
How to enable or disable recurring events and configure the optional settings for the Events module. Note: Recurrences days are local-
ized.



 1. Commence adding a new event ( "Adding an Event". ) but don't click the Update link until completing the below steps - OR - Edit 
an existing event ( "Editing an Event".

 2. Go to the Recurring Event section. 

 3. At Recurring Event, select from these options:

 l Check  the  check box to set the event as recurring.

 a. At Recurrence End Date, click the Calendar  button and select the last date when the event will reoccur. See 
"Working with the Calendar". Note: Event Start Date must occur before the recurrence end date in order for the 
event to occur at least once

 b. Select and set one of the following reoccurrence schedules:

 l To set the event to reoccur periodically: 

 i. Select Periodic Event. 

 ii. At the Repeated every field, enter the frequency of the reoccurrence into the text box, and then 
select either Day(s), Weeks(s), Month(s), or Year(s) to set the period of the recurrence. The default 
setting is every 1 day.

 l To set the event to reoccur weekly: 

 i. Select Weekly Event.

 ii. In the                          Repetition Frequency (Weeks) text box, enter how frequently the event occurs each week.

 iii. Check  the check box for each of the day the event reoccurs.

 l To set the event to reoccur once each month: 

 i. Select Monthly Event. 

 ii. At Repeated on select the week in which the event reoccurs in the month. Options are First, Sec-
ond, Third, Fourth and Last. The default setting is First. 

 iii. Select the day of the month when the event reoccurs.  The default setting is Sunday.

 l To set the event to reoccur on a specific date of each month:

 i. Select Monthly Event. 

 ii. At Repeated On Day, select the date of the month when the event is repeated. The default setting is 
1st.

 iii. In the Repetition Frequency (Months) text box, enter the number of months that the event reoccurs 
for. E.g. Enter 1 for an event which reoccur each month, or 2 for an event which reoccur every sec-
ond month.



 l To set the event to reoccur annually:

 i. Select Annual Event. 

 ii. At Repeat On Date, click the Calendar  button and select the date. See "Working with the Cal-
endar".

 l Uncheck  the check box to set the event as a one time event. Note: Saved settings are retained for future use.

 4. Click the  Update link.

Tip: Recurring events display the Recurring Event  icon which displays recurrence details when you hover over it. 

Tip: You can either edit individual instances of recurring events or the full event series.

Setting Recurring Events

Copying an Existing Event Series as a New Event Series
How to copy an existing recurring event series and save it as a new event series using the Events module.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month 
View)". or "Viewing Event Details (Week View)".

 2. Click the  Edit Series link.

 3. Edit the event details as required.

 4. Click the  Copy As New Event Series link. If the event requires moderation you will be notified when moderation has occurred 
and whether the event was accepted. Once moderated events are accepted they are displayed in the module.





Copying an Existing Event Series as a New Event Series

Enabling/Disabling and Configuring Event Enrollment
How to enable or disable users to enroll for a paid event and configure the related settings on the Events module. Note: Enrollment must 
be enabled by a Page Editor on the Settings page of this module."Configuring the Enrollment Settings".

 1. Add a new event, or edit an existing event. "Adding an Event". or "Editing an Event".

 2. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month View)". 
or "Viewing Event Details (Week View)".

 3. Select from these options:

 l Click the  Edit link to edit one time events, on to edit only this instance of a recurring event. 

 l Click the  Edit Series link to edit all instances of a recurring event.

 4. At Allow Enrollment, select from these options:

 l Check  the check box to allow enrollment.

 l Uncheck  the check box to disable enrollment. Skip to Step 9.

 5. At Type of Enrollment, select from these options:

 l Free (Moderated)Paid Fee

 l Paid Fee

 a. In the Paid Fee text box, enter the fee amount. Note: The currency type is set by the Administrator. 

 b. In the PayPal Account text box, edit the PayPal account email address if required. 

 6. Optional. In the Max. Enrollment text box, enter the maximum number of enrollments that can be accepted for this event. If an 
unlimited number of enrollments can be accepted, enter 0. The default setting is 0 (unlimited enrollments) 



 7. Optional. At Enroll List on Detail View, check  the check box to display the list of enrolled users on the detailed event view - OR 
- Uncheck  the check box to disable and display on the Edit Event page only displayed at the Enrolled Users field.

 8. Optional. At Enrollee Role, select one of the following: 

 l Select None to permit all registered users to enroll for the event. This is the default setting. 

 l Select a role to limit enrollment to members of that role. Note: This restriction also applies to the Admin role.

 9. Click the  Update link for a single event - OR - Click the  Update Series link for an event series.

Enabling and Configuring Event Enrollment



Event Enrollment Enabled on an Event

Related Topics:

 l "Configuring the Enrollment Settings".

Enrolling User to an Event
How to enroll one or more users to an event on the Events module. Note: Event enrollment must be enabled. See "Configuring the Enroll-
ment Settings"

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month 
View)". or "Viewing Event Details (Week View)".

 2. Click the  Edit link.

 3. Go to the Allow Enrollment section.

 4. At Enroll User To Event, select the user from the drop-down box.

 5. Click the Enroll User link. The user will be added to the Enrolled Users list below.

 6. Repeat Steps 4-5 to enroll additional users.



Enrolling Users to Events

Managing Existing User Enrollments
How to delete one or more enrolled users from an event on the Events module.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month 
View)". or "Viewing Event Details (Week View)".

 2. Click the Edit link. 

 3. At Allow Enrollment, details of current enrollments are listed at Enrolled Users.

 4. At Select, check  the check box beside the required users to perform any of the following tasks:

 l Click the Email Selected Enrolled Users link to email these users.

 l Click the Delete Selected Enrolled Users link to email these users.

Managing Existing User Enrollments

Deleting an Event or Event Series
How to permanently delete an event from the Events module. Note: Module and Page Editors may only be able to delete their own 
events. This depends on the moderation settings configured by a Page Editor on the Settings page of this module.

 1. Go to the event details page of the required event. See "Viewing Event Details (List View)", "Viewing Event Details (Month View)". 
or "Viewing Event Details (Week View)".



 2. Select from these options:

 l Click the  Delete link to delete a one time event or this instance of a recurring event. This displays the message "Are 
you sure you wish to Delete this entry?"

 a. Click the OK button to confirm.

 l Click the Delete Series link to delete all instances of this recurring event. This displays the message "Are you sure 
you wish to Delete ALL recurrences?"

 a. Click the OK button to confirm.

Global Category Editor
Adding Event Categories
How to add one or more categories to the Events module.



 1. Select  Edit Categories from the module actions menu. This opens the Edit Categories page.

 2. In the Category text box, enter a category name. To use the colors shown at the Preview field below, skip to Step 5. Note: The 
preview field updates whenever the color selections are modified.

 3. Optional. At Background Color, perform one of the following to set the background color:

 l Click the     Color Picker  button and select a color. 

 l Enter a web safe hexadecimal color value into the background color. E.g. #99d9ea

 l Leave this field blank for no background color. 

 4. Optional. At Font Color, perform one of the following to set the font color:

 l Click the     Color Picker  button and select a color. 

 l Enter a web safe hexadecimal color value into the background color. E.g. #99d9ea

 l Leave this field blank to use the color associated with the applied stylesheet.

 5. Click the  Add link. This lists the category  in the Category Name list to the right. 

 7. Repeat Steps 2-6 to add additional categories.

 8. Click the  Return link to return to the module.

Adding an Event Category

Editing Event Categories
How to edit one or more categories on the Events module.



 1. Select  Edit Categories from the Events module actions menu.  

 2. In the Category Name list, click on the linked [Category Name]. This displays the category details in the Category and Color 
fields. 

 3. Edit fields as required. 

 4. Click the  Update link.

 5. Repeat Steps 2-4 to edit additional categories. 

 6. Click the  Return link to return to the module.

Deleting Event Categories
How to delete one or more categories from the Events module.

 1. Select  Edit Categories from the Events module actions menu.  

 2. In the Category Name list, click the Delete  button beside the category to be deleted. This displays the message "Are you 
sure you wish to delete this entry?" 

 3. Click the OK button to confirm.



 4. Repeat Steps 2-3 to delete additional categories.

 5. Click the  Return link to return to the module.

Global Location Editor
Adding Event Locations
How to add one or more locations to the Events module.

 1. Select  Edit Locations from the module actions menu. 

 2. In the Location text box, enter the location name. 

 3. Optional. In the Map URL text box, enter the URL which will link to a map of the location. 

 4. Click the  Add link. This displays the location in the Location Name list.

 6. Repeat Steps 2-4 to add additional locations.

 7. Click the  Return link to return to the module.

Adding an Event Location

Editing Event Locations
How to edit one or more locations on the Events module.

 1. Select  Edit Locations from the module actions menu. 

 2. In the Location Name list, click on linked [Location Name] to be edited. This displays the location details in the edit fields to the 
left.

 3. Edit the Location and/or Map URL fields as required. 

 4. Click the  Update link.

 5. Repeat Steps 2-4 to add additional locations. 

 6. Click the  Return link to return to the module.



Editing an Event Location

Deleting Event Locations
How to delete one or more locations from the Events module.

 1. Select  Edit Locations from the module actions menu. 

 2. In the Location Name list, click the Delete  button beside the location to be deleted. This displays the message "Are you sure 
you wish to delete this entry?"

 3. Click the OK button to confirm.

 4. Repeat Steps 2-3 to delete additional locations. 

 5. Click the  Return link to return to the module.

Moderator
About Moderating Events and Enrollments
The Events module can be configured to require moderation of events and enrollments. Moderation can be required for all event/en-
rollment changes or only for new items. One or more moderators will be sent email notification when items require moderation.

Approving All Moderated Enrollments
How to approve all event enrollments awaiting moderation on the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment - Events page.



 2. At Select View to Moderate, select Enrollment. This displays the list of enrollments awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the users who submitted the enrollments. 

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notifications.

 4. Click the Approve All link.

Approving all Moderated Enrollments

Approving All Moderated Events
How to approve all events awaiting moderation on the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page.

 2. At Select View to Moderate, select Events. This displays the list of events awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the users who created the events. 

 a. Optional. In the Email Subject text box, edit the subject of the email.

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notifications.

 4. Click the Approve All link.



Approving all Moderated Events

Approving Moderated Enrollments
How to approve one or more enrollments awaiting moderation in the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page.

 2. At Select View to Moderate, select Enrollment. This displays the list of enrollments awaiting moderation.

 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the users who created the events. 

 a. Optional. In the Email Subject text box, edit the subject of the email.

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notifications.

 4. In the Action column, select Approve beside each enrollment to be approved. 

 5. Click the Update link.

Tip: Click the Unmark All link to deselect the Approve and Deny action for all enrollments.



Approving Moderated Enrollments

Approving Moderated Events
How to approve one or more events awaiting moderation in the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens 
the Moderate Enrollment-Events page.

 2. At Select View to Moderate, select Events. This displays the list of events awaiting moderation.

 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the user or users who created the event(s).

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notification.

 4. In the Action column, select Approve beside each event to be approved. 

 5. Click the Update link.

Tip: Click the Unmark All link to deselect the Approve and Deny action for all events.



Approving Moderated Events

Denying All Moderated Enrollments
How to deny all enrollments awaiting moderation on the Events module. Note: Denying enrollments permanently deletes all details of the 
enrollment.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page. 

 2. At Select View to Moderate, select Enrollment. This displays the list of enrollments awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options: 

 l Check  the check box to send email notification to the users who submitted the enrollments. 

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notifications.

 4. Click the Deny All link.



Denying all Moderated Enrollments

Denying All Moderated Events
How to deny all events awaiting moderation on the Events module. Note: Denying events permanently deletes all details of the events.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page. 

 2. At Select View to Moderate, select Events. This displays the list of events awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the users who created the events. 

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notifications.

 4. Click the Deny All link.



Denying all Moderated Events

Denying Moderated Enrollments
How to deny one or more enrollments awaiting moderation on the Events module. Note: Denying enrollments permanently deletes all 
details of the events.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the 
Moderate Enrollment-Events page.

 2. At Select View to Moderate, select Enrollment. This displays the list of enrollments awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the users who submitted the enrollments. 

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notification.

 4. In the Action column, select Deny for each enrollment to be denied and deleted. 

 5. Click the Update link.



Denying Moderated Enrollments

Denying Moderated Events
How to deny one or more events awaiting moderation on the Events module. Note: Denying events permanently deletes all details of the 
events.

 1. Select Moderate Events from the Events module actions menu. 

 2. At Select View to Moderate, select Events. This displays the list of events awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options: 

 l Check  the check box to send email notification to the user or users who created the event(s). 

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notification.

 4. In the Action column, select Deny for each event to be denied and deleted. 

 5. Click the Update link.



Denying Moderated Events

Editing and Approving a Moderated Event
How to review, edit and approve an event requiring moderation in the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page. 

 2. At Select View to Moderate, select Events. This displays the list of events awaiting moderation. 

 3. At Email Action Notification to User?, select one of these options: 

 l Check  the check box to send email notification to the user or users who submitted the event.

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notification.

 4. In the Action column, select the Approve.

 5. In the Event column, click the linked [Event Title].

 6. Review and edit the event details as required.  

 7. Click the Update link.

Moderating Multiple Enrollments
How to approve and deny multiple event enrollments on the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page. 

 2. At Select View to Moderate, select Enrollments. This displays the list of enrollments awaiting moderation. 



 3. At Email Action Notification to User?, select one of these options: 

 l Check  the check box to send email notification to the user or users who submitted the enrollments.

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notification.

 4. In the Action column, select the Approve or Deny beside one or more enrollments as required. 

 5. Click the Update link.

Tip: Click the Unmark All link to deselect the Approve and Deny action for all enrollments.

Moderating Multiple Enrollments

Moderating Multiple Events
How to approve and deny multiple events on the Events module.

 1. Select Moderate Events from the Events module actions menu - OR - Click the Moderate Events  button. This opens the Mod-
erate Enrollment-Events page. 

 2. At Select View to Moderate, select Events. This displays the list of events awaiting moderation. 



 3. At Email Action Notification to User?, select one of these options:

 l Check  the check box to send email notification to the user who created the event. 

 a. Optional. In the Email Subject text box, edit the subject of the email. 

 b. Optional. In the Email Message text box, edit the message of the email.

 l Uncheck  the check box if you don't want to send email notification.

 4. In the Action column, select the Approve or Deny beside one or more events as required. 

 5. Click the Update link.

Tip: Click the Unmark All link to deselect the Approve and Deny action for all events.

Moderating Multiple Events

Edit Settings
Configuring Event General Settings
How to configure the General Settings of the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Go to the General Settings section.

 3. At Edit Time Interval, select the time interval in minutes at which events can be scheduled. E.g. Select 15 to set 15 minute inter-
vals. The default setting is 30. Important: This setting must be set before any events are added. If events exist in the module you 
will be unable to edit this field.

 4. At Event Time Zone, select the default time zone to be used for all events. 



 5. At Permit Recurring Events, select from the following options: 

 l Check  the check box to enable the adding of recurring events. If checked, the Recurring Settings section is displayed 
on the Edit Events page.

 l Uncheck  the check box to disable recurring events from being added.

 6. In the Max Generated Occurrences, edit the Maximum number of occurrences of an event generated on save. Leave blank for 
unlimited. Until date is set to last occurrence if limit reached.

 7. At Prevent Schedule Conflict, check  the check box to check for a location conflict when checking date conflicts - OR - 
Uncheck  the check box to disable.

 8. At Check for Location Conflict, select from the following options: 

 l Check  the check box to prevent the adding of events within the same date and time period. If this option is selected, a 
"Conflict with existing Event! Change Date/Time" message is displayed to users when they attempt to add 
a conflicting event.

 l Uncheck  the check box to enable events to be scheduled at the same time.

 9. At Enable DNN Search, check  the check box to enable site wide searches conducted using the Search modules and the 
Search skin token to search events - OR - Uncheck  the check box to exclude events from DNN searches. 

 10. At Allow Subscriptions, check  the check box to enable users to subscribe to receive notification of new events - OR - Uncheck 
 the check box to disable. 

 11. At Owner Change Allowed, check  the check box to enable moderators to change the event owner. Note: Administrators can 
always change the event owner - OR - Uncheck  the check box to disable. 

 12. In the Delete Events Older Than text box, enter the number of Days to set expiration of old events. Leave this field blank for no 
expiration.

 13. In the Private Calendar Message text box, enter a message to be displayed to anonymous users instead of event title/details. 
Authenticated event editors can only see event title/details of their own events. Moderators/Administrators can see all event 
details.

 14. At Filter Events by Category, select All to display events from all categories in this module - OR - Select the category to only dis-
play events within that category.

 15. Click the  Update Settings link.



Configuring Event General Settings

Configuring Event Look and Feel Settings
How to configure the Look and Feel Settings of the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Look & Feel Settings section.

 3. At Theme/Skin, select a Standard Theme (also called skin) for this events module from the drop-down list - OR - Select a Custom 
Theme. Note: To enable custom theme's, place stylesheet files into the  Portals\[portalid]\DNNEvents\Themes folder.

 4. At Default Module View, select either List, Month, Week as the default view for the module. This automatically checks the related 
check box on the next field, and disables if from being unchecked.

 5. At Module Views Allowed, select one or more of the following options:

 l Month: Check  the check box to enable the month view.

 l Week: Check  the check box to enable the week view.

 l List: Check  the check box to enable the list view.

 6. At Use Module Container & Skin, check  the check box to use the module container and page skin for views that would nor-
mally default to the  portal default container and skin - OR - uncheck  to enable users to switch between the different views.

 7. At Enable Category Select, select from the following options:

 l Check  the check box to enable category selection.

 l Uncheck  to disable users from selecting categories on all view forms.

 8. At Enable Date Navigation Controls, check  the check box to enable the date navigation controls (links).



 9. At Enable Event Image, check  the check box to enable images to be displayed on events.  If checked, the Image Settings sec-
tion is displayed on the Edit Events page - OR - Uncheck  the check box to disable images on events.

 10. At Display TimeZone, check  the check box to enable the TimeZone to be displayed on the Detail Event - OR - Uncheck  the 
check box to hide the TimeZone.

 11. At Icon Bar, select from these options:

 l Select Top Right to display the icon bar above events.

 l Select Bottom Center to display the icon bar below events

 l Select None to hide the icon bar.

 12. Click the  Update Settings link.

Configuring Event Look and Feel Settings

Configuring Detail View Settings
How to configure the Detail View Settings of the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Detail View Settings section.

 3. At Event Detail New Page, select from the following options:

 l Check  the check box to display event detail on a new page.

 l Uncheck  the check box to display event details on the same page. 



 4. At Set Event Detail Page Allowed, select from the following options:

 l Check  the check box to allow event editors to set a specific page as event detail page.

 l Uncheck  the check box to disable.

 5. At Enable Enroll  Validation Popup, select from the following options

 l Check  the check box to enable a message box which required the user to confirm they want to enroll.

 l Uncheck  the check box to disable popup box.

 6. Click the  Update Settings link.

Configuring Detail View Settings

Configuring Event Month View Settings
How to configure the month view settings of the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Month View Settings section.

 3. At Enable Month View Cell Events, check  the check box to display event details in the monthly calendar - OR - Uncheck  the 
check box to hide event details in the monthly calendar. To view event details users must click on the date in the calendar. 

 4. At Show Events in Next/Prev Month, select from the following options: 

 l Uncheck  the check box to hide events which fall on the previous or the next month from being displayed in the selected 
month view.

 l Check  the check box to display events which occur in the month before or after the displayed month in the monthly cal-
endar. E.g. If the displayed month is July and July 31st falls on a Monday, any events which occur at the start of August will 
be displayed in the cells for August. 

 5. At Weekend Starts Friday, check  the check box to use Fri/Sat as the weekend - OR - Uncheck  the check box to use Sat/Sun 
as the weekend

 6. At Show Events Start Time in Title, check  the check box display the event start time to be displayed on the link to the event - 
OR - Uncheck  the check box to hide the event start time.

 7. At Event Day New Page, check  the check box to enable Event Day to be shown in new Page (not embedded) when Enable 
Month View Cell Events unchecked -  OR - Uncheck  the check box to disable.

 8. At Enable Selectable  Day, check  the check box to enable a day to always be selectable when Enable Month View Cell Events 
is  enabled -  OR - Uncheck  the check box to disable.



 9. At Show Event Icons, check  the check box beside each event icon to be displayed next to the event title in the month view. All 
icons are checked by default.

 10. At Show Event Image, check  the check box to display the event image in month view - OR - Uncheck  the check box to hide 
them.

 11. Click the  Update Settings link.

Configuring Event Month View Settings

Configuring Week View Settings
How to configure the General Settings of the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Week View Settings section.   

 3. At Full Time Scale, check  the check box to display the full time scale in the week view - OR - Uncheck  the check box to dis-
able. 

 4. At Include End Value, check  the check box to display the end time of the event in the week view - OR - Uncheck  the check 
box to hide the end time.

 5. At Show Value Marks, select from these options:

 l Check  the check box to display the grid lines against each time in the week view when the above field is unchecked. 
Note: The Include End Value field above must be unchecked to enable this option.

 l Uncheck  the check box to hide grid lines.

 6. At Show Event Icons, check  the check box beside each icon to be displayed beside the event title in week view. All icons are 
checked by default.

 7. Click the  Update Settings link.



Configuring Week View Settings

Configuring the Event List Settings
How to configure the list view of the Events module. To use the list view, you must place two Events modules on the page. Do not enable 
List mode on the first module, only in the second events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Event List Settings section. 

 3. At Show Table Header, select Yes to display a header above the event list - OR - Select No to hide the header. 

 4. To set the number of events displayed in the list, select from the following options: 

 l To display the number of events displayed by the number of days: 

 a. Select Select Events By Days. 

 b. Enter the [number of] days before current date to be displayed. 

 c. Enter the [number of] days after current date to be displayed.

 l To display the number of events displayed by the number of events: 

 a. Select Select Events By Number. 

 b. Enter the Next [number of] events to be displayed from the current date. 

 c. Enter the within the next [number of] days. E.g. Entering Next 10 events from current date within the next 14 
days will display a maximum of 10 events and will not display events more than 2 weeks in advance. 

 5. At Event Fields to Display, set the fields to be displayed on each event: 

 l To Add a Field, click on the name of the field in the Available box and then click the Add > link. 

 l To Add All Fields, click the Add All >> link. 

 l To Remove a Field, click on the field name in the Selected box and then click the Remove < link. 

 l To Remove All Field, click the Remove All << link.

 6. At Page Size, select the number of events to be displayed on each page of the Event List.

 7. At Default Sorting, select to sort events either Ascending or Descending by their start date. The default settings is Ascending.

 8. At Default Sort Column, select the column by which events in list view will be sorted by default.

 9. At Collapse Recurring, check  the check box to collapse recurring events to one row - OR - Uncheck  the check box disable.



 10. At Show Event Icons, check  the check box beside each icon to be displayed beside the event title in list view. All icons are 
checked by default.

 11. Click the  Update Settings link.

Configuring the Event Email Settings
How to configure the email settings of the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Event Email Settings section.

 3. At Send New Event Emails, select a radio button to set if and to whom emails are sent to when a new event is added:

 l Never: Select to disable email messages.

 l Subscribers: Select  to enable users to subscribe for notification through the check box in the icon bar.



 l Role: Select the radio button and then select a role from the drop-down box. Users in the selected role will receive email 
notification when a new event is created.

 4. At Allow Email Send by Event Editor, check  the check box to allow editors to send an event email to a role - OR - Uncheck 
 the check box to disallow.

 5. Click the  Update Settings link.

Configuring Event Reminder Settings
How to enable and configure reminder settings for the Events module. Note: The Event Module Scheduler must be enabled by the 
Host to enable reminders.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Reminder Settings section.

 3. At Allow Event Reminder, check  the check box to enable automated event reminders to be send to enrolled users - OR - 
Uncheck  the check box to disable reminders. 

 4. At Reminder Anonymous, check  to enable anonymous users (i.e. unauthenticated users) to request event reminders - OR - 
Uncheck  the check box to disable reminders.

 5. At Send Reminder Default Value, check  to set the Send Reminder field on the Edit Event page as checked by default - OR - 
Uncheck  the check box to set as unchecked by default.

 6. In the                        Remind Email From text box, enter the default email address to be displayed in the From field for reminders. This email 
address can be modified for each event on the Edit Event page.

 7. Click the  Update Settings link.

Configuring the Enrollment Settings
How to configure enrollment settings including PayPal account details for paid events on the Events module. "Configuring Moderation 
Settings".



 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.       

 2. Maximize  the Enrollment Settings section. 

 3. At Permit Event Enrollment, check  the check box to enable authorized users to sign up for events - OR - Uncheck  the 
check box to disable event enrollment. 

 4. Optional. In the PayPal Account text box, enter your PayPal account number if you are collecting fees to paid events. The Host 
email address is entered by default.

 5. Optional. At PayPal URL, enter https://www.paypal.com - OR - enter https://www.sandbox.paypal.com to test this set-
ting. The default setting is https://www.paypal.com

 6. At Display Enroll List by Default, check  the check box to display the enrollment list on the Event Detail Page by default  - OR 
- Uncheck  the check box if it isn't displayed by default.

 7. At Hide Full Enrolled Events, check  the check box to hide an event once the maximum number of enrollees is reached. Note: 
The event owner and moderators always can see the event - OR - Uncheck  the check box to keep displaying the event.

 8. In the Allow Multiple Enrollees text box, enter the number of people that a single user can enroll for an event. The default value 
is one ( 1 ) enrollment per user.

 9. In the Cancel Before Days text box, enter the number of days before an event a user is able to cancel their enrollment. 
Note: Cancellations are only allowed for unpaid events.

 10. At Select the User Fields to Display, select each of the user fields to be displayed on the Event Detail Page and who is able to 
view these fields.

 11. Click the  Update Settings link.

Configuring Moderation Settings
How to enable or disable the moderation of events and enrollments and configure the related settings on the Events module.



 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Moderation Settings section. 

 3. At Moderate Event/Enrollment Changes, select from these option: 

 l Check  the check box to enable moderation of all changes to events and enrollments. 

 l Uncheck  the check box disable moderation. Newly added events and event changes will be automatically displayed on 
the module.

 4. In the Moderator Emails text box, enter the email address of the moderator who will receive notification when an event of enroll-
ment required moderation. To send emails to multiple moderators, enter one or more emails separated by a semi-colon. The 
email address of the Host is entered by default.

 5. Click the  Update Settings link.

Configuring the SubCalendar Settings
How to display events from one or more events modules (SubCalendars) in an Events module. A SubCalendar is an Events module 
which is located on another page. A maximum of 1000 SubCalendars can be added.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the SubCalendars Settings section. 

 3. At Include Other Site Event Modules?, select from these options: 

 l Check  the check box to include events from other Events modules on this Events module

 a. At Add Sub-Calendar Name, check  the check box to include the name of the other Events modules (Sub-
Calendars) in the title of an event when it displays in this Events module - OR - Uncheck  the check box to hide 
the name of other Events modules in the title of events.

 b. At Enforce Permissions, check  the check box you want the View permissions applied to the SubCalendar to be 
observed in the master  calendar - OR - Uncheck  the check box to disable.



 c. At Add/Remove Sub-Calendars, in the Available list, select one or more of the other event modules to be included 
in this module.

 l To Add a Calendar, click on the name of the calendar in the Available box and then click the Add > link. 

 l To Add all Calendars, click the Add All >> link. 

 l To Remove a Calendar, click on the calendar name in the Selected box and then click the Remove < link. 

 l To Remove all Calendars, click the Remove All << link.

 l Uncheck  the check box to only display events added using this Events module.

 4. Click the  Update Settings link.

Configuring Custom Field Settings
How to enable and configure custom fields on the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Custom Fields section.    

 3. At Display Custom Field 1, select from the following options: 

 l Check  the Set name in Admin/Languages  check box to enable Custom Field 1 to be displayed. The field name can 
then be managed using the Languages module. 

 l Uncheck  the check box to disable this custom field.

 4. At Display Custom Field 2, select from the following options: 

 l Check  the Set name in Admin/Languages check box to enable Custom Field 2 to be displayed.  The field name can 
then be managed using the Languages module.

 l Uncheck  the check box to disable this custom field.



 5. Click the  Update Settings link.

Configuring Tooltip Settings
How to configure the Tooltip settings of the Events module. Tool tip show when hovering over whole row in list and day views, and the 
event cell in week view.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the Tooltip Settings section.

 3. At Display Month View Tooltip, check  the check box to display the event description as a tool tip in the month view - OR - 
Uncheck  the check box to hide tool tip.

 4. At Display Week View Tooltip, check  the check box to display the event description as a tool tip in the week view - OR - 
Uncheck  the check box to hide tool tip.

 5. At Display Day View Tooltip, check  the check box to display the event description as a tool tip in the day view - OR - Uncheck 
 the check box to hide tool tip.

 6. In the Tooltip Length text box, enter the maximum number of characters included in the tool tip. The default setting is 10000.

 7. Click the  Update Settings link.

Configuring RSS Settings
How to enable and configure RSS Settings for the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page.

 2. Maximize  the RSS Settings section.



 3. At Enable RSS, select from these options:

 l Check  the check box to enable RSS.

 a. At Date To Use, select which date to use as the Publish Date in the RSS feed.

 b. In the Days To Include text box, enter the number of Days to include in the RSS from today.

 c. In the Feed Title text box, edit the title to be displayed in the RSS feed if desired.

 d. In the Feed Description text box, edit the title to be displayed in the RSS feed if desired.

 l Uncheck  the check box to disable RSS.

 4. Click the  Update Settings link.

Configuring Calendar Export Settings
How to configure the export settings for events on the Events module.

 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button if the Icon Bar is displayed. This 
displays the Event Module Settings page.

 2. Maximize  the Calendar Export Settings section.

 3. At Owner Email Address Export, check  the check box to include the email address of the event owner when a user exports 
an event  - OR - Uncheck  the check box for no email.

 4. At Owner Email For Unregistered User, check  the check box to include the email address of the event owner when an 
unregistered user exports an event  - OR - Uncheck  the check box for no email.

 5. Click the  Update Settings link.

Configuring Calendar Export Settings for the Events Module

Configuring Template Settings
How to modify the default event templates used in the Events module.



 1. Select Edit Settings from the module actions menu - OR - Click the Edit Settings  button (only visible if the Icon Bar is dis-
played). This displays the Event Module Settings page

 2. Maximize  the Template Settings section.

 3. At Event Template, select the template to be viewed/modified. 

 4. Optional. Click the Template Help link to view a full list of replacement tokens.

 5. Modify the template in the text box. 

 6. Click the  Update Template link to save your changes.

Tip:  You can click the  Reset Template link to reset to the default template as any time.

Troubleshooting: Unable to Add New Events to the Events Module
If you are unable to add new events or edit existing events to the Events module this may be cause by Friendly URL's being disabled on 
your web site. Host level access is required to modify this setting. Contact your Administrator or Host to request enabling of friendly 
URL's.

Settings
Setting Unique Event Permissions
How to assign role members and users as Event Moderators, Global Category Editors (users who can manage categories) or/and Global 
Location Editors  (users who can manage locations) on the Events module. These permissions are in addition to the usual module 



permissions.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Permissions tab. 

 3. At Permissions, set these unique Event module permissions:

 l Event Moderators: Users authorized to moderate events.

 l Global Category Editors: Users authorized to create and manage event categories.

 l Global Location Editors: Users authorized to create and manage event categories.

 4. Click the  Update link.

Assigning roles and users as Events Moderators

Related Topics: 

 l "Setting Module Permissions".

FAQ
About the FAQs Module
The FAQs module enables authorized users to manage a list of questions and corresponding answers. The question is displayed as a 
link, requiring the user to click on a question to view the corresponding answer. FAQ's can be managed using your own categories.

The module settings page enables authorized users to set the default sorting order and modify the styles templates allowing you to  dis-
play the question, answer, number of times viewed, category name, category description, date created, date modified, and the question 
number.

Module Version: 04.05.01

Minimum DNN Version: 05.06.01

Features: IPortable, ISearchable



The FAQ Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleFAQ/tabid/892/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/27/scope/threads/Default.aspx

 l Issue Tracker: http://dnnfaq.codeplex.com/workitem/list/basic

All Users
Viewing an FAQ Answer 
How to view the answer to a frequently asked question.

 1. Click the Question which is a link. This displays the answer below that question. 

http://www.dotnetnuke.com/Products/Development/Forge/ModuleFAQ/tabid/892/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/27/scope/threads/Default.aspx
http://dnnfaq.codeplex.com/workitem/list/basic


 2. Optional. Click the link again to hide the answer.

Module Editors
Adding an FAQ 
How to add a frequently asked question to the FAQs module. Note: You cannot include movies, sound files, etc. Only basic HTML is per-
mitted.

Tip: You can add a question without entering an answer. This allows you, or another editor to return later to complete it.

 1. Select  Add New FAQ from the module actions menu - OR - Click the  Add New FAQ link. This opens the "Edit This FAQ 
Entry" page.

 2. Optional. At Category, select a category from the drop-down box. 

 3. In the Question text box, enter the question. A maximum of 400 characters is permitted.

 4. Optional. In the Answer text box, enter the answer.

 5. Click the  Update link. The newly added FAQ is now displayed in the module.



Editing an FAQ
How to edit a frequently asked question on the FAQs module.

 1. Click the Edit  button associated with the FAQ to be edited. 

 2. Edit the one or more fields as required.

 3. Click the  Update link.

Deleting an FAQ 
How to permanently delete a frequently asked question from the FAQs module.

 1. Click the Edit  button associated with the FAQ to be deleted.  

 2. Click the  Delete link. This displays the  message "Are You Sure You Wish To Delete This Item?" 



 3. Click the OK button to confirm.

Adding an FAQ Category
How to add one or more categories to the FAQs module. FAQ's can only be associated with one category. The category name and 
description can optionally be displayed in the module by editing the Item Template under Module Settings. See "Editing the FAQ Tem-
plates"

 1. Select  Manage Categories from the module actions menu - OR - Click the  Manage Categories link. This displays the Man-
age Categories page.

 2. Click the  Add New link.

 3. In the Category Name text box, enter a name for the category.

 4. In the Category Description text box, enter a description for the category.

 5. Click the  Update link.

 6. Repeat Steps 2-5 to add additional categories.

 7. Click the  Cancel link to return to the module.

Editing an FAQ Category 
How to edit a category in the FAQs module.

 1. Select  Manage Categories from the module actions menu - OR - Click the  Manage Categories link. This displays the Man-
age Categories page.    

 2. Click the Edit  button beside the category to be edited.

 3. Edit the Category Name and/or Category Description information as required. 

 4. Click the Update link.



 5. Repeat Steps 2-4 to edit additional categories. 

 6. Click the  Cancel link to return to the module.

Deleting an FAQ Category 
How to permanently delete a category from the FAQs module.

 1. Select Manage Categories from the module actions menu - OR - click the Manage Categories link. 

 2. Click the Delete button beside the category to be deleted. This displays the message "Are You Sure You Wish To Delete This 
Item?"   

 3. Click the OK button to confirm deletion.

 4. Repeat Steps 2-3 to delete additional FAQ's. 

 5. Click the  Cancel link to return to the module.

Settings
Setting the Default Sorting Order of FAQ's
How to set the default sort order for FAQ's in the FAQs module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the FAQs Settings tab. 

 3. At Default Sorting, select from the following sorting options: 

 l Modified Date (newest first): Select to sort FAQ's according to the date they were last modified from newest to oldest.

 l Modified Date (oldest first): Select to sort FAQ's according to the date they were last modified from oldest to newest.

 l Popularity (highest first): Sorts FAQ's from the most popular to least popular. Popularity is rated by the number of times 
the FAQ has been clicked. 

 l Popularity (lowest first): Sorts FAQ's from the least popular to the most popular. Popularity is rated by the number of times 
the FAQ has been clicked.



 l Creation Date (newest first): Select to sort FAQ's according to the date they were first created from newest to oldest.

 l Creation Date (oldest first): Select to sort FAQ's according to the date they were first created from oldest to newest.

 4. Click the Update link.

Editing the FAQ Templates
How to edit the templates which control the layout of FAQ's in the FAQs module. A template is provided for the answer, the question, as 
well as a loading template to be display while AJAX is loading the question. Nine different tokens can be added to these templates to dis-
play information such as the related category, the date the FAQ was created, number of times an item has been viewed, etc. A full list of 
tokens is listed below this topic and on the Settings page.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the FAQs Settings tab. 

 3. At Question Template, edit the default template for the question. 

 4. At Answer Template, edit the default template for the answer. 

 5. At Loading Template, edit the default loading template which is displayed when the user clicks on a Question  until the Answer is 
fully loaded and displayed.



 6. Click the  Update link.

Note: In the below image, the Question template has been modified to include the category name and changes to the color and align-
ment. 



Tip: To restore an original template, add a new module and copy and paste the template from the new module into the module you have 
edited.

FAQ Token List

[FAQ:QUESTION] Displays the information entered into the question field. 

[FAQ:ANSWER] Displays the information entered into the answer field. 

[FAQ:USER] Displays the first name last name of the user who last updated the FAQ. This token can only be added into the 
Answer template.

[FAQ:VIEWCOUNT] Displays the number times the item has been viewed. 

[FAQ:CATEGORYNAME] Displays the information entered into the Category Name field. 

[FAQ:CATEGORYDESC] Displays the information entered into the Category Description field. 

[FAQ:DATECREATED] Displays the date when the FAQ was created. 

[FAQ:DATEMODIFIED] Displays the date when the FAQ was last modified. 

[FAQ:INDEX] Displays the order number of the FAQ.

Feed Explorer
About the Feed Explorer Module
The Feed Explorer module allows users to browse RSS feeds using a tabbed user interface. The standard content layout displays Tabs 
across the top of the module, Sections below Tabs, and Items down the left hand side of the module and then displays the related content 
to the right of the Items. The module  displays DNN information by default however it can be configured to aggregate multiple RSS feeds 
from different sources into one easy to use module.

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.



The Feed Explorer module displaying Yahoo! news

Settings
Displaying DNN Solutions  in the Feed Explorer 
How  to display DNN Solutions using the Feed Explorer module. This enables users to obtain DNN modules, skins, user manuals, video 
training and other DNN solutions - many of which have been verified as fully compatible with DNN. Information is grouped using the fol-
lowing tabs:

 l Marketplace: This tab provides access to the DotNetNuke Store (Snowcovered.com)  which sells extensions for DNN. Many of 
these extensions have all been reviewed by DNN Corporation so you can be confident that they will not break or cause errors on 
your site. This tab is divided into three sections:

 o Modules: DNN modules for sale.

 o Skins: Skins and containers sale.

 o Other: Other DNN products for sale including components, eBooks, providers (including authentication systems and lan-
guage packages) and DNN services (including DNN Sponsorship). 

 l DNN: This tab displays a list of the current DNN core projects. Projects include Modules, Providers, Utility, Core and Components 
which are developed and maintained by the core team and are available for free. 

http://www.snowcovered.com/Snowcovered2/Default.aspx


At the time of writing only the Modules section was completed. You can visit the project page of a module by clicking on module 
name on the Modules tab. 

 l About: Provides information about the Solutions Explorer and DotNetNuke Store (Snowcovered.com).

How  to display DNN Solutions using the Feed Explore module:

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feed Explorer Settings tab. 

 3. At Content Source, select DotNetNuke Solutions Explorer. 

 4. Click the Update link.

http://www.snowcovered.com/Snowcovered2/Default.aspx


Displaying DNN Solutions  in the Feed Explorer

Displaying News  in the Feed Explorer
How to display news using the Feed Explorer module. This displays news from Yahoo!, Google and BBC news, images, video, maps and 
more.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feed Explorer Settings tab.



 3. At Content Source, select DotNetNuke Solutions Explorer. 

 4. Click the Update link.

Yahoo, Google and BBC News are a preset Content Source option

Displaying Custom OPML using a Custom URL or File
How to set the Feed Explorer to display any custom data by entering a URL to an OPML (Outline Processor Markup Language) file or by 
uploading an OPML File. An OPML file is an XML file which contains markup describing multiple RSS feeds.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feed Explorer Settings tab.

 3. At Content Source, select Custom OPML URL/File. 

 4. In the Custom OPML URL/File text box, enter an absolute URL or file path.  E.g. http://ww-
w.domain.com/portals/0/myopmlfile.xml 

 5. Click the Update link.



Displaying Custom OPML  using Custom Text
How to  display any custom RSS feed data by entering OPML (Outline Processor Markup Language) that is customized for the Feed 
Explorer module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feed Explorer Settings tab.

 3. At Content Source, select the Custom OPML Text radio button.  

 4. Edit the existing text in the Custom OPML Text text box - OR - Delete the existing text and paste in your own text. 

 5. Click the Update link.

The sample below shows how to create the Tabs, Sections and items in the Feed Explorer.  You can add as many Tabs, Sections and 
Items as you like.

http://news.google.com/?output=rss" />
http://news.google.com/?output=rss" />

http://news.google.com/?output=rss" />

http://news.google.com/?output=rss" />



This OPML produces the below output in the Feed Explorer

Setting the Feed Explorer Theme 
You can change the skin design applied to the Feed Explorer module. Two skins or themes are supplied by default.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feed Explorer Settings tab.

 3. At Theme, select a theme from the drop-down box.



 4. Click the Update link.

Feedback
About the Feedback Module
The Feedback module allows users to send messages to the site Administrator. The Feedback Comments module is a companion mod-
ule which is also added to the page when the Feedback module is added. See "About the Feedback Comments Module"

Module Version: 05.00.02

Minimum DNN Version: 05.02.03

Features: ISearchable

Features:

 l Subject and category list management

 l Hide or display multiple form fields

 l Optional moderation for one or more feedback categories

 l Templates enable editors to change the module's look and feel

 l Set unique permissions to manage moderation and lists

 l Set validation rules for email, postal code, and telephone

 l Optional CAPTCHA security code



The Feedback Module

Project Links



 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleFeedback/tabid/841/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/30/scope/threads/Default.aspx

 l Issue Tracker: http://dnnfeedback.codeplex.com/workitem/list/basic

Configuration
Configuring the Feedback Module
The Feedback module can be used as soon as it is added to a page, however it is recommended the following settings are configured:

 l Disable Caching: It is recommended that caching is disabled to prevent stale data being displayed in the module. See "Con-
figuring Cache Settings for a Module"

If you choose to use the Feedback module now, the following defaults are used:

 l The primary site Administrator (See "Setting the Primary Administrator") will receive email notification when feedback is sent.

 l Feedback messages will be displayed in the Feedback Comments module to all users who have access to view that module.

See the Manage Settings section for both the Feedback and Feedback Comments modules to modify these defaults and set a wide 
range of optional settings.

All Users
Sending Feedback
How to send feedback  using the Feedback module. Note: Some fields listed in this topic  may not be displayed on the Feedback module. 
Required fields display the Required  icon. Required fields can differ depending on the settings for each module.

 1. Optional. Log in to your account (See "Logging into a Site"). Authenticated users can either skip all fields in the Your Contact Infor-
mation section (which are pre-populated from their user account), or they can optionally choose to edit the information.

 2. Go to the Your Contact Information section.

 a. In the Email text box, enter your email address. 

 b. In the Name text box, enter your name.

 c. In the Street text box, enter your street address.

 d. In the City text box, enter your city.

 e. In the Region or State text box, enter your region/state.

 f. In the Country text box, enter your country.

 g. In the Postal Code text box, enter your postal code.

 h. In the Telephone text box, enter your telephone number.

 3. Go to the Your Feedback section.

 4. The following optional fields may also be available:

 a. At Subject, enter or select the subject of your message. 

 b. At Category, select a category from the drop down list. 

 5. In the Message text box, enter your message. 

http://www.dotnetnuke.com/Products/Development/Forge/ModuleFeedback/tabid/841/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/30/scope/threads/Default.aspx
http://dnnfeedback.codeplex.com/workitem/list/basic


 6. The following optional fields may also be available: 

 a. At Send Copy?, select from the following options: 

 l Check  the check box to have a copy of the message emailed to you. 

 l Uncheck  the check box if you do not wish to receive a copy of your message.

 b. In the Security Code text box, enter the code displayed on the picture above. Note: If the image is difficult to read, click the 
Refresh  button to be presented with an alternative image.

 7. Click the Send Feedback link. This typically displays the message "Your feedback has been  sent to the site owner. Thank you!", 
however you may be redirected to another page.





Sending Feedback

Feedback Comments
Settings
Configuring Comments View Settings
How to configure the module settings of the Feedback Comments module.

 1. Go to the Feedback Comments module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Comments View Settings section.

 4. At Scope, select which Feedback modules comments are displayed for:

 l Selected Modules Only: Select to choose which Feedback modules to display feedback from. This displays a list of the 
Feedback modules on this site.

 i. At Feedback Modules, check  the check box beside each module to be included.

 l Portal (from all Feedback Modules): Select to display published feedback from all modules.

 5. At Categories, select one or more categories to restrict the feedback displayed to only those categories - OR - Leave all cat-
egories unchecked to display feedback from all categories.

 6. At Allow Paging, select from these options:

 l Check  the check box to enable paging (I.e. Restrict the number of comments displayed on the page and enable users 
to page through each page).

 a. In the Default Page Size text box, enter the number of comments to be displayed on each page.

 l Uncheck  the check box to remove paging and display all published comments.

 7. Click the  Update link.



Displaying Feedback for all Categories
How  to display feedback for all categories using the Feedback Comments module. This is the default option.

Tip: Categories are managed under Feedback Lists on the Feedback module.

 1. Go to the Feedback Comments module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Comment View Settings section. 

 4. At Category, select the None Selected. 

 5. Click the  Update link.

Display Feedback for All Categories

Configuring Comments View Settings
How to modify the various templates which control the appearance of the Feedback Comments module.

Note: A list of the available replacement tokens is displayed on this page at the Available Tokens field. These tokens are also included 
below this topic  for convenience.

 1. Go to the Feedback Comments module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Comments View Settings section.

 4. In the Header Template text box, edit the template as required. This template specifies what is displayed at the top of the com-
ments.

 5. In the Item Template text box, edit the template as required. This template specifies what is displayed for each odd numbered 
comment.

 6. In the Alternating Item Template text box, edit the template as required. This template specifies what is displayed for each even 
numbered comment. If an alternating item template is not specified, the item template is used for both odd and even numbered 
comments.

 7. In the Separator Template text box, edit the template as required. This template specifies  what displays between each comment.

 8. In the Footer Template text box, edit the template as required. This template specifies what is displayed below comments.



 9. Click the  Update link.

Tip: You can reset any of the default templates by clicking the Load Default button to the right of each template field.

List of Available Tokens



[Feedback:CategoryID],  [Feedback:Category], [Feedback:CategoryName], [Feedback:Subject],  [Feedback:Message], [Feed-
back:CreatedOnDate], [Feedback:PublishedOnDate],  [Feedback:FeedbackID], [Feedback:SenderName], [Feedback:SenderStreet],  [Feed-
back:SenderCity], [Feedback:SenderRegion], [Feedback:SenderCountry],  [Feedback:SenderPostalCode], [Feedback:SenderEmail], 
[Feedback:SenderTelephone],  [Feedback:SenderRemoteAddr], [Feedback:TotalRecords]

Displaying Feedback for a Single Category
How to  display feedback for a single category only using the Feedback Comments module. You may like to have a different Feedback 
Comments module to display feedback for each category or feedback for different categories as visible to different roles and users.

Tip: Categories are managed under Feedback Lists on the Feedback module.

 1. Go to the Feedback Comments module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Comment View Settings section. 

 4. At Category, select the category name. 

 5. Click the  Update link.

Displaying Feedback for a Single Category

Displaying/Hiding Feedback Email
How to hide or display a person’s email address on feedback comments that are published on the Feedback Comments module.

 1. Go to the Feedback Comments module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Comment View Settings section. 

 4. At Hide Email, check  the check box to hide names - OR - Uncheck  the check box to display names.

 5. Click the  Update link.



Email Addresses are Hidden on this Feedback Comments Module

Displaying/Hiding Feedback Name
How to hide or display a person’s name on feedback comments that are published on the Feedback Comments module.

 1. Select Settings from the Feedback Comments module actions menu. 

 2. Go to the Comment View Settings section. 

 3. At Hide Name, check  the check box to hide names - OR - Uncheck  the check box to display names.

 4. Click the  Update link.



Names are hidden on this Feedback Comments module

Displaying/Hiding Feedback Subject
How to hide or display the subject list value beside feedback comments that are published on the Feedback Comments module.

 1. Go to the Feedback Comments module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Comment View Settings section. 

 4. At Hide Subject, check   the check box to hide names - OR - Uncheck  the check box to display names.

 5. Click the  Update link.



The Feedback Subject List Value is Hidden on this Feedback Comments Module

About the Feedback Comments Module
The Feedback Comments module is a companion of the Feedback module. It displays published comments which have been submitted 
using one or more Feedback modules. The module can be set to display all feedback comments or feedback comments from selected 
feedback categories. In addition, the use of templates enable the look and feel of the comments to be designed as required, as well as 
enabling fields to be hidden or displayed.

The Feedback Comments Module

Manage Feedback Lists
Adding Feedback Categories
How to add basic categories to the Feedback module. Note: For details on how to associate a category with one or more email 
addresses, See "Adding Feedback Categories with Email Values"

Tip: The Feedback Comments module can also be set to display feedback for all categories or just one category.



 1. Select Feedback Category/Subject Lists from the Feedback module actions menu.

 2. At List Type, select Categories. 

 3. In the Name text box, enter a name for this category. E.g. Marketing 

 4. In the Value text box, enter a value for this category. E.g. Marketing. This value will be displayed in the Feedback Comments 
module beside any feedback within this category. 

 5. At Is Active, check  the check box if this category will show up in the category list on the Feedback module, or uncheck  if 
this category is currently inactive. 

 6. Click the Save link. The category is now displayed to the left.

 7. Repeat Steps 3-6 to add additional categories. 

 8. Click the Return to Module link to return to the module.

Adding Feedback Categories with Email Values
How to add feedback categories that are associated with one or more email addresses using the Feedback module. This sends a 
notification message to those email addresses whenever feedback is submitted to that category.

 1. Select Feedback Category/Subject Lists from the Feedback module actions menu.

 2. At List Type, select Categories. 

 3. In the Name text box, enter a name for this category. E.g. Marketing 

 4. In the Value text box, enter one or more email values for this category separated by a semi-colon (;). E.g. sales-
manager@domain.com;sales@domain.com. This value will be displayed in the Feedback Comments module beside any feed-
back within this category. 

 5. At Is Active, check  the check box if this category will show up in the category list on the Feedback module - OR - Uncheck 
 the check box if this category is currently inactive. 

 6. Click the Save link. The category is now displayed to the left.



 7. Repeat Steps 3-6 to add additional categories. 

 8. Click the Return to Module link to return to the module.

Editing Feedback Categories
How to edit categories in the Feedback module.

 1. Select Feedback Category/Subject Lists from the Feedback module actions menu. 

 2. At List Type, select Categories. 

 3. Click the Edit  button beside the category to be edited. The properties of this category are now displayed in the fields to the 
right.

 4. Edit the category details as required. 

 5. Click the Save link. The new details for this category are now displayed to the left. 

 6. Repeat Steps 3-5 to edit additional categories. 

 7. Click the Return to Module link to return to the module.

Re-ordering Feedback Categories
How to re-order categories on the Feedback module. Feedback module categories are listed in the order in which they are created.

 1. Select Feedback Category/Subject Lists from the Feedback module actions menu. 

 2. At List Type, select Categories. 



 3. Click the Up  or Down  button beside a category to move it up or down one position in the list. 

 4. Repeat Step 3 to re-order additional categories.

 5. Click the Return to Module link to return to the module.

Activating/Deactivating Feedback Categories
How to activate or deactivate a category on the Feedback module. Active categories are listed on the Settings page, whereas deactivated 
categories are not listed on the settings page and are only visible to Administrators on the Feedback Lists page.

 1. Select Feedback Category/Subject Lists from the Feedback module actions menu. 

 2. At List Type, select Categories. 

 3. Click the Edit  button beside the category to be activated or deactivated. 

 4. At Is Active, check  the check box to activate the category - OR - Uncheck  the check box to deactivate it. 

 5. Click the Save link.

 6. Repeat Steps 3-5 to modify additional categories. 

 7. Click the Return to Module link to return to the module.

Deleting Feedback Categories
How to permanently delete categories from the Feedback module. As an alternative to deleting a feedback category, you can deactivate 
it.



 1. Select Feedback Category/Subject Lists from the Feedback module actions menu. 

 2. At List Type, select Categories. 

 3. Click the Delete  button beside the category to be deleted. This displays the message "Are You Sure You Wish To Delete 
This Item?" 

 4. Click the OK button.

 5. Repeat Steps 3-4 to delete additional categories. 

 6. Click the Return to Module link to return to the module. 

Adding Feedback Subjects
How to add subjects to a Feedback module. Once you have created subjects they can either be associated with one or more instances of 
a Feedback module, or users can be enabled to select a subject from a list when sending their feedback.

 1. Select Feedback Category/Subject Lists from the Feedback module actions menu. 

 2. At List Type, select Subjects. 

 3. In the Name text box, enter the subject name. E.g. Feedback 

 4. In the Value text box, enter a value for this subject. E.g. Feedback. This value can optionally be displayed in the Feedback Com-
ments module beside any feedback associated with this subject.  

 5. At Is Active, check  the check box if this category will show up in the category list on the Feedback module - OR - Uncheck 
 if this category is currently inactive. 

 6. Click the Save link. The saved subject will be displayed to the left.



 7. Repeat Steps 3-6 to add additional subjects. 

 8. Click the Return to Module link to return to the module.

Editing Feedback Subjects
How to edit subjects on the Feedback module.

 1. Select Feedback Category/Subject Lists from the Feedback module actions menu. 

 2. At List Type, select Subjects. 

 3. Click the Edit  button beside the subject to be edited. 

 4. Edit the subject fields as required. 

 5. Click the Save link. The edited subject is displayed to the left.

 6. Repeat Steps 3-5 to edit additional subjects. 

 7. Click the Return to Module link to return to the module.

Re-ordering Feedback Subjects
How to re-order subjects on the Feedback module. Feedback subjects are listed in the order in which they are created.

 1. Select Feedback Lists from the Feedback module actions menu. 

 2. At List Type, select Subjects. 

 3. Click the Up  or Down  button beside a subject to move it up or down one position in the list.



 4. Repeat Steps 3 to re-order additional subjects. 

 5. Click the Return to Module link to return to the module. 

Activating/Deactivating Feedback Subjects
Feedback subjects can be set as active or inactive. Active subjects are listed on the Settings page, whereas deactivated subjects are not 
listed on the settings page and are only visible to Administrators on the Feedback Lists page.

 1. Select Feedback Lists from the Feedback module actions menu. 

 2. At List Type, select Subjects. 

 3. Click the Edit  button beside the subject to be activated or deactivated. 

 4. At Is Active, select from the following options: 

 l Check  the check box to activate the subject. 

 l Uncheck  the check box to deactivate the subject.

 5. Click the Save link. 

 6. Repeat Steps 3-5 to activate or deactivate additional subjects. 

 7. Click the Return to Module link to return to the module.

Deleting Feedback Subjects
How to permanently delete subjects from the Feedback module. As an alternative to deleting a feedback subject, you can deactivate it.



 1. Select Feedback Lists from the module actions menu. 

 2. At List Type, select Subjects. 

 3. Click the Delete  button beside the subject to be deleted. This displays the message "Are You Sure You Wish To Delete This 
Item?" 

 4. Click the OK button.

 5. Repeat Steps 3-4 to delete additional subjects. 

 6. Click the Return to Module link to return to the module.

Moderate Feedback Posts
Moderating Pending Feedback Posts
How to moderate and edit feedback submitted using the Feedback module. This enables you control which feedback comments are dis-
played in the Feedback Comments module. 

Note: Posts which are displayed in the Pending Feedback section of the Moderate/Manage Feedback Posts page can consist of these 
feedback posts:

 l When all categories are moderated, then all unmoderated posts are added to the Pending Feedback section of the Mod-
erate/Manage Feedback Posts page.

 l When one or more categories are unmoderated, posts from these categories can be set to appear in any section as desired. This 
means that newly submitted posts which are not associated with a moderated category may never appear in the Pending Feed-
back section. See "Configuring Moderation and Feedback Management Settings"

Here's how to moderate posts:

 1. Select Feedback Moderation/Management from the Feedback module actions menu.

 2. Optional. In the Pending Feedback section, click the Print  button beside a feedback post to view a print friendly version of 
this post. You can then select the print option on your Web browser to print a hard copy.

 a. Click the Return button to return.



 3. Optional. Click the Edit  button beside a feedback post to edit the subject or message.

 a. In the Subject text box, edit the subject as required.

 b. In the Message text box, edit the message as required.

 c. Click the Update  button to save and return.

 4. In the Pending Feedback section, click on one of the following links beside the feedback to be moderated: 

 l Click the Publish link to publish feedback on the Feedback Comments module. The feedback will be viewable by all 
users authorized to view the associated Feedback Comments module. 

 l Click the Set Private link to set feedback as private. Private feedback is not published on the Feedback Comments mod-
ule and is only viewable in the Private Feedback section of this page. 

 l Click the Archive link to archive feedback. Archived feedback is not published on the Feedback Comments module and 
is only viewable in the Archived Feedback section of this page. 

 l Click the Delete button to permanently delete this feedback. This displays the message "Are You Sure You Wish To 
Delete This Item?"    

 i. Click the OK button to confirm deletion.

 5. Repeat Steps 2-4 to moderate additional feedback.

 6. Click the Return to Module link to return to the module.



Moderating pending feedback

Reclassifying Moderated Feedback
How to reclassify feedback submitted using the Feedback module. This enables you to set any feedback comments that have already 
been moderated as visible or not visible in the Feedback Comments module.

 1. Select Feedback Moderation from the Feedback module actions menu.

 2. Optional. Check  the Show feedback only in unmoderated categories check box to limit feedback displayed to unmoderated 
categories only. This is useful if you wish to check the integrity of unmoderated categories.

 3. Locate the feedback post to be reclassified and click one of these links: 

 l Click the Publish link to publish the feedback on the Feedback Comments module. 

 l Click the Set Private link to set feedback as private. Private feedback is not published on the Feedback Comments mod-
ule and is only viewable in the Private Feedback section of this page. 

 l Click the Archive link to archive feedback. Archived feedback is not published on the Feedback Comments module and 
is only viewable in the Archived Feedback section of this page.



 4. Click the Return to module link to return to the module.

Settings
Setting Feedback Permissions
How to set the roles and users who are able to manage subject and category lists, and or moderate post for the Feedback module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Permissions tab.

 3. In the Moderate Feedback Posts column, check  the check box for each role and each user authorized to moderate feed-
back. 

 4. In the Manage Feedback Lists column, check  the check box for each role and each user authorized to manage feedback 
lists.



 5. Click the  Update link.

Related Topics:

 l See "About Module Permissions"

Configuring Email Addresses and Options Settings
How to configure the optional email addresses and user roles who will receive feedback, as well as other email options using the Feed-
back module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feedback Settings tab. 

 3. Go to the Email Addresses and Options Settings section.

 4. In the Send To text box, enter the email address of the recipient of feedback sent from this module.

 5. At Send To User  Roles, check  the check box beside each  security roles whose users are to be recipients of the feedback.

 6. In the Send From text box, enter the email address to be used as the default From email address. The email address set at this 
field overrides the one entered by the user in the Email field on the feedback form. This value is not displayed to users. This set-
ting is useful if you find feedback is being blocked by Spam filters.

 7. At Send Copy, check  the check box to send a copy of the message to the sender - OR - Uncheck  the check box to disable 
this feature. If this option is unchecked, skip to Step 9.

 8. At Can Opt Out, check  the check box to display the Send Copy? check box on the Feedback module that enables users to 
opt out of receiving a copy of their message by email - OR - Uncheck  the check box to remove the opt out option 
and automatically send a copy to the sender.



 9. At Send Email Asynchronously, select from these options:

 l Check  the check box to send email asynchronously. Emails are sent as a background task. This can be useful it feed-
back is emailed to a large number of recipients.

 l Uncheck  the check box to send emails immediately.

 10. Click the  Update link.

Configuring Feedback Category Settings
How to configure the option category settings for the Feedback module. 

Tip: One or more categories must be created prior to configuring these settings. See "Adding Feedback Categories"

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feedback Settings tab. 

 3. Maximize  the Feedback Category Settings section.

 4. At Category, select the category associated with this module. This displays the selected category name on the module.  

 5. At Category List Visible, check  the check box to enable users to select an alternative category - OR - Uncheck  the check 
box to disable category selection.

 6. At Use Category Value as Send To, check  the check box to use the category value as the email address of the recipient of 
this message. Where no email address exists in the category value, then the "Send To" value is used - OR - Uncheck  the 
check box to disable.



 7. Click the  Update link.

Configuring Form and Fields Settings
How to configure the form and field settings for the Feedback module. 

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feedback Settings tab. 

 3. Maximize  the Form and Fields Settings section.

 4. At Field Label Position, select the position of field names on the form from these options

 l  Same Line As Field

 l Above Field: This option is useful when the Feedback module is located in a narrow pane on the page.

 5. In the Form Width text box, enter a value to set the width of the message window. The default setting is 100%. Note: You can 
enter either a pixel value (E.g. 100) or you can set a percentage value by including the percentage sign (E.g. 100%).

 6. At Subject, select the subject to be associated with feedback sent from this module - OR - Select None Selected if you don't 
want to associate this module with a subject. Select one of the following options: 

 7. At Subject Field Type, select from these options:

 l Drop-Down List: Select to display a drop-down of the active subjects on the form. This enables users to select a subject 
from the list you have created on the Feedback Lists page.

 l Editable Text Box: Select to display a text box where users can edit the subject. Note: Subject will be an optional form 
field.

 l Hidden: Select to hide the subject list. Users can neither select a subject nor enter their own subject.

 8. At Name Field, choose to set the name field as either Required, Optional, or Hidden.

 9. At Street Field, choose to set the street field as either Required, Optional, or Hidden.

 10. At City Field, choose to set the city field as either Required, Optional, or Hidden.

 11. At Region or State Field, choose to set the region or state field as either Required, Optional, or Hidden.

 12. At Country Field, choose to set the country field as either Required, Optional, or Hidden.

 13. At Postal Code Field, choose to set the postal code field as either Required, Optional, or Hidden.

 14. At Telephone Field, choose to set the telephone field as either Required, Optional, or Hidden.

 15. In the Email Validation text box, enter a .NET regular expression to validate email addresses. See "Configuring the Request 
Filter"

 16. In the Postal Code Validation text box, enter a .NET regular expression to validate postal codes. Leave blank to disable postal 
code validation.

 17. In the Telephone Validation text box, enter a .NET regular expression to validate telephone numbers. Leave blank to disable tel-
ephone number validation.

 18. In the Message Rows text box, enter a value to set the number of rows for the message window. The default is 20 rows.



 19. Click the  Update link.

Tip: You can reset default value for any of the validation fields by clicking the Reset Default button.

Configuring Submission and Security Settings
How to submission settings and optionally enable CAPTCHA security on the Feedback module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feedback Settings tab. 

 3. Maximize  the Submission and Security Settings section.

 4. At Captcha Visibility, set when or if the Security Code field is displayed on the Feedback module (as shown in the below image). 
CAPTCHA  requires users to enter the displayed code in order the submit feedback. Select from these options:

 l All Users:   CAPTCHA is displayed to all users.

 l Anonymous Users Only: CAPTCHA is displayed to anonymous users only.

 l Disabled: CAPTCHA is disabled.



 5. At Repeat Submission Filter, select the type of filtering used to limit repeat submissions by the same user. The following options 
are available:

 l No Filtering: Skip to Step 7.

 l DotNetNuke User ID: Do not filter by DotNetNuke UserID if anonymous users are allowed to submit feedback. Filtering by 
User IP Address may block legitimate uses behind proxy or firewall sharing same IP.

 l User IP Address

 l User Email Address

 6. In the Minimum Submission Interval text box, enter the time (in minutes) the same user must wait before submitting additional 
feedback. The default setting is 0.

 7. At Redirect To Page, select the page users are redirected to upon submitting feedback. This allows you to create a custom expe-
rience for your users - OR - Select <None Specified> for no redirect page.

 8. Click the  Update link.

Configuring Moderation and Feedback Management Settings
How to configure the moderation and feedback management settings of the Feedback module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Feedback Settings tab. 

 3. Maximize  the Moderation and Feedback Management Settings section.

 4. At Scope, select the scope of moderation from these options:

 l Instance (for this Feedback module only): Feedback  moderators can only view and manage feedback associated 
with this instance of  the Feedback module.

 l Portal (across all Feedback modules of portal): Feedback  moderators can view and manage feedback for all 
instances of the Feedback module on this  site. This option should  be used with caution. 

 5. At Moderated, select from these options:

 l Check  the check box to enable moderation. This displays the list of the current categories for this module.

 i. Optional. Select one or more categories to limit moderation to those categories. If no categories are selected, 
then all categories are moderated.



 ii. At Unmoderated Category Status, select the status for unmoderated posts when not  all categories are mod-
erated. The available options are: Archived, Pending,  Private, Published, or Deleted.

 l Uncheck  the check box to disable moderation.

 6. In the Print Template text box,  view and/or edit the HTML template used for printing a single feedback item from the mod-
eration/management control. You may use the same field value tokens as those available in the guest book settings. For exam-
ple, the token [Feedback:Subject] will be replaced with the feedback Subject field value. Note: You can reset the default 
template by clicking the Reset Default button.

 7. At Print Action, select to display print results either In-Line (Existing Page) or in a Popup (New Window). This setting relates to 
the Print button which can be selected when moderating feedback.

 8. Click the  Update link.

File Manager
About the File Manager Module
The File Manager Module enables the management of files on this site. This module allows authorized users to upload new files, down-
load files, delete files, and synchronize the file upload directory. It also provides information on the amount of disk space used and avail-
able. This administration module  can be added to any site page, and is also displayed on the Admin and Host menus.



The File Manager Module - Community Edition



The File Manager Module - Professional Edition

Getting Familiar with the File Manager Module
Here's an overview of the different areas of the File Manager:

Folders Toolbar: Located at the very top of the File Manager, this toolbar enables the management of folders, as well as file syn-
chronization. The Folders Toolbar includes the following tools: 

 l  Add Folder:                         See "Adding a New Folder"

 l  Delete Folder: See "Deleting a Folder"

 l  Synchronize Files /  Recursive: See "Synchronizing Files within a Folder"



Files Toolbar: Located below the Folders toolbar, this toolbar enable management of files within the selected folder. The File Toolbar 
includes the following tools:

 l  Refresh: See "Refreshing All Files within a Folder"

 l  Copy Files: See "Copying Files"

 l  Move Files: See "Moving Files"

 l  Upload: See "Uploading Files" or "Uploading Multiple Files"

 l  Delete Files:                         See "Deleting Multiple Files"

 l  Filter: See "Filtering Files"

Folder Explorer: Located on the left of the File Manager, the Folder Explorer enables users to navigate to folders using a hierarchical 
structure (See "Navigating to and Selecting Folders" as well as folder synchronization (See "Synchronizing Folders").

Files Window: This central window lists files within the selected folder. Note: Use the Files Navigation bar to access files not displayed 
(See "Navigating to Files"). This section provides the following options:

 l  Rename File: See "Renaming a File" as well as editing file properties. See "Setting the Read Only Property of a File", See "Set-
ting the Hidden Property of a File", or See "Setting the Archiving and Indexing Property of a File"

 l  Delete File: See "Deleting a File"

 l  Select All: Click to select all files; or  UnSelect All: Click to unselect all files. 

 l  Select File: Select one or more individual files to perform any of the above tasks on the Files Toolbar. 

 l  Unzip File: See "Unzipping Compressed Files"



Files Navigation Bar: This bar provides navigation and file display tools. It displays the Page [Page Number] of [Number of Pages]: ena-
bles the user to scroll through files when there are more items than displayed on one page. E.g. Page 1 of 5.

Folder Information Bar: This information bar is located below the Folder Explorer and provides details related to the File Manager. The 
following information is displayed from left to right:

 l Folder Address 

 l Used and Available Space 

 l Items Per Page: Select the number of Items (files) displayed in the Files Window. The default setting is ten (10) and this setting 
defaults back to ten (10) when the page is refreshed. Other options are: 15, 20, 30, 40, and 50.

Folder Security Settings: This section enables Administrators to control security role access to each folder. Three basic levels of per-
mission are available in DNN Community Edition (Open Files in Folder, Browse Files in Folder, and Write to Folder). DNN Professional 
Edition provides seven types of permission (Browse, Folder, View, Add, Copy, Delete, Manage Settings, and Full Control)



Folder Security Settings - Community Edition

Folder Security Settings - Professional Edition

All Users
Navigating to and Selecting Folders
How to navigate to and select a folder with the File Manager module.



 l View Child Folders: Click the Maximize  button beside a folder to view its child folders. 

 l Hide Child Folders: Click the Minimize  button beside a folder to close it and hide its child folders. 

 l Select Folder: Click on a folder name to select it. This highlight the selected folder name and displays the associated files in the 
Files Window.

Synchronizing Folders
How to synchronize the folders of the File Manager module. Synchronizing ensures the folders listed match the folder structure within 
the database. Use this feature when folders are uploaded using FTP directly to the database.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Click the  Synchronize Folders button located in the title bar of the Folder Explorer. The Folder Explorer is minimized when 
synchronization is completed.

Synchronizing Folders

Navigating to Files
By default the File Manager displays the first ten (10) files within the selected folder inside the Files Window. When there are more than 
ten (10) files, the following options are displayed enabling you to navigate to the additional files as well as change the default number of 
files displayed.

 l Page 1 of 4: If there is more than one page of files associated with the selected folder, the number of pages and the page number 
of the current page will be displayed along with the Items Per Page tool.

 l Page Navigation: The following navigation buttons are displayed. 

 l  Move First: Displays the first page of files.

 l  Move Previous: Displays the previous page of files.



 l  Move Next: Displays the next page of files.

 l  Move Last: Displays the last page of files.

 l Items Per Page: Select a number to change the number of files displayed in the Files Window. This setting will default to ten (10) 
whenever the File Manager is refreshed. Important. When performing a task against multiple files, use this feature to enable you 
to select up to 50 items at one time, rather than the 10 items which are displayed by default.

Selecting Items Per Page

Filtering Files
How to filter the files using the File Manager module. This will display only files which match the entered criteria and which are in the 
selected folder. The filter is applied to both the file name and the file extension. 

Tip: You must remove the filter to view all files again. Do this by deleting the filter criteria from the text box and clicking the Filter but-
ton.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the required folder. See "Navigating to and Selecting Folders"

 3. Go to the Files Toolbar and enter the filter criteria into the text box. 

 4. Click the Filter  button. This filters the files displayed in the Files Window so only files containing the filter criteria are dis-
played.



Filtering Files

Refreshing All Files within a Folder
How to refresh the files within a selected folder of the File Manager module.  This task refreshes the file information in the database to 
match the files on the server. This may be required if files have been uploaded via FTP.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the required folder. See "Navigating to and Selecting Folders"

 3. Click the  Refresh button to refresh files.

Refreshing Files

Reordering Files
How to reorder the files displayed in the Files Window of the File Manager module. Files can be ordered in either ascending or descend-
ing order by  the File Name, Date or Size columns.

 1. In the Title Bar of the Files Window, click on a column title (I.e. File Name, Date, or Size) to order files in ascending order by that 
field.

 2. Optional. Click the same column title again to a second time to reorder files in descending order.



Ordering Files by Size

Downloading a File
How to download a single file from the File Manager. 

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder containing the file to be downloaded. See "Navigating to and Selecting Folders"

 3. Click the linked file name.

 4. Save the file to your computer.



Module Editors
Overview of Folder Types
There are three (3) folder types which are included with DNN by default. These folder types come as standard with DNN Community Edi-
tion. The DNN Professional Edition and DNN Enterprise Editions also allow you to add Cloud based folder types located on Amazon's S3 
service and Microsoft's Azure Service.

To view the Folder Types:

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Select  Manage Folder Types from the module actions menu.

The Folder Type Definitions Page

Adding an Amazon S3 Folder Type
How to add an Amazon Simple Storage Service (Amazon s3) folder type to the File Manager. This enables you to store your files on the 
Amazon cloud using the paid Amazon S3 service.

Prerequisites. You must first sign up for an Amazon S3 account. For details and to sign up, go to http://aws.amazon.com/s3. 

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Select  Manage Folder Types from the module actions menu.

http://aws.amazon.com/s3


 3. Click the Add New Type button.

 4. Go to the General Settings section.

 5. In the Name text box, enter a name for the new provider. This name will show up in the File Manager as a Folder Type when you 
add new folders.

 6. At Folder Provider, select AmazonS3FolderProvider from the drop-down list. This displays the Folder Provider Settings section.

 7. Go to the Folder Provider Settings section.

 8. In the AccessKeyID text box, enter the key for your service.

 9. In the SecretAccessKey text box, enter the secret key for your service.

 10. At Bucket Name, select <Refresh> from the drop-down list. This populates the list with the bucket available for you to store files 
in.

 11. At Bucket Name, select the bucket you want to store the files in.



 12. Click the Update button. This returns to the Folder Types list and displays the new Amazon S3 Folder Provider.

Adding a Windows Azure Folder Type
How to add a Windows Azure  folder type to the File Manager. This enables you to store your files on the Windows Azure cloud which is a 
paid service.

Prerequisites. You must create a Windows Azure account. For details and to sign up, go to http://ww-
w.microsoft.com/windowsazure/storage. 

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Select  Manage Folder Types from the module actions menu.

http://www.microsoft.com/windowsazure/storage
http://www.microsoft.com/windowsazure/storage
http://www.microsoft.com/windowsazure/storage


 3. Click the Add New Type button.

 4. Go to the General Settings section.

 5. Click the Add New Type button.

 6. In the Name text box, enter a name for the new provider. This name will show up in the File Manager as a Folder Type when you 
add new folders.

 7. At Folder Provider, select AzureFolderProvider from the drop-down list. This displays the Folder Provider Settings section.

 8. In the Account Name text box, enter your account name.

 9. In the Account Key text box, enter the account key for your service.

 10. At Container Name, select <Refresh> from the drop-down list. This populates the list with the bucket available for you to store 
files in.

 11. At Container Name, select the container you want to store the files in.



 12. Click the Update button. This will now take you back to the Folder Types list and show the new Azure Folder Provider.

Folder Editors
Uploading Files
How to upload one or more individual files or a zipped (compressed) file to the File Manager module. These files can then be viewed 
using various modules such as Links, Media, HTML/HTML Pro, etc. Users require the following minimum permissions to complete this 
task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file will be uploaded to.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Add permission for the folder 
where the file will be uploaded to.



 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select a folder that you are authorized to upload files to. See "Navigating to and Selecting Folders"

 3. Click the  Upload button located on the Files toolbar. This opens the File Upload page.

 4. Click the Browse... button and select a file from your computer.

 5. Optional. At the drop-down box, change the folder which the file will be uploaded to. The default selection is the folder you 
chose at Step 1.

 6. Optional. At Decompress ZIP Files?, select from the following options if you are uploading a zip file that you wish to decom-
press (unzip) during upload.

 l Check  the check box to decompress the files while uploading them. This adds both the ZIP file and all the individual 
files to the selected folder. 

 l Uncheck  the check box to upload the file as a zipped folder. You can unzip the files at a later time if required. See 
"Unzipping Compressed Files"

 7. Click the  Upload File link. If upload is successful, the [FileName] Uploaded Successfully message is displayed.



 8. Repeat Steps 4-7 to upload additional files - OR -              Click the  Return link to return to the module.

Related Topics:

 l See "Uploading Multiple Files"

Unzipping Compressed Files
How to decompress a zipped folder of files (compressed files) within the File Manager module. Users require the following minimum per-
missions to complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located as well as the destination folder.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Add permission for the folder 
where the file is located as well as the destination folder.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the Folder containing the file to be unzipped. See "Navigating to and Selecting Folders"

 3. Click the Unzip File  button beside the file to be decompressed. This displays the message asking "UnZip Files(s): [File-
Name]?" 



 4. Click the OK button to confirm. This displays a message asking you to select the destination folder from the Folder Explorer.

 5. Navigate to and select the folder you want to unzip the files to. This displays the Unzip Select Files To message. Note: If you 
wish to unzip the files into the folder where they currently reside, then you must click the folder name twice.

 6. Click the OK         button to confirm. The files are now unzipped in the selected folder. The original zip file is still located in the original 
folder.

Synchronizing Files within a Folder
How to synchronize the files inside one or more folders of the File Manager module. Synchronizing ensures the files listed match the files 
within the database. Use this feature when files are uploaded using FTP directly to the database, or when you wish to refresh the file 
within multiple folders. Users require the following minimum permissions to complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission to 
the required folder.

DNN Professional Edition: Edit Content or Full Control permission for the module (See "Setting Module Permissions") and Manage Set-
tings permission to the required folder.



 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder to be synchronized. See "Navigating to and Selecting Folders"

 3. Optional. At Recursive, check  the check to synchronize all child folders of the selected folder. 

 4. Click the  Synchronize Files button. The Folder Explorer is minimized when synchronization is completed.

Synchronizing Files within the Selected Folders

Selecting Files
How to select one or more files in the File Manager module. Selecting files enables you to perform file management tasks such as copy-
ing and moving files. Users require the following minimum permissions select files:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and View 

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions").

Note: These permissions enable users to select files and perform file refreshing and filtering. Additional permissions are required to per-
form specific tasks.

Here are the options for selecting files:

Select a File: Check  the check box to the right of the file to select it.

Deselect a File: Uncheck  the check box to the right of the file to deselect it.



Select All Files: Check  the check box in the title bar of the Files Window to select all of the displayed files. Important. Use the Items 
Per Page tool if you want to select more files at one time. This enables you to select up to 50 files at one time. See "Modifying Items Per 
Page"

Deselect All Files: Uncheck  the check box in the title bar of the Files Window to deselect all of the displayed files.

Copying Files
How to copy one or more files from one folder to another folder of the File Manager module. Users require the following minimum per-
missions to complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located as well as the destination folder.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Copy permission for the 
folder where the file is located as well as the destination folder.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.



 2. Navigate to and select the folder where the files to be copied are located. See "Navigating to and Selecting Folders"

 3. In the Files Window, check  the check box beside each of the files to be copied - OR - Click the  Select All  button to select 
all of the files displayed in the Files Window. Tip: See "Navigating to Files" to select different or additional files within this folder.

 4. Click the  Copy Files button. This displays the "Copy Checked Files?" message. 

 5. Click the Ok button to confirm. This displays the Copying Files message which lists the names of the files to be copied and 
requests that you select the destination folder.

 6. Navigate to and select the folder you want to copy the files to. Note: Files cannot be copied to the same folder. This displays the 
Copy Selected Files To message which displays the name of the selected folder.

 7. Click the Ok button.

Moving Files
How to move one or more selected files from one folder into another folder within the File Manager module. Users require the following 
minimum permissions to complete this task:



DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located as well as the destination folder.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Copy permission for the 
folder where the file is located as well as the destination folder.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder where the files to be moved are located. See "Navigating to and Selecting Folders"

 3. In the Files Window, check  the check box beside each of the files to be moved - OR - Click the  Select All   button to select 
all of the files displayed in the Files Window.  Tip: See "Navigating to Files" to select different or additional files within this folder.

 4. Click the  Move Files button. This displays the "Move Checked Files?" message. 

 5. Click the Ok button to confirm. This displays the Moving Files message which lists the names of the files to be moved and 
requests that you select the destination folder.

 6. Navigate to and select the folder you want to move the files to. Note: Files cannot be moved to the same folder. This displays the 
Moving Selected Files To message which displays the name of the selected folder.

 7. Click the Ok button.



Deleting a File
How to permanently delete a single file from the File Manager module. Users require the following minimum permissions to complete this 
task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located.

DNN Professional Edition: Edit Content permission for the module (See "Setting Module Permissions") and Manage Settings permission 
for the folder where the file is located.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder containing the file to be deleted. See "Navigating to and Selecting Folders"

 3. In the Files Window, navigate to the required file. See "Navigating to Files"

 4. Click the Delete File  button beside the file to be deleted. A message asking "Are You Sure You Wish to Delete The File [ File-
Name ]?" is displayed. 

 5. Click OK to confirm deletion.

Deleting a File

Deleting Multiple Files
How to permanently delete multiple files from the File Manager module. Users require the following minimum permissions to complete 
this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located.



DNN Professional Edition: Edit Content permission for the module (See "Setting Module Permissions") and Full Control permission for 
the folder where the file is located.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder containing the files to be deleted. See "Navigating to and Selecting Folders"

 3. In the Files Window, display the required files. See "Navigating to Files"

 4. Check  the check box beside each of the files to be deleted - OR - Click the Select All  button to select all of the files cur-
rently displayed in the File Window.  Tip: See "Navigating to Files" to select different or additional files within this folder.

 5. Click the  Delete Files button. This displays the Delete Files message which lists the files selected for deletion.

 6. Click the OK button to confirm.

Adding a New Folder
How to add a new folder to the File Manager module. The new folder will inherit         the permissions assigned to its parent folder.     

Permissions. Users require these minimum permissions:

In DNN Community Edition, Edit Content permission for the module and Write         to Folder permission for the folder which will be the parent 
of the new folder.

In DNN Professional Edition, Edit Content permission for the module and Add         permission for the folder which will be the parent of the 
new folder.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager -             OR - Select              File Manager from the Admin section             of 
the Control Panel.

 2. Navigate to and select the folder which will be the parent for the new folder.             See "Navigating to and Selecting Folders"



 3. On the Folders Toolbar, select one of the following options from the Foldersdrop-down list:             

 l Standard - File System: Select this option to store most of your files. This                     is the default option.

 l Secure - File System: Select this option if you want to encrypt the file                     name to prevent direct linking to this file.

 l Secure - Database: Stores files as a byte array in the database rather than                     in the usual file system.

 l Amazon Folder Provider:Stores files on the Amazon service. Only available in Professional and Enterprise Editions.                     

 l AzureFolder Provider: Stores files on the Azure service. Only available in Professional and Enterprise Editions.                     

 4. In the Folders text box, enter a name for the new folder.

 5. Click the              Add                     Folder button. This displays the new folder in the Folder Explorer.



The Newly Added Folder displayed in the Folder Explorer

Deleting a Folder
How to permanently delete empty folders from the File Manager. Users require the following minimum permissions to complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder to be deleted.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Delete permission for the 
folder to be deleted.

Tip: A folder cannot be deleted if it has any child folders, or if it contains any files. If you wish to keep files which are located within a 
folder which you are about to delete, you can move them to another folder. 

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder to be deleted. See "Navigating to and Selecting Folders"

 3. Click the  Delete Folder button. This displays the message "Delete Folder: [Folder Location:Folder Name]?"

 4. Click the OK button to confirm deletion.



Deleting a Folder from the File Manager

Renaming a File
How to rename a file in the  File Manager module. Users require the following minimum permissions to complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Manage Settings permission 
for the folder where the file is located.

Warning. Renaming a file does not update any other references to this file across your site. E.g. If the file is an image displayed in the 
HTML / HTML Pro module, then the path to the image will be broken and you are required to manually update the image. As such, it is 
recommended that you only rename a file when it is first uploaded and has yet to be used on the site.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Click the Rename File  button beside the file to be renamed.

 3. In the File Name text box, enter a new name for the file.

 4. Click the Save Changes  button to save your changes.

Renaming a File

Setting the Read Only Property of a File
How to set the read only property of a file in the File Manager module. Users require the following minimum permissions to complete this 
task:



DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Manage Settings permission 
for the folder where the file is located.

Tip: Setting a file as Read Only does not prevent it from being deleting.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Locate the required file. See "Navigating to Files"

 3. Click the Rename File  button beside the file to be edited. 

 4. At the R check box, select one of the following options: 

 l Check  the check box to set the file as read only. 

 l Uncheck  the check box to remove the read only property from the file.

 5. Click the Save Changes  button to save your changes - OR - Click the Cancel Rename  button to cancel.

 
Setting a file as read only

Tip: The letter R is displayed beside files set as Read Only.

Setting the Hidden Property of a File
How to set the hidden property of a file in the File Manager module. Hidden files don't display on your site in modules such as the Media 
and HTML / HTML Pro modules, they are also not displayed on vendor banners, nor are they displayed for selection on RTE galleries. 
Users require the following minimum permissions to complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Manage Settings permission 
for the folder where the file is located.

An Image Set as Hidden isn't displayed in the HTML module 



The Image displays once the Hidden property is removed

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Locate the required file. See "Navigating to Files"

 3. Click the Rename File  button beside the file to be edited. 

 4. At the H check box, select one of the following options: 

 l Check  the check box to set the file as hidden. 

 l Uncheck  the check box to remove the hidden property from the file.



 5. Click the Save Changes  button to save your changes - OR - Click the Cancel Rename  button to cancel.

Tip: The letter H is displayed beside files set as Hidden.

Setting the Archiving and Indexing Property of a File
How to set the archiving and indexing properties of a file within the File Manager. Users require the following minimum permissions to 
complete this task:

DNN Community Edition: Edit Content permission for the module (See "Setting Module Permissions") and Write to Folder permission for 
the folder where the file is located.

DNN Professional Edition: Edit Content  permission for the module (See "Setting Module Permissions") and Manage Settings permission 
for the folder where the file is located.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Locate the required file. See "Navigating to Files"

 3. Click the Rename File  button beside the file to be edited.  



 4. At the S check box, select from these options:

 l Check  the check box to disable hidden option in file properties (Windows). For fast searching, allow Indexing Serv-
ice to index this file. 

 l Uncheck  the check box to remove this file property.

 5. At the A check box, select from these options: 

 l Check  the check box to allow file to be archived by the operating system. This is the default option. 

 l Uncheck  the check box to remove this file property.

 6. Click the Save Changes  button to save your changes - OR - Click the Cancel Rename  button to cancel.

Set archiving and indexing for a file

Tip: The letters S and A are displayed beside the selected files if these options are set./or 

Administrators
Overview of Folder Security Settings
The File Manager module enables authorized users to manage access to one or more folders within the File Manager by setting Folder 
Security Settings. Here's a description of the different permissions which can be set:

Community Edition Permissions

 l Open Files in Folder: Enables authorized users to view the files within this folder which are displayed or linked to on the site. All 
Users are granted this permission by default.

 l Browse Files in Folder: Enables authorized users to browse and select the files within this folder. Users are granted permission 
to their personal folder only by default. This enables them to manage their profile image, etc.

 l Write to Folder: Enables authorized users to perform all file management tasks for files within this folder.



Professional Edition Permissions

 l Browse Folder: Enables authorized users to browse and select the files within this folder. Users are granted permission to their 
personal folder only by default. This enables them to manage their profile image, etc.

 l View: Enables authorized users to view the files within this folder which are displayed or linked to on the site.  All Users are 
granted this permission by default.

 l Add: Enables authorized users to add folders and documents beneath (as child folders) this folder.

 l Copy: Enables authorized users to copy files to and from this folder.

 l Delete: Enables authorized users to delete a folder and/or its child folders.

 l Manage Settings: Enables authorized users to manage folder settings.

 l Full Control: Provides authorized users with full control to perform all file and folder management task within the selected folder.



Related Topics:

 l See "Adding a New Folder"

 l See "Assigning Folder Permissions to a User"

 l See "Assigning Folder Permissions by Role"

Assigning Folder Permissions by Role
How to assign permissions to manage a folder of the File Manager to users with one or more roles.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder to have permissions assigned. The name of the selected folder is displayed in the Folders Infor-
mation Bar. 

 3. Go to the Folder Security Settings section. The current permission settings are displayed. 

 4. Optional. At Permissions, select < All Roles > from the Filter By Group drop-down box (if displayed) to view all available roles. 

 5. Check  the check box in one or more columns to grant permissions to that role. See "Overview of Folder Security Settings"

 6. Click the  Update link.

Assigning Folder Permissions to a User
How to assign access to view folders and upload to folders of the File Manager module.

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder to have permissions assigned. The name of the selected folder is displayed in the Folders Infor-
mation Bar. 



 3. Go to the Folder Security Settings section. The current permission settings are displayed. 

 4. At Permissions, enter the username of the user into the Username text box. 

 5. Click the Add link. This adds the user's name to the Permission role list. 

 6. Check  the check box in one or more columns beside this user's name to grant them folder permissions. See "Overview of 
Folder Security Settings"

 7. Repeat Step 4-6 for to assign folder permission to additional users.

 8. Click the  Update link.

Removing Folder Permissions
How to remove permission to view files within a folder and/or to write to a folder of the File Manager module. 

 1. Go to a File Manager module - OR - Navigate to Admin > File Manager - OR - Select  File Manager from the Admin section of 
the Control Panel.

 2. Navigate to and select the folder to have permissions assigned. The name of the selected folder is displayed in the Folders Infor-
mation Bar. 

 3. Go to the Folder Security Settings section. The current permission settings are displayed. 

 4. Optional. At Permissions, select < All Roles > at the Filter By Group drop-down box (if displayed) to display all of the roles.

 5.  Uncheck  the check box beside in one or more columns to remove that permission. See "Overview of Folder Security Set-
tings"

 6. Click the  Update link.

Form And List
About the Form And List Module 
The Form And List module enables the creation of a list or a form which can be populated with data.  The module can also display a form 
with results displayed in a list on the same page. Data types are: Text, Rich Text (HTML), Integer, Decimal, Date and Time, Date, Look-
Up, Time, True/False, Email, Currency, URL, Image, Download, Calculated Column, and User Profile Link. List columns can be set as 
required (must be completed to save the row), as visible to all users or visible to Administrators only, and as searchable.

Module Version: 05.01.03

Minimum DNN Version: 05.01.03

Features: IPortable, ISearchable



The Form & List Module configured to display as a Form

The Form & List Module configured to display as a List

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleUserDefinedTable/tabid/877/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/56/scope/threads/Default.aspx

 l Issue Tracker: http://dnnfnl.codeplex.com/workitem/list/basic

 l Advanced User Documentation:  http://dnnfnl.codeplex.com/releases/view/38489

http://www.dotnetnuke.com/Products/Development/Forge/ModuleUserDefinedTable/tabid/877/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/56/scope/threads/Default.aspx
http://dnnfnl.codeplex.com/workitem/list/basic
http://dnnfnl.codeplex.com/releases/view/38489


Configuration
Advanced Column Options
Advanced Calculated Column Options
How to configure the optional Advanced Column Options for calculated columns for a form or list in the Form & List module. This topic  
assumes you are currently adding or editing a calculated column. See "Creating a List", See "Creating a Form" or See "Editing List or 
Form Columns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At Data Type select the result type from one of the following options: 

 l Date and Time

 l Decimal

 l Integer

 l Text (This is the default setting) 

 l True/False

 3. In the Output Format text box, enter an output format string suitable for this data type. E.g. "###.###". 

 4. In the Expression text box, enter an expression formula (appropriate for the data type) which will be evaluated at runtime. See 
MSDN Library for more on expressions.

 5. At Show on Edit Form?, check  the check box to display to all users when editing - OR - Uncheck  to disable.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting a Calculated column

Tip: In the above image, the columns of this list have been set so that users enter the Product Number and the Product Category data 
into separate fields, however the information is displayed as a truncated code on the list by using a Calculated Column.

The Calculated Column is displayed on the Edit Record page once it has been updated



The Calculated Column Displayed in a List

Advanced Currency Column Options                            
How to configure the optional Advanced Column Options for currency columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a currency column. See "Creating a List", See "Creating a Form" or See "Editing List or Form 
Columns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following: 

 a. In the List of Values text box, enter one or more values separated by a semi-colon ( ; ). E.g. 
10;10.50;20;20.50;30;30.50 - OR - Leave this field blank to display a text box in which any value can be 
entered.       

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a 
lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Currency Symbol text box, enter the currency symbol that you want to display in the Table. E.g. $. Leave this field blank to 
display the currency as set under Site Settings. E.g. USD. 

 4. In the Default Value text box, enter the default currency value for this field. When creating a new row this value will automatically 
be selected or entered. 

 5. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 6. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule. 

 7. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 8. In the Help Text text box, enter a help message to assist users when they add and manage data for this column.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting the Advanced Options for a Currency column

Adding a currency record to a list on the Edit Record page



The currency column with the currency symbol set as displayed in a list

Advanced Date and Time Column Options
How to configure the optional Advanced Column Options for date and time columns for a form or list in the Form & List module. This tuto-
rial assumes you are currently adding or editing a date and time column. See "Creating a List", See "Creating a Form" or See "Editing List 
or Form Columns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. In the Output Format text box, enter the format to set how the column data will be displayed in the table - OR - Leave blank to use 
default format. The following options are available: 

 l f: Enter to display long date and short time. E.g. Thursday, February 21, 2011 8:00 AM 

 l F: Enter to display long date and long time. E.g. Thursday, February 21, 2011 8:00:00 AM 

 l g: Enter to display short date and short time. E.g. 2/21/2011 8:00 AM 

 l G: Enter to display short date and long time. E.g. 2/21/2011 8:00:00 AM 

 l Y: Enter to display year and month. E.g. February, 2011

 3. At Convert TimeZone?, select one of the following options: 

 l Check  the check box to display date/time according to the users' time zone as set in their user profile. 

 l Uncheck  the check box to use default site time zone.

 4. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically populate 
the field, however it can be changed. 

 5. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 6. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule. 

 7. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 8. In the Help Text text box, enter a help message to assist users when entering data for this column.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting the Advanced Options for a Date And Time column

Adding a date and time record to a list on the Edit Record page

The Date and Time field displayed in a List

Advanced Date Column Options
How to configure the optional Advanced Column Options for date columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a date column. See "Creating a List", See "Creating a Form" or See "Editing List or Form Col-
umns"



 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 a. In the List of Values text box, enter a list of dates that can be selected from a drop-down box. E.g. 2008-01-
01;2008-01-15;2008-01-31 - OR - Leave this field blank to display the Calendar link.

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a 
lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Output Format text box, enter the format to set how the column data will be displayed in the table. If no value is selected 
the default setting is used. The following options are available: 

 l d: Enter to display a short date. E.g. 2/21/2008 

 l D: Enter to display a long date. E.g. Thursday, February 21, 2008 

 l M: Enter to display the month and day. E.g. February 21 

 l Y: Enter to display year and month. E.g. February, 2008

 4. In the Default Value text box, enter the default value for this field. E.g. 2000-01-01.  When creating a new row this value will auto-
matically populate the field, however it can be changed. 

 5. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 6. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule.

 7. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 8. In the Help Text text box, enter a help message to assist users when entering data for this column.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting the Advanced Options for a Date column

Adding a date record to a list on the Edit Record page

The Date field displayed in a List

Advanced Decimal Column Options
How to configure the optional Advanced Column Options for decimal columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a decimal column. See "Creating a List", See "Creating a Form" or See "Editing List or Form 
Columns"



 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following: 

 a. In the List of Values text box, enter a list of values that can be selected for this field. Setting this field will remove the 
user's ability to enter other values. E.g. 5;10;15;20;25;30  Note: You can enter values that are not decimals such as 1 or 
2.333. In this case they will display as entered in the drop-down list on the Edit Record page however they will display 
as decimal values in the list - OR - Leave this field blank to enter any decimal values into a text box.       

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Output Format text box, enter a format for this number. E.g. 0.00

 4. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically populate 
the field, however it can be changed. 

 5. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 6. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule. 

 7. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 8. In the Help Text text box, enter a help message to assist users when entering data for this column.

Setting the Advanced Options for a Decimal column

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


The decimal column as displayed on the Edit Record page

The Decimal Column displayed in a List

Advanced Download Column Options
How to configure the optional Advanced Column Options for download columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a download column. See "Creating a List", See "Creating a Form" or See "Editing List or 
Form Columns"

Error: An error occurs when a List Of Values is entered for download columns. It is recommended that Advanced Options are not used.

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 a. In the List of Values text box, enter a list of URL's separated by a semi-colon ( ; ). E.g. http://www-
.ecozany.com/toys.pdf;http://www.ecozany.com/dolls.pdf - OR - Leave this field blank to display the Link Control which 
enables a file to be selected (and uploaded if permissions allow) from the File Manager.        

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Link Caption text box, enter the text that you want to display instead of the Download URL in the table. E.g. Download this 
brochure. This text will display and be a link to the download. 



 4. At Abbreviated URL, select from these options: 

 l Check  the check box to display only the file or page name. E.g. http://www.domain.com/brochures/toys.pdf would 
then display as toys.pdf. 

 l Uncheck  the check box if to display the complete URL. Note: If the Link Caption field is used it will override this field.

 5. In the Default Value text box, enter the default value for this field. When creating a new record this value will automatically be 
selected or entered. 

 6. In the Help Text text box, enter a help message to assist users when entering data for this column.

 Setting the Advanced Options for a Download column

A download column with a Link Caption as displayed in a list

Advanced Email Column Options
How to configure the optional Advanced Column Options for email columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing an email column. See "Creating a List", See "Creating a Form" or See "Editing List or Form 
Columns"



 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 a. In the List of Values text box, enter one or more values for this field separated by a semi-colon ( ; ). E.g. admin@d-
omain.com;sales@domain.com;marketing@domain.com - OR - Leave this field blank to display a text box into which 
any email address can be entered.        

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Link Caption text box, enter the text that you want to display instead of the email address in the Table. E.g. Contact this 
person. This text displays as a mailto link.  

 4. At Disable Hyperlink?, check  the check box to disable the mailto hyperlink and display the email address as static text - OR - 
Uncheck  to enable the mailto hyperlink. Note: If the Link Caption field is used it will override this field and the hyperlink will be 
enabled. 

 5. In the Default Value text box, enter the default value for this field. This email is pre-selected/entered when a new record is 
created. 

 6. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 7. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule.

 8. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 9. In the Help Text text box, enter a help message to assist users when entering data for this column.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting the Advanced Options for an Email column

Adding an email record to a list on the Edit Record page

The email column with a Link Caption  in a list

Advanced Image Column Options
How to configure the optional Advanced Column Options for image columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing an Image column. See "Creating a List", See "Creating a Form" or See "Editing List or Form 
Columns"



 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 a. In the List of Values text box, enter a list of image URL's separated by a semi-colon ( ; ). E.g. http://ww-
w.domain.com/massage.gif;http://www.domain.com/acupuncture.gif - OR - Leave this field blank to display the Link Con-
trol to enable the user to select an image from the File Manager.             

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the ALT Tag text box, enter the text that displays when the user places their mouse over this text.

 4. At Hyperlink, check  the check box to display a thumbnail of the image. The user can then click on the thumbnail to view the 
full sized image- OR - Uncheck  the check box to display the full sized image in the table. 

 5. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically be 
selected or entered. 

 6. In the Help Text text box, enter a help message to assist users when entering data for this column.

Related Topics:            "Configuring Image Column Settings". to configure additional setting for this column type.

Setting the Advanced Options for an Image column

Setting an image to a list on the Edit Record page



The Image Column displayed in a List

Advanced Integer Column Options                               
How to configure the optional Advanced Column Options for integer columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing an Integer column. See "Creating a List", See "Creating a Form" or See "Editing List or Form 
Columns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following: 

 a. In the List of Values text box, enter a list of integers that can be selected for this field. Setting this field will remove the 
user's ability to enter any integer. E.g. 5;10;15;20;25;30. Leave this field blank to display a text box in which any integer 
can be entered rather than a drop-down box.        

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Output Format text box, enter a format for this number. E.g. 0.00

 4. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically populate 
the field, however it can be changed. 

 5. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 6. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule.

 7. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 8. In the Help Text text box, enter a help message to assist users when entering data for this column.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting the Advanced Options for an Integer column

The Integer column on the Edit Record page of a list

The Integer Column displayed in a List

Advanced Look-Up Column Options
How to configure the optional Advanced Column Options for look-up columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a Look-Up column. See "Creating a List", See "Creating a Form" or See "Editing List or Form 
Columns"



 1. Go to the Advanced Column Options section and set any of the following optional fields:

 2. At Source Column, enter the name of the column containing a ref to a user or local file.

 3. In the Token Value text box, enter the token text to query the User or File object. 

 4. At Show on Edit Form?, check  the check box if this value will be displayed to all users when editing - OR - Uncheck  the 
check box to hide the field on the Edit Form.

Tip: In the below example, the Look-Up column is set to display the size of the file selected in the Brochure column.

Setting the Advanced Options for a Look-Up column

The Look-Up Column displayed in a List

Advanced Rich Text (Html) Column Options                       
How to configure the optional Advanced Column Options for Rich Text (Html) columns for a form or list in the Form & List module. This 
tutorial assumes you are currently adding or editing a Rich Text (Html) column. See "Creating a List", See "Creating a Form" or See "Edit-
ing List or Form Columns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At Plain Text Box select from the following options: 

 l Check  the check box to display the plain text box only. The Plain text box will still be multiple lines deep. 

 l Uncheck  the check box to display the RTE as well as the option to switch to the Basic Text Box. 

 3. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically populate 
the field, however it can be edited.

 4. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


 5. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule.

 6. In the Help Text text box, enter a help message to assist users when entering data for this column.

Setting the Advanced Options for a Rich Text (Html) column

Adding Basic Text/Rich Text to a list on the Edit Record page

The Rich Text Column displayed in a List



Advanced Separator Column Options                     
How to configure the optional Advanced Column Options for Separators on a form or list in the Form & List module. This tutorial assumes 
you are currently adding or editing a separator column. See "Creating a List", See "Creating a Form" or See "Editing List or Form Col-
umns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At Acts as Fieldset (applies only to CSS based layout select from the following options: 

 l Check  the check box for greater page accessibility. This creates a fieldset element around the form and uses the title 
of the field as the fieldset legend.

 l Uncheck  the check box to disable.

Setting the Advanced Options for a Separator

Separators  displayed on a Form



Advanced Text Column Options
How to configure the optional Advanced Column Options for Text columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a text column. See "Creating a List", See "Creating a Form" or See "Editing List or Form Col-
umns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2.  At List of Values set the following:

 a. In the List of Values text box, enter one or more values for this field separated by a semi-colon ( ; ). E.g. 
Mr;Mrs;Ms;Miss;Dr. Leave this field blank to display a text box in which any data can be entered.      

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically be 
selected or entered. 

 4. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. 

 5. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule. 

 6. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 7. In the Help Text text box, enter a help message to assist users when entering data for this column.

Setting the Advanced Options for a Text column

Setting text value to a list on the Edit Record page



Text displayed on a Form

Advanced Time Column Options
How to configure the optional Advanced Column Options for Time columns for a form or list in the Form & List module.  This tutorial 
assumes you are currently adding or editing a time column. See "Creating a List", See "Creating a Form" or See "Editing List or Form Col-
umns"

Error: An error occurs when a List Of Values is entered for Time columns. It is recommended that Advanced Options are not used.

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 i. In the List of Values text box, enter a list of times that can be selected. E.g. 12:00:00;12:00:01;                                 

 ii. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of 
values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Output Format text box, enter the format to set how the column data will be displayed in the table. The following options 
are available: 

 l t: Enter to display a short time. E.g. 8:00 AM. 

 l T: Enter  to display  standard format long time - OR - Leave this field blank. E.g. 8:00:00 AM.

 4. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically populate 
the field, however it can be changed. 

 5. In the Validation Rule text box, enter the required input pattern using the "Regular Expression" language. See MSDN Library for 
more on expressions.

 6. In the Validation Message text box, enter the message to be displayed if the value entered is incorrect for the validation rule.

 7. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 8. In the Help Text text box, enter a help message to assist users when they add and manage data for this column.

http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx
http://msdn.microsoft.com/en-us/library/system.data.datacolumn.expression(VS.71).aspx


Setting the Advanced Options for a Time column

Adding a time record to a list on the Edit Record page

Advanced True/False Column Options
How to configure the optional Advanced Column Options for True/False columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a True/False column. See "Creating a List", See "Creating a Form" or See "Editing List or 
Form Columns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. In the Right Label Text text box, enter a label to be displayed to the right of the True/False check box on the form or list.

 3. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically be 
selected or entered. 

 4. In the CSS Style text box, enter the Style which is applied on  text box or list control in form. E.g. width:300px

 5. In the Help Text text box, enter a help message to assist users when they add and manage data for this column.



Setting the Advanced Options for a True/False column

Adding a True/False record to a list on the Edit Record page

The True/False Column displayed in a List

Advanced URL Column Options
How to configure the optional Advanced Column Options for URL columns for a form or list in the Form & List module. This tutorial 
assumes you are currently adding or editing a URL column. See "Creating a List", See "Creating a Form" or See "Editing List or Form Col-
umns"

 1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 a. In the List of Values text box,  enter a list of URL's separated by a semi-colon ( ; ). E.g. s/home.htm;http://ww-
w.domain.com/services.htm.  Alternatively, leave this field blank to display the Link Control which enables any URL, 
Page or File to be selected.          

http://www.domain.com/home.htm
http://www.domain.com/home.htm
http://www.domain.com/home.htm


 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when there are a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Link Caption text box, enter the text that you want to display instead of the URL in the table. E.g. Visit this website. This 
text will then display as a mailto link. 

 4. At Abbreviated URL, check  the check box to display only the file or page name. E.g. 
http://www.domain.com/home.htm would then display as home.htm - OR - Uncheck  the check box if to display the com-
plete URL. Note: If the Link Caption field is used it will override this field. 

 5. In the Default Value text box, enter the default URL value for this field. When creating a new row this value will automatically be 
selected or entered. 

 6. In the Help Text text box, enter a help message to assist users when entering data for this column.

"Configuring URL Column Settings". to  configure additional settings for this column type.

Setting the Advanced Options for a URL column

Adding a URL record to a list on the Edit Record page



The URL column  displayed in a List

Advanced User Profile Link Column Options                          
How to configure the optional Advanced Column Options for Link To User's Profile columns for a form or list in the Form & List module. 
This tutorial assumes you are currently adding or editing a User Profile Link column. See "Creating a List", See "Creating a Form" or See 
"Editing List or Form Columns"

 1.  1. Go to the Advanced Column Options section and set any of the following optional fields: 

 2. At List of Values set the following:

 a. In the List of Values text box, enter one or more usernames separated by a semi-colon ( ; ).  E.g. 
Admin;Jack:Julie;. Where a non-existent username is entered it will not be displayed as an option. Leave this field 
blank to display a text box into which any username can be entered.           

 b. Select how the list options are displayed:

 l Drop Down List: Display values in a drop-down selection list. This is useful when you have a lot of values.

 l Radio Button List (Vertical): Display values in a vertical list with radio buttons.

 l RBL (Horizontal): Display values in a horizontal list with radio buttons.

 3. In the Caption Options text box, enter the text to be displayed as the link for this user on the UDT. HTML formatting is permitted. 
Leave this field blank to display the user's name. Tip: Click the Available Tokens Help link for more.

 4. At Show User's Username Instead of his Displayname, check  the check box to display username - OR - Uncheck  to dis-
play the user's display name.

 5. In the Default Value text box, enter the default value for this field. When creating a new row this value will automatically be 
selected or entered. 

 6. In the Help Text text box, enter a help message to assist users when they add and manage data for this column.

"Configuring  User Profile Link Settings". to configure additional settings for this column type.



Setting the Advanced Options for a User Profile Link column

The Link to User's Profile column as displayed on the Edit Record page

The User Profile field displayed in a List

Column Settings
Configuring Image Column Settings
How to set the width or height of images displayed in the image columns of a list created using the Form & List module.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Maximize  the Column Settings section.

 3. At             Settings for Image Columns set one of the following options: 

 l In the Image Width text box, enter the width that images are displayed in image column. Larger or smaller images will 
be scaled accordingly. 



 l In the Image Height text box, enter the height that images are displayed in image column. Larger or smaller images will 
be scaled accordingly. If the Image Width field is set it will override this field rather than both dimensions being used.

 4. Click the Save Configuration and Return link to save this setting and return to the module.

Configuring Image Column Settings

Configuring URL Column Settings
How to set URL columns in the Form & Lists module to display in the same or a new Web browser window.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Maximize  the Column Settings section.

 3. At Settings for URL Columns, set the following: 

 a. At Show "Open Link in new Browser Window"? check  the check box open URL links in a new Web browser win-
dow - OR - Uncheck  the check box to display in the same window. 

 b. At Force Download,  check  the check box to force the download of the resource - OR - Uncheck  the check box for 
optional download.

 c. At Url Optimization, select from these options:

 l Track Number Of Times URL's Are Clicked: Select to enable the Link Click log for URL's. Note: Tracking 
numbers only  apply for new or updated URL's.

 l Search Engine Friendly: Select to use search engine friendly URL's. This is the default option.

 4. Click the Save Settings and Return link to save this setting and return to the module.

Configuring URL Column Settings for the Form & List Module

Configuring  User Profile Link Settings
How to configure the optional setting for user profile links in a list on the Form & List module.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.



 2. Maximize  the Column Settings section. 

 3. At Settings for User Profile Links set the following options: 

 a. At Open in New Window, check  the check box to open the profile in a new Web browser window - OR - Uncheck 
 the check box to open the profile in the same window.

 b. At User Link Caption select from the following options to set which name to display as the link to User Profile:

 l Display Name

 l User Name 

 c. At Add to CreatedBy/UpdatedBy?, check  the check box to add a link to the user's profile on both the Created By 
and Updated By columns - OR - Uncheck  the check box for no link.

 4. Click the Save Configuration and Return link to save these settings and return to the module.

 
Configuring User Profile Link Settings

Email Settings
Setting Email Settings
How to set the email settings for forms or lists on the Form & List module. Note: 

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.

 2. Go to the Page Related Settings section.

 3. At Enable Email Settings, check  the check box. This displays the Email Settings section at the bottom of this page.

 4. Maximize  the Email Settings section. 

 5. In the To text box, enter one or more email addresses, separated by semicolon ";" or enclosed in [brackets]. You may enter the col-
umn Title name for column types Email, Created By, Changed By, or User Link. E.g. admin@domain.com;[Created By];[-
Secondary Email]. 

 6. In the CC text box, enter each email address to be sent a 'carbon copy' of this message. See To field for more details.

 7. In the BCC text box, enter each email address to be sent a 'blind carbon copy' of this message. See To field for more details.

 8. In the Reply To (Overrides Default)text box, enter the email address that you want any replies to the notification messages to be 
sent to. Leave this field blank to use the Portal Administrator email address. See "Setting the Primary Administrator".

 9. In the From (Overrides Default)text box, enter the email address to be displayed in the From field of the notification message. 
Leave this field blank to use the Portal Administrator email address.

 10. In the Email Subject text box, enter the subject for the notification email. 



 11. In the Tracking Message Editor, enter the body of the notification email message. 

 12. Optional. At Trigger, select one or more of the following options to set which actions will trigger a notification email.

 l On New, check  the check box if you want to send a notification email when a new record is created.

 a. Optional. In the On New Text text box, enter the message to display in the body of the notification email. 

 l On Update, check  the check box if you want to send a notification email when an existing record is updated.

 a. Optional. In the On Update Text text box, enter the message to display in the body of the notification email. 

 l On Delete  check  the check box if you want to send a notification email when an existing record is deleted.

 a. Optional. In the On Delete Text text box, enter the message to display in the body of the notification email.

 13. At Email Body Creation, select from these options: 

 l Auto: Create the email body on the fly. 

 l XSL-Script: Email body is created using an XSL script you have created. At Tracking XSL Script, set the link to your XSL 
file, upload a new file or generate a new XSL Script. 

 i. At Tracking XSL Script, set the link to your XSL file, upload a new file or generate a new XSL Script.

 14. Click the Save Configuration and Return link to return to the module.



Setting Tracking and Notification Settings

Form Settings
Configuring Form Settings
How to configure the optional settings for forms on the Form and List module. This tutorial assumes you have already configured the mod-
ule as a form. "Configuring a Form".

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 



 2. Maximize  the Form Settings section and complete these optional settings. If these settings are not configured the default 
options are applied.

 a. At Action Upon Submit select from these options to set what happens once the form is submitted:

 l Show Form and Text: Displays both the form and the text (as entered into the below Editor) on the page.

 l Show Text only: Displays the text (as entered into the below Editor) on the page.

 l Redirect to another page: Redirects the user to any internal or external page. 

 i. At Redirect Upon Submit, set the redirection link. See "Setting a Page Link","Setting a URL Link". or 
"Selecting an Existing URL Link".

 3. In the Displayed text after form post Editor, enter the text to be displayed on form after is has been submitted. This option on not 
require if Redirect To Another Page is selected.

 4. Click the Save Configuration and Return link to return to the module.

Configuring Form Settings

List Settings
Editing Current XSL Script
How to edit the  XSL Transformation file of a self-made stylesheet for a list on the Form & List module. This tutorial assumes you have 
created a stylesheet and set it for this module.      "Rendering a List using Self Made Stylesheets".



 1. Select  Edit Current XSL Script from the Form and List module actions menu. This opens the Token Based XSLT Generator 
and Editor page. 

 2. Optional. Maximize  the 1. Edit HTML Template section to edit the HTML template for this XSL file. 

 a. Maximize  the List View section to view the HTML of the XSL file you are editing. Complete the following to edit the 
file:  

 i. At List Type, select the layout for the content. The following options are available: 

 l Table: Renders all records inside a single table. 

 l Division: Renders each record inside its own div tag. E.g. < div > 

 l Paragraph: Renders each record inside its own paragraph tag. E.g. < p > 

 l Ordered List: Renders each record inside its own list item tag. E.g. < li > 

 l Unordered List: Renders each record inside its own list item tag. E.g. < li > 

 l Nothing: Renders all records separated by the delimiter (as selected at Delimiter below.) 

 ii. In the Delimiter text box, view/edit the characters or tags used as a column delimiter. The default value is a 
semi-colon ( ; ). This is the only option when Table is selected as the List Type. 

 iii. At Available Fields and Context, insert one or more fields or columns as follows: 

 1. To insert a field: 

 a. Click inside the Text Box where you want to insert the field. 

 b. Select a UDT field from the drop-down list. 

 c. Click the Insert link. 

 2. To insert a column: 

 a. Click inside the Text Box where you want to insert the field. 

 b. Select a UDT field from the drop-down list. 

 c. Click the Insert Column link. This option is only enabled when Table is selected as the List 
Type. 

 iv. Maximize  the Options section, complete the following optional settings: 

 1. Optional. At Add Sorting Support to the Style Sheet, check  the check box to sort displayed rec-
ords according to sort column and direction specified on the Form & List Configuration page. 

 2. Optional. At Add Paging Support to the Style Sheet, check  the check box to add a pager for the 
displayed list. Page size is specified on the Form & List Configuration page. 

 3. Optional. At Add Search Box to the Style Sheet, check  the check box to add a text box above the 
displayed list, where users can enter a text to search for in the records. 



 4. Optional. At Add Detail View, check  the check box to add a link to an additional Detail View, show-
ing the columns of the current record only. This displays the current layout of the Detail View page. 
You can manually edit the information or perform the following edit tasks: 

 a. To insert a new field: 

 i. Click inside the Text Box where you want to insert the field. 

 ii. At Available Fields and Content, select the field you wish to insert. 

 iii. Click the Insert link. 

 b. To restore the default Detail View template: 

 i. Click the Rebuild link to the left. 

 b. Click the Generate from HTML Template button. 

 5. Optional. In the 2. Edit XSLT Script section, view and edit the XSLT script if required.  

 6. Go to the 3. Save File section. 

 a. Optional. In the File Name text box, enter a new file name if you want to create a new file rather than editing this one.

 7. Click the Save File and Return link. 

 a. If you didn't change the File Name you will be asked to confirm that you want to override the existing file. Select from 
these options: 

 l Yes: Select to override the existing file. 

 l No: Select to return to the page to create a new file as follows: 

 1. In the File Name text box, enter a new file name. 

 b. Click the Back link to return to the module.

Tip: Click the Rebuilt link located in the 1. Edit HTML Template section to rebuild the HTML template if required. Note: All changes will be 
lost.

Editing the XSLT of a Self-Made  Stylesheet
How to edit the  XSL Transformation file of a self-made stylesheet for a list on the Form & List module. This tutorial assumes you have 
created a stylesheet and set it for this module. "Rendering a List using Self Made Stylesheets".

 1. Select Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Go to the List Settings section.

 3. At XSL Script, click the Edit link. This displays the Token Based XSLT Generator and Editor page. 

 4. Optional. Maximize  the 1. Edit HTML Template section to edit the HTML template for this XSL file. 

 a. Maximize  the List View section to view the HTML of the XSL file you are editing. Complete the following to edit the 
file:  

 i. At List Type, select the layout for the content. The following options are available: 



 l Table: Renders all records inside a single table. 

 l Division: Renders each record inside its own div tag. E.g. <div> 

 l Paragraph: Renders each record inside its own paragraph tag. E.g. <p> 

 l Ordered List: Renders each record inside its own list item tag. E.g. <li> 

 l Unordered List: Renders each record inside its own list item tag. E.g. <li> 

 l Nothing: Renders all records separated by the delimiter (as selected at Delimiter below.) 

 ii. In the Delimiter text box, view/edit the characters or tags used as a column delimiter. The default value is a 
semi-colon ( ; ). This is the only option when Table is selected as the List Type. 

 iii. At Available Fields and Context, insert one or more fields or columns as follows: 

 1. To insert a field: 

 a. Click inside the Text Box where you want to insert the field. 

 b. Select a UDT field from the drop-down list. 

 c. Click the Insert link. 

 2. To insert a column: 

 a. Click inside the Text Box where you want to insert the field. 

 b. Select a UDT field from the drop-down list. 

 c. Click the Insert Column link. This option is only enabled when Table is selected as the List 
Type. 

 iv. Maximize  the Options section, complete the following optional settings: 

 1. Optional. At Add Sorting Support to the Style Sheet, check  the check box to sort displayed rec-
ords according to sort column and direction specified on the Form & List Configuration page. 

 2. Optional. At Add Paging Support to the Style Sheet, check  the check box to add a pager for the 
displayed list. Page size is specified on the Form & List Configuration page. 

 3. Optional. At Add Search Box to the Style Sheet, check  the check box to add a text box above the 
displayed list, where users can enter a text to search for in the records. 

 4. Optional. At Add Detail View, check  the check box to add a link to an additional Detail View, show-
ing the columns of the current record only. This displays the current layout of the Detail View page. 
You can manually edit the information or perform the following edit tasks: 

 a. To insert a new field: 

 i. Click inside the Text Box where you want to insert the field. 

 ii. At Available Fields and Content, select the field you wish to insert. 

 iii. Click the Insert link. 

 b. To restore the default Detail View template: 



 i. Click the Rebuild link to the left. 

 b. Click the Generate from HTML Template button. 

 5. Optional. In the 2. Edit XSLT Script section, view and edit the XSLT script if required.  

 6. Go to the 3. Save File section. 

 a. Optional. In the File Name text box, enter a new file name if you want to create a new file rather than editing this one.

 7. Click the Save File and Return link. 

 a. If you didn't change the File Name you will be asked to confirm that you want to override the existing file. Select from 
these options: 

 l Yes: Select to override the existing file. 

 l No: Select to return to the page to create a new file as follows: 

 1. In the File Name text box, enter a new file name. 

 b. Click the Save Configuration and Return link to continue.

Tip: Click the Rebuilt link located in the 1. Edit HTML Template section to rebuild the HTML template if required. Note: All changes will be 
lost.

Generating a New XSL Transformation for a self made stylesheet
How to generate a new User Defined XSL Transformation file for a  self made stylesheet for the Form & List module.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Go to the List Settings section. 

 3. At Rendering Method, select XSLT using self made stylesheets. 

 4. At XSL Script, click the Generate New link. This opens the Token Based XSLT Generator and Editor page. 



 5. Go to the 1. Edit HTML Template section. The text box displays the HTML for a table which includes an Edit Link and each of the 
columns which have added to the table.

 6. In the List View section, complete the following to edit the displayed HTML to create your custom XSL transformation:  

 a. At List Type, select the layout for the content. The following options are available: 

 l Table: Renders all records inside a single table. 

 l Division: Renders each record inside its own div tag. E.g. < div > 

 l Paragraph: Renders each record inside its own paragraph tag. E.g. < p > 



 l Ordered List: Renders each record inside its own list item tag. E.g. < li > 

 l Unordered List: Renders each record inside its own list item tag. E.g. < li > 

 l Nothing: Renders all records separated by the delimiter (as selected at Delimiter below.) 

 b. In the Delimiter text box, view/edit the characters or tags used as a column delimiter. The default value is a semi-colon 
( ; ). This is the only option when Table is selected as the List Type. 

 c. At Available Fields and Context, insert one or more fields or columns as follows: 

 i. To insert a field: 

 1. Click inside the Text Box where you want to insert the field. 

 2. Select a UDT field from the drop-down list. 

 3. Click the Insert link. 

 ii. To insert a column: 

 1. Click inside the Text Box where you want to insert the field. 

 2. Select a UDT field from the drop-down list. 

 3. Click the Insert Column link. This option is only enabled when Table is selected as the List Type.

 7. Optional. Maximize  the Options section, complete the following optional settings: 

 a. Optional. At Add Sorting Support to the Style Sheet, check  the check box to sort displayed records according to 
sort column and direction specified in Manage User Defined Table. 

 b. Optional. At Add Paging Support to the Style Sheet, check  the check box to add a pager for the displayed list. Page 
size is specified in Manage User Defined Table. 



 c. Optional. At Add Search Box to the Style Sheet, check  the check box to add a text box above the displayed list, 
where users can enter a text to search for in the records. 

 d. Optional. At Add Detail View, check  the check box to add a link to an additional Detail View, showing the columns of 
the current record only. This displays the current layout of the Detail View page. You can manually edit the information 
or perform the following: 

 i. To insert a new field: 

 1. Click inside the Text Box where you want to insert the field. 

 2. At Available Fields and Content, select the field you wish to insert. 

 3. Click the Insert link. 

 ii. To restore the default Detail View template: 

 1. Click the Rebuild link to the left. 

 8. Click the Generate from HTML Template button.

 



 9. Optional. In the 2. Edit XSLT Script section, view and edit the XSLT script if required.

  

 10. Go to the 3. Save File section. 

 a. In the File Name text box, enter a file name.

 b. Click the Save File and Return link.

 

 11. Click the Save Configuration and Return link to return to the module.

Tip: Click the Rebuilt link in the 1. Edit HTML Template section to rebuild the HTML template if required. Note: All changes will be lost.



The new user defined XSL transformation

Rendering a List using built-in Stylesheets                   
How to render list using one of the built-in stylesheets on the Forms & Lists module.

 1. Select  Form and List Configuration from the module actions menu - OR - Click the Form and List Configuration  button.

 2. Maximize  the List Settings section.

 3. At Rendering Method, select XSLT using built-in stylesheets.

 4. At XSL Script, select one of the following designs:

 l Advanced Table: Includes search box and detailed view.
(Image One below shows the Advanced Table, and Image Two shows the detailed view accessed when clicking on the 
View  button)



 l Basic Table (pictured below): Similar to the default grid table however this table does not have column sorting or 
paging. 

 l Card View (pictured below): Records displayed in cards. 



 l Only Own Items (pictured below): Users can only see their own items. 

 

 l Transpose (pictured below): Columns are displayed down the page. Column sorting or paging are disabled. 

 5. Optional. Click the Show XSL source code link to view the source code for the selected file. 

 6. Click the Save Configuration and Return link to update these settings and return to the module.

Setting the rendering method

Rendering a List using Self Made Stylesheets
How to render a list using a stylesheet you have created on the Forms & Lists module.



 1. Select  Form and List Configuration from the module actions menu - OR - Click the Form and List Configuration  button. 

 2. Maximize  the List Settings section.

 3. At Rendering Method, select XSLT using self made or generated stylesheets. 

 4. At XSL Script, set the link to your XSLT file. See "Setting a File Link".

 5. Click the Save Configuration and Return link to update these settings and return to the module.

Rendering a List using Self Made Stylesheets 

Rendering a List using the Default Grid Table
How to set the layout and design of a list  using one of the included designs on the Forms & Lists module

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Maximize  the List Settings section. 

 3. At Rendering Method, select Default Grid Table. This displays the CSS Classes field. 

 4. Optional. Maximize  the Grid Table Settings section and set any of these optional settings: 

 a. At CSS Classes, select the CSS classes to be used. Two options are provided: 

 l "Normal UDT_Table*": This is the default table layout. 

 l "DataGrid_*": This table uses a smaller font and row color alternates from black to red.

 l YUI DataTable Styled: This table displays borders.

 5. Click the Save Configuration and Return link.



Setting the List Design using Default Grids

Setting List Search and Filter Options
How to set the list searching and filtering options for the Forms & Lists module.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Maximize  the List Settings section.

 3. Go to the Search and Filter Options section.

 4. In the Filter Statement text box, enter a Boolean filter expression which a record must match to be displayed. Use SQL syntax 
with WHERE clauses. If your column name has spaces or special characters in it, surround the field name with [brackets]. Tip: 
Click the Available Tokens Help or Hidden Columns Help links for a current list of available tokens or hidden column details.

 5. At Show Search Box, select from these options: 

 l Check  the check box display a search box which enables users to search the data within any searchable 
column. Searches can be made on all or one column and can be set to Contain, Start With, End With, or Equal the 
search criteria. Checking this option enables the following optional settings:

 a. Optional. At Simple Search, check  the check box to use a simple search box - OR - Uncheck  the check 
box to use the standard Search Box.

 b. Optional.  At Show No Records Until Search, check  the check box to hide all records until a successful 
search has been made - OR - Uncheck  the check box to display records by default.

 c. Optional.  At Search URL Paths, check  the check box to include URL paths in search results - OR - 
Uncheck  the check box to disable. 

 l Uncheck  the check box to disable the search box.

 6. In the Records Returned text box, enter a number between 1 and 1000 to set the maximum number of records displayed 
according to the sorting applied. Leave this field blank to return an unlimited number of records.

 7. Click the Save Configuration and Return link.



Enabling the list search box

List with Simple Search

Setting List Sorting Options
How to set the default sort order and direction of list records in the Forms & Lists module.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.

 2. Maximize  the List Settings section.

 3. At Sort Column, select a column title from the drop-down box to set the column list record are sorted by - OR - Select Not Spec-
ified to sort records in the order they are entered. 

 4. At Sort Direction, select from these options: 



 l Ascending: Sorts records in ascending order. E.g. Z-A. This displays the Ascending  button beside the title of the sort 
column. 

 l Descending: Sorts records in ascending order. E.g. A-Z. This displays the Descending  button beside the title of the 
sort column.

 5. At Paging, select from these options from the drop-down box:

 l <no paging>: Select to disable paging. All records will be displayed on one page.

 l 5 - 50: Select the number of records to be displayed per page.

 6. Click the Save Configuration and Return link to update these settings and return to the module.

Setting column sorting and direction

Creating a Form
How to add one or more fields to create a form on the Form & List module. This topic  assumes you have already configured the module 
as a form. See "Configuring a Form".

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.

 2. Go to the Data Table Setup section.

 3. Click the Add New Column link to add a new column.



 4. In the Title text box, enter a title for the column. Note: Column titles are listed across the top of the table. 

 5. At Type, select the type of data that can be entered into and displayed for the field. The following options are available: 

 l Calculated Column: Requires an expression to be entered. See "Advanced Calculated Column Options"

 l Currency: Enter and display a currency amount. E.g. 9.00 GBP. See "Setting the Payment Processor for Portal Hosting"

 l Date: Display a selected date. E.g. 6/30/2006 

 l Date and Time: Displays a selected date and an entered time. E.g. 6/30/2006 9:00 AM 

 l Decimal: Enter and display a decimal number. E.g. 8.25

 l Download: Select and display a file for download.

 l Email: Enter and display a valid email address. E.g. john.doe@domain.com

 l Image: Displays an image that has been uploaded to the web site.

 l Integer: Enter and display a whole number. E.g. 8

 l Link to User's Profile: Enter a username of a member of the site to display their name and a link to their user profile.

 l Look-Up

 l Rich Text (Html): Enter and display any keyboard characters into the RTE. This field was not working at the time of writ-
ing.

 l Separator: Displays a separator line.

 l Text: Enter and display any keyboard characters. This is the default option

 l Time: Display an entered time. E.g. 12:30 PM 

 l True/False: Enter and display a true or false statement. E.g. False. 

 l URL: Enter and display a valid URL. E.g. http://www.domain.com

 5. Optional. At Required, select from the following options: 

 l Check  the check box to set the field as mandatory. 

 l Uncheck  the check box to set the field as optional. This is the default setting.

 6. Optional. At Display on List, select from the following options:

 l Check  the check box if this column is visible on the list. This is the default setting. 

 l Uncheck  the check box if the column is only visible to Administrators.

 7. Optional. At Restricted Form Field, select from the following options:

 l Check  the check box if this column is visible to all users. This is the default setting. 

 l Uncheck  the check box if the column is only visible to users/roles for Restricted fields as set in permissions. "Setting 
Form Permissions".



 8. Optional. At Searchable, select from the following options: (Note: This option is only available for some data types)

 l Check  the check box if this column searchable. This is the default setting.

 l Uncheck  the check box if the column is not searchable.

 9. Click the Save  button to the left of these details. 

 10. Repeat Steps 3-9 to add additional columns. 

 11. Click the Save Settings and Return link to return to the module.

Tip: See the Advanced Column Options section for this module for more column options.

Creating a Form

Creating a List
How to add one or more list columns to the Form & List module. This topic  assumes you have already configured the module as a list.
  "Configuring a List".

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.

 2. Go to the Schema Definition - Data Table Setup section.

 3. Click the Add New Column link to add a new column.

 4. In the Title text box, enter a title for the column. Note: Column titles are listed across the top of the table. 

 5. At Type, select the type of data that can be entered into and displayed for the field. The following options are available: 



 l Calculated Column:  Requires an expression to be entered. See "Advanced Calculated Column Options" 

 l Currency: Enter and display a currency amount. E.g. 9.00 GBP. See "Setting the Payment Processor for Portal Hosting"

 l Date: Display a selected date. E.g. 6/30/2006

 l Date and Time: Displays a selected date and an entered time. E.g. 6/30/2006 9:00 AM

 l Decimal: Enter and display a decimal number. E.g. 8.50

 l Download: Select and display a file for download. Note: Link tracking for Download links can be enabled on the Edit 
Record page.

 l Email: Enter and display a valid email address. E.g. john.doe@domain.com

 l Image: Displays an image that has been uploaded to the web site.

 l Integer: Enter and display a whole number. E.g. 8

 l Link to User's Profile: Enter a username of a member of the site to display their name and a link to their user profile.

 l Look-Up:

 l Rich Text (Html): Enter and display any keyboard characters into the RTE. This field was not working at the time of writ-
ing.

 l Separator: This is a read only field which display the title above a horizontal line. Use this type to separate data and for-
mat the layout of your list. 

 l Text: Enter and display any keyboard characters. This is the default option.

 l Time: Display an entered time. E.g. 12:30 PM 

 l True/False: Enter and display a true or false statement. E.g. False. 

 l URL: Enter and display a valid URL. E.g. http://www.domain.com. Note: Link tracking for URL's can be enabled on 
the Edit Record page.

 5. At Required, select from the following options: 

 l Check  the check box to set the field as mandatory. 

 l Uncheck  the check box to set the field as optional. This is the default setting.

 6. Optional. At Display on List, select from the following options:

 l Check  the check box if this column is visible on the list. This is the default setting. 

 l Uncheck  the check box if the column is only visible to Administrators.

 7. Optional. At Restricted Form Field, select from the following options:

 l Check  the check box if this column is visible to all users. This is the default setting. 

 l Uncheck  the check box if the column is only visible to users/roles for Restricted fields as set in permissions. "Setting 
List Permissions".



 8. Optional. At Searchable, select from the following options: (Note: This option is only available for some data types)

 l Check  the check box if this column searchable. This is the default setting.

 l Uncheck  the check box if the column is not searchable.

 9. Click the Save  button to the left of these details. 

 10. Repeat Steps 3-9 to add additional columns.

 11. Click the Save Configuration and Return link to return to the module.

Tip: See the Advanced Column Options section for this module for more column options.

Creating a list

Applying a Template
How to apply a form or list template to a Form & List module which has not yet been configured. This topic  assumes one or more form or 
list templates have been created. "Saving a Template".

 1. Add a Form & List module - OR - Go to a Form & List module hasn't been configured.

 2. View the available list of forms/lists. Note: If no templates are listed, select Scan For New Module Templates from the module 
actions menu. This will refresh the templates list to show any newly created templates.

 3. Click the Apply link beside the required template.

Applying a Template

Re-ordering List or Form Columns 
How to modify the order of columns in either form or a list created using the Form & List module.



 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Go to the Data Table Setup section.

 3. Click the Up  button to move a column one position up in the list or form - OR - Click the Down  button to move a column 
one position down in the list or form. 

 4. Repeat Step 3 until all columns are ordered as desired. 

 5. Click the Save Configuration and Return link to return to the module.

Re-ordering list or form columns

Editing List or Form Columns
How to edit one or more columns in a list or form created using the Form & List module.

Warning. Do not modify the Type field of any column once data has been entered into a list it may cause an error.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Click the Edit  button beside the column to be edited. This enables editing of the column including any advanced column 
options. 

 3. Edit columns as required.

 4. Click the Save  button. 



 5. Repeat Steps 2-4 to edit additional columns. 

 6. Click the Save Configuration and Return link to return to the module.

Editing list or form columns

Deleting List or Form Columns 
How to delete one or more columns in a list or form created using the Form & List module. When this module is configured as a list, delet-
ing a column permanently deletes both the column and any data entered for that column.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button. 

 2. Click the Delete  button beside the column to be deleted. This displays the message "Are You Sure You Wish To Delete This 
Column?" 

 3. Click the OK button to confirm deletion. 

 4. Repeat Steps 2-3 to delete additional columns. 

 5. Click the Save Configuration and Return link to return to the module.



Deleting a column

Configuring a Form
How to configure the Form and List module as a form. Note: Before configuration, the module displays the message: "No  templates avail-
able. Create a new Form or List based  on a template from the list above, or design your own in Form  and List Configuration"

 1. Select  Form and List Configuration from the Form and List module actions menu - OR - Click the Form and List Con-
figuration link on the module - OR -  Click the Form and List Configuration  button.

 2. Go to the Page Related Settings section.

 a. At Appearance, select from these options: 

 l Form: Select to display a form. Records entered into the form can be viewed using the Show Records option. 
See "Viewing Form Records"
This displays the following messages: "Please apply also "Create Record/Submit Form" permissions in Mod-
ule Settings!", and "If the module is collecting  confidential data, you should also exclude its data from system 
wide  search." Skip to Step 2C.

 l Form Above List: Select to display a form with a list below. Records created using the form are displayed as a 
list below the form.

 l Form Below List: Select to display a form with a list below. Records created using the form are displayed as a 
list above the form.

 b. At List View, check  the check box to restrict the viewing of the list  by Permissions - OR - uncheck if all users who can 
see the Form can view the list. Note: This setting can be overridden. See "Setting Form Permissions"

 c. At Email, check to enable email notifications - OR - Uncheck for no notification.



 d. At Form Layout, select from these options:

 l Html Table: Select to use HTML tables.

 l DIV and Custom CSS: Select to use a CSS based edit form.

 e. At Send Buttons, select from these options:

 l Links:  Select to use Text Links.

 l HTML Buttons (Requires No JavaScript): Select to display HTML buttons for "Submit/Cancel".

 f. At Width of Edit Controls, select from these options:

 l Classic: Displays edit controls as a fixed value.

 l Full (100%): Displays edit controls as 100% width.

 3. Optional. Maximize  the Form Settings section and modify settings as required. If these settings are not configured the default 
options are applied. "Configuring Form Settings".

 4. Click the Save Configuration and Return link to return to the module. The module now displays Submit and Cancel options.

 You must now complete the following:

 l Add one or more fields to your form. "Creating a Form".

 l Set which roles/users can submit the form and view form results. "Setting Form Permissions".

Configuring a Form

Configuring a List
How to configure the Form and List module as a list. Note: Before the Form & List module is configured it displays message: "Create a 
new Form or List based on a template from the list above, or design your own in Form and List Configuration."



 1. Select  Form and List Configuration from the Form and List module actions menu - OR - Click the Form and List Con-
figuration link on the module - OR -  Click the Form and List Configuration  button.

 2. Go to the Page Related Settings section.

 a. At Appearance, select List.

 b. At Email, check  the check box to enable email notifications - OR - Uncheck  the check box for no notification.

 c. At Form Layout, select from these options:

 l Html Table: Select to use HTML tables.

 l DIV and Custom CSS: Select to use a CSS based layout.

 d. At Send Buttons, select from these options:

 l Links:  Select to use Text Links.

 l HTML Buttons (Requires No JavaScript): Select to display HTML buttons for "Submit/Cancel".

 e. At Width of Edit Controls, select from these options:

 l Classic: Displays edit controls as a fixed value.

 l Full (100%): Displays edit controls as 100% width.

 3. Optional. Maximize  the List Settings section and modify settings as required. If these settings are not configured the default 
options are applied. "Configuring Form Settings".

 4. Click the Save Configuration and Return link to return to the module. The module now displays the yellow warning "  There 
are no columns defined. Setup the module inside the Form and List Configuration."



You must now complete the following:

 l Set the roles and users who can add and manage list records. "Setting List Permissions".

 l Define the columns for this list. "Creating a List".

The following additional options are available for configuring a list:

 l See the "List Settings" section for full details of the optional settings available for configuring the layout of a list.

Saving Configuration As Default
How to save the configuration of a form or list which you have created as the default configuration the Forms & Lists module. "Save Con-
figuration as Default" simply copies all TabModuleSettings to ModuleSettings. Form and List enables its real power if you place the (exist-
ing) module on several pages. It has no influence on new modules. It is also helpful for templates, as it allows you to store two setups in 
one template. If you apply a template, the stored settings are applied, though the tabmodulesettings win. 

If you add the module also on a second page, the tab module settings are still empty and the saved default wins.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.

 2. Select Save Configuration As Default from the Forms & Lists module actions menu. The configuration is now saved as the 
default. 

Tip: To use this, add a copy of the Form or List module to a new page. See "Adding an Existing Module (Iconbar)", "Adding an Existing 
Module (RibbonBar)".

Resetting to the Default Configuration
How to reset the configuration of a form or list to the default configuration on the Forms & Lists module.

 1. Select  Form and List Configuration from the Form and List module actions menu - OR -  Click the Form and List Con-
figuration  button.

 2. Select Reset To Default Configuration from the Forms & Lists module actions menu. This displays the message "Are You 
Sure Wish To Reset All Page Related Settings For This Module?"

 3. Click the OK button.

All Users
Re-ordering List Records               
How to re-order list records by column on the Form & List module. Note: This option may not be available for some lists.

 1. Click on the linked [Column Name] to reorder list records by that column.



Tip: An Up (ascending)  or Down (descending)  arrow is displayed beside the selected sort column and indicates the sorting order. 
Click the [Column Name] link a second time to reverse the order.

Form Editors
Viewing Form Records
How to view records which have been submitted to a form created using the Form & List module.

 1. Select Show Records from the Form & List module actions menu.

 2. Click the  Show Form link to return to the module.

Viewing Form Records

Editing Form Records
How to view and edit records which have been submitted to a form created using the Form & List module.

 1. Select  Show Records from the Form & List module actions menu.

 2. Click the Edit  button beside the record to be edited.



 3. Edit the record as required.

 4. Click the Submit link. This displays the "Your submission was successful." message.

Editing a form record

List Editors
Overview of Data Types 
There are a number of different types of data that can be entered into a field when adding a record to a list created using the Form & List 
module. Here is an overview of these types of data:

 n Calculated Column: This field permits an ASP.NET developer to write code to display data that is calculated. 

 n Currency: Enter an amount into the text box. The currency type is displayed to the right of the text box. The currency type is set 
under Admin > Site Settings. 

 n Date and Time, Date, or Time: Date fields display the Calendar link to select a date and time field display a text box to enter the 
time. 
Any of the below date formats are also acceptable, however I recommend using the Calendar link to avoid confusion: 

 l 12 February 2004

 l 12 Feb 2004

 l Feb 12 2004

 l Feb 12, 2004

 l 2/12/2004

 l Any of the below time formats are acceptable and will display as 11:00 PM: 

 o 11pm

 o 11:00pm

 o 23:00

 n Decimal: Whole numbers and numbers with a decimal point can be entered. Numbers containing a decimal point will be 
rounded up to the nearest two decimal point value. Numbers can be positive, negative or zero. E.g. 8.458 will be displayed as 
8.46 on the module however it will display as 8.458 in edit mode. 

 n Email: Any a valid email address can be entered. 



 n Image:  Select or upload an image using the Link tool for files. 

 n Integer: Only whole numbers can be entered into an integer field. Numbers can be positive, negative or zero amounts. E.g. 8, -8, 
0 

 n Text: Any keyboard characters can be entered into a text field. 

 n True/False: Check  the check box to display the True  icon - OR - Uncheck the check box to display the False  icon. 

 n URL: Select or enter a URL using the Link tool. Any valid URL can be entered or a Page or File selected. Use the UDT settings 
under Manage User Defined Table to set whether http:// is displayed for URL's. 

 n User Profile: Enter the user's username. E.g. Admin

Adding a List Record
How to add a record to a list using the Forms & Lists module. The ability to add rows may be restricted.

 1. Select Add New Record from the module actions menu - OR - click the Add New Record link. This opens the Edit Record 
page. 

 2. Enter or select your data. Required fields are denoted by an asterisk ( * ).

 3. Click the Update link.

Adding a record to a list

Adding a List Record when a Security Code is Required 
How to add a record to a list when a security code is required using the Forms & Lists module . Note: The ability to add records may be 
restricted.



 1. Select Add New Record from the module actions menu - OR - click the Add New Record link. This opens the Edit Record 
page.

 2. Enter or select your data. Required fields are denoted by an asterisk ( * ). 

 3. In the Security Code text box, enter the code displayed above the text box. 

 4. Click the Update link.

Tip: If you cannot read the Security Code, strike the F5 key on your keyboard to view a new code. You should be this before 
entering your data, as all data will be lost if you strike F5.

Adding a record to a list when a security code is required

Editing a List Record
How to edit a record in a list in the Form & List module. Note: The ability to edit rows may be restricted by users/roles or you may only be 
able to edit your own records.

 1. Click the Edit  button beside the record. 

 2. Edit data as required. 

 3. Click the Update link.



Editing a list record

Showing All Data as XML 
How to view the data of a list created using the Form & List module in XML format. This data can be saved and used as required.

 1. Select Show All Data As XML from the Form & List module actions menu. This displays the XML data in a new Web browser 
window.

 2. Click the Back button on your Web browser to return to the page.

Show all list data as XML



Deleting a List Record
How to permanently delete a record from a list on a Form & List module. Note: The ability to delete rows may be restricted by users/roles 
or you may only be able to delete your own records.

 1. Click the Edit  button beside the record to be deleted. 

 2. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?"   

 3. Click the OK button. 

 4. Repeat Steps 1-3 to delete additional records.

Deleting a list record

Deleting All List Records
How to permanently delete all records from a list in the Forms & Lists module.

 1. Select Delete All Records from the Forms & Lists module actions menu. This displays the message "Are You Sure Wish To 
Delete All Records Stored In This Table?"

 2. Click the OK button.

 3. Optional. Click the Refresh button - OR - F5 key on your keyboard.

Tip: This task can also be performed from the module actions menu on the Form And List Configuration page.



Deleting all rows

Settings
Enabling/Disabling CAPTCHA for Anonymous Users
How to enable the CAPTCHA security field for unauthenticated user who are permitted to manage list records or submit a form on the 
Form & List module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Form and List Settings tab.

 3. At Force CAPTCHA control during edit for Anonymous users, select from the following options: 

 l Check  the check box to enable CAPTCHA.

 l Uncheck  the check box to remove CAPTCHA.

 4. Click the Update link.



Enabling CAPTCHA for anonymous users

CAPTCHA enabled



Enabling/Disabling Entry of Markup Code Scripts
How to enable filtering of data that contains markup code or scripts that is entered into a form or list on the Form & List module. Note: Fil-
tering is always enabled for Anonymous users.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Form and List Settings tab.

 3. At Filter entry for markup code or script input. Note: filtering is always enabled for Anonymous users., check  the check 
box to enable filtering - OR - Uncheck  the check box to remove filtering. 

 4. Click the Update link.

Enabling data filtering for lists and forms

Hiding/Displaying System Fields
How to hide or display system fields even if "Display All Columns" permissions are set for a form or list created using the Form & List mod-
ule.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Form and List Settings tab.

 3. At Hide System Fields even if "Display All Columns" permission is set, select from these options: 

 l Check  the check box to hide system fields.

 l Uncheck  the check box to display system fields.

 4. Click the Update link.



Hiding System Fields

Negating Unique Column Permissions for Administrators
How to negate the "Display All Columns" and "Edit Private Columns" permission settings for a list created using the Form & List module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.     

 2. Select the Form and List Settings tab.

 3. At Negate permission/feature "Display All Columns" for Administrators, select from these options: 

 l Check  the check box if to negate "Display All Columns" settings for Administrators.

 l Uncheck  the check box to apply "Display All Columns" as set.

 4. At Negate permission/feature "Edit Also Restricted Columns" for Administrators, select from these options: 

 l Check  the check box if to negate "Edit Also Restricted Columns" settings for Administrators.

 l Uncheck  the check box to apply "Edit Also Restricted Columns" as set.

 5. Click the Update link.

For more on setting and modifying these permissions "Setting List Permissions". and "Setting Form Permissions".



Negating Permissions

Saving a Template
How to save a template of a form or a list which has been created using the Form & List module. Saved templates will be listed on Form 
& List modules which are yet to be configured. 

 1. Select  Save as Template from the Form & List module actions menu. This opens the Form and List - Module Template page.

 2. In the Name text box, enter a name for the template.

 3. In the Description text box, enter a description for the template.

 4. In the Max Records text box, enter the maximum number of records to be including in the template. Typically you will enter 0 for 
no records, or 1 to add a sample record.

 5. Click the Save as Form and List - Module Template link. The template is now saved into the Templates folder of the site's File 
Manager.

Saving a List as a Template

Setting Form Permissions
How to set permissions to manage form columns and submit a form created using the Form & List module. This setting is in addition to 
the usual module editing permissions for all modules. "Negating Unique Column Permissions for Administrators".



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Permissions tab.

 3. At Permissions, set the typical DNN module permissions as usual. See "Setting List Permissions"

 4. At Permissions, complete these additional role and/or username permissions:

 a. Edit Record, set the following for each role/username:

 l  Not Specified: Permissions are not specified. Role members/usernames are unable to edit form records 
unless they belong to another role which has been granted permission, or if their username has been granted 
permission.

 l  Permission Granted: Permission to edit all form record is granted to role members/username.

 l  Permission Denied: Permission to edit all form records is denied to role members/username. This setting 
overrides the Permission Granted setting.

 b. Create Record/Submit Form, set the following for each role/username: 

 l  Not Specified: Permissions are not specified. Role members/usernames are unable to submit the form unless 
they belong to another role which has been granted permission, or if their username has been granted per-
mission.

 l  Permission Granted: Permission to submit the form is granted to role members/username.

 l  Permission Denied: Permission to submit the form is denied to role members/username. This setting over-
rides the Permission Granted setting.

 c. Delete Record, set the following for each role/username:

 l  Not Specified: Permissions are not specified. Role members/usernames are unable to delete form records 
unless they belong to another role which has been granted permission, or if their username has been granted 
permission.

 l  Permission Granted: Permission to delete form records is granted to role members/username.

 l  Permission Denied: Permission to delete form records is denied to role members/username. This setting over-
rides the Permission Granted setting.

 d. Display All Columns, set the following for each role/username:

 l  Not Specified: Permissions are not specified. Role members/usernames cannot view all columns (including 
those not checked as Visible) unless they belong to another role which has been granted permission, or if their 
username has been granted permission.

 l  Permission Granted: Permission to view all columns (including those not checked as Display On List) is 
granted to role members/username.

 l  Permission Denied: Permission to view all columns (including those not checked as Display On List) is 
denied to role members/username. This setting overrides the Permission Granted setting.

 e. Edit Also Restricted Columns, set the following for each role/username:



 l  Not Specified: Permissions are not specified. Role members/usernames cannot edit restricted columns unless 
they belong to another role which has been granted permission, or if their username has been granted per-
mission. Private columns is an Advanced Column Option for most column types.

 l  Permission Granted: Permission to edit restricted columns is granted to role members/username.

 l  Permission Denied: Permission to edit restricted columns is denied to role members/username. This setting 
overrides the Permission Granted setting.

 5. Click the Update link.

Setting Form Permissions

Setting List Permissions
How to set permissions to manage records and columns for lists created using the Form & List module. This setting is in addition to the 
usual module editing permissions for all modules. See "Negating Unique Column Permissions for Administrators".

Tip: You may need to select <All Roles> at Filter By Group to view the correct permissions.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Permissions tab.

 3. At Permissions, set the typical DNN module permissions as usual. See "Setting Module Permissions".

 4. At Permissions, complete these additional role and/or username permissions:

 a. Edit Record, set the following for each role/username:

 l  Not Specified: Permissions are not specified. Role members/usernames are unable to edit list records unless 
they belong to another role which has been granted permission, or if their username has been granted per-
mission.

 l  Permission Granted: Permission to edit all list record is granted to role members/username.

 l  Permission Denied: Permission to edit all list records is denied to role members/username. This setting over-
rides the Permission Granted setting.

 b. Create Record/Submit Form, set the following for each role/username:



 l  Not Specified: Permissions are not specified. Role members/usernames are unable to add new records 
unless they belong to another role which has been granted permission, or if their username has been granted 
permission.

 l  Permission Granted: Permission to add a new record to the list is granted to role members/username.

 l  Permission Denied: Permission to add a new record is denied to role members/username. This setting over-
rides the Permission Granted setting.

 c. Delete Record, set the following for each role/username: 

 l  Not Specified: Permissions are not specified. Role members/usernames are unable to delete list records 
unless they belong to another role which has been granted permission, or if their username has been granted 
permission.

 l  Permission Granted: Permission to delete list records is granted to role members/username.

 l  Permission Denied: Permission to delete list records is denied to role members/username. This setting over-
rides the Permission Granted setting.

 d. Display All Columns, set the following for each role/username:

 l  Not Specified: Permissions are not specified. Role members/usernames cannot view all records (including 
those not checked as Display On List) unless they belong to another role which has been granted permission, or 
if their username has been granted permission.

 l  Permission Granted: Permission to view all list records (including those not checked as Display On List) is 
granted to role members/username.

 l  Permission Denied: Permission to view all list records (including those not checked as Display On List) is 
denied to role members/username. This setting overrides the Permission Granted setting.

 e. Edit Also Restricted Columns, set the following for each role/username:

 l  Not Specified: Permissions are not specified. Role members/usernames cannot edit private/restricted col-
umns unless they belong to another role which has been granted permission, or if their username has been 
granted permission. Private columns is an Advanced Column Option for most column types.

 l  Permission Granted: Permission to edit private/restricted columns is granted to role members/username.

 l  Permission Denied: Permission to edit private/restricted columns is denied to role members/username. This 
setting overrides the Permission Granted setting.

 5. Click the Update link.



Managing Additional List Permissions on the Form & List Module

Enabling/Disabling Users to Only Manage Their Own Records
How to limit users to only managing their own records in lists on the Forms & Lists module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.   

 2. Select the Form and List Settings tab.

 3. At Users are only allowed to manipulate their own items, select from these options: 

 l Check  the check box if users can only manipulate their own items.

 l Uncheck  the check box to allow users to manipulate all items as set under permission. "Setting Form Permissions".

 4. Click the Update link.

Users can only modifying their own list records

Setting Maximum Records Per User
How to set the maximum records each user can create on a list using the Form & List module.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Form and List Settings tab.

 3. In the Max. Records per User text box, enter the maximum number of records each user can add to the list. Leave the field 
blank if no limit is set.

 4. Click the Update link.

Setting Maximum Records Per User

Forum
About the Forum Module
The Forum module manages multiple discussion groups and forums. Each forum post includes a subject title and content. Optional set-
tings include the ability to quote an existing post, enable post attachments, pinning a post, notification of replies posts, lock posts, as well 
as manage user settings and a wide range of Administration options.

Module Version: 05.00.03

Minimum DNN Version: 06.00.00

Features: ISearchable



The Forum Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleForums/tabid/820/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/7/scope/threads/Default.aspx

 l Issue Tracker: http://dnnforum.codeplex.com/workitem/list/basic

All Users
Go to Forum Home Page
How to go to the home page of the Forum module.

 1. Click the Home link located in the top left corner of the breadcrumb - OR - Click the Home link located top center above all forum 
groups.

Go to Forum Home

http://www.dotnetnuke.com/Products/Development/Forge/ModuleForums/tabid/820/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/7/scope/threads/Default.aspx
http://dnnforum.codeplex.com/workitem/list/basic


Navigating to Forums & Forum Groups
How to navigate to forum groups, forums, threads and posts from the Home page of the Forum module.

Go to a Forum Group

 1. Click on the [Forum Group Name] link.

Go to a Forum

 1. Click on the [Forum Name] link.  

 2. Optional. Click the Show No Replies or Show With Replies link (located under the Search box in the top right-hand corner of the 
module) to modify the threads are displayed.

 3. Optional. Change the order of threads from Oldest To Newest or Newest To Oldest by selecting either option from the drop-down 
box located in the bottom right corner of the page.

Navigating Forums

Navigating Using Breadcrumbs
Breadcrumbing of forum names enables you to quickly view other forums without returning to the Forum Home.



Breadcrumbs enable users to quickly navigate Forums

Navigating Threads
How to navigate to threads which are not displayed in the Forum module

 1. Navigate to the required Forum. See "Navigating to Forums & Forum Groups"

 2. Use the First, Previous, Next and Last links to navigate to threads not currently displayed.



Navigating Threads

Searching One or More Forums 
How to search for posts within one or more forums using the Forum module.

 1. Click the  Search link located in the top center of the module. This opens the Search Forum page.

 2. At Post Dates set the dates you want to search through. This default setting is for the previous one month. If this range is suit-
able and you don't wish to set any further criteria, Skip to Step 4. To change this date range:

 a. At Start, click the Calendar  button and select a new start date.

 b. At End, click the Calendar  button and select a new end date. 

 3. The following additional search criteria is available: 

 a. In the Subject Contains text box, enter a word, phrase or number to limit the search to posts that contain the entered 
criteria in the subject. 

 b. In the Body Contains text box, enter a word, phrase or number to limit the search to posts that contain the entered crite-
ria in the body of the post. You can search for individual phrases, by separating them with a comma. E.g. (phrase1, 
phrase2, phrase3)

 c. At Threads Status, select a thread status to limit your search to threads of that status. Options are: Any Status, Unre-
solved, Resolved, or Informative. If a forum doesn't have a thread status set then this field is ignored.



 d. At Search In,  click the Maximize  button beside a forum group to view the related forums  and check  the check box 
against one or more individual forums.

 4. Click the Search link. The search results are now displayed and the search phrases, words are highlighted in yellow. If no 
results are displayed then no results were found.

Search Results Displayed in Forum Module

Searching a Single Forum 
How to search for a post within a single forum.



 1. Navigate to the required forum.

 2. In the Search text box, enter your search criteria. 

 3. Click the Search  button. The search results are now displayed and the search phrases, words are highlighted in yellow. If 
no results are displayed then no results were found.

Searching a Single Forum

Viewing any Post
How to view a post that has been posted to a Forum.

 1. Navigate to the Forum where the post has been added. See "Navigating to Forums & Forum Groups"

 2. Click on the [Thread Name] link to open the thread and view the related posts.



Viewing any post

Viewing Latest Posts
How to view only the latest posts to all forums within the Forum module.

 1. Go to the Forum Home page. See "Go to Forum Home Page"

 2. At View Latest, select to view posts added within either the last 6, 12, 24, or 48 hours.

Viewing Latest Posts

Filtering Threads from a Single Forum 
How to filter the threads which are displayed for a single forum.



 1. Navigate to the required Forum. See "Navigating to Forums & Forum Groups"

 2. At Display Thread From (located in the bottom right corner of the module), select a timeframe to filter thread by from these options: 
Today, Past Three Days, Past Week, Past Two Weeks, Past Month, Past Three Months, Past Year, All Days. This displays all 
matching threads.

Filtering Threads from a Single Forum

Viewing a Forum as an RSS Feed
How to view a forum as an RSS feed using the Forum module.

 1. Navigate to the required forum. See "Navigating to Forums & Forum Groups"



 1. Click the RSS  button located at the bottom right of the module. This displays the RSS feed.



Downloading a Post Attachment 
How to download an attachment associated with a post on the Forum module. Note: Attachment download may be disabled, enabled for 
all users, or restricted to authenticated user.

 1. Navigate to the required post. The attachment is displayed below the body of the post. 

 2. If the message "Login to download attachment" is displayed, anonymous download is not permitted. In this case you must login 
to download the attachment. 

 3. Click on the Attachment icon or the [Attachment Name] link and then save or open the attachment as required.



Downloading an Attachment

Forum Members
Viewing your Posts
How a forum member can view all of their posts to the Forum module.

 1. Select My Posts from the module actions menu - OR - Click the My Posts link in the top center of the Forum module. This dis-
plays a list of your posts.

 2. Optional. Click on the [Post Title] link to view the associated thread.

Viewing Your Posts



Tip: When viewing a thread, you can order it from Oldest To Newest or Newest To Oldest by selecting either option from the drop-down 
box located in the bottom right corner of the page.

Adding a Forum Post (Basic)
How to add an entry (commonly known as a post) to a forum in the Forums module. This tutorial covers the basic options which are avail-
able when the default settings are applied to the Forum module.

 1. Navigate to the forum where you want to add the new post. See "Navigating to Forums & Forum Groups"

 2. Click the New Thread link.

 3. In the Subject text box, enter the subject of this post. This becomes the title of this post as it appears in the forum, therefore 
choose a subject that best describes the purpose and content of the post. 

 4. In the Editor, enter the body of the post. See "About the Editor"

 5. Optional. At Notification, check  the check box if you wish to receive an email when the post has a response.

 6. At Thread Status, select one of the following options: 

 l (None Specified): Select for no status to be displayed. This is the default option. 

 l Unresolved: Select if the post asks a question requiring resolution. 

 l Resolved: Select if the post is resolved or resolves a question. Typically this option is only selected when an existing 
post is answered. 

 l Informative: Select if the post provides information.

 7. Optional. At Terms, select one or more terms associated with this thread.

 8. Optional. Click the Preview link to preview the post. If you wish to edit it further, click the Return To Edit link.



 9. Click the Submit link.  If the post does not require moderation it is immediately added to the forum and is now displayed to you. If 
the post requires moderation a message is displayed explaining the moderation process. In this case, click the Return To Forum 
link.



The Newly Added Post

Adding a Forum Post (Advanced)
How to add an entry (commonly known as a post) to a forum in the Forums module. This tutorial covers the optional fields which can be 
enabled by Forum Administrators (See "Setting Forum Options" and "Setting Forum Permissions".)

 1. Navigate to the forum that you want to add the a new post to. See "Navigating to Forums & Forum Groups"

 2. Click the New Thread link.

 3. In the Subject text box, enter the subject of the thread. This will be the title of the post as it appears in the forum so choose a sub-
ject that best describes the purpose and content of the post. 

 4. In the Editor, enter the body of the post. 

 5. The following optional settings may also be available: 

 a. At Attachments, select from these options:

 l To attach an attachment upload which was completed for this session or previously terminated sessions, 
select it from the Uploaded Attachments window. Note: You can delete an uploaded file, by selecting it from 
the list and then clicking the Delete  button.

 l To upload a new attachment, click the Browse button and select the file to be attached from your computer 
and then click the Upload link.

 b. At Pinned, check  the check box to 'pin' this post above existing posts in this forum, or uncheck  the check box to 
have the post appear in date/time order as is typical. 



 c. At Notification, check  the check box to be notified when a reply is made to this post or uncheck  the check box to 
disable notification. 

 d. At Locked, check  the check box to prevent others from replying to this post or uncheck   the check box to permit 
replies.

 e. At Thread Status, select one of the following options: 

 l (None Specified): select for no status to be displayed. This is the default option. 

 l Unresolved: select if the post asks a question requiring resolution. 

 l Resolved: select if the post is resolved or resolves a question. Typically this option is only selected when an 
existing post is answered. 

 l Informative: select if the post provides information.

 f. At Terms click the drop-down box and then check the check box beside a term which relates to this post.

 i. Repeat the above step to associate additional terms.

 6. Optional. Click the Preview link to preview the post. If you wish to edit it further, click the Return To Edit link.

 7. Click the Submit link. If the post does not require moderation it is immediately added to the forum and is now displayed to you. If 
the post requires moderation a message is displayed explaining the moderation process.  In this case, click the Return To Forum 
link.



Adding a Post Including Attachments and Optional Settings

Editing your Forum Posts
How a forum member can edit their own posts on the Forum module. Note: Post editing may be restricted to a number of minutes fol-
lowing the original posting.

 1. View your threads. See "Viewing your Threads"

 2. Locate the required post and then open it by clicking on the [post title] link.

 3. Click the Edit link located to the right of the post title. This opens the Add/Edit Post page.

 4. Edit the subject or body or attach files as required. See "Adding a Forum Post (Advanced)"

 5. Click the Submit link.  The post is immediately added to the forum and displayed to you.



Editing Your Post

Related Topics:

 l See "Editing Global User Settings"

Quoting a Post
How to quote an existing forum post when replying it on the Forum module. Quoting adds the name of the poster and the content of the 
post to the post you are adding.

 1. Locate and open the required post. See "Viewing any Post"



 2. Click the     Quote link located to the right of the post title.  This opens the Add/Edit Post page which displays the quoted post in the 
Editor.

 3. In the Editor, add your post in reference to the quote.

 4. Optional. At Notification, check  the check box if you wish to receive an email when the post has a response.



 5. Click the Submit link.  If the post does not require moderation it is immediately added to the forum and is now displayed to you. If 
the post requires moderation a message is displayed explaining the moderation process.



The Quoted Post

Replying to a Post
How to reply to a post in the Forum module.

 1. Locate and open the required post. See "Viewing any Post"



 2. Click the Reply link located top right above the post.  This opens the Add/Edit Post page which displays the post in the Editor.

 3. In the Editor, enter your post, any attachments and set optional fields as required See "Adding a Forum Post (Advanced)"

 4. Optional. At Notification, check  the check box if you wish to receive an email when the post has a response.

 5. Click the Submit link.

Replying to a Post

Reporting a Post
How to report an inappropriate post on the Forum module. This sends a report email to the associated Forum Moderators/Administrators. 
Note: This option may be disabled.

 1. Navigate to the post. See "Viewing any Post"



 2. Click the Report Post link. This opens the Report Post page. 

 3. At Email Template, select the reason for reporting the post from these options: 

 l Post is Duplicate

 l Post is Against Policy 

 l Post is Spam 



 l Post Off Topic 

 l Post Contains Profanity

 l Post Contains Excessive Advertising

 4. Optional. In the Emailed Response text box, edit email message.

 4. Click the Report Post link. This displays the message "Are you sure you want to report this post?"

 5. Click the OK button to confirm. The post now displays the Report Warning  icon. Mouse over the icon to view the number of 
reports against this post.



A Reported Post

Deleting a Forum Post
How authorized users can permanently delete a post from the Forum module.

 1. Locate and open the required post. See "Viewing any Post"

 2. Click the Delete link located to the right of the post title.



 3. Optional. Complete this step to send email notification to the poster that this post has been deleted:

 a. At Email Template, select the reason why the post is being deleted.

 b. Optional. In the Emailed Response, edit the message to be emailed to the poster.

 c. At Email User, check  the check box to email the poster. 

 4. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 5. Click the OK button to confirm.



Deleting a Post

Viewing your Threads
How a forum member can view all of their threads to the Forum module.

 1. Select My Threads from the module actions menu - OR - Click the My Threads link in the top center of the Forum module.



 2. Optional. Click on the title of a thread to view it in full.

Tip: When viewing a thread, you can order it from Oldest To Newest or Newest To Oldest by selecting either option from the drop-down 
box located in the bottom right corner of the page.

Adding a Bookmark to a Thread
How to add a bookmark to a thread in the Forum module. Threads with a bookmark are listed in your User Settings Control Panel.

 1. Locate and open the required thread. See "Viewing any Post"

 2. Click the Add To Bookmarks  button to add  a bookmark - OR - Click the Remove From Bookmarks  button to remove 
the bookmark.

Rating a Thread     
How to add a rating to a thread in the Forum module. Note: Ratings may be disabled on some or all forums.



 1. Locate and open the required thread. See "Viewing any Post"

 2. In the top right-hand corner of the module, a series of Stars are displayed.

 3. Click on the star rating that you want to give. This adds your rating to all existing ratings and displays the average rating on the 
thread.

The Rated Thread

Moving a Thread
How to move a thread to a new forum in the Forum module. Moderators require moderate permissions on the particular forum to move a 
thread.       See "Setting Forum Permissions"



 1. Locate and open the required thread. "Viewing any Post".

 2. Click the  Move link beside the post. This opens the Move Thread page.

 3. At New Forum, check  the check box associated with the new forum for this new thread.

 4. Optional. At Email Users of Thread Move, check  the check box to notify all users participating in this thread that this thread 
has been moved - OR - Uncheck  the check box for no email notification.

 5. Click the Move Thread link.

Splitting  a Thread
How to split a post from its current thread and start it as a new thread in the Forum module. Moderators require moderate permissions on 
the particular forum to split a thread.       See "Setting Forum Permissions"

 1. Locate and open the required post. See "Viewing any Post"



 2. Click the  Split link beside the post. This displays the Split Thread page.

 3. At Splitting Post, you can view the title of the first post of the new thread being created by splitting this existing one

 4. At New Forum, check  the check box associated with the new forum for this split thread.

 5. Optional. At Email Post Authors, check  the check box to notify all users participating in this thread that this thread has been 
moved - OR - Uncheck  the check box for no email notification.

 6. Optional. At Include Post In New Thread, check  the check box to include other posts in this thread - OR - Uncheck  the 
check box to only include the post selected for splitting. E.g. The first post listed here.

 7. Click the Split Thread link. This displays the message "All Posts which are not approved and are being split into the new thread 
will be approved during the split!"

 8. Click the OK button to confirm.



Splitting a Thread

Setting Thread Status
How to set the status of a thread in the Forum module. This setting can be a useful housekeeping tool which helps users quickly identify 
when a post is informative or when a question is or isn't answered. Note: This option may be disabled.

 1. Locate and open the required post. See "Viewing any Post"

 2. At the (None Specified) drop-down box, select either None Specified, Unresolved, Resolved, or Informative.



Setting Thread Status

Editing your Forum Profile
How to edit your user profile via the Forum module. Note: This tutorial explains how to manage your user profile when the Forum module 
uses the core DNN User Profile. Where an alternate non-core module is used, you must follow instructions provided by your module 
developer from Step 2.

 1. Select My Settings from the module actions menu - OR - Click the My Settings link. This opens the User Settings page. The Con-
trol Panel > Overview window is displayed.

 2. In the right-hand panel, select Profile > Edit Profile. This displays your User Profile for this site. 

 3. Modify your profile as required. See "Managing your User Profile","Managing your User Credentials". or "Managing your Profile 
Photo".

Editing your Forum Signature
How to edit your forum signature using the Forum module.

 1. Select My Settings from the module actions menu - OR - Click the My Settings link. This opens the User Settings page. The Con-
trol Panel > Overview window is displayed.

 2. In the right-hand panel, select Profile > Edit Signature. This displays the Edit Signature page. 



 3. In the Signature text box, add/edit your signature. Basic HTML formatting may be disabled.

 4. Optional. Click the Preview link to preview the signature. This displays a preview of the signature on this page.

 a. Click the Edit link to edit this signature.

 5. Click the Update link.

Editing Your Signature (This image displays Signature in Preview mode)

Editing your Forum Settings
How to manage your forum settings using the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Forum > Edit Settings. This displays the User Forum Settings window.

 3. At Email Format, select HTML or Text.

 4. In the Threads Per Page text box, enter the number of threads to be displayed on one page at one time. The default setting is 10. 
Note: Authenticated Users can override this setting for themselves on the My Settings page. 

 5. In the Posts Per Page text box, enter the number of posts to be displayed on one page at one time. The default setting is 5. Note: 
Authenticated Users can override this setting for themselves on the My Settings page.

 6. At Notify on Reply, check  the check box if  the users will receive notification of replies in threads they have posted in. 
Note: They can opt-out of notifications when they post - OR - Uncheck  the check box disable.

 7. At Enable "My Post" Notify, check  the check box if  the users will receive email notification of their own posts - OR - Uncheck 
 the check box disable.

 8. At Moderator Emails, check  the check box if  the users will receive email notification of new posts awaiting moderation - OR - 
Uncheck  the check box disable.

 9. At Clear All Read Status, click the Clear Read Status link to clear all read status for all forums and threads for this user.

 10. Click the Update link.



Editing Your Forum User Settings

Manage Notifications
How to manage your notifications for forums and threads which you have chosen to track using the Forum module.

 1. Select My Settings from the module actions menu - OR - Click the My Settings link. This opens the User Settings page. The Con-
trol Panel > Overview window is displayed.

 2. In the right-hand panel, select Control Panel > Notifications. This displays the Tracked Forums and Threads window with the For-
ums tab selected.

 3. On the Forums tab, you can perform the following:

 l Remove Tracking: Click on the Delete  button beside a thread to stop tracking it.

 l Go to Forum: In the Forum column, click on the [Forum Name] link to go to that forum.

 l View Last Post: In the Last Post column, click on the [Date/Time] link to view the last post.

 4. On the Threads tab you can perform the following:

 

Managing Forum Bookmarks
How to manage your thread bookmarks which you have chosen to track using the Forum module.

 1. Select My Settings from the module actions menu - OR - Click the My Settings link. This opens the User Settings page. The Con-
trol Panel > Overview window is displayed.

 2. In the right-hand panel, select Control Panel > Bookmarks. This displays Bookmarks window.

 3. You can perform these options:

 l Remove Bookmark: Click on the Delete  button beside a bookmark

 l Go to Thread: In the Subject column, click on the [Thread Name] link



 l View Last Post: In the Last Post column, click on the [Date/Time] link

Related Topics:

 l See "Adding a Bookmark to a Thread"

Forum Moderators
Navigating to the Moderator Post Queue

 1. Select Moderate from the module actions menu - OR - Click the Moderate link. This opens the Moderator Control Panel.

 2. In the left-hand panel, select Post Queue. This displays a summary list of forums with posts awaiting approval.



Approving a Post
How forum moderators and Administrators can approve a post to a moderated forum.

 1. Go to the moderator post queue. See "Navigating to the Moderator Post Queue"

 2. In the Forum column, click on a [Forum Name] link to view posts requiring moderation in that forum.

 3. Click the  Approve link beside the post to be approved.



 4. Repeat Step 3 to approve additional posts. 

 5. Click the  Cancel link to return to the module.

Approving and Editing a Post
How forum moderators and administrators can approve a post and edit the content of the post. E.g. Spelling or grammatical errors.

 1. Go to the moderator post queue. See "Navigating to the Moderator Post Queue"

 2. In the Forum column, click on a [Forum Name] link to view posts requiring moderation in that forum.

 1. Click the Edit link beside the required post. This opens the Add/Edit Post page.

 2. Edit the post in the Editor. 

 3. Optional. Edit one or more of these settings: 

 a. At Attachments, modify the attachments if required.

 b. At Pinned, check  the check box to set this post to always appear at the top of the related forum group.

 c. At Notification, check  the check box if you wish to be notified of replies to this post.

 d. At Locked check  the check box to disable replies to this post.

 e. At Thread Status, update the status as required. E.g. Informative

 f. At Terms,  click the drop-down box and then check  the check box beside a term which relates to this post.

 i. Repeat the above step to associate additional terms.

 4. Optional. Click the Preview link to preview the edited post. 

 5. Click the Submit link. 



Approving and Editing a Moderated Post

Approving and Replying to a Post
How to approve a post and add reply to the post.

 1. Go to the moderator post queue. See "Navigating to the Moderator Post Queue"



 2. In the Forum column, click on a [Forum Name] link to view posts requiring moderation in that forum.

 3. Click the Reply link beside the required post. This opens the Add/Edit Post page.

 4. Enter your reply in the Editor. 

 5. Optional. Add/set one or more of these settings: 

 a. At Attachments, modify the attachments if required.

 b. At Pinned, check  the check box to set this post to always appear at the top of the related forum group.

 c. At Notification, check  the check box if you wish to be notified of replies to this post.

 d. At Locked, check  the check box to disable replies to this post.

 6. Optional. Click the Preview link to preview the edited post. 

 7. Click the Submit link.



Approving a Moderated Post and adding a Reply

Approving and Splitting a Post awaiting Moderation
How to split a post in the moderation queue from its current thread and start it as a new thread in the Forum module.

 1. Go to the moderator post queue. See "Navigating to the Moderator Post Queue"

 2. In the Forum column, click on a [Forum Name] link to view posts requiring moderation in that forum.



 3. Click the Split link beside the required post. This opens the Add/Edit Post page.

 4. Enter your reply in the Editor. 

 5. Optional. Add/set one or more of these settings: 

 a. At Attachments, modify the attachments if required.

 b. At Pinned, check  the check box to set this post to always appear at the top of the related forum group.

 c. At Notification, check  the check box if you wish to be notified of replies to this post.

 d. At Notification, check  the check box if you wish to be notified of replies to this post.

 e. At Locked, check  the check box to disable replies to this post.

 6. Optional. Click the Preview link to preview the edited post. 

 7. Click the Submit link.

Deleting a Post awaiting Moderation
How a forum moderator or an Administrator can delete a forum post in the moderation queue. These posts never appear on the site. A 
response explaining the reason for the deletion is emailed to the poster.

 1. Go to the moderator post queue. See "Navigating to the Moderator Post Queue"

 2. In the Forum column, click on a [Forum Name] link to view posts requiring moderation in that forum.



 3. Click the Delete button. This opens the Delete Post page where you can edit and/or view the email template sent to the poster. 

 4. At Email Template, select the reason why the post is being deleted. This populates the Emailed Response text box below with a 
standard message for the selected reason.

 5. Optional. At Emailed Response, edit the text of the email if required. 

 6. Optional. At Email User, check  the check box to email the poster - OR - Uncheck  the check box if no email is required. 

 7. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?"    

 8. Click the OK button to confirm.

Deleting a post awaiting moderation

Managing Reported Posts
How to manage posts that have been reported.

 1. Select Moderate from the module actions menu - OR - Click the Moderate link. This opens the Moderator Control Panel.



 2. In the left-hand panel, select Reported Posts. This displays a summary list of reported posts.

 3. In the Post column, click on a post title link to view the post in full.

 4. Optional. Click the Click To Address Report  button to address this reported post. This displays the This Report Has Been 
Addressed  icon.

 5. Address the reported post as required.

Viewing Banned Users
How to view a list of users who are been banned from the Forum module.

 1. Select Moderate from the module actions menu - OR - Click the Moderate link. This opens the Moderator Control Panel.



 2. In the left-hand panel, select Users > Banned. This displays a summary list of banned users.

 3. In the User column, click on a user name link to view the users profile.

Related Topics:

 l See "Editing Global User Settings"

Viewing Reported Users
How to view the profile of users who are been reported on the Forum module.

 1. Select Moderate from the module actions menu - OR - Click the Moderate link. This opens the Moderator Control Panel.

 2. In the left-hand panel, select Users > Reported. This displays a summary list of reported users.

 3. In the User column, click on a user name link to view the users profile.

Forum Administrators
Content
Enabling/Disabling Word Filtering
How to enable or disable the filtering of words in the body of posts, including an option to also filter the subject of posts.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Filter Settings. This displays the Filter Management window.

 3. At Enable Word Filter,  check  the check box to enable word filtering in post body - OR - Uncheck  the check box to disable. If 
this option is unchecked, skip to Step 5. 

 4. At Filter Subjects,  check  the check box to enable word filtering in the subject of posts - OR - Uncheck  the check box to dis-
able. 

 5. Click the Update link.



Enabling Word Filtering

Adding a Filtered Word
How to set words to be filtered from posts and either removed from the post or  replaced with an alternate word in forum posts.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Filter Words. This displays the Filtered Word Management window.

 3. In the Filter text box, enter the word to be filtered. 

 4. In the Replacement text box, enter the replacement word - OR - Leave blank to remove the filter word without replacing it.

 5. Click the Add  button. The newly added filtered word is now displayed in the Filtered Word List on this page.



Tip: You can filter any content such as numbers and phrases.

Editing Filtered Words
How to edit a filtered word and/or its replacement word in the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Filter Words. This displays the Filtered Word Management window.

 3. In the Filter column, locate the filtered word to be edited. See "Filtering Filter Words"

 4. Click the Edit  button.

 1. Edit the Filter and/or the optional Replacement word as required. 

 2. Click the Update  button.



Editing Filtered Words

Filtering Filter Words
How to view all filtered words or filter them by the first letter of the filtered word for the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Filter Words. This displays the Filtered Word Management window.

 3. At the Filter Words drop-down list, select All to view all words- OR - Select the first letter of the filtered word. This displays match-
ing results in alphabetical order. Note: Use the linked page numbers to navigate to words displayed on another page.

Filtering Filtered Words

Tip: The filter will continue to be applied until you either click the All link or navigate to another section and then return to the Filtered 
Word Management section.

 

Deleting a Filtered Word
How to delete a filtered word from the Forum module.



 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Filter Words. This displays the Filtered Word Management window.

 3. In the Filter column, locate the word to be deleted. See "Filtering Filter Words"

 4. Click the Delete  button.            This displays the message "Are You Sure You Wish To Delete This Item?"    

 5. Click the OK button to confirm.

Deleting a Filtered Word

Managing Rating of Threads

How to enable or disable the users to rate  threads and optionally replace the star   icon(s) with text. Note: Rating must be enabled on 
individual forums. See "Setting Forum Options"

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Rating. This displays the Rating Management window.

 3. At Enable, check  the check box to enable users to rate a thread  - OR - Uncheck  the check box to disable. 

 4. In the Rating Scale text box, enter a number that represents the highest rating for a thread. This sets the maximum number of 
stars. The default is 5. Note: Changing this will not update existing post ratings.

 5. Click the Update link.



Enabling Thread Rating and Setting Maximum Number of Stars

Managing Forum User Ranking
How to enable or disable ranking of forum users and set the number of posts required to achieve ranking positions in the Forum module. 
If enabled, the ranking images will display in the user posts avatar area.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content >       Ranking. This displays the Ranking Management window.

 3. At Enable,  check  the check box to enable ranking  - OR - Uncheck  the check box to disable. 

 4. At Enable Images,  check  the check box to display ranking as images  - OR - Uncheck  the check box to display ranking as 
text. If this option is checked then the images displayed on this page will be used. 

 5. At 1st Rank complete the following:

 a. In the Count text box (left), edit the number of posts required for a poster to rank as 1st.  

 b. In the Title text box (right), enter/edit a title to be displayed for this level of ranking. If the field is left blank then the title of 
"1st Level Poster" is displayed. Note: If the Enable Images check box above is checked  then this option is not used. 

 6. Repeat Steps 5 to manage 2nd-10th ranking fields. 

 7. Optional. In the No Ranking text box, enter a title to be displayed for users without any ranking. Note: If the Enable Images check 
box above is checked, then this option is not used.

 8. Click the Update link.



Configuring Post Ranking Settings

Managing Popular Thread Status
How to set the number of times a thread must be viewed and replied to be marked as a popular thread in the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Content > Popular Status. This displays the Popular Status Management window.

 3. In the View Count text box, enter the number of views required before a thread is marked as popular - OR - leave blank if the 
number of views is not taken into account. The default setting is 200.

 4. In the Reply Count text box, enter the number of replies required before a thread is marked as popular - OR - leave blank if the 
number of replies not taken into account. The default setting is 10.

 5. In the Active Within text box, enter the number of days since the last post for a thread to be marked as popular. The default setting 
is 7.

 6. Click the Update link.



Managing Popular Thread Status

Control Panel
Configuring General Forum Settings
How to configure the general settings of the Forums module such as the forum name and enable other basic setting.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Control Panel >       General. This displays the General Configuration window. 

 3. At Aggregated Forums, check  the check box to enable an aggregated view of threads in all public forums - OR - Uncheck   
the check box to disable. 

 4. At Enable Thread Status, check  the check box to enable users to set the status of any posts they began - OR - Uncheck  
the check box to disable. If enabled, thread status can be set as Unresolved, Resolved or Informative. Setting thread status is 
optional. 

 5. At Enable Post Abuse, check  the check box to enable user to report any post to moderators and/or Administrators - OR - 
Uncheck  the check box to disable. 

 6. At Disable HTML Posting, check  the check box to use a plain text box to enter posts - OR - Uncheck  the check box to use 
the Rich Text Editor and enable HTML posts. 

 7. At Date Last Indexed, the date and time when the Forum content was last indexed (added to DNN search) is displayed. To re-
index forum content click the Reset link. This will re-index all forum content again and the new date will be displayed. Depend-
ing on how busy your Forum is you may like to make this a weekly, fortnightly or monthly task.

 8. Click the Update link.



General Configuration Settings for the Forum

Configuring the Forum Community Management Settings
How to enable the use of an external non-core module to display profile information. Note: This is not necessary for most installs.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Control Panel > Community. This displays the Community Management window.

 3. At Enable External Profile, check  the check box to enable use of a non-core module for user profiles. This exposes addi-
tional settings - OR - Uncheck  the check box to disable external profile and skip to Step 8.

 4. At Profile Page, select the page that contains your profile module. 

 5. In the Profile User Parameter text box, enter the  URL parameter associated with the UserID necessary for user profiles. This 
parameter is required by the non-core module.

 6. In the Profile Parameter Name text box, enter the extra URL property for the non-core module. The URL parameter name will 
be passed in combination with the value for  external profile pages. 

 7. In the Profile Parameter Value text box, enter a value to be passed in combination with Parameter Name for the non-core mod-
ule.

 8. Click the Update link.



Forum Community Management Settings

Enabling/Disabling Attachments
How to enable or disable the attaching of files to  forum posts, as well as configure additional attachment settings on the Forums module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Control Panel >  Attachments. This displays the Attachment Management window. 

 3. At Enable File Attachment,  check  the check box to enable attachments - OR - Uncheck  the check box to disable file attach-
ment and skip to Step 7. 

 4. At Anonymous Downloads,  check  the check box to enable files to be downloaded by unauthorized users - OR - Uncheck  
the check box to disable. Note: File permissions also control access to files.

 5. In the Attachments Path text box, edit the location where attachments are stored in the root directory of this portal's File Man-
ager.  I.e.  domain.com/Portals/0/

 6. In the Max Attachment Size text box, edit the maximum size for attachments in KB. Note: Additionally, the size set here should 
be no larger than what is permitted in the web.config.

 7. Click the Update link.



Managing forum post attachments

Managing RSS Feeds
How to enable or disable an RSS Feed being created for all public forums, as well as configure related settings.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page" 

 2. In the left-hand panel, select Control Panel >      RSS. This displays the RSS Management window. 

 3. At Enable RSS Feeds, check  the check box to enable RSS feeds for all public forums - OR - Uncheck  the check box to dis-
able and skip to Step 6. 

 4. In the Threads Per Feed text box, enter the number of post threads to be displayed in the feed. The default value is 20 threads. 

 5. In the Time To Live text box, enter the frequency in minutes that the RSS is cached before refreshing. The default value is 30 min-
utes. 

 6. Click the Update link.



Manage RSS Feeds for Forums

Configuring the Forum Search Engine Optimization            
How to configure Search Engine Optimization (SEO) settings on the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page" 

 2. In the left-hand panel, select Control Panel >        SEO. This displays the SEO Management window. 

 3. At User's Website No Follow,  check  the check box to indicate to search engines that links entered in user posts should be 
indexed as part of this web site - OR - Uncheck  the check box to indicate that search engines should index these links as rel-
evant to the site content and ranking. This option relates to both user posts and user profile. 

 4. At Override Page Title, check  the check box to override the page name with the forum name or thread name - OR - Uncheck 
 the check box to disable. 

 5. At Override Page Description, check   the check box to override the page description – OR - Uncheck  the check box to dis-
able.

 6. At Override Keywords, check   the check box to override the page keywords with ones pulled from within the module – OR - 
Uncheck  the check box to disable.

 7. At Latest Threads No Follow, check   the check box to indicate that the destination hyperlinks in the initial group view SHOULD 
NOT be afforded any additional weight or ranking by user agents which perform link analysis upon web pages (E.g. search 
engines). Note: This applies to the links in initial group view (6,12,24,48, view latest threads) typically seen when first viewing a 
page with the forum module placed on it - OR - Uncheck  the check box to disable.

 8. In the Sitemap Priority text box, enter the SEO Sitemap priority per thread (this number must be between 0.0 and 1.0). The 
default is 0.5. Note: This will only be enabled if the Forum SEO Sitemap provider is installed.

 9. Click the Update link.



Configuring the Forum Search Engine Optimization Settings

Email
Managing Email Settings
How to enable or disable email notifications for the Forum module as well as configure notification settings.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the right-hand panel, select Email > Email Settings. This displays the Email Management section.

 3. In the From Address text box, enter the from email address for all outgoing forum emails.

 4. In the Email Display Name text box, enter the friendly name to be used for outgoing email notifications from this forum.

 5. At Email Notifications, check  the check box to enable email notification for this module. This displays 3 additional settings- 
OR - Uncheck  the check box to disable. If unchecked, skip to Step 9.

 6. At Enable From Address Per Forum, check  the check box to enable the From address to be set on individual forums. See 
"Setting Forum Email" - OR - Uncheck  the check box to disable and use the address set in Step 3 above for all forums.

 7. At Enable Edit Emails, check  the check box to send a notification email to users when posts are edited - OR - Uncheck  the 
check box to disable.

 8. At Enable Email Queue,  check box is checked  to send notifications using the schedule - OR - Uncheck  the check box this 
feature is disabled. 

 9. Click the Update link.



Managing email notifications from the Forum module

Related Topics: 

 l See "Enabling/Disabling Scheduled Tasks"

Managing Email Templates
How to modify the subject and body of the email notifications sent from the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Email > Templates. This displays the Email Template Management window.

 3. At Email Template, select the template to be edited. 

 4. In the Email Subject text box, edit the name of the email subject. 

 5. In the HTML Email Body text box, edit the HTML version of the email. 

 6. In the Text Email Body text box, edit the text version of the email. 

 7. Click the Update link.

Note: The following replacement tokens are available to use in the subject and body of emails:

[FORUMNAME] Name of the forum
[POSTSUBJECT] Subject of the post
[DATEPOSTED] Date of the post
[POSTAUTHOR] Post Author
[POSTBODY] Post Body
[POSTURL] URL to view the post
[GROUPNAME] Name of forum group 
[PROFILELINK] Link to users profile



Managing Email Notification Templates

Viewing Email Subscribers  Report
How to view the email subscriber report for the Forum module.



 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Email > Subscribers. This displays the Email Subscribers Report window.

 3. Select a report type for the drop-down box. This displays details in the table below.

Viewing Email Subscribers  Report

Forums
Adding a Forum Group
How to add a new forum group to the Forum module. A forum group is like a category which enable you to organize forums into one or 
more groups. Users cannot actually post to a forum group, but rather to the forums within that group. Once you have created a forum 
group, one or more forums must be added to it. A forum group called Discussions which contains a forum called General is created by 
default.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management window.

 3. In the Group Name text box, enter a name for the forum group. 

 4. Click the Add  button.



Adding a Forum Group

Editing a Forum Group
How to edit the name of a forum group.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management window.

 3. Click the Edit Group  button beside the required forum group.

 4. Edit the forum group name in the exposed text box.

 5. Click the Update  button.



Editing a Forum Group

Re-Ordering Forum Groups
How to modify the view order of forum groups on the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management window.

 3. Click the Move Up  or Move Down  button beside a forum group to move it up or down one position respectively.

Reordering Forum Groups

Deleting a Forum Group
How to permanently delete a forum group, including all related forums and posts.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page" 

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management window. 

 3. Ensure the Forum Group is minimized  as this exposes the Delete button.



 4. Click the Delete  button. This displays the message "Are You Sure You Wish To Delete This Item?"    

 5. Click the OK button to confirm.

Deleting a Forum Group

Adding a Forum
How to add a new forum to the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page" 

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management section.

 3. Maximize  the Forum Group to which the forum will be added.

 4. Click the Add Forum  button located in the title bar of the selected group. This displays the General Settings tab of the Edit 
Forum window.

 5. At Forum is Enabled, check  the check box if the forum to be displayed and allowing posting  - OR - Uncheck  the check box 
if the forum is disabled.



 6. Optional. At Group, re-select the Forum Group if required. The group selected at step 3 will be pre-selected.

 7. Optional. At Parent Forum, select a parent for this forum.

 8. In the Forum Name text box, enter a name for the new forum.

 9. Optional. In the Description text box, enter a short description of the purpose of this forum and the intended content.

 10. Optional.  See "Setting Forum Permissions", "Setting Forum Options". or "Setting Forum Email".

 11. Click the Add link. The new forum is now added to the selected group.

 12. Optional. Maximize  the Forum Group to view the new forum.



The Newly Added Forum

Note: The Created By, Date Created, Updated By User and Date Updated fields on the Edit Forum page are automatically populated 
when the forum is added.

Details of the Newly Added Forum on the Edit Forum page

Editing a Forum
How to edit the name or settings of a forum.



 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management window.

 3. Maximize  the Forum Group associated with the forum to be edited.

 4. Click the Edit Forum  button beside the required forum.

 5. Edit any general settings (See "Adding a Forum"), forum options (See "Setting Forum Options",and "Setting Forum 
Permissions".) or forum email settings ("Setting Forum Email". as required.

 6. Click the Update link.

Editing a Forum

Enabling/Disabling a Forum
How to enable or disable a forum. Enabled forums are open for viewing to all those who can see it and posting for all  those who are per-
mitted to post to it. Disabled forums cannot be viewed and posted to. Note: An Enabled  or Disabled  icon to the right of the forum 
name indicates its current enabled or disabled status.

 1. Complete Steps 1-4 of "Editing a Forum". tutorial to access the Edit Forum page. 

 2. At Forum is Enabled, check  the check box to enable this forum - OR - Uncheck  the check box to disable it. 

 3. Click the Update link.



Enabling or disabling a forum

Re-ordering Forums
How to modify the order of forums within a forum group using the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Forums > Forum Manager. This displays the Forum & Group Management window.

 3. Maximize  the Forum Group associated with the forum to be edited.

 4. Click the Move Up  or Move Down  buttons beside a forum to move it up or down one position respectively.

 5. Repeat Steps 3-4 to re-order forums within another forum group.



Reordering Forums

Setting Forum Email
How to configure the email settings for individual forums. Note: Only the “From” email address and display name are used at this time.

Note: The Enable Form Address Per Forum field must be enabled to access this page. See "Managing Email Settings"

 1. Complete Steps 1-4 of editing a forum. See "Editing a Forum"

 2. Select the Email tab.

 3. On the Edit Forum page, click on the Email link and complete these optional settings:

 4.  In the Forum "From" Email Address text box, edit the email address that will be displayed for all outgoing emails for this par-
ticular forum.

 5. In the Email Display Name text box, enter the  friendly display name used on outgoing emails sent from this forum.

 6. Click the Update link.

Setting Forum Options



Setting Forum Options
How to configure the optional settings for individual forums. This tutorial assumes you are in the process of adding a new forum or editing 
an existing forum.

 1. Complete Steps 1-4 of "Editing a Forum". This will take you to the Edit Forum page.

 2. Select the Options tab.

 3. At Forum Type, select from the following options: 

 l Normal: This is the usual option for a forum. 

 l Notification: This option is the same as a normal forum however all forum users will receive notification of new posts 
and are unable to unsubscribe from notifications. 

 l Link: This option redirect user to designated link and can be used to redirect users to old or disabled forums. If this 
option is selected a field called Forum Link will be displayed where you can select the URL link.

 4. At Forum Behavior, select from the following options which will modify the available options when setting role permissions 
below:

 l Public Moderation: A public moderated forum that is available to everyone who can view the module. 

 l Public Moderation w/Post Restrictions: A public moderated forum that enables everyone who can view the module to 
view posts, but only authorized users to add post.

 l Public No Moderation: A public un-moderated forum which enables everyone who can view the module to view and 
add posts.

 l Public No Moderation w/Post Restrictions: A public un-moderated forum that enables everyone who can view the 
module to view posts, but only authorized users to add post.

 l Private Moderation: A private moderated forum that is available to everyone who can view the module.

 l Private Moderation w/Post Restrictions: A private moderated forum that enables everyone who can view the module 
to view posts, but only authorized users to add post.

 l Private No Moderation: A private un-moderated forum which enables everyone who can view the module to view and 
add posts.

 l Private No Moderation w/Post Restrictions: A private un-moderated forum that enables everyone who can view the 
module to view posts, but only authorized users to add post.

 5. At Enable Polls, check  the check box to enable users who can begin a thread to attach a poll  which other users to participant 
in - OR - Uncheck  the check box to disable.

 6. At Enable Thread Status, check  the check box to enable users to change the status of a thread - OR - Uncheck  the check 
box to disable. See "Managing Popular Thread Status"

 7. At Enable Thread Ratings, check  the check box to enable users to rate threads - OR - Uncheck  the check box to disable. 
See "Managing Rating of Threads"

 8. At Enable RSS Feed, check  the check box to enable users to view an RSS feed for the specified forum (as long as it isn't Pri-
vate) - OR - Uncheck  the check box to disable.

 9. At Enable Sitemap, check  the check box to enable threads created within this forum will be exposed to the SEO Sitemap pro-
vider (as long as it isn't Private) - OR - Uncheck  the check box to disable.



 10. In the Site Map Priority text box, enter a number between 0.1- 1.0 that is used to determine the SEO Sitemap priority. This 
requires changes to your web.config, where you can add the forum SEO Sitemap provider manually.

 11. Click the Update link.

Setting Forum Options

Setting Forum Permissions
How to set unique permissions for individual Forums within the Forum module.



 1. Complete Steps 1-4 of "Editing a Forum". This will take you to the Edit Forum page.

 2. Select the Options tab.

 3. Go to the Permissions grid.

 4. Optional. In the User text box, enter the username of a user that you want to grant or deny module permissions for, and then 
click the Add link. Repeat for additional usernames.

 5. Optional. At Filter By Group, select from the following options: 

 l < All Roles >: Select to view all roles (both global and group roles) in one single list. 

 l < Global Roles >: Select to view all roles which are not associated with a Role Group. This includes Administrators, All 
Users, Registered Users, and Unauthenticated Users. 

 l [Role Name]: Select the name of a Role Group to view the roles within that group. 

 6. For each permission type (listed below), check  the check box beside each role to grant that permission - OR - Uncheck  the 
check box to deny that permission. Note: Some options may be disabled depending  Forum Type of this forum.

 l View: Select all roles that can view this forum. 

 l Start: Select all roles that can begin a new thread in this forum. 

 l Reply: Select all roles that can reply to a post in this forum. 

 l Moderate: Select all roles that can moderate on this forum. Administrators are enabled by default.

 l Attach: Select all roles that can add an attachment to their posts for this forum. Note: Users/Roles must be granted per-
mission to add files (See "Assigning Folder Permissions by Role" and "Assigning Folder Permissions to a User".) to the 
attachments folder in the File manager (typically Port Root/Forums/Attachments) unless set otherwise (See "Ena-
bling/Disabling Attachments"). Administrators are enabled by default.

 l Pin: Select all roles that can pin a thread on this forum. Pinned threads will appear at above other threads. Admin-
istrators are enabled by default.

 l Lock: Select all roles that can lock a thread on this forum. Replies cannot be made to locked threads. 

 l Notify: Select all roles that to receive moderator notification from this forum. 

 l Unmoderated: Select all roles that do not require moderation.

 7. To set permissions for an individual, enter their username into the Username text box and click the Add link to the right of the text 
box. You must then complete role permissions as for Step 2.

 8. To set permissions based on the permissions selected on another forum, select the forum name from the Load Permissions of 
Forum drop-down box. You can now edit these permission as shown at Step 2.

 9. Click the Add link.



Setting Forum Permissions

Loading Existing Forum Permissions
How to   load permissions from an existing forum to another forum using the Forum module. These permissions can then be edited if 
required.



 1. Complete Steps 1-4 of "Editing a Forum". This will take you to the Edit Forum page.

 2. Select the Options tab.

 3. At Load Permissions of Forum, select the forum you wish to load permissions from. This displays the permissions of the 
selected forum in the permissions grid above. If these permissions match the permissions you want for this forum, then skip to 
Step 7. Alternatively, complete the remaining steps to customize these permissions for this forum.

 4. Optional. In the User text box, enter the username of a user that you want to grant or deny module permissions for, and then 
click the Add link. Repeat for additional usernames.

 5. Optional. At Filter By Group, select from the following options: 

 l < All Roles >: Select to view all roles (both global and group roles) in one single list. 

 l < Global Roles >: Select to view all roles which are not associated with a Role Group. This includes Administrators, All 
Users, Registered Users, and Unauthenticated Users. 

 l [Role Name]: Select the name of a Role Group to view the roles within that group. 

 6. For each permission type (listed below), check  the check box beside each role to grant that permission - OR - Uncheck  the 
check box to deny that permission. Note: Some options may be disabled depending  Forum Type of this forum.

 l View: Select all roles that can view this forum. 

 l Start: Select all roles that can begin a new thread in this forum. 

 l Reply: Select all roles that can reply to a post in this forum. 

 l Moderate: Select all roles that can moderate on this forum. Administrators are enabled by default.

 l Attach: Select all roles that can add an attachment to their posts for this forum. Administrators are enabled by default.

 l Pin: Select all roles that can pin a thread on this forum. Pinned threads will appear at above other threads. Admin-
istrators are enabled by default.

 l Lock: Select all roles that can lock a thread on this forum. Replies cannot be made to locked threads. 

 l Notify: Select all roles that to receive moderator notification from this forum. 

 l Unmoderated: Select all roles that do not require moderation.

 7. Click the Update link.



Loading Existing Forum Permissions

Deleting a Forum
How to permanently delete a forum and all posts within that Forum using the Forums module.



 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page" 

 2. Select Forums > Forum Manager. This displays the Forum & Group Management section. 

 3. Maximize  the Forum Group  associated with the forum to be deleted.

 4. Click the Delete  button. This displays the message "Are You Sure You Wish To Delete This Item?"    

 5. Click the OK button to confirm.

Deleting a Forum

Users
Searching Forum User Accounts
How to search forum user accounts by username, email, display name, first name or last name.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Users > Users. This displays the User Management window.

 3. Select from these two options:

Option One:

 1. In the Search text box, enter the search criteria. 

 2. Select one of the following filters from the drop down list: 

 l All: Returns all users whose account includes the criteria. 

 l Online: View all online users who match the search criteria.



 l Username: View all for exact matches and all or part of the beginning of the username. E.g. Entering Ad, Admin, or A will 
return Admin. 

 l Display Name: Searches for exact matches and all or part of the beginning of the display name. E.g. Entering R will return 
all names beginning with R.

 l Email: Displays partial and exact matches to the beginning of the email address.

 l First Name or Last Name: Searches for exact matches and all or part of the beginning of the name. E.g. Entering R will 
return all names beginning with R.

Option Two: 

 1. Select Role from the right-hand drop-down box. This displays each role type in the left-hand drop-down box.

 2. Select the name of the role from the first drop-down box.

Related Topics:

 l See "Editing any Forum User's Profile"

Editing any Forum User's Profile
How to edit any forum user's profile using the Forum module.

Tip: Field visibility is managed by the user on their DNN user profile.



Tip: Forum users can manage their own profile under My Settings.

 1. Search and located the required user. See "Searching Forum User Accounts"

 2. Locate the required user and click the Edit  button beside their username. This displays the Edit Profile page.

 3. Optional. If this is the first time you have visited this user's profile on this page, you can click the Update link and then Refresh 
(Ctrl + F5) the screen to view the user's Username, Site Alias and Email Address details. Alternatively, they will be viewable 
whenever you update this page.

 4. In the User ID text box, modify the user's unique identifier.

 5. At Username, here you can view the user's DNN username. Note: User's can click the link to edit their Account profile for this 
site.

 6. At Site Alias, view the alias shown to  other users of this module. This will either be the user's Display Name or Username, 
depending on module  settings.

 7. At Email Address, displays the user's email address. In addition, a checked  check box displayed if other forum users can 
view this user's email address in the user profile screen.

 8. At Trusted User, check  the check box if  the user's posts are not moderated - OR - Uncheck  the check box to enable mod-
eration.

 9. At Lock Trust, check  the check box if  the user's trust status can only be changed by module administrators - OR - Uncheck  
the check box if all forum administrators can edit the Trusted User settings.

 10. Click the Update link.



Viewing/Editing a Forum User's Profile

Editing any Forum User's Signature
How to edit any Forum user's signature using the Forum module.

 1. Search and located the required user. See "Searching Forum User Accounts"

 2. Locate the required user and click the Edit  button beside their username. This displays the Edit Profile page.

 3. In the Signature text box, add/edit the user's signature. Basic HTML formatting may be disabled. See "Setting a User's Forum 
Settings"



 4. Optional. Click the Preview link to preview the signature. This displays a preview of the signature on this page.

 a. Click the Edit link to edit this signature.

 5. Click the Update link.

Editing any Forum User's Signature (This image displays Signature in Preview mode)

Configuring System Avatars
How to enable systems avatars on the Forum module and configure the related settings.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Users > Avatars. This displays the Avatar Management window.

 3. At Enable User Avatars, uncheck  the check box to use system avatars.

 4. In the User Image Size Limit text box, enter the maximum upload size in KB for the avatar image. The default setting is 64.

 5. At Enable Avatar Pool, select from these options:

 l Check  the check box to enable you to upload a folder of images for users to choose from to represent their profile  ava-
tar.

 i. In the Pool Avatar Path text box, modify the folder where the Pool Avatars are stored if required.

 l Uncheck  the check box to disable.

 6. At Enable System Avatars, select from these options:

 l Check  the check box to Site Administrators and Forum  Administrators to assign avatar images to specific users of  their 
choice. This is done per user, not by role.

 a. Optional. In The System Avatar Path text box, modify the folder where the System Avatars are stored if required. 
Note: Forum Administrators must be given permission to view this folder. See "Assigning Folder Permissions by 
Role" or "Assigning Folder Permissions to a User".

 l Uncheck  the check box to disable. 

 7. At Enable Role Avatars, select from these options:

 l Check  the check box to assign avatar images based on roles.

 i. In the Role Avatar Path text box, modify the folder where the Role Avatars are stored if required.



 l Uncheck  the check box to disable.

 8. Click the Update link.

Configuring System Avatars

Enabling User Avatars
How to enable users to upload one image for their profile that will be displayed in posts view and also in their profile.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Users > Avatars. This displays the Avatar Management window.

 3. At Enable User Avatars, check  the check box to enable users to upload an avatar (image) which is displayed in their profile 
and beside their posts.

 4. At Enable Profile Avatar, select from these options:

 l Check  the check box to check box make the system looks for avatars uploaded to the user's core profile and complete 
these options.

 a. At Enable User Folders, select from these options:

 l Check  the check box to set  the system to utilize the core profile image control. This means the path to  the 
image will utilize user folders.

 i. At Profile Property, select the profile property associated with user avatar's in the core profile. 
Please note, this should be an ImageControl data type property.



 l Uncheck the check box to disable and set these options:

 i. At Profile Property, select the profile property associated with user avatars in the core profile. 
Please note, this should be an ImageControl data type property.

 ii. In the User Avatar Path text box, modify the folder where the Avatars are stored. Avatars are stored 
in the portal root directory. I.e. domain.com/Portals/0/. Important. Users must be given permission to 
add files to this folder. See "Assigning Folder Permissions by Role" or "Assigning Folder Per-
missions to a User".

 l Uncheck  the check box to disable and complete these fields:

 a. In the User Avatar Path text box, modify the folder where the Avatars are stored. Avatars are stored in the portal 
root directory. I.e. domain.com/Portals/0/. Important. Users must be given permission to add files to this folder. See 
"Assigning Folder Permissions by Role" or "Assigning Folder Permissions to a User".

 b. In the User Avatar Dimensions text boxes, enter the height and width in pixels (respectively) that avatars are dis-
played. The default setting is 128 x 128.

 c. In the User Image Size Limit text box, enter the maximum upload size in KB for the avatar image. The default set-
ting is 64.

 d. At Enable Avatar Pool, select from these options:

 l Check  the check box to enable you to upload a folder of images for users to choose from to represent 
their profile  avatar.

 i. In the Pool Avatar Path text box, modify the folder where the Pool Avatars are stored if required.

 l Uncheck  the check box to disable.

 5. At Enable System Avatars, select from these options:

 l Check  the check box to enable Administrators and Forum  Administrators to assign avatar images to specific users of  
their choice. This is done per user, not by role.

 a. Optional. In The System Avatar Path text box, modify the folder where the System Avatars are stored if required. 
Note: Forum Administrators must be given permission to view this folder. See "Assigning Folder Permissions by 
Role" or "Assigning Folder Permissions to a User".

 l Uncheck  the check box to disable. 

 6. At Enable Role Avatars, select from these options:

 l Check  the check box to assign avatar images based on roles.

 a. In the Role Avatar Path text box, modify the folder where the Role Avatars are stored if required.

 l Uncheck  the check box to disable.

 7. Click the Update link.

Editing Global User Settings
How to edit the global user settings for the Forum module.



 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Users > User Settings. This displays the User Settings Management window.

 3. At Member Name Display, select either Username or Display Name from the drop-down box. This sets the format the sites users 
will appear to users of this forum module.

 4. In the Post Editing Time text box, enter the number of minutes that users have to edit a previously posted item - OR - Enter 0 for 
indefinite editing.

 5. At Enable Auto Trust, select from these options:

 l Check  the check box if   users will be trusted once they meet the Auto Trust threshold setting. This exposes the Auto 
Trust Threshold field.

 l In the Auto Trust Threshold text box, enter the number of posts required before auto trust kicks in (if enabled). E.g. 
If this number is set to 100, after the untrusted user has their 100th post approved they will automatically have their 
trust status changed and their 101st post will go unmoderated (provided they have no other posts already in the 
queue).  Note: If this setting is set to 0 (zero) all new users will automatically be trusted.

 l Uncheck  the check box to disable.

 6. At Lock New User Trust, check  the check box if  user trust status can only be changed by administrators and not moderators - 
OR - Uncheck  the check box to disable.

 7. At Enable User Read Management, check  the check box if  users are permitted to mark all threads as read and also clear read 
status of all thread items - OR - Uncheck  the check box to prevent users from viewing these links (I.e. Community activity report-
ing can factor in thread reads).

 8. At User Signatures, check  the check box if to enable users to add a custom signature to their profile for the forum module. This 
signature displays in all posts as well as the users profile - OR - Uncheck  the check box to disable.

 9. At Mod Signature Edits, check  the check box to enable moderators to update users' signatures from the user profile area 
which is viewable by all users - OR - Uncheck  the check box to disable.

 10. At HTML Signatures, check  the check box if  users can use HTML code in their signatures - OR - Uncheck  the check box to 
disable.

 11. At User Banning, check  the check box to ban user - Uncheck  the check box to remove ban.

 12. Click the Update link.

Configuring the Default Forum User Interface
How to configure the default user interface setting for the Forum module.

 1. Go to the Forum Administration page. See "Navigating to the Forum Admin Page"

 2. In the left-hand panel, select Users > User Interface. This displays the User Interface Management window.

 3. In the Threads Per Page text box, enter the number of threads to be displayed on one page at one time. The default setting is 10. 
Note: Authenticated Users can override this setting for themselves on the My Settings page. 

 4. In the Posts Per Page text box, enter the number of posts to be displayed on one page at one time. The default setting is 5. Note: 
Authenticated Users can override this setting for themselves on the My Settings page.



 5. In the Thread Page Count text box, enter the number of the number of pages to show in threads view next to the thread 
subject. The default setting is 3.

 6. At Theme, select a theme to be used for this forum. 

 7. At Theme Image Extension, enter the extension of images used in the Theme. The default setting is png which relates to the 
Default theme.

 8. At Display Location, select from the following options: 

 l None: Select to hide the country of the poster. 

 l To Admin Users: Select to display the country of the poster to Administrators only. 

 l To All Users: Select to display the country of the poster to all users.

 9. At Display Region,  check  the check box to display the posters region - OR - Uncheck  the check box to hide.

 10. At Enable Quick Reply,  check  the check box to enable  users to post replies directly in posts view. This uses a normal text box 
and not a Rich Text Editor and is only visible to those with proper posting permissions - OR - Uncheck  the check box to dis-
able.

 11. At Enable User Tagging,  check  the check box  to enable authenticated users to tag threads in public forums - OR - Uncheck 
 the check box to disable.

 12. Click the Update link.

Setting the Forum User Interface

Overview of the Forum Administration Page 
The Forum Administration page enables Administrators and Forum Administrators (See "Setting Additional Forum Permissions" to set up 
this permission) to manage all aspects of the forum module, such as Groups, Forums, Users, Features and Email Notifications. 



The Forum Administration Home Page

Control Panel

 l Overview: Brief description of the Forum Administration section.

 l General: Manage general global forum settings.

 l Community: Used for integration with third party modules

 l Attachments: Enable/disable file attachments

 l RSS: Enable RSS Feeds

 l SEO: Manage the way forums are handled by search engines

Forums

 l Forum Manager: Manage new and existing forums and forum groups.

Users

 l Users: Manage individual user profiles, signatures, avatars, forum access and set users as trusted

 l Avatars: Manage default avatar settings

 l User Settings: Manage default user settings

 l User Interface: Manage default forum interface settings

Content

 l Filter Settings: Enable/disable word filtering

 l Filter Words: Set filtered words and their replacement words



 l Rating: Enable and manage user ratings

 l Ranking: Enable and manage user ranking

 l Popular Status: Manage popular thread settings.          

Email

 l Email Settings: Manages email settings.

 l Templates: Manage templates for emails sent to users and moderators.

 l Queue: Only available if the scheduled task is on and the email queue is enabled, allows hosts to set a time frame for keeping 
email queue related data.

 l Queue Tasks: Only available if the scheduled task is on and the email queue is enabled, allows administrators to see the most 
recent emails that have been queued up, along with who is receiving them and if the sends were successful or not.

 l Subscribers: Displays a list of forum notifications at the forum and thread levels.

Navigating to the Forum Admin Page
How to navigate to the Forum Administration page, also called the Forum Admin Control Panel, of the Forum module. Access to this page 
is restricted to Forum Administrators.

 1. Click the Admin link - OR - Select Admin from the Forum module actions menu.

 
Navigating to the Forum Administration Page

Settings
Setting Additional Forum Permissions
How to set the unique permissions for the Forum module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Permissions tab.



 3. Optional. In the Username text box, enter the username of a user to whom you wish to grant or deny module permissions, and 
then click the Add link. Repeat for additional usernames.

 4. Optional. At Filter By Group, select from the following options: 

 l < All Roles >: Select to view all roles (both global and group roles) in one single list. 

 l < Global Roles >: Select to view all roles which are not associated with a Role Group. This includes Administrators, All 
Users, Registered Users, and Unauthenticated Users. 

 l [Role Name]: Select the name of a Role Group to view the roles within that group.

 5. In the Forum Administrator column, check  each role that is able moderate one or more forums.

 6. In the Global Administrator column, check  each role that is able moderate all forums and access the Forum Admin page and 
manage all related settings.

 7. Click the  Update link.

Setting a Single or Aggregated Forum Group
How to pull content from the parent forum into a child forum using the Forum module. The parent forum is the forum where all forum 
groups and forums are created. The child forum is an instance of the existing parent module, set to only show the select forum group.

Note: These settings are stored on a per page/module basis so even a copy of a module can have a different default group.

 1. Add an existing Forum module. See "Adding an Existing Module (RibbonBar)" or "Adding an Existing Module (Iconbar)".

 2. Select  Settings from the module actions menu - OR - Click the Settings  button. Go to the Forum Settings section.



 3. At Forum Group, select from these options:

 l All Groups: Select to display all forum groups in this module

 l Aggregated: Select to automatically direct users to the aggregated thread view since only a single forum can possibly 
exist in that group.

 l [Group Name]: Select the name of a forum group to only display that group in this module.

 4. Click the  Update link.

A Single Forum Group display in an instance of the Forum Module

Default Forum
How to set the default forum  for this instance of the Forum module. Note: These settings are stored on a per page/module basis so even a 
copy of a module can have a different default forum.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the Forum Settings section.



 3. At Default Forum, perform the following:

 a. Maximize  the forum group where the required forum resides.

 b. Check the required forum.

 4. Click the  Update link.

Setting the Forum Group for a Forum Module

Gallery
About the Gallery Module 
The Gallery module manages multiple media formats. Media files can be categorized into albums, can be displayed in different views 
including a slideshow, and can be manipulated.

Module Version: 04.03.03

Minimum DNN Version: 04.09.03

The Gallery Module

Project Links



 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleGallery/tabid/843/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/9/scope/threads/Default.aspx

 l Issue Tracker: http://dnngallery.codeplex.com/workitem/list/basic

All Users
Setting Gallery View
How to set the way albums are viewed in the Gallery module. Note: This field may be disabled.

 1. At View, select from Card, List or Standard.

Gallery displayed in Card View

http://www.dotnetnuke.com/Products/Development/Forge/ModuleGallery/tabid/843/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/9/scope/threads/Default.aspx
http://dnngallery.codeplex.com/workitem/list/basic


Gallery displayed in List View



Gallery displayed in Standard View

Related Topics:

 l See "Configuring Display Settings"

Sorting Gallery Files
How to sort the files within albums in the Gallery module. The following options are typically available: Name, Size, Title, Author and 
Created Date. Additional fields which may be displayed are: Location, Score, OwnerID and Approved Date. Note: Sorting may be dis-
abled.

 1. At Sort By, select the field to sort files by. 

 2. Optional. At Desc, check  the check box to sort albums in descending order.



Sorting Albums

Related Topics:

 l See "Configuring Display Settings"

Opening Albums
How to navigate to and open albums using the Gallery Menu. Note: File and album editing tools are only available to authorized users.

Option One:

 1. Mouse over the Gallery  icon located in the top left corner of all gallery screens to view the gallery menu. 

 2. Click on an  [Album Name] to open that album. This displays the files and sub-albums within this album.

Tip: The multi-level navigation (as pictured below) which displays all of the albums including sub-albums within the current album may 
be disable. In this case, only the top level navigation is displayed which lists the albums directly below the current album.



Select an Album to Open

Option Two

 1. On the Gallery home page, click on the album cover - OR - Click on the linked [Album Name]. This displays the files and sub-
albums within this album.

 2. Repeat to open sub-albums.

Opening Albums

Tip: Click on the linked [Gallery Name] located in the top left corner of the module to go to the go to the Gallery home page. Breadcrumb 
links to albums may be enabled.



Gallery Home Link and Album Breadcrumbs

Opening the Album Menu
How to open the menu associated with an album using the Gallery Menu. Note: File and album editing tools are only available to author-
ized users.

Parent Albums

 1. Go to the Gallery Home page. This displays all of the parent albums.

 2. If the album is displayed in List View, the menu is displayed on the page - OR - If the album is displayed in Standard View or Card 
View, simply mouse over the album cover.

Sub-Albums (Child Albums)

Tip: Select a parent album to access its sub-album menus.

 1. Go to the Gallery Home page.

 2. Mouse over the  Gallery icon to view the gallery main menu.

 3. Select the parent of the required sub-album. E.g. In the below image, select the EcoZany Dolls album to access the Ruby album 
menu.



 4. If the album is displayed in List View, the menu is displayed on the page - OR - If the album is displayed in Standard View or Card 
View, simply mouse over the album cover.

The Album Menu in Standard View or Card View 



The Album Menu in List View

Opening the File Menu
How to access the file menu in the Gallery module. Note: The menu options displayed will depend on the gallery set-up as well as your 
level of access.

Standard and Card View: 

 1. Open the required album or sub-album. See "Opening Albums"

 2. Mouse over the file thumbnail. 



Displaying the File Menu in Standard or Card View

List View:

 1. Open the required album or sub-album. See "Opening Albums". The file menu is located to the right.



Displaying the File Menu in List View

Tip: Alternatively, users with edit rights can click the Edit  button on the Edit Album page.

Viewing and Manipulating an Image
How to manipulate an image inside an album within the Gallery module. Note: Changes can only be saved by administrators or the 
owner of the top level gallery or child album.

 1. Open the required album. See "Opening Albums"



 2. Click on the required image thumbnail or the linked [File Name]. This opens the Gallery Image Viewer.

 3. Select from the following tools which allow you to manipulate the image:

 l  Previous: Show previous image in the album.

 l  Next: Show next image in the album.

 l  Zoom Out: View a smaller version of the image. 

 l  Zoom In: View an enlarged version of the image. 

 l  Rotate 90° Left: Rotate the image counter clockwise 90°. 

 l  Rotate 90° Right: Rotate the image clockwise 90°. 

 l  Flip Horizontally: Flip the image in the horizontal plane. 

 l  Flip Vertically: Flip the image in the vertical plane. 



 l  Show In Color: Restore the color to colored images shown as black and white. 

 l  Show In Black: View a color image as black and white.

 4. Click the Close button to exit.

Viewing and Manipulating Images

Viewing Image Slideshow
How to view a slideshow of images inside an album of the Gallery module. Note: Slideshow may not be enabled.

 1. Navigate to the required album. See "Opening Albums"



 2. In Standard View/Card View, mouse over any image thumbnail and select  Slideshow - OR - In List View, click the Slideshow 
 button. This commences the slideshow from the chosen image. Images are displayed in accordance with the order in which 

they are sorted including descending order if enabled. 



 3. Click the Back button when you have finished.

Viewing Exif Metadata 
Exif (Exchangeable Image File Format) is a variation of the JPEG format and is used by most digital cameras. When you take a picture 
Exif Metadata information is stored for each picture. This information varies between cameras but can include information such as the 
date, time, camera settings, shutter speed, etc.

Here's how to view the Exif metadata of an image in the Gallery module:



 1. Open the required album. See "Opening Albums"

 2. Select the EXIF Data  button from the File Menu. See "Opening the File Menu"

 3. Select  EXIF Data from the File menu.



Viewing Exif Metadata (Standard View)

Downloading a File
How to download a file from the Gallery module. Note: You must be in one of the download roles (which may include “All Users”) spec-
ified in the Gallery configuration to download files.

 1. Open the required album. See "Opening Albums"

 2. Locate the required file. Then perform one of the following:

 l In List View, select then Download This File  button.



 l In Standard View/Card View, mouse over file and then select  Download.



Tip: For image file types, the file to be downloaded will be the full-resolution file which was originally uploaded rather than a reduced res-
olution file such as that presented when viewing the image.

Viewing File Ratings
How to view the overall rating as well as details of all ratings given to a media file within the Gallery module. The overall rating for a file is 
based on the average rating given by all users who have rated the files. A file can rate from 1 to 5 stars, including half star ratings. 
Note: Ratings may be disabled, or restricted to authorized users.

 1. Open the required album. See "Opening Albums"

 2. An overall rating of 1-5 stars is displayed  below the thumbnail image for each file. Note: A rating of 0 (zero) stars indicates that 
the file is not yet rated.



 3. Optional. To view more rating details, click the Rating  icons below the required image.  This opens the Media Rating 
page which displays the current rating information for this file including the overall rating and how it was calculated and a list of 
all individual ratings.



 4. Click the Back link to return.

Rating Files
How to apply a 1-5 star rating to files in the Gallery module. Only one vote is permitted per user. Note: Ratings may be disabled, or 
restricted to authorized users.

 1. View the rating details of the required file.        See "Viewing File Ratings"

 2. Click the Add View link.



 3. At Your Rating, select a 1-5 star rating.

 4. Optional. In the Comments text box, enter your comments.

 5. Click the Record Your Vote link.

Adding a Rating



Configuration
Configuring Admin Settings
How to configure the administrative settings of the Gallery module including file upload size, available categories, themes and auto 
approval.

 1. Select  Configuration from the Gallery module actions menu - OR - Click the Configuration  button (typically located at the 
bottom right corner of the module). This displays the Gallery Configuration page with the Admin Settings section expanded.

 2. In the Root URL text box, edit the location where files are stored. Note: the specified Root URL will always be relative to the cur-
rent portal home directory. E.g. Portals/<portal#>/. Therefore, it is not possible to share media across multiple portals.

 3. At Created On, you can view the date this gallery was created.

 4. In the Quota text box, enter the maximum number of space available in kilobytes (kb) for all files in this gallery. The default is set 
to 0 which is no limit, however it is recommended that a limit be set. 

 5. In the Max File Size text box, enter the maximum size  in kilobytes (kb) for individual files being uploaded to the gallery. If files 
exceed this limit the user will be warned and the upload will fail. The default setting is 1000.

 6. In the Maximum Pending Uploads Size text box, enter the maximum size  in kilobytes (kb) that files pending upload can grow to 
before they are committed  to storage. The default setting is 0 (zero) which means no limitation. A maximum of 20000 kb or about  
20 Mb is permitted.

 7. At Auto Approval, check  the check box to automatically approve uploaded files  - OR - Uncheck  the check box to require 
files to be approved by a module administrator.

 8. At Build Cache On Start, check  the check box to cache file and module configuration data and enhance performance (rec-
ommended) - OR - Uncheck  the check box to remove caching. 

 9. Click the Update link.



Admin Settings for the Gallery module

Configuring Display Settings
How to configure the display settings of the Gallery module. Here you can set the design and layout of the gallery and  gallery media.

Important. Only the Host can modify the allowed image and media extensions which are maintained under Host Settings. See "Man-
aging Allowable File Extensions"

Important. The fields marked with an asterisk ( * ) below must be configured before adding albums and images to the gallery. They can-
not be modified once albums and images have been added to the gallery unless all of the albums and images are deleted.

 1. Select  Configuration from the Gallery module actions menu - OR - Click the Configuration  button (typically located at the 
bottom right corner of the module). This displays the Gallery Configuration page.

 2. Maximize  the Display Settings section and edit any of the following default settings.

 3. At Theme, select a theme for this module. This modifies the layout and design. See "Gallery Themes"

 4. In the Gallery Title text box, modify the title of the gallery. The title displays in the top left corner of the gallery pages and is a link 
to the gallery home page. 

 5. In the Image Extensions text box, enter any additional extensions which are allowed for image files.

 6. In the Media Extensions text box, enter any additional extensions which are allowed for media files. E.g. .swf

 7. In the Max Fixed Width* text box, enter the maximum pixel width an image will be displayed in the gallery. The default is set to 
500. 



 8. In the Max Fixed Height* text box, enter the maximum pixel height an image will be displayed in the gallery. The default is set to 
500. 

 9. In the Column Count text box, enter the number of thumbnails displayed in each column of the gallery. The default is set to 3 col-
umns. 

 10. In the Row Count text box, enter the number of thumbnails displayed in each row of the gallery. The default is set to 2 rows. 

 11. In the Max Thumb Width* text box, enter the maximum pixel width thumbnails will be displayed in the gallery. The default is set to 
100. 

 12. In the Max Thumb Height* text box, enter the maximum pixel height thumbnails will be displayed in the gallery. The default is set 
to 100.

 13. In the Encoder Quality text box, enter the desired compression  level (encoder quality) with which JPEG images are saved. For 
Example: enter 10 for the higher rate of compression which will result in poor quality images; or enter 100  for no compression. 
The default setting is 80.

 14. At Display Info, check  the check box beside the information to be displayed for the media. Options are: Title, name, size, notes, 
author, location, description, created date, and approved date.

 15. In the Category Values text box, add/edit the available file categories.

 16. At Sort Properties, check  the check box beside the information to be available in the Sort field. Options are: Name, size, title,  
author, location, score, ownerID, created date, and approved date.

 17. At Default Sort, select the default field which items are sorted by from the drop-down box.

 a. At Descending, check  the check box to set default sort order of files to descending order - OR - Uncheck  the check 
box to use ascending order.

 18. At Default View, select the default view (Card, List or Standard) that files will be displayed as when a user enters the gallery.

 a. At Visitors can change view, check  the check box if users change views - OR - Uncheck  the check box to only use 
the default view.

 19. Click the Update link.





Display Settings for the Gallery module

Configuring Feature Settings
How to configure the feature settings of the Gallery module such as slideshow speed, watermarking, voting, downloading, etc.

 1. Select  Configuration from the Gallery module actions menu - OR - Click the Configuration  button (typically located at the 
bottom right corner of the module). This displays the Gallery Configuration page.

 2. Maximize  the Feature Settings section and edit any of the following settings: 

 3. In the Slideshow Speed text box, enter the speed in milliseconds which the slideshow will move. The default setting is 3000. 

 4. At Enable Slideshow?, check  the check box to enable the slideshow option - OR - Uncheck  the check box to disable. 

 5. At Enable Popup?, check  the check box to enable the gallery popup viewer - OR - Uncheck  the check box to display 
images in the page.

 6. At Multi Level Navigation Menu?, check  the check box to enable breadcrumbs of menu levels. (E.g. Gallery > Parent Album 
> Child Album) - OR - Uncheck  the check box to only display the current level. E.g. Child Album 

 7. At Enable Watermark?, check  the check box to enable watermarking of images. See "Adding a Watermark " - OR - Uncheck 
 the check box to disable watermarks.

 8. At Enable Exif?, check  the check box to enable users to view Exif metadata information - OR - Uncheck  the check box to 
hide this data. 

 9. At Enable Voting?, check  the check box to enable users to add votes and comments to images - OR - Uncheck  the check 
box to disable. 

 10. At Enable Download?, check  the check box to enable users to download files- OR - Uncheck  the check box to prevent 
downloading. 

 11. At Download Roles, select from these options:

 l If all authorized users can download files, skip to Step 4.

 l Select which roles can download files as follows: 

 a. Click the Search  button.

 b. In the Find text box, enter the role name - OR - just the first letter(s) of the role name - OR - 
Leave blank to view all roles.

 c. Click the Go button. This displays the matching roles is the Name list below.

 d. Select the required role.

 e. Click the Add button to add the role.

 f. Repeat Steps 11b-e above to add additional roles.

 g. Click OK to save roles.



 12. Click the Update link.



Feature Settings for the Gallery Module

Configuring Private Gallery
How to create a private gallery using the Gallery module. This restricts the adding of files and sub albums to the selected gallery owner. 
Users who are authorized to view the gallery can view all approved files.

 1. Select  Configuration from the Gallery module actions menu - OR - Click the Configuration  button (typically located at the 
bottom right corner of the module). This displays the Gallery Configuration page.

 2. Maximize  the Private Gallery section.

 3. At Is Private?, select from these options:

 l Check  the check box to set the gallery as private.

 l Uncheck  the check box to set the gallery as public. Skip to Step 5.

 4. At Owner, select the gallery owner as follows: 

 a. Click the Search  button. 

 b. In the Find text box, enter the username - OR - just the first letter(s) of the username - OR - Leave blank to view all 
users.



 c. Click the Go button. This displays the matching users in the Name/Display Name list.

 d. Select the required user.

 e. Click the OK button.

 5. Click the Update link.

Configuring a Private Gallery

Gallery Themes
A look at some of the differences between the four themes provided with the Gallery module.



DNNGray Theme

 l Gray gallery with blue and gray text.

 l Gray album covers

 l Blue and yellow image frames in albums

 l Yellow frames with black text in Image Viewer 

DNNGray Theme Gallery



DNNGray Theme Image Viewer

DNNSilver Theme 

 l Gray gallery with blue and gray text.

 l Gray album covers

 l Blue and yellow image frames in albums

 l Gray frames and orange text in Image Viewer 



DNNSilver Theme Gallery

DNNSilver Theme Image Viewer

DNNSimple Theme  



 l Gray gallery with blue and gray text.

 l Gray album covers

 l No image frames in albums

 l No frames and black text in Image Viewer

DNNSimple Theme Gallery



DNNSimple Theme Image Viewer

DotNetNuke Theme  

 l Gray gallery with yellow, blue and gray text.

 l Gray album covers

 l Blue and yellow image frames

 l Yellow frames with yellow text in Image Viewer



DotNetNuke Theme

DotNetNuke Theme Image Viewer

Related Topics



 l See "Configuring Display Settings"

Module Editors
Adding a Parent Album 
How to add a parent album to the gallery module. Note: Album names may not include the following characters which are invalid in either 
a Windows folder name or web URL: \ / : * ? ! " > < | &

 1. Go to the Gallery home page.

 2. Mouse over the Gallery icon and then select  Add Album. This opens the Edit Album page.

 3. In the Name text box, enter a name for the album using plan text. E.g. Close Ups. Important: The Name field cannot be edited. 

 4. At Categories, select the media categories to be added to this album. 

 5. The following optional settings are also available: 

 a. In the Title text box, enter a title for the album.

 b. In the Author text box, enter a name for the author of the images.

 c. In the Notes text box, enter any notes about this gallery.

 d. In the Location text box, enter the location where the media was taken.

 e. In the Description text box, enter a description of this gallery.

 f. At Approved Date, click the Calendar  button and select the date when the album will be visible to authorized 
users. See "Working with the Calendar".

 6. Click the Update link.



Adding a Parent Gallery

Adding a Sub-Album 
How to add a sub-album (also known as a  child album) to an album on the Gallery module.

 1. Navigate to the parent album for this new album and then open the album menu. See "Opening the Album Menu"  

 2. Select  Add Album from the album menu.

 2. In the Name text box, enter a name for the album using plan text. E.g. Close Ups. Note: This field cannot be edited. 

 3. At Categories, select the media categories to be added to this album. 

 4. The following optional settings are also available: 

 a. In the Title text box, enter a title for the album.

 b. In the Author text box, enter a name for the author of the images.

 c. In the Notes text box, enter any notes about this gallery.

 d. In the Location text box, enter the location where the media was taken.

 e. In the Description text box, enter a description of this gallery.



 f. At Approved Date, click the Calendar  button and select the date when the album will be visible to authorized 
users. See "Working with the Calendar".

 5. Click the Update link. The child album is now displayed inside the Parent Album.

A Newly Added Child Album (Sub-Album)

Editing Albums
How to edit the settings of the albums in the Gallery module. Note: The name of sub-album galleries cannot be edited.

Editing the Parent Gallery

 l See "Configuring Display Settings"

Editing Sub-albums

 1. Open the menu of the required sub-album. See "Opening the Album Menu"

 2. Select   Edit This Album from the album menu. This opens the Album Details section of the Edit Album page.

 3. Edit any of the title, author, notes, location, description or categories fields as required.

 4. Click the Update link.



Editing Album Properties

Deleting a Sub-Album 
How to delete a sub-album (child album) from the Gallery module.

 1. Navigate to and open the required sub-album menu. See "Opening Albums"

 2. Select  Edit This Album from the album menu.

 3. Go to the Sub-Albums and Files Currently Contained In This  Album section.

 4. Click the Delete  button beside the album to be deleted. This displays the message "Are You Sure You Want To Delete The 
Album Named '[Album Name]'?

 5. Click the OK button to confirm.

 6. Repeat Steps 4-5 to delete additional albums.



 
Deleting a Sub-Album

Adding a File to an Album
How to add one or more files to an album of the Gallery module.

 1. Navigate to and open the menu of the required album. See "Opening the Album Menu"

 2. Select  Add Files from the menu.

 3. Optional. Maximize and read the Instructions and Permissible File Upload Types and Available Storage Space sections for addi-
tional information.

 4. At Add File, click the Browse... button and select the file from your computer.

 5. Complete any of these optional fields.

 a. Recommended. In the Title text box, enter a title for the file.

 b. In the Author text box, enter the author of the file.

 c. In the Client text box, enter a client name.

 d. In the Location text box, enter the location where the file was taken.

 e. In the Description text box, enter a description of the file.

 f. Recommended. At Categories, select one or more media categories.

 6. Click the Add File link. The file is now listed at Pending Uploads.



 7. Repeat Step 4-6 to add additional files. Note: You must reselect the categories you require each time you add a file.

 8. Click the Upload Pending Files link to upload the added files to the album.

 9. Click on the linked [Gallery Name] to return to the gallery.



Adding One or More Files to an Album

Adding a Watermark 
How to display a watermark over images in an album of the Gallery module. The image must be added to each album separately.

 1. Create a watermark image and name it watermark. E.g. watermark.gif 

 2. Upload the image to each album where it is required. See "Adding a File to an Album"



Displaying a Watermark on Images

Editing File Details 
How to edit the details of a file within the Gallery module.

 1. Navigate to and open the required album. See "Opening Albums"



 2. In Standard View or Card View, mouse over the required image and the select  Edit This Album - OR - In List View click the 
 Edit button. This opens the File Edit page.

 3. Edit one or more fields as required.

 4. Click the Update link.



Editing File Details

Editing Image Properties 
How to edit the properties of an image in the Gallery module. Note: If the Save button is not displayed you will need to login with the cor-
rect permissions.

Important. If a color image is saved as black and white the color cannot be restored to that file.

 1. Navigate to and open the required album. See "Opening Albums"



 2. In Standard View or Card View, mouse over the required image and the select  Edit This Album - OR - In List View, click the 
 Edit button. This opens the File Edit page.



 3. Click the Edit Image link below the image thumbnail. This opens the Gallery Image Viewer/Editor.

 4. Select one or more of these image editing tools as required:

 l  Zoom Out: View a smaller version of the image. 

 l  Zoom In: View an enlarged version of the image. 

 l  Rotate Left: Rotate the image counter clockwise 90 degrees. 

 l  Rotate Right: Rotate the image clockwise 90 degrees. 

 l  Flip Horizontally: Flip the image in the horizontal plane. 

 l  Flip Vertically: Flip the image in the vertical plane. 

 l  Show In Color: Restore the color to colored images. 

 l  Black & White Add: Click once to change a color image to black and white. Click one or more times to increase con-
trast on (saved) black and white images.

 l  Less Black & White: Click one or more times to increase contrast on (saved) black and white images.



 5. Click the Save  button. This displays the message "Are you sure you wish to save the changes to this item?" 

 6. Click the OK button to confirm.

 7. To edit additional images, use the   Previous  and Next  buttons to move to other images and then repeat Steps 4-6.

 8. Click the Close button to exit the Gallery Image Viewer/Editor.

Synchronizing Album Files
How to synchronizing files within an album of the Gallery module.

 1. Open the menu of the required album. See "Opening the Album Menu"

 2. Select  Maintenance from the album menu.



 3. Click the Synchronize link.

Synchronizing Album Files

Refresh Gallery
How to clear cached files from an album of the Gallery module. This synchronizes the gallery and updates any album or file changes 
which have been made outside of the normal gallery user interface, or if the physical location of the gallery is changed.

Option One:

 1. Select   Maintenance from the Album menu. See "Opening the Album Menu"



 2. Click the Clear Cache  button.

Clearing the cache

Option Two:



 1. Open the required album. See "Opening Albums"

 2. Click the Clear Cache  button.

Deleting a File from an Album 
How to delete a file from an album within the Gallery module.

Option One:

 1. Open the menu of the required album. See "Opening the Album Menu"

 2. Select  Edit This Album from the album menu.

 3. Go to the Sub-Albums and Files Currently Contained In This  Album section.

 4. Click the Delete  button beside the file to be deleted. This displays the message "Are You Sure You Want To Delete The File 
Named '[File Name]'?

 5. Click the OK button to confirm.

 6. Repeat Steps 4-5 to delete additional files from this album.

Deleting a File from an Album

Option Two:

 1. Open the menu of the required album. . See "Opening the Album Menu"

 2. Select  Maintenance from the album menu. This opens the Maintenance page.



 3. Go to the list of files displayed at the base of this page.

 4. Check  the check box beside each file to be deleted - OR - Check  the Select All link to select all files for deletion. Note: The 
Select All field changes its name to "Deselect All" once selected.

 5. Click the Delete link.

Deleting Multiple Files



Help
About the Help Module
The Help module consists of two integrated modules titled Help and Category. The Category module displays a hierarchical list of cat-
egories which have one or more HTML pages associated with it. Clicking on a category name displays a summary list of the related 
HTML pages (called tutorials) in the Help module. The user can then click a read more... link beside any summary to display the related 
tutorial in full. The Category module includes a search facility which displays results in the Help module.

The Help module uses a different import/export feature than other modules which enables Administrators to upload an XML file of content 
as well as upload a compressed images file and set their root path.

Module Version: 03.00.02

Minimum DNN Version: 04.05.05

Features: ISearchable

The Help Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleHelp/tabid/850/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/81/scope/threads/Default.aspx

 l Issue Tracker: http://dnnhelp.codeplex.com/workitem/list/basic

Configuration
Configuring the Help Module 
The Help module must be configured before any categories or tutorials can be added. This tutorial explains how to associate the Help 
and Category modules with each other. If the module is not configured any categories added the Category module will not be displayed 
on the Edit Tutorials page of the Help module. Note: Only one Help module can be located on a page.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Click the Update link.

http://www.dotnetnuke.com/Products/Development/Forge/ModuleHelp/tabid/850/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/81/scope/threads/Default.aspx
http://dnnhelp.codeplex.com/workitem/list/basic


Configuring the Help module

All Users
Viewing a Tutorial
How to navigate to and view a tutorial using the Help module.

 1. In the Category module, navigate to and click on the name of the category where the tutorial is located. This displays the related 
tutorials in the Help module. 

 2. Click on the read more... link beside a tutorial to view it.

Tip: Use the Previous  or Next  buttons to view other tutorials within this category. Click the Back To Category button to return to the 
category.



Searching for a Tutorial 
You can make a search for tutorials using the search box on the Help Category module. You can search on both keywords and phrases. 
Results will be exact matches, therefore a single keyword search is recommended. Results are displayed in the Help module. You can 
also use the site wide Portal Search which will return both matching tutorials and matching results from other modules on this site.

 1. In the Category module, enter your search criteria into the text box located below the list of categories. 

 2. Click the Go button. 

 3. The search results are now displayed in the Help module. Click on a read more... link beside a result to view the related tutorial.

Module Editors
Adding a Tutorial 
How to add a tutorial to the Help module. Note: At least one category must be created using the Category module before a tutorial can be 
added.

 1. Select  Add Tutorial from the module actions menu - OR - Click the Add Tutorial link. 

 2. In the Title text box, enter a title for the tutorial. A maximum of 100 characters is permitted. 

 3. In the Short Description text box, enter a short description of the tutorial. 

 4. In the Tutorial Text Editor, enter the tutorial. 

 5. Optional. In the Keywords text box, enter one or more keywords for the tutorial separated by a comma. E.g. alternative ther-
apy,Chinese medicine,health. Enter keywords which aren't included in either of the title, short description or tutorial fields. These 
keywords will then return this tutorial in both the site search and the help module search. 

 6. At Categories, select one or more categories where this tutorial will be displayed. 

 7. Click the Update link.



Adding a tutorial

Editing a Tutorial 
How to edit a tutorial in the Help module.



 1. In the Category module, navigate to and click on the name of the category in which the tutorial is located. 

 2. Click the Edit  button located beside the tutorial to be edited. Note: You can also click the Edit  button displayed 
when viewing a tutorial.

 3. Edit one or more fields as required. 

 4. Click the Update link.

Changing Tutorial Categories 
How to modify the categories that a tutorial is associated on the Help module.

 1. In the Category module, navigate to and click on the name of the category in which the tutorial is located. 

 2. Click the Edit  button located beside the required tutorial. 

 3. At Categories, perform the following: 

 l To add the tutorial to a category: Locate the category and then check  the Category check box. 

 l To remove the tutorial from a category: Locate the category and then uncheck  the Category check box.

 4. Click the Update link.

Re-ordering Tutorials 
Tutorials are listed in the order they are added by default. Changing the order of a tutorial in one category does not affect how it is dis-
played in another category. Here's how to move tutorials up or down by one or more positions on the Help module. 



 1. In the Category module, navigate to and click on the name of the category where the required tutorial is located. 

 2. Click the Refresh  button located below the tutorials. This retrieves the latest database information to ensure the correct re-
ordering. 

 3. Click the Up  and Down  buttons beside the tutorials to re-order them as required.

Reordering Tutorials

Re-ordering Tutorials Alphabetically 
How to re-order all tutorials within a category alphabetically on the Help module. Tutorials are listed in the order they are added by 
default. Changing the order of a tutorial in one category does not affect how it is displayed in another category.

 1. On the Category module, navigate to and click on the name of the category where the required tutorial is located. 

 2. Click the Refresh  button. This retrieves the latest database information to ensure the correct re-ordering. 

 3. Click the Alphabetical View Order  button.



Re-ordering Tutorials Alphabetically

Deleting a Tutorial 
How to delete a tutorial from the Help module.

 1. In the Category module, navigate to and click on the name of the category in which the tutorial is located. 

 2. Click the Edit  button located beside the tutorial to be deleted. 

 3. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?"   

 4. Click the OK button to confirm deletion.



Deleting a Tutorial

Troubleshooting: Categories Not Displayed on the Edit Tutorials Page 
There are two reasons why categories don't display on the Edit Help page of the Help module when you are trying to add a tutorial, either 
the module needs to be configured, or no categories have been added.

"Adding the First Category".   to resolve this problem.



Tip: Only Page Editors can configure the Help module.

Settings
Importing Help Data 
How to import help data including images to the Help module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Help Module Settings tab.

 3. In the Root Path For Images text box, enter the root path for where the images for this module are to be located. The XML is 
updated on import using this new path allowing the content to be portable. E.g. If you create the content on your local machine 
using a standard DNN setup with the portal ID =0 and you need to Import onto a live site with a Portal ID=25 then you set the 
Root path to Portals/25 so that the Portals/0/OnlineHelp is replaced in all of the HTML you have created which makes the 
images show properly: 

 4. At Upload XML, select or upload the data xml file which contains the Help content. This file can optionally be zipped (com-
pressed). 



 5. At Upload Images, select or upload a zipped (compressed) images file. 

 6. Click the Update link.

Importing help data

Help Category
Module Editors
Adding the First Category
How to add the first category to the Help Category module.

 1. Select Manage Categories from the Category module actions menu. 

 2. In the Name text box, enter the name for the category as it will appear in the module. 



 3. In the Description text box, enter a description for the category.   

 4. In the Keywords text box, enter one of more keywords separated by a comma. Note: this keywords field is not currently enabled. 

 5. At Visible, check  the check box to make the category visible on the Category module- OR - Uncheck  the check box to hide 
the category. 

 6. Click the Add New link. The category is now displayed to the left.

Adding the First Category

Adding a Child Category 
The Categories module uses a tree folder structure. Child categories are located below a Parent category and can be viewed by clicking 
on the Maximize  button displayed beside their parent category.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and click on the name of the category you want to add a child category below. 

 3. Click the Add Child link. This will add a new category to the category tree called "New Category". You can now update the 
details of this New Category. 



 4. In the Name text box, enter the name for the category as it will appear in the module. 

 5. In the Description text box, enter a description for the category. 

 6. In the Keywords text box, enter one of more keywords separated by a comma. Note: this keywords field is not currently enabled. 

 7. Click the Update link. 

 8. Repeat Steps 2-7 to add additional child categories. 

 9. Click the Back link to return to the module.

Adding a Sibling Category 
The Categories module uses a tree folder structure. Sibling categories appear in the same level as each other. A parent 
category has one or more child categories added to it which is indicated by a Maximize  button.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and click on the name of the category you want to add a sibling category to. 



 3. Click the Add Sibling link. This will add a new category to the category tree called "New Category". You can now update the 
details of this "New Category". 

 4. In the Name text box, enter the name for the category as it will appear in the module. 

 5. In the Description text box, enter a description for the category. 

 6. In the Keywords text box, enter one of more keywords separated by a comma. Note: this keywords field is not currently enabled. 

 7. Click the Update link. 

 8. Repeat Steps 2-7 to add additional sibling categories. 

 9. Click the Back link to return to the module.

Editing Category Details 
How to edit the details of a category in the Help Category module.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and click on the name of the category to be edited. 



 3. Edit the Name or Description details as required. 

 4. Click the Update link.

 5. Repeat Steps 2-4 to modify additional categories 

 6. Click the Back link to return to the module.

Managing the Visibility of a Category 
Categories set as visible are displayed in the Categories module. Categories set as not visible will not displayed in Category module. All 
child categories of a category set as not visible are also hidden.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and select the category to be modified. 

 3. At Visible, check  the check box to set the category as visible - OR - uncheck  the check box to set it as not visible. 

 4. Click the Update link.



 5. Repeat Steps 2-4 to modify additional categories. 

 6. Click the Back link to return to the module.

Re-ordering Categories on the Same Level 
How to re-order categories on the same level in the Help Categories module.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and select the category to be moved. 

 3. Click the Refresh  button. 

 4. At View Order, click the Up  and Down  buttons to move the category as required.



 5. Repeat Steps 2-4 to re-order additional categories. 

 6. Click the Back link to return to module.

Changing the Parent of a Category 
How to change the parent of a category in the Help Category module.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and select the category to be modified. 

 3. At Parent, select the name of the new parent category. 

 4. Click the Update link.



 5. Repeat Steps 2-4 to modify additional categories. 

 6. Click the Back link to return to the module.

Changing a Child Category to a Parent Category 
How to move a child category to the root of the Help Category module. Root categories are top level parent categories.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and click on the name of the child category to be modified. 

 3. At Parent, select <None Specified>. 

 4. Click the Update link.



 5. Repeat Steps 2-4 to modify other categories. 

 6. Click the Back link to return to the module.

Deleting a Category 
How to delete a category from the Help Category module.

 1. Select Manage Categories from the Category module actions menu. 

 2. Navigate to and select the category to be deleted. 

 3. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?"   You are now able to delete cat-
egories with Child categories as well as the tutorials associated with them. 

 4. Click the OK button to confirm deletion.



 5. Repeat Steps 2-4 to delete additional categories. 

 6. Click the Back link to return to the module.

HTML
About the HTML Module
The HTML module  (typically titled Text/HTML) can display rich text, HTML,  images, flash or can perform a script. This is a free form mod-
ule which is uses the Editor control to manage content using either a Basic Text Box or Rich Text Editor.



The HTML Module

Module Version: 06.00.01

Minimum DNN Version: 06.00.01

Features:

 l Replacement Tokens

 l IPortable, IUpgradable, ISearchable

 l Workflow support for Direct Publish only. (For Content Staging, see "About the HTML Pro Module".Only available 
in DotNetNuke Professional Edition)

Related           Topics:

 l See "About the Editor"

Module Editors
Adding/Editing Text Inline 
How to add and edit text inline using the HTML module. 

Note 1: Inline editing may be disabled on this site.

Note 2: Inline editing is automatically disabled if token replacement is enabled.

 1. Hover your mouse over the content of the HTML module. An Edit  button will appear. 

 2. Click the Edit  button.



 3. Add or edit content as required. A tool bar with a number basic text formatting tools and link insertion is available.

 4. Click the Save  button to save your changes - OR - Click the Cancel  button to cancel your changes. If Content Staging is 
enabled, complete these additional steps:

 a. Optional. Click the Lock Module link to lock this content from further changes until it is published.

 b. These changes must be published before they are displayed on the module. "Publishing a Draft".

Editing HTML Module Content Inline

Related Topics:

 l See "Enabling/Disabling Inline Editing"

Adding Content to HTML Module
How to content to the HTML module. Add basic text, rich text or paste in HTML using the Editor.

 1. Select Edit Content from the HTML module actions menu - OR - Click the Edit Content link.

 2. See "Adding Basic Text using Editor", "Adding Rich Text Using The Editor". or "Pasting HTML Content"

 3. Optional. Click the  Preview link located below the Editor. This expands the Preview section below and displays the content 
currently displayed in the Editor. If Direct Publish (rather than Content Staging) is used for this module, then skip to Step 7.

 4. At On Save? / Publish Changes?, select from the below options (Note: This field only displays when Content Staging is ena-
bled. See "Setting a Workflow"):



 l Check  the check box to publish these changes and set them as ready for approval. This automatically locks the con-
tent until it is either published or the lock is manually removed by an Administrator.

 l Uncheck  the check box if the content is not yet ready for publishing/approval. This enables you to save this draft and 
return to edit it at a later stage before submitting the content for approval.

 i. Check  the Lock Content? check box to lock this content from further changes until you the changes are pub-
lished  - OR - Uncheck  the check box to allow additional changes to this draft prior to publishing.

 5. Click the  Save link. If Direct Publishing is set for this module, the content changes are now displayed in the HTML 
Pro module. If Content Approval is enabled, continue to Step 7.

 6. Optional. In the Enter Submission Comment text box, enter a comment relating to this submission.

 7. Click the  Submit link. This enters these changes into the next stage of content approval and sends out notification messages 
as set in the workflow.

 8. If Direct Publishing is set for this module, the content changes are immediately displayed in the HTML module. If Content Stag-
ing is enabled, complete the following:

 a. In the Enter Submission Comment text box, enter your comments and then click the  Submit link. You will be noti-
fied when your changes are approved or rejected.

Tip: If Content Approval is enabled and this content is ready to publish, See "Publishing a Draft"

Adding Replacement Tokens
How to add replacement tokens into the HTML module. "Enabling/Disabling Token Replacement".

 1. Select Edit Content from the HTML module actions menu - OR - Click the Edit Content link.

 2. Enter the replacement token into the Editor. E.g. [User:FirstName] [User:LastName]. See "Replacement Tokens"



 3. Optional.  Click the Preview link located below the Editor. This expands the Preview section below and displays the content 
currently displayed in the Editor.

 4. At On Save? / Publish Changes?, select from the below options (Note: This field only displays when Content Staging is ena-
bled. "Setting a Workflow".):

 l Check  the check box to if the content is ready for publishing/approval.

 l Uncheck  the check box if the content is not yet ready for publishing/approval. This enables you to save this draft and 
return to edit it further before submitting it for approval.

 5. Click the  Save link. If Direct Publishing is set for this module, the content changes are immediately displayed in the 
HTML module.  If Content Approval is enabled and this content is ready to publish, See "Publishing a Draft".See "Publishing a 
Draft"



Replacement Tokens Displaying the User's Name

Previewing Editor Content
How to preview the current content in the Editor using the HTML module. This allows you to preview the content before updating it and/or 
publishing it. 

 1. Select Edit Content from the HTML module actions menu - OR - Click the Edit Content link.

 2. Click the Preview link located below the Editor. This expands the Preview section below (unless it is already expanded) and 
displays the content currently displayed in the Editor. Note: The state of the version being previewed is displayed at the Workflow 
State field. I.e. Edit Preview.

 3. You can now return to editing the content, or save/cancel this content.

Tip: Each time you modify the content in the Editor, you must re-click the Preview link to see the changes.



Previewing Current Content in Editor

Viewing Previous Versions of Content
How to view previous versions, as well as the currently saved version, of content for an instance of the HTML module. 

 1. Select  Edit Content from the HTML module actions menu - OR - Click the  Edit Content link.

 2. Expand the Version History section.



 3. Click the Preview  button beside the required version.

The Preview section above is now maximized. It displays the content  for the selected version and the Workflow State set for the version 
being previewed. In addition, the Item History section can be expanded to view additional details.

Viewing Previous Versions of Content

Managing My Workflow Tasks
How to view and update content that required reviewing before it can be published using the HTML module. This task requires that Work-
flow is NOT set to direct publish.            See "Setting a Workflow".



 1. Select My Work from the HTML module actions menu. This displays the My Work page and a list of the content to be reviewed 
and published.

 2. Click on one of the listed [Page Name] links. This displays the selected module.

 3. You can now choose to edit, preview and/or publish the unpublished content (           "Publishing a Draft".), or you can rollback to a pre-
vious version ("Rolling Back Content".

Publishing a Draft
How to publish a draft of content using the HTML module. Note: This tutorial only applies to the Content Staging workflow.

 1. Go to the required HTML module. See "Managing My Workflow Tasks".

 2. Select Publish from the HTML module actions menu - OR - Click the Publish link.

Publishing a Draft

Rolling Back Content
How to rollback to a previous content version using the HTML module. Note: This task requires that Workflow is NOT set to direct publish. 
"Setting a Workflow".

 1. Select Edit Content from the HTML module actions menu - OR - Click the Edit Content link.

 2. Maximize  the Version History section.

 3. Locate the required version.



 4. Optional. Click the Preview  button to preview a version. This expands the Preview section and displays the selected version 
including details on the related workflow and the Item History.

 5. Click the Rollback  button. The selected version is published immediately, even if the version was initially a draft (Content Stag-
ing).

 6. Click the  Cancel link to return to the module.

Administrators
Deleting a Content Version
How to delete a specific version of content using the HTML module.

 1. Select Edit Content from the HTML module actions menu - OR - Click the Edit Content link.

 2. Maximize  the Version History section.

 3. Locate the required version.

 4. Optional. Click the Preview  button to preview the version. This expands the Preview section and displays the selected ver-
sion including details on the related workflow and the Item History.

 5. Click the Delete           button. This displays a message similar to "Are you sure you wish to permanently delete version 3 [ that 
was created on [date] by [username]."



 6. Click the OK button to confirm.

 7. Click the  Cancel link to return to the module.

Enabling/Disabling Inline Editor 
How to enable or disable inline editing for the HTML module. Inline editing allows authorized users to perform basic editing of HTML mod-
ule content directly on the web site page (not on the typical edit page). This feature also allows inline editing of titles for all types of 
modules. Inline editing does not effect the usual editing methods.

 1. Navigate to  Admin >  Site Settings. 

 2. Go to Advanced Settings > Usability Settings.  

 3. At Inline Editor Enabled, check  the check box to enable  inline editing - OR - Uncheck  the check box to disable it.

 4. Click the  Update link.

Editing Content Inline

Settings
Enabling/Disabling Token Replacement
How to enable or disable token replacement on the HTML module. Token replacement enables tokens such as [FirstName] to be 
replaced with the first name of the authenticated user. Tokens include information such as user details, portal name, key words, date, 



time, etc. 

Important. Inline editing and module caching are disabled if token replacement is enabled.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the HTML Module Settings tab. 

 3. At Replace Tokens, select from these options:

 l Check  the check box to enable full token replacement.

 l Uncheck  the check box to disable token replacement. This will display any tokens as text in the Editor.

 4. Click the  Update link.

Enabling Token Replacement

Related Topics:

 l See "Adding Replacement Tokens"

Setting a Workflow
How to set the workflow for an individual HTML module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the HTML Module Settings tab. 

 3. At Workflow, select the workflow you wish to use from these options:

 l Content Staging: Content staging allows content to be saved as a draft before it is published. Draft content will only be 
visible when edit mode is selected by users who can edit the module/page.  In view mode the most recent published ver-
sion of content will be displayed instead of the draft. This is the same for users with view permissions only. "Publishing 
a Draft".

 l Direct Publish: With the direct publish workflow any content that is saved on the Edit Content page or through the inline 
editor will be immediately visible to all users with permissions to view the module. Editing users will be able to see the 
content for both view and edit mode. 

 4. Click the  Update link.



Setting the Workflow for a HTML Module           

Setting a Workflow as Default for Site
How to set a workflow as the default for the site using the HTML module. This option is only available to Administrators.

Tip: To set a new workflow whether it is for an individual module or you wish to set the default for the site an HTML module must first be 
added to some page on your site.

 1. Go to any HTML module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the HTML Module Settings tab. 

 4. At Workflow, select the workflow you wish to use. "Setting a Workflow".

 5. At Set As Default Workflow For Site?, select from these options:

 l Check  the check box to set this as the default for the whole site.

 l Uncheck  the check box to set this workflow for this module only.



 6. Click the  Update link.

HTML Pro
About the HTML Pro Module
The HTML Pro module  (typically titled Text/HTML) can display rich text, HTML,  images, flash or can perform a script. This is a free form 
module which is uses the Editor control to manage content using either a Basic Text Box or Rich Text Editor.

The HTML Pro Module

Module Version: HTML (06.00.01)

Minimum DNN Version: 06.00.01

Features:

 l IPortable, IUpgradable, ISearchable

 l Replacement Tokens

 l Workflow support for Direct Publish and Content Staging which allows editors to save and view content in a staging area prior to 
publishing. Create additional and unique content staging workflows for suit your business.

 l Administrators can set the number of previous versions which are kept and editors can preview and rollback content an earlier ver-
sion. 

 l View a detailed history of content versions

Permissions Bug. Users must have Add Content/Edit permissions to the Page on which the HTML module is located in order to manage 
module settings.  

Related           Topics:

 l See "About the Editor"

Module Editors
Adding/Editing Text Inline 
How to add and edit text inline on the HTML Pro module. Note: Inline editing may be disabled on this site. Note: Inline editing is auto-
matically disabled if token replacement is enabled.



 1. Hover your mouse over the content of the HTML Pro module. An Edit  button will appear. 

 2. Click the Edit  button.

 3. Add or edit content as required. A tool bar with a number basic text formatting tools and link insertion is available. 

 4. Click the Save  button to save your changes - OR - Click the Cancel  button to cancel your changes. If Content Staging is 
enabled, complete these additional steps:

 a. Optional. Click the Lock Module link to lock this content from further changes until it is published.

 b. These changes must be published before they are displayed on the module. See "Publishing a Draft".

Inline Text Editing

Related Topics:

 l See "Enabling/Disabling Inline Editing"

Adding Basic Text and HTML
How to add basic text including basic HTML Pro using the Basic Text Box of the HTML Pro module. Note: The Lock Content option is only 
available on the HTML Pro module which is a DNN Professional only feature.



 1. Select  Edit Content from the HTML Pro module actions menu - OR - Click the  Edit Content link.

 2. In the Current Content section, select the Basic Text Box radio button located above the Editor. This displays the Editor as a 
Basic Text Box and displays the content as HTML.

 3. At Render Mode (below the Editor), select Text. 

 4. Click inside the Editor and then enter or paste (Ctrl + V) your text.

 5. Optional. Click the Preview link located below the Editor. This expands the Preview section below and displays the content 
currently displayed in the Editor. If Direct Publish (rather than Content Staging) is used for this module, then skip to Step 7.

 6. At On Save? / Publish Changes?, select from the below options (Note: This field only displays when Content Staging is ena-
bled. See "Setting a Workflow"):

 l Check  the check box to publish these changes and set them as ready for approval. This automatically locks the con-
tent until it is either published or the lock is manually removed by an Administrator. Skip to Step 7.

 l Uncheck  the check box if the content is not yet ready for publishing/approval. This enables you to save this draft and 
return to edit it at a later stage before submitting the content for approval.  

 i. Check  the Lock Content? check box to lock this content from further changes until you the changes are pub-
lished  - OR - Uncheck  the check box to allow additional changes to this draft prior to publishing.

 7. Click the  Save link. If Direct Publishing is set for this module, the content changes are displayed in the HTML Pro module. If 
Content Approval is enabled, continue to Step 8.

 8. Optional. In the Enter Submission Comment text box, enter a comment relating to this submission.

 9. Click the  Submit link. This enters these changes into the next stage of content approval and sends out notification messages 
as set in the workflow.

Adding Content to HTML Pro Module
How to content to the HTML module. Add basic text, rich text or paste in HTML using the Editor.

 1. Select Edit Content from the HTML module actions menu - OR - Click the Edit Content link.

 2. See "Adding Basic Text using Editor", See "Adding Rich Text Using The Editor" or See "Pasting HTML Content"

 3. Optional. Click the Preview link located below the Editor. This expands the Preview section below and displays the content cur-
rently displayed in the Editor. If Direct Publish (rather than Content Staging) is used for this module, then skip to Step 7.

 4. At On Save? / Publish Changes?, select from the below options (Note: This field only displays when Content Staging is enabled. 
See "Setting a Workflow"):

 l Check  the check box to publish these changes and set them as ready for approval. This automatically locks the content 
until it is either published or the lock is manually removed by an Administrator.

 l Uncheck  the check box if the content is not yet ready for publishing/approval. This enables you to save this draft and 
return to edit it at a later stage before submitting the content for approval.

 i. Check  the Lock Content? check box to lock this content from further changes until you the changes are pub-
lished  - OR - Uncheck  the check box to allow additional changes to this draft prior to publishing.

 5. Click the  Save link. If Direct Publishing is set for this module, the content changes are now displayed in the HTML Pro module. 
If Content Approval is enabled, continue to Step 7.



 6. Optional. In the Enter Submission Comment text box, enter a comment relating to this submission.

 7. Click the  Submit link. This enters these changes into the next stage of content approval and sends out notification messages 
as set in the workflow.

Tip: You will be notified when your changes are approved or rejected.

Related Topics:

 l See "About the Editor"

Tip: If Content Approval is enabled and this content is ready to publish, See "Publishing a Draft"

Adding Rich Text
How to add rich text to the HTML Pro module.

 1. Select  Edit Content from the HTML Pro module menu - OR - Click the  Edit Content link. 

 2. In the Current Content section, select the Rich Text Editor radio button located above the Editor. This displays the content as rich 
text. Note: This is the default view for this Editor, however if the Editor was last viewed by you as the Basic Text Box, it will display 
as such until it is changed.

 3. Enter your text, insert images, links, etc. Note: You can also switch the rendering mode of the Editor's content by switching 
between the Design and HTML tabs located below the Editor.

 4. Optional.  Click the Preview link located below the Editor. This expands the Preview section below and displays the content 
currently displayed in the Editor. If Direct Publish (rather than Content Staging) is used for this module, then skip to Step 6.

 5. At On Save? / Publish Changes?, select from the below options (Note: This field only displays when Content Staging is enabled. 
See "Setting a Workflow"):

 l Check  the check box to publish these changes and set them as ready for approval. This automatically locks the content 
until it is either published or the lock is manually removed by an Administrator.

 l Uncheck  the check box if the content is not yet ready for publishing/approval. This enables you to save this draft and 
return to edit it at a later stage before submitting the content for approval.

 i. Check  the Lock Content? check box to lock this content from further changes until you the changes are pub-
lished  - OR - Uncheck  the check box to allow additional changes to this draft prior to publishing.

 6. Click the  Save link. If Direct Publishing is set for this module, the content changes are now displayed in the HTML Pro module. 
If Content Approval is enabled, continue to Step 7.

 7. Optional. In the Enter Submission Comment text box, enter a comment relating to this submission.

 8. Click the  Submit link. This enters these changes into the next stage of content approval and sends out notification messages 
as set in the workflow.

Tip: You will be notified when your changes are approved or rejected.



Adding Rich Text to the HTML Pro Module

Related Topics:

 l See "About the RadEditor"

Pasting HTML Content
How to paste HTML into the HTML Pro module.

 1. Select  Edit Content from the HTML Pro module menu - OR - Click the  Edit Content link.    

 2. In the Current Content section, select the Basic Text Box radio button located above the Editor. This displays the Editor as a 
Basic Text Box. Content is displayed as HTML.

 3. At Render Mode (located below the Editor), select Html.

 4. Paste in your Html.

 5. Optional.  Click the Preview link located below the Editor. This expands the Preview section below and displays the content 
currently displayed in the Editor. If Direct Publish (rather than Content Staging) is used for this module, then skip to Step 7.

 6. At On Save? / Publish Changes?, select from the below options (Note: This field only displays when Content Staging is ena-
bled. See "Setting a Workflow"):



 l Check  the check box to publish these changes and set them as ready for approval. This automatically locks the con-
tent until it is either published or the lock is manually removed by an Administrator.

 l Uncheck  the check box if the content is not yet ready for publishing/approval. This enables you to save this draft and 
return to edit it at a later stage before submitting the content for approval.

 i. Check  the Lock Content? check box to lock this content from further changes until you the changes are pub-
lished  - OR - Uncheck  the check box to allow additional changes to this draft prior to publishing.

 7. Click the  Save link. If Direct Publishing is set for this module, the content changes are displayed in the HTML Pro module. If 
Content Approval is enabled, continue to Step 8.

 8. In the Enter Submission Comment text box, enter a comment relating to this submission.

 9. Click the  Submit link. This enters these changes into the next stage of content approval and sends out notification messages 
as set in the workflow.

Tip: HTML can also be pasted into the Raw Render Mode

Pasting HTML into the HTML Pro module

Adding Replacement Tokens
How to add replacement tokens into the HTML Pro module. See "Enabling/Disabling Token Replacement".



 1. Select Edit Content from the HTML Pro module actions menu - OR - Click the Edit Content link.

 2. Enter the replacement token into the Rich Text Editor. E.g. [User:FirstName] [User:LastName]. See "Replacement Tokens" for a 
complete list of tokens.

 3. Optional.  Click the  Preview link located below the Editor. This expands the Preview section below and displays the content 
currently displayed in the Editor.

 4. Optional. At On Save? select from these options:

 a. Check  the Publish Changes? check box to publish these changes immediately - OR - Uncheck  the check box if the 
content is not yet ready for publishing. Note: This field only displays when Content Staging is enabled.

 b. Check  the Lock Content? check box to lock this content from further changes until it is published  - OR - Uncheck  
the check box to allow additional changes.

 5. Click the  Save link.



Replacement Tokens Displaying the User's Name

Previewing Editor Content
How to preview the current content in the Editor using the HTML Pro module. This allows you to preview the content before updating it 
and/or publishing it. 

 1. Select Edit Content from the HTML Pro module actions menu - OR - Click the Edit Content link.

 2. Click the  Preview link located below the Editor. This expands the Preview section below (unless it is already expanded) and 
displays the content currently displayed in the Editor. Note: The state of the version being previewed is displayed at the Workflow 
State field. E.g. Edit Preview.

 3. You can now return to editing the content, or save/cancel this content.

Tip: Each time you modify the content in the Editor, you must re-click the Preview link to see the changes.



Previewing Editor Content

Viewing Previous Versions of Content
How to view previous versions, as well as the currently saved version, of content for an instance of the HTML Pro module. 

 1. Select  Edit Content from the HTML Pro module actions menu - OR - Click the  Edit Content link.

 2. Expand the Version History section.

 3. Click the Preview  button beside the required version.



The Preview section above is now maximized. It displays the content  for the selected version. It details the following information:

 l Workflow Used: The workflow that was used for the specific version being previewed

 l Workflow State: The state of the version being previewed

In addition, the Item History section can be expanded to view additional details.

Viewing Previous Versions of Content

Managing My Workflow Tasks
How to view and update content that required reviewing before it can be published using the HTML Pro module. This task requires that 
Workflow is NOT set to direct publish.           See "Setting a Workflow".

 1. Select My Work from the HTML Pro module actions menu. This displays the My Work page and a list of the content to be 
reviewed and published.

 2. Click on one of the listed [Page Name] links. This displays the selected module.

 3. You can now choose to edit, preview and/or publish the unpublished content.                     See "Publishing a Draft", or you can rollback to a 
previous version. See "Rolling Back Content".

Managing your Workflow Tasks



Approving  Content
How to approve unpublished content using the HTML Pro module.  This tutorial applies to the Content Approval workflow and other work-
flows with more than two states. 

Tip: As a content approver, you will receive a message when content is ready to be reviewed.

 1. Go to the required HTML module.

 2. Select Approve from the HTML Pro module actions menu - OR - Click the Approve  link. This displays the approval comment 
text box.

 3. Optional. In the Enter Approval Comment text box, add a comment. This comment is included in the notification message sent to 
the author.

 4. Click the  Approve Content link to approve this content and send an approval message  to the author.

Approving  HTML Pro Module Content



Approving or Rejecting Content
How to reject unpublished content using the HTML Pro module. This tutorial applies to the Content Approval workflow and other work-
flows with more than two states.

Tip: As a content approver, you will receive a message when content is ready to be reviewed.

 1. Go to the HTML Pro module.

 2. Select Reject from the HTML Pro module actions menu - OR - Click the Reject link. This displays the approval comment text 
box.

 3. In the Enter Reason(s) for Rejecting text box, enter a comment explaining why the content is being rejected. This comment is 
included in the notification message sent to the author.

 4. Click the  Reject Content link to reject this content and send the explanatory message to the author.

Rejecting HTML Pro Module Content



Locking/UnLocking HTML Pro Module Content
How to lock or unlock the content an HTML Pro module. Locking the content prevents further changes to the current content until either 
the changes are published, or the module is manually unlocked. Unlocking the content enables the currently published content to be 
edited and published.

Note: The module is automatically locked when submitting for approval and automatically unlocked on publish.

Tip: Module content can also be locked whilst it is being added.

 1. Select Lock Module or  Unlock Module from the HTML module actions menu - OR - Click the Lock Module or Unlock 
Module link.

Locking Module Content

Publishing a Draft
How to publish a draft of content using the HTML Pro module. Note: This tutorial only applies to the Content Staging workflow only, and 
custom workflows with multiple states.

Tip: The module must be Locked before publishing.

 1. Go to the required HTML Pro module.

 2. Select Publish from the HTML Pro module actions menu - OR - Click the Publish link.



Publishing a Draft

Rolling Back Content
How to rollback to a previous content version using the HTML Pro module. Note: This task requires that Workflow is NOT set to direct pub-
lish. See "Setting a Workflow".

 1. Select Edit Content from the HTML Pro module actions menu - OR - Click the Edit Content link.

 2. Maximize  the Version History section.

 3. Locate the required version.

 4. Optional. Click the Preview  button to preview a version. This expands the Preview section and displays the selected version 
including details on the related workflow and the Item History.



 5. Click the Rollback  button. The selected version is published immediately, even if the version was initially a draft (Content Stag-
ing).

 6. Click the  Cancel link to return to the module.

Rollback Module Content



Administrators
Setting Maximum Version History
How to set the maximum number of versions to keep in the history for each HTML Pro module instance using the HTML Pro module.

When publishing new content results in more versions than this number, the oldest version(s) will be permanently deleted (purged) until 
the remaining number of versions matches this number. When the value of the maximum number of versions changes from higher to 
lower, we will purge (delete) all the exceeding version history items ONLY when a new version is created.  If the value changes from 
higher to lower, we retain all the history items UNTIL a new version is created; thus if we do not create a new version and change the 
value from lower back to higher the history items, that were not purged, will re-appear.

The purging of older versions may appear to work differently depending on the defined workflow.  If  content approval is defined some-
where in the workflow, when drafts are created (which are not considered new versions) the above scenario does not apply.  Also regard-
ing drafts, drafts are directly related to a version, if a version is purged, then the draft will also be purged.  So depending on your workflow, 
version purging will become more implicit and dependant on your workflow.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the HTML Module Settings section.

 3. In the History Maximum text box, enter the maximum number of versions to save. The default value is 5.

 4. Click the  Update link.

Setting Maximum Version History

Tip: The Version History List section on the Edit Content page only displays after the first version of content is saved.

Configuring Admin Workflow Settings
How to configure  workflow setting for the HTML Pro module. These are Administrator only settings. For more details on setting available 
to authorized editors, see "Setting a Workflow".



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the HTML Module Settings section.

 3. At Page Workflow Override, select from these options:

 l Check  the check box to enable site level workflow configuration to be overridden at the page level. This enables the 
Page option at the Apply Workflow To field below.

 l Uncheck  the check box to require all HTML Pro modules on all pages to use the workflow configuration defined for 
the site. This disables the Page option at the Apply Workflow To field below.

 4. At Module Workflow Override, select from these options:

 l Check  the check box to enable site level workflow configuration to be overridden at the module level. This enables 
the Module option at the Apply Workflow To field below.

 l Uncheck  the check box to require all HTML Pro modules on this page to use the workflow configuration defined for 
this page. This disables the Module option at the Apply Workflow To field below.

 5. At Apply Workflow To, select from these options:

 l Module: Select to apply the workflow set on this module to this module only.

 i. Optional. At Replace Existing Settings, check  the check box if you want to replace existing settings.

 l Page: Select to apply the workflow set on this module to all modules on this page.

 i. At Replace Existing Settings, check  the check box to replace existing settings.

 l Site: Select to apply the workflow set on this module across all modules on the site.

 i. At Replace Existing Settings?, check  the check box to replace existing settings.



 6. Click the  Update link.

Tip: The Replace Existing Settings field must be checked to apply a workflow at the Page or Site level. This provides a safeguard against 
Administrators accidentally modifying Page and Site workflows.

Adding a Workflow
How to add a workflow to the HTML Pro module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the HTML Module Settings section.

 3. Click the Manage Workflows link. This opens the Manage Workflows page.



 4. Go to the Workflow section

 5. Click the Add New Workflow link.

 6. In the Workflow text box, enter a name for this workflow.

 7. In the Description text box, enter a description of this workflow.

 8. Click the Save link.



 9. This saves the new workflow and adds a new section called States. The default workflow states of Draft and Published have 
been created for this new workflow.

Next: See "Adding a Workflow State" to add one or more new states to this workflow.

Adding a Workflow State
How to add a new state to a workflow for a HTML Pro module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button. 

 2. Go to the HTML Module Settings section.

 3. Click the Manage Workflows link. This opens the Manage Workflows page.

 4. Go to the Workflow section.

 5. At Workflow, select the required workflow from the workflow drop-down box. 

 6. Go to the States section.

 7. Click the Add New State link. This displays the State Configuration section.



 8. Go to the State Configuration section.

 9. In the State text box, enter  a name for the workflow. 

 10. At Reviewers, click the check box to Grant  review content permissions to one or more roles and or usernames. 

 11. At Notify?, select from these options:

 l Check  the check box to set the reviewers specified at Permissions to receive an email notification once a version 
reaches this state. For the published state the author of the version will receive an email notification once it is pub-
lished.

 l Uncheck  the check box to disable notifications.

 12. At Active?, check  the check box to enable this new state - OR - Uncheck  the check box if this new state is not currently 
active.



 13. Click the Save link. The newly created workflow state is now listed in the States section.

 14. Optional. Repeat Steps 7-13 to add additional workflow states.

 15. Optional. Use the Up  and Down  buttons to reorder each state according to your workflow requirements.



Editing a Workflow State
How to edit an existing state in a workflow for the HTML Pro module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Go to the HTML Module Settings section.

 3. Click the Manage Workflows link. This opens the Manage Workflows page.

 4. Go to the Workflow section.

 5. At Workflow, select the required workflow from the drop-down box. This displays details of the selected workflow in the States 
section.

 6. Go to the States section.

 7. Click the Edit  button beside the state to be edited. This displays a list of the workflow states associated with this workflow in 
the State Configuration section.

 8. Go to the State Configuration section and edit any of the following as required:

 a. In the State text box, edit the workflow name. 

 b. At Reviewers, select permissions are required. 

 c. At Notify?, select from these options.

 l Check  the check box to set the reviewers specified at Permissions to receive an email notification once a 
version reaches this state. For the published state the author of the version will receive an email notification 
once it is published.

 l Uncheck  the check box to disable notifications.

 d. At Active?, check  the check box to enable this state - OR - Uncheck  the check box to disable this state.

 9. Click the Save link.

Activating/Deactivating a Workflow
How to set an existing workflow as active or inactive for the HTML Pro module. This sets the workflow as inactive on the site.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Go to the HTML Module Settings section.

 3. Click the Manage Workflows link. This opens the Manage Workflows page. 

 4. Go to the Workflow section.

 5. At Workflow, select the required workflow from the workflow drop-down box. 

 6. At Deleted? select from these options:

 l Check  the check box to deactivate this workflow. Deactivated workflows cannot be selected when configuring the 
HTML Module Settings. This allows any existing modules with this workflow set to continue using this workflow if 
required, but prevents it from being selected again.

 l Uncheck  the check box to activate this workflow.

 7. Click the Save link.

Activating/Deactivating a Workflow

Deleting a Content Version
How to delete a specific version of the content using the HTML Pro module.

 1. Select Edit Content from the HTML Pro module actions menu - OR - Click the Edit Content link.

 2. Maximize  the Version History section.

 3. Locate the required version.

 4. Optional. Click the Preview  button to preview the version. This expands the Preview section and displays the selected ver-
sion including details on the related workflow and the Item History.

 5. Click the Delete              button. This displays a message similar to "Are you sure you wish to permanently delete version 3 [ that 
was created on [date] by [username]."



 6. Click the OK button to confirm.

 7. Click the  Cancel link to return to the module.

Settings
Enabling/Disabling Token Replacement
How to enable or disable token replacement on the HTML Pro module. Token replacement enables tokens such as [FirstName] to be 
replaced with the first name of the authenticated user. Tokens include information such as user details, portal name, key words, date, 
time, etc. 

Important. Inline editing and module caching are disabled if token replacement is enabled.

Important. Users must have Add Content/Edit permissions to the Page on which the HTML module is located in order to manage module 
settings.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the HTML Module Settings tab. 

 3. At Replace Tokens, select from these options:

 l Check  the check box to enable full token replacement.

 l Uncheck  the check box to disable token replacement. This will display any tokens as text in the Editor.

 4. Click the  Update link.



Enabling Token Replacement

Related Topics:

 l See "Adding Replacement Tokens"

Setting a Workflow
How to set the workflow for the HTML Pro module. The below settings are available to authorized editors. Note: Administrators can also 
set a workflow as the site default. See "Configuring Admin Workflow Settings"

Important. Users must have Add Content/Edit permissions to the Page on which the HTML Pro module is located in order to manage 
module settings.

Tip: Whether it is for an individual module or you wish to set the default for the site an HTML Pro module must first be added to some 
page on your site.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the HTML Module Settings tab. 

 3. At Workflow, select the workflow you wish to use from these options:

 l Content Approval: Content Approval is similar to Content Staging but it adds an extra "Ready for Approval" state 
between the draft and published states. This allows reviewers to monitor and either approve or reject  any content 
added before it is actually published to the site.

 l Content Staging: Content staging allows content to be saved as a draft before it is published. Draft content will only be 
visible when edit mode is selected by users who can edit the module/page.  In view mode the most recent published ver-
sion of content will be displayed instead of the draft. This is the same for users with view permissions only. See "Pub-
lishing a Draft".

 l Direct Publish: With the direct publish workflow any content that is saved on the Edit Content page or through the inline 
editor will be immediately visible to all users with permissions to view the module. Editing users will be able to see the 
content for both view and edit mode.  

 4. At Module Workflow Override, select from the below options. Note: This option will be disabled if Page Workflow Override has 
been disabled by an Administrator. See "Setting Page Workflow Override"

 l Check  the check box to enable page level workflow configuration to be overridden at the module level. This enables 
a unique workflow the be set for this module, rather than using the workflow set for all modules on this page by an 
Administrator.

 l Uncheck  the check box to set all modules on this page to use the workflow defined for the page.



 5. At Replace Existing Settings, check  the check box to replace the existing settings with these new settings. This option must 
be selected to override the previous settings. It exists as a safeguard against accidental changes.

 6. Click the  Update link.

Setting the Workflow for all HTML Pro Modules on this Site

IFrame
About the IFrame Module
The IFrame module displays content from your web site or another web site within a frame inside a page. The IFrame can be used to 
frame content such as documents, PDF files, images or web site pages. Optional settings include displaying a frame border or adding a 
scroll bar. The width and height of the IFrame can be set as required. A number of querystring parameters can also be set to customize 
the contents of the IFrame.

Module Version: 04.04.00

Minimum DNN Version: 04.03.05



The IFrame Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleIFrame/tabid/845/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/39/scope/threads/Default.aspx

 l Issue Tracker: http://dnniframe.codeplex.com/workitem/list/basic

Module Editors
Displaying an External URL in an IFrame
How to display an external URL such as a web site page, an image or a file in the IFrame module.

Tip: It is good 'netiquette' (network etiquette) to request permission of a site owner before framing their content.

 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link.

 2. Go to the Options section. 

http://www.dotnetnuke.com/Products/Development/Forge/ModuleIFrame/tabid/845/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/39/scope/threads/Default.aspx
http://dnniframe.codeplex.com/workitem/list/basic


 3. At Source, select URL ( A Link To An External Resource ). 

 4. In the Location: ( Enter The Address Of The Link ) text box, enter the URL of the content to be displayed. E.g. http://ww-
w.domain.com/brochures/document.docx

 5. The following optional settings are   recommended: 

 a. In the Width text box, enter the width for the IFrame in either pixels (E.g. 700) or as a percentage (E.g. 100%). If no 
width is entered a default width of 280 pixels is used. 

 b. In the Height text box, enter a height for the IFrame in pixels. If no height is entered a default height of 130px will be 
used.

 c. At Auto Height, skip this step as it only works for files located on your site.

 d. At Scrolling, set the properties of vertical and horizontal scroll bars: 

 l Auto: Scroll bar  displays only when scrolling is required. 

 l No: No scroll bar is displayed. If this option is selected, ensure width and height settings are set to ensure all 
the content can be viewed as users will be unable to scroll. 

 l Yes: Scroll bars display at all times.

 d. At Border, select No to display the file without a border - OR - Select Yes to display a border around the IFramed con-
tent.

 6. Optional. Maximize  the Other Options section to set any of the following fields:

 a. At Allow Transparency, check  the check box to enable transparency on the IFrame, or uncheck  the check box to 
disallow transparency. 

 b. In the Name text box, enter a name for this IFrame content. This name specifies a unique name of the IFrame (to use in 
scripts or as targets for links/IFrames). 

 c. In the Tool Tip text box, enter the tool tip to be displayed when the user hovers their mouse over the IFrame. 

 d. In the Css Style text box, enter a CSS style to be used. 

 e. In the Onload (JavaScript) text box, enter the JavaScript to be executed when the page loads. This field can only be 
set by Administrators. You can do things like alert ("Here's my IFrame") which will pop up an alert box.

 7. Click the Save link.



Displaying an External URL in an IFrame



A web site displayed in the IFrame module

Displaying an Internal File in an IFrame
How to display an internal file such as an image or document in the IFrame module. Note: If the document opens in a new window this 
may be a result of a setting on your Web browser.

 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link. 

 2. Go to the Options section. 

 3. At Source, select File ( A File On Your Site ). 

 4. At File Location/File Name: select or upload the required file. 

 5. The following optional settings are   recommended:

 a. In the Width text box, enter the width for the IFrame in either pixels (E.g. 700) or as a percentage (E.g. 100%). If no 
width is entered a default height of 280 pixels is used. 



 b. In the Height text box, enter a height for the IFrame in pixels. If no width is entered a default height of 130px will be 
used. 

 c. At Auto Height, check  the check box to automatically display the IFrame at 100% for this file, or uncheck  to dis-
able. This option only works for files located on your site. 

 d. At Scrolling, select one of the following options: 

 l Auto: The scroll bar  displays only when scrolling is required.

 l No: No scroll bar is displayed. If this option is selected, ensure width and height settings are set to ensure all 
the content can be viewed as users will be unable to scroll.

 l Yes: Scroll bars display at all times.

 e. At Border, select No to display the file without a border - OR - Select Yes to display a border around the IFramed con-
tent.

 6. Optional. Maximize  the Other Options section to set any of the following fields:

 a. At Allow Transparency, check  the check box to enable transparency on the IFrame, or uncheck  the check box to 
disallow transparency. 

 b. In the Name text box, enter a name for this IFrame content. This name specifies a unique name of the IFrames (to use 
in scripts or as targets for links/IFrames). 

 c. In the Tool Tip text box, enter the tool tip to be displayed when the user hovers their mouse over the IFrame. 

 d. In the Css Style text box, enter a Css style to be used. 

 e. In the Onload (Javascript) text box, enter the JavaScript to execute when the page loads. This field can only be set by 
Administrators.

 7. Click the Save link.



Displaying an Internal File in an IFrame

Tip: IFrame content may appear in a new Web browser window rather than in the IFrame on the page. This is caused by settings on the 
user's Web browser. 



The Internal File displayed in the IFrame

Displaying a Site Page in an IFrame
How to display an internal file such as an image or document in the IFrame module.

 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link.

 2. Go to the Options section.

 3. At Source, select File ( A File On Your Site ).

 4. At File Location/File Name: select or upload the required file.

 5. The following optional settings are   recommended:

 a. In the Width text box, enter the width for the IFrame in either pixels (E.g. 700) or as a percentage (E.g. 100%). If no 
width is entered a default height of 280 pixels is used.

 b. In the Height text box, enter a height for the IFrame in pixels. If no width is entered a default height of 130px will be 
used.

 c. At Auto Height, check  the check box to automatically display the IFrame at 100% for this file, or uncheck  to dis-
able. This option only works for files located on your site.

 d. At Scrolling, select one of the following options:



 l Auto: The scroll bar  displays only when scrolling is required. 

 l No: No scroll bar is displayed. If this option is selected, ensure width and height settings are set to ensure all 
the content can be viewed as users will be unable to scroll.

 l Yes: Scroll bars display at all times.

 e. At Border, select No to display the file without a border - OR - Select Yes to display a border around the IFramed con-
tent.

 6. Optional. Maximize  the Other Options section to set any of the following fields:

 a. At Allow Transparency, check  the check box to enable transparency on the IFrame, or uncheck  the check box to 
disallow transparency. 

 b. In the Name text box, enter a name for this IFrame content. This name specifies a unique name of the IFrames (to use 
in scripts or as targets for links/IFrames). 

 c. In the Tool Tip text box, enter the tool tip to be displayed when the user hovers their mouse over the IFrame. 

 d. In the Css Style text box, enter a Css style to be used. 

 e. In the Onload (Javascript) text box, enter the JavaScript to execute when the page loads. This field can only be set by 
Administrators.

 7. Click the Save link.



Displaying a Site Page in an IFrame



Displaying a Site Page in an IFrame

Editing an IFrame
How to edit the settings of the IFrame.

 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link.



 2. Edit one or more settings as required. 

 3. Click the Save link.

Adding QueryString Parameters
How to add QueryString Parameters to the IFrame module.

Note: QueryString parameters are useful for passing information from your DNN site to the source web site displayed in the IFrame. For 
example: Let's say the web site displayed in the IFrame needs to know the first name of your user so it can display their first name. In the 
page you could pass the first name through by entering FirstName in the Name text box and by selecting User’s First Name from the 
Value drop down list. This only works if the web site in the IFrame knows how to pick up these parameters from the QueryString. There-
fore when setting these values you need to know the names of the parameters which the target web site can use from the QueryString.

 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link.

 2. Set IFrame options as required. See "Displaying an External URL in an IFrame", See "Displaying an Internal File in an IFrame" 
or See "Displaying a Site Page in an IFrame"

 3. Maximize  the QueryString Parameters section. 

 4. Click the Add QueryString Parameter link. 

 5. In the Name text box, enter a name for the QueryString.  E.g. TabID 

 6. At Value, select a parameter type from the drop-down list. The following options are available: Static Value, Pass-Through Que-
ryString, Pass-Through Form Post, Custom User Property, Portal ID, Portal Name, Tab ID, User ID, User's Username, User's First 
Name, User's Last Name, User's Full Name, User's Email, User's Website, User's IM, User's Street, User's Unit, User's City, 
User's Country, User's Region, User's Postal Code, User's Phone, User's Cell, User's Fax, User's Locale, User's TimeZone, 
User's Authorized Flag, User's Lock Out Flag, or User's SuperUser Flag.

 7. Optional. Enter a value in the third text box which will be displayed if either Static Value, Pass-Through QueryString, Pass-
Through Form Post, or Custom User Property are selected.

 8. Optional. At Use As Hash, select this option to pass the querystring parameter through to the IFrame as a bookmark/anchor. 
E.g. Default.aspx#787. This replaces the usual format of Default.aspx?tabid=787.

 9. Click the Save  button. 



 10. Repeat Steps 4-9 to add additional QueryStrings.

 11. Click the Save link.

Note: The below image examples, the IFrame is set to display site content which has been set with the anchor (bookmark) named "Fair-
Trade". The Fair Trade information is located a long way down the page, however by setting the IFrame to this bookmark (by selecting the 
Use As Hash option) this content is displayed at the top of the module.

The Framed Content



Editing QueryString Parameters
How to edit QueryString Parameters on the IFrame module.

 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link. 

 2. Maximize  the QueryString Parameters section. 

 3. Click the Edit  button beside the parameter to be edited.

 4. Edit the Name and/or Value fields. See "Adding QueryString Parameters"

 5. Click the Save  button. 

 6. Repeat Steps 3-5 to edit additional QueryStrings 

 7. Click the Save link.

Deleting a QueryString Parameter
How to delete QueryString Parameters set on the IFrame module.



 1. Select Edit IFrame Options from the module actions menu - OR - Click the Edit IFrame Options link. 

 2. Maximize  the QueryString Parameters section. 

 3. Click the Delete  button beside the parameter to be deleted. This displays the message "Are you sure you want to remove 
this item for the data source? Once remove it cannot be retrieved."

 4. Click the OK button to confirm deletion.

 5. Repeat Steps 3-4 to delete additional QueryStrings.

 6. Click the Save link.

Administrators
Troubleshooting: IFrame Redirects To Source web site
Sites can be programmed to prevent them from being framed with the IFrame module. If these sites are saved as the Source in an IFrame 
module, the site will not appear inside the IFrame module on the page. Instead, when a user clicks on the page containing this IFrame, 
they will be redirected to the framed web site. To avoid to this problem, do not frame any sites without first seeking the permission of the 



site owner and confirming with their webmaster that the Source to be framed permits framing. If however, a Source URL is to be used with-
out first confirming that the web site can be framed, we suggest the following precautions:

 1. Create a new page and test the source URL on this page. 

 2. If the web site does not permit framing, log in as the Administrator on the home page of the portal. 

 3. Navigate to Admin > Pages. 

 4. Locate the test page and delete it.

Links
About the Links Module
The Links module displays a list of links to a page, file or user on your portal; or to an external URL. Links appear in numerical-alpha-
betical order by default, or can be reordered.

Links can be set to display in either vertically (default), horizontally, or in a drop-down list. The link description can be set to display either 
as a tool tip when the user hovers their mouse over the link title, or as an Info Link (E.g. linked leader dots) which displays when the ... 
link is clicked. Links can also be set to disallow wrapping and can display the same icon beside each link.

Module Version: 04.00.01 

Minimum DNN Version: 04.06.02

Features: IPortable, ISearchable

The Links Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Products/Development/Forge/ModuleLinks/tabid/857/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/45/scope/threads/Default.aspx

 l Issue Tracker: http://dnnlinks.codeplex.com/workitem/list/basic

All Users
Viewing a Link Description set as an Info Link 
How to view the description of a link where the Links module is set to Info Link.

 1. Click on the info link leader dots ... displayed beside a link. This displays the description  below the link.

http://www.dotnetnuke.com/Products/Development/Forge/ModuleLinks/tabid/857/Default.aspx
http://www.dotnetnuke.com/Community/Forums/tabid/795/forumid/45/scope/threads/Default.aspx
http://dnnlinks.codeplex.com/workitem/list/basic


Info Link displayed

Module Editors
Adding a Link 
How to add a link to the Links module.

 1. Select Add Link from the module actions menu - OR - Click the Add link link. 

 2. In the Title text box, enter a title for the link as it will be displayed in the module. 

 3. At Link, select the required link type and set the link. See one of these tutorials for more:

 l See "Setting a File Link"

 l See "Uploading and Linking to a File"

 l See "Setting a Page Link"

 l See "Setting a URL Link"

 l See "Selecting an Existing URL Link"

 l See "Adding a User Profile Link"

 l See "Setting No Link"

 4. The following Optional fields are also available: 

 a. At Track Number Of Times This Link Is Clicked? check  the check box track the number of times the link is clicked- 
OR - Uncheck  the check box to disable this feature. 

 b. At Log The User, Date, And Time For Every Link Click?, check  the check box to add a Link Log to this screen once 
the record has been updated- OR - Uncheck  the check box to disable the URL log. 

 c. At Open This Link In New Browser Window?, check  the check box to open the link in a new Web browser window - 
OR - Uncheck  the check box to open the link in the existing Web browser window. 

 d. In the Description text box, enter a description for the link. 



 e. In the View Order text box, enter a number to indicate the order of this link. E.g. 0 = First link; 1 = Second link, etc. This 
setting overrides the default order. By default, links are order by numeral-alphabetic. E.g. 1, 2, 3, a, b, c.

 5. Click the Update link.

Adding a Link

Related Topics

Editing a Link displayed Horizontally or Vertically 
How to edit a link that is displayed either horizontally or vertically on the Links module.

 1. Click the Edit  button beside the required link. 



 2. Edit the required fields. 

 3. Click the Update link.

Editing a Link in a Drop-Down List 
How to edit a link displayed in a drop-down list for the Links module.

 1. Select the link from the drop-down list. 

 2. Click the Edit  button.

 3. Edit the required fields. 

 4. Click the Update link.

Deleting a Link displayed Horizontally or Vertically 
How to delete a link that is displayed horizontally or vertically in the Links module.

 1. Click the Edit  button beside the required link. 

 2. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?"   

 3. Click the OK button to confirm deletion.



Deleting a Link

Deleting a Link displayed in a Drop-Down List 
How to delete a link displayed in a drop-down list on the Links module.

 1. Select the required link from the drop-down list.

 2. Click the Edit  button.

 3. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 4. Click the OK button to confirm deletion.

Deleting a Link



Settings
Displaying Links in a Drop-Down List 
How to display links in a drop-down list using the Links module. By default, links are displayed in a vertical list.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Link Settings tab. 

 3. At Control Type, select Dropdown. 

 4. Click the  Update link.

Links Displayed in a Drop-Down List

Displaying Links Vertically 
How to display links in a vertical list on the Links module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Link Settings tab. 

 3. At Control Type, select List. 

 4. At List Display Format, select Vertical. 

 5. At Display Info Link, select either Yes or No. 

 6. Click the  Update link.

Links Displayed Vertically

Displaying Links Horizontally 
How to set links to display horizontally on the Links module.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Link Settings tab. 

 3. At Control Type, select List. 

 4. At List Display Format, select Horizontal. 

 5. Click the  Update link.

Links Displayed Horizontally

Displaying the Description as a Link 
How to set the link description to display as a link on the Links module. By default, the link description displays when a user hovers over 
the link. This setting instead displays a series of leader dots ... which can be clicked to display the description. Clicking on the ... link dis-
plays the link description below the link title. This setting is useful when the description is lengthy and offers some valuable information 
about the link.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Link Settings tab. 

 3. At Display Info Link, select Yes. 

 4. Click the  Update link.

Info Link and Icons  Displayed

Setting Wrapping or No Wrapping for Links 
How to set links to allow or disallow wrapping on the Links module. When wrapping is selected the link title is allowed to display on more 
than one line. When no wrapping is set, the link title will only display on one line and may expand the width of the module to do so.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Link Settings tab. 



 3. At Wrap Links, select Wrap to allow wrapping - OR - No Wrap to disallow wrapping.  

 4. Click the  Update link.

Links set with No Wrapping

Links set with Wrapping

Displaying an Icon beside Links 
How to set the links module to display an icon beside all links on the Links module. Only one icon (image) can be selected per module 
and will be displayed beside all links added to that module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Link Settings tab. 

 3. At Display Icon select or upload the required image. See "Setting a File Link" or "Uploading and Linking to a File".

 4. Click the  Update link.



Icon (and Info Link) Displayed

Map
About the Map Module
The Map module, using the Google Maps API, provides the ability to pump any custom data into the Google Map in a number of unique 
ways.

The Map module provides a standard solution for recording and plotting geo coordinates along with descriptive information in the DNN 
environment was the core need for the development of the Map module. This documentation provides all the information you will to setup 
and use all the provided features of the Map module within DNN. It has been structured to make it relatively easy to walk through the envi-
ronment and its usage.

Module Version: 01.00.09

Minimum DNN Version: 04.00.03

 l Standard Mode - Display all the points for the designated Module, simultaneously.

 l Playback Mode - Display all the points for the designated Module, in the order which they appear in your source data. This data 
can have associated times and dates that control the functionality of the playback. The most common example of this is the pro-
vided "Regions Online" map which plots the Users Online data - one point for each world Region, in the order which that region 
was first added to your user base. A very effective display, and fun to watch!

 l Positional Mode - Displays the points in your data source by Longitude, Latitude within a target radius. Whenever the user clicks 
the map, the points are automatically fetched from the server  and plotted on the map around the selected point.

 l Directory Mode - Displays the points in your data source within a configurable directory structure. This directory, similar to most 
other map based directory components also uses the Positional Mode interaction, so you data is easily displayed regionally.

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleMap/tabid/952/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/130/scope/threads/Default.aspx

 l Issue Tracker: http://dnnmap.codeplex.com/workitem/list/basic

Module Editors
Getting Started with the Map Module
Within a page in your DNN instance, select and add the Map module to one of your panes. Once added, the initial interface of the map 
will provide a brief description of how to get started:

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleMap/tabid/952/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/130/scope/threads/Default.aspx
http://dnnmap.codeplex.com/workitem/list/basic


Select Edit Map from the module actions menu. This displays the Map Control Panel where you configure the map. The interface for the 
Control Panel is broken into the following regions:

 l General –  the interface used to provide a selection of your interface, source and geo locator providers. These also act as the 
base point for sharing of your map data and map interfaces between map modules.

 l Interface – the interface provider provides the interface options and administration for the look and feel of the Map

 l Data Source – the data source provider sets the properties regarding the source of the data. The standard install included 
Users/Membership, Standard Data Points and Custom Queries.

 l Data – To manipulate the data for the map, regardless of your data source, use the Data page.

 l Geo Locator – Whenever an Address must be geo coded, to obtain a longitude and latitude, the Geo Locator configured for the 
map is utilized.

To begin setup of your Map

Click the General button (If this is a new map, no other Icon will be enabled). Unlike many other module which contain information for the 
specific Module in and of itself, the DNN Map is different. Since you will be creating one or more maps with one or more sets of data 
which you may be utilizing through your Web site in different capacities, the DNN Map module manages the Maps and Sources in a 
manner that lets you share them within your portal and between your modules. 

To get started, first pick a Map Configuration. This identifies the basic name and description of your Map interface, not your specific data. 
Let's say throughout your site you will have many maps which will have the same consistent look and feel, but with different sources of 
data. The Map Configuration refers to the look and feel of the map.



Once a Name and Description are provided, you can now select from a list of Visual Layouts, called Providers. The core module is deliv-
ered with four of these layouts. 

 l Standard: Loading your points all at or near the same time. 

 l Time lapse:  Loading your points in a playback sequence dictated by the Sequence Number for each point 

 l Positional: Loading only the points which will populate the display region when clicked. 

 l Directory: An advanced layout combining Positional with a familiar Address Directory look and feel. 

Like the Map Interface, you will also need to setup or select the basic Source Settings. These settings provide the ability to pick from the 
available Data Providers and Geo coders. The default module ships with the Google Geo coder and the Standard Data Provider.

Again you will need to provide both the Name and optionally the Description of your Map Data Source.

Once complete, and you have satisfied the requirements for the General settings, click the Save link. The Save and Cancel button are 
always placed in the same location and are common for each interface within the module.

Once a configuration for the Map is either Created or Selected, the remaining items on the Control Panel will be enabled.

For configuration of your map for setting up the Layouts:



 l See "Configuring the Directory Settings"

 l See "Configuring the Positional Settings"

 l See "Configuring the Time Lapse Settings"

For configuration of data sources:

 l See "Setting a User/Membership Map"

 l See "Setting Standard Data Points"

 l See "Managing Map Data"

 l See "Adding External Data Sources"

 l See "Adding Custom Queries"

Design/Architecture
The currently provided solution for the core module is broken into three distinct yet separate units:

Data Source Provider: One basic provider is installed with the core installation of the Map module, which stores the physical point data. 
This DOES NOT apply to the configuration settings, source parameters or physical runtime settings of the map, but rather the location, 
storage and manipulation of the map points for this source provider. Future documentation will be provider for insight and examples of 
creating your own source providers.

Visual Provider: four basic providers for the visual layout of the map are provided with the core installation. These four providers, cur-
rently bound to the Google API control the look, feel and interaction of the map. The visual provider is built to contact the source provider 
for its points, and therefore the points are retrieved and plotted by the visual provider. The visual provider consists of two front-end inter-
faces: the Admin of the provider and the UI of the provider. Future documentation will be provided to show how to create and manipulate 
these providers. Additionally more providers are under development for integration with other Map API’s (like Yahoo and Microsoft).

Geo Locator Provider – one provider is supplied with the core build of the map module. This can be extended or more providers can be 
created for supporting additional geo coding services. Future documentation on this subject will be provided.

Setting the Standard Interface
The Standard behavior of the Map is provided to simply load all the points provided within your database. This is the preferred method 
when dealing within smaller sets of points (in the order of a hundred or so). When you have more records than this, you will undoubtedly 
require use of the more advanced map layouts to improve performance.

Setup of the Google API Key

This interface uses the Google API for representation, but can be duplicated to be used with most other Javascript based map solutions.

To begin you must add your Google License Key. This key is bound specifically to a domain name url, unless  you operate under a local 
environment. In that case, the folder is required for the correct license key to work. 

 1. Click the Add License Key link to add your key. Click Get One to connect to Google and setup the license key:



 2. Click the Save License Key link to add the key to your License Key list. If your site will be referenced via multiple base URL's, you 
will need to configure the additional keys here. Note: The Domain is not the specific domain, but rather a portion of the domain 
itself. Map will find the most appropriate key based on the incoming domain name. 

Once you add a key that works for the administration interface, the Interface Map Layout will display the Map based on your current set-
tings. If the Map does not display, no license key that is configured will currently work with that domain name.

Setup of the Markers

Whenever points are placed on the map, they are plotted based on the Icon Index specified within the Point (the default value is zero). 
Each point may use its own Icon Index, but most icons are shared among many points. To configure those markers, click on Add Marker 
in the Markers area of the Interface settings.

Markers are easy to configure – and require 5 basic properties. The Image, Shadow Image, Dimensions of the Image, Dimensions of the 
Shadow, the Shadow Anchor (relative to the Image) and the Info anchor (relative to the Image).

Here's how to set up marker:

 1. Select the Image by using the File Link control. This image will be displayed as the marker for your point. 

 2. Select the Shadow Image. This image will be displayed behind the Image set as the Marker Image, and will provide a shadowed 
effect to the interface.

 3. Set the Width and Height of the  marker – it is not required that the Image match the Width and Height of the marker, but rather the 
Marker controls its width and height specifically from here. These values are in Pixels.

 4. Set the Shadow Width and Height – the shadow is usually wider than the actual image to get the correct look and feel. These 
values are in Pixels.

 5. Set the Anchor X Y. The shadow image will be anchored to be overlapped by the marker Image at that location.  These values 
are in Pixels.

 6. Set the Info X Y. The pop-up balloon that is referred to as the Info Window will be plotted on your page, based on the relative posi-
tion of the Image and this setting. These values are in Pixels.



 7. Click the Save Marker link to save the marker settings.

Setup of the Map Layout

The Map Layout interface is common among the standard core layouts. To configure the Map Layout, you must specify the Latitude and 
Longitude of the map at a minimum, otherwise location 0,0 is the position of the map (as is shown in the default module settings).





 l Map – using the familiar Google Map interface, drag around the map until you settle on the location you prefer. This management 
allows you to quickly set the default map properties you desire. Once you have the location you want, move on to Latitude and 
Longitude. Alternatively, you can manually set these properties.

 l Latitude / Longitude – click the Set link to assign the Latitude and Longitude to the current Map view position. Or manually set the 
Latitude and Longitude to your desired location. If a Description is provided, a point will be plotted at this location.

 l Description – when provided, a point will be placed on the map with the content of your description in its information window. If 
Description is not provided, no point is placed at the provided coordinate.

 l Width – the width of the map, either can be a percentage (as in 100%) or a pixel width (as in 300 or 300px).

 l Height - the height of the map, can be either a percentage (as in 100%) or a pixel width (as in 300 or 300px). 

 l Zoom Level – the default zoom level to use within the map interface display. Click the Set link to pull the zoom level from the Map 
Layout.

 l Map Type – allows you to display the map as either a standard Map, a Satellite Map or a Hybrid Map. Click the Set link to pull the 
Map Type from the Map Layout.

 l Control Type – optionally display the Map Type Selector by choosing “Visible” for the Control Type.

 l Navigation Control – you can display the left hand navigation control in one of three ways – either “Small”, meaning no extended 
zoom control; “Large” which provides the full zoom control; or “None”.

 l Overview Control- the small bottom right hand corner Overview Control is provided if “Visible” is selected.

Setup of the Standard Layout Settings

Each Interface can provide any additional settings that it requires. For the Standard Layout Map, the following options are provided.

 l Initial Delay (ms) – identifies to the Google API that it should hesitate a brief number of milliseconds before attempting to begin 
requesting for point information.

 l Retry Delay (ms)- identifies to the Google Map lookup that it will retry the Initial connection on a specific loop amount. This is only 
required if  the Web site in question has performance issues with the general layout and production of map points.

Configuring the Directory Settings
The Directory layout for DNN Map provides visual representation of you data points via both the Map itself, and a provided directory struc-
ture. The records are paged through a familiar page selector. Overall, the layout can be highly customized, resorting to the default layouts 
provided by the Map, or by providing your own.

Setup of the Positional Layout Settings

Each Interface can provide any additional settings that it requires. For the Positional Layout Map, the following options are provided.

 l Initial Delay (ms) – identifies to the Google API that it should hesitate a brief number of milliseconds before attempting to begin 
requesting for point information.



 l Retry Delay (ms) - identifies to the Google Map lookup that it will retry the Initial connection on a specific loop amount. This is 
only required if  the website in question has performance issues with the general layout and production of map points.

 l Default Radius – identifies the Mile Radius to use when plotting points that should be  displayed relative to the currently selected 
position. 

 l Results Per Page  - the number of records to display per page in the Directory.

 l Search Template – the default template to use for the text contained within the Search area. The Template allows you to place 
the default textbox and button within the template via the values: [TEXTBOX] and [BUTTON]. Clicking the Load Default link will 
automatically place the default value into the text area for  you to use or modify. For example:

<table align='center' width='100%' border='0' cellpadding='1' cellspacing='1'>

<tr>

<td>Enter an address in the space provided to find locations near you.</td>

</tr>

<tr>

<td>[TEXTBOX][BUTTON]</td>

</tr>

</table>

 l No Result Template  - When no results are returned from the Directory, you can provide a specific value. Place that text in this tem-
plate value. Click the Load Default link to use the standard value. For example:

The selected location contains no results, please select a different location on the map.

 l Textbox Element ID  -  You can provide your own custom search text box by providing the element id as it appears in your html 
here.

 l Button Element ID – You can provide your own custom search button by providing the element id as it appears in your html here.

 l Target Element ID – You can provide your own custom location for the directory results to be displayed, rather than displaying it 
within the current module. For example, a div who’s id is “divMyDirectory”. Place the element id as it appears in your html here.

 l Main CSS Name- override the look and feel of the module by setting your own CSS classes to be used for the layout and struc-
ture of the directory. This setting refers to the containing element.

 l Main CSS Item Name – the class name to use from your CSS for the directory items

 l Main CSS Alternate Name – the class name to use from the CSS for the alternating directory items

 l Main CSS Hover Name – the class name to use form the CSS for the mouse over  of each directory item.

 l Paging Element ID – the pager can be placed outside the confines of the Map module, to do this, place the element id as it 
appears within your html here.

 l Paging CSS Name –  the class name to use from the CSS for the body of the pager.

 l Paging CSS Link Name – the class name to use from the CSS for the page link in the pager.



 l Paging CSS Hover Name – the class name to use from the CSS for the page links that are currently handling a mouse over.

 l Item Template - the default template to use for the directory items. Clicking the Load Default link will automatically place the 
default value into the text area for  you to use or modify. This value can use the following set of replacement parameters:

 l [CLASS] is used for the name of the item class or alternating item class.

 l [ONCLICK] is used to handle the default click of the item in the directory.

 l [ONMOUSEOVER] and [ONMOUSEOUT] are used to change the class name of the item element based on your CSS set-
tings.

 l [ICON] is used to obtain the URL of the image for the specific directory item.

 l [DESCRIPTION] is used to obtain the description of the point.

 l [ADDRESS] is used to obtain the address value of the point.

 l [LONGITUDE] is used to retrieve the longitude of the point.

 l [LATITUDE] is used to retrieve the latitude of the point.

 l [DISTANCE] is used to obtain the distance from the clicked map position to the physical point.

For example:

<DIV width=100% class=[CLASS]  [ONCLICK] [ONMOUSEOVER] [ONMOUSEOUT]>

<img src="[ICON]" align=right valign=middle>

[DESCRIPTION]<br>

[DISTANCE]

</DIV>

 l onClick Plot – when checked, the point will be plotted on the map when the directory item is clicked.

 l onClickPan – when checked, the map will pan to the point at the current zoom level when the item is clicked.

 l onClickZoom – when set, the map will zoom to the provided zoom level when the directory item is clicked.

 l onClickClear – when set, the points on the map will be cleared (should be used with Plot) whenever a directory item is clicked.

Configuring the Positional Settings
The Positional layout of the Map identifies that the points will be loaded automatically whenever the users clicks on a new position within 
the map, based on the provided radius. In the settings below, provide the standard Map properties, and finally set the Radius you would 
prefer.

Important: See "Setting the Standard Interface" before you begin for to learn how to set Google API Key, Markets and Map Layout before 
beginning with Positional Settings.

Setup of the Positional Layout Settings

Each Interface can provide any additional settings that it requires. For the Positional Layout Map, the following options are provided.



 l Initial Delay (ms) – identifies to the Google API that it should hesitate a brief number of milliseconds before attempting to begin 
requesting for point information.

 l Retry Delay (ms) - identifies to the Google Map lookup that it will retry the Initial connection on a specific loop amount. This is 
only required if  the website in question has performance issues with the general layout and production of map points.

 l Default Radius – identifies the Mile Radius to use when plotting points that should be  displayed relative to the currently selected 
position. 

Configuring the Time Lapse Settings
The Time lapse layout of the Map identifies that the points will be loaded sequentially, based on the Sequence identified within the 
points. Below the map, a friendly playback and timeline structure is provided for easy replay. You can choose to automatically playback 
the points when the page is loaded, or upon user request.

Important: See "Setting the Standard Interface" before you begin,  for to learn how to set Google API Key, Markets and Map Layout before 
beginning with Time Lapse Settings.

Setup of the Time Lapse Layout Settings

Each Interface can provide any additional settings that it requires. For the Timelapse Layout Map, the following options are provided.

 l Initial Delay (ms) – identifies to the Google API that it should hesitate a brief number of milliseconds before attempting to begin 
requesting for point information.

 l Retry Delay (ms)- identifies to the Google Map lookup that it will retry the Initial connection on a specific loop amount. This is only 
required if  the web site in question has performance issues with the general layout and production of map points.

 l Time lapse Delay (ms) – identifies that the this amount of time will transpire between points plotted in the time lapse. 

 l Automatically Begin Playback – identifies that the playback will begin without requiring the user to press “Play”.

 l Display Timer Info in Status Bar – identifies that the Status of the playback will display the content from the Timer Info value.

 l Use Timer Difference during Playback – when checked the playback will take the Time lapse delay and multiple that by the ratio 
of time between the physical Point Info Dates.

Configuring the Geo Locator Settings
The provided geo locator for the core map module utilizes the Google API for lookup and coding of the requested Address. This is used 
for any of the standard Interfaces or Sources, and provides the ability to get the longitude and latitude for each point. 



First make sure that you have setup the Data Source. The configuration of the Geo Locator is bound to the configuration of the source, 
because without a Geo Locator you cannot look up points that are missing the longitude and latitude. First setup the source and hit Save.

The Geo Locator allows you to provide the depth of the lookup based on the address information provided. With that said, however, the 
value physically stored in the Address column will be used when data is directly imported. This interface is used more specifically when 
you Add an Address from the Data page, or when you Geo Locate the Users for a User/Membership type of map.

 l Google API Key – if you are using a Google Map based interface, just use one of the keys you have already provided there. This  
key is used to obtain the point location from Google.

 l Include Country / Region / Postal Code / City / Street / Unit – when using the Add an Address interface, or when a User is 
looked up by address for you map, these setting identify the geographic information that is actually passed to the Geo Locator. For 
example, if  you only want one point per region, you would only pick Country and Region.

Press the Save link to save the Geo Locator settings.

Setting a User/Membership Map
Once you have established the Interface for you map, you can configure the Data Source. To setup a map that is to be used for a 
User/Membership scenario, you will be plotting points for the users in your DNN instance.

Setup the Point Description Format within the content you may use any of the following tokens: 

 l [ADDRESS] - the Address value of your point.

 l [DESCRIPTION] - the Description value of your point.

 l [SUMMARYCOUNT] - when more than one point has the same location, the Summary is incremented to show the total number of 
records at that location.

 l [TIMERINFO] - The Sequence Info, generally used for Timelapse display.

 l [TIMER] - The physical sequence value of your point

 l [LATITUDE] - The latitude of the point in degrees



 l [LONGITUDE] - The longitude of the point in degrees

 l [ICON] - the specified URL of the Icon for the point

 l [DISTANCE] - when populated, the Distance between your selected point and the record

Choose Users Online as the Data Source Settings.

 l Show Summary Count – When Checked, the description is not populated. Rather, the Summary Count is provided instead. This 
eliminates the Names of your users from the records and instead sums the number of users occurring within each point. When 
Unchecked the summary consists of the users names.

 l Execute User Import – Click this link to force the users to import who have not yet been imported. 

 l Execute Geo Coding – Click this link to force addresses to geo locate which have not yet attempt geo locating.

 l Delete All Points – Click this link to reset and clear the points used for this map source.

Setting Standard Data Points
Standard Data Points provides the simplest inclusion of your records into the Map. You may use the Data page to manipulate your rec-
ords, perform address lookup and use the Geo Coding service directly. This setting can also be used to handle external data sources. To 
do this, you must only push your data source records directly into the Map_Points table, setting the appropriate Source ID. The GUID col-
umn of this table provides an ability to link your external source with the specific points.

 l Execute Geo Coding – Click this link to force addresses to geo locate which have not yet attempt geo locating.

 l Delete All Points – Click this link to reset and clear the points used for this map source.

To manage or manipulate your map points, click on the Data icon in the Control Panel

Managing Map Data
Within the Map Points interface, Add, Remove and Edit your data points by picking them from the list below. Note: When no Latitude or 
Longitude are provided, Geo Coding is automatically performed based on your Geo Locator settings. Additionally, setting the Zoom iden-
tifies which levels on the map will display which points. Meaning - in Positional Mode - if you zoom down to a street level you can display 
points based on that Zoom level, which may be different when you zoom out to a regional level.

To begin Managing your data, click on the Data tab in the Control Panel.



 l New / Edit – create or edit an entry in your Map Points. Click on New to open the Editor with an empty set of attributes. Click on 
the Edit pencil to open the Editor with the current values.



 l Icon – the index of the icon to use from your map Markers.

 l Latitude – the latitude coordinate of the point. Set this value to an empty value to force geo coding on the next service 
pass.

 l Longitude – the longitude coordinate of the point. Set this value to an empty value to force geo coding on the next service 
pass.

 l Timer – the Sequence Number of the item. This is often used for identifying the sequence of points  when in a Time Lapse 
interface.

 l Timer Info – the Sequence Information to display when requested. This is often used for the points in a Time Lapse inter-
face.

 l Address – The address to be used for geo coding. If you are supplying a Longitude and Latitude with your content, you 
can place whatever content you desire in the address.

 l Description – the visual representation of the information for that point, not necessarily an address itself. This is an unlim-
ited length value and can contain HTML syntax.

 l Zoom – the Zoom level at which to start showing the point. Set this value to zero (o) to always show the point.

 l Zoom Hide – the Zoom level at which hides the point. Set this value to zero (0) to never hide the point.

 l Find Address – look for the Latitude and Longitude for an address by clicking on the Find Address link. This window will 
use the settings for the Geo Locator for the geo coding. If you specify that only Country and Region are used, for instance, 
then in the following Screenshot – only Washington will be sent to the Geo Locator (because country is not specified). 
When the Find Address lookup is initiated, the response will announce that the Address was not found, or the Edit window 
will pop open with the identified Latitude and Longitude.

Managing Map Data

Adding External Data Sources
Many users of the Map module will find the need to push data from existing sources into the Map Points table for displaying useful infor-
mation. This is very easy to do with the Map module, and provides not only the ability to display your data, but Geo Code the points and 
provide an easy way to link back to your source data. To accomplish this technique you must first understand the Map data structures.

First, when you create a Map Data Source, the configuration is stored in the Map_Sources table. The SourceID of the Map is used to asso-
ciate Map Points, contained in the Map_Points table, to the Map Source. First check the Map_Sources table to determine the SourceID of 
your Map Data. You can easily distinguish your source from either by the Name and Description columns in combination with your Portal 
ID.

For Example, assume you are in Portal 0 and the Data Source you created is called “Corporate Locations”:

--OBTAIN THE MAP SOURCE ID FOR THIS MAP DATA

Select 



    SourceID 

from 

    Map_Sources 

where 

    PortalID = 0 and 

    Name = 'Corporate Locations'

Assume for this example that the SourceID returned was 2

Next, take a look at the structure of the Map_Points table. Your external source will need to be inserted into this table for use. Here are 
the column requirements for the Map_Points table:

 l PointID: The Primary Key and identity of the Points, this column is automatically generated and cannot be manually assigned.

 l SourceID: he foreign key pointer to your Map_Sources table. This will need to be populated with the SourceID for your data.

 l GUID: dynamic column, set with an nvarchar(200) definition. This column is used to identify the unique id value of the external 
source. Place the primary key of your external source into this column so that future queries you create can bind directly to this 
table.

 l Address: The address of the point. This should be structured without use of line breaks as it is transmitted as written to the Geo 
Locator for identifying the Latitude and Longitude of the address.  However, if you are providing your own Latitude and Longitude, 
this may be whatever format you desire.

 l IconIndex: The Markers created in your Map Interface are bound to the points on the map via this value. Choose the Index of the 
Marker that should be used to place the point on the map.

 l Longitude: The physical longitude coordinate of the point. Leave this null if you need the Geo Locator to identify the location of 
this address.

 l Latitude: The physical latitude coordinate of the point. Leave this null if you need the Geo Locator to identify the location of this 
address.

 l Description: The descriptive value of the point. This is column may contain an unlimited amount of text, and is useful for providing 
any information you may want on the map point balloon.

 l SequenceNumber: If you are using a Time Lapse layout, the points are plotted in order by this column. Use this to identify the 
sequence of plotting of points. Remember that if you are using a Time Lapse and plotting points based on the difference in 
Sequence Numbers, a large gap in the sequence identifies a larger wait between plotting of points.

 l SequenceInfo: A brief descriptive field, useful for displaying the information about the current Sequence in the plotting of points. 
Typically only used with Time Lapse interfaces.

 l ZoomShow: The zoom level at which to start displaying the point (set to zero for always shown)

 l ZoomHide: The zoom level at which to stop displaying the point (set to zero for always shown)

 l SummaryCount: When a point on your map is used for representing more than one record. For example – two users at the same 
geographical location; two users in Canada. This number identifies the number of records contained within the single point.



 l ActionPlot / ActionClick / ActionOpen: Currently ignored, leave as empty string or null. This will be expanded in future map ver-
sion to provide differing functionality based on the click, plot or balloon opening of a map point.

 l FailedGeo: Identifies to the Geo Locator that it was unable to gain the coordinates of the map point due to a failure of the address 
itself. When 1, no further lookups will be attempted on the address record. You can manually force the geo locator to attempt the 
address again by clearing the coordinates in the Data interface, or by nullifying this flag in the database.

 l isUser: When the Users Online is in use, the isser flag identifies that the record pinpoints a specific User record, and assumes 
that the GUID refers to a UserID from the Users table. Leave this column null for your purposes.

Now that the table structure has been identified, continue with the following example. Assume the data provided in the screenshot is from 
our source:

Select 

* 

from 

ExternalDB..CorporateLocations

The source we are using has appropriate address information, but doesn’t contain any Latitude or Longitude. We can inject this data into 
Map_Points for SourceID 2 and then force the Geo Locator to lookup the addresses. Insert the records into Map_Points with a simple 
query:

INSERT INTO Map_Points

(SourceID,

GUID,

IconIndex,SequenceNumber,SequenceInfo,ZoomShow,ZoomHide,SummaryCount,

ActionPlot,ActionClick,ActionOpen,

Address,

Description)

Select

2,

CAST(RecordID as nvarchar(200)),

0,RecordID,'',0,0,1,

'','','',



--ADDRESS LINE

isnull(Street,'') + ' ' + isnull(City,'') + ' ' + isnull(State,'') + ' ' +     isnull(PostalCode,''),

--DESCRIPTION WITH HTML FORMATTING (BOLD LOCATION NAME AND LINE BREAKS FOR ADDRESS)

isnull('<b>' + Location + '</b><br>','') +

isnull(Street + '<br>','') +

isnull(City + ', ','') + isnull(State + ' ','') + isnull(PostalCode,'')

From ExternalDB..CorporateLocations

The result of this query has now pumped out data into the Map Points database. Finally, go back into the Map Control Panel. Click Data 
Source and then “Execute Geo Coding” to Geo Locate your addresses. Remember that depending on your Geo Locator, not all 
addresses will be Geo Located immediately. You may need to execute the Geo Coding link a number of times to completely Geo Code 
all your data. Refer to the FailedGeo column to identify addresses that do not work.

Finally, you can click on Data to review the results.

Adding External Data Sources

Adding Custom Queries
Custom Query sources provides the ability to select data for your points from external sources. The base requirement for this is the simple 
fact that your external source will provide its own Longitude and Latitude. Please refer to the Map_Points table which defines the require 
columns. Your external source query MUST result in the required data structure. Additionally, with Custom Query you may add any 
number of Query Variables to be consumed within the Query. This provides the ability to create a robust and interactive search mech-
anism or direct lookup and plotting of your records based on incoming parameters from your user.

To use an existing source for your data that will not be managed by the Map Points table, or to provide some extended functionality of the 
incoming forms and parameters for your pages (like custom filtering), you can create a Custom Query data source.

First – in the Data Sources page, select Custom Query. This can only be specified when the user is a Super User, otherwise, you cannot 
manipulate or gain access to the SQL interface.

Next, specify the Query. The only requirement of the query is that it return a table structure that contains all of the existing columns 
expected from the Map_Points table. You may include other columns, but the default columns are required specifically. Any incoming var-
iables you will need can be setup with the Query Editor region. It will use a standard String Replacement technique for using your var-
iables, so make sure that the Target of the variable and the value of your source are setup properly.

If you data source is external, you may use any ODBC or OleDB connection string to connect to that external source.



As provided in the above screen, a simple example of the use of the Custom Query functionality is presented. Two Query Variables were 
created that persist the Latitude and Longitude of the current Map view to display points relative to that area. 

 l Type: The following types of variables can be utilized:

 l Session: Values contained in the session. The Source consists of the key value f the session variable (Case Sensitive).

 l Querystring: Values contained in the incoming request URL. The Source consists of the key value from the query string 
parameter (Case Sensitive).

 l Form: Values contained in the incoming form request. The Source consists of the NAME value of the form element from 
the request. Be sure that NAME is the source of your element and not the ID value.

 l TabID / ModuleID / PortalID / UserID - parameters provided directly by DNN. Source is ignored for these attributes.

 l Latitude / Longitude - the coordinates on the interface that are currently the center of the map.



 l Target: The value that will be replaced within your query with the value bound to your Type/Source. The default use of this is via 
SQL-like syntax. For example: @Latitude.

 l Left / Right: If you variable source contains a value - the output of that value will be placed between the Left and Right values. 
E.g. Single quotes for non numeric values. When the value is empty, the left and right are not consumed.

 l Empty Value: When your source contains NO value, the output is provided via the Empty Value.

 l Security: This enforces the check for SQL Injection. It is recommended that this is always used. The end behavior of this is that all 
variables replace single quotes with escaped single quotes.

Marketplace
About the Marketplace Module
The Marketplace module enables users to search for DNN modules, extension and skins.

Module Version: 01.00.00



The Marketplace Module

Working with the Marketplace Module
How to search for products within the DNN Marketplace using the Marketplace module.



 1. At Search For, select from these options:

 l New Products: View the latest products

 l Popular Products: View the most popular products.

 l Reviews: View recent product reviews.

 2. At In Category, select either a DNN Version to view all results in that category, or select a sub-category of the required DNN ver-
sion to filter results further.

 3. Click the Go button. This displays a summary list for all matching products.



 4. Select from the following options to find out more on a product:

 l Click the Product Name - OR - the read more link for more product details

 l Click the Vendor Name to view all product by this vendor.



Media
About the Media Module 
The Media module (formerly known as the Image module) displays a single media file which can be an image, a movie or a sound file 
located on the portal or on an external web site. A large number of media types are supported including Flash, Windows media, Media 
AVI, MPEG, MP3, ASF, ASX, WMA, WMV, WAV, QuickTime and Real Video. Optional settings include linking an image to another 
resource such as another page, file, or Web site.

Module Version: 04.01.00

Minimum DNN Version: 04.06.02

Features: IPortable, ISearchable

The Media Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleMedia/tabid/846/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/42/scope/threads/Default.aspx

 l Issue Tracker: http://dnnmedia.codeplex.com/workitem/list/basic

Configuring The Media Module
When you first add the Media module to a page it displays the message "You haven't set-up any media for this module yet. It's easy to do. 
Just edit the Media Options."

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleMedia/tabid/846/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/42/scope/threads/Default.aspx
http://dnnmedia.codeplex.com/workitem/list/basic


This message will be removed once you select  Edit Media Options from the module actions menu and set the media for this module.

Module Editors
Displaying an Image with an optional Link
How to display an image in the Media module. The image can optionally be set to function as a button by adding a link.

 1. Select  Edit Media Options from the module actions menu - OR - Click the Edit Media Options  button.

 2. Expand the Specify Your Media section.

 a. At Media Type, select Standard File System.

 b. At File Location/Link Type select either a URL or File link to the image. See "Setting a URL Link", "Setting a File Link"., 
or "Uploading and Linking to a File"..



 3. Expand the Basic Settings section.

 a. Required. In the Alternate Text text box, enter the text to be displayed when a user places their mouse over the image.

 b. Optional. In the Width text box, enter a width in pixels to override the actual image size.

 c. Optional. In the Height text box, enter a height in pixels to override the actual image size.

 d. Optional. In the Description of the Media Editor, enter and format text to be displayed below this image.

 e. Optional. At Media Alignment, select either None, Left, Center or Right to set the alignment of the image. If no option is 
selected the default setting Use Module Settings Value is used.



 4. Optional. Complete the following steps to add a link to this image, or Skip to Step 5 for no link.

 a. Expand the Only Images Use the Following Settings section.

 b. At Link / Link Type, select URL, Page or File as the link type and then set the link. See "About the Link Control".

 a. Optional. At Track Number Of Times This Link Is Clicked?, check  the check box to display the number of times this 
link is clicked on this screen once the record has been updated. 

 b. Optional. At Open Link In New Browser Window?, check  the check box to display the media in a new Web browser 
- OR - Uncheck  the check box to display in the existing Web browser.

 5. Click the Update link.



An image displayed using the Media module

Displaying Video and Flash
How to display video or Flash using the Media module. The video displays controls that enables users to play, pause, rewind, volume 
and other controls is automatically displayed for the movie. Video file types include Flash files (swf), wmv, avi, etc. If the video or Flash is 
located on your portal, you may need the Host to enable you to upload some file types. 

 1. Select  Edit Media Options from the module actions menu - OR - Click the Edit Media Options  button.

 2. Expand the Specify Your Media section.

 a. At Media Type, select Standard File System.

 b. At File Location/Link Type select either a URL or File link to the movie. See "Setting a URL Link", "Setting a File Link"., 
or "Uploading and Linking to a File"..



 3. Expand the Basic Settings section.

 a. Required. In the Alternate Text text box, enter the text to be displayed when a user places their mouse over the image.

 b. Required. In the Width text box, enter a width in pixels to override the actual image size.

 c. Required. In the Height text box, enter a height in pixels to override the actual image size.

 d. Optional. In the Description of the Media Editor, enter and format text to be displayed below this movie.

 e. Optional. At Media Alignment, select either None, Left, Center or Right to set the alignment of the image. If no option is 
selected the default setting Use Module Settings Value is used.



 4. In the Only Videos and Flash Use the Following Settings section, set the following:

 a. At Auto-Start Videos, check  the check box to automatically start the video when the page loads - OR - Uncheck  
the check box to require the user to manually start the video.

 b. At Loop Videos, check  the check box to automatically loop the video when it ends - OR - Uncheck  the check box 
to  only play the video once. User can choose to replay videos which are not looped using the controls.



 5. Click the Update link.

A movie displayed in the Media module

Related Topics:

 l See "Managing Allowable File Extensions"



Displaying a Sound File 
How to display a sound file using the Media module. The Media module displays controls with play, pause, rewind, volume and other but-
tons enabling users to manage the sound. Sound file types include mp3, mwa, etc. Note: If the video or Flash is located on your portal, 
you may need the Host to enable you to upload some file types. 

 1. Select  Edit Media Options from the module actions menu - OR - Click the Edit Media Options  button.

 2. Expand the Specify Your Media section.

 a. At Media Type, select Standard File System.

 b. At File Location/Link Type select either a URL or File link to the sound file. See "Setting a URL Link", "Setting a File Link"., 
or "Uploading and Linking to a File"..

 3. Expand the Basic Settings section.

 a. Required. In the Alternate Text text box, enter text describing the sound. This text is not displayed but is a required field. 

 b. Optional. In the Width text box, enter a pixel width  to set the length of the control panel.

 c. Optional. In the Height text box, enter a height to set the height of the module body.

 d. Optional. In the Description of the Media Editor, enter and format text to be displayed below this image.

 e. Optional. At Media Alignment, select either None, Left, Center or Right to set the alignment of the image. If no option is 
selected the default setting Use Module Settings Value is used.

 4. Click the Update link.

Displaying a Sound File

Displaying Embedded Code
How to embed media from existing sites and social media outlets such as YouTube, Vimeo, or Twitter in the Media module. Note: The 
process by which you obtain embedded code with depend on the site, however it is typically as easy as copying and pasting the embed 
code from the site.

Bug: Once embedded code has been set on a module, you may be unable to edit it if the module action menu is hidden behind the 
video. A workaround solution is to switch your Control Panel to Layout mode, delete the module and then add and set-up a new Media 
module.

 1. Select  Edit Media Options from the module actions menu - OR - Click the Edit Media Options  button.

 2. Expand the Specify Your Media section.

 a. At Media Type, select Embed Code.

 b. In the Embed Code text box, enter or paste the code to be embedded.



 3. Expand the Basic Settings section.

 a. Required. In the Alternate Text text box, enter text describing the video, image, etc. This text is not displayed but is a 
required field.

 b. Optional. In the Description of the Media Editor, enter and format text to be displayed below this image.

 c. Optional. At Media Alignment, select either None, Left, Center or Right to set the alignment of the image. If no option is 
selected the default setting Use Module Settings Value is used.

 4. In the Only Videos and Flash Use the Following Settings section, review the message and then set the following:

 a. Optional. At Auto-Start Videos, check  the check box to automatically start the video when the page loads - OR - 
Uncheck  the check box to require the user to manually start the video.

 b. Optional. At Loop Videos, check  the check box to automatically loop the video when it ends - OR - Uncheck  the 
check box to  only play the video once. User can choose to replay videos which are not looped using the controls.

 5. Click the Update link.

Displaying Media using OEmbed Link
How to display media using an OEmbedded link from existing sites and social media outlets such as YouTube using the Media module. 
This method is widely supported and simply requires you to copy the page URL.

Bug: Once the media has been set on a module, you may be unable to edit it if the module action menu is hidden behind the video. A 
workaround solution is to switch your Control Panel to Layout mode, delete the module, and then add and set-up a new Media module.

 1. Select  Edit Media Options from the module actions menu - OR - Click the Edit Media Options  button.

 2. Expand the Specify Your Media section.

 a. At Media Type, select Website URL.

 b. In the Embedable URL text box, enter or paste the URL.

 c. Click the >>Validate URL link. This displays a message informing you if the URL you enter is supported or not. If the 
URL is not supported, you may instead be able to access and embed the code. See "Displaying Embedded Code"



 3. Expand the Basic Settings section.

 a. Required. In the Alternate Text text box, enter text describing the video, image, etc. This text is not displayed but is a 
required field. 

 b. Optional. In the Description of the Media Editor, enter and format text to be displayed below this image.

 c. Optional. At Media Alignment, select either None, Left, Center or Right to set the alignment of the image. If no option is 
selected the default setting Use Module Settings Value is used.

 4. In the Only Videos and Flash Use the Following Settings section, review the message and then set the following:

 a. Optional. At Auto-Start Videos, check  the check box to automatically start the video when the page loads - OR - 
Uncheck  the check box to require the user to manually start the video.

 b. Optional. At Loop Videos, check  the check box to automatically loop the video when it ends - OR - Uncheck  the 
check box to  only play the video once. User can choose to replay videos which are not looped using the controls.

 5. Click the Update link.

Editing Media Options 
How to edit the type and/or details of media set to display in the media module.

 1. Select  Edit Media Options from the module actions menu - OR - Click the Edit Media Options  button.

 2. Edit the required fields. 

 3. Click the Update link.

Troubleshooting: Restricted File Type Warning Message 
You may receive a Restricted File Type warning message when attempting to upload a file via the Link Control to a module. This mes-
sage is displayed when you attempt to upload a file with an extension that you are not enabled to upload such as a movie or a sound file. 
E.g: .avi, .wma. 

Contact your Host to request the file types you wish to upload are permitted.



The Restricted File Type warning message

Messaging
About the Messaging Module
The Messaging module enables registered users to send messages to and receive messages from the site administrator as well as other 
registered users. Users can view their messages from within their DNN portal without having to go to an external email provider (Gmail, 
Yahoo, Hotmail …)

User messaging is an alternative to the synchronous Send Mail option on the Newsletters module

Module Version: 06.00.01 

The Messaging Module

Module Editors
Viewing a Message
How to view a message sent to you using the Messaging module.

 1. Click the View link beside the message. This displays the message on the View Message page.



 2. Optional. Click the Cancel link to close the message - OR - Reply to the message. See "Replying to a Message"

Composing a Message
How to compose a new message using the Messaging module.

Tip: Users must have Edit Content (Edit Module) permissions to compose emails.

 1. Select the Compose New Message button located at the base of the Messaging module. This opens the Preview Message page.

 2. In the To text box, enter the user name of the message recipient.

 3. Click the Validate User link to validate the user name.

 4. In the Subject text box, enter the subject of this message.

 5. In the Message Editor, enter the body of this message.

 6. Click the Save Draft button to save a draft of this message to send later (See "Editing/Sending a Draft Message") - OR - Click the 
Send Message button to send the message now.



Composing a Message

Replying to a Message
How to view a message sent to you using the Messaging module.

 1. View the required message. See "Viewing a Message"

 2. Click the Reply button to reply to the message.



 3. In the Message editor, enter the reply message.

 4. Click the Save Draft button to save a draft of this message to send later  - OR - Click the Send Message button to send the mes-
sage now.



Replying to a Message

Editing/Sending a Draft Message
How to edit and/or send a draft message using the Messaging module.

 1. Click the Edit link beside the required message.



 2. Modify the message subject and/or message if required.

 3. Click the Save Draft button to save a draft of this message to send later  - OR - Click the Send Message button to send the mes-
sage now.

Sending a Draft Message

Deleting a Message
How to delete a draft message from the Messaging module.

 1. Click the Edit link beside the required message.



 2. Click the Delete Message link.

Deleting a Message

Settings
Setting Messaging Template Settings
How to create a custom template to be used for messages sent from this instance of the Messaging module.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.   

 2. Select the Messaging Settings tab. 

 3. In the Template text box, enter a custom template. Replacement tokens and HTML formatting are allowed.

 4. Click the  Update link.

Related Topics:

 l See "Replacement Tokens"

My Modules
About the My Modules Module
The My Modules module allows users to view a list of the each of the modules that have module editing rights for. This module is typically 
added to the default User Profile page as well as any custom User Profile page as created and set by Administrators. Only available 
in DotNetNuke Professional Edition

Module Version: 05.06.00

The following details are listed for each module: 

 l Page Name: Displays the name of the page where the module is located and links to the page.

 l Title: Displays the title given to the module and links to the module.

 l Type: Displays the type of module. E.g. Links Module

 l Actions: Displays the editing rights (permissions) granted to the user and links to the editing and/or setting pages which they are 
authorized to access.

The My Modules Module

News Feeds (RSS)
About the News Feeds (RSS) Module
The News Feeds (RSS) module displays a summary list of news feeds from one or more sources. A news feed is a dynamically gen-
erated list of news items. RSS is an acronym for Really Simple Syndication. Each news item typically includes a date/time stamp,  a 
linked title to read the news item in full, and a brief description. A selection of pre-defined layouts are included allowing you to display the 
news items in either a static list, as a single scrolling 'ticker' list, as a vertical scrolling list, or in a custom format.

Module Version: 04.02.01

Minimum DNN Version: 05.04.04



The News Feeds (RSS) Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleNewsFeeds/tabid/847/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/48/scope/threads/Default.aspx

 l Issue Tracker: http://dnnnewsfeeds.codeplex.com/workitem/list/basic

Module Editors
Adding News Feeds
How to add one or more syndicated news feeds to the News Feeds (RSS) module.

 1. Select  Edit Newsfeeds from the module actions menu - OR - Click the Edit Newsfeeds link. This opens the Edit News 
Feeds (RSS) page.

 2. Click the Add Feed link. This displays the input fields for adding a news feed.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleNewsFeeds/tabid/847/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/48/scope/threads/Default.aspx
http://dnnnewsfeeds.codeplex.com/workitem/list/basic


 3. In the Feed Url text box, enter the URL of the news feed. Skip to Step 7 to accept default setting. Note: Step 5 is required if you 
need to enter you account details to access this feed.

 4. Optional. In the Cache Time text box, enter the number of minutes between refreshes of this feed - OR - enter -1 to use the 
default setting as set by the feed provider. 

 5. Optional. If the news feed requires security information to authenticate your access to the news feed, complete the following 
fields: 

 a. In the User text box, enter the user account details supplied by the news feed provider. 

 b. In the Password text box, enter the password supplied by the news feed provider.

 6. Optional. At Feed Transformation, select from the following options of these from the drop-down box:

 l The dropdown below shows standard transformations and those stored in  directory Por-
tals/0/Newsfeeds/Transformations: Select a standard transformation type from these options:

 o Use Default Transformation: Select to use the default transformation. This is the default option.

 o ATOM 1.0 Transformation: Select for feeds using this transformation type.

 o RDF Transformation: Select for feeds using this transformation type.

 o RSS 0.91 Transformation: Select for feeds using this transformation type.

 o Internal Twitter Transformation: Select for a Twitter RSS feed.  This transforms tweets into correctly formatted links 
to tags and people.

 l Specify a url to an xsl file to use for preprocessing: Select this option to define a pre-processor for the feed. This allows 
you to make non-compliant feeds compliant using an XSL transformation (also called a pre-processor).

 o Set the link to the URL where the transformation (XSL) file is located ( "Setting a URL Link". ) - OR - Set the link to 
the internal file ( "Setting a File Link". ). Bug. A "failure to compile the XSL" error may be displayed. In this case,  use 
the URL option to point to the XSL  sheet. 

 l Specify a type that implements IPreProcessor to preprocess the feed: Select this option if you have a custom pre-
processor that implements the IPreProcessor interface. You will need a developer to create one.

 o In the text box, enter the name of your preprocessor. E.g. CustomPreprocessor



 7. Click the Update link. This displays the name of the newly added feed.



 8. Optional. Repeat Steps 2-7 to add additional feeds.

 9. Click the Return link to return to the module. 

The Newly Added News Feed

Tip: You can also add your own XSL transformations to  portals/[id]/Newsfeeds/Transformations/ and they will show in the  drop-down list.



Adding News Feeds from Syndicated Modules
How to add news feeds from syndicated modules on your web site using the News Feeds (RSS) module.

 1. Go to the syndicated module. 

 2. Select Syndicate  from the module actions menu - OR - Click the Syndicate  button.

 3. This displays the XML code for the module content in a new Web browser. Note: You may need to allow pop-ups to view the 
code.

 4. Copy the URL, which is displayed in the Address bar of the Web browser, to your clipboard.

 5. Go to a News Feed (RSS) module.

 6. Select Edit Newsfeeds from the module actions menu - OR - Click the Edit Newsfeeds link. 

 7. Click the Add Feed link.



 8. In the Feed Url text box, enter/paste the copied URL. 

 9. In the Cache Time text box, enter the number of minutes between refreshes of this feed - OR - enter -1 to use the default setting of 
the feed provider. 

 10. Click the Update link. This displays the name of the newly added feed. 

 11. Optional. Repeat Steps 7-10 to add additional feeds.

 12. Click the Cancel link to return to the module.

Related Topics:

 l See "Configuring Basic Page Settings for Modules"

Editing News Feeds
How to edit the news feeds displayed on the News Feeds (RSS) module.



 1. Select Edit Newsfeeds from the module actions menu - OR - Click the Edit Newsfeeds link. 

 2. Click the Edit  button beside the feed to be edited. 

 3. Edit the details as required. 

 4. Click the Update link. 

 5. Repeat Steps 2-4 to edit additional feeds. 

 6. Click the Update link.

Refreshing the Feed Cache
How to refresh cached news feed displayed using the News Feeds (RSS) module. 

 1. Select  Refresh Feed Cache from the module actions menu. This reloads these feeds from their source.

Refreshing the Feed Cache

Deleting News Feeds
How to delete one or more news feeds from the News Feeds (RSS) module.



 1. Select  Edit Newsfeeds from the module actions menu - OR - Click the Edit Newsfeeds link.

 2. Click the Edit  button beside the feed to be deleted.

 3. Click the Delete link at the base of the page. This displays the message "Do you really want to delete the selected RSS feed?"

 4. Click the OK button to confirm.

 5. Repeat Steps 2-4 to delete additional feeds.

 6. Click the Return link to return to the module.

Settings
Setting Default News Caching
How to set the default cache time for all news items within the News Feeds (RSS) module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the News Module Settings tab. 

 3. In the Default Cache Time text box, enter the default cache time for all news items. This setting is overridden by the cache time 
set for each news feed. The default setting is 30.



 4. Click the  Update link.

Configuring News Retry Settings
How to configure the retry settings for retrieving news feeds on the News Feeds (RSS) module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Select the News Module Settings tab. 

 3. In the Retry Times text box, enter the number of times the module should attempt to load a feed before waiting for a longer 
period. The default setting is 3. 

 4. In the Retry TimeOut text box, enter the number of minutes between retries. The default setting is 120. 

 5. Click the  Update link.

Setting News Layout
How to set the XSL Transformation file for a News Feeds (RSS) module. This XSL file defines the layout of news items in the module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the News Module Settings tab. 

 3. At Xsl Transformation, select a XSL transformation from these options:

 l Default.xsl [System]: News items display in a static list down the module.



 l Ticker.xsl [System]: News items display in a single line which repeatedly scrolls from left to right across the module. Item 
details are Date and Time, and Title.

 l Ticker2.xsl [System]: Suitable for feeds from Twitter. News items display in a static list down the module. Item details are 
Date and Time, Title and summary.



 l Twitter.xsl [System]: A ape layout where only the Title of each item is displayed, separated by a series of asterisk.

 l VScroll.xsl [System]: News items display in a list which repeatedly scrolls up from the base to the top of the module.



 l < Other >: Select this option to set a link to a custom XSL transformation. The link can be set to a URL ( See "Setting a 
URL Link" ); to a file on your site ( See "Setting a File Link" ); or  you can upload an .XSL file if you have the required per-
missions ( See "Uploading and Linking to a File" )

 4. Click the  Update link.

Setting News Layout



Setting the Number and Details of News Items 
How to set the number of news items as well as the details of each news item displayed on the News Feeds (RSS) module. Note: "Show 
Item Details" and "Show Item Date" are passed as parameters to the XSL sheet. If you are using a custom XSL sheet and wish to use 
these parameters you have to include them on the sheet. See the default sheets for an example.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the News Module Settings tab. 

 3. In the Items To Show text box, enter the number of news items to be displayed - OR - Enter -1 to use the number set by the news 
feed provider. 

 4. At Show Item Details, select from the following: 

 l Check  the check box to display a brief description of each item. The description is the beginning of the news item. 

 l Uncheck  the check box to hide the description.

 5. At Show Item Date, select from the following: 

 l Check  the check box to display the date and time for each item. 

 l Uncheck  the check box to hide the date and time.

 6. Click the  Update link.

Configuring Feed Retrieval Settings
How to configure the methods by which the News Feeds (RSS) module retrieves information from news sources. The two options pro-
vided are using Ajax, and/or Background Loading.  Ajax causes the module to render immediately without any content. The module then 
uses Ajax to load its contents directly once the complete page has loaded. This is useful if you find the module hampers page loading. 
Background loading uses the DNN Schedule to manage the frequency with which new data is retrieved. The Schedule runs inde-
pendently of the News Feed (RSS) modules, enabling the data to be retrieved at the optimum time, rather than when the module is being 
viewed, which can cause delays.

Tip: By default, Ajax is disabled and Background Download is enabled. These are the recommended settings.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Select the News Module Settings tab. 

 3. At Use Ajax, check  the check box to enable Ajax - OR - Uncheck  the check box to disable Ajax.

 4. At Background Download, check  the check box to enable - OR - Uncheck  the check box to disable.

 5. Click the  Update link.

Related Topics:

 l See "About the Schedule Page"

Newsletters
About the Newsletters Module
The Newsletters module allows you to send individual or bulk email messages (newsletters). The newsletter can be sent to the members 
of one or more security roles and/or to one or more email addresses. Messages are sent to each recipient separately to prevent recip-
ients from seeing each other's details. The module also identifies when a newsletter is set to send to an email address more than once 
and ensures only one copy of the newsletter is sent to that address. The message can be either plain text or HTML format. Files can be 
attached  and replacement tokens can be included.

Once a newsletter is sent, the sender receives the"Bulk Email Report for [Newsletter Subject]" message. See "The Bulk Email Report"

Permissions Tip: All users who are authorized to view the module can send emails. Unauthenticated users cannot attach files to mes-
sages and authenticated users require appropriate File Manager permissions to upload and/or select files.

Prerequisites: In order for the newsletter module to function correctly you must first:

 1. Ensure you have a valid email address on your user account. This will be the default email address for newsletters, however you 
can specify a different from address when required. See "Managing your User Credentials"

 2. Ensure your SMTP details are completed and messages can be sent. See "Setting the SMTP Server and Port"





The Newsletters Module

Sending a Basic Newsletter
How to send a newsletter without using replacement tokens or personalization using the Newsletters module.

 1. Navigate to Admin > Newsletters - OR - Go to a Newsletters module.

 2. On the Basic Settings tab and complete these fields:

 a. At Addressees complete one or both of these options: 

 i. At User Role(s), check  the check box beside each role which will receive the newsletter. Note: Users in mul-
tiple roles will only receive one copy of the newsletter.

 ii. In the Additional Emails text box, enter each of the email addresses to receive the newsletter separated by a 
semi-colon ( ; ). E.g. john.black@ecozany.com;julie.black@ecozany.com

 b. Optional. In the From text box, enter/modify the email address to be displayed in the From field of this newsletter. If you 
are logged in to the site, the email address associated with your user account is displayed here by default.

 c. Optional. In the Reply To text box, enter the reply to email address for the email.

 d. In the Subject text box, enter a subject title for the email.

 3. Select the Message tab and enter the body of the newsletter into the Editor. (Select Basic Text Boxto send a plain text email - 
OR - Select Rich Text Editor to send an HTML email with formatting and images). 

 4. Optional. Click the Preview Email link located at the base of the module if you wish to preview the newsletter before sending it.



 5. Select the Advanced Settings tab and then set these required settings:

 a. At Replace Tokens?, uncheck  the check box.

 b. At Send Method, select BCC: One Email To Blind Distribution List ( Not Personalized ).



 6. Set any of these Optional Advanced Settings:

 a. At Attachment, select the required attachment (See "Setting a File Link" ), or See "Uploading and Linking to a File".

 b. At Priority, select the priority of the email (High, Normal, or Low) from the drop-down box. The default setting is Normal.

 c. At Send Action, select from the following options: 

 l Synchronous: Emails are all sent before your page refreshes. This method is suitable for small mail outs of 
approximately 100 or less.

 l Asynchronous: This starts a separate thread (user process) to send emails. This method is suitable for large 
mail outs of approximately 100 or more. This is the default option.

 7. Click the Send Email link. This displays either a Successful or Not Successful message. For Synchronous send action, the mes-
sage doesn't display until after all emails have been sent. For Asynchronous send action, the message displays once the send 
action has successfully commenced.



The Newsletter in the recipients mailbox

Sending a Personalized Newsletter without Tokens
How to send a personalized newsletter without using replacement tokens using the Newsletter module. This option adds a greeting 
before the message. The greeting for registered users includes their first and last name. E.g. Dear  Julie Black. The greeting for other 
recipients (those entered in the Additional Emails field), are addressed to their email address. E.g. Dear JulieBlack@domain.com.

 1. Navigate to Admin > Newsletters - OR - Go to a Newsletters module.

 2. Select the Basic Settings tab and complete the basic settings as required. See "Sending a Basic Newsletter"

 3. Select the Message tab and enter the body of the newsletter into the Editor. (Select Basic Text Box to send a plain text email - 
OR - Select Rich Text Editor to send an HTML email with formatting and images).



 4. Select the Advanced Settings tab and then set these required settings:

 a. At Replace Tokens?, uncheck  the check box. 

 b. At Send Method, select To: One Message Per Email Address ( Personalized ).

 5. To set any of the optional Advanced Settings, See "Sending a Basic Newsletter"

 6. Click the Send Email link. This displays either a Successful or Not Successful message. For Synchronous send action, the 
message doesn't display until after all emails have been sent. For Asynchronous send action, the message displays once the 
send action has successfully commenced.

Sending a Newsletter with Tokens
How to send a newsletter that includes replacement tokens using the Newsletters module. Using replacement tokens in your messages 
enables you include relevant and up-to-date information in your messages. For example, you can display the recipient's name in the sal-
utation, or include information such as the site name or description in the body of your message. By using replacement tokens instead of 
static content, you can be sure that details which may change, such as the portal administrators email address are always current.

Tip: If your message includes [TOKENS] you must check the Replace Tokens? check box and set the Send Method field to TO: One 
Message Per Email Address ( Personalized ).

 1. Navigate to Admin > Newsletters - OR - Go to a Newsletters module.

 2. On the Basic Settings tab and complete the basic settings as required. See "Sending a Basic Newsletter"

 3. Select the Message tab and complete the following:

 a. Select Basic Text Box to send a plain text email - OR - Select Rich Text Editor to send an HTML email with formatting 
and images.

 b. Enter the body of the newsletter including replacement tokens into the Editor. E.g. [User:FirstName] [User:LastName]. 
See "Replacement Tokens"



 4. Select the Advanced Settings tab and then set these required settings:

 a. At Replace Tokens?, check  the check box. 

 b. At Send Method, select To: One Message Per Email Address ( Personalized ). 



 5. To set any of the optional Advanced Settings, See "Sending a Basic Newsletter"

 6. Click the Send Email link. This displays either a Successful or Not Successful message. For Synchronous send action, the 
message doesn't display until after all emails have been sent. For Asynchronous send action, the message displays once the 
send action has successfully commenced.

The Received Message. Note the recipients first and last name are included

Sending a Newsletter to a Relay Service
How to send a newsletter via SMS ("Short Message Service" commonly known as phone texting), IM (instant messaging), fax or other 
non-email service using a relay service.

 1. Navigate to Admin > Newsletters - OR - Go to a Newsletters module.

 2. On the Basic Settings tab, complete the basic settings as required. See "Sending a Basic Newsletter"



 3. Select the Message tab and enter the body of the newsletter into the Editor. (Select Basic Text Box to send a plain text email - 
OR - Select Rich Text Editor to send an HTML email with formatting and images).

 4. Select the Advanced Settings tab and then set these required settings:

 a. At Send Method, select Relay: One Message Per Email Address ( Personalized ) to a specified relay server. 

 b. At Relay Address, enter the address of the relay service. 

 5. Complete the additional Advanced Settings as required. See "Sending a Basic Newsletter"

 6. Click the Send Email link. A Successful or Not Successful message is now displayed. For Synchronous send action, the mes-
sage doesn't display until after all emails have been sent. For Asynchronous send action, the message displays once the send 
action has successfully commenced.

Sending Newsletters in a User's Preferred Language
How to send a newsletter to user's in their preferred language using the Newsletter module. Multiple languages must be installed and 
enabled on this portal to display the Language Filter field. 

Important.When you select a Language Filter, only users associated with that language will receive a newsletter. E.g. If you select Eng-
lish (United States) as the language filter, then only users who have selected English (United States) as their Preferred Locale in their pro-
file will receive the newsletter. Users who have selected English (Australia) will not receive a newsletter. If a user has not set a preferred 
language, they will only receive newsletters sent to the default site language.

 1. Navigate to Admin > Newsletters - OR - Go to a Newsletters module.

 2. On the Basic Settings tab, complete all fields. See other tutorials in this section for full details. 

 3. At Language Filter, check  the check box beside the language(s) to receive this newsletter. If no language is selected then no 
filter is applied and all users will receive this newsletter.



 4. Select the Message tab, enter the body of the newsletter into the editor in the language selected at Step 3. See "Sending a 
Basic Newsletter"

 5. Select the Advanced Settings tab and then set these required settings:

 a. At Replace Tokens?, uncheck  the check box. 

 b. At Send Method, select To: One Message Per Email Address ( Personalized ).



 6. To set any of the optional Advanced Settings, See "Sending a Basic Newsletter"

 7. Click the Send Email link. This displays either a Successful or Not Successful message. For Synchronous send action, the 
message doesn't display until after all emails have been sent. For Asynchronous send action, the message displays once the 
send action has successfully commenced.

 8. Repeat Steps 3-7 to send the newsletter in other languages.

The Bulk Email Report
When a bulk email is sent using the Newsletters module, the email address displayed in the From field of the Newsletters module will 
receive the "Bulk Email Report for [Newsletter Subject]" message which contains the following details:

 n The date and time when the bulk email operation commenced 

 n Number of Email Recipients 

 n Number of Email Messages 

 n The date and time when the bulk email operation was completed

 n Status Report listing any errors which occurred

 n List of Recipients



The Bulk Email Report

Pages (Tabs)
About the Pages (Tabs) module
The Pages module (also referred to as the Tabs module) enables authorized users to create and manage pages.  This module is located 
under Admin > Pages on the Control Panel and can be added to site pages. This module has additional page management tools than 
the Pages section of the Control Panel, including the ability to modify page hierarchy and add multiple pages at one time.

Version: 01.00.00. Note: The version number for this module does not update as it is part of the DNN framework.

Permissions. Only Page Editors  and Administrators can access pages where the Pages module is located.

Users must be granted Edit Page permission in DNN Community Edition, or Add Content permissions in DNN Professional Edition, to the 
page where the Pages module is located to access the module. This permission enables these users to manage any pages which they 
are Page Editors for.



The Pages Module as viewed by Admin

Page Editors
Viewing any Page (Pages Module)
How to view any page on your site including pages which aren't displayed in the site menu using the Pages module.

Permissions. In addition to the permissions required for the Pages module, you must have View Pages permissions granted to view a 
page.

 1. In the left-hand navigation tree, right-click on the page name and then select View Page from the drop-down menu.



Editing Page Settings using the Pages Module
How to view and or edit a selection of page settings for any page  using the Pages module.

Permissions. In addition to the required permissions for the Pages module, users must also have Edit Page (Manage Settings for 
DNN Professional Edition) permissions to the required page.

 1. In the left-hand navigation tree, click on a required page name. This displays the settings for this page to the right.

 2. Go to the Common section and enter/edit any of the following settings:

 a. In the Page Name text box, enter a name for the page. If this page is displayed in the menu, this will be the name in the 
menu.

 b. In the Page Title text box, enter a short, descriptive sentence summarizing the page content. The title is used by search 
engines to identify the information contained on the page. It is recommended that the title contains at least 5 highly 
descriptive words and does not exceed 200 characters. 



 c. At Include In Menu?, check  the check box to include this page in the menu- OR - Uncheck  the check box to hide 
the page.

 d. At Disabled, select from these options:

 l Check  the check box if the page name is not a link. I.e. When you click on the page name in the menu noth-
ing happens. This option is typically selected for a parent page to provide a way for users to navigate to its 
child pages.

 l Uncheck  the check box for this page name to be a link to the page. This is the default option. 

 e. At Secure? check  the check box to force this page to use a secure connection or secure socket layer (SSL). This 
option requires the Administrator to configure the SSL Settings on the Admin > Site Settings page.

 3. Expand  the Permissions section to update permissions. Note: This section is only visible to Administrators and SuperUsers. 
See "Setting Page Permissions"



 4. Expand the Modules section to view a list of all modules on this page.

 l Click the Delete  button to delete the related module.

 l Click the Edit  button to go to the Module Settings page for the related module.

 5. Expand  the SEO section and enter/edit any of the following settings:

 a. In the Sitemap Priority text box, enter a number between 0.1- 1.0 that is used to determine the SEO Sitemap priority.

 b. In the Page Description text box, enter a description of the page content. The description is used by search engines to 
identify the information contained on the page. It is recommended that the description contains at least 5 words and 
does not exceed 1000 characters. 

 c. In the Page Keywords text box, enter key words for this page separated by comma.

 d. In the Page Tags text box, select one or more tags associated with this page. Page tagging is a way of categorizing con-
tent for more meaningful search results.



 6. Expand  the Metatags section and enter/edit any of the following settings:

 a. In the Refresh Internal (seconds) text box, enter the interval to wait between automatic page refreshes. (E.g. Enter "60" 
for 1 minute or 60 seconds.) Leave field blank to disable. 

 b. In the Page Header Tags text box, enter any tags that should be rendered in the "HEAD" tag of the HTML for this page.



 7. Expand  the Appearance section and edit/set any of these optional settings:

 a. At Page Skin, select a skin from the drop down list or select                     [Default Skin] to use the default skin set for the site. See 
"Setting the Default Portal Skin and Container"

 b. At Default Container, select a container from the drop down list or select                     [Default Container] to use the default con-
tainer set for the site. See "Setting the Portal Container"

 c. At Large Icon,  select an image to be used as the Large Icon for any Console module relating to this page. Select the 
location of the required icon from these options:

 l File (A File On Your Site ), select to choose any imageSee "Uploading and Linking to a File"

 i. Set the link to an existing file ( See "Setting a File Link",or a new file ( "Uploading and Linking to a 
File".). Note: You can remove the icon from this and the following field by selecting < None Specified 
> as the File Name when setting a file link.

 l System Image: Select to choose an icon which is part of your DNN application. This displays a list of available 
images.

 i. Select the required image.

 d. At Small Icon, using the same steps as for the above field, select the image to be displayed beside the page name in 
the menu. This image is also used as the Small Icon for any Console module relating to this page.



 8. Expand  the Link section and edit/set any of these optional settings:

 a. At Link URL, to set this page to be a navigation link to another resource (rather than displaying the page itself), select 
or add the link here. "About the Link Control".

 b. At Permanently Redirect?, check  the check box to notify the web browser that this page should be considered as 
permanently moved. This enables Search Engines to modify their URL's to directly link to the resource. Note: This set-
ting is ignored if the Link Type is set to None.



 9. Click the  Update Page link.

Editing Page Settings via the Pages Module
How to edit the settings of any page including pages that are not included in the site menu using the Pages module.

Permissions. In addition to the required permissions for the Pages module, users must also have Edit Page (Manage Settings for 
DNN Professional Edition) permissions to the required page.

 1. In the left-hand navigation tree, right-click on a page name and then select Page Settings from the drop-down menu.



 2. Edit page settings as required. 

 3. Click the  Update link. You are now returned to the Pages module.

Deleting a Page (Pages Module)
How to delete a page including any child pages using the Pages module.  Deleted pages are stored in the Recycle Bin where they can 
be restored or permanently deleted. See "About the Recycle Bin Module"

Note: A page defined as Home,  Splash, Login, User Registration, Profile page, or the last visible site page cannot be deleted. You are 
also unable to delete the Admin and Host Pages.

Permissions. In addition to the required permissions for the Pages module, users must also have Edit Page (Delete for 
DNN Professional Edition) to the page they want to delete.

 1. In the left-hand navigation tree, right-click on the required page and then select Delete Page from the drop-down menu.

 2. This displays the  message "This will delete the selected page and all its child pages. Are you sure?"

 3. Click the OK button to confirm.

Hiding/Showing a Page in Site Navigation
How to hide or show a page to in the site menu using the Pages module. This settings updates the "Include In Menu?" check box under 
the settings for this page.

 1. In the left-hand navigation tree, right-click on the required page and then select either Hide From Navigation or Show In Navi-
gation from the drop-down menu.



Tip: Hidden pages display the Hidden  icon in the Pages module for quick reference. However, if the page is also disabled, then the 
Disabled  icon will displayed instead.



Enabling/Disabling Page Link (Pages Module)
How to prevent or allow a page to function as a link in the site menu using the Pages module. This settings updates the "Disabled?" 
check box  under the settings for this page.

Permissions. In addition to the required permissions for the Pages module, users must also have Edit Page (Manage Settings for 
DNN Professional Edition) to the page.

 1. In the left-hand navigation tree, right-click on the required page and then select either Disable Link In Navigation or Enable 
Link In Navigation from the drop-down menu.



Tip: Disabled pages display the Disabled  icon in the Pages module for quick reference.



Administrators
Adding One or More Pages (Pages Module)
How to add one or more new pages to a site using the Pages module.

 1. In the left-hand navigation tree, right-click on a page name and then select Add Page(s) from the drop-down menu.



 2. In the Pages multi-line text box, enter each page name on a separate line. If you wish to create a page hierarchy, simply add 
one right chevron characters ( > ) for each child level.

 3. Click the Create Page(s) link.



 4. The new pages are now added to the site menu, the Pages module navigation tree.



Moving Page Position in Menu
How to move a page to a new position in the site menu using the Pages module.

Permissions. In addition to the required permissions for the Pages module, users must also have Edit Page (Manage Settings for 
DNN Professional Edition) permissions to the required page.

 1. Click on the name of the page to be moved and drag to the required location.

 l To move a page into a parent position, drag the page below the page to be displayed to the right of this parent in the 
menu and the drop the page onto the dotted line.



 l To move a page into a child position, drop the page on top of parent page.

Reports
About the Reports Module
The Reports module displays the results of an SQL query to the database of the portal. The report is displayed as a series of records. The 
Reports Module is designed to query a tabular data store (such as a Relational Database like Microsoft SQL Server) and visualize the 
results. Only the Host is able to create reports. Page Editors are able to configure a range of setting that control the way reports are dis-
played in the module.

Module Version: 05.01.00

Minimum DNN Version: 05.00.01



The Reports Module

Tip: The Reports module is not designed for viewing data from hierarchical sources such as XML, and we recommend you use the XML 
module if you wish to process XML data.

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleReports/tabid/970/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/136/scope/threads/Default.aspx

 l Issue Tracker: http://dnnreports.codeplex.com/workitem/list/basic

Settings
About the Data Source Settings Warning Message 
The following Red Warning Message is displayed to Page Editors and Administrators on the Reports Settings - Data Source Settings sec-
tion on the Module Settings page of the Reports module:  For security and privacy reasons, only Host Users (SuperUsers) are per-
mitted to edit these settings.

This message informs users that only SuperUsers are able to edit the Data Source Settings of the Reports module.

Security warning message

Configuring Display and Caching Settings 
How to configure the Display and Caching Settings on the Reports module. Note: The Data Source Settings for this module must first be 
configured by the Host to display any data.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleReports/tabid/970/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/136/scope/threads/Default.aspx
http://dnnreports.codeplex.com/workitem/list/basic


 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Report Settings tab. 

 3. Go to the Display and Caching Settings section. 

 4. At Caching, select from the following options: 

 l Check  the check box to enable data caching. If checked you can enter the amount of time to cache the data for, in 

minutes. Note: the following warning will also be displayed:  Warning! Enabling Caching when using parameters is 
a security and privacy risk. See the Reports Module documentation for details 

 l Uncheck  the check box to disable data caching.

 5. At Show Info Pane, select from the following options: 

 l Check  the check box to display the Info Pane on the view page for the module. The Info Pane displays the title and 
description of the Report for users. 

 l Uncheck  the check box to hide the Info pane.

 6. At Show Controls, select from the following options: 

 l Check  the check box to display the Run Report and Hide Report Result links on the module. 

 l Uncheck  the check to hide the Run Report and Hide Report Result links on the module.

 7. At Auto Run Report, select from the following options: 

 l Check  the check box to automatically run the report when a user views the page. Note: By default, a report is auto-
matically run when a user views the module. However, many reports can be time-consuming and resource-intensive. In 
this case, the Auto Run Report setting can be displayed. However, in order to allow users to run the report the Show 
Controls setting must be enabled. Note: The module does not, in the current version, automatically enable this setting. 

 l Uncheck  the check box to manually run a report.

 8. At Active Visualizer, select one of the available visualizers. By default, there are three visualizers supplied with the Reports 
module - the Grid Visualizer, the HTML Template Visualizer and the XSL Transformation Visualizer. The default option 
of Grid Visualizer does not require any files to be uploaded, unlike the other two options. Once you have selected a Visualizer, a 
number of additional settings specific to the selected option are displayed. For more details see        "Configuring the Chart Vis-
ualizer Settings"., "Configuring the Grid Visualizer Settings"., "Configuring the HTML Template Visualizer Settings"., "Configuring 
the XSL Transformation Visualizer Settings". and "Configuring the Microsoft Report Viewer Visualizer Settings".



 9. Click the  Update link.

Configuring the Chart Visualizer Settings
The Chart Visualizer option on the Active Visualizer displays a simple horizontal bar or vertical column chart from the data retrieved by 
your query. Note: The Chart Visualizer is not included with the Report module; however it can be installed and configured by your Host.



The Chart Visualizer

Here's how to set the Chart Visualizer settings on the Active Visualizer:

 1. At Active Visualizer, select Chart Visualizer. The following additional setting are displayed: 

 2. At Chart Type, select the type of chart that will be rendered from these options: 

 l Select Horizontal Bar Chart to choose a Bar Chart with bars stretching from left to right. 

 l Select Vertical Column Chart to choose a Bar Chart with bars stretching from bottom to top. Note: Tthe X-Axis Title and 
Y-Axis Title settings still refer to the Horizontal and Vertical axes (respectively), no matter what value this setting has.

 3. In the Width text box, enter the width of the produced chart in pixels. E.g. 500 

 4. In the Height text box, enter the width of the produced chart in pixels. E.g. 500 

 5. In the X-Axis Title text box, enter the title to be displayed along the X-Axis (Horizontal) of the chart. 

 6. In the Y-Axis Title text box, enter the title to be displayed along the Y-Axis (Vertical) of the chart. 



 7. In the Bar Name Column text box, enter the name of the column in the produced dataset that will be used as the name of each 
bar in the chart. 

 8. In the Bar Value Column text box, enter the name of the column in the produced dataset that will be used to determine the 
height of each bar in the chart 

 9. At Bar Color Mode, select way in which the color of each bar will be determined from these options: 

 l Select One Color for every Bar to set every bar as same color. 

 1. In the Bar Color text box, enter the color to use for the bars in the chart

 l Select One Color per Bar to set the color of each bar as given by a column in the dataset. 

 1. In the Bar Color Column text box, enter the name of the column containing the color for each bar in 
the chart.

 10. Click the Update link.

Tip: In its current version, the Chart Visualizer is limited to displaying this form of Bar Chart.  It is limited to displaying the value of one col-
umn as the height of the bar. The Chart Visualizer is not installed by default. After installing the module, the installation packages can be 
found in the DesktopModules/Reports/Install/Visualizers folder. See the section on installing the Chart Visualizer for details. See Man-
aging Reports Module Add-Ins for information on installing Visualizers and Data Sources.

Configuring the Grid Visualizer Settings
The Grid Visualizer displays data in a tabular grid. This setting supports paging and sorting of data and includes display options that con-
trol the appearance of grid lines as well as finer grained control over the appearance of the grid, through attaching CSS Classes and 
CSS Attributes to the entire grid.

Here's how to set the Grid Visualizer settings on the Active Visualizer:



 1. At Active Visualizer, select Grid Visualizer. The following additional setting are displayed: 

 2. At Enable Paging?, check  the check box to enable paging on the grid, or uncheck  to disable paging and display all data 
on one page. 

 l In the Page Size text box, enter the number of rows to be displayed on each page of data.

 3. At Enable Sorting?, check   the check box to enable users to sort data by clicking on a column header to sort by that column, 
or uncheck  to disable sorting. If Show Header? is not checked, this setting has no effect. 

 4. At Show Header?, check  the check box to display of column headers on the Grid, or uncheck  the check box to hide head-
ers. 

 5. At Grid Lines, select an option to control the appearance of grid lines on reports. Select from the following options: 

 l Both: Select to display both horizontal and vertical lines. 

 l Horizontal: Select to display horizontal lines only. 

 l None: Select to hide all lines. 

 l Vertical: Select to display vertical lines only.

 6. In the Additional CSS text box, enter any additional CSS attributes to be placed in the 'style' attribute of the < table > element 
produced by this visualizer. 

 7. In the CSS Class text box, enter a list (separated by single spaces) of CSS classes to apply to the < table > element produced 
by this visualizer. For more details see CSS Formatting below. 

 8. Click the Update link.

Configuring the HTML Template Visualizer Settings
The HTML Template Visualizer uses an HTML Template file to display the data retrieved in the report. The template file is processed 
once for each row and then rendered as a list. Each Template is processed by locating tokens of the form [Column Name] in the Tem-
plate and replacing them with the value of Column Name in the returned dataset. The HTML Template Visualizer automatically proc-
esses every row retrieved from the data source. If you wish to display just one row, or a smaller set of rows, you must change the Data 
Source to have it return only the rows you need.

Here's how to configure the HTML Template Visualizer settings on the Active Visualizer:



 1. At Active Visualizer, select HTML Template Visualizer. This displays the Template File fields. 

 2. At Template File, specify the HTML template file to use to generate the display. Failure to set this option to a file may result in an 
error. 

 a. At File Location, select the folder where the file is located. The file must have previously been uploaded to the portal's 
File Manager. Alternatively, if you have access to upload files, select the name of a folder you have access to upload 
files to. 

 b. At File Name, select the name of the html file - OR - Click the Upload New File link and upload the new file.

 3. Click the Update link.

E.g. The following HTML Template was used to produce the output seen below.

Module #[ModuleID]

Title: [ModuleTitle]

Example of HTML Template

Configuring the XSL Transformation Visualizer Settings
The XSL Transformation Visualizer uses an XSL Transformation file and XML produced by the Data Source to produce HTML that is 
used to display the report.



The XML produced by the Data Source has the following format:

<DocumentElement>

<QueryResults>
<Column1Name>Column1Value</Column1Name>
<Column2Name>Column2Value</Column2Name>
...
</QueryResults>
<QueryResults>
... Same as above, for Row 2 ...
</QueryResults>

To ensure the correctness of your XSL, you can use the Show Xml Source command to check the exact XML returned by your Data 
Source configuration.

For example, to reproduce the results displayed in the "Configuring the XSL Transformation Visualizer Settings on the Active Visualizer" 
tutorial, the following XSL would be used:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:output method="xml" indent="yes"
doctype-system="http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"
doctype-public="-//W3C//DTD XHTML 1.0 Transitional//EN" />
<xsl":template match="/DocumentElement/QueryResults">
<h1>Module =<xsl:value-of select="ModuleID" /></h1>
<p>Title: <xsl:value-of select="ModuleTitle" /></p>
</xsl:template>
</xsl:stylesheet>

Similar to the HTML Template Visualizer, all of the data retrieved from the Data Source will be displayed in this Visualizer. If you wish to 
restrict the amount of data displayed, you must modify your Data Source configuration.

Here's how to configure the XSL Transformation Visualizer settings on the Active Visualizer of the Reports module:

 1. At Active Visualizer, select XSL Transformation Visualizer.                    

 2. At Transform File, select the XSLT file to use to generate the display. Failure to set this option to a file may result in an error. 

 3. At Link Type, select the link to the transform file. "About the Link Control".



 4. Click the Update link.

Configuring the Microsoft Report Viewer Visualizer Settings
The Microsoft ReportViewer Visualizer uses the ReportViewer control to display rich reports, as well as reports running on a SQL Server 
Reporting Services instance. Note: The Microsoft Report Viewer Visualizer is not included with the Report module, however it can be 
installed and configured by your Host.

Important: This Visualizer DOES NOT require a license to Microsoft SQL Server or Microsoft SQL Server Reporting Services. All you 
need is this module and DNN.

The ReportViewer Visualizer has two modes: Local Report Mode and Server Report Mode.

About Local Report Mode: In Local Report Mode, the Report is run by the Reports Module on your web server. Using the Report 
Designer Add-In for Microsoft Visual Web Developer Express (Both Free Downloads) or Visual Studio 2005 or 2008, you can design a 
report and save it as an RDLC file. After creating an RDLC file for your report, upload it to your portal and select that file from the Reports-
Viewer Visualizer settings page. Then, enter the name of the DataSource used in the RDLC report into the Data Source Name field. The 
Reports Module will provide the data from the Data Source to the RDLC report through this Data Source.

About Server Report Mode: In Server Report Mode, the Report is run by an instance of Microsoft SQL Server Reporting Services 
(SSRS). In order to use this mode, you will need an instance of SSRS and must know the user name and password of an account with 
permission to access the server. Specify the URL of the server and the path, within the server, to the Report you wish to display. If authen-
tication is required, specify the User Name, Password, and Domain of a user account with permission to access the server.

Here's how to set the Grid Visualizer settings on the Active Visualizer:

 1. At Active Visualizer, select Grid Visualizer. This displays the following additional settings. 

 2. In the Height text box, enter the height of the ReportViewer control used to display the report in pixels. 

 3. At Show, this field indicates which toolbars, buttons, and other controls to display on the ReportViewer control. 

 4. At Report Type, this field indicates if the ReportViewer should operate in Local Report or Server Report mode. Depending on 
your choice for the Report Type setting, the module will enter one of these modes. 

 5. At Local Report Mode, the following settings are available in Local Report Mode: 

 a. Data Source Name: The name of the data source, defined in the RDLC file, to populate with data from the Reports Mod-
ule Data Source. 

 b. Report File: The location of the RDLC file defining the Report to display. 

 c. Enable External Images: Check this check box to allow the visualizer to load images from other sites referenced by the 
Report. 

 d. Enable Hyperlinks: Check this check box to allow the visualizer to display hyperlinks defined in the Report.

 6. At Server Report Mode, the following settings are available in Server Report Mode: 

 a. Server Url: A URL referring to the Web Service interface to an SSRS instance. 

 b. Server Report Path: The path, within the SSRS server, to the Report you wish to display. 

 c. User Name: The user name to use when authenticating to the SSRS server. 



 d. Password: The password to use when authenticating to the SSRS server. 

 e. Domain: The Active Directory domain to use when authenticating to the SSRS server.

 7. Click the Update link.

Special Note Regarding Caching 
When caching is enabled, a single copy of the data retrieved by the Data Source is stored in-memory so that future requests for the same 
report can use the cached data rather than re-executing the Data Source. However, since this cached copy is always used to satisfy 
requests, any parameters you have used in your queries will be disregarded. Therefore, when using caching, parameterized queries are 
not allowed. If you use parameters in your query and enable caching, you will see an error message similar to the following when trying 
to run the report: "There was an error while executing the configured data source: There is an error in your SQL at line 1: Must declare the 
scalar variable "@ParameterName""

An Error Report

Repository
About the Repository Module
The Repository module stores and displays a range of items. The type of items stored is controlled through the skin which is applied to 
the module. By changing the skin, the Repository can be used for numerous purposes such as a simple blog, a media repository, a file 
repository, an articles repository, a compact file listing, and more. The module is packaged with a range of module skins, see the  Skin 
Designs section below for an overview of each skin.

Important Upgrade Note. If you have modified any of the standard templates that are part of the Repository package, be sure to back 
them up before installing this new release, then restore them after the release has been installed. Alternatively, you can copy them to the 
/Portals/n/RepositoryTemplates folder which is the preferred location where modified templates should be stored.

Module Version: 03.05.04

Minimum DNN Version: 05.03.01

Features: ISearchable

Optional settings (not available on all skin designs):  

 l Category management

 l Item ratings

 l Item comments



The Repository Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleRepository/tabid/830/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/54/scope/threads/Default.aspx

 l Issue Tracker: http://dnnrepository.codeplex.com/workitem/list/basic

All Users
Searching for an Item
How to search for an item in the Repository module. The search will return results from the Item Title, Description, Author Name, and 
Email Address fields. Results include words/numbers that are all or part your search criteria. E.g. Entering "gum tree" will return results for 
gum, gum tree, trees, tree, etc.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleRepository/tabid/830/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/54/scope/threads/Default.aspx
http://dnnrepository.codeplex.com/workitem/list/basic


 1. At Categories, select the category to search within - OR - (if available) Select All Items to search all categories.

 2. In the Search text box, enter your search criteria. E.g. gum trees 

 3. Click the GO  button.

Searching Repository Items

Filtering Items by Category
How to filter items by category on the Repository module. Note: The Categories filter is not available on some Repository skins.

 1. At Categories, select the required category. 

 2. Optional. At Sort By, select the field you want to sort the items by.



Filtering Items by Category

Sorting Items
How to set the sort order of items displayed in the Repository module. Date is the default sort order. Sort order is not persistent if the page 
is refreshed or navigated away from.

 1. At Sort by, select the field you want to order items by. The following options are available: Date, Downloads, User Rating, Title, 
Author Name and CreatedDate. 

 2. Optional. At Categories, select a category to filter items - OR - (if available) select All Items to view all items.



Sorting Repository Items by Category

Viewing an Item Image
How to view the image associated with an item on the Repository module. Note: Not all repository designs (skins) have an associate 
image.

 1. Locate the required item. 

 2. Click on the image displayed to the left. This displays the image in a new Web browser.



Viewing an Image

Viewing Comments
How to view comments added to an item in the Repository module. Note: Comment viewing may not be available to all users. The 
number of comments added to an item will be displayed on the COMMENTS link. E.g. COMMENTS (0) indicates no comments, COM-
MENTS (2) indicates 2 comments.

 1. Locate required item. 

 2. Click the COMMENTS link for that item. This displays the comments for this item.



Viewing comments

Viewing Item Ratings
How to view the rating of an item in the Repository module. Ratings can be displayed as either a 5 star rating  or a 
10 Dash rating . Note: Ratings may not be visible to all users.

 1. Locate the required item. The RATING score is typically displayed below each item. 

 2. Mouse over the rating stars/dashes to view the rating %, and the total number of votes.



Viewing Ratings

Downloading a File
How to download a file from the Repository module. Note: Download may not be available to all users.

 1. Search for the required file. 

 2. Click the DOWNLOAD link. This displays the File Download dialog box, enabling you to save the file to your computer.



Downloading a File

Adding Comments to an Item
How to add a comment to an item in the Repository module. Note: Adding comments may not be available to all users.

 1. Locate the required item. 

 2. Click the COMMENTS link. This displays the User Comments panel and any existing comments. 

 3. In the Your Name text box, enter your name. Note: If you are logged in to the web site your Display Name is displayed here and 
cannot be edited. 

 4. In the Your Comment text box, enter your comment. 

 5. Click the POST YOUR COMMENT button.



Adding Comments

Rating an Item
How to rate an item in the Repository module. Note: Rating of items may not be available to all users.

 1. Locate the required item. 

 2. At RATING, click on the Rating Stars  or Dashes . This displays the User Rat-
ing panel below the item. Note: If you are not authorized to add rating the User Rating panel is not displayed. 

 3. Click inside a radio button to select your rating. Rating options are 0 - 10. 

 4. Click the POST YOUR RATING button. Your rating is now added to the total tally.



Posting your Rating

Configuration
Configuring the Repository Module (Default Settings)
How to configure the Repository module by accepting all of the default settings including the Default skin. Undertaking this configuration 
will remove the message "ADMIN: Select Repository Settings from the Module Settings drop down menu to set the Repository Descrip-
tion text as well as set the number of objects to be displayed on each page" which is displayed at the top of the Repository module when 
you first add it to a page.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.



 2. Click the Update link. The following settings have now been accepted:

 l Only Administrators can upload, moderate, download, rate and comment on files. To modify these permissions, see See 
"Setting Repository Role Access"

 l There will be no description displayed for this repository. 

 l All items will be added to the All Items category. There are no other categories. 

 l The default sort order of items is by date. 

 l Five ( 5 ) items are displayed per page .

 l Authorized users can view comments. 

 l Authorized users can view ratings. 

 l The default skin is used .

 l Approved, unapproved and anonymous file are stored in the default Repository folder. 

 l The first image listed in the Root folder will be used when there is no image selected.

Repository with Default Configuration Settings

Contributors
Uploading a File (Default and Nifty Skins)
How to upload a file to the Repository module. This tutorial is based on the Default and Nifty skins. Note: Upload may not be available to 
all users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove the file selected at the File field. For this 
reason perform any Editor switches before selecting this file.

 1. Click the UPLOAD button. 

 2. In the Title text box, enter the title for the item. 

 3. At File, click the Browse... button and then locate and select the file. 

 4. In the Description text editor, enter a description of the file. 

 5. Optional. At Image, click the Browse... button and select the required file. Images are displayed scaled down to a width of 100 
pixels. If no image is selected the default image will be used but will not be scaled. 

 6. Optional. At Categories, select one or more categories if available. 



 7. Optional. In the Your Name text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed but can be edited if required. 

 8. Optional. In the Your EMail Address text box, enter your email address. If you are logged in to the web site, the email address 
associated with your user account is displayed but it can be edited if required. 

 9. Optional. At Show my email address check  the check box to display your email address on this item listing - OR - Uncheck 
 to keep your email address private.  

 10. Click the Upload button.





 11. If you are not a moderator: 

 a. This displays a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on the 
web site. You will receive an email when your upload has been approved."

 b. Click the OK button.

Uploading a Business Card
How to upload a business card to the Repository module. This tutorial is based on the Business Card skin. Note: Upload may not be avail-
able to all users.

Tip: Changing the Editor from Basic Text Box to Rich Text Editor or back will remove any file you have selected at the Company Logo 
field. This means you will need to reselect this file.

 1. Click the UPLOAD button. 

 2. In the Company Name text box, enter the company name. 

 3. In the Company Address editor, enter the company address. 

 4. In the Company Tagline editor, enter the company tagline. 

 5. The following optional fields are also provided: 

 a. At Company Logo, click the Browse... button and select a picture of yourself to be displayed beside this article. 
Logos are scaled down to a width of 48 pixels. If no image is selected the default image is displayed but it is not scaled. 

 b. At Categories, select one or more categories if available. 

 c. In the Your Name* text box, enter your name. Your First Name and Last Name will be displayed in this text box if you 
are logged in to the web site, however these details can be edited. 

 d. In the Your EMail Address* text box, enter your email address. Your email address will be displayed in this text box if 
you are logged in to the web site, however it can be edited. 

 e. At Show my email address* check  the check box to display your email address on this item listing- OR - Uncheck 
 to keep your email address private.

 6. Click the Upload button. 

 7. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

* Note: The contributor's name and email address are NOT displayed on business cards.





Uploading a Business Card

Uploading a Directory Listing
How to upload a directory listing to the Repository module. This tutorial is based on the Directory skin. Note: Upload may not be available 
to all users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove any files you have selected at the Resource URL 
and Image fields. For this reason perform any Editor switches before selecting these files.

 1. Click the UPLOAD button. 

 2. In the Title text box, enter a title for this directory listing. 

 3. In the Resource URL text box, enter the URL to this resource. E.g. http://www.domain.com/resource.aspx 

 4. In the Description Text Editor, enter a description of this directory listing. 

 5. The following optional settings are also available: 

 a. At Image*, click the Browse... button and select an image to be displayed on this listing. This image is scaled down to a 
width of 48 pixels. If no image is selected the default image is displayed but is not scaled. 

 b. At Categories, select one or more categories if available. 

 c. In the Your Name* text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed, but can be edited if required. 

 d. In the Your EMail Address* text box, enter your email address. If you are logged in the email address associated with 
your user account is displayed but can be edited if required. 

 e. At Show my email address* check  the check box to display your email address on this item listing- OR - Uncheck 
 the check box to keep your email address private.

 6. Click the Upload button. 

 7. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed.

 a. Click the OK button.

* Note: The image, contributor's name, and contributor's email address are NOT displayed on directory listings.





Uploading a Directory Listing

Uploading a File Listing
How to upload a file to the Repository module. This tutorial is based on the Default and Nifty skins. Note: Upload may not be available to 
all users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove any file you have selected at the File field. For this 
reason perform any Editor switches before selecting this file.

 1. Click the UPLOAD button. 

 2. In the Title text box, enter a title for the file. 

 3. At File, click the Browse... button and then locate and select the file. 

 4. The following optional settings are also available: 

 a. At Categories, select one or more categories if available. 

 b. In the Your Name text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed, but these can be edited if required. 

 c. In the Your EMail Address text box, enter your email address. If you are logged in the email address associated with 
your user account is displayed but can be edited if required. 

 d. At Show my email address check  the check box to display your email address on this item listing, or uncheck  to 
keep your email address private.

 5. Click the Upload button.

 6. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

Note: The contributor's name and email address are NOT displayed on file listings. Categories are not displayed on this skin.



Uploading a File Listing

Uploading a File (Nifty Toggle Skin)
How to upload a file to the Repository module. This tutorial is based on the Nifty Toggle skin. Note: Upload may not be available to all 
users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove any files you have selected at the File and Image 
fields. For this reason perform any Editor switches before selecting these files.

 1. Click the UPLOAD button. 

 2. In the Title text box, enter the title for the item. 

 3. At File, click the Browse... button and select the file. 

 4. In the Summary editor, enter a summary description of the file. 

 5. In the Description editor, enter a description of the file. 

 6. The following optional settings are also available: 



 a. At Image, click the Browse... button and select the required file. Large images are scaled down to a width of 100 pixels. 
If no image is selected the default image will be used. 

 b. At Categories, select one or more categories if available. 

 c. In the Your Name* text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed but can be edited if required. 

 d. In the Your EMail Address text box, enter your email address. If you are logged in to the web site, the email address 
associated with your user account is displayed but it can be edited if required. 

 e. At Show my email address*, check  the check box to display your email address on this item listing - OR - Uncheck 
 the check box to keep your email address private. 

 7. Click the Upload button.

 8. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

* Note: The contributor's name and email address are NOT displayed on this module.





Uploading a File (Nifty Toggle Skin)

Uploading a Portfolio Listing
How to upload a portfolio listing to the Repository module. This tutorial is based on the Portfolio skin. Note: Upload may not be available 
to all users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove the file selected at the Image field. For this 
reason perform any Editor switches before selecting this file.

 1. Click the UPLOAD button. 

 2. In the Title text box, enter the title for the item. 

 3. In the Description editor, enter a description of the file. 

 4. The following optional settings are also available: 

 a. At Image, click the Browse... button and then locate and select the image. Large images are scaled down a thumbnail 
width of 175 pixels. If no image is selected the default image will be used but will not be scaled. 

 b. At Categories*, select one or more categories if available.

 c. In the Your Name* text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed but can be edited if required. 

 d. In the Your EMail Address text box, enter your email address. If you are logged in to the web site, the email address 
associated with your user account is displayed but it can be edited if required. 

 e. At Show my email address* check  the check box to display your email address on this item listing- OR - Uncheck 
 the check box to keep your email address private. 

 5. Click the Upload button.

 6. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

* Note: The contributor's name and email address are NOT displayed on portfolio listings. Categories are not displayed on this skin.





Uploading a Portfolio Listing

Uploading a Slide Image
How to upload a slide image to the Repository module. This tutorial is based on the Slides skins. Note: Upload may not be available to all 
users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove the file selected at the Image field. For this 
reason perform any Editor switches before selecting this file.

Important: This skin has been designed for landscape images. Images that are orientated as portrait do not display correctly inside the 
slide frame.

 1. Click the UPLOAD button. 

 2. In the Title text box, enter the title for the item. 

 3. At Image, click the Browse... button and then locate and select the required image. Large images are scaled down to a max-
imum width of 140 pixels. If no image is selected the default image will be used but will not be scaled. 

 4. In the Description Text Editor, enter a description of the file. 

 5. The following optional settings are also available: 

 a. At Categories*, select one or more categories if available. Note: Category filtering is not provided on the Slides skin.

 b. In the Your Name text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed but can be edited if required. 

 c. In the Your EMail Address text box, enter your email address. If you are logged in to the web site, the email address 
associated with your user account is displayed but it can be edited if required. 

 d. At Show my email address, check  the check box to display your email address on this item listing- OR - Uncheck 
 to keep your email address private. 

 6. Click the Upload button.

 7. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

* Note: Category filtering is not provided on the Slides skin.



Uploading a Slide Image



Uploading a Video Listing
How to upload a video to the Repository module. This tutorial is based on the Nifty Video skin. Note: Upload may not be available to all 
users.

Tip: Switching the Editor from Basic Text Box to Rich Text Editor or back will remove the file selected at the Image field. For this 
reason perform any Editor switches before selecting this file.

 1. Click the UPLOAD button. 

 2. In the Video Title text box, enter the title for the video. 

 3. At Video File, click the Browse... button and then locate and select the video. 

 4. In the Description Text Editor, enter a description of the file. 

 5. The following optional settings are also available: 

 a. At Splash Image, click the Browse... button and then locate and select an image. Images are not scaled down there-
fore they should not be larger than 320 pixels. If no image is selected the video screen will display as blank. 

 b. At Categories, select one or more categories if available. 

 c. In the Your Name text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed but can be edited if required. 

 d. In the Your EMail Address text box, enter your email address. If you are logged in to the web site, the email address 
associated with your user account is displayed but it can be edited if required. 

 e. At Show my email address* check  the check box to display your email address on this item listing- OR - Uncheck 
 to keep your email address private. 

 6. Click the Upload button.

 7. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

* Note: The contributors email address will not be displayed on this skin.





Uploading a Video Listing (Nifty Video Skin)

Uploading an Article
How to upload an article to the Repository module. This tutorial is based on the Articles skin. Note: Upload may not be available to all 
users.

Tip: Changing the Editor from Basic Text Box to Rich Text Editor or back will remove any files you have selected from the Downloadable 
Version and Your Picture fields. This means you will need to reselect these files. For this reason these tasks should be performed last.

 1. Click the UPLOAD button. 

 2. In the Title of the Article text box, enter the title for the article. 

 3. At Article Summary, click the Basic Text Box radio button  to enter a summary, and then enter the article summary into the text 
box. Note: If you do not enter an article summary then the text "Add Article Summary..." will be displayed on this listing. 

 4. In the Article Text Editor, enter your article. Note: If you do not enter text for this article then the text "Add Article Text..." will be dis-
played on this listing. 

 5. The following optional settings are also available: 

 a. At Categories, select one or more categories if available. 

 b. In the Your Name text box, enter your name. If you are logged in to the web site, your First Name and Last Name are 
displayed, but can be edited if required. 

 c. In the Your EMail Address text box, enter your email address. If you are logged in the email address associated with 
your user account is displayed but can be edited if required. 

 d. At Show my email address* check  the check box to display your email address on this item listing- OR - Uncheck 
 to keep your email address private. 

 e. At Your Picture, click the Browse... button and select a picture of the author to be displayed beside this article. This 
picture is scaled down to a width of 48 pixels. If no image is selected the default image is displayed but is not scaled. 

 f. At Downloadable Version, click the Browse... button and select a downloadable version of your article such as a .PDF 
or .DOC file.

 6. Click the Upload button.

 7. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

* Note: The contributor's email address is NOT displayed on article listings.





Uploading an Article

Editing an Item
How to edit the details of an item in the Repository module. Authenticated users who are authorized to upload items are able to edit their 
items. Unauthenticated user are unable to edit any items.

 1. Locate the item. 

 2. Click the Edit  button beside the item. 

 3. Edit one or more fields as required. 

 4. Click the Upload button. 

 5. If you are not a moderator, a message reading "Your upload MUST be approved by an Administrator BEFORE it is displayed on 
the web site. You will receive an email when your upload has been approved" is displayed. 

 a. Click the OK button.

Editing an Item

Deleting an Item
How to permanently delete an item from the Repository module. Authenticated users who are authorized to upload items are able to 
delete their own items. Unauthenticated users are unable to delete any items.

 1. Locate the item. 

 2. Click the Edit  button beside the item. 



 3. Click the Delete button. This displays the message "Are You Sure You Wish To Delete This Item?" 

 4. Click the OK button.





Deleting an item

Troubleshooting: Restricted File Type Warning Message
You may receive a Restricted File Type warning message when attempting to upload a file via the Link Control to a module. This mes-
sage is displayed when you attempt to upload a file with an extension that you are not enabled to upload such as a movie or a sound file. 
E.g. .avi, .wma. If you don't have Host access contact your Administrator or Host and request that the file types you want to upload are per-
mitted.

The Restricted File Type Warning Message

Moderators
Overview of the Repository Moderator Role
Page Editors can add one or more security roles to the Moderator role of the Repository module. Moderators have the following capabil-
ities:

 l Items uploaded to the Repository by a Moderator are unmoderated. 

 l Moderators receive a notification message when new items are uploaded to the Repository and when existing items are 
changed. 

 l Moderators can edit, approve and reject items awaiting moderation. 

 l Moderators can edit and delete all Repository items.

The New/Changed Notification Message



Approving an Item
How to approve an item awaiting moderation on the Repository module.

Tip: The number of items requiring moderation is displayed on the MODERATE button. E.g. MODERATE (0) indicates there are no items 
to be moderated, MODERATE (2) indicates 2 items requiring moderation.

 1. Click the MODERATE button. This opens the Moderate page which displays the items awaiting moderation. 

 2. Optional. Click the VIEW FILE link to view the file. This permits you to view the file before approving it. Note: The file may not 
be the same as the image displayed. 

 3. Click the APPROVE link. An approval message is now sent to the author's email address. 

 4. Repeat Steps 2-3 to approve additional items. 

 5. Click the RETURN link.

Approving a Repository Item



The Approval Notification Message

Editing and Approving an Item
How to edit and approve an item awaiting moderation on the Repository module.

 1. Click the MODERATE button. The number of items awaiting moderation is displayed on this button. 

 2. Optional. To View File click the VIEW FILE link. You may like to view the file before approving it. 

 3. Click the  Edit button to the left of the item title. 

 4. Edit one or more fields as required. 

 5. Click the UPLOAD button. 

 6. Click the APPROVE link. An approval notification will be emailed to the author's email address. 

 7. Repeat Steps 3-6 to edit and approve additional items.



Editing and Approving an Item

Rejecting an Item
How to reject an item awaiting moderation in the Repository module.

 1. Click the MODERATE button. The number of items awaiting moderation is displayed on this button. 

 2. Optional. Click the VIEW FILE link to view the file. 

 3. Click the REJECT link. 

 4. In the Rejection Reason text box, enter the reason the item was rejected. 

 5. Click the Send Rejection Notice button. A rejection message is emailed to the Author's email address. 

 6. Repeat Step 2-5 to reject additional items. 

 7. Click the RETURN link.



Rejecting an Item

The Rejection Notification Message



Settings
Setting the Repository Design
How to set the layout and design options on the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. In the Repository Description Editor, enter a description for this repository. This description is displayed at the top of the mod-
ule.

 4. At Default Sort, select the default field to sort Repository files by. The default setting is Date. Users can modify the sort order 
using the Sort By field that is displayed on most of the skins provided.

 5. In the Enter the number of Items Per Page text box, enter the number of items to be displayed on each page of the repository. 
The default setting is 5.

 6. At Repository Skin, select the skin for this repository module. The default skin is Default. "Setting the Repository Skin". for more 
details.

 7. At Image set to use for Ratings, select the image to be displayed for ratings from the following options:

 l Default: Uses a five star rating scale. 

 l Dashes: Uses a ten dash rating scale.  This is default setting.

 8. At No Image*, select the default image to be displayed where no image is uploaded for an item. See Link Control for more 
details on selecting images. 

 9. Click the  Update link.

* Note: When uploaded images are displayed on the Repository module, they appear as a thumbnail image which is scaled down to a 
uniform width. This width varies between different skins. However the image you select at No Image is not scaled down. In order to pro-
vide the best visual presentation on your Repository you should match the width of the No Image to the thumbnail width on selected skin.

Here's a list of the thumbnail width displayed on each skin:

 l Articles, Business Cards, and Directory: Images are scaled down to a width of 48 pixels. 

 l Default, Nifty, and Nifty Toggle: Images appear scaled down to a width of 100 pixels. 

 l Portfolio: Large images are scaled down a thumbnail width of 175 pixels. 

 l Slides: Large images are scaled down a thumbnail width of 140 pixels. Note: Default image should be landscape. 

 l Blog, File List, and Nifty Video: Images are not used on these skins.





Configuring Repository Layout and Design

Adding a Repository Category
How to add a category to the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. At the Categories drop-down box, select <root> to create a parent category, or select an existing category to create a child cat-
egory. 

 4. In the Categories text box, enter a name for the new category. 

 5. Click the ADD CATEGORY link. 

 6. Repeat Steps 3-5 to add additional categories.

Tip: You do not need to click the Update link to save these changes.

Adding a Category

Editing Repository Categories
How to edit a category on the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. At Categories, select <root> from the drop-down box to edit a root category- OR - Select a parent category to edit a child cat-
egory. 

 4. In the Categories box below, select the category to be edited. 

 5. Click the Edit  button. 

 6. In the Categories text box, edit the category name. 

 7. Click the SAVE link.

Tip: You do not need to click the Update link to save these changes.



Editing a category

Reordering Repository Categories
How to reorder categories on the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Select the Repository Settings tab.

 3. At the Categories drop-down box, select <root> to reorder parent categories or select a parent category to reorder its child 
categories. 

 4. In the Categories text box, select the category to be moved. 

 5. Click the Up  or Down  buttons to re-order. 

 6. Repeat Steps 3-5 to reorder additional categories.

Tip: You do not need to click the Update link to save these changes.

Reordering categories

Enabling/Disabling the All Items Category 
How to enable or disable the All Items category on the Repository module. All items within the Repository are automatically assigned to 
an All Items category. If this option is enabled, an All Items category is displayed in the Category drop-down list. If this option is 
disabled, items that are not assigned to a category cannot be viewed. If this option is disabled it is recommended that at least one cat-
egory is created.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. At Include All Files, select one of the following options:

 l Check  the check box to enable the All Items category. 

 l Uncheck  the check box to disable the All Items category.



 4. Click the  Update link.

Setting the All Files Category

The All Items Category

Deleting a Repository Category
How to delete a category from the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.    

 3. At the Categories drop-down box, select <root> to delete a root category - OR - Select a parent category to delete its child 
category. 

 4. In the Categories box below, select the category to be deleted. 

 5. Click the Delete  button. This displays the message "Are you sure you want to delete this Category?". 

 6. Click the OK button.

Tip: You do not need to click the Update link to save these changes.



Deleting a category

Adding Attributes
How to add attributes and attribute values to the Repository module. Attributes can be exposed in the Repository by creating a Repos-
itory Skin with the [ATTRIBUTES] token.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. In the Attributes text box, enter an attribute name in the text box. 

 4. Click the ADD ATTRIBUTE link. 

 5. Repeat Steps 3-4 to add additional attributes.  

 6. To add Attribute Values to an existing attribute: 

 a. In the Attributes list, click on the attribute name. 

 b. In the Attribute Values text box, enter an attribute value. 

 c. Click the ADD VALUE link.

 7. Repeat Step 6 to add additional attribute values. 

 8. Click the  Update link.

Tip: You do not need to click the Update link to save these changes.

Adding an Attribute



Adding an Attribute Value

Editing Attributes
How to edit attributes and attribute values on the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.         

 3. In the Attributes text box, select the attribute to be edited. 

 4. To edit the attribute, click the Edit  button beside it in the Attributes list. 

 5. In the Attributes text box, edit the attribute. 

 6. Click the SAVE link. 

 7. To edit an Attribute Value: 

 a. In the Attributes list, select the attribute. 

 b. In the Attribute Values list, select the attribute value. 

 c. In the Attributes Values text box, edit the attribute value. 

 d. Click the SAVE link.

Note: You do not need to click the Update link to save these changes.

Editing an Attribute



Editing an Attribute Value

Deleting Attributes
How to permanently delete attributes and/or attribute values from the Repository module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. At Attributes, the following options are available: 

 4. To delete an attribute including all related attribute values: 

 a. Click on the attribute name in the Attributes list. 

 b. Click the Delete  button. This displays the  message "Are you sure you wish to delete this Attribute?"

 c. Click the OK button to confirm.

 5. To delete a single Attribute Value: 

 a. In the Attributes list, click on the attribute name. 

 b. In the Attribute Values list, click on the attribute value name. 

 c. Click the Delete  button. This displays the  message "Are you sure you wish to delete this Value?"

 d. Click the OK button to confirm.

 6. Click the  Update link.

Deleting an Attribute



Deleting an Attribute Value

Setting Repository Role Access
How to set the roles which can perform uploading, downloading, rating, commenting and moderation on the Repository module. These 
permissions are in addition to the permission set in under Module Settings - Basic Settings. This tutorial also includes how to select the 
roles who can view comments and ratings. Note: Some Repository skins do not provide file downloading, comments, or ratings.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. Go to the Security Roles field. 

 4. At Moderation Roles, check  the check box for each role that can moderate newly uploaded files. Users of this role will also 
be able to upload files without moderation. 

 5. At Download Roles, check  the check box each role that can download files. 

 6. At Upload Roles, check  the check box each role that can upload files. 

 7. At Rating Roles, check  the check box each role that can add ratings. 

 8. At Comment Roles, check  the check box each role that can add comments. 

 9. At View User Comments, select between the following options: 

 l Authorized Users Only: Only users who are authorized to add comments can view comments. This is the default set-
ting. 

 l All Users: All users who can view the module can view comments.

 10. At View User Rating, select between the following options: 

 l Authorized Users Only: Only users who are authorized to add ratings can view comments. This is the default setting. 

 l All Users: All users who can view the module can view ratings.

 11. Click the  Update link.



Configuring the Repository Security Roles

Setting the Repository Skin
How to set the skin used on the Repository module. Note: It is preferable to choose the Repository skin before uploading files to the mod-
ule as changing skin changes the fields which are displayed on the upload page.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Repository Settings tab.

 3. At Repository Skins select one of these skins: 



 l Articles: Repository for articles. "Overview of the Articles Repository".

 l Blog: Repository for blog posts. "Overview of the Blog Repository".

 l Business Card: Repository that displays business details in a card design. "Overview of the Business Card Repos-
itory".

 l Default: Repository for files with image previewing. "Overview of the Default and Nifty Repositories".

 l Directory: Repository for a list of resources that link to a URL. "Overview of the Directory Repository".

 l File List: Repository which displays a compact list of files. "Overview of the File List Repository".

 l Nifty Toggle: Repository for files with image previewing. Similar functionality to the default skin. "Overview of the Nifty 
Toggle Repository".

 l Nifty Video: Repository for viewing videos. "Overview of the Nifty Video Repository".

 l Portfolio: Repository for viewing portfolio image. "Overview of the Portfolio Repository". 

 4. Click the  Update link.

Setting the Repository Skin

Related Topics:

 l "Setting the Repository Design".

Administrators
Editing Item Comments
How to edit comments on the Repository module. Note: The COMMENTS link displays the total number of comments for this item.

 1. Search for the required item. 

 2. Click the COMMENTS (1) link. Existing comments for this item are now displayed in the User Comments panel. 

 3. Click the Edit  button beside the comment to be edited.



 4. In the Comment text box, edit the comment as required.



 5. Click the Update link. The edited comment now displays a Comment edited message

A Repository module displaying an edited Comment



Deleting Item Comments
How to delete comments from the Repository module.

 1. Search for the required item. 

 2. Click the COMMENTS link. Existing comments will be displayed. 

 3. Click the Edit  button beside the comment to be deleted. 

 4. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Comment?"

 5. Click the OK button.

Deleting a Comment

Skin Designs
Overview of the Articles Repository
By applying the Articles skin, the Repository module can be used as an article repository.

Each listing displays the article title, a thumbnail image of the author, the author's name, the date and time when the item was last 
updated, a summary of the article, and a read article button to view the full article. A downloadable version of each article can optionally 
be uploaded and is available to users in the download role.

Categories, sorting, ratings and comments are enabled on this skin.



The Articles Repository

Overview of the Blog Repository
By applying the Blog skin, the Repository module can be used as simple blog module. 

Each blog post displays the blog title, blog content, and the date and time when the blog was posted. The blog author can optionally dis-
play their email address. Posts are listed from the most recently updated to the oldest. There are no downloads associated with this skin.

Sorting and comments are enabled on this skin.



The Blog Repository

Overview of the Business Card Repository
By applying the Business Card skin, the Repository module can be used to display a list of company details in a business card layout. 



Each business card displays the company name, company address (this field uses the Rich Text Editor so other details such as email 
addresses, phone numbers, etc can be entered), the company tagline, and the date when the card was last updated. A company logo 
can optionally be displayed. There are no downloads associated with this skin.

Categories and sorting are enabled on this skin.

The Business Card Repository

Overview of the Default and Nifty Repositories
By applying either the Default or Nifty skins, the Repository module can be used to display of list of files with a corresponding image. This 
repository is similar to the Nifty Toggle skin however it does not include the summary field.

Each listing displays the item title, thumbnail image, description, the contributor's name, the file size, the number of times the file has 
been downloaded, and the date and time when the item was last updated. The contributor can optionally display their email 
address. Users can click on the image thumbnail to view the full size image in a new Web browser. A link to DOWNLOAD the file is dis-
played to users in the download role.

Categories, sorting, ratings and comments are enabled on these skins.



The Default Repository



The Nifty Repository

Overview of the Directory Repository
The Directory skin for the Repository module displays a of list of resources that link to a URL or fil

Each listing displays the resource title, description, the date and time when the listing was last updated, and the number of times the URL 
has been hit (i.e. visited from this page). A link to VISIT the resource URL is displayed to users in the download role.

Categories, sorting, ratings and comments are enabled on this skin.



The Directory Repository

Overview of the File List Repository
By applying the File List skin, the Repository module can be used to display a compact list of files.

Each listing displays the file name, the date and time when the file was last updated, and the file size. A link to download the file is dis-
played to users in the download role.

Ratings, comments and categories are not enabled on this skin. Sorting is enabled.



The File List Repository

Overview of the Nifty Toggle Repository
By applying the Nifty Toggle skin, the Repository module can be used to display of list of files with a corresponding image. This repository 
skin is similar to the Default and Nifty skins however it includes a summary field.

Each listing displays the item title, image, summary, file size, number of times the file has been downloaded, and the date and time when 
the item was last updated. Users can click the Show Details button to display the full description of the item. A link to DOWNLOAD the file 
is displayed to users in the download role.

Categories, sorting ratings and comments are enabled on this skin.



The Nifty Toggle Repository

Overview of the Nifty Video Repository
By applying the Nifty Video skin, the Repository module can be used to display a list of videos. Each listing displays the video 
title, contributor's name, video size, description, and the date and time when the video was last updated. Controls to play, stop, restart 
and skip along the video are displayed as is volume control.

Categories and sorting are enabled on this skin.





The Nifty Video Repository

Overview of the Portfolio Repository
By applying the Portfolio skin, the Repository module can be used to display a portfolio of images. 

Each listing displays the item title, image, description, and the date and time when the item was last updated. There are no downloads 
associated with the portfolio.

Ratings and comments are enabled on this skin.



The Portfolio Repository

Overview of the Repository Dashboard Module 
The Repository Dashboard module works together with one Repository module. This module can be configured to function as a category 
list menu, or can display the Latest Upload, Top Downloads, or Top Rated items for the selected Repository module.

Multiple Repository Dashboard modules can be set to operate with one Repository module.



Three different configurations of the Repository Dashboard Module

Overview of the Slides Repository 
By applying the Slides skin, the Repository module can be used to display a list of images inside frames that looks like traditional slides. 

Each listing displays an image thumbnail, description, author name, the date and time when the slide was last updated, and a copyright 
notice. The author's email address can optionally be displayed. Users can click on the image thumbnail to view the full size image in a 
new Web browser.

Ratings and comments are enabled on this skin.



The Slides Repository

Repository Dashboard
Displaying Repository Categories
How to configure the Repository Dashboard module to display all Repository categories.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Maximize  the Dashboard Settings section. 

 3. At Select Repository, select the Repository to be associated with this module. Repository modules are listed by their Tab 
Name/Module Title. E.g. Home/Repository. 

 4. At Dashboard Mode, select one of the following options: 

 l Categories (single-column): Select to display the categories of the selected Repository in a single column layout. 

 l Categories (double-column): Select to display the categories of the selected Repository in a double column layout.

 5. Click the Update link.

Note: The below example uses the Module Header field to display the category type displayed in each module.

The Repository Module offers two category layouts

 

Displaying the Latest or Top Items
How to configure the Repository Dashboard module to display a select number of the latest uploads, top downloads, or top rated items.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Maximize  the Dashboard Settings section. 

 3. At Select Repository, select the Repository to be associated with this module. Repository modules are listed by their Tab-
Name/ModuleTitle. E.g. Home/Repository. 

 4. At Dashboard Mode, select one of the following options: 

 l Latest Uploads: Select to display the latest uploads to the selected Repository module. 

 l Top Downloads: Select to display the most downloaded items from the selected Repository module. 

 l Top Rated: Select to display the best rated items in the selected Repository module.

 5. In the Indicate the number of items to be displayed text box, enter the number of items to be displayed on the Repository Dash-
board. E.g. 5 

 6. Click the Update link.

Note: The below example uses the Module Header field to display the information displayed in each module. See Module Settings for 
more details.



Repository Dashboard set to display different information

Overview of the Repository Dashboard Module
The Repository Dashboard module works together with one Repository module. This module can be configured to function as a category 
list menu, or can display the Latest Upload, Top Downloads, or Top Rated items for the selected Repository module. Multiple Repository 
Dashboard modules can be set to operate with one Repository module.

Search Input
About the Search Input Module
The Search Input module is included with DNN Community Edition. The Search Results module displays a search box where users can 
perform keyword searches of the site. This module can be associated with either the default Search Results module which is included in 
the site, or may be associated with an instance of the Search Results module which can be added to any page.

Important.  Professional Edition users should see the See "About the Search Crawler Module Suite" for details on configuring the Search-
Crawler Input module.

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.

See "About the Search Admin Module" for details on setting the default search settings and re-indexing site content.



The Search Input module

All Users
Performing a search using the Search Input module 
How to perform a search using the Search Input module. Note: Keyword matches are exact therefore entering timetables will not return 
results for the word timetable.

 1. Go to a Search Input module. 

 2. Enter a keyword into the Search Input module's text box. E.g. timetables 

 3. Click the Go button.

 4. Review the displayed results and then click on a linked title of a result item to go to that page.

Search Results

Settings
Configuring the Search Input Module 
How to configure the setting of the Search Results module associated with a Search Input module. When a search is made on this 
Search Input module the results will be displayed in the Search Results module selected here.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Search Input Settings tab. 

 3. At Search Results Module, select the Search Result module to be associated with this module. Each Search Results modules 
is listed by page name (E.g. Home).  Alternatively, select the default Search Result page. If there aren't any Search Results mod-
ules added to the site pages then the default Search Results page will be automatically selected. 

 4. Click the  Update link.

Setting the Search Results module

Designing the Search Input Module 
How to set the design options for a Search Input module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Search Input Settings tab. 

 3. At Show Go Image, select from the following options: 

 l Check  the check box to display a Go button. 

 l Uncheck  the check box to display the default Go button of your Web browser.

 4. At Show Search Image, select from the following options: 

 l Check  the check box to display a Search image to the left of the search input box. 

 l Uncheck  the check box to remove the Search image.

 5. Click the  Update link.



Search Input module with Go & Search buttons displayed

 

Search Results
About the Search Results Module
The Search Results module is included with DNN Community Edition.

Important.  Professional Edition users should see the See "About the Search Crawler Module Suite" for details on configuring the Search-
Crawler Results module. 

The Search Results module displays results of searches conducted using the Search Input module. Note: The Search Input module 
MUST be added to the site in order to perform a search. Page Editors are able to customize the way results are displayed. 

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.

The Search Results Module

Settings
Configuring the Search Results Module 
How to configure the appearance of results displayed in the Search Results module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Search Results Settings tab and then set one or more of these Optional settings: 

 3. In the Maximum Search Results text box, enter the maximum number of results that the search can display. 

 4. In the Results Per Page text box, enter the maximum number of results to be displayed per results page. 

 5. In the Maximum Title Length text box, enter the maximum number of characters that the search title can display. 



 6. In the Maximum Description Length text box, enter the maximum number of characters that the search description can display. 

 7. At Show Description, check  the check box to display a description for the search results.

 8. Click the  Update link.

Store
About the Store Module Suite
The Store module suite consists of the following five (5) integrated modules which are used together to create an online shopping expe-
rience.

Module Version: 03.00.00

Minimum DNN Version: 4.06.02

Features: ISearchable

Here's a summary of the five store modules:

Store Admin: This module allows Store Administrators to configure the store including payment processor details, manage products and 
categories and product reviews. Users in the Manage Orders role can only view Orders on this module and similarly users in the Manage 
Catalog role can only view Categories, Products and Reviews.





Store Account: This module enables customers to manage their current and previous orders, including the addresses associated with 
order. 

The following three modules are typically used on one page to create the shopping experience:

 l Store Catalog: This module displays the store products and enables authorized users to add new products and manage existing 
product. Options include setting a product as featured and including special discount prices. A wide range of layout options can 
be set using the Setting page. 

 l Store Menu: This module displays the product categories and enables authorized users to add new categories and manage exist-
ing categories. Some layout options can be set on the Setting page. 

 l Store Mini Cart: This module displays a summary of the products in the customer's cart and enables them to modify quantities of 
each.



The Store Catalog, Menu and Mini Cart modules

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleStore/tabid/890/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/114/scope/threads/Default.aspx

 l Issue Tracker: http://dnnstore.codeplex.com/workitem/list/basic

Important Information About Roles
The Store Admin module can be configured to enable a single role to Manage Orders ( update order status and send messages to the 
customer ) and another ( or the same ) role to Manage Catalog (create and manage categories and products and well as manage 
reviews). In this way, the Store Admin module can handle all store administrative tasks from one place and provide different levels of 
access to different users.

Details on granting page and module permissions for the Store Admin module is covered in this tutorial.

To set this up now, you should create the role you want to manage orders and the one you want to manage the catalog before beginning 
this tutorial. ( See "Adding a Security Role (Basic Settings)" ). Alternatively, you can set up these permissions at any time. 

For the purpose of this manual, the following names are used when referring to these user groups:

Customers: Users who are members of roles which have been View permissions to the Store page.

Catalog Managers: Users who are members of the role which has been selected at the Manage Catalog field on the Store Info page of 
the Store Admin module. These users can access the Categories, Products and Review pages on the Store Admin module. These users 
don't have access to view and manage orders or Store Info.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleStore/tabid/890/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/114/scope/threads/Default.aspx
http://dnnstore.codeplex.com/workitem/list/basic


Store Admin module as viewed by a Catalog Manager

Order Managers: Users who are members of the role which has been selected at the Manage Orders field on the Store Info page of the 
Store Admin module. These users can access the Orders pages on the Store Admin module.

Store Admin module as viewed by an Order Manager

Store Administrators: Users who are members of the Administrator or SuperUser role. These users can access all pages of the Store 
Admin module.





Store Admin Module as viewed by a Store Administrator

The following additional user groups have been superceded by the Catalog Managers role. They provide limited access to performing 
category and product management tasks. They are included here to provide details of what tasks are enabled when the below per-
missions are provided on these modules.

Category Managers: Users who are members of the role(s) which have been granted Edit Content/Edit permissions on the Store Menu 
module. Members of this role can add categories and manage parent categories. This role has been superseded by the Catalog Man-
agers role but is still covered in this manual.

Store Menu module as viewed by a Category Manager

Product Managers: Users who are members of the role(s) which have been granted Edit Content/Edit permissions on the Store Catalog 
module. Members of this role can perform most product manager tasks, however they cannot restore archived products. This role has 
been superseded by the Catalog Managers role but is still covered in this manual.

Store Catalog module as viewed by a Product Manager



Configuration
Configuring the Store Modules
How to configure the five (5) store modules to enable you to begin adding categories and products to the Store modules.

For more comprehensive installation information, download the  DotNetNuke Store Installation Guide from http://dnnstore.-
codeplex.com/releases/view/61524.

Important. Before beginning configuration, see "Important Information About Roles".

Step 1: Creating the Store

 1. Add a new page (E.g. Store), granting View Permissions to  roles/users who can use the store (  See "Adding a New Page via the 
Site Settings Page". Typically all users are granted viewing rights which allows them to browse products before registering, how-
ever you may choose to set the module as only viewable by registered users if that is your business model. Note: You may 
choose to set permissions View at a later time once you have populated your store.

http://dnnstore.codeplex.com/releases/view/61524
http://dnnstore.codeplex.com/releases/view/61524
http://dnnstore.codeplex.com/releases/view/61524




 2. Add the Store Catalog module to the content pane.

 3. Add the Store Menu to either the left or right pane.

 4. Add the Store Mini Cart to the same pane as the Store Menu.

Step 2: Configuring the Store Account module where Customers manage their Account and Orders

 1. Add a new page (E.g. Store Account) where customers can access their account information, set the page as visible to users that 
are authorized to go shopping.

 2. Add the Store Account module to the content pane.

Step 3: Creating the Store Administration Area 

 1. Add a new page (E.g. Store Admin), restricting View Permissions to  roles which can manage orders (E.g. manage order status), 
manage the catalog (manage categories, products and reviews) and manage store information (includes important business 
information such as your PayPal/Authorize.net banking details). See "Adding a New Page via the Site Settings Page"



 2. Add the Store Admin module to the page. See "Adding a New Module (RibbonBar)".

 3. Click the Update link.

Step 4: Linking the Store Modules together and Setting Additional Permissions

 1. See "Setting Store Info" and related topics in this section.

Tip: You can use addition instances of these modules on other pages as you like. For example, you might choose to add a second Store 
Menu module to the Home page of your site to promote sales.

Important Information About Roles
The Store Admin module can be configured to enable a single role to Manage Orders (update order status and send messages to the 
customer) and another (or the same) role to Manage Catalog (create and manage categories and products and well as manage 
reviews). In this way, the Store Admin module can handle all store administrative tasks from one place and provide different levels of 
access to different users.

Details on granting page and module permissions for the Store Admin module are covered in this tutorial.

To set this up now, you should create the role you want to manage orders and the one you want to manage the catalog before beginning 
this tutorial. ( See "Adding a Security Role (Basic Settings)"  ). Alternatively, you can set up these permissions at any time. 

For the purpose of this manual, the following names are used when referring to these user groups:

Customers: Users who are members of role(s) that have been granted view permissions on the Store page.

Catalog Managers: Users who are members of the role which has been selected at the Manage Catalog field on the Store Info page of 
the Store Admin module. These users can access the Categories, Products and Review pages on the Store Admin module. These users 
don't have access to view and manage orders or Store Info.



Store Admin module as viewed by a Catalog Manager

Order Managers: Users who are members of the role which has been selected at the Manage Orders field on the Store Info page of the 
Store Admin module. These users can access the Orders pages on the Store Admin module.

Store Admin module as viewed by an Order Manager

Store Administrators: Users who are members of the Administrator or SuperUser role. These users can access all pages of the Store 
Admin module.





Store Admin Module as viewed by a Store Administrator

The following additional user groups have been superseded by the Catalog Managers role. They provide limited access to performing 
category and product management tasks. They are included here to provide details of what tasks are enabled when the below per-
missions are provided on these modules.

Category Managers: Users who are members of the role(s) which have been granted Edit Content/Edit permissions on the Store Menu 
module. Members of this role can add categories and manage parent categories. This role has been superseded by the Catalog Man-
agers role but is still covered in this manual.

Store Menu module as viewed by a Category Manager

Product Managers: Users who are members of the role(s) which have been granted Edit Content/Edit permissions on the Store Catalog 
module. Members of this role can perform most product manager tasks; however they cannot restore archived products. This role has 
been superseded by the Catalog Managers role but is still covered in this manual.

Store Catalog module as viewed by a Product Manager



Working with Product Images
Image Formats and Locations

Five standard bitmap file formats can be used for products images (BMP, GIF, JPEG, PNG, and TIF). They can be stored anywhere in the 
portal subfolder (E.g.: ...\Portals\n\). 

The PNG transparency is fully supported (PNG-8 and PNG-24). We recommend using PNG-8 for wider compatibility, included Internet 
Explorer 6. Because the .NET Framework does not natively support the GIF transparency, therefore you have to define the ‘GIF Back-
ground’ setting if you want to use GIF images with transparency.

You might want to facilitate their management by grouping them into sub-folders by category, and use the product model number as a 
basis for their file name. You can also use external image files, but the DotNetNuke instance may require the full trust level. Visit the 
Microsoft MSDN web site for more information about trust levels. For security reasons, some hosting plans do not allow to operate in this 
mode. 

Thumbnail Settings

Three settings control the thumbnail display for each product section. The Show Thumbnails setting allows you to turn on/off the thumb-
nail display without changing the associated template. Thumbnails are created dynamically based on the size specified in the Thumbnail 
Width setting. Although source images can theoretically be of any size, it is better to reduce their width to the maximum size specified in 
the Thumbnail Width setting. To do this, you can use any photo editing tool or web site. This can reduce the image processing time and 
therefore alleviate the server workload. Similarly, the weight of the pictures should also be optimized. Depending on the quality of the 
source, you can reduce several MB to a few KB, save bandwidth, time and disk space. By default, all generated thumbnails are cached 
during 2 minutes. They are two settings in the Store Catalog general settings used to enable or disable the cache and the duration. If you 
use GIF images with transparency, set the 'GIF Background' setting with the hex value of the background color of your template. The 
default background color is white (FFF). To change this value "Managing New Product Settings"., "Managing Featured Product Settings". 
"Managing Popular Product Settings"., and "Managing Category Product Settings".

Image Caching

Image caching can be enabled on your store. It is recommended that you disable this feature  while designing the Store or you will have 
to wait for the cache duration to see your image changes (impacted settings are size and background color for GIF images). See "Man-
aging Store Catalog General Settings"

Templating and Design Guide
The Store module can easily be personalized. The template system builds pages dynamically, with HTML templates containing tokens, 
and several cascading styles sheets. The default templates and style sheets are XHTML compliant. They have been tested with Internet 
Explorer 8 and Firefox 3. 

In brief, the chosen content, which is read from the database, is displayed using templates, while its presentation (type, colors and sizes) 
is defined in the style sheets. 

A template is a file containing static HTML code, and dynamic tokens, which retrieve certain content from the database: for example, the 
products description or properties. 

The elegance of the Store module's architecture is that templates can be embedded. This makes the design very flexible. You may for 
example design the products’ presentation once for all catalogs (main, new products, featured, etc.); but alternatively you may design a 
different layout for every catalog. This helps building your own library of reusable catalog templates, which you can use in other portals 
like a construction game. Skin objects are small pieces of ready-to-use code that can easily be placed inside a skin by a designer without 
programming knowledge. 

All labels and messages comply with the DotNetNuke localization standards. This provides translation capabilities to other languages. 
But it may also be used to change the texts and build your own ‘pack’, adjusting your text to the site's audience.

For additional information on setting up portal templates, templates hierarchy, understanding CSS and using store skin objects visit: 
http://dnnstore.codeplex.com/documentation.

http://msdn.microsoft.com/
http://msdn.microsoft.com/
http://msdn.microsoft.com/
http://msdn.microsoft.com/
http://msdn.microsoft.com/
http://msdn.microsoft.com/
http://msdn.microsoft.com/
http://dnnstore.codeplex.com/documentation


Customers
Viewing Products
How to navigate to and view products associated with a category in the Store module.

 1. In the Store Menu, select a category.

 2. This displays products within this category in the Store Catalog module. If the selected category is a parent category, products 
within all related child categories are also displayed.

 3. Optional. If available, click on a linked Child Category Name in either the Store Menu or the Store Catalog module to filter prod-
ucts by that child category. The related products are again displayed in the Store Catalog module.

 4. Optional. To view products not displayed on the first page of the category, click on the [Page Number] link located at the base of 
the module.

 5. Optional. At Sort By, select to sort products by Manufacturer, Model Number, Model Name, Unit Price, or Date. You can also 
click the related icon to view product in either Ascending  or Descending  order.

Viewing Product Details
How to navigate to and view products associated with a category in the Store module.

 1. Locate the required product. See "Viewing Products"

 2. Click the More Info link beside a product to view product details.



Tip: Click the Return To Category link to return to the category.

Viewing Product Reviews 
How to view reviews of a product within the store. Only approved reviews are displayed.

 1. Go to the Product Details page for the required product. See "Viewing Product Details". This displays any approved reviews at 
the base of the module.



Viewing Product Reviews

Adding a Product Review 
How to submit a review of a product within the Store. Submitted reviews must be approved  before it is displayed in the store.

 1. Locate the required product. 

 2. Click the More Info link to view product details.  This displays all approved reviews  below the product details.

 3. Click the Add Review link which is typically located at the bottom right corner of this page.

 4. In the Your Name text box, enter your name. If you are logged in, this field is pre-populated with your display name.

 5. At Rating, select a rating the drop-down list. This updates the number of stars displayed at this field.

 6. Optional. In the Comments text box, enter your comments.



 7. Click the Update link.

Buying a Product Now
How to select a product and proceed directly to the checkout to purchase it using the Store module. This  adds one unit of the item to your 
cart and displays your Store Account, enabling you to proceed to the checkout.



 1. Locate the required product. "Viewing Products".

 2. Click the More Info link beside a product to view product details.

 3. Click the Buy Now  button.

 4. The Store Account module is now displayed, enabling you to proceed to the checkout. See "Completing Checkout - Managing 
Contact Addresses"

Adding a Product to the Cart
How to add a product to your shopping cart using the Store module.

 1. Locate and view the required product. See "Viewing Product Details"

 2. Optional. In the Quantity text box, edit the number of items required.



 3. Click the Add To Cart  button.

 4. The product has now been placed in your shopping basket, displays the item in the Store Mini Cart and returns you to the 
selected category page as shown below.



Viewing Products in your Cart 
How to view the products in the shopping basket using the Store module suite.

Option One:

 1. Go to the Store Mini Cart module. Her you can view a summary list of products added to your basket. 

 2. Click the View My Basket link to view additional product details.

Note: You may need to complete the Contact details before continuing to the Order Review tab where product details are displayed.

Option Two:

 1. Navigate to the Store Account module.

 2. Optional. Complete any incomplete Contact details. This may not be required depending on the setup of this store.

 3. Click the Continue link.



 4. The Order Review tab now displays product details and any additional costs.

Managing Products in your Cart
How to delete or modify the quantity of one or more products  in your Cart using either the Store Mini Cart module or the Store Account 
module. The images used in this tutorial are from the Store Mini Cart; however the process is the same for both locations.

To modify the quantity of a single product:



 1. In the Quantity text box, the edit the quantity of this product.

 2. Click the Click To Update Entered Quantity  button.

To modify the quantity of multiple products:

 1. In each Quantity text box, the edit the quantity of  products required. Note: Enter zero (0) to remove a product.

 2. Click the Update Cart button.

To delete a product:

 1. Click the Click To Delete This Product From Your Cart  button.

Tip: You can also modify quantities when reviewing your order on the Store Account module.

Proceeding to the Checkout
How to proceed to the Store checkout once you have selected products to buy using the Store module.



Recommended. Sign up for a user account (  See "Signing up as a Registered User" ) before continuing to the checkout. If you are 
already a registered user, log in and complete your Profile details, ensuring your address details are complete (See "Managing your 
User Profile" ).

 1. Click the View My Basket link on the Store Mini Cart module - OR - Go to the Store Account module.

 2. Optional. Click the Please Register Or Log In To Checkout if you are not already logged in. This will take you to the User Login 
page where you can login or signup for a user account ( See "Signing up as a Registered User" ). Once you have registered 
and/or logged in you will need to repeat Step 1.

 3. Click the Checkout  button. The next step is "Completing Checkout - Managing Contact Addresses".

Proceeding to the Checkout

Completing Checkout - Managing Contact Addresses
How to add a new address or edit an existing address using the Store Account module. You can add multiple addresses to use for billing 
and shipping orders. Note: Your Registration address is managed under your user profile. If See "Managing your User Profile"

 1. Click the View My Basket link on the Store Mini Cart module - OR - Go to the Store Account module. This displays the Contact tab 
of the Checkout page.

 2. At Bill To, select the address you wish to use from the drop-down box. If this is the first time you have made a purchase, or if you 
haven't saved any additional addresses, only your Registration Address (the address associated with your user account) will be 
available.

 3. Complete or edit these Billing Address fields:

 a. Optional. At Save, check  the check box to save this address for later use. Saved addresses are displayed on the Bill To 
field on this page.

 i. Optional. At Primary, check  the check box if this is your primary address.

 ii. In the Description text box, enter a name for this address. E.g. Work, Home, Shop.

 b. In the First Name text box, enter the first name of the person associated with this address. E.g. Elizabeth

 c. In the Last Name text box, enter the last name associated with this address. E.g. Smith

 d. In the Street text box, enter the street address. E.g. 101 Blackburn Road

 e. Optional. In the Unit # text box, enter a unit number. E.g. Flat 2

 f. In the Postal Code text box, enter the postal code. E.g. 12345

 g. In the City text box, enter the city. E.g. New York



 h. At Country, select a country from the drop-down list. Depending on your selection, this may populate the Region field 
below with the regions associated with this country.

 i. At Region, enter or select the region. E.g. New York

 j. In the Email text box, enter the email address associated with this address.

 k. In the Daytime Phone text box, enter the daytime telephone number for this address.

 l. In the Evening Phone text box, enter the evening telephone number for this address.

 4. Complete or edit these Shipping Address fields:

 a. At Shipping Address Options, select from these options:

 l Ship the order to the billing address: Select if the shipping address is the same as the billing address and then 
Skip to Step 5.

 l Separate shipping address: Select if the shipping address is different to the billing address and then complete all 
shipping address fields.

 5. Click the Continue link. This will save any changes and advance you to the Checkout - Order Review page. See "Completing 
Checkout - Order Review"

Completing Checkout - Order Review
How to review your order during the checkout process using the Store Account module. 



 1. Complete "Completing Checkout - Managing Contact Addresses"..      Once you complete this step, you will be located on the Order 
Review tab of the Checkout page.

 2. Review  the products you are about to purchase and any related shipping and handling costs.

 3. Optional. Adjust product quantities or delete products as required. See "Managing Products in your Cart"

 4. Click the Continue link to proceed to the Payment tab and then complete one of these checkout processes, depending on the 
payment provider used:

 l See "Completing Checkout - Authorize.Net Payment"

 l See "Completing Checkout - PayPal Payment"

 l See "Completing Checkout - PayPal Payment"

Completing Checkout - Atos Payment
How to complete the checkout process when Atos is the payment method for the Store.

 1. Complete "Completing Checkout - Order Review"..      Once you complete this step, you will be located on the Payment tab of the 
Checkout page.

Note: Once the order is complete you will receive confirmation via email.

Completing Checkout - Authorize.Net Payment
How to complete the checkout process when Authorize.Net is the payment method for the Store.

 1. Complete "Completing Checkout - Order Review"..      Once you complete this step, you will be located on the Payment tab of the 
Checkout page.

 2. Complete these Payment Details:

 a. Card Name: Enter the name on your credit card

 b. Expiry Date: Select the month / year when this card expires.

 c. Card Verification Code: Enter the 3 digit verification code displayed on the back of your card.

 3. Click the Confirm Order button to complete this order. Once the order is complete you will receive confirmation via email.



 4. Review the details of the order.

 5. Optional. You can now choose display details of your order.

Completing Checkout - Email Payment
How to complete the checkout process when email is the payment method for the Store.

 1. Complete "Completing Checkout - Order Review"..      Once you complete this step, you will be located on the Payment tab of the 
Checkout page.

 2. Click the Confirm Order button to complete this order. You will now receive confirmation via email.

 3. Review the details of the order.

 4. Optional. You can now choose display details of your order.



 5. This displays the order in detail.

Details of the completed order

Completing Checkout - PayPal Payment
How to complete the checkout process when PayPal is the payment method for the Store.

 1. Complete "Completing Checkout - Order Review"..      Once you complete this step, you will be located on the Payment tab of the 
Checkout page.

 2. Click the Confirm Order button to proceed to the PayPal web site.



 3. Create a PayPal account (if you don't already have one) and then login and complete the transaction on PayPal. Once the order 
is complete you will receive confirmation via email.

Completing Checkout using PayPal Payment

Canceling an Order
How to cancel an order placed in the Store using the Store Account module. This option may not be available on all stores.

Option One:



 1. Go to the Store Account module.

 2. Click the Order History link.

 3. Click the Details link beside the required order.

 4. Click the Cancel Order button. The order status is updated to Canceled.

Option Two:

 1. Go to the Store Account module.

 2. Click the Order History link.

 3. Click the Cancel link beside the required order.

Canceling an Order

Viewing your Order History
How to view your order history as a customer of the Store using the Store Account module



 1. Go to the Store Account module. 

 2. Click the Order History link.

 3. Optional. Click the Details link to view details of any order.

Viewing Order Details

Downloading Virtual Products
How to download virtual products which have been ordered using the Store module.

 1. Go to the Store Account module. 

 2. Click the Downloads link.

 3. Optional. Click the Download link to download the file and follow the prompts on your computer.



Important. Whenever you click on the 'Download' button, the file download counter is incremented regardless of the outcome.

Catalog Managers
Categories
Adding a Product Category
How to add a product category to the store using the Store Admin module.

 1. On the Store Admin module, click the Categories link.

 2. Click the  Add Category link.

 3. In the Name text box, enter a name for the category.

 4. Optional. In the SEO Name text box, enter the search engine optimization name to be appended to the URL for this category. 
Only alpha-numerical characters without spaces can be entered. 

 5. Optional. In the SEO Keywords text box, enter  keywords separated by a comma. This value will be inserted in the META Key-
words when the catalog page is displayed. The SEO Feature setting must be enabled in the Store settings for works.

 6. Optional. In the Description text box, enter a full description of the category.

 7. In the Display Order text box, enter a number to set the order of this category. E.g. Enter 1 to display this product first, Enter 2 to 
display this product second, etc. Leave the field blank to display categories in the order they are created.

 8. At Parent, leave this field set to None - OR - Select the name of parent category from the drop-down list.

 9. Optional. In the Message Editor, enter a message to be displayed above the category listing.



 10. Click the Update link. You can now view the newly added category details by click the category name in the Store Menu module. 
This displays the category name and description in the Store Catalog module as shown below.



The Newly Added Category

Editing a Product Category
How to edit a product category in the Store  module using the Store Admin module.

 1. On the Store Admin module, click the Categories link.

 2. Click the Edit link beside the category to be edited.

 3. Edit one or more fields as required. 

 4. Click the Update link.

 5. Repeat Steps 2-4 to edit additional categories.

Deleting a Product Category
How to delete a product category from the Store module using the Store Admin module.

Tip: You cannot delete categories with child categories. In this scenario, you must first delete the child category, change the child cat-
egory to a parent category, or associate the child category with a different parent category.

 1. On the Store Admin module, click the Categories link.

 2. Click the Edit link beside the category to be deleted.

 3. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 



 4. Click the OK button to confirm.

 5. Repeat Steps 2-4 to delete additional categories.

Managing Product Category Archiving
How to enable or disable archiving of a product category on the Store module using the Store Admin module.

 1. On the Store Admin module, click the Categories link.

 2. Click the Edit link beside the category to be archived.



 3. At Archived, select from these options:

 l Check  the check box to archive the product. Archiving a category removes it and its associated products from the 
Store Menu module. Archiving a parent category, will archive all of its child categories.

 l Uncheck  the check box to remove archiving.  Restoring a category will display it in the Store Menu module. Restor-
ing a parent category also restores all child categories unless they are individually set as archived.

 4. Click the Update link.

 5. Repeat Steps 2-4 to modify archive status for additional categories.



Products
Adding a Product
How to add a product to the Store using the Store Admin module.

Note 1: The SEO Feature option must be enabled  to use the SEO Name and SEO Keywords fields. See "Setting Store Info"

Note 2: Before you begin adding products, consider how you want to manage your product images which are stored in the File Manager. 
Typically, images are uploaded to the Portal Root/Store folder. If you have a large number of products, consider creating a child folder for 
each category (See "Adding a New Folder"). See "Working with Product Images" for more detailed information.

Note 3: If you wish to add customers who purchase this product to a Security Role, you should create this role before adding the product.

Tip: If you are adding multiple products at once, it is quickest to upload all of your store images  before adding your products. Don't forget 
to set Folder Security Permissions for your Catalog Managers if you want to enable them to add images.

 1. On the Store Admin module, click the Products link. 

 2. Click the  Add Product link.

 3. Strongly Recommended. At Category, select the category for this product from the drop-down list.

 4. In the Manufacturer text box, enter the name of the product manufacturer. E.g. EcoZany

 5. In the Model Number text box, enter a model number. E.g. W001

 6. Strongly Recommended. In the Model Name text box, enter the product name. E.g. Train Engine

 7. Optional. In the SEO Name text box, enter the search engine optimization name to be appended to the URL for this product. 
Only alpha-numerical characters without spaces can be entered. 

 8. Recommended. In the SEO Keywords text box, enter one or more keywords separated by a comma. This value is inserted in 
the META Keywords when the detailed product page is displayed. Note: SEO Feature setting must be enabled. See "Setting 
Store Info"

 9. Recommended. In the Summary text box, enter a short description of the product. 

 10. Recommended. In the Unit Price text box, enter the price of this product.

 11. Optional. At Virtual Product, check  the check box if this is a virtual product. I.e. A document, image, etc which can be deliv-
ered online.



 12. In the Product Dimension section, complete the following fields:

 a. Recommended. In the Shipping Weight text box, enter the weight of this product. This weight is used for shipping costs 
by weight range. This is the default shipping provider. See "Adding Shipping Rates"

 b. Optional. The following fields are provided for DNN Developers who want to create advanced shipping rates.  These 
fields can be used by PayPal gateway and shipping providers to compute shipping cost. Moreover, they can be dis-
played in templates using the corresponding tokens (See "Templating and Design Guide"). Because the Store module 
uses the provider model, DNN developers can create their own shipping and/or gateway provider using these values.

 i. In the Shipping Height text box, enter the height of this product. 

 ii. In the Shipping Length text box, enter the length of this product. 

 iii. In the Shipping Width text box, enter the width of this product.



 13. In the Stock Management section, complete the following fields:

 a. Strongly Recommended. In the Quantity text box, enter the quantity of this product currently in stock. If the value is 
zero ( 0 ) then the product may not be displayed. See "Setting Store Info" for details on how zero quantity is configured 
in your store set-up.

 b. In the Low Threshold text box, enter the minimum quantity in stock before reorder.

 c. In the High Threshold text box, enter the maximum quantity in stock.

 d. In the Delivery Time text box, enter the number of days required to receive a new delivery of this product.

 e. In the Purchase Price text box, enter the price you have must pay to purchase this product from its original supplier.

 14. At Apply Role, select the role users are added to when they purchase this product.

 15. At Featured, select from these option:

 l Check  the check box to set the product as featured. This displays the Special Offer Pricing section.

 l Uncheck  the check box to remove the product from the featured list. Skip to Step 17

 16. In the Special Offer Pricing section, complete the following fields:

 a. In the Special Offer Unit Price text box, enter the offer price. Leave this field blank to remove special offer pricing.

 b. At Special Offer Start Date, navigate to and select the first date for this offer price. If no start date is selected the offer 
will commence immediately. 

 c. At Special Offer End Date, navigate to and select the last date for this offer price. If no end date is selected the offer will 
be available indefinitely. 



 17. Recommended. At Image, select or upload an image for this product.  See "Setting a File Link", "Uploading and Linking to a 
File". or "Setting a URL Link".

 18. Recommended. In the Description text box, enter the full description of the product including any addition images, etc.



 19. Click the Update link. The new product is now displayed  in the Store Catalog module and a summary is displayed to Catalog 
Managers in the Product list.



Adding a Virtual Product
How to add a virtual product to the Store using the Store Admin module. A virtual product can include a file such as a document, image, 
etc.

Note 1: The SEO Feature option must be enabled  to use the SEO Name and SEO Keywords fields. See "Setting Store Info"

Note 2: Before you begin creating virtual products, consider how you want to manage your product downloads and product images which 
are stored in the File Manager. Typically, downloads and images are uploaded to the Portal Root/Store folder. However if you have a 
large number of products, you may want to create a child folder for each category and/or for your downloads. (See "Adding a New 
Folder"). See "Working with Product Images" for more detailed information.

Note 3: If you wish to add customers who purchase this product to a Security Role, you should create this role before adding the product.

Tip: If you are adding multiple products at once, it is quickest to upload all of your images or downloads before adding your products. 
Don't forget to set Folder Security Permissions for your Catalog Managers if you want to enable them to add images.

 1. On the Store Admin module, click the Products link. 

 2. Click the  Add Product link.

 3. Strongly Recommended. At Category, select the category for this product from the drop-down list.

 4. In the Manufacturer text box, enter the name of the product manufacturer. E.g. EcoZany

 5. In the Model Number text box, enter a model number. E.g. W001

 6. Strongly Recommended. In the Model Name text box, enter the product name. E.g. Train Engine

 7. Optional. In the SEO Name text box, enter the search engine optimization name to be appended to the URL for this product. 
Only alpha-numerical characters without spaces can be entered. 

 8. Recommended. In the SEO Keywords text box, enter one or more keywords separated by a comma. This value is inserted in 
the META Keywords when the detailed product page is displayed. Note: SEO Feature setting must be enabled. See "Setting 
Store Info"

 9. Recommended. In the Summary text box, enter a short description of the product. 

 10. Recommended. In the Unit Price text box, enter the price of this product.



 11. At Virtual Product, check  the check box. This displays the Download Information section.

 12. In the Download Information section, complete the following fields:

 a. At Product File, select from these options:

 l None: Select if there is no downloadable file associated with this product.

 l File ( A File On Your Site ): Select to associate a file with this product. See "Setting a File Link" or "Uploading and 
Linking to a File"..

 b. In the Allowed Downloads text box, enter the maximum numbers of downloads permitted. If there is no limit, enter -1. The 
default settings is for unlimited downloads.



 13. In the Stock Management section, complete the following fields:

 a. Strongly Recommended. In the Quantity text box, enter the quantity of this product currently in stock. If the value is 
zero ( 0 ) then the product may not be displayed. See "Setting Store Info"for details on how zero quantity is configured 
in your store set-up.

 b. In the Low Threshold text box, enter the minimum quantity in stock before reorder.

 c. In the High Threshold text box, enter the maximum quantity in stock.

 d. In the Delivery Time text box, enter the number of days required to receive a new delivery of this product.

 e. In the Purchase Price text box, enter the price you have must pay to purchase this product from its original supplier.

 14. At Apply Role, select the role users are added to when they purchase this product.

 15. At Featured, select from these option:

 l Check  the check box to set the product as featured. This displays the Special Offer Pricing section.

 l Uncheck  the check box to remove the product from the featured list. Skip to Step 17

 16. In the Special Offer Pricing section, complete the following field:

 a. In the Special Offer Unit Price text box, enter the offer price - OR - Leave this field blank to remove special offer pricing.

 b. At Special Offer Start Date, navigate to and select the first date for this offer price. If no start date is selected the offer 
will commence immediately. 

 c. At Special Offer End Date, navigate to and select the last date for this offer price. If no end date is selected the offer will 
be available indefinitely. 



 17. Recommended. At Image, select or upload an image for this product.  See "Setting a File Link", "Uploading and Linking to a 
File". or "Setting a URL Link".

 18. Recommended. In the Description text box, enter the full description of the product including any addition images, etc.



 19. Click the Update link. The new product is now displayed  in the Store Catalog module and a summary is displayed to Catalog 
Managers in the Product list.



Editing a Product
How to edit a product in the Store using the Store Admin module.

 1. On the Store Admin module, click the Products link.

 2. At Category Filter, select the category associated with the required product.

 3. Click the Edit link beside the product.

 4. Edit the required fields. See "Adding a Product (Product Manager)" for details of available fields.

 5. Click the Update link.

Deleting a Product
How to delete a product from the Store using the Store Admin module. Deleted products cannot be restored. If you plan to offer the prod-
uct in the future you should archive the product instead. See "Managing Product Archiving"

 1. On the Store Admin module, click the Products link.

 2. At Category, select the category the product belongs to. 

 3. Click the Edit link beside the product.



 4. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 5. Click the OK button.

Managing Featured Products
How to set a product as featured in the Store using the Store Admin module. Featured products are typically displayed at the top of the 
Store Catalog module. Additional settings enable you to create a special offer price for featured products with optional start and end 
dates for the offer.

 1. On the Store Admin module, click the Products link.

 2. At Category, select the category of the required product. 

 3. Click the Edit link beside the product.

 4. At Featured, select from these option:

 l Check  the check box to set the product as featured. This displays the Special Offer Pricing section.

 a. Optional. Go to the Special Offer Pricing section and complete any of the following settings:

 i. In the Special Offer Unit Price text box, enter the offer price. Leave this field blank to remove special 
offer pricing.

 ii. At Special Offer Start Date, click the Calendar link and select the commencement date for this offer 
price. If no start date is selected the offer will commence immediately.

 iii. At Special Offer End Date, click the Calendar link and select the last date for this offer price. If no end 
date is selected the offer will be available indefinitely.

 l Uncheck  the check box to remove the product from the featured list. Any special offer pricing which has been 
entered will now be ignored.

 5. Click the Update link. 



Featured Product Displayed in the Store Catalog

Related Topics:

 l See "Working with the Calendar"

Managing Product Archiving
How to archive a product or remove it from the archive in the store using the Store Admin module. Archived products are not displayed in 
the Store Catalog module.

Tip: You can archive a product rather than delete it if you may want to restore at a later time. See "Managing Product Archiving"

 1. On the Store Admin module, click the Products link.

 2. At Category, select the category of the required product. 

 3. Click the Edit link beside the product.



 4. At Archived, select from these options

 l Check  the check box to archive the product. This removes the product from the store and lists it as archived in the 
Product summary list of the Store Admin module.

 l Uncheck  the check box to remove archiving. This displays the product in the Store Catalog module.



 5. Click the Update link. This displays the Product page with the  product marked as archived.



The Archived Product

Managing Special Offer Pricing on Products  (Store Admin Only)
How to enable or disable a special offer price for a product in the Store using the Store Admin module. The special price is controlled by 
date range and can be set to occur either from a start date until an end date; from a start date with no end date; or with no start date but 
with an end date.

 1. On the Store Admin module, click the Products link.

 2. At Category, select the product category. 

 3. Click the Edit link beside the required product. 

 4. Maximize  the Special Offer Pricing section and complete the following:

 a. In the Special Offer Unit Price text box, enter the offer price. Leave this field blank to remove special offer pricing.

 b. At Special Offer Start Date, navigate to and select the first date for this offer price. If no start date is selected the offer 
will commence immediately. 

 c. At Special Offer End Date, navigate to and select the last date for this offer price. If no end date is selected the offer will 
be available indefinitely. 



 5. Click the Update link.

Tip: To clear a start or end date, click either the Clear Start Date or Clear End Date buttons respectivley.

Reviews
Filtering Product Reviews
How to filter product reviews that have been submitted to the Store using the Store Admin module. 

 1. On the Store Admin module, click the        Reviews link and then apply one or more of these filters.

 2. At Status, select from these options: 

 l --- ALL ---: Select to view both approved and unapproved reviews. 

 l Not Approved: Select to only view unapproved reviews. These reviews are not visible to customers. 

 l Approved Only: Select to view only reviews that are approved. These reviews are visible to customers.

 3. At Category, select --- ALL --- to view reviews for products in all categories - OR - Select a category to only view reviews for prod-
ucts within that category. 

 4. At Product, select --- ALL --- to view reviews for all products - OR - Select a product to only view reviews for that product.



Filtering Product Reviews

Approving Product Reviews
How to approve one or more product reviews on the Store using the Store Admin module. Reviews can be submitted to the Store by all 
users; however they do not appear until they are authorized.

Bug. A bug in Store (03.00.00) prevents Catalog Managers, Store Administrators and Administrators from approving product reviews. As 
a result, only SuperUsers can approve reviews in this version.

 1. On the Store Admin module, click the Reviews link.

 2. Recommended. At Status, select either Approved Only or Not Approved to filter reviews accordingly.

 3. Optional. Filter reviews by Category and/or Product fields. See "Filtering Product Reviews"

 4. Click the Edit link beside the required review.

 5. Optional. In the Comments text box, edit the comments if required.

 6. At Approved, select from these options:

 l Check the check box to approve the review. This will displays the review on the product detail page.

 l Uncheck  the check box if the review is not approved. This will removes the review product detail page. 

 7. Click the Update link to approve this comment.



 8. Repeat Steps 3-7 to approve additional reviews.

Editing Product Reviews
How to edit product reviews submitted to the Store using the Store Admin module. Note: Ratings cannot be edited.

 1. On the Store Admin module, click the        Reviews link.

 2. Filter reviews by Status, Category and/or Product as required. See "Filtering Product Reviews"

 3. Click the Edit link beside the required review.

 4. In the Comments text box, edit the comments as required.

 5. Click the Update link.



 6. Repeat Steps 2-5 to edit additional reviews.

Unapproving Product Reviews
How to remove approval for one or more product reviews which have been previously been approved for viewing in the Store using the 
Store Admin module.  Removing approval  removes the review from the Store Catalog thereby hiding it from customers. Unapproved 
reviews can still be managed via the Reviews list of the Store Admin module.

 1. Click the Reviews link.

 2. At Status, select Approved Only.

 3. Optional. Filter reviews by Category and/or Product. See "Filtering Product Reviews".

 4. Click the Edit link beside the required review.

 5. At Approved, uncheck  the check box.

 6. Click the Update link.

 7. Repeat Steps 2-6 to set additional reviews as unapproved.

Deleting Product Reviews
How to permanently delete product reviews from the store using the Store Admin module.

 1. On the Store Admin module, click the        Reviews link. 

 2. Filter reviews by Status, Category and/or Product as required. See "Filtering Product Reviews"

 3. Click the Edit link beside the required review.

 4. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 



 5. Click the OK button.

 6. Repeat Steps 3-5 to delete additional reviews.

Category Managers
Adding a Product Category (Category Manager)
How to add a category to the Store using the Store Menu module. This tutorial is can be completed by Category Managers and Catalog 
Managers.

Important. The SEO Feature option must be enabled  to use the SEO Name and SEO Keywords fields. See "Setting Store Info"

 1. Click the Add New Category link - OR - Select  Add New Category from the Store Menu module actions menu. This opens 
the Edit Catalog page.

 2. Complete Steps 3 onwards in "Adding a Product Category".

Editing a Parent Category  (Category Manager)
How to edit a parent category in the store using the Store Menu module. This tutorial is can be completed by Category Managers and Cat-
alog Managers. Note: Child categories can only be edited using the Store Admin module. See "Editing a Product Category"

 1. On the Store Menu module, click the Edit  button beside of the required parent category. This opens the Edit Catalog page.



 2. Edit one or more fields as required.

 3. Click the Update link.

Deleting a Parent Category (Category Manager)
How to delete a parent category from the store using the Store Menu module. Categories cannot be deleted if there are products within 
the category or if it has one or more child categories. This tutorial is can be completed by Category Managers and Catalog Managers.

 1. On the Store Menu module, click the Edit  button beside of the required parent category. This displays the Edit Catalog page.

 2. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 3. Click the OK button to confirm.

Order Managers
Viewing a Customer Order
How to view details of a single customer order  using the Store Admin module. 

 1. On the Store Admin module, click the        Orders link. This displays the Order History page. 

 2. In the Order Number text box, enter the number of the required order.

 3. Click the Search button. If the order is found, then the details of the selected order are displayed below in the Order Details sec-
tion. If the order number selected is not found, then a message reading "Order number not found" is displayed. In this scenario, 
enter a new order number and retry your search, or use a filter to locate the order.



Order Details displayed on the Order History page

Tip: Click on the customers email address to send them an email message.

Filtering Customer Orders
How to filter customer orders by customer or order status using the Store Admin module. 

 1. On the Store Admin module, click the        Orders link. This displays the Order History page. 

 2. Select one of these filters: 

 l At Customers, select to view all orders placed by the selected customer. 

 l At Order Status, select to view all orders set to the selected status. Available options are: Awaiting Payment, Paid, Proc-
essing, Awaiting Stock, Packing, Dispatched, or Canceled.



 3. Optional. Click the Details link beside an order to view more details and/or modify the order. 

Modifying Order Status
How to modify the status of a customer order using the Store module. The customer is sent an email informing them of the new status of 
their order. Note: You cannot reverse a canceled order.

 1. Locate the required order and go to the Order Details page. See "Viewing a Customer Order" or "Filtering Customer Orders".. 
Note: The current Status of the selected order is displayed at the Order Status field.

 2. At Change Status, select a new status for the order from these options: Awaiting Payment, Paid, Processing, Awaiting Stock, 
Packing, Dispatched, Canceled.



 3. At Confirm By Email, select from these option:

 l Check  the check box to send email notification to the customer of this status change.

 a. Optional. In the Order Status Management text box, enter a comment to be included in the email message to 
this customer.

 l Uncheck  the check box if you don't want to send a message informing the customer of the status change.

 4. Click the Save link. This returns you to the Order History page where you can view the updated Status and Status Date fields.



Modified Orders Status on the Order History page

Canceling Customer Orders
How to cancel one or more customer orders using the Store Admin module. Canceling of orders can be enabled or disabled using the 
Authorize Cancel field on the Store Admin module. See "Setting Store Info"

Note: Orders cannot be canceled once they have been dispatched, however they can be canceled following payment, in this case the 
associated role is removed. The Store module doesn't manage payment refunds. These must be managed using your back office pay-
ment system.

Option One:

 1. Filter orders.      See "Filtering Customer Orders"

 2. Click the Cancel link beside the required order.

 3. This updates the order status to Canceled.



Option Two:

 1. Modify order status to Canceled. See "Modifying Order Status"

Product Managers
Adding a Product (Product Manager)
How to add a product to the store using the Store Catalog module. This tutorial is can be completed by Product Managers and Catalog 
Managers. Note: If you wish to add customers who purchase this product to a Security Role, you must create this role before beginning 
this tutorial.

 1. Go to the Store Catalog module.

 2. Select Add New Product from the module actions menu - OR - Click  Add New Product link. This opens the Edit Catalog 
page.

 3. Complete Steps 3 onwards in "Adding a Product". or See "Adding a Virtual Product".

Editing a Product
How to edit a product as a Catalog Manager using the Store module.

 1. Go to the Store page.

 2. Using the Store Menu module, navigate to and select the category where the product is located.

 3. In the Store Catalog module, locate the required product.

 4. Click the Edit  button beside the title of the required product.



 5. Edit one or more product details. See "Adding a Product Category" for details of available fields.

 6. Click the Update link.

Setting Special Offer Pricing on Products
How to set a special offer price for products in the Store using the Store Menu module.  The special price is controlled by date range and 
can be set to occur either from a start date until an end date; from a start date with no end date; or with no start date but with an end date.

 1. Go to the Store page.

 2. Using the Store Menu module, navigate to and select the category where the product is located.

 3. In the Store Catalog module, locate the required product.

 4. Click the Edit  button beside the title of the required product.

 5. Maximize  the Special Offer Pricing section and complete the following:

 a. In the Special Offer Unit Price text box, enter the offer price. Leave this field blank to remove special offer pricing.

 b. At Special Offer Start Date, navigate to and select the first date for this offer price. If no start date is selected the offer will 
commence immediately. 

 c. At Special Offer End Date, navigate to and select the last date for this offer price. If no end date is selected the offer will be 
available indefinitely. 

 6. Click the Update link.

Tip: To clear a start or an end date click the Clear Start Date or Clear End Date buttons.



Special offer pricing set from 1 September 2010 - 30 September 2010

Managing Products (Product Manager)
How to manage product using the Store Menu and Store Catalog modules.  This tutorial is can be completed by Product Managers and 
Catalog Managers.

 1. Go to the Store page.

 2. Using the Store Menu module, navigate to and select the category where the product is located.

 3. In the Store Catalog module, locate the required product.

 4. Click the Edit  button beside the title of the required product.



 5. You can now perform any of these product managements tasks by completing the below tutorials from Step 4 onwards. 

 l See "Editing a Product"

 l See "Deleting a Product"

 l See "Managing Product Archiving" Note: Archived products can only be restored by a Store Administrator using the Store 
Admin module. 

 l See "Managing Featured Products"

Settings
Catalog Settings
Managing Store Catalog General Settings
How to set the general settings applied to the Catalog of the Store module.

 1. Go to the Store Catalog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Catalog Settings tab.

 4. Go to the General Settings section and modify any of the following settings: 

 a. At Catalog Template, select the template to be applied to the default Catalog page. The default selection is Cat-
alog.htm, which is used in store images throughout this manual. For details on using other templates, see "Templating 
and Design Guide".



 b. At Use Default Category, select from these options: 

 l Check  the check box to set a default category to be displayed on the default catalog page.

 i. At Default Category, select the default category - OR - Select None. 

 l Uncheck  the check box to use the option set in the selected catalog template. By default this will be new 
products and featured products.

 c. At Show Category Message, select from these options: 

 l Check  the check box to display the message entered in the Message field of the category. This is the 
default selection.

 l Uncheck  the check box to hide the message.



 d. At Show Category Products, select from these options: 

 l Check  the check box to  displays products in the Store Catalog module. See "Managing Category Product 
Settings", "Managing Search Settings". and "Managing Sort Settings".

 l Uncheck  the check box to hide products in the Store Catalog module. Warning. Users cannot view products 
in the Store Catalog if this option is selected.

 e. At Show Product Detail, select from these options:

 l Check  the check box to enable the Product Details page associated with the More Info link on the Store Cat-
alog. See "Managing Product Details Settings" to manage the related settings. This option also enables you to 
manage the Show Also Bought Products field and its related settings.

 i. At Show Also Bought Products, select from these options: 

 l Check  the check box to display the "Customers Who Bought This Product Also Bought" 
section on the Product Details page. See "Managing Also Bought Product Settings" to man-
age the related settings. 



 l Uncheck  the check box to disable the Also Bought Products field.

 l Uncheck  the check box to hide the Product Details page. If this option is selected, it is recommended that 
you trial this setting with different Catalog Templates to find the correct combination for your store.

 f. At Show New Products, select from these options: 

 l Check  the check box to display the New Products section in the Store Catalog module. See "Managing 
New Product Settings" to manage the related settings.            

 l Uncheck  the check box to disable the New Products section.

 g. At Show Featured Products, select from these options: 

 l Check  the check box to display featured products in the Store Catalog module. See "Managing Featured 
Product Settings" to manage the related settings.



 l Uncheck  the check box to disable featured products.

 h. At Show Popular Products, select from these options: 

 l Check  the check box to display popular products in the Store Catalog module.  See "Managing Popular 
Product Settings" to manage the related settings.



 l Uncheck  the check box to hide popular products.

 i. At Allow Print?, select from these options:

 l Check  the check box to disable the default print module setting. You have to add the StorePrint.Action but-
ton to your container skin to be able to use this feature. See "Templating and Design Guide"        

 l Uncheck  the check box to use default print option.



 j. At Enable Content Indexing, select from these options:

 l Check  the check box to enable content indexing by the DNN search engine. If you use several Store Cat-
alog modules, you should check this setting on ONLY one Store Catalog module instance. Otherwise, your 
products will indexed twice (or more) by the search engine.

 l Uncheck  the check box to disable DNN Search.

 k. At Enable Image Caching, select from these options:

 l Check  the check box to enable image caching. Note: This option should be uncheck while designing the 
Store or you will have to wait for the cache duration to see your image changes (impacted settings are size 
and background color for GIF images).

 l Uncheck  the check box to disable image caching.

 l. In the Cache Duration text box, enter the  cache duration (in minutes) for images. The default setting is 2.

 5. Click the  Update link.

Managing Category Product Settings
How to manage the layout of category product listings in the Store Catalog module.

Tip: The Show Category Products field must be checked in the General Settings section to configure these settings.

 1. Go to the Store Catalog module. 

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the       Catalog Settings tab. 

 4. Maximize  the Category Product Settings section and modify any of the following settings. 

 a. At Container Template, select the template to be applied to the default Catalog page. The template included with the 
Store is called CategoryContainer.htm.

 b. At List Template, select the template to be applied to the default Catalog page. The templates included with the Store 
are called ProductList.htm and ProductListFullInfo.htm templates. The default setting is ProductList.htm.

 c. In the Rows text box, enter the number of row of items to be displayed across the page. The default setting is 10.

 d. In the Columns text box, enter the number of columns of items to be displayed down the page. The default setting is 2.

 e. In the Column Width text box, enter the pixel width of each column. The default setting is 200.

 f. In the Repeat Direction text box, select either Horizontal or Vertical to set the direction that items incrementally repeat. 
E.g. down the page or across the page. 



 g. At Show Thumbnail, select from these options:

 l Check  the check box to display a thumbnail image. This is the default setting.

 l Uncheck  the check box to hide the thumbnail image. If this option is selected, skip the next step.

 h. In the Thumbnail Width text box, enter the pixel width of each thumbnail image.  The default setting is 90.

 i. In the GIF Background text box, enter the hex value of the background color to use with GIF image format. Valid values: 
#FFFFFF, #f00, FF0000, F09, etc.

 j. At Detail Page, select the page where product details are displayed. Choose Same Page to open the product details 
on the same page. This is the typical behavior however if you have multiple Store Catalog modules on your site and 
you want the product details to be displayed on that page, then select that page name.

 k. At Sub-Categories, select from these options:

 l Check  the check box to include in the list products of the sub categories of the selected category.

 l Uncheck  the check box to disable.

 l. At Repositioning, select from these options:

 l Check  the check box to apply repositioning at the top of the module rather than at the top of the page when 
a user is viewing the catalog.

 l Uncheck  the check box to disable repositioning.

 5. Click the  Update link.

Managing Search Settings
How to manage search setting for the Store Catalog module.



Tip: The Show Category Products field must be checked in the General Settings section to configure these settings.

 1. Go to the Store Catalog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Catalog Settings tab.

 4. Maximize  the Sort Setting section and modify any of the following settings:

 a. At Search Columns, check  the check box beside each of the columns which can be searched on. The available 
options are Manufacturer, Model Number, Model Name, Product Summary, and Product Description.

 b. At Search By, select the default search column.

 c. At Search Results Template, select the template to be used for search results. The template included with the Store is 
called SearchResultsList.htm.

 5. Click the  Update link.

Managing Sort Settings
How to manage the way product sorting is managed in the Store Catalog module.

Tip: The Show Category Products field must be checked in the General Settings section to configure these settings.

 1. Go to the Store Catalog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Catalog Settings tab.

 4. Maximize  the Sort Setting section and modify any of the following settings:

 a. At Sort Columns, Check  the check box beside each of the product fields which customers can sort by. The available 
options are Manufacturer, Model Number, Model Name, Unit Price, and Created Date.

 b. At Sort By, select the default field that  products are sorted by.

 c. At Direction, select the default direction, Ascending or descending that products are displayed in.



 5. Click the  Update link.

Managing Product Details Settings
How to manage the layout of product details in the Store Catalog module.

Tip: The Show Product Detail field must be checked in the General Settings section to configure these settings.

 1. Select Settings from the Store Catalog module actions menu. 

 2. Select the Catalog Settings tab.

 3. Maximize  the Product Details Settings section and modify any of the following settings. 

 a. At Detail Template, select the template to be applied to the product details page.  The templates included with the Store 
are called ProductDetail.htm and ProductDetailFullInfo.htm. The default setting is ProductDetail.htm.

 b. At Cart Warning, select from these options:

 l Check  the check box to display a warning message when the selected product is already in cart. 

 l Uncheck  the check box to hide warning message.

 c. At Show Thumbnail, select from these options: 

 l Check  the check box to display a thumbnail image.

 i. In the Thumbnail Width text box, enter the pixel width of each thumbnail image. The default setting is 
300.

 ii. In the GIF Background text box, enter a hexadecimal value to set the background color for GIF 
images. The default setting is white (FFF). Valid hexadecimal values are #FFFFFF, #f00, FF0000, 
F09, etc.

 l Uncheck  the check box to hide the thumbnail image.

 d. At Show Reviews, select from these options:

 l Check  the check box to show reviews on the Product Details page.

 l Uncheck  the check box to hide reviews. If reviews are hidden then only Store Administrators can read 
review using the Store Admin module. 



 e. At Return To, select the page where the user will be taken to when they click on the Return To Category link on the 
Product Details page. The default setting is Same Page. 

 4. Click the  Update link.

Managing Also Bought Product Settings
How to manage the layout of the Customers Who Bought This Product Also Bought section in the Store Catalog module.

Tip: The Show Product Detail and Show Also Bought Products fields must be checked in the General Settings section to configure these 
settings.

 1. Go to the Store Catalog module. 

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the         Catalog Settings tab. 

 4. Maximize  the Also Bought Product Settings section and modify any of the following settings:       

 a. At Container Template, select the template to be applied to the container of the Also Bought Products section. The tem-
plate included with the Store is called ListContainer.htm.

 b. At List Template, select the template to be applied to the Also Bought Products section list. Templates included with the 
Store are AlsoBoughtProduct.htm and AlsoBoughtProduct_Small.htm. The default setting is AlsoBoughtProduct.htm

 c. In the Rows text box, enter the number of row of items to be displayed across the page. The default setting is 10.

 d. In the Columns text box, enter the number of columns of items to be displayed down the page. The default setting is 2.

 e. In the Column Width text box, enter the pixel width of each column. The default setting is 200.

 f. In the Repeat Direction text box, select either Horizontal or Vertical to set the direction that items incrementally repeat. 
E.g. down the page or across the page. 



 g. At Show Thumbnail, select from these options:

 l Check  the check box to display a thumbnail image. This is the default setting.

 i. In the Thumbnail Width text box, enter the pixel width of each thumbnail image.  The default setting is 
90.

 ii. In the GIF Background text box, enter the hex value of the background color to use with GIF image for-
mat. The default setting is white (FFF). Valid hexadecimal values are #FFFFFF, #f00, FF0000, F09, 
etc.

 l Uncheck  the check box to hide the thumbnail image.

 h. At Detail Page, select the page where  you want to display the product details page. The page must have a Store Cat-
alog module on it. Typically this will be set to Same Page, unless you are using multiple Store Catalog modules.

 5. Click the  Update link.

Managing New Product Settings
How to set the layout of new product listings in the Store Catalog module. 

Tip: The Show New Products field must be checked in the General Settings section to configure these settings.

 1. Go to the Store Catalog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Catalog Settings tab.



 4. Maximize  the New Product Settings section and modify any of the following settings: 

 a. At Container Template, select the template to be applied to the default Catalog page. 

 b. At List Template select the template to be applied to the default Catalog page. 

 c. In the Rows text box, enter the number of row of items to be displayed across the page. The default setting is 10.

 d. In the Columns text box, enter the number of columns of items to be displayed down the page. The default setting is 2.

 e. In the Column Width text box, enter the pixel width of each column. The default setting is 200.

 f. In the Repeat Direction text box, select either Horizontal or Vertical to set the direction that items incrementally repeat. 
I.e. Either down or across the page respectively.

 g. At Show Thumbnail, select from these options: 

 l Check  the check box to display a thumbnail image.

 i. In the Thumbnail Width text box, enter the pixel width of each thumbnail image. 

 ii. In the GIF Background text box, enter the hex value of the background color to use with GIF image for-
mat. The default setting is white (FFF). Valid hexadecimal values are #FFFFFF, #f00, FF0000, F09, 
etc.

 l Uncheck  the check box to hide the thumbnail image. 

 h. At Detail Page, select the page where product details are displayed. Choose Same Page to open the product details 
on the same page. This is the typical behavior however if you have multiple Store Catalog modules on your site and 
you want the product details to be displayed on that page, then select that page name.

 5. Click the  Update link.

Managing Featured Product Settings
How to set the layout of featured product in the Store Catalog module.

Tip: The Show Featured Products  field in the General Settings section must be checked to configure these settings.



 1. Go to the Store Catalog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Maximize  the Sort Setting section and modify any of the following settings:

 a. At Container Template, select the template to be applied to the default Catalog page. 

 b. At List Template select the template to be applied to the default Catalog page. 

 c. In the Rows text box, enter the number of row of items to be displayed across the page. 

 d. In the Columns text box, enter the number of columns of items to be displayed down the page. 

 e. In the Column Width text box, enter the pixel width of each column. 

 f. In the Repeat Direction text box, select either Horizontal or Vertical to set the direction that items incrementally repeat. 
I.e. Down the page or across the page. 

 g. At Show Thumbnail, select from these options: 

 l Check  the check box to display a thumbnail image.

 i. In the Thumbnail Width text box, enter the pixel width of each thumbnail image.

 ii. In the GIF Background text box, enter the hex value of the background color to use with GIF image for-
mat.  The default setting is white (FFF). Valid hexadecimal values are #FFFFFF, #f00, FF0000, F09, etc.

 l Uncheck  the check box to hide the thumbnail image.

 h. At Detail Page, select the page where product details are displayed. Choose Same Page to open the product details on 
the same page. This is the typical behavior however if you have multiple Store Catalog modules on your site and you 
want the product details to be displayed on that page, then select that page name.

 4. Click the  Update link.



Managing Popular Product Settings
How to manage the layout of popular product listings in the Store Catalog module. 

Tip: The Show Popular Products field in the General Settings section must be checked to configure these settings.

 1. Go to the Store Catalog module.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Catalog Settings tab.

 4. Maximize  the Popular Product Settings section and modify any of the following settings.

 a. At Container Template, select the template to be applied to popular products in the Catalog. Default template is List-
Container.htm

 b. At List Template, select the template to be applied to popular products on the default Catalog page. Choose from the 
PopularProduct.htm, or PopularProduct_Small.htm template. 

 c. In the Rows text box, enter the number of row of items to be displayed across the page.

 d. In the Columns text box, enter the number of columns of items to be displayed down the page.

 e. In the Column Width text box, enter the pixel width of each column. If the value is higher than 0, the value will be 
inserted to the style attribute of the corresponding table cell. For a better control display, you should set this value to 0 
and use the CCS classes: td.StorePopularProductItem and td.StorePopularProductAlternatingItem as defined in the file 
StoreFront.css.

 f. In the Repeat Direction text box, select either Horizontal or Vertical to set the direction that items incrementally repeat. 
E.g. down the page or across the page.

 g. At Show Thumbnail, select from these options:

 l Check  the check box to display a thumbnail image.

 i. In the Thumbnail Width text box, enter the pixel width of each thumbnail image.

 ii. In the GIF Background text box, enter the hex value of the background color to use with GIF image for-
mat.  The default setting is white (FFF). Valid hexadecimal values are #FFFFFF, #f00, FF0000, F09, 
etc.

 l Uncheck  the check box to hide the thumbnail image. If this option is selected, skip the next step.

 h. At Detail Page, select the page where product details are displayed. Choose Same Page to open the product details 
on the same page. This is the typical behavior however if you have multiple Store Catalog modules on your site and 
you want the product details to be displayed on that page, then select that page name.



 5. Click the  Update link.

Menu Settings
Managing Category Menu Settings 
How to manage the category menu settings of the Store module.

 1. Go to the Store Menu module. 

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Select the Category Menu Settings tab.

 4. At Display Mode, select from these options:

 l Table: Displays categories inside an HTML table. This is the default settings.

 l List: Displays categories using an HTML unordered list (UL > LI). This option allows web designers use jQuery or Java.

 5. In the Column Count text box, enter the number of columns to use when displaying categories. In the below example, a column 
count of two ( 2 ) is used.

 6. At Catalog Page, select the page where the Store Catalog module is located. Typically this will be Same Page, which is the 
default setting. You may however prefer to have two Store Menus for your store. E.g. You may have one Store Menu module on 
the Home page of your site that drives people to your store. In this case, you would set Store Menu module on the Home page to 
direct to the page name of your Store.



 7. Click the  Update link.

Store Administrators
Shipping Settings
Adding Shipping Rates
How to add one or more shipping rates for the default shipping provider of the Store module.  Different rates can be created for different 
weight ranges. Shipping rates are added to the price of orders at checkout.

Tip: When adding weight and cost values for this tutorial, the fields are decimal values.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link.

 3. Maximize  the Shipping Settings section.  

 4. In the Description text box, enter a description for this fee. E.g. Light Weight 

 5. In the Min. Weight text box, enter the minimum weight of items within this shipping fee range as a decimal value. E.g. 0.01         

 6. In the Max. Weight text box, enter the minimum weight of items within this shipping fee range as a decimal value. E.g. 5

 7. In the Cost text box, enter the cost for this shipping fee range as a decimal value. E.g. 5

 8. Click the Add link. 

 9. The newly added shipping rate is now displayed in the Shipping Settings section.

 10. Repeat Steps 4-8 to add additional rates.

Important. If virtual products are enabled on your store, you must create a shipping rate for a zero ( 0 ) weight range.



Editing a Shipping Rate
How to edit one or more shipping rates on the Store  module.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link.

 3. Maximize  the Shipping Settings section.

 4. Edit one or more field as required.

 5. Click the Update Shipping Rates link.

Editing Shipping Rates

Deleting a Shipping Rate
How to permanently delete one or more shipping rates from the Store module.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link. 

 3. Maximize  the Shipping Settings section. 



 4. In the Delete column, check  the check box beside each shipping rate to be deleted. 

 5. Click the Update Shipping Rates link.

Deleting a Shipping Fee

Tax Settings
Disabling Taxation on Orders 
How to disable taxation on orders placed in the Store using the Site Admin module.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link.

 3. Maximize  the Tax Administration section. 

 4. At Enable Tax, uncheck  the check box.

 5. Click the Update Tax Settings link.

Managing Taxation on Orders 
How to enable and set or disable taxation for orders created  using the Store module. This tutorial is for the default taxation provider. Tax-
ation is added to an order when the customer proceeds to the checkout.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link. 

 3. Maximize  the   Tax Settings section. 



 4. At Enable Tax, select from these options:

 l Check  the check box to enable taxation.

 a. In the Tax Rate text box, enter the taxation rate as a percentage. E.g. 10

 l Uncheck  the check box to disable taxation.

 5. Click the Update Tax Settings link.

Setting Store Info
How to set the general information of the store as displayed in the Store and the Shopping Cart pages of the Store module.

Note: You can configure the Store to enable one or more roles to manage orders or manage the catalog (reviews, products and cat-
egories). If you would like to set this up now, you should create those roles ( See "Adding a Security Role (Basic Settings)" ) and add the 
users to those roles ( See "Adding a User to a Security Role" ) before beginning this tutorial. Alternatively, you can set up these per-
missions at any time.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link.

 3. In the Store Name text box, enter a name for your store. E.g. EcoZany Store

 4. Recommended. At SEO Feature, select from these options:

 l Check  the check box to inject the Store Name, Description and Keywords into the corresponding META fields of the 
page where the catalog module is placed. This allows a better indexing by search engines and produces higher rank-
ing. When product details are displayed, the product's fields model name, summary and keywords are used.

 a. In the Description text box, enter a description of your store.

 b. In the Keywords text box, enter one or more key words or phrases separated by a comma.

 l Uncheck the check box to disable.

 5. In the Store Email text box, enter the email address to  be used in emails sent by the store. Order details will also be sent to this 
address.



 6. In the Currency Symbol text box, enter the symbol to be displayed for product prices. E.g. $

 7. Optional. At Portal Templates, check  the check box to enable portal templates on your store.

 8. At Style Sheet, select the style sheet to be used for the store.

 9. At Store Page, select the page name where the Store Catalog and Store Menu modules are located.

 10. At Store Account Page, select the page name where the Store Account module is located.

 11. Optional. At Authorize Cancel, check  the check box to enable customers to cancel their orders.

 12. Optional. At Inventory Management, check  the check box to enable inventory management. This displays these additional 
fields:



 a. At On Out of Stock, select the message to be displayed when a product is out of stock. Note: This feature only works 
when the [STOCKQUANTITY] token is used in templates. 

 b. At Product's Behavior, select the behavior for out of stock products from these options:

 l Accept order if a product is out of stock

 l Hide quantity, links and buttons. This hides the field quantity, links/buttons "Add to Cart" and "Buy now!"

 l Hide the Product

 13. Optional. At Avoid Negative Stock, check  the check to enable an additional availability test to be performed when a product 
is added to shopping cart. Note: There is no guarantee of stock availability due to the nature of the Internet.

 14. At Manage Orders, select the role which is allowed to manage orders. By default,  Administrators  and SuperUsers are allowed to 
manage orders.

 15. At Manage Catalog, select the role which is allowed to manage products, categories and reviews. By default,  Administrators  and 
SuperUsers are allowed to manage these.

 16. Optional. At Secure Cookies, check  the check box to encrypt cookie values.

 17. At Checkout Mode, select from these options:

 l Registration Required: Shopper must be registered users to complete the checkout process.

 a. Optional. At Allow Virtual Products, check  the check box to allow virtual products. Note: Registration is 
required for virtual products because a user account is required to save the download counter.

 l User Choice: Shopper can either be registered users or anonymous users to complete the checkout process.

 a. At Impersonated Account, select which user account to use if the customer chooses to remain anonymous.

 l Always Anonymous: Shopper are always anonymous when completing the checkout process.

 a. At Impersonated Account, select which user account to use.

 18. At Address Provider, select the address provider to use.

 19. At Tax Provider, select the tax provider to use. 

 20. At Shipping Provider, select the shipping provider to use. 

 21. At Payment Gateway, select the payment gateway provider to use and then configure the related settings. See "Configuring 
Atos as the Payment Gateway", "Configuring Authorize.Net as the Payment Gateway".  and "Configuring PayPal as the Payment 
Gateway Provider".



 22. Click the Update link. The Address Administration, Tax Settings, and Shipping Settings sections are now displayed, enabling 
you to configure these settings as required. Note: There are no Address Administration settings associated with the Default 
Address Provider.

Configuring Atos as the Payment Gateway
How to set and configure Atos as the payment provider for your Store using the Store Admin module. Important. Before configuring this 
setting, you must register for an account at http://www.sips-atos.com/Fr/index.html to obtain a Merchant ID and Merchant certificate. 

To test your integration with ATOS Payment Gateway, you can use the demonstration Merchant ID - Certificate file pair. To process real 
payments, you should change the demonstration Merchant ID into the production Merchant ID in your  configuration form and upload the 
production certificate file using this form.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link. 

 3. At Payment Gateway, select AtosProvider. 

 4. In the Merchant ID text box enter ID provided to you by SIPS  at the time of the registration of its shop. This ID allows the iden-
tification of a shop SIPS. It generally corresponds to the SIRET preceded by 0.

 5. In the PathFile Folder text box, click the Load Pathfile link and upload your Merchant Certificate.

 6. At PathFile Folder, select the file you just uploaded at Step 5.

 7. At Bank Logo, select the logo.

 8. Click the Update link.

Configuring Authorize.Net as the Payment Gateway
How to set and configure Authorize.Net as the payment provider for your Store using the Store Admin module. Important. Before con-
figuring this setting, you must create an account at http://www.authorize.net to obtain the account information.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link. 

 3. At Payment Gateway, select AuthorizeNetProvider. 

http://www.sips-atos.com/Fr/index.html
http://www.sips-atos.com/Fr/index.html
http://www.authorize.net/


 4. In the Transaction POST URL, text box enter the POST URL provided to you by Authorize.Net. The default option is https:/-
/secure.authorize.net/gateway/transact.dll. 

 5. Optional. In the Version text box, edit the version number of the AIM gateway you are posting to if required. This field is pre-pop-
ulated with the version number "3.1" which is the typical choice, unless you are told otherwise. 

 6. In the API Login ID text box, enter the API Login ID provided by authorize.Net. 

 7. In the Transaction Key text box, enter the transaction key provided by authorize.Net. 

 8. At Capture Type, select from the following options: 

 l Auth and Capture: This option authorizes the payment and captures the funds. 

 l Auth Only: This option authorizes the payment but does not capture the funds. This is the default option. 

 l Capture Only: This option captures the funds but does not authorize the payment.

 9. At Test Mode, select from these options:

 l Check  the check box to use the store in test mode only. Transactions are not live in this mode.

 l Uncheck  the check box to begin accepting payments.

 10. Click the Update link.

Enabling/Disabling Authorize.Net Test Mode
How to enable or disable the Authorize.Net test mode on the Store. Enabling Test mode allows orders to be sent to the payment gateway 
without taking live transactions. This tutorial assumes Authorize.Net has already been configured as the gateway. See "Configuring 
Authorize.Net as the Payment Gateway"

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link. 

 3. At Test Mode, select from these options:

 l Check  the check box to use the store in test mode only (Transactions are not live in this mode).

 l Uncheck  the check box to begin accepting payments.

https://secure.authorize.net/gateway/transact.dll
https://secure.authorize.net/gateway/transact.dll
https://secure.authorize.net/gateway/transact.dll


 4. Click the Update link.

Setting the Store Gateway as Email Only
How to use email notifications to process  orders placed using the Store module. Note: There are no additional Payment Gateway Set-
tings associated with this provider.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link.

 3. At Gateway, select EmailProvider.

 4. Click the Update link.

Configuring PayPal as the Payment Gateway Provider
How to set and configure  PayPal as the payment provider for your Store using the Store Admin module. Important. Before completing 
this tutorial you must first obtain a PayPal account at http://www.paypal.com/.

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link.

 3. At Gateway, select PayPalProvider. 

 4. At Use PayPal Sandbox, select from these options:

 l Check  the check box to use the store in test mode only. Transactions are not live in this mode. 

 l Uncheck  the check box to begin accepting payments. 

 5. In the PayPal ID text box, enter the email address associated with this account. 

 6. Recommended. In the Secure ID text box, enter the Secure Merchant Account ID  displayed on your profile summary at PayPal. 
Complete this field to harden your security.

 7. Optional. In the PayPal Verification URL text box, edit the PayPal URL used for verifying payments if required. This default 
value should not require editing. 

http://www.paypal.com/


 8. Optional. In the PayPal Payment URL text box, edit the PayPal URL used for processing payments if required. This default 
value should not require editing. 

 9. In the PayPal Language text box, enter an abbreviation to represent the language to be used on the PayPal site. E.g. US. 
Options are: 

 l AU: Australian English

 l DE: German

 l ES: Spanish

 l FR: French

 l GB: English

 l IT: Italian

 l US: American English. This is the default option.

 9. Optional. In the Charset text box, edit the character set to be used for the transferring data. A default value of UTF-8 is provided. 

 10. Optional. In the PayPal Button URL text box, edit the URL of the default PayPal button if you want to use your own button. 
Note: You must first upload the button to a secure page on your web site.

 11. In the Currency text box, enter the three character PayPal currency code. A default value of USD for United States Dollars is pro-
vided. 

 12. Optional. In the Surcharge (Percent) text box, enter the percentage surcharge for using PayPal. This amount will be added at 
the checkout. Enter 0 or leave blank if no percentage surcharge is charged. This option can be combined with a fixed surcharge 
as below. Refer to the PayPal documentation for details.

 13. Optional. In the Surcharge (Fixed) text box, enter the fixed surcharge cost for using PayPal. This amount will be added at the 
checkout. Enter 0 or leave blank for no fixed surcharge is charged. This option can be combined with a percentage surcharge as 
above.



 14. Click the Update link.

Tip: When you are ready to begin taking live transactions, you should uncheck  the Use PayPal Sandbox check box.

Enabling/Disabling PayPal Sandbox
How to enable or disable the PayPal sandbox or test mode on the Store using the Store Admin module. Enabling the sandbox allows 
orders to be sent to the payment gateway without taking live transactions. This tutorial assumes PayPal has already been configured as 
the gateway. See "Configuring PayPal as the Payment Gateway Provider"

 1. Go to the Store Admin module.

 2. If the Store Info page isn't displayed, click the Store Info link. 

 3. At Use PayPal Sandbox, select from the following options: 

 l Check  the check box to use the store in test mode only. Transactions are not live in this mode. 

 l Uncheck  the check box to begin accepting payments.



 4. Click the Update link.

Survey
About the Survey Module
The Survey module displays a survey consisting of one or more survey questions. Questions can have either a single or multiple choice 
answers. One answer to a question can be selected as the correct response, thereby enabling the survey to function as a quiz. Author-
ized users can submit their response to the survey and/or can view current survey results. This module uses cookies to remember which 
computers have already submitted a response to the survey, reducing the opportunity for one person to answer the survey repeatedly. 
Optional features include the ability to set a closing date for submitting responses to the survey, and the ability to set the width of the 
results graph.

Module Version: 04.70.00

Minimum DNN Version: 05.05.01

Features: ISearchable



The Survey Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleSurvey/tabid/837/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/51/scope/threads/Default.aspx

 l Issue Tracker: http://dnnsurvey.codeplex.com/workitem/list/basic

All Users
Submitting Survey Response 
How to submit a response to a survey on the Survey module. Note: Access to view results may be restricted.

 1. If a message reading "You must sign in to vote in this survey" is displayed below the questions you must               Login to the site to sub-
mit a response to the survey. 

 2. Click in the selection boxes to select your answer(s) for each question. 

 3. Click the Submit Survey link.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleSurvey/tabid/837/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/51/scope/threads/Default.aspx
http://dnnsurvey.codeplex.com/workitem/list/basic


 4. If you are authorized to view survey results, the accumulative results are displayed. If you are unable to view results the message 
"Thank You for Participating" is displayed.

Viewing Survey Results 
How to view survey results. Note: Access to view results may be restricted.

 1. Click the View Results link. The results are now displayed.



 2. Optional. To return to the survey, click the View Survey link.

Tip: If a correct answer is provided a question, it will be indicated as >CorrectAnswer<.

Module Editors
Adding a Question
How to add a question to the Survey module. Single selection questions permit users to select only one answer to a question.

 1. Select  Add Question from the module actions menu - OR - Click the  Add Question link. 

 2. In the Question text box, enter the question. E.g. Who was the leader female actor in My Fair Lady? 

 3. At Type, select one of the following options: 

 l Select Single Selection to restrict users to selecting only one answer. 

 l Select Multiple Selection to permit users to select multiple answers.



 4. Optional. In the View Order text box, enter a number to set the position of this question in the list of questions. E.g. 1=first ques-
tion, 2=second question, etc.  Leave this field blank to order questions in the order they are entered. 

 5. In the New Option text box, enter an option that the user can choose. E.g. Audrey Hepburn. 

 6. Optional. At Option Is Correct Answer? check  the check box to mark this option as the correct answer, or uncheck  the 
check box if the answer is incorrect, or if you do not want to indicate the correct answer. Note: A question may have multiple cor-
rect answers. 

 7. Click the Add Option link.

 8. Repeat Steps 5-7 to add additional options. 

 9. Click the Update link to save the question and it's associated answer options.

Editing a Survey Question 
How to edit a question in the Survey module. Existing options cannot be edited, therefore you must  delete and/or add options to change 
the available options.

 1. Click on the Edit  button beside the question.



 2. Edit any of the following question properties: 

 a. In the Question text box, edit the question. 

 b. At Type, change the selection type if required. 

 c. In the View Order text box, modify the view order of the question.

 d. To manage question options, perform any of the following: 

 l To add an option: enter the option name in the New Options text box and click the Add Option link.  Repeat Step 
3a to add additional options. 

 l To delete an option: select it and click the Delete  button. 

 l To reorder an option, select the option and then click either the Move Option Up  or Move Option Down  but-
ton one or more times to move the selected option up or down one or more positions respectively.

 3. Click the Update link.

Deleting a Survey Question 
How to permanently delete a question from a Survey module.

 1. Click the Edit  button beside the question. 

 2. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 



 3. Click the OK button to confirm deletion.

Settings
Setting Survey Closing Date 
How to set the closing date for survey responses. Once the close date is reached, the Submit Survey link is hidden. Survey results are dis-
played to users who are authorized to view results.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Survey Settings tab. 

 3. At Survey Closing Date, click the Calendar link and select the final date that a response can be submitted.



 4. Click the Update link.

Related Topics:

 l See "Working with the Calendar"

Setting the Maximum Graph Width 
How to set the maximum bar graph width of survey results displayed in the Survey module. For example, if you set the width to 200 pixels 
then the maximum width of the graph bar will be 200 pixels for a 100% response. The default width of the survey bar graph is 100% of 
the module width.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Select the Survey Settings tab. 

 3. In the Maximum Bar Graph Width text box, enter the maximum pixel width for the bar graph.

 4. Click the Update link.



Maximum Bar Graph Width set to 200 pixels



Maximum Bar Graph Width not set

Setting Vote Tracking 
How to set the type of tracking used to track the responses to a survey.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.  

 2. Select the Survey Settings tab. 

 3. At Vote Tracking, select from the following options:

 l Vote tracking via cookie: Select to restrict voting to one vote per computer using a cookie. Each computer can only sub-
mit results once, unless the cookie is deleted. This option doesn't require users to login to vote. 

 l 1 Vote/Registered User: Select to restrict voting to one per registered user and requires users to be logged in to vote.



 4. Click the Update link.

Setting Survey Results as Public or Private 
How to set the survey results as public to all users authorized to view the module or private for Administrators only.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Survey Settings tab. 

 3. At Survey Results, select Public or Private as required.

 4. Click the Update link.



Modifying the Survey Result Template 
How to modify the template which defines the content, layout and style of survey results in the Survey module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Survey Settings tab. 

 3. In the Survey Results Template text box, edit the HTML as desired.

 4. Click the Update link.

List of the Survey Template Tokens 
The list of the replacement tokens for the survey results template of the Survey module.

Token  Description
[SURVEY_OPTION_NAME] Displays the name of each option.

[SURVEY_OPTION_VOTES] Displays the total number of votes for this option.

SURVEY_OPTION_IMAGEPATH] Sets the image path to the survey bar graphic

[SURVEY_OPTION_GRAPH_WIDTH] Enables the 'Maximum Bar Graph Width' setting

Exporting Survey Results Data 
How to export the votes of registered users submitted to the Survey module. Results are saved as a csv (comma separated values) file.



 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Survey Settings tab. 

 3. At Survey Results Data, click the Export Data link.

 4. Save the file to your computer as required.

Clearing Survey Results Data 
How to clear the existing votes on a Survey module. This allows you to restart the survey and is useful if you have been testing or dem-
onstrating the survey.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Select the Survey Settings tab. 

 3. At Clear Results Data, click the Clear link. The link is now disabled, indicating there are currently no existing results.



 4. Click the Update link.

Users Online
About the Users Online Module
The Users Online module displays a range of information about your portal users. 

Module Version:  05.01.00

Minimum DNN Version:  05.01.00

The module can be set to display one, two or three types of the user information called Membership, People Online and Online Now as 
detailed below:

Membership:

 l Latest: Displays the username of the latest user to register on the portal. 

 l New Today: Displays the number of users who registered today. 

 l New Yesterday: Displays the number of users who registered yesterday. 

 l Overall: Displays the total number of registered users for this portal.

People Online:



 l Visitors: Displays the number of unauthenticated users currently visiting the portal. 

 l Members: Displays the number of registered users currently visiting the portal. 

 l Total: Displays the total number of user currently visiting the portal.

Online Now: 

 n Displays the User Names of all members currently online.

The Users Online Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleUsersOnline/tabid/835/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/36/scope/threads/Default.aspx

 l Issue Tracker: http://dnnusersonline.codeplex.com/workitem/list/basic

Settings
Setting the Member Details
How to set the member details displayed in the Users Online module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.
 2. Select the Survey Settings tab. 

 3. At Show Membership, check  the check box to display the Membership section- OR - Uncheck  the check box to hide it.

 4. At Show People Online, check  the check box to display the People Online section- OR - Uncheck  the check box to hide it.

 5. At Show Users Online, check  the check box to display the Online Now section- OR - Uncheck  the check box to hide it.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleUsersOnline/tabid/835/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/36/scope/threads/Default.aspx
http://dnnusersonline.codeplex.com/workitem/list/basic


 6. Click the  Update link.

Vendors
About the Vendors Module
The Vendors module enables authorized users to create and manage vendor accounts, vendor banners and affiliate accounts. This 
Administration module can be deployed to any site page and provides users with view permissions can view  Vendor details and users 
with edit permissions can manage vendor accounts, banners and affiliate accounts. DNN comes with two Vendor directories: Site Ven-
dors and Host Vendors. 

Important. The Vendors module located on the Admin > Vendors page manages banners which are exclusive to that portal. The Ven-
dors module located on the Host > Vendors page manages banners which are available to all portals within this DNN installation.

Banner Advertising: Banner can be images, text or script. Each banner record records a number of statistics including tracking of clicks, 
views and impressions. Multiple banners can be added to each vendor and can be displayed on pages using the Banners module. 
"About the Banners Module".. They can also be displayed in a skin using the [BANNER] token which is controlled by Administrators ( See 
"Enabling/Disabling Banner Advertising" ).

Affiliate Referrals: The Vendors module can be set up to track commission for banner advertising on other portals and the commissions 
received for banner advertisement on the portal. 

The Vendors Module



All Users
Changing the Records per Page 
How to change the number of vendor records displayed on each page of the Vendors module. This is set to ten (10) by default and will 
return to ten (10) when the page is refreshed.

 1. At Records per Page, select the number of records to be displayed. Options are: 10, 25, 50, 100, or 250.

Setting the Number of Records Per Page

Filtering Vendors by Company Name 
How to filter vendor records by the first letter of the company name using the Vendors module.

 1. Click on the linked [letter of the alphabet] that corresponds with the first letter of required vendor name (company name). The cor-
responding vendor accounts are listed in alphabetical order.

Filtering Vendors by Name

Filtering Vendors by Unauthorized Vendors 
How to view all vendor accounts that have been set as unauthorized on the Vendors module. 

 1. Click the Unauthorized link. By default, the first ten (10) unauthorized vendor accounts will be listed in alphabetical order by 
name. Use the Pager Control to navigate to further records. 



Viewing Unauthorized Vendor Accounts Only

Searching Vendors by Company Name 
How to search for vendors by all or part of the beginning of their company name on the Vendors module. 

 1. In the Search text box, enter all or part of the Vendor's company name. 

 2. Select Name from the drop-down box. 

 3. Click the Search  button. This displays all matching vendor records.

Search for a Vendor by the Company Name

Searching Vendors by Email 
How to search for a vendor account by email address on the Vendors module. 



 1. In the Search text box, enter the vendor's full email address. 

 2. Select Email from the drop-down box. 

 3. Click the Search  button. This displays all exact matches.

Tip: You must enter the full and exact email address.

Searching for a Vendor by Email Address

Viewing All Vendor Accounts 
How to view all vendor accounts on the Vendors module.

 1. Click the All link. By default, the first ten (10) of all vendor accounts are listed in alphabetical order by vendor name.

Viewing All Vendor Accounts

Related Topics:

 l See "About the Pager"



Module Editors
Affiliate Accounts
About Vendor Affiliate Accounts
One or more affiliate accounts can be created for Vendors in the Vendors module. These accounts are used for tracking advertising of 
this site on other web sites. DNN generates the link for other web sites to use, so that it can track each time a visitor clicks through to the 
portal, from an advertising site, so that the difficulty in collecting information for commissions to be paid can be easily managed.

Adding an Affiliate Referral Account 
How to add affiliate referral account to a vendor in the Vendors module. This generates a link which affiliates can add to their web site. 
The number of clicks and acquisitions for the link is tracked within the Affiliate Referral module, permitting  the tracking of commission 
owing to the vendor.

 1. Locate the required vendor account by selecting a filter or by doing a search. 

 2. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page. 

 3.  Maximize  the Affiliate Referrals section. This displays any affiliate referral accounts associated with this vendor. 

 4. Click the Add New Affiliate link.  

 5. Optional. At Start Date, click the Calendar link and select a start date.

 6. Optional. At End Date, click the Calendar link and select an end date. 

 7. In the Cost Per Click ( CPC ) text box, enter the advertising charge. CPC is the commission paid to the vendor when a visitor is 
referred to your site. 

 8. In the Cost Per Acquisition ( CPA ) text box, enter the advertising charge. CPA is the commission paid to the vendor when a vis-
itor becomes a member of your site. 

 9. Click the Update link.

Adding an Affiliate Account

Related Topics:

 l See "Working with the Calendar"

Editing an Affiliate Referral Account 
How to edit the details of an affiliate referral account using the Vendors module. 

 1. Locate the required vendor account by selecting a filter or by doing a search. 

 2. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page. 



 3. Maximize  the Affiliate Referrals section. This displays any affiliate referral accounts associated with this vendor. 

 4. Click the Edit  button beside the required record.

 5. Edit fields as required. 

 6. Click the Update link.

Deleting an Affiliate Referral Account 
How to permanently delete an affiliate referral account from the Vendors module.

 1. Locate the required vendor account by selecting a filter or by doing a search. 

 2. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page. 

 3. Maximize  the Affiliate Referrals section. This displays any affiliate referral accounts associated with this vendor.

 4. Click the Edit  button beside the required record. 

 5. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 



 6. Click OK to confirm deletion.

Sending Notification of Affiliate Referral Account 
How to send an affiliate report email to an affiliate using the Vendors module.  The report provides details of the site they have been made 
an affiliate of and the URL link to be used.

 1. Locate the required vendor account by selecting a filter or by doing a search. 

 2. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page. 

 3.  Maximize  the Affiliate Referrals section. This displays any affiliate referral accounts associated with this vendor. 

 4. Click the Edit  button beside the required record. 

 5. Click the Send Notification link.

 6. Click the  Cancel link to return to the module.

Vendor Accounts
Adding a New Vendor
How to add a vendor account using the Vendors module. Note: Mandatory fields are indicated with an asterisk ( * ). Where a check box is 
displayed beside a field, uncheck  the check box to make the field optional - OR - Check  the check box to make the field mandatory.

 1. Select  Add New Vendor from the module actions menu- OR -Click the  Add New Vendor link. This opens the Edit Ven-
dors page. 

 2. In the Vendor Details section, complete all of these fields: 

 a. In the Company* text box, enter the company name of the vendor. 

 b. In the First Name* text box, enter the first name of the contact person for the vendor. 

 c. In the Last Name* text box, enter the last name of the contact person for the vendor. 

 d. In the Email Address* text box, enter the email address of the contact person listed above.

 4. Optional. In the Address Details section, complete the address details. Note: Address field names and required details may 
vary. 

 a. In the Street text box, enter the street part of the Vendor's address.  E.g. 10 Main Road 

 b. In the Unit # text box, enter the unit number.  E.g. Unit 6, or Suite 6, etc. 



 c. In the City text box, enter the Vendor's city. E.g. Melbourne 

 d. At Country, select the Vendor's country. 

 e. In the Region text box, enter the Region/State/Province of the Vendor - OR - select from the drop down list where 
available. (See Host > Lists for more details on creating regions for countries). 

 f. In the Postal Code text box, enter the Vendor's postal code. E.g. 31234 

 g. In the Telephone text box, enter the Vendor's telephone number.  E.g. +61 3 9421 6555 

 h. In the Cell text box, enter the Vendor's cell (mobile) number. E.g. 0400 100 100 

 i. In the Fax text box, enter the Vendor's facsimile number. E.g. + 61 3 9421 6444

 5. In the Other Details section, the following optional field is available: 

 a. In the Website text box, enter the Vendor's web site address. E.g. http://www.domain.com.

 6. Click the Update link.



Tip: Once a new vendor is created the following additional settings will be available vendor logo, authorization, classifications, banner 
advertising, and affiliate referrals.  To complete these additional fields, you must edit the vendor record.

Editing/Adding Vendor Account Details
How to edit existing details and add new details to a vendor account in the Vendors module. If the vendor account has just been created 
a logo field, additional settings are available.

 2. Locate the required vendor account by selecting a filter or doing a search. 

 3. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page. 

 4. Edit any of the below fields as required. 



 5. In the Vendor Details section, edit any of the required fields. 

 6. In the Address Details section, edit/complete any the address fields.              

 7. In the Other Details section, edit/complete any of the following optional fields: 

 a. In the Website text box, enter the Vendor's web site address. E.g. www.domain.com 

 b. At Logo, select or upload a logo for this vendor. See the Common Tools > Link Control section for more details. 

 c. At Authorized, check  the check box if the vendor account is authorized- OR - Uncheck  the check box if the vendor 
account is not authorized. This setting enables Administrator(s) to easily identify unauthorized vendors however it does-
n't prevent current banners from displaying in the Banners module.

 9. Maximize  the Vendor Classification section to access these fields which are not implemented: 

 l In the Classifications box, define the classifications for the Vendor. This setting is not currently enabled. 

 l In Key Words text box, enter key words for the Vendor.

 10. Click the Update link.





Editing a Vendor Account

Authorizing/Unauthorizing a Vendor Account
How to authorize or unauthorized a vendor account using the Vendors module.

 1. Locate the required vendor account by selecting a filter or doing a search - OR - Click the Unauthorized link to view all unauthor-
ized vendor accounts. 

 2. Click the Edit  button beside the vendor.

 3. Go to the Other Details section.

 4. At Authorized, check  the check box to authorize the account - OR - uncheck  the check box to unauthorize the account. 

 5. Click the Update link.

Authorizing a Vendor Account

Deleting a Vendor Account 
How to permanently delete a vendor account from the Vendors module.

 1. Locate the required vendor account. 

 2. Click the Edit  button beside the required vendor. 

 3. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 



 4. Click the OK button to confirm deletion.

Deleting all Unauthorized Vendors
How to permanently delete all unauthorized vendors from the Vendors module. Deleting a vendor does not delete any related Vendor 
banner for the File Manager, however the banners will no longer be displayed in the banners module.

 1. Optional. Click the Unauthorized link to view unauthorized vendor accounts before deleting them. 

 2. Click the Delete Unauthorized Vendors link. This displays the  message "Are You Sure You Wish To Delete These Items?"

 3. Click the OK button to confirm.



Deleting all Unauthorized Vendors

Vendor Banners
Adding an Image Banner to a Vendor
How to add an image banner to a vendor account using the Vendors module.

 1. Locate the required vendor account by using a filter or by searching. 

 2. Click the Edit  button beside the required Vendor. This opens the Edit Vendor page. 

 3. Maximize  the Banner Advertising section. This displays all banners associated with this vendor. 

 4. Click the Add New Banner link. This displays the Edit Banners page.

 5. In the Banner Name text box, enter a name for this banner. If the Text/Script field below is left blank then the Banner Name is the 
alternate text for the banner. 

 6. At Banner Type, select either Banner, MicroButton, Button, Block, or Skyscraper. 

 7. Optional. In the Banner Group text box, enter a name to group this banner with other banners. The banner group can then be 
entered into the banners module to set it to only display banners in this group. 

 8. At Image/Link, select the image for this banner. See "Setting a File Link".

 9. Complete any of the following optional settings - OR - Skip to Step 11.   

 a. In the Text/Script text box, enter the text of the banner. This is the alternate text for this banner and is displayed when a 
user places their mouse over this image. 

 b. At URL, select one of the following options: 

 l Select URL ( A Link To An External Resource ) and leave the text box empty. This sets the link to the Ven-
dors web site. 



 l Select URL ( A Link To An External Resource ) and enter the URL user will be taken to when they click on 
the banner name. This URL is also displayed below the banner.

 l Select Page (A Page On Your Site ) and select the page users are taken to when they click on this banner. 

 l Select File (A File On Your Site ) and select the file to be displayed when a user clicks on this banner. 

 c. In the CPM/Cost text box, enter the cost per 1000 Impressions or the once off cost. E.g. For every 1000 impressions of 
the banner the Vendor will charge the listed amount. Alternatively, the vendor may charge a flat fee for banner adver-
tising. 

 d. In the Impressions text box, enter the number of impressions the banner will display for. A impression is made each 
time a banner is displayed on the page. 

 e. At Start Date, click the Calendar link and select the first date the banner will be displayed.

 f. At End Date, click the Calendar link and select the last date the banner will be displayed.

 g. At Criteria, select one of the following options: 

 i. And: Banner only expires if both the Impressions and the End Date has been met.  I.e. The banner has 
reached its number of clicks AND a banner has expired. 

 ii. Or: Banner expires if either the Impressions or the End Date has been met. I.e. The banner has reached its 
number of clicks or it has expired. 

 10. Click the Update link. This returns you to the Edit Vendor page.





 11. Optional. To view a preview of the newly added banner:

 a. Maximize  the Banner Advertising section.

 b. Click the Edit  button beside the new banner. This opens the Edit Banner page which displays a preview of the banner.

Previewing a newly added image banner

Related Topics:

 l See "Working with the Calendar"

Adding a Text Banner to a Vendor 
How to add a text banner to a vendor account using the Vendors module.

 1. Click the Edit  button beside the required Vendor. This opens the Edit Vendor page. 

 2. Maximize  the Banner Advertising section. This displays all banners associated with this vendor. 

 3. Click the Add New Banner link. This opens the Edit Banner page. 

 4. In the Banner Name text box, enter the text to be displayed at the top of this banner. This text is displayed as a link to the ven-
dor's web site or to the URL, Page or File as set at the URL field below. 

 5. At Banner Type, select Text. 

 6. Optional. In the Banner Group text box, enter a name to group this banner with other banners. The banner group can then be 
entered into the banners module to set it to only display banners in this group. 



 7. Optional. At Image/Link, select an image to be associated with this banner. The image isn't displayed on the banner, instead the 
image name is displayed as a link to view the image. You can also select URL to add a link to an image, file or page. The 
full URL will be displayed on the text banner. "About the Link Control". section for more details on setting links. 

 8. In the Text/Script text box, enter the text of the banner. HTML formatting can be used.

 9. Complete any of the following Optional settings - OR - Skip to Step 10.

 a. At URL, select one of the following options: 

 l Select URL ( A Link To An External Resource ) and leave the text box empty. This sets the link to the Ven-
dor's web site. 

 l Select URL ( A Link To An External Resource ) and enter the URL users go to when they click on the banner 
name. This URL also displays at the bottom of the banner. 

 l Select Page (A Page On Your Site ) and select the page users go to when they click on the banner name. The 
page number is also displayed at the bottom of the banner. E.g. 85 

 l Select File (A File On Your Site ) and select the file the user go to when they click on the banner name. The 
file ID number is also displayed at the bottom of the banner. E.g. FileID=148.

 b. In the CPM/Cost text box, enter the cost per 1000 Impressions or the once off cost. E.g. For every 1000 impressions of 
the banner the vendor will charge the listed amount. Alternatively, the Vendor may charge a flat fee for banner adver-
tising. 

 c. In the Impressions text box, enter the number of impressions the banner will display for. 

 d. At Start Date, click the Calendar link and select the first date the banner is displayed. 

 e. At End Date, click the Calendar link and select the last date the banner is displayed. 

 f. At Criteria, select one of the following options: 

 l And: Banner only expires if both the Impressions and the End Date has been met.  I.e. The banner has 
reached its number of clicks AND a banner has expired. 

 l Or: Banner expires if either the Impressions or the End Date has been met. I.e. The banner has reached its 
number of clicks OR the banner has expired.





 10. Click the Update link.

Text Banner (with a one pixel border)

Related Topics:

 l See "Working with the Calendar"

Adding a Script Banner to a Vendor
How to add a JavaScript banner to a vendor account using the Vendors module.

 1. Locate the required vendor account by using a filter or by searching. 

 2. Click the Edit  button beside the required Vendor. This opens the Edit Vendor page. 

 3. Maximize  the Banner Advertising section. This displays all banners associated with this vendor. 

 4. Click the Add New Banner link. This displays the Edit Banner page.

 5. In the Banner Name text box, enter a name for this banner.

 6. At Banner Type, select Script. 

 7. Optional. In the Banner Group text box, enter a name to group this banner with other banners. The banner group can then be 
entered into the banners module to set it to only display banners in this group. 

 8. In the Text/Script text box, enter the script for this banner.

 9. Complete any of the following Optional settings - OR - Skip to Step 10.

 a. At URL, select one of the following options: 

 l Select URL ( A Link To An External Resource ) and leave the text box empty. This sets the link to the Ven-
dors web site. 

 l Select URL ( A Link To An External Resource ) and enter the URL user will be taken to when they click on 
the banner name. This URL is also displayed below the banner.

 l Select Page (A Page On Your Site ) and select the page users are taken to when they click on this banner. 

 l Select File (A File On Your Site ) and select the file to be displayed when a user clicks on this banner. 



 b. In the CPM/Cost text box, enter the cost per 1000 Impressions or the once off cost. E.g. For every 1000 impressions of 
the banner the Vendor will charge the listed amount. Alternatively, the vendor may charge a flat fee for banner adver-
tising. 

 c. In the Impressions text box, enter the number of impressions the banner will display for. A impression is made each 
time a banner is displayed on the page. 

 d. At Start Date, click the Calendar link and select the first date the banner will be displayed.

 e. At End Date, click the Calendar link and select the last date the banner will be displayed.

 f. At Criteria, select one of the following options: 

 i. And: Banner only expires if both the Impressions and the End Date has been met.  I.e. The banner has 
reached its number of clicks AND a banner has expired. 

 ii. Or: Banner expires if either the Impressions or the End Date has been met. I.e. The banner has reached its 
number of clicks OR the banner has expired. 

 10. Click the Update link. This returns you to the Edit Vendor page.

 11. Optional. To view a preview of the newly added banner:

 a. Maximize  the Banner Advertising section.

 b. Click the Edit  button beside the new banner. This opens the Edit Banner page which displays a preview of the banner.

Related Topics:

 l See "Working with the Calendar"

Editing a Vendor Banner
How to edit the properties of a banner using the Vendors module.

 1. Locate the required vendor account by selecting a filter or doing a search. 

 2. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page.

 3.  Maximize  the Banner Advertising section. This displays all banners associated with this vendor. 

 4. Click the Edit  button beside the banner to be edited.

 5. Edit the required fields. 

 6. Click the Update link.

Deleting a Vendor Banner 
How to edit the properties of a banner using the Vendors module.



 1. Locate the required vendor account by selecting a filter or doing a search. 

 2. Click the Edit  button beside the required vendor account. This opens the Edit Vendors page.

 3. Maximize  the Banner Advertising section. This displays all banners associated with this vendor. 

 4. Click the Edit  button beside the banner to be deleted.

 5. Click the Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 6. Click the OK button to confirm.

Viewing the Clicks and Views for a Banner
How to view the number of times a banner has been viewed and clicked using the Vendors module. 

 1. Locate the required vendor account by using a filter or by searching. 

 2. Click the Edit  button beside the required Vendor. This opens the Edit Vendor page. 

 3. Maximize  the Banner Advertising section. This displays all banners associated with this vendor including: 

 l Views: The number of time a banner has been clicked on. 

 l Clicks: The number of times a banner has been displayed on a page.

Viewing Banner Views and Clicks 

Emailing Banner Status to Vendor 
How to send a banner status report to the related vendor using the Vendors module. The report contains the following information: 
Banner Name, Banner Description, Image Name, Number of CPM/Cost, Number of Impressions, Start Date, End Date, Number of Views, 
and Number of Click Through's.

 1. Click the Edit  button beside the required Vendor. This opens the Edit Vendor page. 

 2. Maximize  the Banner Advertising section. This displays all banners associated with this vendor. 

 3. Click the Edit  button beside the required banner. 



 4. Click the Email Status to Vendor link at the base of the module. A success or failure message is displayed at top of the module 
letting you know if the email sent successfully. 

 5. Click the  Cancel link to return to the module.

View Profile
About the View Profile Module
The View Profile  module (also called My Profile) enables users to manage their user credentials,  password, profile and subscriptions to 
services. The module is accessed by clicking on your display name (the name you chose to be displayed to you and to others on the web 
site) which is typically located in the top right hand corner of the web site.

Module Version: 01.00.00. Note: The version number for this module does not update as it forms part of the DNN framework.

Related Topics:

 l See "Managing your User Profile"

 l See "Subscribing to a Member Service"

 
The View Profile or My Profile module

Whats New
About the What's New Module
The What's New module displays a summary of the major features for each release including lists of the Major Highlights, Security Fixes, 
and Updated Modules/Providers.

Module Version: 03.03.00



The What's New Module

Project Links

 l Project Home: http://dnnwhatsnew.codeplex.com/

 l Issue Tracker: http://dnnwhatsnew.codeplex.com/workitem/list/basic

http://dnnwhatsnew.codeplex.com/
http://dnnwhatsnew.codeplex.com/workitem/list/basic


Wiki
About the Wiki Module
The Wiki module enables authorized users to create and manage a Wiki web site. Wiki's are designed to enable multiple contributors to 
build a community based information resource. Contributors add new content and update existing information to  progressively enrich the 
caliber of the content. Wiki's are typically accessible to anonymous contributors however the usual security levels can be set on this Wiki.

Each Wiki topic is a Wiki page. Links between pages are created by adding a link the topic name. This Wiki includes searching, version 
history, comments and ratings.

Important. It is recommended that the module is configured prior to use.

Module Version: 04.05.00

Minimum DNN Version: 05.06.02

The Wiki Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleWiki/tabid/848/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/70/scope/threads/Default.aspx

 l Issue Tracker: http://dnnwiki.codeplex.com/workitem/list/basic

Configuration
Configuring Wiki Editing Permissions
How to configure editing permissions for the Wiki module. You can use either the standard module permissions as set on the Module Set-
tings page, or create a unique set of editing permissions. Note: Only Administrators and SuperUsers can access manage configuration.

 1. Select  Configuration from the Wiki module actions menu. 

 2. Go to the Security Settings section.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleWiki/tabid/848/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/70/scope/threads/Default.aspx
http://dnnwiki.codeplex.com/workitem/list/basic


 3. At Use DotNetNuke Security for edit content permissions, select from these options:

 l Check  the check box to use the standard module permissions. See "Setting Module Permissions".

 l Uncheck  the check box to create custom permissions as follows:

 o To assign a role as an editor, click on the role name in the Available list and click the Add selected Available 
Item to Assigned > link.

 o To remove a role as an editor, click on the role name in the Assigned list and click the Remove 
selected Assigned Item < link. 

 o To assign all roles as editors, click the Add All selected Available Items to Assigned >> link. 

 o To remove all roles as editors, click the Remove All Assigned Items >> link.



 4. Click the Save link.

Configuring Notification Settings
How to enable user groups to receive notification when a page is updated on the Wiki module.

 1. Select Configuration from the Wiki module actions menu.

 2. Go to the Notification Settings section and select from these options:

 l To enable typical notifications:

 o Optional. At Enable Notifications for Edit roles? check  the check box to notify all roles who are authorized to 
edit the Wiki.

 o Optional. At Enable Notifications for View roles? check  the check box to notify all roles who are authorized to 
view the Wiki.



 l At Enable Notifications for custom roles? check  the check box to create custom permissions and set as follows:

 n To assign a role as an editor, click on the role name in the Available list and click the Add selected Available 
Item to Assigned > link.

 n To remove a role as an editor, click on the role name in the Assigned list and click the Remove 
selected Assigned Item < link. 

 n To assign all roles as editors, click the Add All selected Available Items to Assigned >> link. 

 n To remove all roles as editors, click the Remove All Assigned Items >> link.



 3. Click the Save link. 

Enabling Comments on All Wiki Pages
How to enable  comments to be added to all pages of the Wiki module. Note: When adding or edit a Wiki page, the editor will still have the 
option of disabling comments for that page.

 1. Select Configuration from the Wiki module actions menu.

 2. Go to the Comment Settings section.

 3. At Allow Page Comments, check  the check box.

 4. At Activate comments on all pages after settings are saved!, check  the check box to enable comments to be added to all 
pages.



 5. Optional. At Enable comments by default in add topic control, check  the check box to pre-select the "Enable Page Com-
ments" field when adding a new page.

 6. Optional. At Enable Notifications for User Comments? check  the check box if you want to send a notification message 
when a comment is added. Notifications will be sent to role as set in the Notification Settings section. See "Configuring Noti-
fication Settings"

 7. Click the Save link.

Allowing Wiki Comments for Individual Pages
How to allow users to add comments to one or more pages of the Wiki module. This setting enables the "Enable Page Comments" field 
on the Add Wiki Topic page, enabling you to enable or disable rating for individual pages when adding or editing a page.

 1. Select  Configuration from the Wiki module actions menu.

 2. Go to the Comment Settings section.

 3. At Allow Page Comments, check  the check box. 



 4. At Activate comments on all pages after settings are saved!, uncheck  the check box.

 5. At Enable comments by default in add topic control, select from these options:

 l Check  the check box to pre-select the "Enable Page Comments" field on both existing and new pages.

 l Uncheck  the check box to deselect the "Enable Page Comments" field when adding a new page. This will not change 
this setting on existing pages. Selecting this option will require you to enable comments for individual pages. See "Ena-
bling Comments on Individual Wiki Pages"

 6. Optional. At Enable Notifications for User Comments? check  the check box if you want to send a notification message 
when a comment is added. Notifications will be sent to role as set in the Notification Settings section. See "Configuring Noti-
fication Settings"

 7. Click the Save link. 

Enabling Comments on Individual Wiki Pages
How to enable comments on an existing page  of the Wiki module. This tutorial assumes comments have been allowed for this Wiki, See 
"Allowing Wiki Comments for Individual Pages"

 1. Navigate to the required page. See "Navigating the Wiki"

 2. Click the Edit Wiki Topic link.

 3. At Enable Page Comments, check  the check box. 

 4. Click the Save link.



 5. Repeat Steps 6-8 to enable comments on other pages.

Disabling Comments on Individual Wiki Pages
How to disable comments from being added to one or more pages of the Wiki module. Note: This tutorial requires comments to be ena-
bled for single Wiki pages.



 1. Navigate to a page where you want to disable comments. 

 2. Click the Edit link. 

 3. At Enable Page Comments, uncheck  the check box. 



 4. Click the Save link.

 5. Repeat Steps 1-4 to disable comments on other pages.

Enabling Ratings on All Wiki Pages
How to enable users to add ratings to all pages of the Wiki module.

 1. Select  Configuration from the Wiki module actions menu.

 2. Go to the Rating Settings section.

 3. At Allow Page Ratings, check  the check box.

 4. Click the Save link.

 5. Select  Configuration from the Wiki module actions menu.

 6. Go to the Rating Settings section.

 7. At Activate ratings on all pages after settings are saved!, check  the check box to enable comments to be added to all 
pages.

 8. Optional. At Enable ratings by default in add topic control, check  the check box to pre-select the Enable Page Comments 
field when adding a new page.



 9. Click the Save link.

Disabling Ratings on All Wiki Pages
How to prevent users from adding rating on all pages of the Wiki module. This hides any existing rating but doesn't delete them. If ratings 
are enabled again in the future, the existing rating will be restored.

 1. Select  Configuration from the Wiki module actions menu.

 2. Go to the Rating Settings section.

 3. At Allow Page Ratings, uncheck  the check box.



 4. Click the Save link.

Allowing Wiki Ratings for Individual Pages
How to allow users to add ratings to one or more pages of the Wiki module. This setting enables the "Enable Page Ratings" field on the 
Add Wiki Topic page, enabling you to enable or disable rating for individual pages when adding or editing a page.

 1. Select  Configuration from the Wiki module actions menu.

 2. Go to the Rating Settings section.

 3. At Allow Page Ratings, check  the check box.



 4. Click the Save link.

 5. Complete the following additional steps to pre-select the Enable Page Comments field when adding a new page.

 6. Select  Configuration from the Wiki module actions menu.

 7. Go to the Rating Settings section.

 8. At Activate ratings on all pages after settings are saved!, uncheck  the check box.

 9. At Enable ratings by default in add topic control, select from these options:

 l Check  the check box to pre-select the "Enable Page Ratings" field on both existing and new pages.

 l Uncheck  the check box to deselect the "Enable Page Ratings" field when adding a new page. This will not change 
this setting on existing pages. Selecting this option will require you to enable rating for individual pages. See "Enabling 
Ratings for an Existing Wiki Page"

 10. Click the Save link.

Enabling Ratings for an Existing Wiki Page
How to enable ratings on an existing page  of the Wiki module. This tutorial assumes ratings have been allowed for this Wiki, See "Allow-
ing Wiki Ratings for Individual Pages"

 1. Edit an existing (See "Editing a Wiki Page")

 2. At Enable Page Ratings, check  the check box. 

 3. Repeat Steps 1-2 to enable ratings on additional pages.

Disabling Ratings on Individual Wiki Pages
How to disable rating from being added to one or more pages of the Wiki module. This task assumes ratings have been enabled for 
individual pages. This task can also be performed when adding a new page.



 1. Navigate to a page where you want to disable ratings. 

 2. Click the Edit link. 

 3. At Enable Page Ratings, uncheck  the check box. 

 4. Click the Save link.

 5. Repeat Steps 1-4 to disable ratings on other pages.

All Users
Go to Wiki Home
How to go to the Home page of a Wiki module.

 1. Click the  Home link.

Go to Wiki Home Page

Navigating the Wiki
How to navigate to all pages and locate topics within the Wiki module.

Viewing all Wiki Pages

 l Click the  Show All Pages link to display links to all Wiki pages. Click on a link to visit that page.



Navigating the Wiki Module

Locating Wiki Topics without Pages

 1. Navigate to the page which has a link to the topic.

 2. Click on the [Topic Name] link.

Searching the Wiki
How to search the Wiki module. Searches return results for all or part of the search criteria.

 1. Click the  Search link. 



 2. In the Search text box, enter your search criteria. 

 3. Click the Go link. This displays the search results below.

 4. To visit a page, click on the linked page name in the Topic column.

Viewing Comments
How to view the comment added to a Wiki page. Note: Comments may be disabled.



 1. Navigate to the required page. See "Navigating the Wiki"

 2. If required, Maximize  the Comments section.

All comments for this page are displayed in the            Comments section.

Tip: You can send an email to the person who posted a comment by clicking on their name which is displayed above their comment.

Viewing Ratings
How to view the average rating and total number of ratings for a page in the Wiki module. Note: Ratings may be disabled on some or all 
pages.

 1. Navigate to the required page. See "Navigating the Wiki" 

 2. Click on the required page name. The average rating tally is displayed in the top right corner of the module. E.g. 2 blue bars indi-
cates an average rating of 2 out of a total of 5.

 3. Maximize  the Rating section (if required) to view the number of ratings included in the tally.



Viewing Page Ratings

Viewing Recent Changes
How to view recent changes to a Wiki module.

 1. Click the  Recent Changes link. This displays all recent changes.



 2. Optional. Click one of the following links to filter recent changes by that time period: 

 l Last 24 Hours

 l Last 7 Days

 l Last Month

Viewing Topic History
How to view the history of the changes made to a page in the Wiki module.

 1. Navigate to the required page. See "Navigating the Wiki"

 2. Click the View Topic History link. This displays the History for this page.



 3. In the Topic column, click on any version to view the content of that version.

 4. Click the << Back to return to the History.

 5. Repeat Steps 3-4 to view other versions.

Adding a Comment
How to add a comment to a Wiki page. Note: Commenting may not be available on some or all pages.

 1. Navigate to the required page. See "Navigating the Wiki" 

 2. In the Comments section, click the Add Comment link.

 3. Unauthenticated Users Only, complete these fields: 

 a. In the Name text box, enter your name. 

 b. In the Email text box, enter your email address.

 4. In the Comments text box, enter your comment.



 5. Optional. Check  the Subscribe to E-Mail Notifications check box to be notified of updates to this Wiki page.

 6. Click the Post Comment link. This displays the comment including the date and time it was posted in the Comments section.



The newly added Comment

Adding a Rating
How to rate the content of  a Wiki page. Users are restricted to one rating per page which is tracked by computer using a cookie. Note: Rat-
ings may be disabled on some or all pages.

 1. Navigate to the required page. See "Navigating the Wiki"

 2. In the Rating section, click inside one of the five radio boxes to select your rating from one to five where one is poor and five is 
great.



 3. Click the Rate Content link. Your rating is now added to the rating tally and a message reading "Thank you for rating this Page!" 
is displayed.



The Rating Thank You Page

Module Editors
Adding a Wiki Page
How to add a new page to a Wiki module. Note: Page Name is the only required field. This allows you to create pages and then add con-
tent at a later stage.

 1. Click the Add Wiki Topic link.



 2. In the Page Name text box, enter the name for the new page. Note: The page name appears in the Wiki Index using the cap-
italization entered here. E.g. EcoZany will create a page titled "EcoZany". Note: A maximum of 50 characters is permitted.

 3. Optional.    Maximize  the Page Search Engine Optimization section.

 a. In the Title text box, enter a title to be displayed on this Wiki page as well as in the browser title for this page. Note: A 
maximum of 256 characters is permitted.

 b. In the Description text box, enter a description to be  used in the Meta-Description tag for the HTML of the page where 
this module is located.  Note: A maximum of 500 characters is permitted.

 c. In the Keywords text box, enter a description to be  used in the Meta-Description tag for the HTML of the page where 
this module is located.  Note: A maximum of 500 characters is permitted.

 4. In the Editor, enter the page content. Note: When you create a link to a page which does not yet exist, the page will not appear 
in the Wiki Index until content is added to it. For details on adding page links, Maximize  the Wiki Text Directions section.

 5. Optional. Check  the Enable Page Comments check box to enable users to post comments to this page.

 6. Optional. Check  the Enable Page Ratings check box to enable users to rate this page.

 7. Optional. Click the Save & Continue link to save the details entered so far and immediately continue adding content.

 8. Click the Save link.



Adding Content to a Topic
How to add content to a topic which has been created as a link on another Wiki page but has not yet had content created. These topics 
don't have an associated Wiki Page, and are therefore not displayed in the Show All Pages list.

Option One:

 1. Navigate to the page which has a link to the topic (See "Navigating the Wiki").

 2. Click on the [Topic Name] link.

 3. Complete Steps 2 onwards in "Adding a Wiki Page".

Option Two:

You can also simply add a Wiki page (See "Adding a Wiki Page"), however you need to ensure the spelling of the Page Name is exactly 
the same as linked Topic Name.

Editing a Wiki Page
How to edit the content of a Wiki page or add content to an existing page which has no content. 

Important. To add content to the  Home page of your Wiki, you must add a new page ( See "Adding a Wiki Page" ) with the Page 
Name WikiHomePage. Once this has been done the first time, the Edit Wiki Topic link will be visible on the Home page.

 1. Navigate to or search for the required page. See "Navigating the Wiki" or           "Searching the Wiki".

 2. Click the Edit Wiki Topic link.



 3. In the Editor, add or edit page content. 

 4. Optional. Click the Save & Continue link to save your changes to date and continue editing.

 5. Click the Save link to save and view the edited page.

Restoring Previous Version
How to restore a previous version of a Wiki page to make it the current page visible in the Wiki module.

 1. Locate the previous version to be restored. See "Viewing Topic History"

 2. When you are viewing the version you want to restore, click the Restore link.           

Restoring Previous Page Version



Deleting a Wiki Page
How to delete the content from a Wiki page including the page history from the Wiki module. Note: Links to the page which exist on other 
pages are not deleted.

 1. Navigate to the required Wiki page. See "Setting the Wiki Index"

 2. Click the Edit Wiki Topic link.

 3. Click the Delete link.

Tip: The Home page cannot be deleted.

Deleting a Comment
How to delete a comment from a Wiki page.



 1. Navigate to the required page. See "Navigating the Wiki"

 2. Maximize  the               Comments section.

 3. Click the Delete Comment link.

XML
About the XML/XSL Module 
The XML/XSL module displays the result of an XML/XSL transform. By combining the transformation language of XSL (Extensible Style 
Sheet Language) to the data contained in an XML (Extensible Markup Language) document, you can create multiple output formats from 



the same XML document. For example you can have an XSL document that will transform an XML document into HTML, PDF, Word and 
many other formats.

Module Version: 04.03.05

Minimum DNN Version: 04.03.05

 
The XML/XSL Module

Project Links

 l Project Home: http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleXML/tabid/836/Default.aspx

 l Support Forum: http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/59/scope/threads/Default.aspx

 l Issue Tracker: http://dnnxml.codeplex.com/workitem/list/basic

Module Editors
Adding a Basic XML/XSL Transformation 
How to add an XML/XSL transformation to the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Go to the XML Data Source Settings section. 

 3. At Link Type, set the link control to the XML file. 

 4. Go to the XSL Transformation Settings section. 

 5. At Link Type, set the link control to the XSL file. 

 6. Click the Update link.

http://www.dotnetnuke.com/Community/ExtensionsForge/ModuleXML/tabid/836/Default.aspx
http://www.dotnetnuke.com/Resources/Forums/tabid/795/forumid/59/scope/threads/Default.aspx
http://dnnxml.codeplex.com/workitem/list/basic




Setting a basic XML/XSL transformation

Adding an XML/XSL Transformation (All Settings) 
How to set all of the settings available for an XML/XSL transformation on the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Go to the XML Data Source Settings section. 

 3. At Link Type, set the link to the XML file. 

 4. The following optional settings are also available: 

 a. Maximize  the Querystring Parameters section and set the following: 

 i. Click the Add Parameter link. 

 ii. In the Name text box, enter a name for this querystring parameter. 

 iii. At Required, check  the check box if this parameter is required or uncheck  it if this parameter is optional. 

 iv. At Data Origin, select a value from the drop-down box. 

 v. Click the Save  button. 

 vi. Optional. To add a fallback parameter, complete the following steps: 

 1. Click the Edit  button. 

 2. Enter the fallback value in the text box to the left. 

 3. Click the Save  button. 

 b. Maximize  the Querystring URL Encoding section and set the following for services that use a different type of 
encoding: 

 i. ASCII 

 ii. Windows Default 

 iii. UTF 8 (this is the default setting and most commonly required)

 c. Maximize  the Security Options (optional) section and set the following optional settings: 

 i. In the Domain\username text box, enter the domain name or username given to you by the service provider. 

 ii. In the Password text box, enter the password given to you by the service provider.

 5. Go to the XML Data Source Settings section. 

 6. At Link Type, set the link to the XSL file. 

 7. Maximize  the XSL Parameters section and set the following: 

 a. Click the Add Parameter link. 

 b. In the Name text box, enter a name for this XSL parameter. 



 c. At Data Origin, select a value from the drop-down box. 

 d. Click the Save  button.

 8. Click the Update link.

Tip: The URL Query string parameters allow you to pass data to the URL that is producing the XML.  The source of the XML does not 
need to be an XML file it could be a dynamic page that takes in the parameters and process them and produces an XML output.  The 
security settings allow you access secure services that provide XML such as weather or stock prices services.

Enabling/Disabling XML Search Indexing 
How to enable or disable the DNN Search for the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Maximize  the Advanced Options section. 

 3. At Allow Indexing, select one of the following search options to set how often this module is updated in search: 

 l Never (search is disabled) 

 l Only on next run 

 l Always 

 l Once per hour

 l Once per day

 4. Click the Update link.

Clearing XML Search Index 
How to clear cached data from the DNN Search for the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Maximize  the Advanced Options section. 

 3. Go to the Allow Indexing section. 

 4. Click the Clear Search Index link.



Clearing Search Index

Setting the Required Querystring Parameter/ Value Pair 
Setting these options will stop the module executing unless the querystring parameter set in the XML Data Source section matches 
exactly.  You can use this feature for example to only show the content to users in a particular locale by setting the query string parameter 
Name to locale and the Data origin to User's Locale.  Then in the defined querystring section set Querystring Param to locale and 
set Querystring Value =  en-US, this will then only show the content to users from the US.

How to set a defined querystring parameter/value pair that is required for the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Maximize  the Advanced Options section. 

 3. In the Querystring Param text box, enter the querystring parameter. 

 4. In the Querystring Value text box, enter the querystring value. 

 5. Click the Update link.

Clearing/Disabling Required Querystring Parameter/Value Pair 
How to clear or disable a defined querystring parameter/value pair that is required for the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Maximize  the Advanced Options section. 

 3. Click the Clear/Disable link.

Editing a Querystring Parameter 
How to edit a querystring parameter that has been added to an XML/XSL transformation on the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Go to the XML Data Source Settings section. 

 3. Maximize  the Querystring Parameters section. 

 4. Click the Edit  button beside the parameter to be edited. 

 5. Edit one or more settings as required. 

 6. Click the Save  button.



Deleting a Querystring Parameter 
How to permanently delete a querystring parameter from an XML/XSL transformation on the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Go to the XML Data Source Settings section. 

 3. Maximize  the Querystring Parameters section. 

 4. Click the Edit  button beside the parameter to be deleted. 

 5. Click the Delete  button. This displays the  message "Are you sure you want to remove this item from the data store? Once 
removed it cannot be retrieved."

 6. Click the OK button.

Editing a XSL Parameter 
How to edit a XSL parameter that has been added to an XML/XSL transformation on the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Go to the XSL Transformation Settings section. 

 3. Maximize  the XSL Parameters section. 

 4. Click the Edit  button beside the parameter to be edited. 

 5. Edit one or more settings as required. 

 6. Click the Save  button.

Deleting a XSL Parameter 
How to permanently delete a XSL parameter from an XML/XSL transformation on the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Go to the XSL Transformation Settings section. 

 3. Maximize  the XSL Parameters section. 

 4. Click the Edit  button beside the parameter to be deleted. 

 5. Click the Delete  button. This displays the  message "Are you sure you want to remove this item from the data store? Once 
removed it cannot be retrieved."    

 6. Click the OK button.

Setting XML Rendering Output 
How to set the rendering output for the XML/XSL module.

 1. Select Edit XML/XSL Options from the XML/XSL module actions menu. This opens the XML Module Configuration page. 

 2. Maximize  the Advanced Options section. 

 3. At Output, select one of the following output options: 



 l Inside Module: This renders the output to be viewed inside the module. This is the default option. 

 l As Link to a Download: This displays a Download link enabling users  to download the file. 

 l As Download: This renders the output as a downloadable file.

 4. At Content Type, select one of the following formats for the content: 

 l *.xml (text/xml) 

 l *.htm (text/html) 

 l *.csv (text.comma-separated-values

 l *.txt (text/plain)

 5. Click the Update link.



Advanced Site Management
Advanced Site Management
This section covers how to use Administration modules which provide advanced site management tools.

Sub-Sections Contents
Application Health Monitor database health, security, files and your web server.

Extensions Deploy modules to a site and set your sites authentication (log-in) method.

Logs View data logs from your site using the Log Viewer (See "About the Log Viewer Module" ) 
and Site Log ( See "About the Site Log Module" )

Multi Language Sites Manage installed modules and create module content in multiple languages.

Recycle Bin Restore pages and modules to your site.

Search Optimization Maximize your search engine results with these modules.

Users and Roles Add and manage user accounts and security roles.

 

Application Health
File Integrity Checker
About the File Integrity Checker Module
The File Integrity Checker module (Host > Professional Features > Application Integrity) provides a summary of the files on your site. This 
feature can detect files that have been modified since the install, files that are missing and files that are not included in the list of allow-
able file types. By keeping an eye on these categories you can ensure you do not have any malicious files that could cause problems on 
your site. Only available in DotNetNuke Professional Edition

Module Version: 06.00.00

Minimum DNN Version: 06.00.00

 l File Integrity Summary: Using the signature file included in the install, this section allows you to see which files have been mod-
ified or are missing. The file integrity summary will tell you if this signature file has been modified or not. If the File Integrity Data-
base has not been tampered with then all of the files in the unmodified section are in the same state as they were when the site 
was installed. 

 l Unmodified Files: The files that are listed in this section have not been modified since installing DNN professional. 

 l Modified Files: The list of files in this section is files that have been modified since installing DNN professional edition. Files in this 
section are not necessarily malicious, they could just be there because of customization changes you have made. 

 l Missing Files: The missing files section refers to files that are included in the default installation of DNN professional but are not 
in the section currently. Missing files could cause certain DNN features to work incorrectly, or not work at all. 

 l Other Files: The list of other files includes all of the files on your site with a file extension that is not in the list of allowable exten-
sions. Third party or custom modules may be included in this list but that does not mean they are malicious. Files in this list could 
contain executable code, and could be a potential security threat to your site.  It is important to monitor the files in this list for files 
that could be a threat to your site. 



Working with the File Integrity Checker Module
Health Monitoring
About the Health Monitoring Module
The Health Monitoring module  (Host > Professional Features > Health Monitoring) works in conjunction the DotNetNuke web site to 
ensure that your site is running correctly. Once your site has been configured through the DNN support network the "health" of your site is 
monitored using the DNN servers. 

The Health Monitoring service "pings" your site regularly to ensure it is online and sends you notification if it is not. Health monitoring also 
provides your site with a "Keep alive" service, if your site does not receive a high amount of traffic the regular pings will ensure that IIS 
does not unload your site from memory. By keeping your site in IIS's memory you will avoid long loading times when you site receives vis-
itors. Only available in DotNetNuke Professional Edition

Module Version: 06.00.00

Minimum DNN Version: 06.00.00

Configuring Health Monitoring 
How to configure the Health Monitoring Service for your portal.

 1. Sign in with the account you used when you purchased your copy of DNN professional. 

 2. Navigate to Host > Professional Features > Health Monitoring - OR - Go to a Health Monitoring module.

 3. Click the Configure Health Monitoring link. This opens the Health Monitoring page of the DNN Support Network.

 4. Click the Add Site link.

http://www.dotnetnuke.com/
http://www.dotnetnuke.com/
http://www.dotnetnuke.com/
http://www.dotnetnuke.com/
http://www.dotnetnuke.com/


 5. In the Site URL text box, enter the URL for your site.

 6. Click the Check URL link. This will verify that the URL you entered is running DNN Professional Edition and the domain name is 
correct.

 7. Optional. At Enable Monitoring,  check  the check box to enable  health monitoring on your site. 

 8. Optional. At Enable Notifications,  check  the check box to receive email notifications. These emails will be sent to the email 
entered for the account you purchased DNN professional with.

 9. Click the Update link to save these settings.

Viewing the Health Logs
The health logs provide you with the information that the Health Monitoring servers collected from your site, and will give you a clear idea 
of the current health of your site. Once your site has been configured with health monitoring you can access these logs through the 
Health Monitoring page on the DNN Support network, or through the link on you DNN pro sites' Health Monitoring page. 

 1. To view your sites health logs click on the icon next to the site URL. The health log for your site will now be displayed. The log will 
show you information about when it was pinged by the Health monitoring servers. For each time your site was pinged you will see 
the date and time it was checked, the time it took to respond and the status of that ping, you may also see a comment.



Viewing the Health Logs

Security Center
About the Security Center Module
The Security Center module (Host > Professional Features > Security Center) dynamically loads a list of any known security vul-
nerabilities affecting the version of DNN application you are running. It also provides you with navigational guidance to acquire the latest 
upgrade. Only available in DotNetNuke Professional Edition

Module Version: 06.00.00

Minimum DNN Version: 06.00.00



The Security Center Module

Web Server Manager
About the Web Server Manager Module
The Manage Web Servers module  (Host > Professional Features > Manage Web Servers), also known as the Web Server Manager mod-
ule, is designed to help you manage your web servers easily. This administration module can be added to any site page and is also 
located under Host > Professional Features > Manage Web Servers. It allows users to view all the web servers that your site is currently 
using, edit the URL and disable/enable a server, view the memory usage for your servers, and select the caching provider that you are 
currently using. Only available in DotNetNuke Professional Edition

Module Version: 06.00.00

Minimum DNN Version: 06.00.00

The Manage Web Servers Module

Managing Cache Items
How to view the details of a cached item and optionally choose to expire the item. If you have a large number of objects in the cache this 
will take a bit longer. 

Only available in DotNetNuke Professional Edition

 1. Navigate to Host > Professional Features > Manage Web Servers.

 2. Expand the Memory Usage section. 

 3. Click the Load Cache Items link. This displays the Items list of active cache items.



 4. At Items, select an item. This displays the following information for the selected item:

 l Key: Displays the full cache key name of the item.

 l Value: Displays the value associated to the item.

 l Size: Displays the approximate size of the item.

 5. Optional. Click the Expire Cache Item link to expire this item from the cache.

 6. Repeat Steps 4-5 to view and optionally expire additional items.

Managing Your Web Server
How to set the URL for a server and set it as enabled or disabled. 

Only available in DotNetNuke Professional Edition

 1. Navigate to Host > Professional Features > Manage Web Servers.

 2. Expand the Servers section.

 3. Click the Edit [Server Name]  button. From here you will be able to edit the URL and optionally enable the server. 



 4. At URL, select a URL from the drop-down list. The URL's listed here are the portal aliases for your site. If you are using a web farm 
then the URL for each of your servers will be unique. The URL will identify each server, you may need to add these URL's to your 
list of portal aliases.

 5. At Enabled, check  the check box to enable the server - OR - Uncheck  the check box to disable it.

 6. Click the Save button.

Setting the Default Caching Provider
How to set the default caching provider for your web server.

Only available in DotNetNuke Professional Edition

 1. Navigate to Host > Professional Features > Manage Web Servers.

 2. Expand the Caching section.

 3. At Caching Provider, select the default caching provider from these options:

 l FileBasedCachingProvider

 l WebRequestCachingProvider



 4. Click the Save  button.

Viewing Memory Usage Information

The memory usage section of the page provides some information about how your server is using memory. Only available 
in DotNetNuke Professional Edition

 1. Navigate to Host > Professional Features > Manage Web Servers.

 2. Go to the Memory Usage section. The following information is listed:

 l Server: Displays the server name.

 l Memory Limit: Displays the maximum amount of memory that can be used by the application.

 l Private Bytes: Displays how much physical memory (in KB) is available to your application for caching.

 l Cache Objects: Displays the  number of cache objects that are in memory currently.



Viewing Memory Usage Information

Extensions
About the Extensions Module
The  Extensions module allows Administrators and authorized users to view and manage extensions which have been installed on the 
site by SuperUsers. This Admin module is located on the Admin > Extensions page and can be added to additional pages. The module 
displays a details of each extension and indicates which extensions are in use on this site.

Module Version: 06.00.00

Minimum DNN Version: 06.00.00



The Extensions Module (as displayed on the Admin page)

All Users
Viewing Extension Information
How to view details including a description and version number for all extensions installed on a site using the Extensions module.

 1. Using the Control Panel, go to the Admin >  Extensions page - OR - Navigate to an Extensions module.

 2. Select the Installed Extensions tab. Note: This tab should be pre-selected.

 3. Click on a extension type heading to view the associated extensions. Extensions types are: Authentication Systems, Containers, 
Core Language Packs, Dashboard Controls, Extension Language Packs, Libraries, Modules, Providers, Skins, Skin Objects and 
Widgets.



 4. A list of the extensions within the selected type are now displayed. Each record displays the extension icon, name, description 
and version number. For modules only, the In Use column displays a Yes or No statement if the module is or isn't in use on this 
site.



Related Topics:

 l "Viewing Added To Pages Module Settings".



Module Editors
Enabling/Disabling DNN Active Directory Authentication
How to enable or disable DNN Active Directory Authentication and configure the optional settings. This authentication system uses the 
Windows Active Directory authentication protocol to authenticate users.

 1. Go to an  Extensions module - OR - Navigate to Admin > Extensions.

 2. At   Filter by Type, select Authentication System from the drop-down box.

 3. Click the Edit  button beside DNN_ActiveDirectoryAuthentication.

 4. Go to the Extension Settings section.

 5. At Enabled?, select from these options:

 l Check  the check box to enable this authentication. 

 l Uncheck   the check box to disable. Skip to Step 9. 

 6. At Hide Login Controls?, select from these options:

 l Check  the check box to hide the Windows Login button on the Login screen. 

 l Uncheck   the check box to display the Windows Login button on the Login screen.                   

 7. At Synchronize Role?, select from these options:

 l Check  the check box to synchronize the user's role with the Windows Active Directory security group each time user 
logon. 

 l Uncheck   the check box to disable.                   

 8. At Do Not Automatically Create Users? select from these options:

 l Check  the check box to prevent Active Directory users from log into the DNN portal until an account is created.

 l Uncheck   the check box to disable.                   

 9. At Provider, select the Authentication provider for this portal. E.g. ADSIAuthenticationProvider

 10. At Authentication Type, select the Authentication type for this portal. Note: Delegation is recommenced.

 11. In the Root Domain text box, enter your Root Domain in the format yourdomain.com or DC=yourdomain,DC=com. Leave this 
value blank if you want to obtain Active Directory objects from root forest.

 12. In the User Name text box, enter who has permission to access Active Directory.

 13. In the Password text box, enter the password for the above user name.

 14. In the Confirm Password text box, re-enter the above password.

 15. Optional. In the Email Domaintext box, enter the Email Domain to be used for user email when your network doesn't have Win-
dows Active Directory. Note: It is recommended that you leave this field blank.

 16. Optional. In the Default Domaintext box, enter the default domain to enable users to login with just their username instead of 
DOMAIN\Username.



 17. Optional. In the Auto-login IP Address (Optional)text box, enter the IP string, address, or range separated by semicolons that you 
want to automatically log in (E.g.: 192.168.0.1-192 - 192.168.0.100 for any IP in that range, 192.168.0.50 for only that IP.). An 
example string could look like 192.168.0.100;192.168.0.1-192.168.0.100.

 18. Click the  Update Authentication Settings link.

 19. Click the  Cancel link to return to the module.

Enabling/Disabling LiveID Authentication
How to enable or disable the LiveID authentication system and configure the authentication settings using the Extensions module.

To obtain your ApplicationID (and Secret Key) you will need to register on "live.com" (https://msm.live.com/app/default.aspx).

 1. Go to an  Extensions module - OR - Navigate to Admin > Extensions.

 2. At   Filter by Type, select Authentication System from the drop-down box.

 3. Click the Edit  button beside DNN_LiveIDAuthentication.

 4. Go to the Extension Settings section.

 5. At Enabled?, select from these options:

 l Check  the check box to enable LiveID authentication. 

 l Uncheck   the check box to disable. Skip to Step 9. 

 6. Optional. At Include Help? check  the check box to render help text for the LiveID Login box - OR - Uncheck  the check box to 
hide it.

 7. In the Application ID text box, enter your Windows LiveID Application ID.

 8. In the Secret Key text box, enter your Windows LiveID secret key.

 9. Click the Update Authentication Settings link.

 10. Click the  Cancel link to return to the module.

Enabling/Disabling the Default DNN Authentication Settings 
How to enable or disable the default DNN authentication system and set the associated authentication settings. 

 1. Navigate to Admin > Extensions - OR - Go to an Extensions module.

 2. At Type Filter, select Authentication System from the drop-down box.

 3. Click the Edit  button beside Default Authentication.

 4. Go to the Extension Settings section.

 5. At Enabled?, select from these options:

 l Check  the check box to enable DNN authentication. 

 l Uncheck   the check box to disable. Skip to Step 7. 

https://msm.live.com/app/default.aspx


 6. Optional. At Use Captcha?, select from these options:

 l Check  the check box to require a Security Code to be entered during login.

 l Uncheck  the check box to disable.

 7. Click the  Update Authentication Settings link.

 8. Click the  Cancel link to return to the module.

Default login system with CAPTCHA enabled

Viewing the Extension Settings and Package Setting of a Container Package
How to view the extension settings and package settings of containers installed on this site using the Extensions module. 

 1. At Filter by Type, select Container  from the drop-down box. This filters the extensions list and displays the Name, Description 
and Version for each container package.

 2. Click the Edit  button beside the required container package.

 3. Go to the Extension Settings section. The following details are listed: 

 l Skin Package Name: Displays the name of the related skin package. 

 l Skins: Displays the names of each container within this package. 

 4. Go to the Package Settings section to view the Package Settings. For a full list of these fields "Viewing Package Settings for all 
Extension Types".

 5. Click the  Cancel link to return to the module.



Viewing the Extension Settings and Package Setting of a Skin Package
How to view the extension settings for skins installed on this site using the Extensions module. This provides detail of each container 
within the container package.

 1. At Filter by Type, select Skin from the drop-down box. This filters the extensions list and displays the Name, Description and Ver-
sion for each skin package.

 2. Click the Edit  button beside the required skin package.

 3. Go to the Extension Settings section. The following details are listed: 

 l Skin Package Name: Displays the name of this skin package. 

 l Skins: Displays the names of each skin within this package. 

 4. Go to the Package Settings section to view the Package Settings. For a full list of these fields "Viewing Package Settings for all 
Extension Types".

 5. Click the  Cancel link to return to the module.

Viewing Package Settings for all Extension Types
How to view the package settings of any extension using the Extensions module. Package Settings provide detail such as the friendly 
name, description, version, license, release notes, owner, organization name and contact details.

This task can be performed by any user with edit rights on an Extensions module.

 1. Optional. At Filter by Type, select an extension type  from the drop-down box to filter extensions.  E.g. Authentication System, Con-
tainer, Module, Skin.

 2. Click the Edit   button beside the required extension.

 3. Go to the Package Settings section. The following details are listed:

 l Name: Displays the name of this container package. 

 l Friendly Name: Displays the friendly name of this package. 

 l Description: Displays a description of this package.

 l Version: Displays the package version number.

 l License: Displays the license for this package.

 l Release Notes: Displays any release notes for this package.

 l Owner: Displays the name of the owner of this package.

 l Organization: Displays the name of the organization responsible for this package.

 l Url: Displays the URL of the organization.

 l Email Address: Displays a contact email address for this package.



 4. Click the  Cancel link to return to the module.

Administrators
Setting Permissions to Deploy a Module
How to set role and username permissions to deploy a module to the site. I.e. Add a module to a page.



 1. Navigate to Admin > Extensions.

 2. Optional. At   Filter by Type, select Module from the drop-down box. This filters the extensions list to display only modules.

 3. Click the Edit  button beside the required module. 

 4. Go to the Extension Settings section.

 5. Optional. To set permission for individual users, complete the following:

 a. In the Username text box, enter a username.

 b. Click the Add link.

 6. Optional. At Filter By Group, select <Global Roles>, <All Roles> or a Role Group to view the related roles. Note: This field may 
not be displayed.

 7. At Desktop Module Permissions, select permissions for each role/username  as follows:  

 l  Permission Granted: Permission is granted to add this module.   

 l  Not Specified: Permission is not specified. These roles/users are unable to deploy the module unless they belong to 
another role that has been granted permissions.

 l  Permission Denied: Permission is denied to add this module. These roles/users are unable to deploy the module 
regardless of whether they belong to another role that has been granted permissions.

 8. Click the   Update Desktop Module link.



Tip: When setting module permissions, you can change the selection at Filter By Group and set permissions for any of the related roles 
before updating.

Logs
Log Viewer
About the Log Viewer Module
The Log Viewer module (also known as the Event Viewer or Viewer module)  is located on the Admin > Event Viewer page. This Admin-
istration module can be deployed to portals and added to pages.

The Log Viewer is an historical log of database events such as event schedules, exceptions, account logins, module and page changes, 
user account activities, security role activities, etc. Authorized users can Send Exceptions to any email address and SuperUsers can add, 
edit and delete event records for all portals.

The Log Viewer Module

All Users
Enabling/Disabling Event Log Color Coding
How to enable or disable color coding of rows in the event log of the Log Viewer module.



 1. Navigate to Admin > Event Viewer - OR - Navigate to a page with the Log Viewer module.

 2. At Color Coding On, select from these options:

 l Check  the check box to enable color coding of logged events. This displays the Color Coding Legend field.

 a. Optional. At Color Coding Legend, click the Maximize  button to view the color code legend - OR - Click the 
Minimize  button to hide it.

 l Uncheck  the check box to disable color coding. This display all log rows in gray and hides the Color Code Legend.



 

Filtering Events by any Event Type
How to filter the records displayed in the Log Viewer module by a single event type.

 1. Maximize  the Viewer Settings section.

 2. At Type, select an event type. This displays the results in the event log below.

Filtering Events by Type



Setting Records Per Page 
How to  set the number for records displayed per page on the Log Viewer module.  Ten (10) records are displayed per page by default. 
You can choose to display up to 250 records per page however the module defaults back to ten ( 10 ) each time the page is refreshed.

 1. Maximize  the Viewer Settings section. This is the default setting. 

 2. At Records per page, select the number of records ( 10, 25, 50, 100, or 250 ) from the drop-down list.

Setting the Records per Page 

Viewing Event Details 
How to view a detailed report of a logged event using the  Log Viewer module.

 1. Optional. At Type, select the required event type to filter records. 

 2. Click on a record. A detailed report for the selected record is displayed.



 3. Optional. Click on the record a second time to close it.

Module Editors
Sending Exceptions by Email
How to send one or more selection exception records via email using the  Log Viewer module. 

Warning: By using this feature, you may be sending sensitive data over the Internet in clear text (not encrypted). Before sending your 
exception submission, please review the contents of your exception log to verify that no sensitive data is contained within it.

 1. Navigate to Admin > Event Viewer - OR - Navigate to a page with the Log Viewer module.

 2. Locate the required exceptions. Filtering records by type such as General Exception can be useful. Note: If color coding is ena-
bled, exceptions are colored red.

 3. Check  the check box beside each record to be emailed.

 4. Maximize  the Send Exceptions section. 

 5. In the Email Address text box, enter one or more email addresses separated by a semi-colon ( ; ). E.g. host@d-
omain.com;host@domain.com.au

 6. Optional. In the Subject text box, enter a subject for the message. Leave blank to use "[Portal Name] Exceptions".

 7. Optional. In the Message (optional) text box, enter a message.

 8. Click the Send Selected Exceptions link.



Sending Exceptions by Email

Site Log
About the Site Log Module
The Site Log module enables users to view statistical reports on site activity. Twelve (12) reports are provided. Each report can be set by 
date range, with the previous month being the default setting. Any user who has been granted access to view this module can view 
reports. The Host is able to enable the Site Log and restrict the number of days log history is kept for. 



The Site Log Module

Troubleshooting: Site Log History Has Been Disabled 
If the Site Log module displays the yellow warning message: "Your Hosting Provider Has Disabled the Site Log History Feature For Your 
Portal" you are unable to access site log reports. Contact your Host to configure this setting.

A Disabled Site Log

Viewing a Site Report 
How to view a site report in the Site Log. Site reports are set to display the report for the previous week by default. 

 1. Navigate to Admin > Site Log. 

 2. At Report Type, select the required report. 

 3. Optional. At Start Date, click the Calendar  button and select the start date for the report. 



 4. Optional. At End Date, click the Calendar  button and select the start date for the report. 

 5. Click the Display link.

Viewing a Site Log Report

 l See "Working with the Calendar"

Site Log Reports
Affiliate Referrals 
The Affiliate Referrals site log report tracks referrals from affiliates by adding an affiliate ID = number in the URL to your site.

Report Fields:

 n Affiliate Id: The ID number of the affiliate 

 n Requests: Number of requests associated with this affiliate 

 n Last Referral: Date and time when the last referral occurred

The Affiliate Referrals Report



Detailed Site Log 
The Detailed Site Log site log report displays a detailed log of all site activity. This report includes activity for all users, including Admin-
istrators and Hosts. 

Report Fields:                 

 n Date Time: Date and time of the visit 

 n Name: Displays the user name of authenticated users 

 n Referrer: The previous web site the user visited during this session 

 n User Agent: The type of Web browser used 

 n User Host Address: The Host address of the user

 n Tab Name: The name of the page being visited

The Detailed Site Log Report

Page Popularity 
The Page Popularity site log report displays a summary list of the most visited pages.

Report Fields: 

 n Page Name: The page being visited 

 n Requests: The number of times the page has been visited 

 n Last Request: The last time the page was visited



The Page Popularity Report

Page Views By Day Of Week 
The Page Views By Day Of Week site log report displays a summary list of the number of visitors and users who viewed the site during 
the selected day range. 

Report Fields:               

 n Week Day: The day of the week 

 n Views: Number of views for the day 

 n Visitors: Number of all visitors for the day 

 n Users: Number of registered user visits for the day



The Page Views By Day Of Week Report

Page Views By Day 
The Page Views By Day site log report provides a summary list of the number of visitors and users who viewed the site for the selected 
day range.

Report Fields:

 n Date: Date of the visit 

 n Views: Number of views for the day 

 n Visitors: Number of all visitors for the day 

 n Users: Number of registered user visits for the day



The Page Views By Day Report

Page Views By Hour 
The Page Views By Hour site log report provides a summary list of the number of visitors and users who viewed the site each hour for the 
selected day range.

Report Fields:              

 n Hour: The hour in which the visitor came to the web site. This field uses a 24 hour clock 

 n Views: Number of views for the hour 

 n Visitors: Number of all visitors for the hour 

 n Users: Number of registered user visits for the hour



The Page Views By Hour Report



Page Views By Month 
The Page Views By Month  site log report displays the total number of visitors and users who viewed the site each month for the selected 
range of months. 

Report Fields:

 n Month: A number representing the calendar month. E.g. 1 = January 

 n Views: Number of views for the month 

 n Visitors: Number of all visitors for the month 

 n Users: Number of registered user visits for the month

The Page Views By Month Report 

Site Referrals 
The Site Referrals site log report displays a summary list of web sites or search engines used by users who visit this site.

Report Fields:

 n Referrer: The URL of the referring web site 

 n Requests: Number of requests 

 n Last Request: Date and time of the last request



The Site Referrals Report

User Agents 
The User Agents site log report displays a summary list of search engine bots and Web browsers users used to go to the site. 

Report Fields: 

 n User Agent: Search engine or Web browser

 n Requests: Number of requests 

 n Last Request: Date and time of the last request



The User Agents Report

User Frequency 
The User Frequency site log report displays a list of registered users and shows how many pages they have visited as well as the time of 
their last visit. 

Report Fields:

 n Name: First name and last name of the user 

 n Requests: The total number of page requests by this user 

 n Last Request: Date and time of the last request



The User Frequency Report

User Registrations By Country 
The User Registrations By Country site log report displays the number of new registered users for each country for the selected date 
range.

Report Fields: 

 n Full Name: The first name and last name of the user 

 n User Name: The user name of the user 

 n Country: The country associated with the user as set on their profile. 



The User Registrations By Country Report

User Registrations By Date 
The User Registrations By Date site log report displays the number of new Registered Users for each date within the selected date 
range.

Report Fields: 

 n Full Name: The first name and last name of the user 

 n User Name: The user name of the user 

 n Date Registered: The date and time of the user registration



The User Registrations By Date Report

Multi Language Sites
Content Localization
About Content Localization
Content Localization allows Administrators or editors to create localized module content in multiple languages (cultures). Content local-
ization requires more than one language to be enabled on the site and localized content to be created.                 See "About the Languages Mod-
ule"

Important. Content localization must be enabled by the Host.

Viewing a Site in the Default Language
How to view a site in the default site language. This tutorial assumes more than one language is enabled on the site and that content 
localization is enabled.

 1. Click on the country flag icon displayed on the left hand side. This displays the site menu in the default language.



Viewing a Site in the Default Language

Viewing a Site in a Secondary Language
How to view the site in a secondary language (e.g. a language other than the default site language). 

Tip: Translators can view unpublished languages which they are authorized to translate. Administrators and SuperUsers can view all 
unpublished languages.

 1. Click on the country flag icon associated with the required secondary Language.

Viewing a Site in a Secondary Language

Adding a New Page (Default Language)
How to add a page to a site once Content Localization is enabled. This adds a new page for the language.



 1. View the site in the default language. See "Viewing a Site in the Default Language"

 2. Add the new page as per usual ensuring you set the Localization settings as required.  See "Adding a New Page via the Site Set-
tings Page" and "Localization Settings for New Pages".

 3. Add modules and content to this page as required.

 4. If you have chosen to create localized versions of the page, once the content is completed, you can set page for translation. See 
"Setting a Page as Ready for Translation"

Adding a Module to all Languages
How to add a new module (and then add module content) for all enabled languages on your site.

 1. View the site in the default language. See "Viewing a Site in the Default Language"

 2. Navigate to the page where you want to add the module. See "Viewing Any Page"

 3. Add the module. See "Adding a New Module (RibbonBar)"

 4. Add module content as required. See "Editing Module Content". 

Note: The section name "Master Language Version" is displayed above the Editor.

Setting a Page as Ready for Translation
How to set a page as ready for translation using the Languages module. Setting a page as ready for translation creates a copy of the 
page (including modules and content) for each of the enabled language. This also provides translators with Edit Rights to the page and 
notifies translators (by sending both an message via email and using the My Messages module) that the page is ready for translation.

 1. Ensure you are viewing the site in default site language. See "Viewing a Site in the Default Language"

 2. Navigate to the required page.



 3. On the RibbonBar, hover over the Pages link and select  Page Settings - OR - On the Iconbar, go the Page Functions section and 

select       Settings. This opens the Page Settings page.

 4. Recommended. If you haven't already done so, you should now set the view rights for this page. E.g. All Users.

 5. Go to the Localization section. You can view the current localization information on this page, as well as review related notes.

 6. Click the  Ready For Translation link.

 7. Optional. Maximize  the Location section again to view the updated localization details.



The page is now ready to be translated. See "Translating a Page". Note: The English (Australia) language page cannot be viewed by 
users until it is translated.

Tip: To remove this page from one or more languages, a translator or Administrator must hide the page using permissions. See "Setting 
Page Permissions"

Adding Modules to a Secondary Language Only
How to add one or more modules to the site which only display when the user is viewing the site in a secondary language (i.e. a lan-
guage other than the default site language).

 1. View the site in the required secondary language. See "Viewing a Site in a Secondary Language"

 2. Navigate to the page where you want to add the module.

 3. Add the module. See "Adding a New Module (RibbonBar)"

 4. Add module content as required, typically this will be in the selected language.

Translating a Page
How to translate a page including both the page name and the content of modules into a language other than the default language. 
Localized content must first be created. See "Enabling Localized Content".

 1. Login to your user account. See "Logging into a Site" Note: The language flag for the site you are a translator for is now displayed 
above the control panel. Since this page is not yet translated, this flag is only visible to translators, Administrators and SuperUsers 
until the content has been set as translated. Administrators and SuperUsers can always view all pages in all enabled languages 



regardless of translation status.

 2. Click on your Display Name. As a translator, you will receive a message whenever content is awaiting translation. See "Viewing a 
Message"

See "Viewing a Message"

 3. In the View Message screen,  click the Page name link to go to the page. Note: the Page Name is appended with the language 
code. E.g. About Us is now About Us (EN-AU)

 4. Translate the page content as required. Note: In the below image, see how a version of the content in the Master Language is dis-
played above the Editor. 

 5. Optional. You may also wish to translate the page name. See "Page Details Settings for Existing Pages"

Next Step: See "Setting a Page as Translated"

Translating a Page

Translating a Page (Admin)
How to translate a page including both the page name and module content  into a language other than the default language. You must be 
either a translator or an administrator to perform this task. Localized content must first be created. See "Enabling Localized Content"

Tip: Administrators and SuperUsers can view Flag buttons for all enabled languages.

 1. Click the Country Flag button associated with the language to be translated. This button is typically located in the top right corner 
of the site. E.g. The English (Australia)  button. This displays the site in the selected language. Page Names are appended 
with the language code. E.g. Home is now Home (EN-AU)



 2. Go to the Page Settings page. See "Editing Page Settings"

 3. In the Page Name text box, edit the page name as required. E.g. Change it from Home (EN-AU), to Home.

 4. See "Page Details Settings for Existing Pages"

 5. In the Module Localization grid, check  the check box beside each module to be translated - OR - check  the top check box to 
select all modules.

 6. Click the Localize link.

 7. The             Green OK  button is now displayed in the Localized? column.

 8. Click the  Update link.

 9. Edit the text of the modules as usual. E.g. For the HTML Pro module.

 10. Click the Edit Text link.

 11. Return to the Page Settings page.

 12. In the Module Localization grid, check  the check box beside each module which has been translated  - OR - check  the top 
check box to select all modules.

 13. Click the Mark Translated link.



Translating a Page as an Administrator

Setting a Page as Translated
How to mark localized versions of pages as translated or not translated.

 1. Ensure you are viewing the site in the required language.

 2. Go to the Page Settings page. See "Editing Page Settings"

 3. Maximize  the Localization section.

 4. At Is Translated, check   the check box to set this page as translated - OR - uncheck   the check box to set the page as requir-
ing translation.

 5. Click the  Update link.

Publishing a Secondary Language Page
How to publish a secondary language page once it has been translated. This copies the view permissions from the default language to 
this page.



 1. Navigate to the required page.

 2. On the RibbonBar, go to the Pages tab and select Page Settings  - OR - On the Iconbar, go the Page Functions section and select      

 Settings. This opens the Page Settings page.

 3. Recommended. If you haven't already done so, you should now set the view rights for this page. E.g. All Users.

 4. Go to the Localization section. Here you can view the current localization information on this page.

 5. At Publish Page, click the Save  button.

Publishing a Site Page

Adding a Module to all Languages
How to add a new module which will be displayed in all languages which are enabled on your site.

 1. View the site in the default language. See "Viewing a Site in the Default Language"

 2. Navigate to the page where you want to add the module. See "Viewing Any Page"

 3. Add the module. See "Adding a New Module (RibbonBar)". At this stage the module only exists for the default language. 

 4. Add module content as required. See "Editing Module Content"

Next Step: See "Setting a Page as Ready for Translation" to creates copies of the module in secondary languages.

Adding Modules to a Secondary Language Only
How to add one or more modules to the site which only display when the user is viewing the site in a secondary language (i.e. a lan-
guage other than the default site language).

 1. View the site in the required secondary language. See "Viewing a Site in a Secondary Language"

 2. Navigate to the page where you want to add the module.

 3. Add the module. See "Adding a New Module (RibbonBar)"

 4. Add module content as required.

Next Step: See "Setting a Page as Translated" to make the page visible on the site.



Editing the Content of Shared Modules
How to edit the content of a shared module. Note: Since shared modules are a reference to a single instance of the module, when updat-
ing a module, all the pages that contain the reference are updated.

 1. View the site in the default language. See "Viewing a Site in the Default Language"

 2. Navigate to the page where the shared module is located. See "Viewing Any Page"

 3. Edit the module content. See "Editing Module Content"

Editing (Translating) Localized Module Content
How to edit and translate module content  into a language other than the default site language.

Important. Localized content must first be created. See "Enabling Localized Content".

 1. View the site in the required secondary language. See "Viewing a Site in a Secondary Language"

 2. Select the edit option for this module. E.g. For the HTML module, click the Edit Text link.

 3. Edit/translate text as required.

 4. Click the  Save link.



Translating Localized Module Content

Modifying Module Localization Status
How to manually modify the status of one or more modules located on a page which is in a secondary language.

 1. Ensure you are viewing the site in the required language. See "Viewing a Site in a Secondary Language"

 2. Go to the Page Settings page. See "Editing Page Settings"

 3. Select the Localization tab.

 4. Go to the Module Localization section which lists of each of the modules on this page. 

 5. Check  the check box beside each of the modules whose status you want to modify - OR - Select the check box located in the 
header row to select all modules.



 6. Click one of the following links as required:

 l  Detach from Default Culture: Select to  create a separate version of the module content from the default culture. You 
can then translate this content as required. This displays the Grant               button in the Is Detached? column.

 l  Reference Default Culture: Select to make module content the same as the content in the default culture. This dis-
plays the message "Binding to the default culture version will delete the content from the sub culture versions. This action 
is irreversible. Are you sure you wish to proceed?"

 a. Click the OK button to confirm. This displays the Deny  button in the Is Detached? column.

 l  Mark as Translated: Select to mark these modules as translated.  This displays the Grant  button in the Is 
Detached? column.

 l  Mark as Not Translated: Select to mark these modules as requiring translation. This displays the Deny  button in 
the Is Detached? column.

 7. Click the  Cancel link to return to the module.

Delete Modules from Secondary Language
How to  delete a module from a page which is in a secondary language. Note: The  module is still available in other languages.

 1. View the site in the required secondary language. See "Viewing a Site in a Secondary Language"

 2. Navigate to the required page. See "Viewing Any Page"

 3. Delete the module. See "Deleting a Module"

Languages
About the Languages Module
The Languages module (also titled the Language Management module) is located under the Admin page and can also be added to 
pages. 

It allows authorized users to perform the following:

 l Enable multiple languages (cultures)

 l Manage the languages files (such as the welcome email message sent to new users) associated with a site

 l Manage Content Localization, which allows you to create localized module content in multiple languages (cultures). 
Note: Additional tasks relating to Content Localization which are not undertaken using the Languages module are covered in Con-
tent Localization section. See "About Content Localization"

Tip: A large section of language packs are available from the DotNetNuke web site and the DotNetNuke Store (Snowcovered.com).

http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.dotnetnuke.com/Development/LanguagePacks/tabid/933/Default.aspx
http://www.snowcovered.com/Snowcovered2/Default.aspx


The Languages (Language Management) Module

All Users
Setting the Default Site Language
How to set the default language for this site. This language is allocated to site members upon registration, or when the regional language 
selected by a user is unavailable. 

Note 1: A language must be enabled to become the default site language. If it is not enabled, it is automatically enabled when you set it 
as the default.

Note 2: Changing the default language doesn't update the language allocated to existing users. Only English (United States) is installed 
by default.

Contact your host to add additional languages which can then be enabled or disabled by Administrators.

For more on languages, See "About the Languages Module".

 1. Using the Control Panel, go to the  Admin >  Languages page - OR - Navigate to a Languages module. This opens the Lan-
guages page.

 2. At Site Default, select the default language for this site from the drop-down list.



 3. Click the  Update link.

Editors
Enabling Browser Language Detection
How to enable Web browser Language Detection for a single portal. If enabled, the user's  Web browser language is used to detect the 
user's preferred language.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. At Enable Browser Language Detection?, check  the check box to enable - OR - Uncheck  the check box to disable.

 3. Click the  Update link.

Enabling/Disabling a Language
How to enable or disable a language on your site using the Languages module. Note: More than one core language packs must be 
installed to perform this task as one language must always be enabled. Whenever a language is enabled, the site displays an image of 
that country's flag on the page. Users can click on the flag to view the site in that language. This displays field labels and may also 
include translated module content.

Skin Token: The skin applied to the site (or any individual site pages) must include the Languages skin token to view flag icons on site 
pages.

 1. Go to a Languages module - OR - Navigate to Admin > Languages. This displays the list of available languages.



 2. In the Enabled column, check   the check box beside the language to be enabled - OR - Uncheck   the check box to disable 
the language. Note: The default language cannot be disabled.

Tip: Where two or more languages are enabled on a site, different settings can be configured for each language via the Site Settings 
page.

A Country Flag icon is displayed above the menu for each enabled Language. The language the site is currently viewed in is highlighted.

Related Topics:

Enabling/Disabling a Language
How to enable or disable a language on your site using the Languages module. Note: More than one core language packs must be 
installed to perform this task as one language must always be enabled. Whenever a language is enabled, the site displays an image of 
that country's flag on the page. Users can click on the flag to view the site in that language. This displays field labels and may also 
include translated module content.

Skin Token: The skin applied to the site (or any individual site pages) must include the Languages skin token to view flag icons on site 
pages.

 1. Go to a Languages module - OR - Navigate to Admin > Languages. This displays the list of available languages.



 2. In the Enabled column, check   the check box beside the language to be enabled - OR - Uncheck   the check box to disable 
the language. Note: The default language cannot be disabled.

Tip: Where two or more languages are enabled on a site, different settings can be configured for each language via the Site Settings 
page.

A Country Flag icon is displayed above the menu for each enabled Language. The language the site is currently viewed in is highlighted.

Related Topics:

Enabling Browser Language Detection
How to enable Web browser language detection for a single portal. If enabled, the user's  Web browser language is used to detect the 
user's preferred language.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. At Enable Browser Language Detection?, check  the check box to enable - OR - Uncheck  the check box to disable.



 3. Click the  Update link.

Setting Fallback Languages
How to set the fallback language using the Languages module. The fallback language is used if the selected language is not available.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Edit column of the Culture grid, click the Edit  button for the required language. This opens the Edit Language page.

 3. Optional. At Fallback Language, select Native Name to view names in their native spelling, or English Name to view names in 
English spelling.

 4. At Fallback Language, select the fallback language to be used.

 5. Click the  Update link.



Setting Language Files as Pending Translation
How to set the values (language files) associated with a language package as pending translation using the Languages module.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Static Resources - Site column of the Culture grid, click the Edit  button for the language file to be edited. This displays 
the GlobalResources file ready for editing.



 3. At  Highlight Pending Translations, check  the check box to set all values as pending translation. This displays the text in the 
Localized Values text boxes as highlighted in red.

 4. To edit a resource file, perform one of the following options: 

 l In the Localized Value text box, edit the text  - OR -  

 l Click the Edit  button. This displays the  message "All unsaved changes will be lost if you continue. Are you sure you 
want to continue?" 

 a. Click the OK button. 

 b. In the Editor, enter the new text ensuring you include the desired replacement tokens displayed at Default Value. 

 c. Click the  Update link.  Note: The red highlight is removed from the box each time you update a value using the 
Editor.

 5. At  Highlight Pending Translations, uncheck  the check box once translations are completed or if you wish to hide pending 
translations.

 6. Click the  Save Resource File link.

Tip: Whenever you check Highlight Pending Translations, the fields that haven't been translated will once again be displayed.

Editing Portal Language Files
How to edit the Language files associated with a Language Pack  on your site using the Languages module. See the Language Files sec-
tion below for a complete list of the email messages, error messages, and portal messages available for editing.



 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Static Resources - Site column of the Culture grid, click the Edit  button beside the language to be edited. This displays 
the GlobalResources file ready for editing. Note: This is where you will find the files most commonly edited files such as mes-
sages. If these are the required files, skip to Step 4.

 3. Optional. In the Resources folder list, navigate to and select the required file from the below folders.

 l Local Resources: Files which are related to specific Admin controls, modules (desktop modules), controls, installation 
and Host skins.

 l Global Resources: Files which are used across the site. This is divided into GlobalResources and SharedResources. 
This is where you can edit the messages that are sent to users, error messages, portal messages, etc.

 4. Locate the required resource file. Note: If Paging is enabled, the file may be located on another page. See "Enabling Browser Lan-
guage Detection"

 5. To edit a resource file, perform one of the following options: 

 l In the Localized Value text box, edit the text  
- OR -  

 l Click the Edit  button. This displays the  message "All unsaved changes will be lost if you continue. Are you sure you 
want to continue?" 

 a. Click the OK button. 

 b. In the Editor, enter the new text ensuring you include the desired replacement tokens displayed at Default Value. 



 c. Click the  Update link.

 6. Optional. To edit the subject associated with email messages, edit the associated Subject resource file which will be listed above 
the Body resource file.

 7. Repeat steps 4-6 to edit additional files.

 8. Click the  Save Resource File link to save your changes.

Editing Portal Language Files

Deleting a Resource File
How to delete the resource file associated with a  Language Pack  on your site using the Languages module.



 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Static Resources - Site column, click the Edit  button beside the language associated with the resource file to be 
deleted.

 3. In the Resources folder list, navigate to and select the required file from the below folders:

 l Local Resources: Files which are related to specific Admin controls, modules (desktop modules), controls, installation 
and Host skins.

 l Global Resources: Files which are used across the site. This is divided into GlobalResources and SharedResources. 
This is where you can edit the messages that are sent to users, error messages, portal messages, etc.

 4. The name of the file you selected for deletion at Step 3 is now displayed at                      Selected Resource File.

 5. Click the  Delete Resource File link (located at the base of the page) to delete the file. This displays the message "Are You 
Sure You Wish To Delete This Item?" 



 6. Click the OK button to confirm.

 

Enabling Localized Content
How to create a localized copy of the current site content for each of the enabled languages using the Languages module. This creates a 
translator role ( titled Translator and then appended with the country code. E.g. Translator (EN-AU) ) for each enabled language.

Important. Once localized content is enabled it cannot be disabled.

Important. The ability to enable localized content must first be enabled by the Host. See "Enabling/Disabling Content Localization"

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. Click the  Enable Localized Content link.



 3. The Enable Localized Content message box is now displayed, which shows the Current Site Default language and informs you 
that this language cannot be changed once localized content is enabled. If you wish to change the default site culture, you must 
select Cancel now and change the default language.



 4. Click the  Enable Localized Content link. This displays progress bars which show the languages and pages being created for 
each of the enabled languages. This creates a copy of each of these pages (including the modules and content on these pages) 
for each language. It also creates a translator role for each language. Once completed, a new section titled Content Localization 
is displayed in the grid.

 l  No of Pages: The number of pages and the percentage of pages that have been localized. Note: In this example, the 
number of pages is shown as five ( 5 ). These are the Home, Store and About Us pages which I have created, as well as 
the Search Results and User Profile pages.

 l  Translated Pages: The number of pages and percentage that have been translated.

 l Active: Localized content is activated / not activated

 l Publish: The Publish Pages  icon enables editors to publish pages which are marked as translated for this language.



To view the newly created localized copies for this language, click on the country flag for this language (typically located in the top right 
corner of the site above the menu). This displays the localized copies of these pages in the menu. Note: Page names are appended with 
the country code. E.g. For Australia it is (EN-AU). You can modify these names as you like by editing the Page Name. See "Page Details 
Settings for Existing Pages"



Enabling Localized Content

A translator role named Translator (en-AU) is now displayed in the Security Roles module for Australian English. Before translation can 
begin, the users who are the translators for each language should be added to the newly created translator roles. See "Adding a User to 
a Security Role"

Tip: You can also assign other roles as translators for a language. See "Setting Translator Roles"

For details on translating content and managing content for multiple languages, See "About Content Localization"

Creating Localized Pages for a Language
How to create localized pages for a language using the Languages module. This creates a translator role ( titled Translator and then 
appended with the country code. E.g. Translator (EN-AU) ) for each enabled language. Users will need to be added to this role. See "Add-
ing a User to a Security Role"

Note:  Localized content must first be enabled. See "Enabling Localized Content".



 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Enabled column of the Culture grid, check   the check box beside the language. 

 3. This enables the language and creates localized pages.



Creating Localized Pages for a Language

Setting Translator Roles
How to enable or disable one or more roles to have Edit Rights to translate all new pages and localized modules for a language using 
the Languages module. Note: A translator role is automatically created for each language upon creation of localized content. This tutorial 
explains how to add additional roles if required.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Edit column of the Culture grid, click the Edit  button beside the required language. This opens the Edit Language page.



 3. At Localized Content Translators, check   the check box in the Selected Role column beside each role which can translate this 
language. Note: The translator role associated with this role is checked by default.

 4. Click the  Update link.

Setting Localized Content Translators



Activating/Deactiving a Language
How to activate or deactivate a language using the Languages module. Activating a language enables site visitors to see these pages. A 
language is typically activated once it has been translated. 

 1. Go to a Languages module - OR - Navigate to Admin > Languages. This displays the list of available languages.

 2. In the Content Localization column of the Culture grid, check  the Active check box  to activate a language - OR - Uncheck  
the check box to deactivate it. Note: Deactivating a language disables the Publish button.

Activating a Language

Publishing Localized Content
How to publish localized content using the Languages module. Once a language is published, site visitors can click on the associated 
country flag and view the translated pages. Note: A language must be Active in order to be published.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. In the Content Localization section of the Culture grid, click the Publish Pages  icon in the Publish column to publish pages 
which are marked as translated for this language. Note: This copies the View Settings from the default language to that language.



Publishing Localized Content

Manage Settings
Configuring the Portal Language Settings
How to configure language settings for a single portal.

 1. Go to a Languages module - OR - Navigate to Admin > Languages.

 2. Select  Settings from the module actions menu - OR - Click the Settings  button.

 3. Go to the Portal Language Settings section.

 3. At Enable Language Parameter in URLs?, check  the check box to enable - OR - Uncheck  the check box to disable.

 4. At Use Paging in Editor?, select from these options:

 l Check  the check box to enable paging which is disabled by default. Use paging  to reduce the size  of the page.

 a. At Editor Page Size enter the number of items to be displayed on each page of the editor. The default setting is 10.

 l Uncheck  the check box to disable paging.

 5. Click the  Update link.



Related Topics:

 l See "About the Pager"

Language Files
Overview of the Type of Language Files
The Core Language Pack included with DNN includes language files which can be modified. Here's a list of the types of language files 
which can be edited using the Languages module.

 l Actions: The names given to common actions such as clear cache, delete module, edit module.

 l Strings:  String resources are the names attributed Admin and Host pages, Banner types and Permission to Deploy modules.

 l Error Messages: Messages which appear when an error occurs.

 l Email Messages: Email messages are sent by DNN when users request password reminders, subscribe to a role, etc. They can 
also be message to editors or Administrators confirming actions such as deleting user accounts or sending newsletters. 

 l Text: Text language files.

Example: Adding/Editing the Login Message
How to edit the login instructions displayed on the Account Login module using the Languages module. No message is displayed by 
default.

 1. Go to a Languages module - OR - Navigate to Admin > Languages. This displays the Culture grid which lists the available lan-
guages.

 2. In the Static Resources - Portal column, click the Edit  button beside the language file to be edited. This displays Glob-
alResources.Portal-0.resx at Selected Resource File as the files ready for editing. Note: This is where you will find the files most 
commonly desired for editing such as portal and email messages.



 3. Find Resource Name: MESSAGE_LOGIN_INSTRUCTIONS.Text. Note: If Paging is enabled then it may be located on a sub-
sequent page. See "Enabling Browser Language Detection"

 4. To edit the message, perform one of the following options: 

 l Edit the message body using HTML tags in the Localized Value text box below

- OR -  

 l Click the Edit  button. This displays the  message "All unsaved changes will be lost if you continue. Are you sure you 
want to continue?" 

 i. Click the OK button. 

 ii. Enter your new message into the RTE ensuring you include the replacement tokens displayed at Default Value. 

 iii. Click the Update link to return to the Language Editor.

 5. Optional. To edit the subject associated with email message language files, edit the associated Subject resource file which will be 
listed above the Body resource file.

 6. Click the Update link. 

 7. Optional. Repeat all of the above steps to update this message for another language.



Login Instructions on the User Log In page

Example: Editing Privacy and Terms of Use Statements
How to edit the Privacy statement and/or the Terms of Use Statements using the Languages module. No message is displayed by 
default. See "Portal Privacy Text" 

 1. Go to a Languages module - OR - Navigate to Admin > Languages. This displays the Culture grid which lists the available lan-
guages.

 2. In the Static Resources - Portal column, click the Edit  button beside the language file to be edited. This displays Glob-
alResources.Portal-0.resx at Selected Resource File as the files ready for editing. Note: This is where you will find the files most 
commonly desired for editing such as portal and email messages.



 3. Find Resource Name: MESSAGE_PORTAL_PRIVACY.Text or MESSAGE_PORTAL_TERMS.Text as desired. Note: If Paging is 
enabled then it may be located on a subsequent page. See "Enabling Browser Language Detection"

 4. To edit the message, perform one of the following options: 

 l Edit the message body using HTML tags in the Localized Value text box below
- OR -  

 l Click the Edit  button. This displays the  message "All unsaved changes will be lost if you continue. Are you sure you 
want to continue?" 

 i. Click the OK button. 

 ii. Enter your new message into the RTE ensuring you include the replacement tokens displayed at Default Value. 

 iii. Click the Update link to return to the Language Editor.

 5. Optional. To edit the subject associated with email message language files, edit the associated Subject resource file which will be 
listed above the Body resource file.

 6. Click the Update link. 

 7. Optional. Repeat all of the above steps to update this message for another language.

Email Messages
Affiliate Notification Email Message
The Affiliate Notification email message is sent to an affiliate when their account is created.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [Custom:0], 



Your account for the [Portal:PortalName] Affiliate Program has been created. 

To begin earning rewards, please use the following URL to link to our site: [Custom:1] 

Thank you, [Portal:PortalName] 

Banner Notification Email Message
The Banner Notification email message is sent to a Vendor and provides them with up to the minute information on one of their banners.

Here is the default value (default text) of this email message  in the DNN core language pack:

Banner: [Custom:0] 

Description: [Custom:1] 

Image: [Custom:2] 

CPM/Cost: [Custom:3] 

Impressions: [Custom:4] 

StartDate: [Custom:5] 

EndDate: [Custom:6] 

Views: [Custom:7] 

Click Throughs: [Custom:8]

Bulk Email Confirmation Email Message
The Bulk Email Confirmation email message is sent to the primary Administrator when a bulk email (newsletter) mail out is completed.

Here is the default value (default text) of this email message  in the DNN core language pack:

Bulkmail Report

Operation started at: [Custom:0] 
EmailRecipients: [Custom:1] 
EmailMessages: [Custom:2] 
Operation completed: [Custom:3] 
[Custom:4| Number of errors:{0} ]  

Status Report: 

[Custom:5]

[Custom:6|

--------------------------------------------------------------------------------

Recipients:
{0}] 

Tip: There is a HTML and a text version of this email

Password Reminder Email Message
The Password Reminder email message is sent to a user when they request a password reminder.

Here is the default value (default text) of this email message  in the DNN core language pack:



Dear [User:DisplayName], 

You have requested a Password Reminder from [Portal:PortalName]. 

Please login using the following information: 

Portal Website Address: [Portal:URL] 
Username: [Membership:Username] 
Password: [Membership:Password]

Sincerely, 
[Portal:PortalName] 

*Note: If you did not request a Password Reminder, please disregard this Message. 

Portal Signup Email Message
The Portal Signup email message is sent to the new site Administrator when the portal is created.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName],  

Your Portal Website Has Been Created. Please read the following information carefully and be sure to save this message 
in a safe location for future reference. 

Portal Website Address: [Portal:URL]
Username: [Membership:UserName] 
Verification Code: [User:VerificationCode] 

Please take the opportunity to visit the website to review its content and take advantage of its many features. 

Thank you, we appreciate your support...  
[Host:HostTitle]  

Profile Updated Email Message
The Profile Updated email message is sent to a user when they update their profile.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName], 

Your profile on [Portal:PortalName] has been successfully updated. 

Sincerely, 
[Portal:PortalName] 



Editing the Profile Updated email

Retrieve Password Instructions
The Retrieve Password instructions are displayed to a user when a question and answer is required to modify or retrieve their password.

Here is the default value (default text) for these instructions  in the DNN core language pack:

In order to retrieve your password, you will need to provide your user name, and the answer to the Password Question.

Editing the Retrieve Password Instructions

Role Assignment Email Message
The Role Assignment email message is optionally sent to a user when they are assigned to a role.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName], 

Your user account at [Portal:PortalName] has been recently updated to include access to the following Security Role: 

Role: [Custom:0] 
Description: [Custom:1] 
Effective Date: [Custom:2] 
Expiry Date: [Custom:3]



Thank you, we appreciate your support... 
[Portal:PortalName] 

Editing the Role Assignment email

Role Unassignment Email Message
The Role Unassignment email message is optionally sent to a user when they are unassigned from a role.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName], 

Your user account at [Portal:PortalName] has been recently updated to restrict access to the following Security Role:

Role: [Custom:0] 
Description: [Custom:1] 

Thank you, we appreciate your support... 
[Portal:PortalName] 



Editing the Role Unassignment email

SMTP Configuration Test Email Message
The SMTP Configuration Test email message is sent to the Host when they test the SMTP configuration. See "Testing Outgoing Email Set-
tings" 

Here's the default value (default text) of this email message  in the DNN core language pack:

[Host:HostTitle] SMTP Configuration Test

User Registration Administrator Email Message
The User Registration Administrator email message is sent to the primary site Administrator when a user registration occurs. This 
includes those made by visitors, users authorized to create user accounts, and other Administrators.

Here is the default value (default text) of this email message  in the DNN core language pack:

Date: [Date:Current] 
First Name: [Profile:FirstName] 
Last Name: [Profile:LastName] 
Unit: [Profile:Unit] 
Street: [Profile:Street] 
City: [Profile:City] 
Region: [Profile:Region] 
Country: [Profile:Country] 
Postal Code: [Profile:PostalCode] 
Telephone: [Profile:Telephone] 
Email: [User:Email] 



Editing the User Registration Administrator email message body and subject

User Registration Private Email Message
The User Registration Private email message is used when site registration is set as Private. It is sent to the new user when they register 
for a user account.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName], 

Thank you for registering at [Portal:PortalName]. 

Please read the following information carefully and be sure to save this message in a safe location for future reference.  
Portal 

Website Address: [Portal:URL] 
Username: [Membership:UserName] 
Password: [Membership:Password]  

Your account details will be reviewed by the portal Administrator and you will receive a notification upon account acti-
vation. 

Thank you, we appreciate your support...

[Portal:PortalName] 



Editing the Private User Registration email 

User Registration Public Email Message
The User Registration Public email message is used when site registration is set as Public. It is sent to the new user when they register 
for a user account.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName],  

We are pleased to advise that you have been added as a Registered User to [Portal:PortalName]. 

Please read the following information carefully and be sure to save this message in a safe location for future reference. 

Portal Website Address: [Portal:URL] 
Username: [Membership:UserName] 
Password: [Membership:Password]

Please take the opportunity to visit the website to review its content and take advantage of its many features.  

Thank you, we appreciate your support... 

[Portal:PortalName] 



The Public User Registration email message body and subject

User Registration Verified Email Message
The User Registration Verified email message is used when site registration is set as Verified. It is sent to the new user when they reg-
ister for a user account.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [User:DisplayName],  

We are pleased to advise that you have been added as a Registered User to [Portal:PortalName]. 

Please read the following information carefully and be sure to save this message in a safe location for future reference. 

Portal Website Address: [Portal:URL] 
Username: [Membership:UserName] 
Password: [Membership:Password] 
Verification Code: [User:VerificationCode] 

You may use the following link to complete your verified registration:  http://-
[Portal:URL]/default.aspx?ctl=Login&username=[Custom:0]&verificationcode=[User:VerificationCode] 

Please take the opportunity to visit the website to review its content and take advantage of its many features.  

Thank you, we appreciate your support...

[Portal:PortalName]



Editing the Verified User Registration email

User Unregister Email Message
The User Unregister email message is sent to the primary site Administrator when a user unregister or is unregistered.

Here is the default value (default text) of this email message  in the DNN core language pack:

Date: [Date:Current]
 First Name: [Profile:FirstName] 
Last Name: [Profile:LastName] 
Unit: [Profile:Unit] 
Street: [Profile:Street] 
City: [Profile:City] 
Region: [Profile:Region] 
Country: [Profile:Country] 
Postal Code: [Profile:PostalCode] 
Telephone: [Profile:Telephone] 
Email: [User:Email] 

Vendor Registration Administrator Email Message
The Vendor Registration Administrator email message is sent to the primary site Administrator when a new Vendor account is created.

Here is the default value (default text) of this email message  in the DNN core language pack:

Date: [Custom:0] 
Vendor Name: [Custom:1] 
First Name: [Custom:2] 
Last Name: [Custom:3] 
Unit: [Custom:4] 
Street: [Custom:5] 
City: [Custom:6] 
Region: [Custom:7]
Country: [Custom:8]
 Postal Code: [Custom:9] 



Telephone: [Custom:10] 
Fax: [Custom:11] 
Cell: [Custom:12] 
Email: [Custom:13] 
Website: [Custom:14]

Editing the  Administrator's Vendor Registration email message

Vendor Registration Email Message
The Vendor Registration email message is sent to a Vendor when their new Vendor account is created.

Here is the default value (default text) of this email message  in the DNN core language pack:

Dear [Custom:0] [Custom:1], 

[Custom:2] company has been successfully registered at [Portal:PortalName]. 

Thank you, 

[Portal:PortalName]



Editing the Vendor Registration email

Error Messages
The Default 403_3 Error Message
Here is the default text for the 403_3 Error Message in the DNN core language pack:

DotNetNuke Configuration Error {0}  DotNetNuke has extensive file upload capabilities for content, modules, and skins. 
These features require custom security settings so that the application is able to create and remove files in your web site.

Using Windows Explorer, browse to the root folder of the web site ( C:\DotNetNuke by default ). Right-click the folder and 
select Sharing and Security from the popup menu ( Note: If you are using Windows XP you may need to Disable Simple 
File Sharing before these options are displayed ). Select the Security tab. Add the appropriate User Account and set the 
Permissions. 

 n If using Windows 2000 - IIS5 

 l the [SERVER]\ASPNET User Account must have Read, Write, and Change Control of the virtual root of your 
web site. 

 n If using Windows 2003 - IIS6 

 l the NT AUTHORITY\NETWORK SERVICE User Account must have Read, Write, and Change Control of the 
virtual root of your web site. 

The Default 404 Error Message
Here is the default text for the 404 Error Message in the DNN core language pack:

Domain Name {0} Does Not Exist In The Database 

DNN supports multiple portals from a single database/codebase. It accomplishes this by converting the URL of the client Web browser 
Request to a valid PortalID in the Portals database table. The following steps describe the process:    

http://whoozoo.co.uk/winxpFilePerms.htm
http://whoozoo.co.uk/winxpFilePerms.htm
http://whoozoo.co.uk/winxpFilePerms.htm
http://whoozoo.co.uk/winxpFilePerms.htm
http://whoozoo.co.uk/winxpFilePerms.htm
http://whoozoo.co.uk/winxpFilePerms.htm
http://whoozoo.co.uk/winxpFilePerms.htm


 1. Web Server Processing

 l When a web server receives a Request from a client Web browser, it compares the file name extension on the target URL 
resource to its Application Extension Mappings defined in IIS. 

 l Based on the corresponding match, IIS then sends the Request to the defined Executable Path ( aspnet_asapi.dll in the 
case of ASP.NET Requests ). 

 l The aspnet_isapi.dll engine processes the Request in an ordered series of events beginning with Application_Begin-
Request.

 2. HttpModule.URLRewrite OnBeginRequest ( UrlRewriteModule.vb )

 l The Request URL is parsed based on the "/" character  A Domain Name is constructed using each of the relevant parsed 
URL segments. 
Examples: 
URL: http://www.domain.com/default.aspx = Domain Name: www.domain.com 
URL: http://209.75.24.131/default.aspx = Domain Name: 209.75.24.131 
URL: http://localhost/DotNetNuke/default.aspx = Domain Name: localhost/DotNetNuke 
URL: http://www.domain.com/virtualdirectory/default.aspx = Domain Name: www.domain.com/virtualdirectory 
URL: http://www.domain.com/directory/default.aspx = Domain Name: www.domain.com/directory 

 l Using the Domain Name, the application queries the database ( Portals table - PortalAlias field ) to locate a matching rec-
ord.   
Note: If there are multiple URLs which correspond to the same portal then the PortalAlias field must contain each valid 
Domain Name in a comma seperated list.   
Example:   URL: http://localhost/DotNetNuke/default.aspx 
URL: http://MACHINENAME/DotNetNuke/default.aspx 
URL: http://209.32.134.65/DotNetNuke/default.aspx 
PortalAlias: localhost/DotNetNuke,MACHINENAME/DotNetNuke,209.32.134.65/DotNetNuke 

Note: If you are installing the application to a remote server you must modify the PortalAlias field value for the default rec-
ord in the Portals table according to the rules defined above. 

Portal Messages
License Text
The DotNetNuke License is displayed in the code of the site. It is not displayed on any page.

Here is the default value (default text) of this email message  in the DNN core language pack:

DotNetNuke® - http://www.dotnetnuke.com Copyright (c) 2002-2009 by DotNetNuke Corporation   

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, 
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:   

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Soft-
ware. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.



Portal Privacy Text
The Portal Privacy text is associated with the Privacy skin token.

This language file is located in the Language Editor Resources List under: Local Resources - Admin - Portal - App-
LocalResources: Privacy.ascx

Here is the default value (default text) of this email message  in the DNN core language pack:

[Portal:PortalName] is committed to protecting your privacy and developing technology that gives you the most powerful 
and safe online experience. This Statement of Privacy applies to the [Portal:PortalName] web site and governs data col-
lection and usage. By using the [Portal:PortalName] web site, you consent to the data practices described in this state-
ment.  

Collection of your Personal Information 

[Portal:PortalName] collects personally identifiable information, such as your e-mail address, name, home or work address 
or telephone number. [Portal:PortalName] also collects anonymous demographic information, which is not unique to you, 
such as your ZIP code, age, gender, preferences, interests and favorites.  

There is also information about your computer hardware and software that is automatically collected by [Por-
tal:PortalName]. This information can include: your IP address, browser type, domain names, access times and referring 
web site addresses. This information is used by [Portal:PortalName] for the operation of the service, to maintain quality of 
the service, and to provide general statistics regarding use of the [Portal:PortalName] web site. 

Please keep in mind that if you directly disclose personally identifiable information or personally sensitive data through 
[Portal:PortalName] public message boards, this information may be collected and used by others. Note: [Por-
tal:PortalName] does not read any of your private online communications. 

[Portal:PortalName] encourages you to review the privacy statements of web sites you choose to link to from [Por-
tal:PortalName] so that you can understand how those web sites collect, use and share your information. [Por-
tal:PortalName] is not responsible for the privacy statements or other content on web sites outside of the 
[Portal:PortalName] and [Portal:PortalName] family of web sites.  

Use of your Personal Information

[Portal:PortalName] collects and uses your personal information to operate the [Portal:PortalName] web site and deliver 
the services you have requested. [Portal:PortalName] also uses your personally identifiable information to inform you of 
other products or services available from [Portal:PortalName] and its affiliates. [Portal:PortalName] may also contact you 
via surveys to conduct research about your opinion of current services or of potential new services that may be offered. 

[Portal:PortalName] does not sell, rent or lease its customer lists to third parties. [Portal:PortalName] may, from time to time, 
contact you on behalf of external business partners about a particular offering that may be of interest to you. In those 
cases, your unique personally identifiable information (e-mail, name, address, telephone number) is not transferred to the 
third party. In addition, [Portal:PortalName] may share data with trusted partners to help us perform statistical analysis, 
send you email or postal mail, provide customer support, or arrange for deliveries. All such third parties are prohibited 
from using your personal information except to provide these services to [Portal:PortalName], and they are required to 
maintain the confidentiality of your information.  

[Portal:PortalName] does not use or disclose sensitive personal information, such as race, religion, or political affiliations, 
without your explicit consent.  

[Portal:PortalName] keeps track of the web sites and pages our customers visit within [Portal:PortalName], in order to deter-
mine what [Portal:PortalName] services are the most popular. This data is used to deliver customized content and adver-
tising within [Portal:PortalName] to customers whose behavior indicates that they are interested in a particular subject 
area.  [Portal:PortalName] web sites will disclose your personal information, without notice, only if required to do so by law 
or in the good faith belief that such action is necessary to: (a) conform to the edicts of the law or comply with legal process 



served on [Portal:PortalName] or the site; (b) protect and defend the rights or property of [Portal:PortalName]; and, (c) act 
under exigent circumstances to protect the personal safety of users of [Portal:PortalName], or the public.  

Use of Cookies

The [Portal:PortalName] web site use "cookies" to help you personalize your online experience. A cookie is a text file that 
is placed on your hard disk by a Web page server. Cookies cannot be used to run programs or deliver viruses to your com-
puter. Cookies are uniquely assigned to you, and can only be read by a web server in the domain that issued the cookie to 
you. 

One of the primary purposes of cookies is to provide a convenience feature to save you time. The purpose of a cookie is to 
tell the Web server that you have returned to a specific page. For example, if you personalize [Portal:PortalName] pages, 
or register with [Portal:PortalName] site or services, a cookie helps [Portal:PortalName] to recall your specific information 
on subsequent visits. This simplifies the process of recording your personal information, such as billing addresses, ship-
ping addresses, and so on. When you return to the same [Portal:PortalName] web site, the information you previously pro-
vided can be retrieved, so you can easily use the [Portal:PortalName] features that you customized.  

You have the ability to accept or decline cookies. Most Web browsers automatically accept cookies, but you can usually 
modify your browser setting to decline cookies if you prefer. If you choose to decline cookies, you may not be able to fully 
experience the interactive features of the [Portal:PortalName] services or web sites you visit. 

Security of your Personal Information

[Portal:PortalName] secures your personal information from unauthorized access, use or disclosure. [Portal:PortalName] 
secures the personally identifiable information you provide on computer servers in a controlled, secure environment, pro-
tected from unauthorized access, use or disclosure. When personal information (such as a credit card number) is trans-
mitted to other web sites, it is protected through the use of encryption, such as the Secure Socket Layer (SSL) protocol.  

Changes to this Statement

[Portal:PortalName] will occasionally update this Statement of Privacy to reflect company and customer feedback. [Por-
tal:PortalName] encourages you to periodically review this Statement to be informed of how [Portal:PortalName] is pro-
tecting your information.  

Contact Information

[Portal:PortalName] welcomes your comments regarding this Statement of Privacy. If you believe that [Portal:PortalName] 
has not adhered to this Statement, please contact [Portal:PortalName] at [Portal:Email]. We will use commercially rea-
sonable efforts to promptly determine and remedy the problem.  

Portal Terms Text
The Portal Terms text is associated with the Terms skin token.

Here is the default value (default text) of this email message  in the DNN core language pack:

AGREEMENT BETWEEN USER AND [Portal:PortalName] 

The [Portal:PortalName] Web Site is comprised of various Web pages operated by [Portal:PortalName].  

The [Portal:PortalName] Web Site is offered to you conditioned on your acceptance without modification of the terms, con-
ditions, and notices contained herein. Your use of the [Portal:PortalName] Web Site constitutes your agreement to all such 
terms, conditions, and notices.  

MODIFICATION OF THESE TERMS OF USE 

[Portal:PortalName] reserves the right to change the terms, conditions, and notices under which the [Portal:PortalName] 
Web Site is offered, including but not limited to the charges associated with the use of the [Portal:PortalName] Web Site.  



LINKS TO THIRD PARTY SITES 

The [Portal:PortalName] Web Site may contain links to other Web Sites ("Linked Sites"). The Linked Sites are not under the 
control of [Portal:PortalName] and [Portal:PortalName] is not responsible for the contents of any Linked Site, including with-
out limitation any link contained in a Linked Site, or any changes or updates to a Linked Site. [Portal:PortalName] is not 
responsible for webcasting or any other form of transmission received from any Linked Site. [Portal:PortalName] is pro-
viding these links to you only as a convenience, and the inclusion of any link does not imply endorsement by [Por-
tal:PortalName] of the site or any association with its operators.

NO UNLAWFUL OR PROHIBITED USE 

As a condition of your use of the [Portal:PortalName] Web Site, you warrant to [Portal:PortalName] that you will not use the 
[Portal:PortalName] Web Site for any purpose that is unlawful or prohibited by these terms, conditions, and notices. You 
may not use the [Portal:PortalName] Web Site in any manner which could damage, disable, overburden, or impair the [Por-
tal:PortalName] Web Site or interfere with any other party's use and enjoyment of the [Portal:PortalName] Web Site. You 
may not obtain or attempt to obtain any materials or information through any means not intentionally made available or pro-
vided for through the [Portal:PortalName] Web Sites. 

USE OF COMMUNICATION SERVICES

The [Portal:PortalName] Web Site may contain bulletin board services, chat areas, news groups, forums, communities, per-
sonal web pages, calendars, and/or other message or communication facilities designed to enable you to communicate 
with the public at large or with a group (collectively, "Communication Services"), you agree to use the Communication 
Services only to post, send and receive messages and material that are proper and related to the particular Com-
munication Service. By way of example, and not as a limitation, you agree that when using a Communication Service, you 
will not:

 l Defame, abuse, harass, stalk, threaten or otherwise violate the legal rights (such as rights of privacy and publicity) 
of others.

 l Publish, post, upload, distribute or disseminate any inappropriate, profane, defamatory, infringing, obscene, inde-
cent or unlawful topic, name, material or information.

 l Upload files that contain software or other material protected by intellectual property laws (or by rights of privacy of 
publicity) unless you own or control the rights thereto or have received all necessary consents.

 l Upload files that contain viruses, corrupted files, or any other similar software or programs that may damage the 
operation of another's computer.

 l Advertise or offer to sell or buy any goods or services for any business purpose, unless such Communication Serv-
ice specifically allows such messages.

 l Conduct or forward surveys, contests, pyramid schemes or chain letters.

 l Download any file posted by another user of a Communication Service that you know, or reasonably should know, 
cannot be legally distributed in such manner.

 l Falsify or delete any author attributions, legal or other proper notices or proprietary designations or labels of the 
origin or source of software or other material contained in a file that is uploaded.

 l Restrict or inhibit any other user from using and enjoying the Communication Services.

 l Violate any code of conduct or other guidelines which may be applicable for any particular Communication Serv-
ice.



 l Harvest or otherwise collect information about others, including e-mail addresses, without their consent.

 l Violate any applicable laws or regulations.

[Portal:PortalName] has no obligation to monitor the Communication Services. However, [Portal:PortalName] reserves the 
right to review materials posted to a Communication Service and to remove any materials in its sole discretion. [Por-
tal:PortalName] reserves the right to terminate your access to any or all of the Communication Services at any time without 
notice for any reason whatsoever.  

[Portal:PortalName] reserves the right at all times to disclose any information as necessary to satisfy any applicable law, 
regulation, legal process or governmental request, or to edit, refuse to post or to remove any information or materials, in 
whole or in part, in [Portal:PortalName]'s sole discretion.

Always use caution when giving out any personally identifying information about yourself or your children in any Com-
munication Service. [Portal:PortalName] does not control or endorse the content, messages or information found in any 
Communication Service and, therefore, [Portal:PortalName] specifically disclaims any liability with regard to the Com-
munication Services and any actions resulting from your participation in any Communication Service. Managers and hosts 
are not authorized [Portal:PortalName] spokespersons, and their views do not necessarily reflect those of [Por-
tal:PortalName].

Materials uploaded to a Communication Service may be subject to posted limitations on usage, reproduction and/or dis-
semination. You are responsible for adhering to such limitations if you download the materials. 

MATERIALS PROVIDED TO [Portal:PortalName] OR POSTED AT ANY [Portal:PortalName] WEB SITE 

[Portal:PortalName] does not claim ownership of the materials you provide to [Portal:PortalName] (including feedback and 
suggestions) or post, upload, input or submit to any [Portal:PortalName] Web Site or its associated services (collectively 
"Submissions"). However, by posting, uploading, inputting, providing or submitting your Submission you are granting [Por-
tal:PortalName], its affiliated companies and necessary sublicensees permission to use your Submission in connection 
with the operation of their Internet businesses including, without limitation, the rights to: copy, distribute, transmit, publicly 
display, publicly perform, reproduce, edit, translate and reformat your Submission; and to publish your name in connection 
with your Submission.  

No compensation will be paid with respect to the use of your Submission, as provided herein. [Portal:PortalName] is under 
no obligation to post or use any Submission you may provide and may remove any Submission at any time in [Por-
tal:PortalName]'s sole discretion.  

By posting, uploading, inputting, providing or submitting your Submission you warrant and represent that you own or other-
wise control all of the rights to your Submission as described in this section including, without limitation, all the rights nec-
essary for you to provide, post, upload, input or submit the Submissions. 

LIABILITY DISCLAIMER

THE INFORMATION, SOFTWARE, PRODUCTS, AND SERVICES INCLUDED IN OR AVAILABLE THROUGH THE [Por-
tal:PortalName] WEB SITE MAY INCLUDE INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE PERI-
ODICALLY ADDED TO THE INFORMATION HEREIN. [Portal:PortalName] AND/OR ITS SUPPLIERS MAY MAKE 
IMPROVEMENTS AND/OR CHANGES IN THE [Portal:PortalName] WEB SITE AT ANY TIME. ADVICE RECEIVED VIA 
THE [Portal:PortalName] WEB SITE SHOULD NOT BE RELIED UPON FOR PERSONAL, MEDICAL, LEGAL OR FINAN-
CIAL DECISIONS AND YOU SHOULD CONSULT AN APPROPRIATE PROFESSIONAL FOR SPECIFIC ADVICE TAI-
LORED TO YOUR SITUATION.  

[Portal:PortalName] AND/OR ITS SUPPLIERS MAKE NO REPRESENTATIONS ABOUT THE SUITABILITY, RELIABILITY, 
AVAILABILITY, TIMELINESS, AND ACCURACY OF THE INFORMATION, SOFTWARE, PRODUCTS, SERVICES AND 
RELATED GRAPHICS CONTAINED ON THE [Portal:PortalName] WEB SITE FOR ANY PURPOSE. TO THE MAXIMUM 
EXTENT PERMITTED BY APPLICABLE LAW, ALL SUCH INFORMATION, SOFTWARE, PRODUCTS, SERVICES AND 
RELATED GRAPHICS ARE PROVIDED "AS IS" WITHOUT WARRANTY OR CONDITION OF ANY KIND. 



[Portal:PortalName] AND/OR ITS SUPPLIERS HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH 
REGARD TO THIS INFORMATION, SOFTWARE, PRODUCTS, SERVICES AND RELATED GRAPHICS, INCLUDING ALL 
IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE 
AND NON-INFRINGEMENT.  

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL [Portal:PortalName] AND/OR ITS 
SUPPLIERS BE LIABLE FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, CONSEQUENTIAL DAM-
AGES OR ANY DAMAGES WHATSOEVER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF USE, DATA 
OR PROFITS, ARISING OUT OF OR IN ANY WAY CONNECTED WITH THE USE OR PERFORMANCE OF THE [Por-
tal:PortalName] WEB SITE, WITH THE DELAY OR INABILITY TO USE THE [Portal:PortalName] WEB SITE OR RELATED 
SERVICES, THE PROVISION OF OR FAILURE TO PROVIDE SERVICES, OR FOR ANY INFORMATION, SOFTWARE, 
PRODUCTS, SERVICES AND RELATED GRAPHICS OBTAINED THROUGH THE [Portal:PortalName] WEB SITE, OR 
OTHERWISE ARISING OUT OF THE USE OF THE [Portal:PortalName] WEB SITE, WHETHER BASED ON CONTRACT, 
TORT, NEGLIGENCE, STRICT LIABILITY OR OTHERWISE, EVEN IF [Portal:PortalName] OR ANY OF ITS SUPPLIERS 
HAS BEEN ADVISED OF THE POSSIBILITY OF DAMAGES. BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIM-
ITATION MAY NOT APPLY TO YOU. IF YOU ARE DISSATISFIED WITH ANY PORTION OF THE [Portal:PortalName] WEB 
SITE, OR WITH ANY OF THESE TERMS OF USE, YOUR SOLE AND EXCLUSIVE REMEDY IS TO DISCONTINUE USING 
THE [Portal:PortalName] WEB SITE.  

SERVICE CONTACT : [Portal:Email] 

TERMINATION/ACCESS RESTRICTION 

[Portal:PortalName] reserves the right, in its sole discretion, to terminate your access to the [Portal:PortalName] Web Site 
and the related services or any portion thereof at any time, without notice. GENERAL To the maximum extent permitted by 
law, this agreement is governed by the laws of the State of Washington, U.S.A. and you hereby consent to the exclusive 
jurisdiction and venue of courts in King County, Washington, U.S.A. in all disputes arising out of or relating to the use of 
the [Portal:PortalName] Web Site. Use of the [Portal:PortalName] Web Site is unauthorized in any jurisdiction that does not 
give effect to all provisions of these terms and conditions, including without limitation this paragraph. You agree that no 
joint venture, partnership, employment, or agency relationship exists between you and [Portal:PortalName] as a result of 
this agreement or use of the [Portal:PortalName] Web Site. [Portal:PortalName]'s performance of this agreement is subject 
to existing laws and legal process, and nothing contained in this agreement is in derogation of [Portal:PortalName]'s right 
to comply with governmental, court and law enforcement requests or requirements relating to your use of the [Por-
tal:PortalName] Web Site or information provided to or gathered by [Portal:PortalName] with respect to such use. If any 
part of this agreement is determined to be invalid or unenforceable pursuant to applicable law including, but not limited to, 
the warranty disclaimers and liability limitations set forth above, then the invalid or unenforceable provision will be 
deemed superseded by a valid, enforceable provision that most closely matches the intent of the original provision and 
the remainder of the agreement shall continue in effect. Unless otherwise specified herein, this agreement constitutes the 
entire agreement between the user and [Portal:PortalName] with respect to the [Portal:PortalName] Web Site and it super-
sedes all prior or contemporaneous communications and proposals, whether electronic, oral or written, between the user 
and [Portal:PortalName] with respect to the [Portal:PortalName] Web Site. A printed version of this agreement and of any 
notice given in electronic form shall be admissible in judicial or administrative proceedings based upon or relating to this 
agreement to the same extent an d subject to the same conditions as other business documents and records originally 
generated and maintained in printed form. It is the express wish to the parties that this agreement and all related doc-
uments be drawn up in English.  

COPYRIGHT AND TRADEMARK NOTICES: 

All contents of the [Portal:PortalName] Web Site are: [Portal:FooterText] and/or its suppliers. All rights reserved.  

TRADEMARKS 

The names of actual companies and products mentioned herein may be the trademarks of their respective owners.  The 
example companies, organizations, products, people and events depicted herein are fictitious. No association with any 



real company, organization, product, person, or event is intended or should be inferred.  Any rights not expressly granted 
herein are reserved.  

NOTICES AND PROCEDURE FOR MAKING CLAIMS OF COPYRIGHT INFRINGEMENT 

Pursuant to Title 17, United States Code, Section 512(c)(2), notifications of claimed copyright infringement under United 
States copyright law should be sent to Service Provider's Designated Agent. 

ALL INQUIRIES NOT RELEVANT TO THE FOLLOWING PROCEDURE WILL RECEIVE NO RESPONSE. 

See Notice and Procedure for Making Claims of Copyright Infringement.  

User Lockout Email Message
The User Lockout email message is sent to the primary site Administrator when a user is locked out of their account.

Here is the default value (default text) of this email message  in the DNN core language pack:

An attempt was made to access a locked out user account ( username: [Custom:0] ) on [Date:Current]. You may wish to 
investigate this matter further... 

Thank you, 
[Portal:PortalName] 

Editing the User Lockout email

Recycle Bin
About the Recycle Bin Module
The Recycle Bin module stores all pages and modules that have been deleted from a site. These pages and modules can be restored to 
the portal or permanently removed.



The Pages Window

 l Pages are listed in the Recycle Bin by page name 

 l Pages are listed in the order that they were deleted from most recently deleted to first deleted

The Modules Window

 l Modules are listed in the Recycle Bin by page name - module title. E.g. Home - Announcements

 l Modules are listed in the order that they were deleted from most recently deleted to first deleted

Restoring Modules and Pages

 l Restoring a page will restore it to its previous location on the site menu. All modules (including content) will also be restored. 

 l A module (including content) is restored to a selected page

Deleting Modules and Pages

 l Deletion is permanent 

 l Page deletion includes modules and content 

 l Module deletion includes content

Tip: It is recommended that unwanted pages and module are regularly deleted from the recycle bin. This will ensures that the Recycle 
Bin doesn't become so large that Site Administrators must search through a large number of modules and pages to find the required 
item.



Viewing Pages and Modules in the Recycle Bin
How to view details of pages and modules that are stored in the Recycle Bin module. Users who are authorized to view the Recycle Bin 
module are able to see details of all pages and modules in the Recycle Bin. Users must have editing rights to restore or delete page and 
modules.

 1. Navigate to Admin > Recycle Bin - OR - Go to a Recycle Bin module. All deleted pages and modules are listed.

Viewing Pages and Modules in the Recycle Bin

Module Editors
Deleting Modules from the Recycle Bin
How to permanently delete one or more modules (including module content) from your site using the Recycle Bin module.

 1. Go to a Recycle Bin module.

 2. In the Modules window, select one or more modules. 

 3. Click the Delete  button. This displays the  message "Are You Sure You Wish To Permanently Delete This Module?" 

 4. Click OK to confirm deletion.



Permanently deleting one or more modules

Deleting Pages from the Recycle Bin 
How to permanently delete one or more pages (including modules and module content) from your database using the Recycle Bin mod-
ule.

 1. In the Pages window, click on the name of each page to be permanently deleted. 

 2. Click the Delete  button. This displays the "Are You Sure You Wish To Permanently Delete This Page" message. 

 3. Click OK to confirm deletion.



Deleting one or more pages

Emptying the Recycle Bin 
How to permanently delete all pages and modules from the Recycle Bin module.

 1. Click the Empty Recycle Bin link. This displays the  message "Are You Sure You Wish To Permanently Delete All Pages and 
Modules?"

 2. Click the OK button to confirm deletion.

Emptying the Recycle Bin



Restoring Deleted Modules
How to restore one or more deleted modules (including module content) to their original page using the Recycle Bin module.

 1. Navigate to Admin > Recycle Bin.

 2. In the Modules window, click on the name of each module to be restored. 

 3. Click the Restore  button.

Restoring deleted modules to a page

Restoring Deleted Pages
How to restore one or more deleted pages to the site using the Recycle Bin module. This restores the selected pages including any mod-
ules and module content on those pages prior to deletion. The pages are restored to their previous location in the pages list and site 
menu. 

Tip: You cannot restore a page whose parent page has also been deleted unless you restore the parent page first.  

 1. Navigate to Admin > Recycle Bin.

 2. In the              Pages window, click on the name of each page to be restored.

 3. Click the Restore  button.



Restoring deleted pages to the site

Troubleshooting: Page Cannot Be Restored Until Its Parent Is Restored First 
A yellow warning message is displayed if you attempt to restore a page whose parent page has also been deleted and is in the Recycle 
Bin. 

The message reads:  [PageName] Page Cannot Be Restored Until Its Parent Is Restored First.

If this happens you must first Restore  the parent page and then Restore  the child page .

Tip: Once you have restored the pages, you can always move the child page to a new location in the menu and delete the parent page.

Troubleshooting: Page Cannot Be Deleted Until Its Children Have Been Deleted First 
You will receive a yellow warning message if you attempt to delete a parent page that has one or more children pages in the Recycle 
Bin. 

The warning message reads:   [PageName] Page Cannot Be Deleted Until Its Children Have Been Deleted First.

In this case, here's how to delete both the children and parent pages:

 1. Click on the name of one or more child pages.

 2. Click the Delete  button.



 3. Click on the name of the parent page.

 4. Click the Delete  button.

If you don't want to permanently delete the children pages you can:

 1. Click on the name of the parent page.

 2. Click the Restore  button.

 3. Click on the name(s) of the child page(s).

 4. Click the Restore  button. 

 5. Modify the settings of the child pages and set them as parent pages or assign them a new parent. 

 6. Delete the parent and children pages so they are moved back to the Recycle Bin. 

 7. Click on the name of the parent page.

 8. Click the Delete  button.

Troubleshooting: Page Cannot Be Deleted Until Its Children Have Been Deleted First

Search Optimization
Google Analytics
About the Google Analytics Module
The Google Analytics (or Google Analytics Pro in DNN Professional Edition) module is located on the Admin > Google Analytics / Google 
Analytics Pro page and can also be added to any site page. This module enables Administrators and authorized users to analyze and 
improve online search results.



The Google Analytics Module

The Google Analytics Pro module includes the ability to add Segmentation Rules

What Is Google Analytics and why should I consider using it?

Taken directly from the Google Analytics site (http://www.google.ca/analytics/), Google Analytics is…
"…the enterprise-class web analytics solution that gives you rich insights into your web site traffic and marketing effec-
tiveness. Powerful, flexible and easy-to-use features now let you see and analyze your traffic data in an entirely new way. 
With Google Analytics, you're more prepared to write better-targeted ads, strengthen your marketing initiatives and create 
higher converting web sites."

Currently, some of the major feature points include:

 l Analytics Intelligence: Google Analytics monitors your reports and automatically alerts you of significant changes in data patterns. 

 l Advanced Segmentation: Isolate and analyze subsets of your traffic with a fast interactive segment builder. Only available 
in DotNetNuke Professional Edition

http://www.google.com/analytics/


 l Flexible Customization:  Get the data you need, organized in the way you want to see it with custom reports, custom variables, and 
a flexible tracking API.

 l E-Commence Tracking: Trace transactions to campaigns and keywords, get loyalty and latency metrics, and identify your revenue 
sources. GOALS Track sales and conversions. Measure your site engagement goals against threshold levels that you define. 
MOBILE TRACKING Track web-enabled phones, mobile web sites and mobile app's.

 l Data Export: API Integrate business information and develop applications that access Google Analytics data. 

 l Advance Analysis Tools: Perform advanced data analysis with pivot tables, filtering and multiple dimensions. Discover new trends 
and insights with motion chart visualizations.

 l Benchmarking Find out whether your site usage metrics under perform or outperform those in your industry.

How do I get an account?

For details on Google Analytics and to sign up for an account, visit the Google Analytics web site at http://www.google.com/analytics and 
look for the sign up link. 

Signing Up for GA
How to sign up for a Google Analytics account.

 1. Go to http://www.google.ca/analytics/.

 2. Click the Sign Up Now link and follow the prompts.

 3. Once you gain access to the Google Analytics dashboard, go ahead and create an account for your site. Here are different path-
ways for new users and existing Google Analytics users.

New Users

 1. At My Analytics Accounts (located on the top right) select "Create New Account" from the drop-down box and then click the Sign 
Up button. This displays the "Analytics: New Account Signup" page.

 2. Complete the "Analytics: New Account Signup" information as per your requirements, along with the Contact Information, and 
User Agreement pages.

http://www.google.com/analytics
http://www.google.com/analytics/


 3. Once complete, you will end up on the "Add Tracking" page, which should resemble something similar to the below image. The 
single most important piece of information on this page is the Tracking ID, based on the above screen shot our new Tracking ID is:  
“UA-17965093-1”.  Copy this down in a safe place.

Existing Users

 1. Existing Users should see their account on the home page of Google Analytics, something similar to this image:



 2. Under the Name field, click the relevant Domain which you need to start tracking.  It should switch over, and now the Name field 
includes the URL along with the tracking code to the right.  Similar to:

 3. As you can see above, the tracking code is “UA-78805-1”, copy this down into a safe place. You are now ready to begin "Setting 
Google Analytics".

Module Editors
Setting Google Analytics
How to configure Google Analytics for your site using the Google Analytics or the Google Analytics Pro module.  You must sign up for a 
Google Analytics account to complete this tutorial at                http://www.google.com/analytics/

 1. Go to a Google Analytics Pro or Google Analytics module - OR - Navigate to Admin > Google Analytics Pro or Google Ana-
lytics.

 2. In the Tracking ID text box, enter the web site tracking ID that you obtained from Google when you signed up for an account.

 3. Optional. In the URL Parameter text box, enter the Javascript code fragment that will be passed as a parameter to the page 
tracker (used to customize the value tracked in Google Analytics instead of the default location.href value).

http://www.google.com/analytics


 4. Click the  Update link.

Adding a Segmentation Rule

How to add up to 5 segmentation rules using the Google Analytics Pro module. Only available in DotNetNuke Professional Edi-
tion

Segmentation Rules allow you to isolate and analyze subsets of your traffic in a granular fashion.  The rule editor is designed to facilitate 
the creation of a list of rules that are enumerated in order until a match is found. The order of rules is important because the match criteria 
are Page, then membership within a Role. In order to see code emitted on the page, two conditions would have to be met: Restart app 
after changing rules as they are cached; and At least one rule much match.

 1. Go to the Segmentation Rules section of the Google Analytics Pro module.

 2. Click the Add Rule link. This displays the Edit Segmentation Rule section.

 3. In the Label text box, enter a name (label) for this rule.

 4. At Page, select the page name - OR - Select Any Page.

 5. At Role, select the role name - OR - Select Any Role.

 6. Click the Save link.

Editing a Segmentation Rule

How to edit a segmentation rule to the Google Analytics Pro module. Only available in DotNetNuke Professional Edition



 1. Go to the Segmentation Rules section of the Google Analytics Pro module.

 2. Click the Edit  button beside the rule to be edited. This displays the Edit Segmentation Rule section.

 3. Edit one or more fields as required.

 4. Click the Save link.

Deleting a Segmentation Rule

How to delete a segmentation rule from Google Analytics. Only available in DotNetNuke Professional Edition

 1. Go to the Segmentation Rules section of the Google Analytics Pro module.

 2. Click the Delete  button beside the required rule.

Search Admin
About the Search Admin Module
The Search Admin module enables authorized users to specify the settings associated with DNN's search capability which will be 
applied to this site.

Optional Settings:

 l Maximum and minimum word length when searching

 l Whether to include common words and numbers

 l Ability to re-index the search catalog (the content which is searched) if there has been significant changes since the last indexing

The Search Admin Module

Including Common Words in Searches
How to set searches made on this site to include common words such as 'the' using the Search Admin module.

 1. At Include Common Words, check  the check box to search for common words.

 2. Click the  Update link.



Including Common Words in Searches

Including Numbers in Searches
How to set searches made on this site to include numbers using the Site Admin module.

 1. At Include Numbers, check  the check box to include numbers in searches.

 2. Click the  Update link.

Including Numbers in Searches

Re-Indexing Searched Content
How to re-index the search content for maximum efficiency and to ensure all new content is included in searches made on this site using 
the Search Admin module. 

 1. Click the  Re-Index Content link to re-index the search content for maximum efficiency.



Re-indexing Searchable Content

Setting the Maximum Word Length for Searches
How to set the default maximum word length for searches on this site using the Search Admin module.

 1. In the Maximum Word Length text box, enter the maximum length word to search for as a numeric value. E.g. 20

 2. Click the  Update link.

Setting the  Maximum Word Length for Searches

Setting Minimum Word Length for Searches
How to set the default minimum word length for searches on this site using the Search Admin module.

 1. In the Minimum Word Length text box, enter the minimum length word to search for as a numeric value. E.g. 3

 2. Click the  Update link.



Setting the  Minimum Word Length for Searches

Search Crawler
About the Search Crawler Module Suite
The Search Crawler module suite ( also known as the DNN Search Engine) provides an enterprise level search engine capable of index-
ing and searching any site the Administrator chooses, as well as directly indexing physical directories.
Only available in DotNetNuke Enterprise Edition
The Search Crawler module suite consists of  three modules:

 l SearchCrawlerAdmin module. This module is located on the Host  > Professional Features > SearchCrawler Admin page. It can 
also be added to any page  if you choose to give an Administrator or another user the ability to manage the spider administration. 
See "About the SearchCrawlerAdmin module"

 l SearchCrawlerInput and SearchCrawlerResults modules. Neither of these modules are installed by default. See "Setting up 
Search Crawler Searching"

Important. The Search Engine must be configured before searches can be made. See "Enabling Search Crawler Functionality"

Module Version: 03.00.00

Minimum DNN Version: 05.05.00



The SearchCrawlerAdmin module

The SearchCrawlerInput module

The SearchCrawlerResults module

PDF and Microsoft Office Documents (Word, Excel, and PowerPoint) are also indexed by default. 

Features:



 l Allows for multiple sites to be indexed

 l Indexing of PDF and Microsoft Office Documents (Word, Excel, and PowerPoint). Once indexed, the content of the PDF is search-
able.

 l Integrated DNN security while spidering, and spidering as a particular role (with the role’s view access).

 l Meta Data contained in the meta data tags such as Description tag will be relevant in a query, and results will be displayed if the 
query term matches the information found in such a tag.

 l Search Input implemented as a Skin Object. You can include the search input box directly into your skin as a Skin Object, so that it 
will appear on every page on your site, with no need to add it as a module.

 l Configurable Search Scope. Every search result module can be configured to limit the search results to only some of the sites that 
the spider has indexed. This is helpful in case you have different searches in different pages on your site, and only want to show 
results from specific sites.

 l Configurable Search Impersonation. When spidering your own site, you can impersonate a role other than the anonymous user. 
This will allow you to index content that was not previously accessible to the spider. All the pages available to a user in the role 
you selected will be indexed by the spider.

 l Compliance with META directives. Follow the directives of "no index", "no follow" that can be found on some web pages. This way, 
if these directives are present, the page will either not be indexed and/or its links not be followed nor spidered.

 l Automatic exclusion of anonymous modules.  Pages such as Privacy, Terms, Login and Register, are in reality modules that load 
in the same page where the user is referencing them from. This means that from DNN, you can access the same content from dif-
ferent URL's. This caused searches for terms such as "terms" that appear in the Terms page, to appear listed as many times as 
there were pages on your site. With this new version, they will only appear once.

General Notes

 l All styles can be changed through the module.css style sheet found in the module’s specific directories.

 l All text can be localized through the .resx files found in the App_LocalResources directories in the module’s specific directories.

Configuration
Enabling Search Crawler Functionality
The following steps must be completed to configure the Search Crawler ( DNN Search Engine) for your site.

1. Set Your Site to Full Trust
Lucene.net requires your web site to be running on Full Trust. The <trust> element in the web.config, configures the level of code access 
security (CAS) that is applied to an application. By default, Web applications run with Full trust, or with the trust configured in the web.co-
nfig or machine.config. When the trust level is set in a DNN default installation, it is set to Medium. You will need to verify this setting in 
the web.config and set it to Full as in the example below:

Required web.config <trust> settings
<system.web>

...

<trust level="Full" originUrl="http://localhost/.*" />

...

</system.web>



2. Enable Search Crawler Task in Schedule
The SearchCrawler task must be enabled in the Schedule. This task is not enabled by default. See "Enabling/Disabling Scheduled 
Tasks"

3. Add URL's for Indexing
See "Adding URL's for Indexing"

Configuring the SearchCrawlerAdmin module
Here's how to quickly enable spidering of a URL using the SearchCrawlerAdmin module. A spider is a program that visits all the pages of 
the web site which you have configured for crawler. The spidermakes an index of their content. Note: For sites with many links, you will 
need to add at least one duplicate pattern. See "Adding a Duplicate Pattern"

 1. Navigate to Host > Professional Features >  SearchCrawler Admin. This displays the Paths tab of the SearchCrawlerAdmin 
module.

 2. In the URL(s) To Index, enter the URL to spider. E.g. http://www.domain.com



 3. Click the Add URL  button. The URL (if valid) will automatically be added to the list of available URL's. If enabled ( See "Ena-
bling/Disabling Scheduled Tasks" ) , the Search Engine will index its contents next time the Schedule runs or when you chose to 
run it (See "Running a Task" )

 4. Click the Update link.

Configuring Search Crawler  Modules for Upgrade Portals
How to set up your upgraded portal to prepare to use the Search Crawler (DNN Search Engine) modules. This task must be performed 
by an Administrator (or a SuperUser) prior to configuring searches. Note: This task is only required for DNN Professional Edition.

 1. Navigate to Admin > Pages.

 2. Locate and view the Search Results page. See "Viewing any Page (Pages Module)". This displays the Search Results page.

 3. Delete the core Search Results module from the Search Results page. See "Deleting a Module"

 4. Add the SearchCrawlerResults module to the Search Results page. See "Adding a New Module (RibbonBar)"

 5. Navigate to Admin > Site Settings.

 6.  Set the Search Results Page setting to the Search Results page. See "Setting the Search Results Page"

All Users
Performing a Search
How to perform a search using the SearchCrawlerInput module. Results are displayed using the SearchCrawlerResults module, which 
may be located on another page.

 1. Go to a SearchCrawlerInput module - OR - Use the Search box, typically located in the top right corner of all site pages.

 2. Enter a keyword into  text box - OR - . E.g. toys



 3. Click the  Search  icon or button- OR - Strike the Enter key to perform your search. Note: Striking the Enter key to search may 
be disabled on this module. This displays your search results in the associated SearchCrawlerResults module.

 4. Review the displayed results and then click on a linked result title to view it.

Search Results

Related Topics:

 l "Help with Search Queries".

Help with Search Queries
The SearchCrawlerInput module allows you to enter the query term or phrase. There is a rich syntax that allows you to fine tune your 
searches and obtain very accurate results as shown in the tips below:



Sample Query Syntax

Query Example Notes
single term document Searches for documents that contain "document" term in the default field.

phrase "important document" Searches for documents that contain the phrase "important document" in the default 
fields.

searching 
fields title:document Searches for documents that contain "document" term in the "title" field.

wildcard 
search doc?ment Single-character wildcard search. It will match "document" and "dociment" but not 

"docooment".

 document* Multi-character wildcard search. It will match "document" and "documentation".

fuzzy search document~ Search based on similar spelling.

 document~0.9 Search based on similar spelling. 0.9 is the required similarity (default: 0.5)

proximity 
search "important document"~5 Find words of a phrase that are not next to each other. Maximum distance in this exam-

ple is 5 words.

range search author:{Einstein TO Newton} Searches for document with "author" field value between specified values.

 date:{20050101 TO 20050201} Searches for document with "date" field (DateTime type) value between specified dates.

relevance important^4 document Set boost factor of the term "important" to 4. Default boost factor is 1.

 "important document"^4 You can set boost factor for phrases too.

 "search engine"  

OR operator important document "OR" is the default operator.

 important OR document The default field must contain either "important" or "document".

AND operator important AND document The default field must contain both word.

+ operator important +document The default field must contain "document" and may contain "important".

NOT/- oper-
ator -important document The default field must contain "document" but not "important".

grouping (important OR office) AND doc-
ument Use parentheses for expression grouping.

 author:(Einstein OR Newton) Parentheses work with fields as well.

Prohibited Queries

Query Example Notes

wildcard at the beginning of a term ?ocument 
*ocument Throws Lucene.Net.QueryParsers.ParseException.

stop words a, the, and Stop words are not indexed.

special characters: + - && || ! ( ) { } [ ] ^ " ~ * ? : \ \+, \: Use a backslash to escape the special characters.

Module Editors
Setting up Search Crawler Searching
How to add Search Crawler (DNN Search Engine) searching to a page using the SearchCrawlerInput and SearchCrawlerResults mod-
ules. Note: User's must be granted Add Content permissions for the required page to undertake this tutorial.

 1. Add an instance of the  SearchCrawlerInput module to a page. See "Adding a New Module (RibbonBar)", or "Adding an Existing 
Module (RibbonBar)"..



 2. Optional. Add an instance of the SearchCrawlerResults module to a page. Note: The SearchCrawlerResults module can be 
located on another page if preferred. If no SearchCrawlerResults module is added, then the default Search Results page is used.

 3. Go to the SearchCrawlerInput module.

 4. Select  Settings from the module actions menu - OR - Click the Settings  button.

 5. Go to the SearchCrawler Input Settings section.

 6. At Search Results Module, select the SearchCrawlerResults module which will display the results of searches made with this 
SearchCrawlerInput module from the drop-down list. SearchCrawlerResults modules are listed by page name (E.g. Home). If 
there are no SearchCrawlerResults modules on any site page, then the default Search Results page is used.

 7. Click the  Update link.

Upgrading Existing Sites
The Administrator of existing sites will need to undertake these steps to prepare to use these search modules.

 1. Remove the core Search Results module from the Search Results page.

 2. Add the SearchCrawlerResults module to the Search Results page.

 3. In Admin/Site Settings set the Search Results Page setting to the Search Results page.

Related Topics:

 l See "Configuring the SearchCrawler Input Settings"

Settings
Configuring the SearchCrawler Input Settings
How to set the mandatory and optional settings for the SearchCrawlerInput module.



Important. If you are using a Professional Edition site which has just been upgraded to include these search modules, Administrators 
must undertake some basic steps prior to configuring upgraded web sites. See "Configuring Search Crawler  Modules for Upgrade Por-
tals"

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the SearchCrawler Input Settings section.

 3. At Search Results Module, select the SearchCrawlerResults module which will display the results of searches made with this 
SearchCrawlerInput module from the drop-down list. SearchCrawlerResults modules are listed by page name (E.g. Home).

 4. Optional. At Show Go Image, select from the following: 

 l Check  the check box to display the Execute Search  button.

 l Uncheck  the check box to display the default Search button of your Web browser.

 5. Optional. At Show Search Text, select from the following: 

 l Check  the check box to display the text "Search" to the left of the search input box on this module.

 l Uncheck  the check box to remove the Search image.

 6. Optional. At Show On Enter, select from the following:

 l Check  the check box to enable users to click the Enter key to perform a search.

 l Uncheck  the check box to disable Enter key to perform a search.

 7. Click the  Update link.



Configuring the SearchCrawler Input Settings

Configuring the SearchCrawler Results Settings
How to set the mandatory and optional settings for the SearchCrawlerResults module.

 1. Select  Settings from the module actions menu - OR - Click the Settings  button.

 2. Go to the SearchCrawler Results Settings section and set any of these Optional settings:

 a. At Show Module On Search Only?, select from the following: 

 l Check  the check box to always display this module on the page.

 l Uncheck  the check box to hide this module until a search is made. This is the default setting.

 b. At Display Results By Role?, select from the following:

 l Check  the check box to enforce user role's view permissions. If the user cannot access a page, then it will not be 
displayed to them in the search results. 
Note: This option will only work if the index you are getting the results from is on the same DNN installation as the 
SearchCrawlerAdmin module. It enforces user role's view permissions. If the user cannot access a page, then it will 
not be displayed in the search results. Note: The way this option works does not guarantee 100% accurate results. 
The search results module will detect if there is a tabid parameter in the URL of the result. If there is a tabid, then it 
will look for the corresponding portal or child portal permission for the user that is doing the search. If the per-
missions the current user has, are apt to see the page, then the result is displayed, otherwise it is not. What this 
method does not take into consideration is module level permissions. Also, some URL's contain additional param-
eters such as ctl=edit that share tabid but do not share view permissions. The module will not detect that, and will 
show the result in any case if the user has view permission on the tabid. If a result is shown and the user does not 
have permission to navigate to that page, the user will be prompted to login when they click the link.

 l Uncheck  the check box to display all results.

 c. At Results Scope, select the sites to be included in search results displayed using this module. Tip: Hold down the Ctrl 
key to select multiple URL's. By default, all sites are selected. Important. If you do limit the scope, keep in mind that any 
modification that you make to the name of one of the URL's that you did select from the list, will cause that URL to be 
dropped, so you will need to go back to the settings and select it again.

 d. In the  Max. Results Per Page text box,  enter the maximum number of results to display in a page. The default setting is 
10.



 e. In the  Max. Title Length text box,  enter the maximum number of characters that will appear in the title portion of each 
search result. This is useful to avoid the title wrapping when you only have limited horizontal space on your web site. The 
default setting is 100.

 f. At Title Link Target, select to open the link associated with a result in either the Same Page or a New Window (I.e. open a 
new Web browser).

 g. In the  Max. Description Frags text box,  enter the maximum number of "..." separated bits of descriptions that will appear in 
the description portion of each search result. The default setting is 3.

 h.  At Hide Description?, select from the following:

 l Check  the check box to hide the description in the search results.

 l Uncheck  the check box to display the description in the search results. This is the default setting.

 3. Click the  Update link.

Configuring the SearchCrawler Results Settings

SearchCrawlerAdmin
About the SearchCrawlerAdmin module
The SearchCrawlerAdmin module forms part of the Search Crawler module suite. It is located on the Host > Professional Features 
> SearchCrawler Admin page and can be added to additional pages. This module is used to configure the settings relative to the spider.



SearchCrawlerAdmin module

Related Topics:

 l See "About the Search Crawler Module Suite"

Adding URL's for Indexing
How to add one or more URL's to specific sites and/or directories to be indexed using the SearchCrawlerAdmin module.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the  SearchCrawlerAdmin module with the Paths tab selected.

 2. In the URL(s) to Index text box, enter the URL's of the web sites that you want the Search Crawler (DNN Search Engine) to index 
through a spider crawl.



 3. Click the Add URL  button. The URL (if valid) will automatically be added to the list of available URL's that the spider will index 
by default. The URL is added to a grid like list, where there are various columns and check boxes. You may now wish to under-
take "Adding Directories to the Index".

Tip: Always point to the default URL. E.g: http://www.website.com and NOT http://www.website.com/default.aspx. This is 
because the spider will go to the first page you indicate, and from there, start collecting links to all the pages in the site. So, eventually, it 
will get to any specific page you need.

Enabling/Disabling Spidering
How to enable or disable spidering of one or more URL's set for indexing using the SearchCrawlerAdmin module.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the  SearchCrawlerAdmin module with the Paths tab selected.

 2. Go to the URL(s) to Index field which displays a table listing all of the URL's which are indexed for spidering.

 3. At Enable Spidering, select from these options:

 l Check  the check box to display event detail on a new page. This is the default setting.

 l Uncheck  the check box to display event details on the same page. If you uncheck it and click on “Update”, the spider 
will not index the site (or, if it has already been indexed, it will not repeat the indexing next time the spider runs). This is 
very useful in case you want to spider many sites, but there are some that you do not want to refresh on every run.



 4. Click the Update link.

Managing URL's for Indexing
How to manage the URL's and functionality related to the specific sites and/or directories to be indexed using the SearchCrawlerAdmin 
module.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the  SearchCrawlerAdmin module with the Paths tab selected.

 2. Go to the      URL(s) to Index field. Each of the indexed URL's are listed in a grid.

 3. In the URL grid, Click the Edit URL  button beside the URL to be edited. This displays the Edit Url page.

 4. In the URL text box, view/edit the URL of the site that the spider is going to index.

 5. At Enable Spidering, select from these options:

 l Check  the check box to display event detail on a new page. This is the default setting.

 l Uncheck  the check box to display event details on the same page. If you uncheck it and click on “Update”, the spider 
will not index the site (or, if it has already been indexed, it will not repeat the indexing next time the spider runs). This is 
very useful in case you want to spider many sites, but there are some that you do not want to refresh on every run.

 6. At DNN Role Impersonation,  select the type of role that the spider should use to index your site. Essentially the spider makes 
requests to pages and follows the links it encounters on those pages. If you tell the spider to impersonate a particular role, it will 
make requests to pages that the role you have selected has access to. For example, if you select the Administrators role, pages 
where only an admin has access to will be indexed as well. 
In order for DNN Role Impersonation to be enabled, the site must exist in the same DotNetNuke instance (database) where the 
spider is installed. This means that a portal and all of its child portals are eligible for DNN Role Impersonation, as long as the 
spider is installed on that portal.



 7. Optional. At Windows Authentication, select from these options:

 l Check  the check box to enable Windows Authentication (See Notes below) and set any of these optional settings:

 a. In the Windows Domain  (optional) text box, enter the Computer Domain of the user account that will be used.

 b. In the Windows User Account (optional) text box, enter Login Name (user account) that will be used.

 c. In the Windows User Password (optional) text box, enter the Password that will be used.

 l Uncheck  the check box to disable Windows Authentication.

 8. Click the Update URL link.

Notes on Windows Authentication

If the site you want to index is an intranet (technically: if the IIS authentication methods does not allow Anonymous Access, and requires 
Integrated Windows Authentication as in the below image), then you want to enable Windows Authentication.



Clicking on the Windows Authentication checkbox of the SearchCrawlerAdmin module, will tell the spider to use the Default User Cre-
dentials that are stored on the server where Search Crawler (DNN Search Engine) is installed. This will work in most cases where the 
Search Crawler (DNN Search Engine) modules are installed in the same server as the site you want to spider. If you want to index a 
remote site, or you simply need to use a specific user, then you can fill in the rest of the information such as Windows Domain, Windows 
User Account and Windows User Password.

Important. If the site you want to spider is a DNN site using the ADSI authentication provider, then the steps above are still valid, but will 
only be applicable if the SearchCrawlerAdmin module is installed in the same server or network as the site you want to spider.



Deleting URL's from Indexing
How to permanently delete one or more URL's from the list of spidered sites using the SearchCrawlerAdmin module.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module with the Paths tab selected.

 2. Go to the               URL(s) to Index field. Each of the indexed URL's are listed in a grid.

 3. In the URL grid, Click the Delete URL  button beside the URL to be deleted. This displays the message "Are You Sure You 
Wish To Delete This Item?" 

 4. Click the OK button to confirm.

 5. Click the Update URL link.

Adding Directories to the Index
How to add one or more directories for indexing using the SearchCrawlerAdmin module. The Spider will directly access your file system 
and index the contents of the directory you specify. The index created through direct directory access, will be seamlessly integrated into 
the search results.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module with the Paths tab selected.

 2. At      Directory(ies) to Index,  select the directory that you would like the Search Crawler (DNN Search Engine) to index directly, with-
out performing a web site crawl, from the drop-down box.



 3. Click the Add a Directory  button to add the directory to the list of directories that the spider will index. This adds the directory 
to the list below. If multiple portal aliases exist for the newly added directory, then a second drop-down box is now displayed on 
this page.

 4. At Select a new the Portal Alias, select the required portal alias.

 5. Click the Update link.



Tip One: The list of directories that can be indexed is limited to the directories found under the “<dnn_root>/Portals” folder. This folder is 
where the default portal and all child portals are created.

Tip Two: All the files in that directory will be indexed, regardless of any access level you might have assigned through the File Manager.

Tip Three: If you index a directory in this way, and you also perform an index of the Web site that has links to some of the documents in 
the directory, you may get duplicate results.

Deleting Directories from the Index
How to delete one or more directories set for indexing using the SearchCrawlerAdmin module.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module with the Paths tab selected.

 2. At                 Director(ies) to Index, select the directory to be deleted from the list of directories.

 3. Click the Delete The Selected Directory  button to remove it to the list of directories to be spidering.

Deleting Directories from the Index

Managing Spidered Documents
How to select which documents can or cannot be indexed using the SearchCrawlerAdmin module. These settings are global to all sites 
and/or directories that you will spider.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module.

 2. Select the Documents tab.



 3. At Spider MSOffice Documents, check  the check box beside each type of Microsoft Office document that you would like the 
spider to index. The following options are available: MS Word, MS Excel, and MS PowerPoint.

 4. At Spider Pdf Documents, click on the checkbox corresponding to the PDF document that you would like the spider to index.

 5. At Excluded Document Types, you can maintain a list of the file extensions to be ignored by the spider ( The spider also main-
tains an internal list of file types that are automatically excluded, such as images, style sheets etc… ). For example, if your site con-
tains many .txt files that you do not want to be indexed, adding the .txt extension to the list will bypass these files, and make your 
spider faster.

 l To add an extension: enter the required extension in the text box and then click the Add  button.

 l To remove an extension: select the extension in the list and then click the Delete  button.

 6. Click the Update link.

Managing Spidered Documents (Adding an excluded document shown)



Setting SearchCrawlerAdmin Options
How to set the Options tab which groups miscellaneous functionality related to spider paths and performance on the Search-
CrawlerAdmin module. These settings are global. 

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module.

 2. Select the Options tab.

 3. At Spider Index Path,  enter the  relative path of the folder where the Spider Index will be stored. E.g.  Desk-
topModules\DNNCorp\SearchEngine\Input\Index

 4. At Spider Threads, enter the number of threads that the Spider will use. A maximum of 10 is allowed. For “best” performance you 
can use up to 10 separate threads. Having multiple threads allows you to spider and index more than one page at a time, pos-
sibly improving indexing times. However, it also means that more memory resources are utilized by the spider. Tip: DNN hosted 
sites are especially vulnerable to a lack of memory resources. It is advisable to leave this parameter to its default value of 1.

 5. At Spider Encoding Mode, select the required encoding mode from the following options:

 l Quick: Select this option if the  sites you are indexing use Western character set encoding or, in case of  Non-Western char-
acter sets, Content-Type is always returned in the HTML headers

 l Deep: Select if you are spidering sites that do not use Western Characters (such as Chinese).

 6. Click the Update link.

Tip - Spider Index Path
When you spider a site, there are two physical directories created, that will be placed under the “Spider Index Path” that you have indi-
cated. The first directory takes the name of the url being spidered, and is considered a working directory. The second directory is what is 
used during a search, and is a copy of the last index the spider completed successfully. 
For Example: If you want to index http//:www.yoursite.com, the spider will create a the following directory:

<DNN root>/DesktopModules/XSSearchInput/Index/www.yoursite.com

Then, when the spider completes successfully, the contents of the above directory, will be copied to

<DNN root>/DesktopModules/XSSearchInput/Index/www.yoursite.com.out

Having a working directory avoids that user searches, that occur while the spider is working, be affected by the index being created.

Tip - Encoding: Text encoding is what allows the spider to read, store and search html text correctly. Since determining the right encod-
ing can be a resources intensive task, Search Crawler (DNN Search Engine) provides two ways of doing it.



Quick and Deep what is the real difference?
Quick tries to get the encoding from the HttpRequest's Content Type. This attribute is not always set, so, if it is blank, the spider defaults to 
iso-8859-1 encoding, which encompasses Western Characters. 
Enter the rest of the world: the Deep mode. In the above scenario, the spider would not work if we were to spider a site written in Chinese 
or Arabic. To determine the encoding, if the HttpRequest’s Content Type attribute was empty, we would need to inspect the HTML and 
look for the charset meta tag, that tells us what character set the site is using. In order to do this, the page needs to be downloaded as 
ASCII, scanned, and the value of charset collected. Based on that, we can determine the appropriate encoding. This is quite more expen-
sive than the Quick method, so use it when necessary only.

Adding a Duplicate Pattern
How to add a duplicate pattern to the SearchCrawlerAdmin module. The Duplicates tab allows the manipulation and creation of what is 
called Duplicate Patterns. This functionality is specific to the indexing of DNN sites, and is meant as a means to reduce duplicates in the 
search results. Duplicate Patterns are regular expressions that recognize URL parameters. Thanks to duplicate patterns, by default, in a 
DNN site, the spider indexes the same "tabid" only once. If you have a control that through the use of URL parameters posts to the same 
page, and creates dynamic content through URL parameters, then you will have to create a regular expression that recognizes such 
parameters and add it to the list. The Spider will recognize the parameters and not consider the same "tabid" as a duplicate.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module.

 2. Select the Duplicates tab.

 3. In the Duplicate Patterns text box, enter the regular expression that will recognize the parameters specific to a module, which will 
change the content of the html dynamically.

 4. Click the Add  button. A record for this item is added to the list below.



 5. Click the Edit  button beside the newly added record. This opens the Edit  Duplicate Pattern page.

 6. In the Description text box, update the automatically generated code with a friendly name. E.g. NewsID

 7. Click the Update Duplicate Pattern link.



Tip: Duplicate Patterns are stored in an XML file in the <DNN root>/De-
sktopModules/XSSearchSpider/XSSearchSpiderDuplicatePatterns.xml file. For the correct functioning of the duplicates reduction 
mechanism, some entries are required: Tabid, ctl terms, and ctl privacy. You can always choose not to filter for duplicates and delete all 
entries, or simply delete the physical .xml file.

Example One:

You have just installed a fantastic “custom links module” that shows a brief description and a “more…” link, to see the details. Clicking on 
the more… link, will cause a refresh of the page, and the links module will disappear to be replaced by some very interesting details. Yes, 
you are still on the same page, your view has simply changed because clicking on more… caused the URL of your Web browser to get 
an additional parameter: newsid=xx

So, here is what the spider sees by default:

Before clicking on more…:

URL: http://www.yoursite.com/default.aspx?tabid=1

After clicking on more…:

URL: http://www.yoursite.com/default.aspx?tabid=1&newsid=1

Since in both cases tabid=1, then the spider would not follow the more… link, because it would consider it a duplicate.

We then need to teach the spider that tabid=x + newsid=x is a unique identifier for a page. Since tabid is already taken care of by another 
regular expression (one of the required ones), we only need to worry about recognizing newsid.

The easiest thing to do is to copy a regular expression that already exists on the list, and start modifying it. We’ll take the one that rec-
ognizes tabid as a template since it recognizes a single parameter that is a number.

tabid=(?<id>\d*[^&])|tabid/(?<id>\d*[^/]) 

you will see there is a "|" in the middle of the regex. This is the equivalent of an "or" because all of our regular expressions need to rec-
ognize 2 formats: regular URLs and friendly URLs. The left side recognizes normal URLs and the right side of the "|" recognizes friendly 
URLs.

Let’s take the left side of the "or" and analyze that:



tabid=(?<id>\d*[^&])

this tells me that I am looking for something that starts with tabid=, and I want to capture the value to the right of the "=" sign, which is a 
decimal (\d*), up to the first occurrence of an “&” and place this value in a variable called <id>… in English: gimme the value of the param-
eter tabid.

We want to do exactly the same for our newsid parameter. So let’s start changing some names: tabid will become newsid (and that's 
really all you need to do).

newsid=(?<id>\d*[^&])|newsid/(?<id>\d*[^/])

that's all. Notice the following:

 l If the value of newsid had been an alphanumeric instead of a number, then you could have used \w* instead of \d*.

 l The name of the variable <id> where you will place the value is irrelevant, as long as it is unique within the same regular expres-
sion.

Adding the above regular expression to the list of Duplicate Patterns, will ensure that the spider will index not only the list of links, but 
also the details of every link.

Editing a Duplicate Pattern
How to edit a duplicate pattern using regular expressions, as maintained using the SearchCrawlerAdmin module.

 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module.

 2. Select the Duplicates tab.

 3. In the list of regular expressions, click the Edit  button beside the item to be edited. This opens the Edit  Duplicate Pattern page.

 4. In the Description text box, edit the name given to this regular expression.

 5. In the Regex Pattern text box, edit the name given to this regular expression.

 6. Click the Update Duplicate Pattern link.

Editing a Duplicate Pattern

Deleting a Duplicate Pattern
How to delete a duplicate pattern using regular expressions, as maintained using the SearchCrawlerAdmin module.



 1. Navigate to Host > Professional Features >  SearchCrawler Admin - OR - Go to a SearchCrawlerAdmin module. This displays 
the SearchCrawlerAdmin module.

 2. Select the Duplicates tab.

 3. In the list of regular expressions, click the Delete Regex  button beside the required item. This displays the message "Are You 
Sure You Wish To Delete This Item?" 

 4. Click the OK button to confirm.

Deleting a Duplicate Pattern

Search Engine SiteMap
About the Search Engine SiteMap Module
The Search Engine SiteMap (or Sitemap) module enables authorized users (any user authorized to view the module), to configure a Site-
Map which can be submitted to one or more search engines for improved search optimization.



Sitemap providers for DotNetNuke allows any DotNetNuke module to participate into the Google/Yahoo!/Bing Sitemap generation for 
your site.  Sitemap files generated by DotNetNuke Sitemap provider are fully compliant with protocol specification published at: 
http://www.sitemaps.org/protocol.php

The Sitemap Module

Configuring the SiteMap Settings
How to configure the search engine settings and priorities using the Sitemap module.

 1. Navigate to Admin > Search Engine Sitemap - OR - Go to a Sitemap module.

 2. At Sitemap URL, here you can view the URL of your Sitemap as well as the Sitemap providers which are enabled. E.g. http://-
ecozany.com/SiteMap.aspx

http://www.sitemaps.org/protocol.php


 3. Optional. Go to the Base Page URL's Settings section. Here you can modify the basic settings that apply to general DotNetNuke 
pages.

 a. At Use page level based priorities?, select from these options:

 l Check  the check box to set the priority for each page based on the hierarchical level of the page. Top level (par-
ent) pages will have a value of 1, second level (first level child pages) 0.9, third level 0.8,  (second level child 
pages), etc. This setting will not change the value stored in the actual page but it will use the computed value when 
required.

 l Uncheck  the check box if you don't wish to use page level based priorities. Skip to step 3c.

 b. In the Minimum Priority for pages text box, if Use page level based priorities? is checked, this field allows you set the 
lowest priority that will be used on low level pages.  You must provide a valid number between 0.0 and 1.0.

 c. At Include Hidden Pages? select from these options:

 l Check  the check box to include hidden pages (those not visible in the menu)  in the Sitemap. 

 l Uncheck  the check box to exclude hidden pages from the Sitemap. This is the default setting.

 d. Click the Refresh Sitemap Priorities link.

 4. Optional. Go to the General Sitemap Settings section. Here you can configure the settings that apply to all URL's included in the 
Sitemap.

 a. In the Exclude URL's with a priority lower than text box, enter a number between 0.0 and 1.0 This option can be used to 
remove certain pages from the Sitemap. For example you can setup a priority of -1 for a page and enter -1 here to cause 
the page to be excluded from the generated Sitemap.

 b. At Days To Cache Sitemap For select from these options:

 l To enable Sitemap caching: Select the number of days (from 1 Day to 7 Days) the Sitemap is cached for. This 
stops the Sitemap from being generated every time it is requested. This is especially necessary for big sites. If your 
site has more than 50.000 URL's the Sitemap will be cached with a default value of 1 day. 

 l To disable Sitemap caching: Set this value to zero. I.e. 0

 c. Click the Save Sitemap Configuration link.



Configuring Sitemap Settings

Purging Cached Sitemap
How to purge the currently cached Sitemap forcing it to be regenerated on the next request.

 1. Navigate to Admin > Search Engine Sitemap - OR - Go to a Sitemap module.

 2. Go to the General Sitemap Settings section. 

 3. At Days To Cache Sitemap For, click the Clear Cache link.

Purging the cached Sitemap

Setting the Sitemap Providers
How to enable and configure one or more Sitemap providers to be used for your DNN site. DNN comes with a default provider named 
coreSitemapProvider. It also uses a provider model to allow third-party modules to participate in Sitemap generation.

 1. Navigate to Admin > Search Engine Sitemap - OR - Go to a Sitemap module.

 2. Below the                 Sitemap URL field, you can view details Sitemap provider which is in use.

 3. Click the Edit link beside the Sitemap Provider to be modified.

 4. At Enabled, select from these options:

 l Check  the check box to enable this Sitemap provider. If only one provider is enabled, skip to Step 5.

 i. Optional. At Override Priority, check  the check box to override the priority given to pages crawled by a Sitemap 
provider - OR - Uncheck  the check box to use the priority given to pages crawled by a Sitemap provider. 

 ii. Optional. In the Priority text box, enter a numerical value to set the priority for this provider.



 l Uncheck  the check box to disable it.

 5. Click the Update link.

Setting the Sitemap Providers

Submitting Site to Google
How to submit a site for indexing to the Google search engine   using the Sitemap module. This tutorial assumes you have already con-
figured the Sitemap settings. See "Configuring the SiteMap Settings"

 1. Navigate to Admin > Search Engine Sitemap - OR - Go to a Sitemap module.

 2. Go to the Site Submission section.

 3. At Search Engine, select Google.

 4. When signing up with Google Webmaster Tools you will need to Verify your site ownership. Choose the "Upload an HTML file" 
method from the Google Verification screen.

 5. In the Verification text box, enter the filename displayed. I.e. google53c0cef435b2b81e.html

 6. Click the Create link.

 7. Return to Google and select the Verify button.

 8. Return to the Sitemap module.

 9. At Search Engine, click the Submit link.

Submitting Site to Google

Submitting Site to Yahoo! or Bing
How to submit a site for indexing to either the Yahoo! or Bing search engine using the Sitemap module.

 1. Navigate to Admin > Search Engine Sitemap - OR - Go to a Sitemap module.

 2. Go to the Site Submission section.

 3. At Search Engine, select either Bing or Yahoo!.



 4. Click the Submit link.

 5. Repeat Steps 3-4 to submit the site to the other search engine if desired.

Submitting Sitemap to Yahoo! or Bing

Taxonomy Manager
About the Taxonomy Manager Module
The Taxonomy Manager module is located on Admin > Taxonomy page and can also be added to site pages. This module enables the 
management of vocabularies (tags). These tags can be associated with pages (See "Page Details Settings for Existing Pages") and mod-
ules and are also used to classify site content. 

The Taxonomy Manager module enables authorized users to view vocabularies. Editors and Administrators can create and manage por-
tal specific vocabularies. SuperUsers can create and manage application wide vocabularies which are available to all portals. User 
created tags (See "Tagging Page Content") are managed using the Taxonomy Manager module.

The Taxonomy Manager Module

Viewing Vocabularies List
Users who are authorized to view the Taxonomy Manager module are able to view the list of vocabularies which have been created.

The Taxonomy Manager module displays the following information:

 l Name: The Vocabulary name

 l Description: The description given to the vocabulary

 l Type: Whether the vocabulary is a simple or hierarchical list

 l Scope: Whether the vocabulary is available to all portals in this DNN application (i.e. Application) or only this portal (i.e. Portal).



The Taxonomy Module

Module Editors
Adding the First Term (Hierarchical Vocabulary)
How to add the first term to a hierarchical vocabulary using the Taxonomy Manager module. Important. It is recommended that you name 
this first term the same as the Vocabulary name. This allows you to create a hierarchical tree of terms. Failure to set up terms in this way 
will restrict you to only one top level parent term.

 1. Click the Edit link beside the vocabulary for the new terms.  This opens the Edit Vocabulary page.

 2. Click the Add New button. This displays the Create New Term section.

 3. In the Create New Term section, complete these fields:

 a. In the Name text box, enter the vocabulary name.

 b. In the Description text box, enter a description for this term. Tip: Copying the Vocabulary description is suitable.

 4. Click the Save button.

 5. The newly added term is now displayed in the Terms section. You can now add additional terms. See "Adding Additional Terms 
(Hierarchical Vocabulary)"



The newly added first hierarchical term

Adding Additional Terms (Hierarchical Vocabulary)
How to add terms to a hierarchical vocabulary using the Taxonomy Manager module.

Important. The first term for a vocabulary requires a different process. See "Adding the First Term (Hierarchical Vocabulary)"

 1. Click the Edit link beside the vocabulary for this term. This opens the Edit Vocabulary page.

 2. Click the Add New button. This displays the Create New Term section.

 3. In the Create New Term section, complete these fields:

 a. In the Name text box, enter a name for this term.

 b. In the Description text box, enter a description for this term.

 c. At Parent Term, select the parent term for this term.

 4. Click the Save button. The new term is now displayed in the Terms hierarchical list.

 5. Repeat Steps 2-4 to add additional terms.

Example: In the below image, the first term added was called Products. Two additional terms called Dolls and Wooden Toys were added 
next. Finally, this image displays the term Blocks being added to the parent category Wooden Toys.



The newly added hierarchical term

Adding Terms (Simple Vocabulary)
How to add terms to a simple vocabulary using the Taxonomy Manager module.

 1. Click the Edit link beside the vocabulary for this term. This opens the Edit Vocabulary page.



 2. Click the Add New button. This displays the Create New Term section.

 3. In the Create New Term section, complete these fields:

 a. In the Name text box, enter a name for this term.

 b. In the Description text box, enter a description for this term.

 4. Click the Save button. The new term is now displayed in the Terms hierarchical list.

 5. Repeat Steps 2-4 to add additional terms.

Adding a term to a simple vocabulary list

Creating a Vocabulary
How to create a new vocabulary using the Taxonomy Manager module.

Tip: Only the Description field can be edited once the vocabulary is saved.

 1. Click the Create New Vocabulary button located at the base of the Taxonomy Manager module. This opens the Create New 
Vocabulary page.



 2. In the Name text box, enter the name for this vocabulary.

 3. In the Description text box, enter the description of this vocabulary.

 4. At Type, select from this options:

 l Simple: Select to create a flat list.

 l Hierarchy: Select to hierarchical tree list.

 5. At Scope, Portal is pre-selected. This confirms that the vocabulary is only available to this portal.

 6. Click the Create Vocabulary button. You can now add terms to this vocabulary. See "Adding the First Term (Hierarchical Vocab-
ulary)"

Creating a Vocabulary

Deleting Terms
How to delete one or more term associated with either a simple or hierarchical vocabulary using the Taxonomy Manager module.

 1. Click the Edit link beside the vocabulary which the term is associated with. This opens the Edit Vocabulary page.

 2. In the Terms list, select the term to be edited. This displays the Edit Term section.

 3. Click the Delete link located below the Edit Term section.

 4. Repeat Steps 2-3 to delete additional terms.

 5. Click the  Cancel link to return to the module.



Deleting Vocabulary Terms

Deleting a Vocabulary
How to delete a vocabulary from the Taxonomy Manager module. 

Permissions: Editors cannot delete vocabularies created by Administrators or SuperUsers. Similarly, Administrators cannot delete vocab-
ularies created by SuperUsers.

 1. Click the Edit link beside the vocabulary to be deleted. This opens the Edit Vocabulary page.

 2. Click the Delete link.



Deleting a Vocabulary

Editing Terms
How to edit one or more term associated with either a simple or hierarchical vocabulary using the Taxonomy Manager module.

 1. Click the Edit link beside the vocabulary which the term is associated with. This opens the Edit Vocabulary page.

 2. In the Terms list, select the term to be edited. This displays the Edit Term section.

 3. In the Edit Term section, edit one or more fields:

 a. In the Name text box, edit the name of this term.

 b. In the Description text box, edit the description of this term.

 c. At Parent Term, select the parent term for this term. Note: This option is only displayed on Hierarchical Vocabularies.

 4. Click the Update button.

 5. Repeat Steps 2-4 to edit additional terms.

 6. Click the  Cancel link to return to the module.



Editing Vocabulary Terms

Editing a Vocabulary
How to edit the description of a vocabulary using the Taxonomy Manager module. 

 1. Click the Edit link beside the vocabulary to be edited. This opens the Edit Vocabulary page.

 2. In the Description text box, edit the description of this vocabulary.

 3. Click the Update button.

Viewing User Entered Tags
How to view the tags which have been created by users. SuperUsers are able to edit and delete tags.

 1. Click the Edit link beside the pre-existing entry named "Tags". This opens the Edit Vocabulary page where all of the tags are listed 
in the Terms list.



 2. In the Terms list, click on a tag. This displays the description in the Edit Term section.

 3. Repeat Step 2 to view descriptions for other tags.

 4. Click the  Cancel link to return to the module.

Users and Roles
Controlling Site Access
Site access is controlled by restricting access to pages and modules to users who are members of particular security roles.                   See "Key 
Concepts"

The following is modules are used to restrict site access:

 l The Security Roles module is used to create roles which one or more users (user accounts) can be assigned to. See "About the 
Security Roles Module".

 l The User Accounts module is used to create user accounts. See "About the User Accounts Module"

 l The File Manager module is used in controlling site access when folders containing files are restricted to one or more roles. See 
"About the File Manager Module".

 l Access to view and manage pages and modules is restricted using page settings or module settings. See "About Page Per-
missions" and "Setting Module Permissions".

Add New User
About the Add New User Module
The Add New User module enables authorized users to create new user accounts.

Tip: This module forms part of the Users & Roles module package.

Once the user account is created, it can be managed using the User Accounts module. See "About the User Accounts Module"



 
The Add New User Module

Adding a User Account
How to add new user accounts to this site using the  Add New User module. Note: The Add New User module is part of the Users & Roles 
module package.

Tip: Fields marked with a Required  icon are mandatory.

 1. Go to the Add New User module.

 2. In the User Name text box, enter a user name. The user name cannot be changed. Note: Usernames are unique; a new user 
cannot be added with an existing Username. If you attempt to save a user account using an existing username this displays the 
message: "A User Already Exists For the Username Specified. Please Register Again Using A Different Username."

 3. In the First Name text box, enter the person's first name. 

 4. In the Last Name text box, enter the person's last name.  

 5. In the Display Name text box, enter the name to be displayed to other site members.  Note: This field may not be displayed. 
"Managing User Accounts Settings". 

 6. In the Email Address text box, enter a valid email address. 



 7. At Authorize, select from the following options: 

 l Check  the check box if the user is authorized to access the portal. This will automatically provide access to the Reg-
istered User role and any roles set for Auto Assignment. This is the default setting. 

 l Uncheck  the check box if the new user is not yet authorized to access the portal. The Administrator is required to 
authorize this account at a later date.

 8. At Notify, select from the following options: 

 l Check  the check box to send a notification email to the user's email address. This is the default setting. 

 l Uncheck  the check box if you don't wish to send notification. If the account is not authorized, you may like to send the 
notification at a later time.

 9. To create the user's password, select from these options:

 l To generate a random password, check  the Random Password check box.

 l To create a password manually:

 a. Uncheck  the Random Password check box.

 b. In the Password text box, enter a password. 

 c. In the Confirm Password text box, re-enter the same password. 

 10. Click the  Add New User link.



Tip: The site may be set to required unique passwords, as for usernames. In this case, choose a new password, or opt for a random pass-
word.

Security Roles
About Security Roles in DNN
Default Security Roles

The Security Roles module has three (3) default Security Roles: Administrators, Registered Users and Subscribers.

 l Administrators: Members of this role have full access to manage this site. This includes access to add, delete and edit all pages 
and modules on the site. Members of this role also have access to the Admin Console, which enable users to access all of the 
Site Administration modules which other users can be authorized to access as well as the additional Pages, Solutions Explorer, 
What's New, Pages and Site Settings pages. This role cannot be deleted or modified.

 l Registered Users: Everyone who is a registered user of this site is a member of this role.  Members of this role can manage their 
User Profile and may be granted rights to view pages and modules which are only displayed to logged in users. Registered user 
accounts can be set as either Authorized or Unauthorized. If an account is Unauthorized, then the user cannot access pages/mod-
ules which are restricted to this role. This role cannot be deleted or modified.

 l Subscribers: All Registered Users are automatically added to this role upon registration. ( i.e. this role is set as Auto Assignment)  
Authenticated users can unsubscribe or re-subscribe to this role under Membership Services on the View Profile (also called the 
My Profile) module.  Administrators can choose to delete this role, or change its settings as required. This role cannot be deleted.

Security Role Groups

The following terms are used throughout the DNN application. They refer to groups of users as well as their status.

 l All Users: All Users refers to all site visitors regardless of whether they are logged in or registered on the site. This term is used 
on page and module setting pages to enable them to be set as accessible to all users. This term is not used on the Security Roles 
module.

 l  Authenticated Users: An authenticated user is a registered user who is logged into the site.

 l Unauthenticated Users: An unauthenticated user is a site visitor who isn't logged into the site. This term is used on page settings 
and module setting pages, but is not displayed as a role on the Security Roles module. A typical application for these users would 
be to set a page or module as viewable to Unauthenticated Users, but not to All Users. Then when an unauthenticated user logs 
into the site, the page or module is no longer visible. This could be used for information about joining the site which isn't relevant 
to users who are already registered.

 l Module Deployer: A Module Deployer is any person or role who has been granted permission to add one or more types of mod-
ules to site pages. This term is used on the Extensions module.

About Security Role Settings
Security Roles can be configured in a number of ways to change the way users can access roles.  The following options are available.

 l Public Role: Roles set as public enable all registered users to be able to subscribe or unsubscribe to the role.  Public Roles are 
managed by authenticated users under Membership Services on the View Profile (also called the My Profile) module. 

 l Private Role: When a role is not set as public, it is a private role.  Only Administrators have access to manage user access to 
these roles, unless the role includes an RSVP Code.

 l RSVP Code: When a role includes an RSVP code, users can subscribe to the role by entering the code into a text box under Man-
age Services on their profile. This provides a quick way to subscribe and also enables subscriptions to be limited to those with the 
code if the role is set as Private.



 l RSVP Link: The RSVP link setting automatically adds a user to that role when they go to the RSVP link. This provides a very easy 
way of subscribing to a role.

 l Auto Assignment: All registered users are automatically added to these roles upon registration. If the role is also set as Public, 
users can unsubscribe and unsubscribe to it.  If the role is set as Private, only Administrators can manage user access.

About the Security Roles Module
The Security Roles module enables the creation and management of security roles and security role groups. It also permits authorized 
user to manage users within roles.

Tip: This module forms part of the Users & Roles module package.

The Security Roles Module

All Users
Filtering Security Roles by Role Group 
How to view the security roles within a role group using the Security Roles module.

 1. At Filter By Role Group, select one of the following options: 

 l <All Roles>: Displays all roles including both roles within and not within a role group. 

 l <Global Roles>: Displays all roles that do not belong to a role group including the Administrators and Registered Users 
roles. 

 l [Role Group Name]: Select the name of a role group to view each of the roles associated with that Role Group.



Filtering by Role Group

Viewing Security Role Details
How to view the details of roles on the Security Roles module. 

All users who are authorized to view the Security Role module are able to view details of the roles which have been added to this site. 
The following details of each role are typically displayed: 

 l Role Name

 l Role description

 l Role fee and period

 l Trial fee and period

 l If the role is public

 l If users are automatically assigned to the role

Module Editors
User Settings
Managing User Account Settings
How to view and manage the settings applied to the User Accounts module. These settings can be accessed using either the User 
Accounts or Security Roles module.

 l See "Viewing Membership and Password Settings"

 l See "Setting User Registration Options"

 l See "Managing User Accounts Settings"

 l See "Setting the Login and Logout Options"

Adding a Security Role (Basic Settings)
How to add a basic security role to a site using the Security Roles module.



 1. Select Add New Role from the module actions menu - OR - Click the  Add New Role link. 

 2. In the Basic Settings section complete the following fields: 

 a. In the Role Name text box, enter a name for the Security Role. 

 b. In the Description text box, enter a brief description of the Security Role. 

 c. Optional. At Role Group, select a group for this role if desired. Note: One or more role groups must already be created 
to set this field. You can also associate a role with a role group at a later time. See "Adding a Role Group"

 d. At Public Role?, select one of the following options:

 l Check  the check box if all users are able to view details of this role and subscribe to this role. Users can 
subscribe to or unsubscribe from these roles when they manage their profile. 

 l Uncheck  the check box if the role is Private. Only Administrators can add a user to a private role unless it 
has an RSVP Code or RSVP Link (see below) which has been supplied to the user.

 e. At Auto Assignment?, choose from the following options: 

 l Check  the check box if users are automatically assigned to this role. 

 l Uncheck  the check box if users must be manually added to the role.

 4. Click the  Update link.



Adding a Security Role - Basic Settings

Creating a Membership Service 
How to create a Membership Service using the Security Roles module. A Membership Service is a security role which is set as 
Public. These roles are displayed to users when they manage their account under the Manage Services link on the Manage Profile page. 
For here users can view details of the available membership services and elect to subscribe to or unsubscribe to them. A trial period, trial 
fee, service period, and service fee can also be set for membership services. "Adding a Security Role with a Fee".

 1. Select Add New Role from the module actions menu - OR - Click the Add New Role link.

 2. Go to the Basic Settings section.         

 3. In the Role Name text box, enter a name for the role. 

 4. In the Description text box, enter a brief description of the role. 

 5. Optional. At Role Group, select a role group for this role if required. 

 6. At Public Role?, check  the check box to set this role as a Membership Service. 

 7. Optional. At Auto Assignment, select from the following options: 

 l Check  the check box to assign all users to this role. This includes both existing and new  users.

 l Uncheck  the check box if users must subscribe to the role.



 8.  Click the  Update link.

Tip: The new role is now displayed as a member's service on the View Profile  (also called the My Profile) module.



 
Member Services displayed on the Manage Profile page on the User Profile page

Adding a Security Role with a Fee
Hoe to can create a security role which charges a subscription and/or a trial fee using the Security Roles module. 

Important: You will need to configure the Payment Processor under Site Settings, in order to enable fee based roles/services. The fee 
and billing period fields do not display until the payment processor is configured. See "Setting the Payment Processor"

 1. Select  Add New Role from the module actions menu  - OR - Click the  Add New Role link. 

 2. In the Basic Settings section complete the following fields: 

 a. In the Role Name text box, enter a name for the Security Role. 

 b. In the Description text box, enter a brief description of the Security Role. 

 c. Optional. At Role Group, select a group for this role if required. 

 d. At Public Role?, select one of the following options: 

 l Check  the check box if all users are able to view details of this role and subscribe to this role. Public Roles 
can be maintained by user on their profile under Manage Service. 

 l Uncheck  the check box if the role is Private. Details of private roles are not displayed on the user profile 
page. Only Administrators can add a user to a Private role unless it has an RSVP Code (see below) which has 
been supplied to the user.

 e. At Auto Assignment, choose from the following options: 



 l Check  the check box if users are automatically assigned to this role. 

 l Uncheck  the check box if users must be manually added to the role.

 3. Maximize  the Advanced Settings section and complete one or more of the following fee settings: 

 a. In the Service Fee text box, enter the fee amount charged to become a member of the Security Role. If no fee is to be 
charged, leave this field blank. If no service fee is charged, skip to Step 3C. 

 b. In the Billing Period (Every) text box, enter a number and select a billing period. If no fee is charged, but access to the 
role will expire on a given day, complete this field as this sets the access period for the role. 

 c. In the Trial Fee text box, enter the fee amount charged to access the Security Role for a trial period. If no fee is charge, 
leave this field blank. If no trial period is charged, skip to Step 4. 

 d. In the Trial Period (Every) text box, enter a number and select a billing period. If no trial fee is charged, but access to 
the role will expire on a given day, complete this field as this sets the access period for the role.

 4. Optional. The following optional Advanced Settings are also available:

 a.  In the RSVP Code text box, enter a code which enables users to subscribe to this role.

 b. At Icon, select or upload an image for the role. "Setting a File Link".



 5. Click the  Update link.

Adding a Security Role with an RSVP Code
How to create an RSVP Code for a security role using the Security Roles module. By providing the RSVP code or link to users you can 
enable them to subscribe to the role either by linking on the link or  by entering the code on the Manage Services page when managing 
their User Profile.



 1. Select  Add New Role from the module actions menu  - OR - Click the  Add New Role link. 

 2. In the Basic Settings section complete the following fields: 

 a. In the Role Name text box, enter a name for the Security Role. 

 b. In the Description text box, enter a brief description of the Security Role. 

 c. Optional. At Role Group, select a group for this role if desired. 

 d. At Public Role?, choose from the following options: 

 l Check  the check box if all users are able to view details of this role and subscribe to this role. Users can 
subscribe to or unsubscribe from these roles when they manage their profile. 

 l Uncheck  the check box if the role is Private. 

 e. At Auto Assignment?, choose from the following options: 

 l Check  the check box if users are automatically assigned to this role. 

 l Uncheck  the check box if users must be manually added to the role.

 3. Maximize  the Advanced Settings section.

 a. In the RSVP Code text box, enter a code which enables users to subscribe to this role. The code can be any com-
bination of letters and numbers.

 4. Click the  Update link.   This saves the new role and generates an RSVP link which displays on the Edit Security Roles page. See 
"Obtaining an RSVP Link"



Adding a Security Role with an RSVP Code

Obtaining an RSVP Link
How to obtain an RSVP link using the Security Roles module. Once you have created a security role with an RSVP Code an RSVP Link 
will be generated for that role. Users can subscribe to the role simply by clicking on the link or going to the URL.

 1. If the required role is not displayed, at Filter By Role Group select the [Role Group Name] associated with the role, or select <All 
Roles>.



 2. Click the Edit  button beside the required Security Role. 

 3. Maximize  the Advanced Settings section. 

 4. At RSVP Link, copy the link. 

 5. Click the  Cancel link to return to the module.



Editing a Security Role
How to edit the settings and details of a security role using the Security Roles module.

 1. If the required role is not displayed, at Filter By Role Group select the [Role Group Name] associated with the role, or select <All 
Roles>. 

 2. Click the Edit  button beside the role to be edited. 

 3. Edit the settings as required. 

 4. Click the  Update link.

Editing a Security Role

Deleting a Security Role 
How to permanently delete a security role from the Security Roles module. This will also delete the information of which users were 
members of this role.

Tip: The Administrators and Registered Users roles cannot be deleted.

 1. If the required role is not displayed, at Filter By Role Group select the [Role Group Name] associated with the role, or select < 
All Roles >. 

 2. Click the Edit  button beside the role to be deleted. 

 3. Click the  Delete link. This displays the message "Are You Sure You Wish To Delete This Item?" 

 4. Click the OK button to confirm.



Deleting a Security Role

Adding a Role Group
How to add a role group to a Security Role using the Security Roles module. Role Groups enable you to group multiple roles together, 
making them easier to manage. E.g. The Role Group called Staff could have the following Security Roles associated with it: All Staff, Tel-
emarketing, Marketing, Sales, Information Technology, etc. Roles can be filtered by Role Group, which is useful on sites with lots of 
roles. Once a role group has been added,  one or more security roles can be added to the role group. "Adding a Security Role (Basic Set-
tings)". and "Editing a Security Role"..

 1. Select  Add New Role Group from the module actions menu - OR - Click the  Add New Role Group link. 

 2. In the Group Name text box, enter a name for the Security Role Group. E.g. Staff 

 3. In the Description text box, enter a brief description of the Security Role Group. 

 4. Click the Update link.



Adding a Role Group

Editing a Role Group
How to edit a security role group using the Security Roles module.

 1. At Filter By Role Group, select the role group from the drop-down box. This displays the Edit button beside this field. 

 2. Click the Edit  button. This opens the Edit Role Group page.

 3. In the Group Name text box, edit the name of the role group.

 4. In the Description text box, edit the role group description.

 5. Click the Update link.

Editing a role group

Deleting a Role Group 
How to delete a role group from the Security Roles module.

Tip: You must first remove all roles belonging to that role group. This can be achieved by editing each role associated with the Role 
Group and either changing the associated role group - OR - disassociating the role group from all roles. E.g. selecting <Global Roles>. If 
a role group has associated roles, the delete option will not be displayed.

 1. At Filter By Role Group, select the role group from the drop-down box.

 2. Click the Delete  button. This displays the message "Are You Sure You Wish To Delete This Item?" 

 3. Click the OK button to confirm.



Deleting a Role Group

Adding a User to a Security Role
How to add a user to a security role using the Security Roles module. Once a user is added to a new role they will immediately gain 
access to any modules or pages restricted to the members of the selected role. The user may need to refresh their Web browser to view 
additional areas of access.

 1. Click the Manage Users  button beside the required role. 

 2. At User Name, select or enter a user name. 

 3. Optional. At Effective Date, click the  Calendar  button and select the first date the user can access this role. See "Working 
with the Calendar". Where no date is selected access will be immediately granted. 

 4. Optional. At Expiry Date, click the  Calendar  button and select the last date the user can access this role. See "Working with 
the Calendar". Where no date is selected access will not expire.

 5. Optional. At Send Notification?, select from the following options: 

 l Check  the check box to send a notification email to the user. This option is ticked by default. 

 l Uncheck  the check box to add the user to a role without sending them notification.

 7. Click the  Add User to Role link. The name of the user will be added to the list of users associated with this role. 

 7. Repeat Steps 3-7 to add new users. 

 8. Click the  Cancel link to return to the module.



Editing a User's Security Role Access 
How to modify the date range that a user is able to access a security role using the Security Roles module. 

 1. Click the Manage Users  button beside the role.

 2.  At User Name, select the required user from the drop-down box - OR - Enter the user's User Name into the text box and click 
the Validate link. If the user name remains in the text box then it is 'valid'.

 3. Optional. At Effective Date, click the  Calendar link and select the first date the user can access this role. Where no date is 
selected access will be immediately granted.

 4. Optional. At Expiry Date click the  Calendar link and select the last date the user can access this role. Where no date is 
selected access will not expire. 

 5. At Send Notification?, select from the following options: 

 l Check  the check box to send a notification email to the user informing them of their new role access. This is the 
default setting. 

 l Uncheck  the check box to add the user to the role without notifying them.

 6. Click the  Add User To Role link. This either adds a new record for this user in the User Name table below, or updates the 
existing record.

 7. Click the  Cancel link to return to the module.

Related Topics:

 l See "Working with the Calendar"

Deleting a User from a Security Role 
How to delete a user from a security role using the Security Roles module. Users will immediately be denied access to any modules or 
pages which are restricted to members of the selected roles.

 1. If the required role is not displayed, at Filter By Role Group select the [Role Group Name] associated with the role - OR - Select 
<All Roles>. 

 2. Click the Manage Users  button beside the required role. This opens the Manage Users In Role page for the selected role. 

 3. Locate the user and click the Delete  button located to the left of their name. This displays the message "Are you sure you 
want to remove [username] from the [role name] role?"

 4. Click the OK button to confirm.



Tip: On the Manage Users In Role page, each user who is a member of the role is listed by Username. Clicking on a linked Username 
will display their users profile and enable you to check their account details and ensure you have the correct user.

User Accounts
About the User Accounts Module
The User Accounts  module enables the creation and management of registered user's account, as well as assignment of security roles. 
The fields displayed on the module can be set, as well as the way user accounts are handled. See the Manage Profile Properties and 
User Settings sections. New profile properties can be created. This Administration module can be deployed to any page by an authorized 
user. It is also displayed on the Admin > User Accounts page.

Note: This module forms part of the Users & Roles module package which is set as a Premium Module by default to reduce the instance 
of it being accidentally added to a page and revealing personal user information.



The User Accounts Module

All Users
Filtering User Accounts by Username
How to filter user account records by the first letter of all user names on the User Accounts module. 

 1. Click on the linked [letter of the alphabet] which is the first letter of the persons user name. This displays all matching user 
accounts is alphabetical order.

Filtering User Accounts by Username

Viewing All User Accounts
How to view all user accounts in the User Accounts module. 



 1. Click the All link. By default, the first ten (10) of all user accounts will be listed in alphabetical order by username. Use the Pager 
Control to navigate to further records. "About the Pager".

Tip:  "Managing User Accounts Settings". to modify the default number of records displayed or to display all records by default

Filtering User Accounts by Online Users
How to filter user accounts to only view users who are currently logged in to this site using the User Accounts module. This filter is inte-
grated with the Users Online module which must be enabled by the Host. "About the Users Online Module".

 1. Click the Online link.

Filtering User Accounts by Online Users Only



Filtering User Accounts by Unauthorized Users 
How to filter user accounts to display only unauthorized users using the User Accounts module. Unauthorized user accounts display the 
Unchecked  icon in the Authorized column.

 1. Click the Unauthorized link. By default, the first ten ( 10 ) unauthorized user accounts are listed in alphabetical order by user-
name. Use the Pager Control to navigate to further records. "About the Pager".

Filtering User Accounts by Unauthorized User Accounts

Searching for a User Account
How to search for a user account on the User Accounts module. Searches can be performed using one of several account details such 
as user name, address, email, name, etc.

 1. In the Search text box located at the top right of the module, enter the search criteria. 

 2. Select one of the following options from the drop down list: 

 l Username: Searches for exact matches and all or part of the beginning of the username. E.g. Entering Ad, Admin, or A 
will return Admin. 

 l Email: Searches for exact matches only. 

 l Prefix: Searches for exact matches and all or part of the beginning of the prefix. E.g. Entering M, or Mr will return Mr 
and Mrs. 

 l First Name, Middle Name and Last Name: Searches for exact matches and all or part of the beginning of the name. 
E.g. Entering J will return all names beginning with J. 

 l Suffix: Searches for exact matches and all or part of the beginning of the suffix. E.g. Entering E or Esq will return Esq. 
and Esquire. 

 l Unit: Searches for exact matches and all or part of the beginning of the unit address. 

 l Street: Searches for exact matches and all or part of the beginning of the street address. The street number must be 
included. E.g. Entering 1 Jack, 1 Jack Street will return 1 Jack Street and 1 Jackson Street. Entering Jack Street will not 
all addresses with Jack street. 

 l City: Searches for exact matches and all or part of the beginning of the city name. E.g. Entering Melb will return Mel-
bourne. 

 l Region: Searches for exact matches and all or part of the beginning of the region name. E.g. Entering V or Vic will 
return Victoria. 



 l Country: Searches for exact matches and all or part of the beginning of the region name. E.g. Entering Aus will return 
Austria and Australia. 

 l Postal Code: Searches for exact matches and all or part of the beginning of the postal code. 

 l Telephone and Cell and Fax: Searches for exact matches and all or part of the beginning of the number.

 l Website: Searches for exact matches only as displayed on the user's profile. E.g. If the user's web site is entered as 
www.domain.com, searching on domain.com will not return a match. 

 l IM: Searches for exact matches only as displayed on the user's profile. 

 3. Click the Search button.

Searching for a User Account

Module Editors
Adding a User Account
How to add new user account to the site using the  User Accounts module. 

 1. Select  Add New User from the User Accounts module actions menu - OR - Click the  Add New User link. This opens the 
Add New User page.  

 2. In the User Name text box, enter a user name. The user name cannot be changed. Note: Usernames are unique; a new user 
cannot be added with an existing Username. If you attempt to save a user account using an existing username this displays the 
message: "A User Already Exists For the Username Specified. Please Register Again Using A Different Username."

 3. In the First Name text box, enter the person's first name. 

 4. In the Last Name text box, enter the person's last name.  

 5. In the Display Name text box, enter the name to be displayed to other site members.  Note: This field may not be displayed. 
"Managing User Accounts Settings". 

 6. In the Email Address text box, enter a valid email address. 



 7. At Authorize, select from the following options: 

 l Check  the check box if the user is authorized to access the portal. This will automatically provide access to the Reg-
istered User role and any roles set for Auto Assignment. This is the default setting. 

 l Uncheck  the check box if the new user is not yet authorized to access the portal. The Administrator is required to 
authorize this account at a later date.

 8. At Notify, select from the following options: 

 l Check  the check box to send a notification email to the user's email address. This is the default setting. 

 l Uncheck  the check box if you don't wish to send notification. If the account is not authorized, you may like to send the 
notification at a later time.

 9. To create the user's password, select from these options:

 l To generate a random password, check  the Random Password check box. 

 l To create a password manually:

 a. Uncheck  the Random Password check box.

 b. In the Password text box, enter a password.

 c. In the Confirm Password text box, re-enter the same password. Note: The site may be set to required unique 
passwords. In this case, choose a new password, or opt for a random password.



 10. Click the Add New User link.

Editing a User Account
How to edit the details of a user's account using the User Accounts module.

Tip: The user name field cannot be edited.

 1. Find the user to be edited using a filter or by searching. 

 2. Click the Edit  button beside their record. This opens the Edit User Accounts page.



 3. Select the              Manage User Credentials tab.

 4. Edit one or more fields as required. Editable fields are the user's first name, last name, display name and email address.

 5. Click the  Update link.

UnAuthorizing a User
How to unauthorize a user's account using the User Accounts module. Unauthorized users will be unable to login to the portal or thereby 
removing their access to all role restricted areas.

 1. Find the user to be unauthorized using a filter or by searching. 

 2. Click the Edit  button beside their record. This opens the Edit User Accounts page.

 3. Select the Manage User Credentials tab.

 4. Click the UnAuthorize User link.  This displays the "  User Successfully UnAuthorized"  message and sets the Authorized 
field to False.



Unauthorizing a User Account

The Message Displayed to an Unauthorized User Attempting Login

Authorizing an Unauthorized User
How to authorize an unauthorized user account using the User Accounts module. 

 1. Click the Unauthorized link to display only unauthorized accounts and find the required account. 

 2. Click the Edit  button beside their record. 



 3. Click the  Authorize User link.  This displays the "  User Successfully Authorized"  message  and sets the Authorized field to 
True.

Deleting all Unauthorized User Accounts 
How to permanently delete all unauthorized user accounts using the User Accounts module. 

 1. Optional. Click the Unauthorized link  to view a list of unauthorized users before deleting them. 

 2. Select  Delete Unauthorized Users from the module actions menu - OR - Click the Delete Unauthorized Users link. This dis-
plays the message "Are You Sure You Wish To Delete These Items?" 



 3. Click the OK button to confirm deletion.

Deleting a User Account 
How to "soft" delete a user account from a site using the User Accounts module. Information about this deleted account can still be 
viewed using this module.

 1. Find the user to be deleted using a filter or by searching. 

 2. Click the Delete  button beside their record. This displays the message "Are You Sure You Wish To Delete This Item?" 

 3. Click the OK button to confirm.



Managing User Roles
How to add a user to a Security Role or change a users role access using the User Accounts module. 

 1. Find the required user by using a filter or by performing a search. 

 2. Click the Manage Roles  button beside the required user account. 

 3. At Security Role, select the role this user is to be added to.

 4. Optional. At Effective Date, click the  Calendar link and select the first date the user can access this role. If no date is 
selected then access to this role is immediately granted. 

 5. Optional. At Expiry Date, click the  Calendar link and select the last date the user can access this role.   If no date is selected 
then access to this role will not expire.



 6. At Send Notification?, select from the following options: 

 l Check  the check box to send a notification email to the user informing them of their new role access. This is the 
default setting. 

 l Uncheck  the check box to add the user to the role without notifying them.

 7. Click the Update User Role link. The updated role details are now displayed in the list below.

 8. Repeat Steps 3-7 to add this user to additional roles.

 9. Click the  Cancel link to return to the module.

Related Topics:

 l See "Working with the Calendar"

Editing a User's Security Role Access
Deleting a User from a Security Role
How to delete a user from a security role using the User Accounts module. 

 1. Locate the required user using a filter or by performing a search. 

 2. Click the Manage Roles  button beside the required user account. 

 3. At Send Notification?, select from the following options: 

 l Check  the check box to send a notification email to the user informing them that they have been removed from the 
role. This is the default setting. 

 l Uncheck  the check box to delete role access without sending a notification email. 



 4. Click the Delete  button beside the role the user is to be deleted from. This displays the message "Are You Sure You Wish To 
Delete This Item?" 

 5. Click the OK button to confirm.

 6. Repeat Steps 4-5 to delete this user from additional roles.

Forcing a Password Change
How to force a user to change their password next time they login to the site using the User Accounts module. 

 1. Find the required user using a filter or by searching. 

 2. Click the Edit  button beside their user account.

 3. Select the Manage User Credentials tab.

 4. Click the Force Password Change link. This removes the Force Password Change link; sets  the Update Password field to True; 
and displays the "User must update password on next login" message.

Managing a User Profile
How to manage all fields of a user's profile using the User Accounts module. Editable fields include address information, contact infor-
mation, biography, time zone and preferred locale.

 1. Find the user account to be edited using a filter or by searching.

 2. Click the Edit  button beside their user account.

 3. Select the Manage Profile tab.

 4. Edit any fields as required.

 5. Click the  Update link.

Managing a User's Password 
How to change or reset a user's password as well as view details regarding the user's current password settings using the User Accounts 
module. 



 1. Find the user to be edited using a filter or by searching. 

 2. Click the Edit  button beside the required user account.

 3. Select the Manage Password tab.

 4. The following details regarding the user's password are displayed: 

 l Password Last Changed: Displays the date the password was last changed.

 l Password Expires: Displays the date the password will expire, if any.

 5. To change the password, perform the following in the Change Password section: 

 a. In the New Password text box, enter a new password. 

 b. In the Confirm Password text box, re-enter the new password. 

 7. To reset the password, perform the following in the Reset Password section: 

 a. Click the Reset Password link. This generates a random password which is sent to the user's email address.

 8. Click the  Cancel link to return to the module.

Profile Properties
Managing Global User Profile Properties
How to set the properties of the fields in the user profile using the User Accounts module.

 1. Select  Manage Profile Properties from the User Accounts module actions menu - OR - Click the  Manage Profile Prop-
erties link. This displays the Users Accounts page where you can perform any of the following management tasks.

Reordering Fields

 l Click the Down  button to move a field down one position on the profile page, and then click the  Apply Changes link.

 l Click the Up  button to move a field up one position on the profile page, and then click the  Apply Changes link.



Setting Fields as Required or Optional

 1. At Required, select one or the following options: 

 l Click on the check box located at the top of this column to set all fields at the same time as follows:

 o Check  the check box to set all fields as required.

 o Uncheck  the check box to set all fields as optional.



 l Check  the check box beside a field to set it as mandatory on the User's Profile page. The user will be prompted to 
update this field when they edit their profile. Note: The field will only be required at Registration if set under User Set-
tings. See "Setting Registration Options" 

 l Uncheck  the check box beside a field to set it as optional.

 2. Click the  Apply Changes link.

Setting Field Visibility

 1. At Visible, select from the following options to set the visibility of fields on the Manage Profile page:

 l Click on the check box located at the top of this column to set all fields at the same time as follows:

 o Check  the check box to set all fields are visible in the User Profile.

 o Uncheck  the check box to set all fields as not visible in the User Profile.



 l Check  the check box beside a field to set it as visible. 

 l Uncheck  the check box beside a field to set it as not visible.

 2. Click the  Update link.

Refreshing the Profile Properties Grid

 1. Click the Refresh Grid link located at the base of the module. This refreshes the grid with any recent updates.



Adding a User Profile Property
How to add a new property (field) to the user profile using the User Accounts module.

 1. Select  Manage Profile Properties from the module actions menu - OR - Click the  Manage Profile Properties link. 

 2. Select  Add New Profile Property from the Manage Profile Properties menu  - OR - Click the  Add New Profile Property 
link. This opens the  Add Profile Property Definition wizard.



 3. On the Add New Property Details page complete the following:

 a. In the Property Name text box, enter a name for this property as it will appear on the Manage Profile page.

 b. At Data Type, select a data type from the following options: Checkbox, Date, DateTime, Country, List, Locale, Page, 
Region, RichText, TimeZone, Integer, Multi-line Text, Text, TrueFalse, Image, TimeZoneInfo and Unknown.

 c. In the Property Category text box, enter the category that this property belongs to. This determined where it is dis-
played in the profile. Pre-existing categories are: Name, Address, Contact Info, Preferences.

 d. Optional. In the Length text box, enter the maximum character length for this field. This is only relevant to fields where 
users enter information such as Text and RichText data types. 

 e. Optional. In the Default Value text box, enter the default value for this field. 

 f. Optional. In the Validation Expression text box, enter a regular expression to validate data entered into this field.

 g. Optional. At Required, check  the check box to set the field as required - OR - Uncheck  the check box to set it as 
optional. 

 h. Optional. At Visible, check  the check box to set the field as visible in the User Accounts module - OR - Uncheck 
 the check box to hide it.

 i. Optional. In the View Over text box, enter the view order for this property.

 j. At Default Visibility, select one of the following options to set the default visibility of this property:

 l All Users: All users can view this property by default.

 l Members Only: Only registered users can view this property by default.

 l Admin Only: Only Administrators can view this property by default.

 k. Click the  Next link. This saves this information and opens the Manage List Entries page.



 4. On the Manage List Entries page add the list entries for this property:

 a. Click the  Add Entry link. This displays the Add Entry fields.

 b. In the Entry Text text box, enter the text to be displayed for this entry.

 c. In the Entry Value text box, enter the value for this entry.

 d. At Enable Sort Order, check  the check box enable sort order to be modified - OR - Uncheck  the check box to use 
the default order which is the order in which entries are saved.

 e. Click the  Save link.

 5. Repeat Step 4 to add additional entries. Note: The Enable Sort Order field is only displayed when adding the first entry.

 6. Click the  Next link to manage localization and opens the Manage Localization page - OR - If localization isn't required, Skip 
to Step 9. 

 7. On the Manage Localization page, you can create different text for different languages. This requires you to have more than one 
language pack installed.  Here's how to set the localized text for this property:

 a. At Choose Language, choose a language from the list of languages enabled on this portal.

 b. In the Property Name text box, edit the name of this property as it is displayed in the profile. For this example I have 
changed Prefix to Title.

 c. In the Property Help text box, edit the help for this property. For this example I have edited this text.

 d. In the Required Error Message text box, enter the error message to display for this field when the property is Required 
but not present.



 e. In the Validation Error Message text box, enter the error message to display for this field when the property fails the 
Regular Expression Validation.

 f. In the Category Name text box, enter the category name in the selected language.

 g. Click the  Save Localized Text link.

 8. Optional. Repeat Step 7 to set localized text for other languages.

 9. Click the  Return to Profile Properties List link to return to the Manage Profile Properties page where the new property is 
listed.

 10. Optional. Move the property to the required position by clicking the Down   button repeatedly, and then click the  Apply 
Changes link. For further options, See "Managing Global User Profile Properties"

The new property displayed on the Manage Profile page

Editing a User Profile Property
How to edit the properties of user profile fields using the User Accounts module.

 1. Select  Manage Profile Properties from the User Accounts module actions menu - OR - Click the  Manage Profile Prop-
erties link. 

 2. Click the Edit  button beside the field to be edited.

 3. On the Edit Property Details page, edit one or more fields as required and then click the  Next link.



 4. On the Manage Localization page, edit one or more fields as required, and then click the  Save Localized Text link.

 5. Click the  Return to Profile Properties List link to return to the Manage Profile Properties page.

Deleting a Profile Property
How to delete a user profile property (field) using the User Accounts module.

 1. Select  Manage Profile Properties from the User Accounts module actions menu - OR - Click the  Manage Profile Prop-
erties link.

 2. In the Del column, click the Delete  button beside the property to be deleted. This displays the message "Are You Sure You 
Wish To Delete This Item?" 

 3. Click the OK button to confirm.

Deleting a Profile Property

User Settings
Viewing Membership and Password Settings
How to view membership provider and password security settings applied to this site. These tasks can be performed using either the 
User Accounts or Security Roles module.

 1. Select  User Settings from the User Accounts or the Security Roles module actions menu - OR - Click the User Settings 
link. 



 2. Select the Membership Provider Settings tab to view the following settings: 

 l Requires Unique Email: If checked  a unique email address is required for each user account. 

 l Password Format: Displays the password format. The default option is Encrypted. 

 l Password Retrieval Enabled: If checked  users can retrieve their password using the account login module. 

 l Password Reset Enabled: If checked  Administrators can reset user passwords. 

 l Minimum Password Length: Displays the minimum number of characters required for a valid password. 

 l Minimum No of Non AlphaNumeric Characters: Displays the minimum number of non-alphanumeric characters 
required for a valid password. 

 l Requires Question and Answer: If checked  users must answer a question to retrieve their password. 

 l Password Regular Expression: Displays the regular expression  used to validate a password. 

 l Maximum No of Invalid Attempts: Displays the maximum number of times a user may attempt to login with invalid cre-
dentials (in the time period specified in the next field) before they are locked out of their account. If a user is locked out 
an Administrator must unlock the account. 

 l Invalid Attempt Window (in mins): The maximum number of minutes in which the set number of invalid login attempts 
(as set in the above field) must be made before lock out occurs.



 3. Select the Password Aging Settings tab, the following settings are displayed: 

 l Password Expiry (in days): Displays the number of days before a user's password expires. Users will be prompted to 
change their password the next time they login. Note: 0 = no expiry 

 l Password Expiry Reminder (in days): Displays the number of days warning given to a user that they will be required 
to change their password.

 4. Click the  Cancel link to return to the module.

Managing User Accounts Settings
How to view and manage the settings applied to the User Accounts module. This task can be performed using either the User Accounts 
or Security Roles module.

 1. Select  User Settings from the User Accounts or the Security Roles module actions menu - OR - Click the  User Settings 
link.

 2. Select the User Accounts Settings tab.

 3. For each of the below fields, set each column as visible (True) or hidden (False) on the User Account page: 

 a. Show Address Column. The default value is True (visible).

 b. Show Authorized Column. The default value is True (visible).

 c. Show Created Date Column. The default value is True (visible).

 d. Show Name Column. The default value is True (visible).

 e. Show Email Column. The default value is False (hidden).

 f. Show First Name Column. The default value is False (hidden).

 g. Show Last Login Column. The default value is False (hidden).

 h. Show Last Name Column. The default value is False (hidden).

 i. Show Telephone Column. The default value is True (visible).

 4. At Default Display Mode, select one of the following options to set the way the User Accounts page is displayed: 



 l All: All user accounts are displayed on the User Accounts module by default. 

 l First Letter: All user accounts for the first letter of the alphabet are displayed by default. 

 l None: No user accounts are displayed on the User Accounts module by default. 

 5. At Disable Results Paging, select from these options:

 l True: Select to hide the page in the user accounts grid if only one page of records exists.

 l False: Select to display results paging regardless of the number of results.

 6. At Default Profile Visibility Mode, select one of the following options to set the default visibility of user profiles: 

 l All Users: All users can view profiles by default. 

 l Members Only: Only registered users can view profiles by default. 

 l Admin Only: Only Administrators can view profiles by default.

 7. At Display Profile Visibility, select True to  enable a user to override the Default Profile Visibility Mode as set at Step 7 - OR - 
Select False to remove this option.

 8. At Display Manage Services, select True to display the Manage Services section in the Users profile - OR - Select False to hide 
it. This option is set as True by default. 

 9. In the Users per Page text box, enter the number of users to be displayed on each page. The default setting is 10.



 10. In the Display Name Format text box, enter tokens to set the format of the users display name. Setting this option will remove 
the user’s ability to edit their display name. Available tokens include [FIRSTNAME], [LASTNAME], [USERNAME]. 

 11. In the Email Address Validation text box, modify the provided email validation expression.

 12. In the User Name Validation text box, modify the provided user name validation expression. 

 13. At Users display mode in Manage Roles, select one of the following display options for the User Name field on the Manage 
Roles page: 

 l Combo Box: User names are displayed in a drop down selection box. This is the default setting. Note: The Combo Box 
always displays using the user's display mode in Manage Roles field regardless of which option is set.



 l Text Box: Displays a text box in which to enter a user name.

 14. Click the  Update link.

Setting User Registration Options
How to set the user registration options applied to this portal. This task can be performed using either the User Accounts or Security 
Roles module. Settings include a redirect page, enabling the  CAPTCHA security code and setting validation requirements. 

 1. Select  User Settings from the User Accounts or the Security Roles module actions menu - OR - Click the  User Settings 
link. 

 2. Select the User Account Settings tab and set the following options: 

 a. At Redirect After Registration, select the name of the page that users are redirected to after registering on the portal. 
To disable redirection choose the 'blank' option at the top of the pages list. 

 b. At Use CAPTCHA For Registration , select from these options:

 l True: Select to use CAPTCHA feature during registration.

 l False: Select to disable CAPTCHA. This is the default setting.          

 c. At Require a Valid Profile for Registration, select from these option:

 l True: Select to require users to enter a valid profile during registration. Valid Profiles require the User Name, 
First Name, Last Names, Display Name, Email Address and Password fields to all be completed. In addition, 
all fields set as required on the Manage Profile Properties page are required when registering on the site. 
"Managing Global User Profile Properties".

 l False: Select to disable. This is the default setting.



 3. Click the  Update link.

Setting the Login and Logout Options
How to set the login and logout options for this portal. This task can be performed using either the User Accounts or Security Roles mod-
ule.

 1. Select  User Settings from the User Accounts or Security Roles module actions menu - OR - Click the  User Settings link.

 2. Select the User Accounts Settings tab and set any of the following options: 

 a. At Redirect After Login, select a page to redirect users to when they login to the portal. To disable redirection choose 
the 'blank' option at the top of the pages list. 



 b. At Redirect After Logout, select a page to redirect users to when they logout of the portal. To disable redirection after 
login choose the 'blank' option at the top of the pages list.

 c. At Use CAPTCHA For Associate Logins, select from these options:

 l Select True to use the CAPTCHA security code with authentication methods (E.g. LiveID) other than the 
default DNN authentication method.

 l Select False to only use CAPTCHA on the default DNN authentication method.

 d. At Use CAPTCHA To Retrieve Password, select from these options:

 l Select True to enable the CAPTCHA security code features when a user retrieves their password.

 l Select False to disable CAPTCHA.

 e. At Require a Valid Profile for Login, select from these options:

 l True: Select to require users to update their profile during login if their profile no longer meets the require-
ments for a valid profile. E.g. If the required fields for a valid profile have changed since the user last logged in.

 l False: Select if a valid profile is now required to login. This is the default setting.



 3. Click the  Update link.

User Switcher
About the User Switcher Module
The User Switcher module enables authorized users to impersonate the identity of any registered site user. This enables you to  quickly 
identify what editing access different users have across the site, as well as manage their profile. Note: You cannot assume SuperUser 
level accounts.

Only available in DotNetNuke Professional Edition



The User Switcher Module

Impersonating a User
How to impersonate a user using the User Switcher module. Note: You cannot assume SuperUser level accounts.

Warning. Any user with View access to this module can impersonate other users, regardless of other permission settings.

 1. Locate the user you want to impersonate. See tip below.

 2. Click on the Impersonate User  button. 

Tip: To locate the user, use one of these methods  which are the same as the User Accounts module: See "Searching for a User Account", 
See "Filtering User Accounts by Username", See "Viewing All User Accounts", See "Filtering User Accounts by Online Users"



Managing Site Design
Managing Site Design
Manage skin design in DNN using the Skins module which allows you to upload a Skin Package and the Skin Designer module. These 
are the main tools used for site design management:

 l The Admin > Skins page which displays the Skins and Skin Designer modules. The Skins module can also be added to other 
pages. See "About the Skins Module" and "About the Skin Designer Module".

 l The Stylesheet Editor section located on the Admin > Site Settings page. See "About the Stylesheet Editor"

Note: This manual does not cover how to build skins.

Important. On the new 6.0 skin there are two pages that are created by default (getting started and home) these pages are hard coded to 
stay using the default 6.0 skin unless a user goes into the pages settings and tells it to use another skin. This may cause some confusion 
if you install a skin via extensions then change the site skin only to notice that the home page is using the default DNN skin. It is expected 
that the user will delete the getting started page.



Skins or Skin Editor module

Skin Designer
About the Skin Designer Module
The Skin Designer module is only located on the Admin > Skins page. It enables Administrators to set container and skin token values.



The Skin Designer Module

Setting Container Token Values
How to set the values of container tokens using the Skin Designer module.

 1. Navigate to Host > Skins.

 2. Go to the Skin Designer module.

 3. At Skin, select a skin package. This lists all skins within this package at the File field below. 

 4. At Container, select a container package.

 5. At File, select the name of the required container.  

 6. At Token, select a skin token. If a yellow warning message reading "Object Selected Does Not Have Settings Defined" is dis-
played there are no values associated with that token. In this case, reselect a new token." At Setting, select a setting from the 
options. This displays a description of this setting below. 

 7. In the Value text box, enter the value for the setting. 

 8. Click the Update link.

Setting Skin Token Values
How to set the values of skin tokens using the Skin Designer module.

 1. Navigate to Host > Skins.

 2. Go to the Skin Designer module.

 3. At Skin, select a skin package. This lists all skins within this package at the File field below. 

 4. At File, select the name of the required skin.  



 5. At Token, select a skin token. If a yellow warning message reading "Object Selected Does Not Have Settings Defined" is dis-
played there are no values associated with that token. In this case, reselect a new token." At Setting, select a setting from the 
options. This displays a description of this setting below. 

 6. In the Value text box, enter the value for the setting. 

 7. Click the Update link.

An example of the Logo token with a BorderWidth value set to 3 

Troubleshooting the Yellow Warning Message "You Must Select A Token Setting"
When using the Skin Designer on the Host > Skins page, the yellow warning message "You Must Select A Token Setting" displays when 
one or more settings are incomplete.

To resolve this error, complete all fields. 



Skins
About the Skins Module
The Skins module (also titled the Skin Editor module) enables users to manage skin packages, skins and containers. Skins which have 
been installed on this portal are available to all portals within this DNN installation.

This module is located under the Admin page and can also be added to site pages.

The Skins Module



All Users
Applying a Default Site Container
How to apply a container as the default container for all modules on a site. This setting does not override containers set for individual 
modules on the module settings page. See "Setting the Portal Container".

 1. Go to the Skins module. 

 2. Locate and optional preview the required container. "Previewing a Container Package".

 3. At Apply To, select one or both of the following options: 

 l Portal: check  the check box to apply the container to all site pages. 

 l Admin: check  the check box to apply the container to all Admin Console pages.

 4. Click the Apply link below the chosen container.

Setting the Default Site Container

Applying the Default Site Skin
How to apply a skin as the default skin for all modules on a site. This setting does not override page settings. See "Advanced Settings for 
Existing Pages".



 1. Go to the Skins module. 

 2. Locate and optional preview the required skin. "Previewing a Skin Package".

 3. At Apply To, select one or both of the following options: 

 a. Portal: check  the check box to apply the skin to all site pages. 

 b. Admin: check  the check box to apply the skin to all Admin Console pages.

 4. Click the Apply link.



Applying the Default Site Skin

Previewing a Container Package
How to preview all of the containers within a container package.  



 1. Go to the Skins module.

 2. At Skin Type, select one or both of these options:

 l Host: Select to view skins which are available to all sites. 

 l Site: Select to view skins which are only available to this site.

 3. Optional. At Skins, select from these options:

 l Select a skin package from the drop-down list to only view containers associated with that skin. A thumbnail image for 
each skin and container is displayed. 

 l Select <Not Specified> to hide all skins.

 4. At Containers, select a container package from the drop-down list. A thumbnail image for each container is displayed. 

 5. Click the Preview link to preview a container. This opens a new Web browser with a preview of the container.

 6. Repeat Step 5 to preview additional containers.

Previewing a Container Package

Previewing a Skin Package
How to preview all skins and containers contained within a skin package.



 1. Go to the Skins module.

 2. At Skin Type, select one or both of these options:

 l Host: Select to view skins which are available to all sites. 

 l Site: Select to view skins which are only available to this site.

 3. At Skins, select a skin package from the drop-down list. A thumbnail image for each skin and container is displayed. 

 4. Click a Preview link to preview that skin or a container.  This opens a new Web browser with a preview of the skin.

 5. Repeat Step 4 to preview additional containers.



Previewing Skins

Restoring the Default Skin
How to restore the default skin to a site. For more on setting the default skin See "Setting the Default Portal Skin and Container".

 1. Go to the Skins module. 

 2. Click the Restore Default Skin link located at the base of the module.



Restoring the Default Skin
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